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WHAT'S NEW

GENERAL APPLICATION CHANGES

INTRODUCTION OF THE MINI TOOLBAR

Ó EXAMPLE OF THEMINI TOOLBAR

The property inspector has been replaced with
the mini toolbar resulting in more efficient
property changes. The mini toolbar is displayed
in each element, similarly to charts, watchlists,
and so on, and the options adapt to the
selected element and item. With the mini
toolbar you have quick access to the most used
properties of an item and any changes made in the mini toolbar are updated live.
Additionally, the mini toolbar is shown in each workspace individually, also on
another desktop.

Within the mini toolbar, settings are available for Symbols, such a chart type,
period and used colors. For tools, settings are also available, including colors, line
styles and alerts. Settings are also available for Indicators and Strategies, such
as inputs, colors and line styles. All available settings for the activated item are
displayed with a click on the gear at the end of the mini toolbar, see "Mini Toolbar"
on page 45.

General Chart Settings and Money Management are now accessible via the
Home-Tab, see "Settings" on page 157 and "Money Management" on page 236.

Saving default settings is now possible in the context menu of properties that
have a default setting, see "Default Settings" on page 53. As before are some
default settings part of the "Tradesignal Options" on page 319.

HIDE ELEMENTS IN THE CHART

Ó HIDE ELEMENTS IN THE CHART

For a more focused overview in your charts,
you can now easily hide a individual chart
elements with a click on the eye in the "Mini
Toolbar" on page 45. Hidden elements like
indicators, symbols or strategies are still
calculated but their output is not visible
anymore. With another click on the eye is the output visible again, see "Mini
Toolbar" on page 45.
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USER-DEFINED CONTINUATIONS AND ROLLING CONTRACTS
FOR JOULE PERIOD SPREADS

The newWizard allows you to create user-defined continuations for a period
spread as well as a rolling contract. Please define the second leg as second
contract to select in the wizard. The symbol name reflects both used legs, see
"User-defined continuations" on page 84.

NEW ADDITIONAL SYMBOL SEARCH BOX

Ó QUICK SYMBOL SEARCH

A new symbol search box has been added to
the symbol lists. The search finds symbol folder
as well as single symbols. First please select
the datafeed where you want to search the
symbol. In addition, a filter can be applied to the
results: Automatic, Commingled - All Venues,
Commingled - Cleared and Non-Commingled.

The new symbol search box is added to other
dialogs and wizards like for "User-defined continuations" on page 84 as well to
make the symbols search easier.

NEW COLOR SCHEME

The color scheme of the icons and the themes are adjusted to our new company
colors. The icons are still at the same position, but changed the color. Some icons
are new because of the new mini toolbar. Themes are still available in dark and
light versions as before.

CLICK ONCE INSTALLATION AND UPDATE

Tradesignal and the embedded Tradesignal DataConnect are now installed via
Click Once. If you have Tradesignal already installed via the previous method
InstallShield, please uninstall Tradesignal before the start of the Click Once
Installation. A setup process after the initial installation will guide you through the
setup of the datafeeds and the license.

If a new version of Tradesignal is available in the future, you will be notified in the
application and will perform the update. It is not necessary anymore to download
the update from our cloud service.

When a new empty workspace is opened, a variety of sample workspaces
grouped by security type, region and market are shown.
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To use one of them, just click on the image and the workspace is created. To save
your changes in the workspace, please save the workspace.

DIFFERENT COLORS FOR DIFFERENT FIBONACCI LEVEL

Ó DIFFERENT COLORS FOR EACH LINE

All Fibonacci tools can now have different
colors for each line/level. As default is still one
default color specified, but you can change the
color for each line in the mini toolbar easily. In
order to set the color back to one default color,
select None in the color picker for each changed
line.

CUSTOM DISPLAY NAMES

For symbols, indicators and strategies you can
define a custom display name in the
Appearance settings. For example you can
define a different name for one of two equal indicators in a chart or shorten the
display name of the symbol within the legend. When using format characters like
%n for the name or %lp for the period of the symbol the custom display name is
updated after a symbol replacement. All available format characters are
explained in the tool tip.

DEFAULT SYMBOL LISTS IN FOLDER

Symbols have to be part of a symbol list. If you move a symbol via drag-and-drop
into a folder without a symbol list, Tradesignal creates automatically a default
symbol list in this folder. In this way you do not need to create manually a symbol
list at first, see "Symbol Lists" on page 62.

REPLACEMENT FOR JOULE SYMBOLS

Ó REPLACE PRODUCT

It is now possible to replace only the parts of a
Joule symbol with a compatible replacement or
to replace the single contract with a compatible
rolling contract, see "Symbol Replacement" on
page 70. All others parts of the symbol stay the
same.

You can quickly replace the product of a
symbol as well as the calendar and period. For
example, you can replace a gas symbol with
another gas symbol without searching for the new symbol in the symbol search or
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lists. Select Replace > Replace Product, Replace > Replace Calendar Period or Replace >
Replace Rolling in the context menu of the symbol and the appropriate wizard
appears.

In addition, all wizards offers a bulk replacement operation for every instance of
the same symbol in the workspace and you can also replace the legs of a spread.

INDICATORS AND STRATEGIES
à The indicator Order Book Depth is extended with the function

Annotate to see the corresponding close and volume fields,
see "Order Book Depth" on page 718.

à The new indicator Trade Volume Magnitude plots the trade
volume on a given bar and indicates if the trades were made
on Bid or Ask side, see "Trade Volume Magnitude" on
page 799.

à The indicator Strategy Market Position is extended with a
color inputs for the color of the band, see "Strategy Market
Position" on page 787.

EQUILLA
à The DataOptions meta property has a new value called

DataExtendedInlineHistory. If the new value is specified,
extended history for all inline instruments is requested.

à A custom symbol list with alternate instrument properties,
created via Equilla in the strategy code, can now be optimized
with the optimizer. So it is possible e.g. to optimize in one go
more then one period per symbol for a strategy.

à The new Annotate function adds an annotation for the current
bar. The function needs a name and a value. A grouping is
optional. Annotations are shown e.g. in the data inspector and
tool tip, see the Equilla help for Annotate.

à To show an input from your Equilla code always in the new
mini toolbar, please use the new Prominent attribute in the
declaration of the input. Only inputs marked as prominent
appear on the toolbar, see the Equilla help for Inputs.

à The NewInstrumentDefinition function returns a modified version
of the InstrumentDefinition for the bound data item and includes
the period and optional an additional FID. You can use the
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function to create variations of the parent instrument e.g. to
forward the parent unit and currency to the inner instrument,
see the Equilla help for NewInstrumentDefinition.

MISCELLANEOUS CHANGES
à Tradesignal for the start-up and Tradesignal DataConnect

now use named pipes instead of sockets for non-server mode
to eliminate port dependency.

à Tradesignal supports now Drag-and-Drop for symbols from
Joule. If a symbol is dropped from Joule into an empty
workspace or onto the background of the program, a new
chart is created. This feature needs the latest version of Joule.

à The predefined continuations and rolling contracts for Gas
and Emission symbols from Joule are extended by symbols
for each type of season and each quarter for Gas and for
December only for emissions.

à It is now possible to reload a workspace, if the needed data
feed was not available at the opening of the workspace.
Please wait until the data feed is connected and then reload
the workspace, either via the Reload button in the toolbar or via
F5.

à The autosized width of a column in a correlation matrix after a
scan can be defined in the settings: manual only, widest cell
or widest header or cell, see "Correlation Matrix" on page 270.

à Tradesignal uses now telemetry to support our development
team for new features and bug fixes. The settings for
telemetry are available in the "Tradesignal Options" on
page 319.

à Symbols (single or multiple selected) and symbol list from a
predefined symbol lists can be copied to My Symbol Lists via
copy-and-paste, see "Symbol Lists" on page 62.

à You can now use Alt and the mouse wheel to scroll in the
value axis. With Crtl in addition you can zoom and with Shift in
addition you can scroll slowly.
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GETTING STARTED

USER INTERFACE IN A NUTSHELL
When you start Tradesignal, the main user interface may look like this:

Ó THE TRADESIGNAL USER INTERFACE

à At the very top area of the window, there is the title bar. It
contains information about the current window and the "Quick
Access Toolbar" on page 48.

à Below the title bar, there is the "Toolbar" on page 42 (or
Ribbon bar). It offers access to all basic functionality (Edit,
Insert, Search...). The Toolbar is tabbed with different toolbars
for different groups of functionality. New tab pages may
appear depending on the document currently selected in a
workspace.

à To the right of the toolbar tabs, you can see the status of the
connection to the data provider. A green icon shows that the
connection is available, and a red icon signals a failed
connection. To reconnect a failed connection, double-click the
icon to open the Primary Data Feed (Online Data) Settings in
the "Tradesignal Options" on page 319.

à When you move the mouse pointer over the connection
status, a pop-up opens. Here you can find information about

15



à the used data provider

à the current connection status

à the connected server (depending on the used
data provider)

à the set timezone

à To the right of the connection status, the time (depending on
the time zone) is displayed. When scheduled jobs are active,
an icon is displayed to the left of the connection status.

à On the right, you can find the "Toolbox" on page 49. It offers
access to symbols, properties, indicators, strategies,
functions, templates, (saved) workspaces and help. Above
the button area, the details are displayed, like symbol lists or
the property manager for the selected elements.

à In the middle, you find the open "Workspaces" on page 31.
This is where document types like "Chart" on page 96,
"Portfolio" on page 251, "Watchlist" on page 77, "Scanner" on
page 71, indicators, strategies, and other information are
displayed. The tabs below the currently visible workspace
allow selection of which workspace to show.

à Below the workspaces, there is the "Output Window" on
page 331 which contains tabs for the "Alerts" on page 329
generated by strategies, tools and indicators.

USING MOUSE AND KEYBOARD

MOUSE HANDLING
The user interface is operated with the mouse.

à Elements and buttons are activated or selected by clicking on
them with the left mouse button (default). Typical activities are
clicking on buttons to start activities, clicking on menu entries,
or clicking on a drawing object to select it. When chart objects
are selected, their properties become available in the "Mini
Toolbar" on page 45.

à To open the context menu of an element, click on it with the
right mouse button (also called right-click). The context menu
opens, and you can select entries in the menu by clicking the
default (left) mouse button. Context menus are available
almost everywhere, e.g. for documents, indicators etc.
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à Some elements or menus open with a double click. This
means clicking two times in fast succession with the left
mouse button. (If you click too slowly, you may simply open
and close an element. In this case, try double-clicking again.)
Typical double-click activities are opening symbol lists
(instead of clicking on the plus symbol), or opening a symbol
in a chart (instead of selecting Open in Chart from the context
menu).

à You can move elements around with the mouse. To do so,
you need to drag-and-drop the elements. Click on the element
with the left mouse button and keep the button pressed while
moving the pointer to a new position (drag). Once there,
release the mouse button (drop). Typical drag-and-drop
activities in Tradesignal are applying indicators to symbol
charts by dragging them into the chart, or drawing lines,
squares etc. with the chart tools.

KEYBOARD HANDLING
Many elements can be opened/closed, or actions can be started, by pressing a
certain keyboard shortcut. These shortcuts are notated in a special way, for
example:

à Ctrl + Smeans "press the Crtl key and the S key at the same
time".

à Ctrl + Shift + F4means "press the Crtl key, the Shift key
and the F4 function key all at the same time". (Function keys
are usually in the top area of a keyboard.)

You can find a comprehensive list of all shortcuts in the chapter "Keyboard
Shortcuts" on page 54.

HIDING USER INTERFACE ELEMENTS
You can hide the toolbar, the toolbox and the alert area.

à To hide the Toolbar, click on the icon with the vertical arrow at
the top right in the header bar. To display the hidden Toolbar
temporarily, left-click onto one of the toolbar tabs that remain
visible.

à To hide the Toolbox, click on the icon with the small right-
pointing arrow in the toolbox title. The toolbox is hidden to the
very right, under a long button labeled with the currently
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selected toolbox panel. Click on this button to temporarily
open the toolbox, or click the left-pointing arrow button at the
top of the bar to show the full toolbox once more.

à To hide the alert area (which is situated in the lower area of
the workspace), click on the button to the bottom-right of the
pane, below the tabs. When hidden the alert area will be
replaced with a small info icon next to the workspace tabs,
click this to restore the alert pane. The alert pane can also be
maximized using the button above the collapse button. You
can find more information on alerts in the chapter "Alerts" on
page 329.

IMPORTANT FEATURES TOUR
In this article you can find an overview of the most important Tradesignal
functions. For detailed information, please follow the references to the respective
articles.

CLASSIC CHART ANALYSIS

Ó A CHART

Tradesignal makes it easy for you to create
charts for one or more symbols, indicators and
strategies. The design possibilities are vast. In
the following, some important features will be
given.

You can find an introduction to the user
interface in the chapter "User Interface in a
Nutshell" on page 15.

CREATING A CHART
To open a new empty chart, click on the Chart button in the "Toolbar" on page 42.
You can then add symbols to this chart, e.g. by dragging symbols from the
"Toolbox" on page 49 into it.

You can also quickly open a chart for a symbol directly from the toolbar:

01. Click on the Symbol Lists button in the Toolbox.

02. Open a symbol list, e.g. the Nasdaq indexes, and look for the
".NDX".
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03. Double-click on the entry. Alternatively, right-click on it and
selectOpen in Chart in the context menu.

Alternatively, you can enter the symbol shortcut in the "Command Line" on
page 38:

01. Enter the shortcut ".NDX" in the command line.

02. Select New Chart from the drop-down menu.

The data is displayed as a candlestick chart. You can change this default chart
setting in the Tradesignal Options, see the chapter "Setting a New Default Chart
Style" on page 106. The line and bar chart types are also available as default.

In general, many more chart types are available to you, like Forest, Equivolume,
Kagi or Point&Figure.

Tip: You can find a complete list of all available chart types in the chapter "Chart" on
page 96.

Ó A CHARTWITH LEGEND AND
CONTEXT MENU

On the top left in the (sub-)chart, you can find
the chart legend. Here, information about the
symbols, indicators, strategies, periods etc. is
available. The chart legend offers a context
menu in which you can find various functions,
depending on the entry type.
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Ó EDITING THE PERIOD

CHANGING THE PERIOD AND TIME
SPAN
There are various ways to change the
displayed data. In the toolbar, the buttons
Period and Time Span are available. Click on
the small arrows to open the respective button
menus.

à Keep the Period at Daily. With this
setting, one bar (candlestick) is
drawn per day.

à For the Time Span, select Current
Year, for example.

You can also change the displayed time span
and prices by directly manipulating the axes
with the mouse. To do so, click on the time axis with the right mouse button and
keep it pressed while moving the mouse left and right. You can see that the axis is
stretched and shrunk. The price axis can be changed accordingly. You can find
more information in the chapter "Stretching/shrinking Axes" on page 101.

Ó TREND LINE AND REGRESSION
CHANNEL

ADDING DRAWING ELEMENTS
In the chart tools you can find simple drawing
elements like lines, circles and rectangles, but
also tools with a calculation function, like the
Fibonacci Retracements or Andrew's Pitchfork.
You can find more information in the chapter
"Chart Tools" on page 161.

01. Click on the symbol for the trend line in the toolbar.

02. With the mouse button pressed, draw a trend line between
two points in your current chart. A line is drawn.

03. Now click on the symbol for the linear regression channel in
the toolbar.

04. With the mouse button pressed, draw a linear regression
channel from a low to a high in the chart. You can see that the
midline and a regression channel are calculated and drawn;
they change angle and width depending on the bars
(candlesticks) that are included from the start to the end point.
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Some drawing elements can be combined with the alert function. You can find
more information in the chapter "Alerts" on page 329.

CHANGING THE CHART DESIGN
You can edit the details of the chart design, for example by changing the chart
properties in the Home-Tab Styles.

However, you can also use one of the available chart styles to change the design
extensively.

01. Click on the small arrow on the Styles button in the toolbar to
open the button menu.

02. Select a style from the list, for example Blue. If you have
drawing elements in the chart, you can see that changing the
style also results in color changes for the drawn elements.

Tip: You can find more information in the chapter "Settings" on page 157.

Ó THREE CHARTS AS SUBCHARTS

DISPLAYING SEVERAL SYMBOLS IN
THE SAME WORKSPACE
You can display more than one symbol in the
same workspace, e.g. as subchart. For that, it
is important to have a look at the settings for
subcharts in the "Tradesignal Options" on
page 319.

01. Open the file menu (above the toolbar in the Tradesignal
window) and select the entryOptions.

02. On the left, click on the entry Advanced and then check
whether the setting Instruments > Open symbols in a new
subchart is selected.

This entry has the following effect:

à If no subcharts should be opened: If a chart with a symbol is
displayed and you add a symbol by selecting Add Symbol in
the context menu of that symbol, then the symbol is displayed
in the same chart as the first symbol. This can make it hard to
distinguish between the two quotations.

à If subcharts should be opened: The added symbol is
displayed as a subchart below the first symbol.
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Subcharts share the same time and price axes. This has the advantage (or
disadvantage) that all changes of e.g. period and time span apply to all subcharts.

Tip: You can edit the period for a single symbol in the chart legend context menu.

You can also display several charts in one workspace. For this, simply add the
symbol by selectingOpen in Chart in the symbol context menu. This way, the
chart opens with its own axes.

Tip: You can find more information in the chapter "Chart" on page 96.

Ó SYMBOLS AND SYMBOL LISTS

KEEPING THE SYMBOL OVERVIEW

You can see symbols and symbol lists by
clicking on the button Symbol Lists (1) in the
toolbox.

Symbol lists are sorted in groups. These are
labeled with a folder symbol (2). Click on the
plus symbol in front of it to display the symbol
lists.

Symbol lists are labeled with a document
symbol with a star (3). Symbols are labeled
with a star (4).

The context menu offers a lot of functions for
both. For example, you can open symbols in
charts or in a market depth document. Symbol
lists can be opened in a "Scanner" on page 71,
"Watchlist" on page 77or a "Portfolio" on
page 251.

On the top of the symbol lists is quick symbol
search (5).

You can find more information in the chapter "Symbol Lists" on page 62 and the
chapter "Symbol Search" on page 59.

ADDING SYMBOLS TO LISTS
Single symbols are always managed in symbol lists.

22



01. To add a new symbol, open the context menu of a symbol list
and select New Symbol. The New Symbol wizard opens.

02. You can choose between three options. Select A standard
symbol (from the data provider).

03. The "Symbol Search" on page 59 opens. Search the symbol
you want to add.

You can also add symbols to symbol lists by dragging symbols into them from
other lists.

Tip: You can find more information in the chapter "Add a Symbol to a Symbol List" on
page 64.

CREATING A NEW SYMBOL LIST

You can create your own symbols lists, for example to have your favorites in one
list.

01. In the toolbox, click the Symbol Lists button and then on
New Symbol List in the Related Task area. The Symbol List
wizard opens. Select the option User-defined Symbol List.

02. The second window of the Wizard opens. Enter a name for
the symbol list.

03. Click on Add to start the "Symbol Search" on page 59. Find
the symbols, select them and add them to the list.

04. Click on Done. The new symbol lists appears in the toolbox.

Tip: You can find more information in the chapter "Symbol Lists" on page 62.

Ó AWATCHLIST

USING A WATCHLIST
TheWatchlist is optimized for monitoring
symbol data in realtime. In combination with
indicators (see below), alerts can be issued
when certain data is "interesting" as defined by
your indicators.

The easiest way is to open an existing symbol list in a Watchlist.
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01. Right-click on a symbol list in the toolbox and selectOpen in
Watchlist from the context menu. TheWizard opens.

02. You can add one or more indicators, for example the "Relative
Strength Index".

03. In the next step, you can also add one or more strategies.

04. When finished selecting, click on Done.

Similarly you can open single symbols in the Watchlist.

To open an empty Watchlist, click on theWatchlist button in the toolbar.

You can sort the Watchlist columns by clicking on the respective column header.
A small triangle appears (pointing up or down, depending on the sorting
direction). To change the direction, click on the column header again.

Symbols can be copied from other tables into the Watchlist by using Drag-and-
Drop, e.g. from the Scanner to the Watchlist. In a similar way, you can drag
symbols from the Watchlist into a "Scanner" on page 71 or "Portfolio" on
page 251.

01. Click into a table cell of the symbol you want to copy. A small
plus sign and a rectangle appear under the mouse cursor.

02. Drag the cursor into the other table. The symbol is copied into
the table.

Tip: You can find more information in the chapter "Watchlist" on page 77.

Ó SYMBOLS IN A SCANNER

SCANNING SYMBOLS
The Scanner helps you search the large
number of symbols traded at international
markets for profitable trading candidates.

In contrast to the "Watchlist" on page 77, the
"Scanner" on page 71 offers no realtime
information. It is therefore more useful for
scanning large symbol lists for indicator or price
patterns, for example overnight.

Similar to the Watchlist, you can quickly fill the Scanner by calling up the context
menu of a symbol or symbol list and selectingOpen in Market Scanner.

As for a "Watchlist" on page 77, you can
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à open an empty Scanner via the toolbar

à directly add indicators and strategies when creating a
Scanner

à copy symbols from the Scanner into other tables by using
Drag-and-drop, or filling symbols from other tables into the
Scanner

à sort the columns in the Scanner by clicking on the respective
column headers.

Tip: You can find more information in the chapter "Scanner" on page 71.

INDICATORS AND STRATEGIES

Indicators and strategies are the main themes in analyzing symbol quotations.

Alongside classic drawing tools like trend lines or channels, indicators help to
classify trends or offer clear trading signals. In Tradesignal, you can use
indicators with Charts, Scanners, Watchlists and more. Indicators can be
combined, derived from each other, or calculated for more than one symbol.

Strategies combine indicators with entry and exit signals. This allows you to trade
mechanical systems.

Tip: You can find more information in the chapter "Introduction to Functions, Indicators and
Strategies" on page 369.

APPLYING AN INDICATOR TO A CHART

01. Open a symbol in a chart.

02. Click on the Indicators button in the toolbox.

03. Drag the indicator "Moving Average Exponential" onto the
chart legend of the symbol. Alternatively, you can also select
Apply in the context menu of the indicator.

In a similar way you can apply indicators to a "Watchlist" on page 77, "Scanner"
on page 71 and "Portfolio" on page 251.

Tip: You can find more information in the chapter "Using Indicators" on page 372.
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EDITING THE INDICATOR PROPERTIES
You can edit the properties of indicators.

à Click on the indicator in the chart and the "Mini Toolbar" on
page 45 is displayed. The common properties are now direct
changeable and the changes are applied live in the chart.

For the "MACD" indicator in our example, you can set the PeriodSlow to "38" by
clicking into the field and entering a number. You can also click on the spin
buttons to increase or decrease the number.

APPLYING AN INDICATOR TO AN INDICATOR
You can apply a second indicator to the indicator used above, "Moving Average
Exponential", for example via the command line.

01. Click on the Moving Average Double Crossover entry in the
chart legend to select the indicator.

02. Enter the symbol shortcut MACD in the command line.

03. Select Add Indicator in the drop-down menu.

The MACD indicator is now applied to the Moving Average Exponential.

Ó APPLYING STRATEGIES

APPLYING STRATEGIES TO A CHART
Strategies are an important part of trading
systems, since they combine indicators with
entry and exit signals. This allows you to trade
mechanical systems.

Strategies are applied similarly to indicators.
You can apply strategies to "Chart" on page 96,
"Watchlist" on page 77, "Scanner" on page 71
and "Portfolio" on page 251.

Here is an example that you can also use for the optimization below.

01. Open a symbol in a chart, for example a symbol of the Dow
Jones group.

02. Click on the Strategies button in the toolbar.

03. Select the Moving Average Double Crossover strategy and
drag it into the chart.
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04. Click on the strategy in the chart and change the properties in
the mini toolbar.

05. Set PeriodFast to 5 days and PeriodSlow to 10 days.

Now the strategy is set up.

Alternatively, you can add trading systems by clicking on the Add Strategy
button in the Trading Systems group in the toolbar. A window opens in which you
can find strategies sorted by subject, e.g. strategies for stops or position sizing.

Tip: You can find more information in the chapter "Using Strategies" on page 381.

Ó OPTIMIZER RESULTS

OPTIMIZING TRADING SYSTEMS
Trading systems are often based on
mathematical or statistical calculations and
include many variables. The "Optimizer" on
page 274 helps you to find good and stable
parameter sets for your trading system.

For the following example, please use the system you created in the previous
section.

01. Click on theOptimize button in the toolbar.

02. Select the method Brute Force.

03. In the right field, select the parameter PeriodFast.

04. Remove it by clicking on the << button in the middle of the
window.

05. Select PeriodSlow in the field on the right and enter the start
value 10 and the end value 50.

06. Click on Next. Click on Next again (so that all available data is
used for optimization) and finally click onOptimize in the last
window.

The optimization starts. This may take some time, therefore a button Pause is available in
the Optimizer group in the toolbar. Click on it to halt the optimization and to display the
intermediate results.

When the optimization is finished, the results are displayed, in this case for
optimizing the Moving Average Double Crossover strategy. During the
optimization, Tradesignal has calculated and checked many possible parameter
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combinations, and the result shows that certain settings for PeriodSlow would
have been more profitable than others.

To apply the result of the optimization, for example the number for PeriodSlow
with the highest profit, simply double-click on the row with the highest profit and
confirm the warning with Yes.

Please remember that the optimization is always a backtest, e.g. working with the
data of past trading periods. Therefore it is recommended to check the
optimization results against current developments from time to time.

Tip: You can find more information in the chapter "Optimizer" on page 274.

Ó PORTFOLIO AND PERFORMANCE
REPORT

PORTFOLIO TRADING
Trading with a trading system of one or more
symbols, or even several trading systems, is
done most effectively by using the Portfolio
function. With it, you can trade via a central
account that includes settings for money and
risk management. The Portfolio also allows you
creating a global Performance Report.

In a similar way to the Scanner andWatchlist,
you can open an empty Portfolio from the
toolbar, or you can open symbols and symbol lists in a Portfolio by selecting
Open in Portfolio from the context menus.

As for a Watchlist, you can

à directly add indicators and strategies when creating a
Portfolio

à copy symbols from the Portfolio into other tables by using
Drag-and-drop, or filling symbols from other tables into the
Portfolio

Tip: You can find more information in the chapter "Portfolio" on page 251.
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Ó POSITIONMANAGER

POSITION MANAGER
When trading a mechanical system, the
Position Manager offers a complete overview
over your current trading system activities. It
displays open, filled, and canceled orders and
your currently held positions.

You can open the Position Manager via the
button Position Manager in the toolbar.
However, there are only entries in the Position
Manager if a number of conditions have been met.

Tip: You can find more information in the chapter "Position Manager" on page 246.

The Position Manager is closely correlated with automatic order routing, see next
paragraph.

AUTOMATIC ORDER ROUTING
The automatic order routing function in Tradesignal allows you trading with a
more or less mechanical trading system connected to your broker. You can
decide if the orders are to be routed automatically or only with a manual
confirmation.

If you are using broker software without interfaces to Tradesignal, you can set up
the order routing so that the trading activity is only displayed in the Position
Manager. You can then enter the orders into the broker's software manually.

Tip: You can find more information in the chapter "Automatic Order Routing" on page 307.

USING THE HELP BUTTON
With the help button in the File menu you can:

à call up the help topics of Tradesignal

à write an e-mail to support with necessary system information

à show the application log file

à get information about your current Tradesignal version
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HELP LIBRARY

Show the online version of the help as found in the Toolbox "Help" on page 53.
The help topics give you an overview of Tradesignal help. You can either
manually search the tree structure for an article or you can use the input field to
search for a specific keyword. In this case, a flat list of articles with those
keywords is displayed. If you want to go back to the overview, click on the link
Table of Contents.

GET SUPPORT INFORMATION

This function collects some data about your Tradesignal system and puts it into a
ZIP file, so that it can be attached to your email to send to support. If the
workspace is also important, please add the current open and selected
workspace to the support information via the dialog. Please keep in mind, that the
workspace has to be saved and focused. This data collection will help the support
team solve your problem.

SHOW LOG FILE

Open the application log text file with detailed information.

ABOUT TRADESIGNAL

Shows you information about your Tradesignal installation.
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USER INTERFACE

WORKSPACES
The workspace is the area of a software
desktop in which documents are open and
editable. Tradesignal workspaces provide
many special functions to make using the
software easier for you.

You can use workspaces for the following:

à Editing and saving several charts at the same time

à Arranging charts in groups

à Saving different documents like charts, scanners, portfolios
and editors as one workspace

à Working with several desktops and monitors at the same time

WORKING WITH WORKSPACES

CREATING NEW WORKSPACES
Tradesignal always opens a new workspace if you start a new document on an
empty desktop.

You can also use the following methods to set up new workspaces manually:

à Press the Ctrl + N.

à Click on New in the context menu of the workspace tab.

à Click on the plus (+) button next to the workspace tabs at the
bottom of the screen.

à Click New Workspace on the bottom of the Workspaces
Manager.

à Click File > Open > Open > Recent > Create new blank
workspace.
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USE A SAMPLE WORKSPACE

Ó SAMPLEWORKSPACES

When a new empty workspace is opened, a
variety of sample workspaces grouped by
security type, region and market are shown.

To use one of them, just click on the image and
the workspace is created. To save your
changes in the workspace, please save the
workspace.

OPENING WORKSPACES
There are multiple options for opening exisiting workspaces.

FROM THE WORKSPACES MANAGER

à Open theWorkspaces Manager in the toolbox and double-
click a list entry.

à Right-click on the name of a package and select eitherOpen
all workspaces in this package orOpen All Yellow
Workspaces (red, blue) to open the color-tagged ones only.

à For color-tagging workspaces in the toolbox, see the chapter
"Workspaces" on page 53.

FROM THE FILE MENU

à Click File > Open > Open > Recent and select a workspace
from the list of recently edited workspaces.

à Click File > Open > Open, select a package and click on the
workspace you want to open.

Note: Press Ctrl + O and select one or more workspaces.

RENAMING A WORKSPACE
To rename a workspace, open the context menu of the workspace tab and click
on Rename. A dialog opens in which you can enter a new name for the workspace.

CLOSING A WORKSPACE
To close a single workspace, choose one of the following options:
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à Press the Ctrl + Shift + F4.

à Click on Close Workspace in the context menu of the
workspace tab or in the file menu.

à Click on the x button on the tab of the workspace.

To close all workspaces, click on Close all Workspaces in the File menu.

The last closed workspace can be quickly restored using the Restore Removed
Items feature.

SAVING A WORKSPACE
To save workspaces, choose one of the following entries in the file menu:

à Save (Ctrl + S) to save the current workspace (also available
in the tab context menu).

à Save as to save the current workspace under another name.

à Save all to save all open workspaces.

Tip: You can find all saved workspaces in the "Workspaces" on page 53 Manager of the
toolbox.

DELETING A WORKSPACE
You can only delete workspaces that have been saved. Otherwise you can simply
close a workspace that is no longer useful.

To delete a saved workspace, open theWorkspaces manager in the toolbox for
a list of saved workspaces. Choose Delete from the context menu of an entry.

NAVIGATING THROUGH WORKSPACES
You can browse through open workspaces by pressing Ctrl + W for forward and
Ctrl + Q for backward scrolling.

You can change the workspace sequence by clicking on a tab and drag-and-drop
it to the left or right.

Note: If you want to see all open workspaces at a glance in multiple line, select Multiline in
the context menu of the workspace.
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DEFINING KEYBOARD SHORTCUTS
You can assign the keyboard shortcuts Ctrl + 0 up to 9 for often used
workspaces. For this, either:

à Right-click on the workspace tab or

à Right-click in the list of workspaces in theWorkspace
Manager in the toolbar and choose Set Shortcut to select a
key command from the sub-menu.

ARRANGING WORKSPACES ON MONITORS
You can move a workspace to another monitor by clicking the workspace tab and
drag-and-drop it to the target monitor.

You can also arrange the workspaces on more than one monitor by clicking on
the Layout button in the toolbar and choosing up to ten monitors to distribute the
workspaces.

ARRANGING WORKSPACES ON DESKTOPS
You can display workspaces on new desktops. Desktops are new windows that
will appear in the Windows task bar. They only offer the context menus of
workspace bar and chart.

To display a workspace on a different desktop, right-click the workspace tab, then
choose Change Desktop from the context menu to select a desktop. Alternative
you can drag-and-drop the workspace tab to the according desktop.

You can move the new desktop to other monitors by drag-and-drop.

LOCKING LAYOUT
To prevent unwanted changes in the layout design of your workspaces, either

à click the Layout toolbar tab and click on Lock, or

à right-click the workspace tab and choose Lock from the
context menu.

Documents in a locked workspace cannot be changed in size, form or position.

To unlock the workspace, simply click on the toolbar button a second time.

CHANGE TAB COLOR
You can change the color of the workspace tabs. This makes it easier to visually
differentiate between workspaces.
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To change the tab color, right-click the workspace tab and choose Tab Color
from the context menu. Pick a color or remove an unwanted color by choosing
"No color".

PASSWORD PROTECTION
You can restrict access to a
workspace by specifying passwords
for opening and editing it by selecting
the Layout toolbar tab and clicking
on Password Protect...

Caution: The password cannot be recovered, so if you lose it, you will not be able to
edit/access your protected workspace anymore.

ORGANIZING DOCUMENTS IN WORKSPACES

DEFAULT LAYOUTS
Tradesignal offers several default
layouts for documents on a
workspace. You can find them by
selecting the Layout tab on the
toolbar.

Rebalance arranges the documents as homogeneous as possible on the
workspace.

Tabbed arranges all documents in a single stack. Each document is accessible via
a tab.

Columns arranges all documents in a row.
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Rows arranges all documents in a vertical column.

Tiled generates a checker-board pattern of the open documents. The documents
are arranged as homogeneously as possible in size and position.

Maximize (key F4) shows the active document in full size in the workspace. A
double-click on the document tab will also maximize the document. Repeat to
return to the former arrangement.

You can change the size of a single document by moving the frame of the
document to the left, right, up or down.

MOVING DOCUMENTS
You can move documents across the workspace by drag-and-drop the document
tab to a new position. During dragging, the position is marked by a black,
rectangular frame.

In principle, documents can be placed to the left, right, above or below another
document.

In addition, you can place a document over another one, which results in a
document stack. In this case, two tabs will be offered in the document space. The
following rules apply to stacked documents:

à Click on the document tab to bring the document to the front of
the stack, i.e. display.

à Drag the document tab to the left or right to change the
position of the document in the stack.

QUICK NAVIGATION BETWEEN DOCUMENTS
A document is activated when you click on its tab or frame.

You can also use keyboard commands for quickly switching between documents
(especially when stacked):

à Ctrl + Tab switches to the next document in the workspace. If
documents are stacked, the next document in the stack is
displayed.

à Ctrl + Shift + Tab switches to the previous document in the
workspace. If documents are stacked, the previous document
in the stack is displayed.
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COPY AND PASTE DOCUMENTS
In a workspace, you can copy documents and then paste them into another or the
same workspace, duplicating it.

01. Activate a document by clicking on its tab or frame.

02. In the Edit group in the Home tab of the "Toolbar" on page 42,
click on the button Copy (keyboard shortcut Ctrl + C).

03. If necessary, switch to another workspace and click on the
button Paste (keyboard shortcut Ctrl + V).

SYMBOL LINKING
You can link several documents so
that in all documents the same
symbol or period is displayed. The
links are connected to colors, which
are displayed as small filled
rectangles on the top left of the
document tab.

You can find the linking possibilities
in the context menu of the document
tab:

Symbol Linking When you change the
symbol of a linked document, the symbol is changed in all linked documents.

Period Linking When you change the period of a linked document, the period is
changed in all linked documents.

You have the choice between

à Six normal links: these links only apply within the same
workspace.

à Three global links: these links apply across all workspaces.

Note that you can assign only one document and one period link per document.

à Global component linking In addition to linking components
within a single workspace, a component can be marked with a
‘global link’. The effect of this is that whenever a globally
linked item is changed (either the symbol or period replaced),
all other components in all open workspaces with the same
global link color will also be updated.
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RESTORING REMOVED ITEMS
When a workspace or item in a workspace is closed, or an item from a chart or
watchlist is deleted, a yellow pop-up window will be displayed at the bottom of the
application window with a button labelled Unremove. This button may be clicked
to undo the last remove/delete operation. Clicking the x button on the pop-up
window will hide it without performing the undo operation (a new link labelled
Unremove will instead be displayed to the left of the clock at the top right of the
application window).

To only show the unobtrusive link at the top right of the application window,
uncheck the corresponding box in the options found under File > Options >
Advanced > Workspaces.

COMMAND LINE

Ó COMMAND LINE

The command line is a central control element
of Tradesignal. From here, you can

à create new documents like charts or
scanners

à apply indicators and strategies

à open Internet pages

à enter Equilla formulas

à change the trading period of charts

à enter Tradesignal-specific !Bang commands

Ó COMMAND LINEWITH MENUOPENED

GLOBAL COMMAND LINE
FUNCTIONS

The command line is context-sensitive, i.e. in
the drop down menu of the command line, only
functions available for the entered command or
text are displayed. The most probable function
is offered first.

à Double-click in the command line
field to open the drop-down menu.
This can be useful e.g. if there is a
symbol shortcut in the command line and you want to call up a
function for it.
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The command line "remembers" previous entries.

à Click the small arrow to the right of the command line field to
open the list of previous entries. You can delete the command
line history in the "Tradesignal Options" on page 319.

On the basis of these remembered entries, the command line offers auto-
completion upon entering letters. For example, if you have already entered
"nsd.x" once, the next time you type "nsd" it will lead to the correct auto-
completion.

SYMBOL SHORTCUTS

With a symbol shortcut you can open a "Chart" on page 96, a "Scanner" on
page 71, a "Watchlist" on page 77 or a "Portfolio" on page 251. If such document
types are already open, you can display the symbol in them. In case of an open
chart, you can either substitute the displayed symbol or add a second time line to
the existing chart.

Further commands can be entered along with the symbol shortcut:

Periods Enter a trading period right after the symbol shortcut. For example, ".DJI
60m" will open an hourly chart of the Dow Jones index. ".DAX 5kt" will open a
chart where every bar is comprised of at most 5.000 ticks of the German DAX.

Data fields Enter a data field name, for example "CAT NYS bid" oder "CAT NYS
ask". (Calls up data from the data provider.)

Units Enter a unit; this is especially useful in case of commodities and goods.
(Calls up data from the data provider.)

Currency Enter the currency in which the symbol should be displayed. For
example, enter "IBM NYS eur" to display IBM in euros. You can find the currency
shortcuts in the symbol properties in the toolbox.

SHORT CODES OR NAMES FOR INDICATORS

Tradesignal indicators can be found by entering either their short code or a
characteristic part of their name.

For example, entering "MOM" in the command line leads to the top suggestion
"Add Indicator Momentum".

Entering "momentum" leads to the top suggestions "Add Indicator
Momentum"and "Add Strategy Momentum Zero Line Crossover".
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Tip: To find possible short codes, open the indicator window in the toolbox and hover over
the list entries with the mouse. You can find the short code in the tool tip.

EQUILLA CODE

You can also enter "Equilla Basics" on page 397 directly in the command line (not
available for trading commands like Buy or Short). This way you can easily set up
new indicators or display an often-used spread between two symbols.

ENTER A FORMULA IN A CHART
You can create and apply indicator combinations by directly entering the formula
in the command line. In that formula, you can combine Equilla functions and
perform arithmetic operations. An editor is not necessary.

To apply the following examples, an instrument has to be open in a chart.

Example 1: Calculate a five day average of the trading volume and then the
ten day momentum:
Momentum( Average( Volume, 5 ), 10 )

Example 2: Calculate the absolute difference between the open and close,
then the 14 day RSI and then the exponential average for it over 5 days:
Drawline( XAverage( RSI( ABS( Open - Close ), 14 ), 5 ) )

Example 3: Display the difference between the close and the 200 day average
line:
Close - Average( Close, 200 )

DISPLAY SYNTHETIC TIME LINES, E.G. SPREADS
If you want to display the difference or ratio between two timelines, enter the two
symbol shortcuts with the arithmetic operator between them. Instead of entering
the symbol short cuts you can also drag the symbol from a symbol list, scanner,
watchlist or an open chart to the command line.

For example, enter

fdax 2006m / fdax 2006z

and choose the option New Formula Chart to display the spread.
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OPEN WEB ADDRESS

To open a web site, enter a website address in the command line and choose the
option New Browser.

CHANGING THE TRADING PERIOD

This feature is available for every document with an editable time period. Enter
one of the following period shortcuts in the command line and choose the option
Set Intra-Bar Period:

m, monthly Display a monthly period.

w, weekly Display a weekly period.

d, daily Display a one day period. You can add a number, e.g. "2d" for a two day
period.

h Display a period based on hours. A leading number has to be added, e.g. "3h"
for a three hour period.

m Display a period based on minutes. A leading number has to be added, e.g.
"5m" for a five minute period.

s Display a period based on seconds. A leading number has to be added, e.g.
"6s" for a six second period.

t, tick Display a one tick period. You can add a number, e.g. "15t" for 15 ticks, or
"90kt" for 90.000 ticks.

!!BANG COMMANDS

The so-called !!Bang commands in Tradesignal work in a similar manner to the
traditional commands for command line interpreters. They always have a leading
"!!" (2 exclamation marks) and offer you a quick way to access certain software
functions.

!! Enter only the 2 exclamation marks in the command line to open a list of all
available Bang!! commands.

!!add Adds a symbol to an open document in the workspace. Example: "!!add
.dax" adds the dax in a Chart, Scanner, Watchlist or Portfolio.

!!close + option - "!!close d" Closes the active document, "!!close w" closes the
active workspace and "!!close all" closes all workspaces and documents.
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!!eval + formula name Adds an Equilla formula in the chart. Example: "!!eval open of
.dax" adds the timeline for the dax open to a chart.

!!evalseries + formula series name Adds an Equilla formula series to a chart.

!!log Opens the Tradesignal log file which contains important information about
the program status and error messages.

!!new + type shortcut (+ content) Opens a new document. For most documents, the
content, e.g. a symbol or web address, has to be given. The following shortcuts
are available: b - browser, c - chart, f - Equilla function, i - indicator, m - Scanner, o
- Portfolio, p - market profile, s - strategy, t - Position Manager, v - Watchlist, w -
workspace.

!!replace + symbol shortcut Exchanges the symbol in the active chart with the
symbol given in the command. Example: "!!replace .dax".

!!replaceall + old symbol shortcut + new symbol shortcut Exchanges the old symbol in
all charts with the new symbol. Example: "!!replaceall ADS GER".

!!set + document property Changes the property settings of a document. Example:
"!!set historylength 100" for a chart.

!!setall + document property Changes the property settings of all documents in
which this property is applicable. Example: "!!setall historylength 100" for all
charts.

TOOLBAR

Ó TOOLBAR

In Tradesignal, the classic menu is substituted
with a ribbon-style toolbar. There are multiple
tab-pages of toolbar buttons and menus
organized according to general functionality.

à The first tab is the File menu, that will show the backstage
view of the application when selected. The backstage view is
an interactive menu that contains all functions that operate on
a workspace as a whole (for example printing).

à The Home tab contains the majority of functions that pertain to
the contents of a workspace.

à The remaining tabs contain the functions implied by their title.
Insert for commands concerning inserting content into a
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workspace. Layout for workspace layout commands. Order
routing for functions concerned with order routing.

à The final tab Editor will only appear if a text editor is selected
in a workspace. This tab has all functions concerned with
editing Equilla or HTML source code and debugging Equilla
content in charts. See "Equilla Debugger" on page 401 for
more information.

à Some buttons open menus that offer further functions. You
can recognize these by the small black arrow below the
buttons.

à The arrangement of the buttons in the toolbar changes
depending on the monitor or program window size. Therefore,
either more buttons or fewer buttons (but with menu
functionality) are visible.

à For many functions, you can open a help topic. The help is
available via the key F1 if the tool tip says that there is a help
file for this feature. The help topic is then displayed in the
internal browser.

à You can toggle the Toolbar with the keyboard shortcut Ctrl +
F1, by double-clicking on a Toolbar tab or by clicking the small
arrow on the far right of the toolbar tabs. When collapsed the
toolbar can be temporarily shown by clicking on one of the
toolbar tabs.

TOOLBAR TABS AND GROUPS

The functions displayed on a Toolbar tab are further organized into named groups
to improve identification. The following groups are available by toolbar tab:

FILE TAB

Ó FILE TAB

This tab shows the backstage view, which
combines typical file operations like save and
open with interactive inline content organized
as sub menus:

Recent List of recently opened workspaces.

Print Print preview and printing.

Save & Send Functions to export the current
workspace in various ways and formats.
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Help The application Help menu, see "Using the Help Button" on page 29.

Options All application configuration options, see "Tradesignal Options" on
page 319.

HOME TAB

Ó HOME TAB

Edit The typical clipboard functions like copy
and paste.

Strategies Functions to add and augment
trading system components.

Table Functions concerning table-based elements.

Data Functions associated with searching for - and manipulating - financial data.

Chart Functions concerned with chart document.

Chart Tools Drawing tools for use in charts.

Favorites Any indicators with short codes that have been color-tagged will be listed
here.

Style Operations for creating and applying styles and templates to workspace
elements.

Find Search for items withing open workspace elements.

INSERT TAB

Ó INSERT TAB

Charts Chart-like items that can be inserted into
a workspace.

Tables Table-based items that can be inserted
into a workspace.

Trading Trading-system related elements.

Research Research tools.

Developer Developer specific tools.

LAYOUT TAB

Ó LAYOUT TAB

Layout Functions to change the layout of the
current workspace
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Monitors Options to utilize multiple monitors and to save and load different layouts
for the use of multiple monitors.

ORDER ROUTING TAB

Ó ORDER ROUTING TAB

Automatic Order Routing Functions to control and
configure automatic order routing.

Order Entry Form Access to "Manual Order
Routing" on page 317 functionality.

EDITOR TAB

Ó EDITOR TAB

Edit The typical clipboard functions like copy
and paste.

Text Editor Functions found in a typical
developer text editor

Export Options to export an Equilla script in various ways.

Find Typical search (and replace) operations.

Debug Commands to control the "Equilla Debugger" on page 401.

Breakpoints Set and manage breakpoints for use when debugging.

MINI TOOLBAR

Ó EXAMPLE OF THEMINI TOOLBAR IN A
CHART

The mini toolbar is the place to change
properties of any item quick and easy. The mini
toolbar is shown in nearly every type of charts
and tables like scanner, watch list. All changes
are applied live. Additionally, the mini toolbar is
shown in each workspace individually, also on
another desktop.

MINI TOOLBAR IN CHARTS

If you click on any item in a chart, the mini toolbar is shown automatically and the
most common used properties are adjustable right away in the mini toolbar. Most
of the properties have a tool tip which shows further information about the
property. Hex codes for colors can be edited via copy-and-paste.

Within the mini toolbar, settings are available for Symbols, such a chart type,
period and used colours, please see "Symbol Properties in the Mini toolbar" on
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the next page. For tools, settings are also available, including colors, line styles
and alerts, see "Chart Tools" on page 161. Settings are also available for
Indicators and Strategies, such as inputs, colors and line styles, see "Using
Indicators" on page 372 and "Using Strategies" on page 381. 

Ó OVERVIEWOF ALL PROPERTIES (1)
AND HIDE ELEMENT (2)

If you need an overview of all properties,
please click on the gear (1) and change the
properties as wished. The changes are also
applied live in the chart.

With a click on the little eye (2) you can hide
elements in the charts. Hidden elements are
still calculated but their output is not shown. If
the element has connected tools, the tools are
also not shown anymore. The symbol in legend of the hidden element is crossed
out. With one more click on the eye the element is shown again.

General "Settings" on page 157 and "Money Management" on page 236 are now
accessible via the Home-Tab in the "Toolbar" on page 42.

However, you can activate the deprecated property inspector in the Advanced
area of "Tradesignal Options" on page 319.

SYMBOL PROPERTIES IN THE MINI TOOLBAR

Click on the symbol name or the bars to edit the symbol properties. Depending on
the symbol in the chart, you can do the following:

à Display the trading volume and define colors for rising/falling

à Define the colors of candles, bars etc. in the chart

à Set other properties, e.g. "Open Interests" for Futures

In the mini toolbar of the symbol you can find the following parameters.

à Chart Type, see "Chart" on page 96

à Period, see "Time Spans and Periods" on page 218

à FID, field of the symbol

à Appearance of the symbol like Bullish/Bearish Colors, Line
Color

If you need an overview of all properties, please click on the gear and change the
properties as wished.
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GENERAL SETTINGS

Scale Align Select whether scales should be displayed left, right, or left and right.

Scale Labels Select whether the current price should be displayed as a special
label on the scale.

Legend Here you can set the legend (top left of the chart) to either visible or hidden
(invisible).

Display Units Here you can change the display units, e.g. with how many decimal
places or fractions the prices should be displayed. The default display unit will be
read from the symbol properties. You can customize the default display unit via
sessions.

VOLUME PROPERTIES

Volume Bars Select whether the volume should be displayed as a forest
(histogram) chart on the bottom of the chart.

Color Basis Select what should determine if a volume bar is shown as rising or
falling

Rising / Falling Color Here you can set the colors for the volume bars.

INSTRUMENT PROPERTIES
Depending on the chart type, additional parameters may be available.

FID Here you can set which fields (Last, Bid, Ask) are used for chart calculation.

Unit Here you can change the unit, e.g. Barrel, Bushel etc. Whether this option is
available depends on the used data provider.

Currency By default, the currency related to the exchange on which the symbol is
traded will be displayed; you can change the default currency to your preferred
one.

Exchange Displays the exchange at which the symbol is traded.

Data Quality Displays whether the data is realtime or delayed.

Expiry Date Displays the date, when the contract will expire.

PERCENT PERFORMANCE

In this group are "Percent Performance" on page 154 properties for a specific
symbol. This allows you to enable it only for certain symbols.
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APPEARANCE

In an additional area, you can find parameters depending on the chart type, e.g.
bullish and bearish color settings.

MINI TOOLBAR IN TABLES AND OTHER ITEMS

Ó EXAMPLE OF THEMINI TOOLBAR IN A
WATCHLIST

The mini toolbar is also used in tables like
"Scanner" on page 71, "Watchlist" on
page 77,"Correlation Matrix" on page 270 and
"Market Depth" on page 90 and other items like
"Portfolio" on page 251, "Position Manager" on
page 246 or "Optimizer" on page 274. The
handling of the mini toolbar is the same as for charts. For more information,
please check the help article of the specific item.

Ó MANAGE OBJECTS

If some settings are not part of the mini toolbar,
you find all settings via the gear in Manage
Objects in the home tab in the toolbar.

QUICK ACCESS TOOLBAR
The Quick Access Toolbar allows you to create a personalized toolbar comprised
of buttons and menus found on the various Toolbar tabs. The Quick Access
Toolbar can be displayed above or below the main Toolbar by using the option
available in the context menu by right-clicking on the Quick Access Toolbar.

ADDING ITEMS

Ó ADD TOQUICK ACCESS TOOLBAR

Items may be added to the toolbar either by

à right-clicking on the desired item in
the main Toolbar and selecting the
option Add to Quick Access
Toolbar, or
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à using the + button in the tree of commands found in the
options under File > Options > Personalize > Ribbon Toolbar

Some items may not be added to the Quick Access Toolbar. These items will
have the Add to Quick Access Toolbar option disabled in their context menu.

REMOVING ITEMS

Items may be removed from the Quick Access Toolbar by either

à right-clicking on the desired item on the Quick Access Toolbar
and selecting the option Remove from Quick Access
Toolbar, or

à using the x button on the desired item in the Toolbar Items
list found in the options under File > Options > Personalize >
Ribbon Toolbar

REORDERING AND GROUPING

Items in the Quick Access Toolbar may be reordered and/or grouped using the
Toolbar Items list in the options under File > Options > Personalize > Ribbon
Toolbar. The up and down arrows against an item may be used to reposition that
item. The Begin Group box may be checked to inset a group separator before
the selected Toolbar item.

TOOLBOX

Ó TOOLBOX

The toolbox on the lower right grants you
access to many key features of Tradesignal,
namely symbol lists, indicators, strategies,
(Equilla) functions, templates, and workspaces.

GENERAL FEATURES

CONTEXT MENUS
In all windows you can right-click on a list entry to open its context menu. There,
you can find functions like applying, editing, renaming, deleting, etc. You can also
tag list entries with colors to find themmore easily later.

RELATED TASKS AREA
Here you can find links to related tasks. These depend on the active tool.
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à For symbols, the available links are New Symbol List, New
Symbol and New Group (see the chapter "Symbol Lists" on
page 62).

à For indicators, strategies, functions and workspaces, you can
find the link New... (indicator, strategy etc.) and links for
"Package and File Management" on page 334 (New Package
and Show/Hide Packages). Packages correspond to folders
on your computer and should make tool handling easier for
you.

à Templates are saved from charts (see the chapter "Saving a
Template" on page 223), so only links for Package
Management are available here.

Note: In lower version of Tradesignal were the properties part of the toolbox which can be
shown via "Tradesignal Options" on page 319 again.

EDIT THE TOOLBOX APPEARANCE
You can also decrease and increase the number of tool buttons, as well as
completely removing tools from the toolbox. Click on the small arrow head on the
lower right to open the context menu of the toolbox. You have the following
options:

Show More Buttons Display one of the small buttons below the toolbox as a regular
tool button. You can repeat this until all tools are shown as tool buttons.

Show Less Buttons Display one of the tool buttons as small symbol button below
the toolbox. You can repeat this until all tool buttons are shown as small buttons.

Add or Remove Buttons Here you can completely suppress the display of tools in
the menu. For this, click on the respective entries in the subordinate menu to
switch the tools on or off.

Alternatively you can reduce/expand the display of the tool buttons by dragging
the separator between the button menu and the display window upwards or
downwards. For this, position the mouse cursor on the dotted grip bar above the
tool buttons so that it changes into a double arrow. Then drag the grip bar up or
down and release the mouse button when done.

REPOSITIONING TOOLBOX ELEMENTS
Toolbox buttons can be reorganized by drag-and-drop them either
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à vertically within the same list of buttons, or

à to the opposite edge of the application window, to split the
toolbox on both left and right sides

To drag all toolbox elements to the opposite side, hold the Ctrl key while dragging
a single button.

COLLAPSING AND TEMPORARILY SHOWING THE TOOLBOX
You can hide and show the toolbox by pressing the small arrow button to the right
of the toolboxes title.

To hide and show the properties window directly, press Ctrl + F2.

When the Toolbox is collapsed, it can be temporarily shown by clicking on the
collapsed toolbox in any location other than the arrow button used to restore the
toolbox.

To temporarily show a specific toolbox pane, click the corresponding icon.

DELETING AND RESTORING ITEMS
If a toolbox allows the deletion of its contents, normally using the right-click
context menu and selecting Delete. The most recently deleted item may be
restored clicking on the Unremove button that is either displayed in a yellow pop-
up at the bottom of the application window, or the Unremove link shown to the left
of the clock at the top right of the application window. Please note, only the most
recently deleted item may be restored in this way.

Note: If an item that is deleted has a corresponding file (for example workspace, indicators,
strategies, functions and templates), the deleted file will be moved to the system Recycle Bin
if it was stored on a file system that supports the Recycle Bin function.

NAVIGATING TO AN ITEM IN WINDOWS EXPLORER
If an item or folder in the Toolbox has a corresponding file (e.g. workspaces and
indicators), the right-click context menu for the item or folder will have an option
calledOpen In Windows Explorer. Clicking on this option will open the file or
folders location in Windows Explorer.

SELECTING MULTIPLE ITEMS AT ONCE
To perform an operation on multiple items at once, first select the items by either:
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à holding down the Ctrl key and clicking on each item, or

à clicking on the first item to select, then hold down the Shift
key and click on the last item to select all items between these
two items.

Once multiple items have been selected, the right-click context menu will show
only those operations that are applicable to multiple selected items. Typically
allowed operations include: deleting the selected items, moving the selected
items between folders, color tagging all the items, or opening the items in various
ways within a workspace.

AVAILABLE TOOLS IN THE TOOLBOX

SYMBOL LISTS
Here you can find the list of symbols for the available securities. Read the chapter
"Symbol Lists" on page 62 for more information.

INDICATORS
Here you can find all indicators that were delivered in the Tradesignal data folder,
as well as all indicators you may have saved in other packages. Read the chapter
Indicators for more information. A search box at the top of the pane allows
searching by title keywords or indicator short code.

STRATEGIES
Here you can find all strategies that were delivered in the Tradesignal data folder,
as well as all strategies you may have saved in other packages. Read the chapter
Strategies for more information. A search box at the top of the pane allows
searching by title keywords or strategy short code. Strategies are by default
filtered based on the content, so that e.g. are for Portfolios only Portfolio
strategies shown. To see all strategies please disable the filter at the top of the
list.

FUNCTIONS
Here you can find all functions that were delivered in the Tradesignal data folder,
as well as all functions you may have saved in other packages. Read the chapter
Functions for more information. A search box at the top of the pane allows
searching by title keywords.

TEMPLATES
Here you can find templates, in which graphical properties and information about
indicators and trading systems are saved. Via the context menu, you can directly
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call up a template. It will contain the security data with which it was originally
saved. Read the chapter "Using Templates" on page 223 for more information. A
search box at the top of the pane allows searching by title keywords.

WORKSPACES
Here you can find saved workspaces. Via the context menu you can assign up to
ten "Keyboard Shortcuts" on the next page. Read the chapter "Workspaces" on
page 31for more information. A search box at the top of the pane allows
searching by title keywords

HELP
The help is divided into categories that are displayed as main entries. Under most
main entries, sub-topics are available. At the top of the help window you can find
an input box. Here you can enter a search term for a full-text search in the help.
Alternatively, double-click on a list entry to open the topic in the browser window.
Via the context menu, you can open the help topic in a new browser window. For
this, click onOpen Link in new Browser. The new browser window is then
stacked upon the first one (see also the section Move Documents in the
Workspace).

COLOR-TAGGING ENTRIES

Except for symbols and properties, you can color-tag entries in the Toolbox.
Color-tagged entries will appear on top of the list, sorted by the three colors
yellow, red, and blue.

To assign a color tag, right-click on an entry and select Yellow Tag (red, blue)
from the context menu.

To remove the tag again, click on No Tag.

If a color-tagged indicator or strategy also has a Short Code set, this item will be
displayed in the Toolbar in the Home > Favorites group. Options to configure this
feature can be found in the options under File > Options > Advanced > Indicators
& Strategies.

DEFAULT SETTINGS

SAVING, RESTORING AND RESETTING DEFAULT SETTINGS

Ó DEFAULTS IN MINI-TOOLBAR

Saving default settings is easy possible in the
context menu of every property which have a
default setting.
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Most of the time inputs can be saved as defaults right away in the "Mini Toolbar"
on page 45. Colors are saved as default in the mini toolbar after chosen from the
color picker.

In other dialogs like "Money Management" on page 236 or "Settings" on page 157
please also save defaults via the context menu.

DEFAULT SETTINGS IN THE TRADESIGNALOPTIONS

Ó DEFAULTS IN MONEYMANAGEMENT

Not all settings can be saved like this:

à Some chart settings are done in the
"Tradesignal Options" on page 319,
like the history length, the default
chart type etc.

à The standard period and other user
interface settings are entered in the
Tradesignal Options.

Some settings also do not make much sense
as a default, like the value for a stop line.

To restore the original default settings of your Tradesignal installation, click on the
Restore Default Settings button in the Tradesignal Options.

KEYBOARD SHORTCUTS
Many functions in Tradesignal can be called up by using keyboard shortcuts. You
can find a complete list of all shortcuts in the following tables.

GENERAL APPLICATION

Description Keyboard
Shortcut

Help F1

Jump to Command Line F2

Start Symbol Search F3

Start Print Preview Ctrl + P

Open / Close the toolbar Ctrl + F1

Delete text, documents, or elements in documents Del
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NAVIGATING IN THE CHART

Description Keyboard
Shortcut

Move up value axis
Arrow up or
Alt + mouse
wheel up

Move down value axis

Arrow down
or Alt +
mouse
wheel down

Move date axis to the right
Arrow right
or mouse
wheel up

Move date axis to the left
Arrow left or
mouse
wheel down

Zoom in value axis

Shift +
Arrow up or
Alt + Shift +
mouse
wheel down

Zoom out value axis

Shift +
Arrow down
or Alt + Shift
+ mouse
wheel up

Zoom out date axis

Shift +
Arrow right
or Ctrl +
mouse
wheel down

Zoom in date axis

Shift +
Arrow left or
Ctrl +
mouse
wheel up

Page up value axis Ctrl + Arrow
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Description Keyboard
Shortcut

up

Page down value axis
Ctrl + Arrow
down

Page date axis to the right
Ctrl + Arrow
right

Page date axis to the left
Ctrl + Arrow
left

Toggle between subcharts
Page up /
Page down

Jump to the beginning of the chart Pos1

Jump to the end of the chart End

Magnetic mode for drawing tools F6

Show standard time span F8

Show complete time span Shift + F8

WORKSPACES

Description Keyboard
Shortcut

Arrange workspaces F9

Go to previous workspace Ctrl + Q

Go to next workspace Ctrl + W

Toggle between full view (maximized) and normal view F4

Reload data (e.g. chart, scanner, browser) F5

Reload data for all workspace elements Ctrl + F5

Go to next workspace element Ctrl + Tab

Go to previous workspace element
Ctrl + Shift +
Tab

Open new workspace Ctrl + N
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Description Keyboard
Shortcut

Create new Equilla strategy
Ctrl + Shift +
N, S

Create new Equilla indicator
Ctrl + Shift +
N, I

Create new Equilla function
Ctrl + Shift +
N, F

Open dialog for opening workspaces or packages Ctrl + O

Save workspace Ctrl + S

Close active workspace element Ctrl + F4

Close active workspace
Ctrl + Shift +
F4

CLIPBOARD

Description Keyboard Shortcut

Select all (for text, Equilla code,
tables)

Ctrl + A

Copy selected document, text, Equilla
code or table element

Ctrl + C

Cut selected document, text, Equilla
code or table element

Ctrl + X

Insert clipboard contents into active
document

Ctrl + V

Repeat last clipboard action Ctrl + Y

Undo last clipboard action Ctrl+ Z

PROGRAMMING AND DEBUGGING

Description Keyboard Shortcut

Compile Equilla code F7

Toggle comments for the selected
code

Ctrl + K, C
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Description Keyboard Shortcut

Search for text Ctrl + F

Search and replace text Ctrl + H

Jump to a specific line Ctrl + G

Pause debugger Pause

Resume debugger F5

Restart debugger Ctrl + Shift + F5

Step over F10

Step in F11

Step out Shift + F11

Quick watch Shift + F9

Toggle breakpoint F9

Enable/disable breakpoint Ctrl + F9

Open related function F12

Save indicators, strategies or Equilla
functions

Ctrl + Shift + S

Show all available functions Ctrl + Space

Show all available variables for a
function

Ctrl + Shift + Space
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FINDING AND HANDLING SYMBOLS

SYMBOL SEARCH
The symbol search is a useful tool to keep an overview of all the securities
available on markets around the world.

QUICK SYMBOL SEARCH

Ó QUICK SYMBOL SEARCH

A quick symbol search is accessible above of
the "Symbol Lists" on page 62 in the "Toolbox"
on page 49 on the right side. The search finds
symbol folder as well as single symbols. First
please select the datafeed where you want to
search the symbol.

In addition, a filter can be applied to the results:
Automatic, Commingled - All Venues,
Commingled - Cleared and Non-Commingled.

SYMBOL SEARCH IN THE TOOLBAR

Ó SYMBOL SEARCH BUTTONMENU

The following options are directly available
from the Symbol Search button menu:

à Add Symbol Search for a single
symbol or assemble symbol lists with
securities of similar categories, see
below.

à Add Formula Symbol Add a symbol based on an Equilla
formula, see "Create Formula Symbols" on page 67.

à Add User-defined Continuation Symbol See "User-defined
continuations" on page 84

à Add Rolling Forward Symbol  See also "User-defined
continuations" on page 84. (For this option to be available,
you need to have a DataConnect-based feed.)

à Add Combined Symbols Assemble a new symbol from
several existing symbols, see "Create Combined Symbols" on
page 68.
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Ó SYMBOL SEARCH

THE LOOKUP SYMBOL WINDOW
There are several ways to open this window:

à Click the Symbol Search button in
the toolbar and select Add Symbol.

à Press F3.

à Open the context menu of a symbol
list and select the entry New
Symbol, then the option Standard
Symbol.

à In the toolbox, select the datafeed and type in your search
term. You can use the whole name or even only parts of it.

The Lookup Symbol window opens in which you can further define your search terms.
Please note that the available search options depend on the used data provider.

Ó SYMBOL ACTIONS

USING THE SEARCH RESULT

In the next window, you have the choice of
actions to perform with the symbol. Note that
depending on the selected symbol, not all
actions might be available.

In principle, you can open the following new
documents: "Chart" on page 96, "Forward
Curve" on page 153, "Seasonal Chart" on
page 155, "Market Depth" on page 90.

Alternatively, you can insert the symbol into the
selected element of the workspace, e.g. a chart. This can be done in the following
four ways:

Insert the symbol into the selected workspace item Select this to add the found item as
a second symbol in a chart, for example.

Insert the symbol into the selected workspace item with a new date scale Select this to
add the new symbol, for example as a subchart with its own date scale.

Replace the symbol in the selected workspace item Select this to substitute the new
symbol for the original symbol.

Replace all symbols in the selected workspace item Select this to substitute the new
symbol for the original symbols, for example in several charts.
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ADDING A FORMULA SYMBOL

Ó ADDING A FORMULA SYMBOL

To start adding a symbol based on an Equilla
formula, click the Symbol Search button in the
toolbar and select Add Formula Symbol.

Enter the template, a name, and two legs.

After clicking Ok, the Symbol action window
opens. Depending on the selected instruments,
not all actions might be available.

Note: Please keep in mind these symbols are not
automatically saved in your symbol lists.

ADDING USER-DEFINED CONTINUATION AND ROLLING
FORWARD SYMBOL

To create a user-defined continuation or rolling forward symbol right-away via the
symbol search, please use these options. For more information about the
creation of these symbol types, please see "User-defined continuations" on
page 84.

Note: Please keep in mind these symbols are not saved automatically in your symbol lists.

ADDING COMBINED SYMBOL

To create a combined symbol right-away via the symbol search, please use this
option. For more information about combined symbols, please see "Create
Combined Symbols" on page 68.

Note: Please keep in mind these symbols are not automatically saved in your symbol lists.
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SYMBOL LISTS

Ó SYMBOL LISTS

Symbol lists include the symbols and names of
traded securities. A symbol list corresponds to
a category, a branch or index or is assembled
by the trader. You can use the symbol lists for
the following:

à As an "extended memory" for a high
number of symbols

à Sorting symbols according to
branches, countries or other criteria

à As a basis for "Chart" on page 96,
"Scanner" on page 71 and other
documents

à For filing symbols from the Scanner
or "Symbol Search" on page 59

à For filing formulas or other
calculations with which to generate
charts

Tradesignal offers a symbol list manager in
which you can administrate and sort a large
number of lists. You can find it in the toolbox
under the Symbol Lists button.

Since single symbols are always managed as part of a symbol list, the special
functions for those are also described in this chapter, see "Starting a New Symbol
List" below.

Note: Symbol lists that can be reloaded are indicated by the Reload Icon .

STARTING A NEW SYMBOL LIST

When starting Tradesignal for the first time, you are asked if you want to receive
lists from your data provider. If you confirm this, you will use the Symbol List
wizard for the first time. However, you can start the wizard any time to create a
new list.
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01. In the toolbox, click the Symbol Lists button.

02. Select the top entry for your own symbol lists. New symbol
lists can only be created below this folder.

03. In the Related Task area, click on New Symbol List.

The Symbol List wizard opens. Two options are available:

Search for a predefined symbol list Receive standard lists, for example NASDAQ
indexes.

Manually create a symbol list (or import from a file) Start a new, empty symbol list to
which you can add symbols or symbol lists, also by importing.

The New Symbol List window opens.

Ó ADD SYMBOL TO SYMBOL LISTS

Use Search to start the "Symbol Search" on
page 59.

Alternatively, you can:

Import symbols from a local symbol list... Import a
local symbol list.

Import symbols from a CSV... Import a symbol list
from a file in CSV format (comma separated
values) or XML format. The expected
separators for CSV in Tradesignal are comma
or semicolon. One way to create files in such a format is to save your data in
Excel as CSV text file or use export on a symbol list.

Select the option List contains future contracts if this is the case, to enable features
like "Forward Curve" on page 153 and "Seasonal Chart" on page 155.

MANAGING SYMBOLS AND SYMBOL LISTS

EDITING VIA THE CONTEXT MENU
You can manage Symbols and Symbol Lists with the functions offered in the
context menus.

à Open single symbols in a "Chart" on page 96, "Scanner" on
page 71, "Portfolio" on page 251, "Watchlist" on page 77,
"Market Depth" on page 90, "Market Profile" on page 148 or
"News" on page 365.

à Open a symbol list in a Scanner, Watchlist or Portfolio.
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à You can open a symbol from a list in an "Equilla Editor" on
page 399 as long as it is a composite symbol.

à You can add a new symbol to your existing list.

à A symbol list can be refreshed. This option is only available
for predefined symbol lists from the data provider. Tradesignal
will update changes of the predefined lists after restart of the
application, unless you do a manual refresh.

à You can rename a symbol or symbol list.

à You can delete a symbol or symbol list from the list.

à You can duplicate a list. A one-to-one copy will be created,
which can be modified and renamed.

à You can print a symbol or symbol list. With this function, all
information for each symbol is printed. This can take a while if
you print a long list of symbols. For more information, see the
chapter "Publish to Office" on page 346.

à SelectOptimize to start the optimizer for the symbol or
symbol list. This starts the "Optimizer" on page 274. In the
case of a symbol list, all symbols included in the list will be
optimized. The results will be displayed in a table, sorted by
total net profit.

à You can also sort a symbol list, see the section "Sorting
Symbol Lists" on page 66.

à You can export a symbol list in either CSV or XML format.
The XML format supports all symbol types, whereas CSV only
supports standard symbols.

à When you select the option List contains future contracts,
the optionsOpen in Forward Curve andOpen in Seasonal
Chart become available. For these to work, all symbols in the
list need to have an expiry date.

Note: Shared symbol lists are read-only.

ADD A SYMBOL TO A SYMBOL LIST
Single symbols are always managed in symbol lists. Therefore please create at
first a symbol list where you can create a new symbol. If there is no symbol list in
the folder, Tradesignal creates a new default symbol list automatically, see "Drag-
And-Drop and Copy-And-Paste Symbols" on the next page. To add a new
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symbol, open the context menu of a symbol list and select New Symbol. The New
Symbol menu opens. It shows the same options as the "Symbol Search" on
page 59.

New Symbol A standard symbol from the data provider.

New Formula Symbol A composite symbol calculated from a formula. This way you
can add a formula, which refers to other securities, as a symbol itself. You can
find more information below in the section "Create Formula Symbols" on page 67.

New User-Defined Continuation Here you can set up continuations for futures in
which the history of the instrument is continuously growing by adding each new
contract's history on rollover. For more information see the chapter "User-defined
continuations" on page 84.

New Rolling Forward Symbol Here you can set up continuations for futures in which
the history of the instrument is replaced completely by the history of the new
contract. The option is only available for DataConnect-based feeds. For more
information see the chapter "User-defined continuations" on page 84.

New Combined Symbol This option allows you to create a combination of standard
symbols, e.g. the same security traded on multiple exchanges. For more
information see the section "Create Combined Symbols" on page 68.

DRAG-AND-DROP AND COPY-AND-PASTE SYMBOLS

à Symbols have to be part of a symbol list. If you move a symbol
via drag-and-drop into a folder without a symbol list,
Tradesignal creates automatically a default symbol list in this
folder. These default symbol lists are always shown at the top
of the folder and automatically expanded, when the folder is
used. The name of the symbol list is fix and is only updated,
when the folder itself gets renamed.

à You can move single symbols into another symbol list by
drag-and-drop or copy-and-paste.

à You can drag a symbol into a document in the workspace, for
example to add the symbol to a Scanner table.

à Drag a symbol into an existing chart to create a subchart or
drag a symbol while holding CTRL to replace the chart.

à You can also go the other way round and drag a symbol from
an open document (like a Chart, Scanner, Watchlist or
Portfolio) into a symbol list. To do this, click into the chart
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legend or - in case of tables - click into a table cell until a plus
symbol and a rectangle appear under the mouse cursor. Then
drag the symbol into the symbol list.

à If you drag a symbol to an open editor, its symbol shortcut will
be inserted enclosed in single quotes. This can be used for
"Inline Instruments and Data Inputs" on page 431.

DRAG-AND-DROP AND COPY-AND-PASTE SYMBOL LISTS

à Symbol lists can be moved between folders. To do this, simply
drag the list into the target folder. You can even copy-and-
paste symbol lists.

à Symbol lists can also be dragged into an open Scanner,
Watchlist or Portfolio. They can also be dragged to an open
Chart, this will open all contained symbols.

à If you drag a symbol list to an open editor, its symbol list
shortcut will be inserted in double quotes. This can be used
for lists of Equilla inline instruments. For further details see the
Equilla help in Tradesignal.

SETTING UP A SYMBOL LIST WITH SEVERAL SYMBOLS
When creating a new symbol list, you can add symbols in the process.

01. In the symbol list manager, click on the folder in which the new
list should be created.

02. Select New Symbol List in the context menu of the folder. The
Symbol List wizard opens.

03. Enter a name for the list and click the Add button to start the
symbol search for finding and adding symbols.

SORTING SYMBOL LISTS
You can sort a symbol list in two ways.

à Sort from A-Z via the entry Sort in the context menu of a
symbol list.

à Sort manually by dragging the symbol to another position in
the list.

A changed order only affects the current symbol list, not all.
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CREATE NEW FOLDER
When you are handling many different symbol lists, it may be useful to structure
them further. To do so, create new folders in your symbol list area by clicking on
New Folder in the Related Task area.

CREATE FORMULA SYMBOLS

Ó CREATING A FORMULA SYMBOL

Formula symbols (previously called "composite
symbols)" are artificial instruments calculated
from Equilla formulas that refer to other
symbols. You can save formula instruments as
symbols if the relevant references to symbols
and their prices are included in the formulas.

à For a simple formula instrument, a
formula can be entered directly into
the command line to create a new
chart.

à To create a more formula instrument, choose New Symbol in
the context menu of a symbol list and select New Formula
Symbol. Enter the Equilla code and a name. The new formula
symbol is added to the current symbol list.

à If symbols in the symbol toolbox are selected, these symbols
will be filled into the templates when creating a new formula
symbol. The order will be the same as the order of the
selection.

In Tradesignal you can use the symbol picker to quickly add a symbol to the
formula as an inline instrument.

EXAMPLE FOR A SIMPLE FORMULA SYMBOL
We want to calculate the difference between the open and close of each trading
period. The Equilla code for this is

Open - Close

Since we want to save the formula as a formula symbol in a symbol list,
references to a security have to be included in the formula, for example .DJI (Dow
Jones Industrial). The resulting code is

Open .dji - Close .dji
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Enter this formula in the Command Line and select the option New Formula Chart
in the drop-down menu. The formula is instantly calculated and ready for use.
Save the formula as a symbol by dragging its name from the chart legend into a
symbol list.

Example for a more complex formula symbol

The following code would result in a formula symbol that includes the spread
between the Intel symbol and the Dow Jones Industry index.

Variables: openRatio, closeRatio;

openRatio = Open of 'intc nas' / Open of '.dji';
closeRatio = Close of 'intc nas' / Close of '.dji';

DrawForest( openRatio, closeRatio );

Copy this code into the editor window of a composite instrument, enter a name,
and generate the symbol. Afterwards you can display the spread by calling up the
composite symbol.

CREATE COMBINED SYMBOLS

Ó CREATING A COMBINED SYMBOL

Combined symbols are synthetic instruments
created by combining the input values of an
ordered list of standard symbols and cumulated
to a target period from a specified base period.

A combined symbol is very useful when you
have a similar product traded at multiple
different sources (e.g. Forex and Commodity
Brokers) and you would like a combined view of
the whole market for that product.

In the editor you can define the instruments
with the used field for the combined symbol. You can use any field which is
provided by the datafeed.

When a combined symbol is created, a base period must be specified, the data
from this base period for each of the component symbols will be combined to
make the new instrument. Obviously, for periods other than tick there is likely to
be some overlapping of data; in this case the values from the component symbol
that is specified earlier in the list will be used.

It is recommended to only use tick as a base period when absolutely necessary.
The calculation time of the composite will be excessively long and it is unlikely
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there will be a suitable quantity of tick data to create a daily chart of reasonable
length.

At the end you can define a custom session for the combined symbol.

CREATE MULTI-VENUE SYMBOL LISTS

Ó CREATINGMULTI-VENUE SYMBOL
LISTS

The Multi-Venue Symbol List dialog allows an
entire set of lists of combined symbols and
continuations for a related set of products to be
easily created in a single action.

Note: Multi-Venue Symbol Lists are only available for the
datafeed Trayport Trading Gateway (TGW).

To create a set of multi-venue symbol lists:

01. Right-click on the top folder My Symbol Lists and select
Create Multi-Venue Symbol Lists to show the Multi-Venue
Symbol List dialog

02. For each venue, click Click here to add a new
product/venue... and select the products from each venue to
aggregate

03. Choose a combined product name for the resulting symbols

04. Specify how many continuation symbols should be
generated (the default is normally sufficient)

05. Choose a fallback cumulative period (what period data to use
to combine the various instruments, the default option is
normally sufficient)

06. Select if individual contracts should be generated in addition
to continuations (available from version 8)

07. Select how many expired contracts should be generated
(available from version 8)

08. Select which contract periods to generate symbols for

09. ClickOK to generate the symbol lists

Note: Generating the lists may take some time.
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To edit the generated lists (for example to add another venue), right-click on the
root folder of the multi-venue lists, in the symbol lists sidebar, and select Edit.

SYMBOL REPLACEMENT

Ó REPLACE SYMBOL VIA SYMBOL LISTS

Symbols can be easily replaced by any symbol
via the context menu Replace Symbol in the
symbol search/list or using the command line.

SPECIAL REPLACEMENT
OPERATIONS FOR JOULE
SYMBOLS

Ó REPLACE PRODUCT

Tradesignal offers special replacement
operations for Joule symbols. As Joule
symbols all use the same logic, you can
replace parts of it like the product or replace a
single contract with a compatible rolling
contract.

Select Replace > Replace Product, Replace >
Replace Calendar Period or Replace > Replace
Rolling in the context menu of the symbol.

For each replacement action you gets a
separate wizard. Each wizard shows you the
compatible replacements like other gas symbols for the product or other periods
for the calendar period.

Ó REPLACE CALENDAR PERIOD

If one symbol is used multiple times in the
same workspace, you can perform a bulk
replacement operation for the other instances
of the same symbol at once. Activate the check
boxes of the additional symbols in the lower
section.

For spreads you can also replace the legs.
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SCANNER

Ó SCANNER

A Scanner (also sometimes called screener) is
used for searching large symbol lists according
to defined criteria. You can use the Tradesignal
Scanner for:

à Searching certain indicator
constellations in symbol lists

à Searching for chart patterns in
symbol lists

à Searching for technical analysis patterns in price lists

à Backtest of trading systems for several symbols

à Obtaining statistical data like annual high in price lists

à Optimizing trading systems based on a group of symbols

The easiest application, for example, is using the Scanner to search a certain
constellation of indicators. Use a relative strength indicator (RSI) > 70 to find the
strongest symbols in a list.

The document type scanner has the following design parameters:

à The maximum history length is 5000.

à The maximum number of instruments is 5001.

à The maximum number of indicators/strategies is 32.

à Indicators and strategies are processed sequentially, i.e. they
are applied in the given sequence to each instrument, before
the next instrument is processed.

STARTING THE SCANNER

You can fill the Scanner with symbols in various ways.

à Click on the Scanner button in the Insert tab of the toolbar.

à Open the context menu of a symbol list in the toolbox and
choose the entryOpen in Scanner.
The Create new Scanner wizard opens, in which you can select indicators
and strategies in two more steps. (If selecting this for a single symbol, it
opens without a wizard.)

Click on Finish to close the wizard and save the settings.
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ADDING ONE OR MORE SYMBOLS MANUALLY
You can also add single symbols or open a new market scanner without using the
wizard.

01. Open the context menu of a symbol or symbol list in the
toolbox and choose the entry Insert Symbol to add it to the
active market scanner.

02. In the command line, enter a symbol shortcut, e.g. "DD NYS"
and select Add Symbol to add it to a scanner, or New Market
Scanner for a new one.

03. Via the "Symbol Search" on page 59. For this, click on the
search button and select Insert the symbol into the
selected workspace item to add it to the scanner, or Create
a new Market Scanner for a new one.

Tip: You can also add symbols to a scanner via drag-and-drop from the toolbox or other
documents.

The History Length (candles/bars) that is regularly taken into account is 3. When
you add an indicator, the length may be increased if necessary for the indicator
calculation. E.g., the Chande Momentum Oscillator sets the length to 16. If you go
below this necessary length, indicators may not give results anymore. In this
case, increase the length again.

When you select a symbol list (e.g. the Nasdaq), please ensure that the index
itself is not included in the Scanner. It makes no sense to include an index in a list
of symbols when scanning for optimal trading parameters. (It is different if you
trade in certificates and the scanner is filled with index values.)

SCANNER PROPERTIES

The properties for the scanner are available via "Settings" on page 157 in the
home tab. Important parameters are:

History Length Enter the length of the history here (max. 5000).

Only Closed Bars Set to "True" if only closed bars should be used. The default is
"False". This option is useful in daily periods to ensure the scan uses the data
from the close of the prior session for all instruments. When using indicators with
lower period inline data, it will most likely be necessary to increase the Scanner's
history length, to ensure there is sufficient intraday data to span back to the prior
session.
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Min. Referenced Bars Enter the minimum number of bars that should be used for
calculating the values of indicators and strategies.

With a click on the row of an indicator or symbol, the "Mini Toolbar" on page 45 for
the selected item is shown. Changes in the mini toolbar are applied live in the
watchlist.

DELETING SYMBOLS FROM A SCANNER

You can delete symbols from a scanner.

01. Select the symbols. You have the following options:

à Press Ctrl+A to select all.

à Press Ctrl and click on single instruments to
select them.

à Press Shift and click on two instruments to
select the instruments between them..

02. Press the Del key to delete the selected instruments.

SCANNER BUTTONS IN THE TOOLBAR

Start Scan Start the Scanner.

Stop Scan Stop the scanning process. All table fields filled at this point are saved.

Period Here you can set the period that is to be used in the Scanner (this
corresponds to the period settings for a chart). The symbols in the Scanner are
always called up with the default period at first.

Columns Open the menu for the column settings of the Scanner.

Set Group Here you can group the parameters for better overview. Select a
number of rows in the table and click on the button. You can now enter a name for
the group. A button appears on top of the table that allows you to open/close the
group views like a folder tree in Windows Explorer.

COLUMNS IN THE SCANNER

The table shows different columns depending on the indicators and strategies
you are using. The number of columns added for each indicator or strategy
depends on the number of output data.

à For each indicator, all columns with a non-static output are
displayed. For example, for the "Bollinger Band" indicator
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there are three columns, for the "Elder Ray" indicator two
columns (and two invisible columns with static values).

à For strategies, the two columns "Position" and "Position Size"
are displayed over all strategies. The parameters of the single
strategies are usually set to invisible in the Equilla code
("visuals" are "inactive"). If they were displayed, they might
also interfere with the statistics, which is usually not desired.
When at least one strategy is available, you can add columns
for statistical output like "Total Net Profit".

SORTING THE COLUMNS
You can sort the columns in the scanner by clicking on the column header. A little
triangle appears, pointing up or down depending on the sorting direction. To
change the direction, click on the column header again.

Alternatively, right-click into the column and select the sort direction in the context
menu.

COLUMN GROUPING
This function in the Columns button menu leads to a new row in the table top. If
groups are already defined, a button appears for them.

You can start a group by dragging a table row in this new row at the table top, or
by selecting a row and clicking on Set Group in the toolbar under Home > Table >
Columns.

ADD/REMOVE COLUMNS

With this function in the Columns button menu, you can set columns in the table to
visible or invisible.

In the list, all available columns are sorted by categories. Standard columns like
price or symbol information are available; so are a large number of statistical
values for trading systems. If an indicator offers additional information, it appears
as an entry here too.

Select the entries for all columns you want to display, or click on Show All to
select all entries.

MANAGE STRATEGIES AND INDICATORS
With this function in the Columns button menu, you can
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à set the processing order of the selected indicators and
strategies. To do so, select an entry and click the Move
up/Move down buttons. The indicators and strategies are
applied in this order to every single symbol (sequential
processing).

à remove indicators or strategies from the scanner by selecting
them and clicking the Remove button.

FORMATTING OPTIONS

In the Scanner, the following buttons are available in the toolbar.

Styles Here you can set the display options of the table, e.g. gray background with
orange and yellow text.

Sessions Here you can set the trading times. You can find more information in the
chapter "Sessions, Holidays and Properties" on page 508.

Price Editor Here you can manually edit prices of symbols. You can find more
information in the chapter "Price Editor" on page 523.

SCANNING RESULTS

The Scanner fills the table with the results from the indicators for all symbols in
the table. This may take awhile. If you stop the scanning while it is in progress, the
results up to that point are saved and available in the table.

FILTERING RESULTS
To get a better overview of important results, you can filter the scan result display.

à Click on the Edit Filter button in the toolbar under Home >
Table > Filter to open the menu for the filter criteria. There,
you can set up e.g. a filter with which you search for an RSI >1
to find the strongest symbols.

Tip: You can find more information in the chapter "Filter" on page 94.

USING THE RESULTS WITH DRAG-AND-DROP

USING SYMBOLS IN ANOTHER TABLE
You can reuse symbols from a Scanner in a Watchlist, a Portfolio or another
Scanner.
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à If you want to start with a new table, open one by clicking the
button Scanner (or Portfolio or Watchlist) in the Insert tab of
the toolbar and closing the wizard with Done.
An empty table is opened.
Alternatively, you can use existing tables.

à In the Scanner, click into a table cell of the symbol you want to
reuse. A little plus sign and a rectangle appear under the
mouse cursor. Now drag the cursor into the other table. The
symbol is copied into the table.

In a similar way, you can drag symbols from a Portfolio or Watchlist into a
Scanner.

SAVING SYMBOLS IN A SCANNER AS SYMBOL LIST
From within the Scanner, you can save interesting symbols as a new symbol list.

01. To save the symbols as a new list, click on the entry New
Symbol List in the Related Tasks area of the symbol
manager in the toolbox. Choose the option User-Defined
Symbol List and name the list but keep it empty.

02. In the Scanner, click into a table cell of the symbol you want to
reuse. (By pressing Shift or Ctrl while clicking with the
mouse, you can select more than one row.)
A small plus sign and a rectangle appear below the cursor.

03. Since a first click opens the properties tab, click again on the
button Symbol Lists in the toolbox to open the symbol
manager.

04. Drag the selected symbols to the new symbol list. The
symbols are added to the list.

OPENING A CHART FROM THE SCANNER AND PAGE THROUGH
CHARTS
To view the chart for a symbol from within the Scanner, open the context menu of
the table row and selectOpen for the entry Chart. The Chart is drawn with the
history length and period of the Scanner and includes all indicators and strategies
you have set up in the Scanner. The Chart will be linked automatically to the
Scanner via symbol linking.

If you want to go through the whole list of symbols in a Scanner to see each chart,
use the small, green arrow buttons to the right of the Command Line. As soon as
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you open one chart of a Scanner entry, you can page through the full list of
symbols this way.

EXPORTING SCANNER DATA
The table contents of the Scanner can be copied to other programs.

Tip: For more information, see the chapter "Publish to Office" on page 346.

EXAMPLE: HOW TO FIND THE STRONGEST VALUES IN THE
NASDAQ

The following parameters can be used for finding the strongest Nasdaq values
with the Scanner.

Symbol list:

à All symbols of the NSD.X (take care that the index itself is not
part of the list)

à History Length in the chart properties to "500"

Indicator:

à Relative Strength Levy with Period 100 days

Start the scanner for the symbols. After the scanning process, sort the table by
the RSL column by clicking the RSL column header (if necessary, repeat until the
sorting direction is correct). At the top, the strongest Nasdaq value should be
displayed.

WATCHLIST

Ó WATCHLIST

TheWatchlist in Tradesignal offers various
functions for monitoring stocks in realtime. It is
especially helpful for monitoring "ticking"
instruments, i.e. instruments with currently
changing quotations. Delayed instruments will
also be updated automatically.

Watchlists are useful for:
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à monitoring symbol lists for their current price development

à monitoring symbol lists for certain constellations of indicators
and trading systems

à receiving alerts via mail or acoustic signal when pre-defined
triggers are set off

With the Tradesignal Watchlist, you get an overview of symbol data in easily
manageable tables. Starting from them, you can open symbol charts and page
through them for the whole symbol list. The cells with the latest changed values
are displayed with colored background.

The document type Watchlist has the following design parameters:

à The maximum history length is 5000.

à The maximum number of instruments is 501.

à The maximum number of indicators/strategies is 32.

à Indicators and strategies are processed sequentially, i.e. they
are applied in the given sequence to each instrument, before
the next instrument is processed.

WATCHLIST SETUP

You can open aWatchlist with symbols in various ways.

USING THE WIZARD
When choosing one of the following methods, the wizard will open:

à Click on theWatchlist button in the Insert tab of the toolbar.

à Open the context menu of a symbol list in the toolbox and
choose the entryOpen in Watchlist. (If selecting this for a
single symbol, it opens without a wizard.)

The Create Item wizard opens, in which you can select indicators and strategies in two more steps.
Click on Done to close the wizard and save the settings.

ADDING ONE OR MORE SYMBOLS MANUALLY
You can also add single symbols or open a newWatchlist without using the
wizard.

à Open the context menu of a symbol or symbol list in the
toolbox and choose the entry Insert Symbol to add it to the
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active Watchlist.

à In the command line, enter a symbol shortcut, e.g. "DD NYS"
and select Add Symbol to add it to the active Watchlist, or
NewWatchlist for a new one.

à Via the "Symbol Search" on page 59. For this, click on the
search button and select Insert the symbol into the selected
workspace item to add it to the Watchlist, or Create a new
Watchlist for a new one.

Tip: You can also add symbols to a Portfolio via drag-and-drop from the toolbox or other
documents.

The History Length (candles/bars) that is regularly taken into account is 3. When
you add an indicator, the length may be increased if necessary for the indicator
calculation. E.g., the Chande Momentum Oscillator sets the length to 16. If you go
below this necessary length, indicators may not give results anymore. In this
case, increase the length again.

When you select a symbol list (e.g. the Nasdaq), please ensure that the index
itself is not included in the Watchlist. It makes no sense to include an index in a list
of symbols when searching for optimal trading parameters. (It is different if you
trade in certificates and the Watchlist is filled with index values.)

WATCHLIST PROPERTIES

The properties for the watchlist are available via "Settings" on page 157 in the
home tab. Important parameters are:

History Length Enter the length of the history here (max. 5000).

Min. Referenced Bars Enter the minimum number of bars that should be used for
calculating the values of indicators and strategies.

In the Indications area, you can enter the colors for changing values in the table.

Update Indications Set the background color for table cells with values that
changed since the last update, e.g. gray. Up Move and Down Move – Set the
colors for increasing/decreasing values, e.g. green for up, red for down.

With a click on the row of an indicator or symbol, the mini toolbar for the selected
item is shown. Changes in the mini toolbar are applied live in the watchlist.

DELETING SYMBOLS FROM A WATCHLIST
You can delete symbols from aWatchlist.
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Select the symbols. You have the following options:

à Press Ctrl+A to select all.

à Press Ctrl and click on single instruments to select them.

à Press Shift and click on two instruments to select the
instruments between them..

à Press the Del key to delete the selected instruments.

PLACING ORDERS
To place orders directly from the watchlist, through "Manual Order Routing" on
page 317, click Order Entry Form from the context menu and click the desired
option.

WATCHLIST BUTTONS IN THE TOOLBAR

Period Here you can set the period that is to be used in the Watchlist (this
corresponds to the period settings for a chart). The symbols in the Watchlist are
always called up with the default period at first.

Columns Open the menu for the column settings of the Watchlist. For activation or
deactivation of several columns select the columns and use check or uncheck at the
bottom.

Set Group Here you can group the parameters for better overview. Select a
number of rows in the table and click on the button. You can now enter a name for
the group. A button appears on top of the table that allows you to open/close the
group views like a folder tree in Windows Explorer.

COLUMNS IN THE WATCHLIST

The table shows different columns depending on the indicators and strategies
you are using. The number of columns added for each indicator or strategy
depends on the number of output data.

à For each indicator, all columns with a non-static output are
displayed. For example, for the "Bollinger Band" indicator
there are three columns, for the "Elder Ray" indicator two
columns (and two invisible columns with static values).

à For strategies, the two columns "Position" and "Position Size"
are displayed over all strategies. The parameters of the single
strategies are usually set to invisible in the Equilla code
("visuals" are "inactive"). If they were displayed, they might
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also interfere with the statistics, which is usually not desired.
When at least one strategy is available, you can add columns
for statistical output like "Total Net Profit".

SORTING THE COLUMNS
You can sort the columns in the Watchlist by clicking on the column header. A
little triangle appears, pointing up or down depending on the sorting direction. To
change the direction, click on the column header again.

Alternatively, right-click into the column and select the sort direction in the context
menu.

COLUMN GROUPING
This function in the Columns button menu leads to a new row in the table top. If
groups are already defined, a button appears for them.

You can start a group by dragging a table row to this new row at the table top, or
by selecting a row and clicking on Set Group in the toolbar under Home > Table >
Columns.

ADDING/REMOVING COLUMNS
With this function in the Columns button menu, you can set columns in the table to
visible or invisible.

In the list, all available columns are sorted by categories. Standard columns like
price or symbol information are available; so are a large number of statistical
values for trading systems. If an indicator offers additional information, it appears
as an entry here too.

Select the entries for all columns you want to display, or click on Show All to
select all entries.

MANAGE STRATEGIES AND INDICATORS
With this function in the Columns button menu, you can

à set the processing order of the indicators and strategies by
selecting an entry and clicking on Sort Ascending or Sort
Descending. The indicators and strategies are applied in this
order to every single symbol (sequential processing).

à delete indicators and strategies by selecting an entry and
clicking on Remove.
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FORMAT OPTIONS

In the Watchlist, the following Format buttons are available in the toolbar.

Styles Here you can set the display options of the table, e.g. gray background with
orange and yellow text. You can find more information in the chapter "Styles" on
page 224.

Sessions Here you can set the trading times. You can find more information in the
chapter "Sessions, Holidays and Properties" on page 508.

Price Editor Here you can manually edit prices of symbols. You can find more
information in the chapter "Price Editor" on page 523.

ANALYZING THE WATCHLIST RESULTS

The watchlist shows a table of the results of the indicator analysis over all
symbols in the list. The data is displayed in real time. Therefore, it is not
necessary to explicitly scan the Watchlist to see the current data.

OPEN A CHART FROM WITH THE WATCHLIST AND PAGE
THROUGH CHARTS
To view the chart for a symbol from within the Watchlist, open the context menu of
the table row and selectOpen for the entry Chart. The chart is drawn with the
history length and period of the Watchlist and includes all indicators and
strategies you have set up in the Watchlist. The Chart will be linked automatically
to the Watchlist via symbol linking.

If you want to go through the whole list of symbols in a Watchlist to see each
chart, use the small, green arrow buttons to the right of the Command Line. As
soon as you open one chart of a Watchlist entry, you can page through the full list
of symbols this way.

USING AND REUSING THE RESULTS WITH DRAG-AND-DROP
You can reuse symbols from aWatchlist in a Portfolio, a Scanner or another
Watchlist.

If you want to start with a new table, open one by clicking the buttonWatchlist (or
Scanner or Portfolio) in the Insert tab of the toolbar and closing the wizard with
Done. An empty table is opened. Alternatively, you can use existing tables.

In the Watchlist, click into a table cell of the symbol you want to reuse. A little plus
sign and a rectangle appear under the mouse cursor. Now drag the cursor into
the other table. The symbol is copied into the table.
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In a similar way, you can drag symbols from a Scanner or Portfolio into a
Watchlist.

SAVING SYMBOLS IN A WATCHLIST AS SYMBOL LIST
From within the Watchlist, you can save interesting symbols as a new symbol list.

01. To save the symbols as a new list, click on the entry New
Symbol List in the Related Tasks area of the symbol manager
in the toolbox. Choose the option User-Defined Symbol List
and name the list but keep it empty.

02. In the Watchlist, click into a table cell of the symbol you want
to reuse. (By pressing Shift or Ctrl while clicking with the
mouse, you can select more than one row.) A small plus sign
and a rectangle appear below the cursor.

03. Since a first click opens the properties tab, click again on the
button Symbol Lists in the toolbox to open the symbol
manager.

04. Drag the selected symbols to the new symbol list.
The symbols are added to the list.

EXPORTING WATCHLIST DATA
The table contents of the Watchlist can be copied to other programs. For more
information, see the chapter "Publish to Office" on page 346.

EXAMPLE: PARAMETERS FOR A WATCHLIST

The following parameters could be used for a Watchlist for index values:

Symbol list:

à all symbols of the .NDX.X (make sure that the index is not part
of the list)

Indicators:

à Net Change (Change)

à Net % Change (Change in %)

Thus configured, the Watchlist offers all important information at a glance. Save
the workspace to keep the Watchlist settings.
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USER-DEFINED CONTINUATIONS

Ó CONTRACT SELECTION

User-defined continuations (UDC) are
constructed price time series for futures.
Futures are forward contracts offered on basis
of commodities, stocks, indexes, currencies or
assets. All futures have a fixed expiration date.
Therefore, the history length of futures is
limited and ends on the day of expiration. For
analysis and testing of trading systems this
poses a problem since the available data for
each contract is too small.

The solution to this problem is continuous contracts, which include the
concatenated price data of expired contracts. You can use continuous contracts
for

à long-term analysis of future markets

à searching seasonal trends in future markets

à trading system tests over longer histories

Tradesignal offers several ways to set up continuous contracts. Depending on
your data provider, you have the choice between several adjustment and
adaptation functions. This way, you can add your own creations to the continuous
contracts offered by your data provider. The result and all its included calculations
is saved as a symbol, which allows further handling and analysis.

A variant of the user-defined continuation is the rolling forward symbol. The
difference is that in case of the rolling forward symbol, the history of the old
contract is replaced by the history of the new one. So it is less a continuation per
se as a forward-writing of the contract. For this option to be available, you need to
have a DataConnect-based feed.

SETTING UP A USER-DEFINED CONTINUATION OR A ROLLING
FORWARD SYMBOL

Both these options act like a normal symbol, and they can be set up via the
context menu of a symbol list.

01. Select New Symbol in the context menu of one of your own
symbol lists, or open the Symbol Search button menu.

02. Choose the option New User-defined Continuation or the New
Rolling Forward Symbol.
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The User-Defined Continuation and Rolling Forward wizard opens.

Tip: Depending on your data provider, some of the following options and adaptation
methods might not be available (grayed out).

Setting up a continuous contract is done in four steps.

CONTRACT SELECTION
Future Root Code Enter a Future Root Code, for example "S" for soybeans. If a
symbol is already selected in the symbol toolbox and the data provider submits
the data, the Future Root Code is already filled.

Next Contract to Select If no special specifications have to be met for the contracts,
select an entry from the list.

Second Contract to Select(Only available for some datafeeds) If the continuous contract
should be period spread, select an entry from the list.

Starting Contract Year Enter the starting year for the futures.

Some contracts are not handled the same way at all times of the year and
therefore should be exempted from the history. The options are:

à Only use contracts for the following months (if such contracts exist) For
this option, select or deselect the check boxes in front of the
months' names. You can also click the All button for all
months, or the Quarters buttons to select contracts from
March, June, September and December. Please note that this
options only applies to contracts of a monthly expiring nature.

à Only use contracts for the following days (if such contracts exist) For this
option, select or deselect the check boxes in front of the days'
names. Please note that this option only applies to contracts
of a daily expiring nature.

As of version 6.2 of Tradesignal if you use the TMDS as your data provider you
can additionally select whether the adjustment calculation should be done on the
server or on the client, what until now was the only possible way. Server side
calculation is used by default if available because it is faster and less resource
consuming. Some options will not be available in this case. Therefore it is
possible to switch back to client side calculation by selecting the checkbox
Enable client side calculation options. All other data providers do not offer this
option thus the client side calculation will always be used and cannot get switched
off.
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ROLLOVER METHOD
Here you can define the rollover method. You can either use fixed intervals or let
the market define the rollover moment. For the latter, conditions based on open
interest and trading volume are available.

ROLLOVER TRIGGER
Rollover strictly on the expiration day of the contract The history of the new contract is
connected to the history of the expiring contract on the expiration date.

Rollover strictly on a specific day of the expiration month of the contract For this
method, you can define on which day of the expiration month the rollover will take
place.

Rollover a number of days before the expiration day of the contract For this method, you
can define a number of days before the expiration day on which the rollover will
take place.

Rollover a number of days before the expiration month of the contract For this method,
you can define a number of days before the expiration month on which the
rollover will take place.

Rollover when Open Interest of the next contract exceeds the current contract The
rollover date is controlled by the market. When the open interest of the next
contract exceeds that of the current contract, the rollover takes place.

Rollover when Volume of the next contract exceeds the current contract The rollover
date is controlled by the market. When the trading volume of the next contract
exceeds that of the current contract, the rollover takes place.

Rollover when Open Interest OR Volume of the next contract exceeds the current contract
This is a hybrid of the two previous methods. The rollover takes place when either
the open interest or the trading volume of the new contract exceeds that of the
current contract. The rollover date is controlled by the market.

Rollover when Open Interest AND Volume of the next contract exceeds the current
contract This is a hybrid of the two previous methods. The rollover takes place
when both the open interest and the trading volume of the new contract exceed
that of the current contract. The rollover date is controlled by the market.

ROLLOVER TRIGGER OPTIONS
The volume or open interest conditions can be tracked for several days.

Trading days before expiry Set the number of days for tracking. Select all (*) or the
number of days (0-31) from the list.
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Consecutive trigger occurrences Select the number of triggers that have to be set off
(1-4).

ROLLOVER ADVANCED OPTIONS
For some methods, the Advanced button is available. It opens another dialog in
which you can set rollover intraday details for trading periods shorter than a day.

Use data only from the expiring contract On the expiration date, only contract data of
the expiring contract are taken into account for the calculation.

Use data only from the continuing contract On the expiration date, only contract data
of the new contract are taken into account for the calculation.

Combine data from both contracts into a single candle The data of both contracts is
used to calculate a combined value.

Include non-trading days in all interval calculations Select this option to include non-
trading days into the calculation for intervals of the rollover triggers.

Force rollover to occur at the following time For trading periods shorter than a day,
you can set the time. Enter the hours and minutes in the respective fields.

DATA ADJUSTMENT

Ó DATA ADJUSTMENT

User-defined contracts are constructed by
mathematical concatenation of price histories
of single contracts. This is done to avoid the so-
called rollover gaps, price differences between
the expiring and the new contracts. However,
this may result in side effects like extreme price
divergence in past histories of continuous
contracts as compared to the originally traded
contracts. Choose the data adjustment method
depending on your preferences or to avoid certain side effects.

DATA ADJUSTMENT METHOD
Continuation: Unadjusted The data of the contracts is simply concatenated without
further adjustments. This results in a large price gap at each rollover date.
However, the advantage is that even histories in the distant past still show the real
traded prices.

Continuation: Forward Adjusted The history of the new contract is adjusted to the
price of the expiring contract.
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Continuation: Back-Adjusted (Difference) The history of the expiring contract is
adjusted to the price of the next contract, i.e. either raised or lowered. For each
additionally concatenated contract, the complete past history is adjusted this way.
Therefore, the resulting data for the distant past is very different from the actually
traded prices. It is also possibly to receive negative (nonsensical) values in the
process.

Continuation: Back-Adjusted (Proportional) For this, the complete history is calculated
anew. All past prices are multiplied with the ratio of the input fields (see below).
This way, no negative values can result since the values are multiplied instead of
subtracted.

Rolling Forward The history of the expiring contract is replaced by the history of the
next contract.

FIELDS WITH WHICH TO CALCULATE THE ADJUSTMENT
Select which fields the chosen adjustment method should be based on.

Closing price of both contracts The calculation is based on the closing prices.

Open of new contract; Close of expiring contract The calculation is based on the close
of the expiring and the open of the new contract.

Opening price of both contracts The calculation is based on the opening prices.

Average price of both contracts The calculation is based on an average, namely
(Highest High + Lowest Low / 2) of both contracts.

ADVANCED OPTIONS FOR THE ADAPTATION
For some settings, an additional dialog is available under Advanced.... Here you
can define which contract data should be used for calculating the price difference.

à The bar after the rollover day

à Same day as the rollover day

SUMMARY
In the summary you can see an overview of your settings. After finishing with
Done, you are asked to enter a name for the UDC.

In the last step, all available options for symbols at this point are offered, e.g.
Create a New Chart using this UDC.

88



MANAGE CONTINUOUS CONTRACTS

Via the context menu of the contract symbol you can reach all other functions for
the contract:

à You can use continuous contracts in the documents "Chart"
on page 96, "Market Profile" on page 148, "Watchlist" on
page 77, "Scanner" on page 71 and "Portfolio" on page 251.

à You can copy, rename or delete contracts.

à You can open the user-defined continuation wizard to edit the
adjustment and calculation methods. To do so, select Edit
Continuation Symbol in the context menu.

EXAMPLE: CREATING A CONTINUOUS CONTRACT FOR
FUTURES

IN THE TOOLBOX

01. Click on Symbol Lists.

02. Click on New Symbol to open the Symbol wizard.

03. Select user-defined continuation and click on Next.
The user-defined continuation (UDC) wizard opens.

IN THE UDC WIZARD

01. For Future Root Code, enter a symbol/shortcut, e.g. "S" for
soybeans. (Futures are not automatically available for all
account types. Contact Tradesignal for an upgrade, if
necessary.)

02. From the list of contract series, select the top entry so that all
available contracts will be taken into account.

03. Click onQuarters to select the four months in which quarters
end, then click Next.

04. As trigger for the concatenation, select Next contract's
volume exceeds current, then click Next.

05. Select Continuation: Back-Adjusted (Proportional) and
Closing prices of both contracts as fields for the
calculation, then click Next.

06. Confirm the resulting settings with Done.
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07. Enter a name for the contract and confirm withOk.

08. Select Create a New Chart when the wizard finishes.

The continuous contract now appears as symbol in the symbol list.

MARKET DEPTH

Ó MARKET DEPTH

The market depth data offer a list of the best bid
and ask orders in streaming view and are
instrumental for assessing the current state of
stocks. This kind of information is also called
Level II. It is especially important for day and
intraday trading.

à Most of the data and charts in
Tradesignal offer Level I data, i.e.
you receive price information based
on the last trade (or ask price, if no
trade has taken place).

à In case of Level II data, however, you can see current bid and
ask orders for a stock. This way, you have an immediate
insight into the order books of the traders or ECN. The
available details depend on the data provider.

The market depth data provides you with

à insight into current bid and ask prices.

à insight into upcoming trades.

à insight into the liquidity of the market.

à the ability to see and judge current trends, accurate to the
second.

à the ability to learn about support and resistance price levels
(lower and upper limit of price movements).

à insights into the activity of individual market makers (if source
given by the data provider).

In Tradesignal, three views are available for market depth analysis:

à Level II displays the current status of the order books
(available data depends on data provider).
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à Price Ladder gives a visual overview of the Level II data, as
size bars for each offered bid/ask price as well as a bid/ask
ratio curve.

à Time and Sales displays the current prices, sizes and actual
transactions in real time.

OPENING THE MARKET DEPTH VIEWS

01. To open one or all of the available market depth views, click
on theMarket Depth button in the Insert tab of the toolbar.

02. Choose a view in the pull down menu or choose Full Market
Depth view for all.

Note: In most cases you can display market depth data for all traded stocks. However, in the
case of rarely traded stocks, the views may remain empty or may be updated infrequently.

PROPERTIES
The properties for the Market Depth are available via "Settings" on page 157 in
the home tab. Settings for the symbols themselves are accessible in the "Mini
Toolbar" on page 45.

Display Units Here you can set up the way the prices should be displayed (default:
2 decimal places). When you choose fraction display, the new field 'Fraction
Precision" appears. Here you can set the maximum number of decimal places to
be used in case the fraction cannot be expressed by an integral numerator.

Layout Here you can switch between the available market depth views.

LEVEL II

Ó LEVEL II

In the Level II view you can see the bid (buying)
and ask (selling) orders and their respective
size for the chosen stock. The price levels are
color-coded. Besides the price ladder (see
below) there are three areas:

Overview On the upper left, you can find a
compressed overview of the bid and ask prices,
the respective sizes and the spread between
the prices.
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Bid / Size Here you can see the offered bid prices and their size. The best price
(highest selling price) is shown on top.

Ask / Size Here you can see the offered ask prices and their size. The best price
(lowest selling price) is shown on top.

On top of the Level II window, you can find a line with the Level I data (open, high,
total, et al.).

The first line of the two areas, with the highest bid and lowest ask, is called "inside
market" and traditionally displayed in yellow. The market depth corresponds to
the number of visible price levels (default: 10). You can change the default in the
properties.

The details of the Level II data depend on the data provider.

PROPERTIES
The properties for the Level II are available via "Settings" on page 157 in the
home tab. Settings for the symbols themselves are accessible in the "Mini
Toolbar" on page 45.

Show Bid/Ask Size When this is set to true, the offered sizes are displayed as
numbers in the bars of the price ladder.

Bid/Ask Ordering Allows you to toggle the order of bid and ask in the price ladder
(has no effect on the ratio field below the price ladder).

Highlight Source When this is set to true, orders by the same source in the bid/ask
areas are highlighted when clicking on one of the orders (only available if source
given).

Smoothing Here you can enter how many successive ticks should be averaged in
the bid/ask ratio to generate a smoother curve in the display.

Levels Here you can set how many price levels should be displayed in the bid/ask
areas.

Depth Shows the data base used for each line in the overview (e.g. "2*4" for 2
summarized bids and 4 summarized asks).

Source Displays the individual market maker or ECN in the first column of the
bid/ask areas (available data depending on the data provider).

Time If set to visible, the time column is displayed in the bid/ask areas (available
data depending on the data provider).
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PRICE LADDER

Ó PRICE LADDER

The price ladder offers a visual overview of the
Level II data. The price ladder is a regular part
of the Level II view but can also be displayed
individually. In the case of individual display, a
line with the Level I data (open, high, total, et
al.) is displayed on top.

The price ladder view consists of:

à The price ladder itself. In it, the sizes
of bid and ask orders are displayed
as colored bars for each price. This way, you can easily see
any existing imbalance between selling and buying orders
and also estimate in which direction the price is likely to move.
The display order of bid and ask can be set in the properties.

à A curve display for the bid/ask ratio (below the price ladder).
The upper red area corresponds to the bid orders, the lower
green area to the ask orders. In case of bid overbalance, the
curve moves into the red area and prices are likely to move
up. In case of an ask overweight, the curve moves down into
the green area and prices are likely to drop. A curve on the
border between the areas shows a balanced market.

Tip: For the price ladder properties, see the section "Level II" on page 91.

TIME AND SALES

Ó TIME AND SALES

Time and Sales shows a streaming display of
price and size of orders and trades as a table. It
allows you to see the up and down ticks of the
stock price at a glance. Individual market
makers or ECN are not available here.

The default color settings of the text are:

à Price changes to best bid price ("To
Bid") are shown in red.

à Price changes to best ask price ("To Ask") are shown in
green.
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à Last, i.e. real trades that correspond to Level I information, are
shown in black.

à If the price changes in comparison to the previous bid/ask
price, its background color changes accordingly and an
additional plus/minus sign is displayed.

PROPERTIES
The properties for Time & Sales are available via "Settings" on page 157 in the
home tab. Settings for the symbols themselves are accessible in the "Mini
Toolbar" on page 45.

History Length Here you can enter the maximum number of transactions to be
stored in the table. Note: Upon changing this value, there might be a noticeable
wait while the system updates the historical information.

Date When this is set to visible, the current date is shown in an additional column.

Condition Codes When this is set to visible, the conditions are written out in an
additional column (e.g., "At Ask").

FILTER

Ó FILTER BUTTONS IN THE TOOLBAR

The filter is an important instrument for filtering
the results of the optimizer and scanner for
certain values.

FILTER VALUES

The filtering proceeds in two steps:

Click the Edit Filter button in the Toolbar under
Home > Table > filter to set up a filter.

FILTER SET UP
When setting up the filter, you define one or more criteria that form the filter. You
have the following options:

New Starts a new filter. An existing filter will be deleted. It is not possible to set up
and save several filters. However, you can enter parallel filters combined byOR.
A dialog opens. Here you can enter which column should be tested with which
operator (=, >, <...) Confirm withOK.
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Edit Opens the dialog as explained above, in which you can edit the selected filter
criteria.

Delete Deletes the selected line in the filter.

OR Choose this to enter other possible criteria sets. This way, you may avoid
setting up new filters. Enter all important filters withOR between them. The ones
that don't apply are ignored.

Move up/Move down With these buttons you can move a criterion up and down in
the appliance sequence.

ADVANCED FILTER OPTIONS

à Click on Show Advanced Options to display additional
options:

Show all filtered rows All rows of the table are shown. An additional column named
Filter appears, in which rows are labeled "true" or "not true". Alternatively you can
combine the row display with another condition by selecting an Equilla formula in
the list or entering a new one. In this case, only filtered rows that fulfill the second
condition are displayed.

Note: This option is only available for Scanner documents.

EXAMPLE - FILTERING FOR STRONGEST VALUES

01. Open a new scanner and fill it with the 50 symbols of the "Dow
Jones Industry", for example. Add the indicator Relative
Strength Levy.

02. Perform the scan.

03. Click the Edit Filter button in the "Toolbar" on page 42 to
open the filter criteria dialog.

04. Click the New button and choose the column RSL for testing.
This is the relative Strength Levy indicator we have entered in
the scanner.

05. Select the operator > and enter the number 1 as the value to
be tested against.

06. Confirm your settings.

A filtered list that includes only stocks with a Relative Strength Levy of more than 1 is
displayed.
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CHARTING

CHART

Ó A CHART

Charts are graphical displays of prices for
stocks, commodities, indexes or funds. They
can be used for:

à Supporting trading decisions by
following price development.

à Making trading decisions solely on
the basis of price development.

à Gathering information about possible
future price developments.

à Preparing analysis for past price developments.

à Visually following symbol positions.

à Systematically developing signals for portfolio trading.

à Graphically displaying trading system results.

à Graphically displaying mathematical and statistical
calculations.

à Visualizing the performance development of a symbol.

With the help of simple methods it is possible to process price developments from
the past to allow prognosis for the future. These methods are known by the term
"chart analysis".

Charts have the following design parameters:

à The maximum number of tools per charts is 250 (e.g. text
elements, chart tools.

à The maximum history length is 500000.

à The maximum number of instruments per chart is 12
(including the subcharts, e.g. 6 instruments with one indicator
each).

For additional information, also see these related topics:
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à In the chapters "Using Indicators" on page 372 and "Using
Strategies" on page 381, you can find information on how to
add these to the chart for chart analysis. It is also possible to
change their output using the available chart types. See
"Equilla Graphs, Outputs and Alerts" on page 440 for more
information.

à In the chapter "Chart Tools" on page 161 you find information
on how to add and use these drawing tools for your chart
analysis.

à In the chapter "Time Spans and Periods" on page 218 you
can find information on how to toggle quickly between
different trading periods, how to define your own periods and
how to set the visible time span and which pre-defined time
spans are available.

à In the chapter "Settings" on page 157 you can find information
about layout settings that define the appearance of the chart
and the displayed symbols. You can also find out about
"Styles" on page 224 and "Using Templates" on page 223 that
allow you saving your own configuration and applying them to
other charts.

à In the chapters "Print" on page 340 and "Publish to Office" on
page 346 you can find information on how to print your chart,
save an image of it, or send it via E-mail.

à In the chapter "Manual Order Routing" on page 317 you can
find information on how to place orders directly from your
Tradesignal workspace.

AVAILABLE CHART TYPES

Type Description

"Bar Chart" on page 109
Plots price movement; vertical bars
indicate range; markers on the bar
show open and close prices

"Candlestick Chart" on page 110
Price chart that shows the open, high,
low and close prices over a given time
period

"Line Chart" on page 124 Plots a line connecting consecutive
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Type Description

prices

"Stepped Line Chart" on page 125
Similar to a line chart where price
levels are connected to form a
sequence of discrete steps

"Symbol Chart" on page 126 Plots symbols at each price

"Filled Area Chart" on page 127 Plots a filled region between two prices

"Forest Chart" on page 128
Plots a histogram between prices by
time

"Linked Forest Chart" on page 132
A forest chart with a line joining the
columns

"Candle Volume Chart" on page 132
A candlestick chart with the width of
each candle representing volume

"Equi Volume Chart" on page 134
Plots vertical bars showing price
movement with the width representing
volume

"Kagi Chart" on page 136
Plots lines with different line width,
independent of the time line

"Renko Chart" on page 137

Plots a sequence of ascending and
descending bricks to indicate price
movement, independent of the time
line

"Three Line Break Chart" on page 139
Plots a sequence of bricks based on
close prices, independent of the time
line

"Heikin Ashi Chart" on page 141
Similar to candlesticks, but uses
average prices

"Point and Figure Chart" on page 144
Plots price increases and decreases
as a series of stacked Xs and Os

"Market Profile" on page 148
Inserts a market profile chart (various
price and turnover data) into the
workspace

"Range Bar Chart" on page 151
Plots price movement with a fixed
price range; markers on the bar show
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Type Description

open and close prices

WAYS OF CALLING UP A CHART

There are three main routes for calling up a chart for a commercial paper:

à If you know the ticker symbol, enter it in the command line.
(Tip: You can find ticker symbols in the "Symbol Search" on
page 59.)

à If you don't know the ticker symbol of the commercial paper,
you can find it in the "Symbol Lists" on page 62.

à If you receive an E-Mail with charts, you can save them and
call up the charts.

Tip: You can also open symbols in subcharts.

CALLING UP A CHART VIA THE COMMAND LINE

01. Type the ticker symbol (e.g. CAT) in the command line.

02. Press Enter. Alternatively, you can choose the entry New
Chart from the pull-down menu.

CALLING UP A CHART FROM A SYMBOL LIST
For this you need to have a symbol list, e.g. one for the USA Dow Jones.

01. Click on Symbol List in the tool bar.
The symbol list manager opens.

02. Double-click on the symbol list to open it. There are two ways
to open a chart for a list entry:

à If the working area doesn't display a chart, or if
you want to substitute the symbols in an
existing chart, double-click on the list entry.

à If you want to open a new chart, right-click on
the list entry and choose New Chart from the
context menu.

03. Use the two green arrow buttons right next to the command
line to move through the list and get each entry displayed in
the chart.
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Tip: You can also open the symbol list as a table in the "Scanner" on page 71, the
"Watchlist" on page 77 and as "Portfolio" on page 251 and call up a new chart by right-
clicking on a table entry and choosing New Chart from the context menu.

CALLING UP A CHART FROM AN E-MAIL
Tradesignal offers you the option to send charts or whole workspaces by E-Mail.
In a similar way, you can import these sent objects into the program.

01. If you receive an E-mail with a workspace, save it locally. We
recommend that you choose the folder Tradesignal Files
which is located in Personal Folder.

02. Update the list of workspaces by right-clicking in the toolbar
on the folder Tradesignal Files and choosing Update.

The saved workspace appears in the list of workspaces and can be opened from there.

COPYING, PASTING AND DELETING CHARTS

You can edit charts with the functions in the Edit group in the toolbar:

Copy Copy the current chart configuration into your Windows clipboard.

Paste Paste the copied chart configuration into a currently opened chart, a new
workspace, an office document or an image processing application.

Delete Delete the currently active chart.

NAVIGATING IN THE CHART

Ó CHARTWITH SHORTENED AXES

To activate a chart, click on its tab. In the active
chart, the small plug symbol on the lower right
of the chart or a portfolio is visible, see the
chapter "Automatic Order Routing" on
page 307.

The axes and visible areas can be set up
relatively flexible. To return to the default
settings, you can either press the key F8 or
click on the axes symbol on the lower right of
the chart. More information you can find in the
chapter "Time Spans and Periods" on
page 218.
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MOVING (SCROLLING) AXES
You can move (scroll) the x- and y-axes (usually time and price axes) by clicking
on them with the mouse and keeping the mouse button pressed while moving it
up/down or left/right.

Alternatively, you can scroll the axes by pressing the cursor keys (up/down,
left/right). To speed up the scrolling, press the Strgkey in addition to the cursor
keys.

STRETCHING/SHRINKING AXES
You can change the scale of the axes, so that more or less of the range is shown.
To do this, click on it with the right mouse button and keep it pressed while moving
the mouse left/right or up/down.

Alternatively, keep the Shift key pressed while pressing the cursor keys
(up/down, left/right).

USING THE X-AXIS SCROLLBAR
You can also scroll the x-axis by using the scrollbar, which is situated on the lower
right corner, to the left of the axes symbol. Click on it and keep the mouse button
pressed to drag the scrollbar to the left or right. The scroll speed depends on how
much the time axis is currently stretched or shrunk.

PANORAMIC SCROLLBAR

Ó CHARTWITH PANORAMIC
SCROLLBAR

In Tradesignal you can use the panoramic
scrollbar to move (scroll) the x-axis by dragging
it or clicking on the axis itself. The background
always shows all available data as a "Filled
Area Chart" on page 127 to give you additional
information about your current viewport. It is
possible to stretch/shrink (zoom) the axis by
dragging the grippers of the new panoramic
scrollbar. New buttons replacing the axes
button makes it easy to toggle between normal
and panoramic scrollbar or show recent/all
data. In the chart properties you can change
the height of the panoramic scrollbar or switch
to the normal one.

CHANGING SCALE ALIGN
You can change the scale align for the y-axis via the mini toolbar (left, right,
left/right), or via the chart legend (left and right).
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For the latter, click on the chart legend and keep the mouse button pressed while
dragging it to the left or right side of the chart, until a little arrow symbol appears.
Then release the mouse button. This way, you can drag and drop the scale to the
left or right side of the chart.

Ó CHARTWITHOUT SCALES

USING THE ZOOM FUNCTION

Ó CHARTWITH ZOOM APPLIED

If you want to take a closer look at certain chart
regions, price patterns or signals of trading
systems, the Zoom function is the right tool.

01. Activate the Zoom tool by clicking on
the small icon with a magnifying
glass and a plus symbol in the Chart
area of the toolbar.

02. Click on the first corner of the area
you want to enlarge.

03. Draw the rectangle around the area.

04. Release the mouse button. The area
is zoomed.

à To reset the Zoom and return to the
previous view, click into an empty
area of the chart with the activated
Zoom tool.

à To deactivate the Zoom tool, click on
another tool like the select tool or
target cursor. Alternatively, right-
click into the chart and then click with
the left mouse button into the empty
area next to the context menu. This
way, you return to the select mode.
Although the second variant may
sound complicated, it's a lot faster than the first one.

USING THE TARGET CURSOR
To retrieve detailed information about the region below the mouse cursor, you
can use the Target Cursor.

Activate the Target Cursor by clicking on the small cross-hairs icon in the Chart
area of the toolbar. When you click into the chart now, information about that
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position, the trading period, prices, indicators, etc. is displayed in a pop-up
window. This window remains visible as long as the Target Cursor is active.

To return to the select mode, click on the select mode button in the toolbar.
Alternatively, right-click into the chart and then click with the left mouse button into
the empty area next to the context menu. This way, you return to the select mode.
Although the second variant may sound complicated, it is a lot faster than the first
one.

You can change the appearance of the Target Cursor in the chart properties,
Target Cursor Style. Select Thin Line orWhole Column.

To have a temporary "target cursor" with an information pop-up, click and keep
pressed the left mouse button in the select mode. The mouse pointer changes
into a target cursor and a pop-up window with information appears. The window
disappears when you release the mouse button.

CONTEXT MENUS IN THE CHART

If you right-click on an element in the chart, a context menu opens, offering you
various functions for this element. The most important functions are:

à Delete the selected element

à Show properties of the selected element

à For the symbol: starting the price editor and trading time
manager, changing the period, saving chart as template,
report bad ticks, trade symbol (automatically opens the order
bar).

à For user-defined continuation, formula and combined symbol:
edit the settings of the symbol

à For the indicators / trading systems: starting the program
editor, request online information.

à Placing order directly from the chart through "Manual Order
Routing" on page 317.

SUBCHARTS

Subcharts are a special form of chart. They can be recognized by not having their
own tab. Subcharts can have the same date axis or a different one than the main
chart. As subcharts, the following documents can be displayed: symbols,
indicators, strategies, equity curves (e.g. of the portfolio).
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OPENING A SUBCHART
To open an instrument as a subchart, proceed as follows:

01. Click on Symbol List in the toolbox.

02. Double-click on the symbol list to open it.

03. Right-click on a symbol in the list to open the context menu.
You have two options:

à If you want to open the subchart with the same
time axis as the main chart, select Insert
Symbol from the context menu.

à If you want to open the subchart with its own
time axis, select Insert Symbol with new Date
Scale from the context menu. (The y-axes are
always independent of each other.)

The subchart opens below the main chart in the same tab.

Note: This action also depends on the option Open symbols in their own subchart. This
defines how the program reacts to Insert Symbol. If the option is selected, symbols are
opened in a subchart. Otherwise, the symbol gets added to the existing chart.

MINIMIZING A SUBCHART
To minimize a subchart, click on the minimize button in the upper right corner of
the subchart.

If there are one or more minimized subcharts, a restore button will appear in the
top-most visible subchart (for each block of subcharts with their own date scale).
Click on it to see the list of minimized subcharts. Then click on an item to restore
the subchart at its original location, or select Restore All to restore all minimized
subcharts.

CLOSING A SUBCHART
To close a single subchart, click on the x button in the upper right corner of the
subchart. Alternatively, right-click into the subchart and select Delete subchart
from the context menu.

Note: When you close a chart, all its subcharts are closed automatically.

104



NAVIGATING IN SUBCHARTS
To maximize a subchart click on the button with the window symbol in the upper
right corner of the subchart. Two little arrow buttons appear (right/left). Click on
them to move between subcharts.

To display all subcharts again click on the button with the staggered windows.

To activate a subchart click on the subchart legend. In the active subchart, the small
plug symbol is visible on the lower right, just like for the chart. (See the chapter
Automatic Order Routing).

EDITING SUBCHART PROPERTIES
When you change the trading period for a chart via the Period button of the
command line (see the chapter "Time Spans and Periods" on page 218), the
period for all subcharts is changed accordingly.

To change the period for a single subchart, right-click into the subchart and select
another Period for Object in the context menu.

MOVING INSTRUMENTS BETWEEN (SUB-)CHARTS
If an instrument is opened in a chart and you would like to move it into a subchart,
you can drag and drop the instrument.

01. Click on the instrument in the legend and drag the instrument
down. A little down-pointing arrow is added to the mouse
cursor.

02. Drop the legend into another subchart or pull it down until the
edge of the window, so that a new subchart is opened.

In the same way, you can move instruments from one subchart into another or
into the main chart. This way, you can display two symbols together in one chart
even though the optionOpen Symbols in their own Subchart in the
"Tradesignal Options" on page 319 is active.

INDICATORS AND STRATEGIES IN SUBCHARTS
Whether an indicator is opened in a subchart depends on their Equilla
programming. You can move indicators by dragging them into other (sub-)charts,
as described above. To which instrument an indicator is applied to is given in the
indicator legend and is independent from the arrangement on the user interface.
(See also the chapter "Using Indicators" on page 372.)

For strategies, the same rules apply in principle. However, usually their graphic
output are only a few arrows at the instrument curve. As this doesn't make not
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much sense in a subchart, most strategies are opened in the same (sub-)chart as
the instrument they are applied to.

SETTING A NEW DEFAULT CHART STYLE

When Tradesignal is first installed, the default chart style is the candlestick chart.
However, you can also set the bar and line chart as default. Proceed as follows:

01. Open the File menu.

02. Select the Tradesignal Options.

03. Open the Chart settings.

04. In the Default Chart Style area, select whether you want the
candlestick, line, or bar chart as standard. Confirm the new
settings by clicking OK.

All new charts are now displayed according to the new default setting.

COMPARING SYMBOLS

If you want to compare several symbols in the chart, it may be essential to
normalize their measuring unit to get meaningful results. Tradesignal offers you
different possibilities to achieve this goal. The following examples use
Tradesignal Realtime as data provider:

CURRENCY CONVERSION
If you are trading the same symbol on different exchanges you may encounter the
problem that they are displayed in different currencies. The following example
shows you how to unify the currency in the chart:

01. Open a chart with Microsoft,MSFT NAS, a symbol traded on
the American market in US Dollars.

02. Add another Microsoft symbol traded on a different exchange,
e.g. MSF GER, which is traded in Germany in Euro.

03. Select the symbol traded in Germany in the chart and change
the currency to US Dollars in the instrument properties.

04. Select the first Microsoft symbol and add the Spread Diff
indicator from the Tradesignal package. In the dialog, choose
the symbol traded in Germany as second input.
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Note: The currency conversion is not available for all symbols, such as indices which are
displayed in index points. The list of available currencies depends on the selected data
provider.

UNIT CONVERSION
Unit conversion can be interesting for comparing symbols that are traded in
different measurement units, e.g. barrel, bushel, tons, etc. This information and
the list of available units and used abbreviations depends on the data provider .

Example for soy beans and soy oil:

01. Create a "User-defined continuations" on page 84 for soy
beans and choose S as Future Root Code. The future is
traded in US Cent per Bushel (Bsh).

02. Create another Continuous Contract for soy oil and choose
BO as Future Root Code. This one is traded in US Cent per
Pound(Lbs).

03. Add both continuous contracts to a chart and select the soy oil
symbol.

04. Change the unit in the instrument properties from Lbs to Bsh.

05. Add one of the Spread indicators from the Tradesignal
package to display the difference.

DISPLAY UNIT
Symbols can have different display units which refer to the displayed numbers of
decimal places. For example, the Dow Jones index has two decimal places while
the Euro has four decimal places. This is how you normalize the display of
symbols in the chart:

01. Create a chart with the Dow Jones, .DJI.

02. Add the Euro (EURUSD) symbol to the chart and select it.

03. Open the properties and change the instrument property
Display Unit to 0.01 to display the Euro with two decimal
places.

The default value is provided by the data provider. It can be changed in the
session properties for each symbol by opening the Session Manager via the
context menu or the toolbar.
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Tip: You can change the display unit also for indicator and strategy outputs. Select the
element in the chart and change the value in the properties. The default value of the output is
based on the underlying symbol display unit.

Tip: The display unit is also available in the "Scanner" on page 71, "Watchlist" on page 77
and "Portfolio" on page 251 and can be used to align the display units for multiple selected
symbols at once.

SEASONAL CHARTS
With the seasonal mode in the chart properties, Tradesignal offers you the ability
to overlay the prices of different years for one or more symbols. Comparing the
symbols this way emphasizes seasonal pattern, e.g. if used with commodities
that have seasonal variations. See the article "Seasonal Chart" on page 155 for
more details

PERCENT PERFORMANCE CHARTS
You can display the price movements of a symbol as percentage
increase/decrease relative to a start price by using percent performance
transformation. This makes it easier to compare the performance of symbols
since their absolute price values are converted to relative price movements. See
the article "Percent Performance" on page 154 for more details.

SEMI-LOGARITHMIC DISPLAY

Ó SCALE VALUE CONTEXT MENU

The value axis can be displayed using a
logarithmic scale. This is mainly used for
symbols with a long history, to emphasis
fluctuations in prices. The changes are not
displayed linearly but perceptually, therefore
the increase from 1 to 10 is identical to the
increase from 10 to 100.

Example for changing the Dow Jones display from linear to logarithmic:

01. Open a chart with the Dow Jones, '.DJI.'

02. Open the context menu for the symbol (see picture) and
choose Logarithmic.
To return to the linear display, repeat this action but select Linear instead.

You also have the option of inverting the value scale by selecting Inverted, this
will cause the lowest values to be displayed at the top.
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Note: The left value axis can be changed separately if you have a second symbol in the
chart.

BAR CHART

Ó BAR CHART

Bar charts are among the most common chart
types and give information about open, high,
low and close prices, price developments and
the magnitude of price movements.

The bar chart can be set as the default chart
type in Tradesignal, see chapter "Chart" on
page 96.

TRADING INFORMATION IN BAR
CHARTS
The following information is available in a bar chart:

à The highest price, given by the top point of the bar

à The lowest price, given by the lowest point of the bar

à The open price, given by the left vertical line

à The close price, given by the right vertical line

à The direction of the price movement, given by the relative
positions of the left and right vertical lines. If the left one is
below the right one, prices have risen during the trading
period. Otherwise, prices have fallen.

à The direction of the price movement, given by the color of the
bars. The usual color setting is red for falling and black for
rising prices. The colors can be edited in the chart properties.

à The strength of the price movement, given by the total length
of the bar (difference between high and low).

GENERAL CHART PROPERTIES
When the chart is active, you can edit the chart properties in the toolbox, for
example the history length, the axes and legends.

You can also
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à set the trading period, see the chapter "Time Spans and
Periods" on page 218. Note that it is not possible to use bar
charts when using ticks as periods.

à change the time span. In this case, several bars of a time
span are combined to a "meta bar" to display the trading
activity of several periods. For example, if you choose
"Current Quarter", three meta bars based on the monthly
dates are displayed.

à change the chart look, see the chapter Chart Properties.

CONTENT-DEPENDENT CHART SETTINGS
In the properties of the displayed stock (symbol), you can find additional
parameters. Besides the Standard Properties, you can find specific parameters
for this chart type.

Bars Properties

Bullish Color Here you can select a color and transparency for upward bars.

Bearish Color Here you can select a color and transparency for downward bars.

CANDLESTICK CHART

Ó CANDLESTICK CHART

Starting in the 17th century, the candlestick
chart pattern was used in Japan. Used by
Charles Dow in 1900, it was the American
trader Steve Nison who brought candlestick
charts back to the awareness of western
traders. Today, candlestick charts are one of
the most common chart types.

Candlestick charts give information about the
open, high, low and close prices and about the
direction and magnitude of the price
movement. It is this wealth of information and the distinct patterns that make the
candlestick charts so interesting. The direction and movement of prices can be
better perceived than by using bars. More complex candlestick patterns are often
used as the basis for trading decisions.

The candlestick chart is the default chart type in Tradesignal. See chapter "Chart"
on page 96.
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TRADING INFORMATION IN CANDLESTICKS
The following information is available in the candle body and the shadows (the
lines on bottom and top, also called wicks):

à The high of the trading period, given by the end of the upper
shadow.

à The low of the trading period, given by the end of the lower
shadow.

à The open price, given by the body edge; either the bottom line
in the case of an upwards development, or the top line in the
case of a downwards development.

à The close price, given by the body edge; either the top line in
the case of an upward development, or the bottom line in the
case of a downward development.

à The direction of the price movement, given by the body color.
Colors are usually red or black for falling and green or white
for rising prices. The color settings can be changed.

à The magnitude of the price movement, given by the length of
the body and the shadows. The total length of a candlestick
between the wicks is the difference between high and low.

More information can be gathered when several candlesticks are seen in context.
Patterns of up to three candles are used to take a closer look at the price
movements and their quality. For example, candles with bodies of the same color
show more pronounced trends. Trading is often done based on a mixture of
candlestick pattern analysis and other methods.

TWO SIMPLE CANDLE EXAMPLES

THE HAMMER

The hammer was named for its characteristic shape and the relationship to the
Japanese sign for "hammering a floor". It has a large lower shadow with a small
body on top, meaning a long downward movement stopped (and changed
direction) during the trading period.

An ideal hammer has a small white or green body, showing that a bullish trend
won out. The hammer should have no upper shadow, meaning that the close
corresponded to the high in the trading period. In combination with analysis
methods like moving average and other support signals, a hammer may be a
good entry signal.
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THE DOJI

A doji is a common candle that has a very small or no body at all. If the body is
small, the color can be ignored. A distinct doji has very large shadows of similar
size.

A doji signals that for all the trading over the day, the market and its forces are in
equilibrium. The opening and close price are almost the same.

The doji itself only shows a kind of "frozen" state, of indecision. However, it
gathers importance depending on the surrounding patterns. Price movements
taking place after a doji often signal new trends or a trend inversion. Therefore,
dojis are good support signals for resistance and support lines.

GENERAL CHART PROPERTIES
When the chart is active, you can edit the chart properties in the toolbox, for
example the history length, the axes and legends.

You can also

à set the trading period and timespans, see the chapter "Time
Spans and Periods" on page 218.

à change the chart look, see the chapter"Settings" on page 157.

CONTENT-DEPENDENT CHART SETTINGS
In the properties of the displayed stock (symbol), you can find additional
parameters. Besides the Standard Properties, you can find specific parameters
for this chart type.

Candles Properties

Border Color Here you can select a color for the border.

Show Frame Here you can select whether the candle frame will be displayed or
hidden.

Bullish Color Here you can select a color and opacity for upward candles.

Bearish Color Here you can select a color and opacity for downward candles.

INDICATORS AND STRATEGIES
In the indicator overview, you can find the indicator Candle Pattern which includes
a long list of typical candlestick patterns to choose from. You can edit these
patterns in the graph properties in the toolbox. The set pattern is displayed in the
graph.
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In the strategies overview, you can find strategies such as Candle Bearish
Engulfing - Exit, Candle Big White Candlestick - Exit, and many more that you can
apply to your candlestick chart.

USING CANDLESTICK PATTERNS
A "Candlestick Chart" on page 110 already delivers a lot of information inside the
candles itself, but their real trading power are candlestick patterns. Patterns of up
to three candles and more are used to take a closer look at the price movements
and their quality. For example, candles with bodies of the same color show more
pronounced trends. Candle patterns involving more than one candle are most of
the time more powerful than one candle patterns.

Trading is often done based on a mixture of candlestick pattern analysis and
other methods. Candlestick Patterns can identify tops, bottoms, reversals and
therefore create buy and sell signals.

Candle Patterns can be confirmed or failed. Both scenarios creates trading
signals. Furthermore, you can also trade without waiting for the confirmation. The
quick trade can result in a higher profit but is also riskier.

In Tradesignal are white rising candles in green and black falling candles in red
drawn. The definitions of the candle patterns are based on the original colors of
candlestick. In the description are therefore the traditional colors white and black
used.

ONE CANDLE PATTERNS

BIG BLACK/WHITE CANDLE
The body of big candles are at least 1/3 bigger as the previous candles in the
defined period. Big bodies implies strong buy or sell pressure depending on the
color. White bodies show a strong buy pressure, while black bodies show a strong
sell pressure.
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HAMMER

Ó HAMMER

The hammer was named for its characteristic
shape and the relationship to the Japanese
sign for "hammering a floor". It has a large
lower shadow with a small body on top and only
appears in a downtrend.

An ideal hammer has a small white body,
showing that a bullish trend won out. The
hammer should have no upper shadow,
meaning that the close corresponded to the
high in the trading period.

The counterpart of the hammer is the "Hanging
Man" below.

HANGING MAN

Ó HANGINGMAN

Hanging man looks like a man hanging from a
gallows. It indicates a trend reversal and the
end of a uptrend. The bearish counterpart is a
"Hammer" above.

The candle itself has a small body with a long
lower shadow, but with a short or even no
upper shadow at all. The color of the body is
not important for the signal.

The hanging man needs a confirmation within
the next candles to be a strong signal.

STAR/RAINDROP
Stars are candles with a small body, either
white or black. They build a gap with the prior
large candle. If a star appears in a downtrend it
is called raindrop.
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DOJI

Ó DOJI

A doji is a common candle that has a very small
or no body at all. If the body is small, the color
can be ignored. A distinct doji has very large
shadows of similar size.

A doji signals that for all the trading over the
day, the market and its forces are in
equilibrium. The opening and close price are
almost the same.

The doji itself only shows a kind of "frozen"
state, of indecision. However, it gathers
importance depending on the surrounding
patterns. Price movements taking place after a
doji often signal new trends or a trend inversion. Therefore, dojis are good
support signals for resistance and support lines. A doji in an overbought or
oversold market shows that the market is vulnerable to corrections.

Special formations of a doji are gravestone and dragonfly. They are defined by
the distance between open and close in relation to the trading range. The names
suggest already the appearance. A gravestone doji has a longer upper shadow
and a dragonfly has a longer lower shadow.

SPINNING TOP
Spinning tops are candles with a small body and shadows which are longer than
the body. If no body at all is drawn, it is a "Doji" above. The pattern shows like the
doji the indecision of the market.

SHOOTING STAR/INVERTED HAMMER

Ó SHOOTING STAR AND INVERTED
HAMMER

A shooting star is a candle with a small body
and very long upper shadow.

A shooting star is a classic bearish signal
because the long upper shadow shows that
trades are also made in the higher levels.

The counterpart of the shooting star is the
inverted hammer. If in a downtrending market a
candle with a long upper shadow and a small
real body occurs, is that bullish trend reversal
signal.
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WINDOW
Windows are gaps and they are a continuation and resistance pattern. A rising
window is a gap in upwards direction and a falling window is a gap in downwards
direction. The color of the candle is not meaningful.

DUMPLING TOP AND PAN BOTTOM
These candle patterns are similar to the Western rounding top. For the bullish
dumpling top you need a gap in the lower direction during an uptrend. For the
bearish pan bottom you need a gap in the upper direction during a downtrend.

MARUBOZU

Ó BEARISH AND BULLISH MARABOZU

A candle with a long body and without any
shadows is a marubozu, also known as
Marabozu. The body has to be longer than the
usual candles. The marubozu is a one of the
strongest bullish or bearish candle. It clearly
represent the victory for one side because high
and low values are equal to the open and close
values.

The color of the body defines if it is a bearish or
a bullish signal. A white body is a bullish signal
and a black body is a bearish signal on the
other side.

BELT HOLD
A belt hold can appear as bullish and bearish signal and indicates a trend
reversal. This pattern is similar to "Marubozu" above because the significant
candle has no lower shadow and only a short upper shadow.

A bullish belt hold occurs if during a uptrend with a series of bullish candles a big
long black candle appears. The open of this candle is lower than the close of the
prior candle.

In the other direction, a bearish belt hold occurs if during a down trend with a
series of bearish candles a big long white candle appears. The open of this
candle is lower than the close of the prior candle.

COUNTERATTACK
A counterattack can be bullish and bearish. Both patterns are signals for trend
reversals.
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A bullish counterattack occurs when a white candle occurs in a downtrend after a
series of a black candles. The open is lower than the prior open but the close and
the prior close are the same.

In the other direction, a bearish counterattack occurs when a black occurs in a
uptrend after a series of a white candles. The open is higher than the prior open
but the close and the prior close are the same.

CANDLESTICK PATTERNS WITH TWO CANDLES

ENGULFING PATTERN

Ó BEARISH AND BULLISH ENGULFING
PATTERN

Engulfing patterns occur on both sides, so as
bearish and bullish engulfing pattern. Engulfing
patterns are in both directions a signal for a
trend reversal.

If in a rising market a black real body appears
which envelopes the prior small white candle, is
that a bearish engulfing pattern.

A bullish engulfing pattern appears in a
descending market, if a large white body
envelops the prior black candle.

The second big candle does not have to engulf
the shadows in both cases, but at least the whole bodies have to be engulfed.

SEPARATING LINE
Separating lines can be bullish and bearish. The relation between the close and
open of the two candles is important. If the second open is the same as the open
of the first white candle and the second close is lower as before, a black candle is
formed and therefore it is a bearish signal. It is a bullish signal, if the second open
is the same as the open of the first white candle and the second close higher as
before. The second candle is then a white candle.

IN NECK AND ON NECK
In neck and on neck patterns are similar to "Separating Line" above but it focuses
on the close or low values, which are the same or at least almost the same.

For the on neck pattern a black candle with long body is followed by a smaller
white candle. The high of the white candle should be the low of the black candle
or almost the low.

117



The in neck pattern is also build from a long black candle followed by a small
white candle. The high of the white candle should be the close of the black candle
or almost the close.

PIERCING PATTERN AND DARK CLOUD COVER

Ó PIERCING LINE AND DARK CLOUD
COVER

Both patterns are signals for trend reversals.
The dark cloud cover is the bearish signal and
the piercing pattern, also known as piecing line,
is the bullish signal.

The piercing pattern occurs at the bottom of a
downtrend. The first candle is a long black
candlestick. The following white candle opens
with a gap and closes more than halfway into
the body of the prior black candle.

A dark cloud cover is performed if the first
candle in a uptrend is white and is followed by
black candle whose close is also more than halfway into the body of the prior
candle.

THRUSTING
A thrusting pattern starts with a long black candle. The following white candle
closes above the first close but not above the midpoint of the first body.

The interpretation of this pattern is not so easy. Traditional it is a confirmation for
the bearish trend, but there are also some evidence that it can be a bullish
reversal as well. So, you can combine this pattern with other patterns or wait for
the confirmation of this pattern within the following candles.

PITFALL

Ó BEARISH AND BULLISH PITFALL

Pitfall is a trend reversal pattern. After a big
candle, which is going with the current trend,
one candle with a gap against the current trend
appears. The second candle shows the new
trend.

In a downwards trend the first candle is black
and is followed by a big white candle with a
rising "Window" on page 116. In a upwards
trend the first candle is white followed by a big
clack candle with a falling window.
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If there is no window between the candles, are the names of this pattern sunrise
and sunset. Sunrise is the bullish pattern and sunset the bearish.

HARAMI

Ó BEARISH AND BULLISH HARAMI

A Harami pattern can be bullish and bearish. If
it is bullish or bearish, is controls by the color of
the candles and the current trend. It shows the
imbalance of the market's health.

For both signals the first candle has an
unusually big body and the second candle's
body is within the first candle's body.

For a bullish signal you need a market with a
down trend. The first candle is black and the
second smaller one is white.

For a bearish signal you need the opposite. While the market is in a downtrend,
the first candle should be white and second small candle should be black.

If the second candle is a "Doji" on page 115, is the pattern called Harami Cross.

TWEEZER BOTTOM/TOP

Ó TWEEZER BOTTOMS AND TOPS

Tweezer patterns appear in down- or upwards
trends. The same lows or highs are tested on
back-to-back sessions. The first candle is a big
candle and the second one is a smaller one or
even a "Doji" on page 115.

For a top pattern the first candle has to white
and the second candle black. For the bottom
pattern is it the other way around.
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CANDLESTICK PATTERNS WITH THREE CANDLES

THREE WHITE SOLDIERS/THREE BLACK CROWS

Ó THREEWHITE SOLDIERS AND THREE
BLACK CROWS

Both patterns consists of three candles with the
same color.

Three white soldiers consists of three white
consecutive candles in a upwards trends. The
open of each following candle has to be inside
the body of the previous one and the high of
each following candle has to be higher than the
previous one. If found at the bottom are the
three white soldiers a sign for a stability of the
upcoming trend.

Three black crows consists of three black
consecutive candles in a upwards trends. The open of each following candle has
to be inside the body of the previous one and the close of each following candle
has to be lower than the previous one. If it is found at the top of an uprising trend it
is reversal pattern.

TWO LITTLE BULLETS/SPINNINGS
Two little bullets is a bearish pattern which occurs in upwards trends. The first
candle has a long body and is followed by a candle with a small body or even a
"Doji" on page 115. This candle has to open with a rising "Window" on page 116.
The last candle has a small body.

The opposite pattern are the two little spinnings, which is a bullish pattern. The
only difference is that the "Window" on page 116 between the first and second
candle has to be a falling window. The first candle has a long body followed by the
second candle with a small body or a "Doji" on page 115. The last candle has also
a small body.
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MORNING/EVENING STAR

Ó MORNING OR EVENING STAR

Morning star and evening star are two opposite
patterns. The morning star is the bottom
reversal and the evening star is the top reversal
pattern. The second candle which is a star, see
"Star/Raindrop" on page 114, can show both
colors or can be a "Doji" on page 115 as well in
both patterns.

A morning star is formed, if the first candle has
a long black body, following by the star with a
gap below. At the end a white candle follows
which closes is within the first body. The star
rises from the black night to the bright day.

A evening star is the opposite and stars rises from the bright day into the dark
night. So the first tall candle has white body. The second is the star and opens
with a gap above. The last candle is a black candlestick which closes is within the
first body.

DELIBERATION
The deliberation pattern consist out of three candles that confirm the current trend
and its continuation. It can be bearish and bullish. The relation between three
candles is important.

The bullish deliberation is build when three black candles appear in a row in a
current downtrend. The second candle's open has to be inside the body of the
first one and the close has to be below the close of the first. The last candle is
short or even a "Spinning Top" on page 115 or a "Doji" on page 115 which opens
with a gap down. It shows the continuation of the downtrend.

The bearish deliberation is build when three white candles appear in a row in a
current uptrend. The relation between the candles is important. The second
candle's open has to have the same relation as for the bullish deliberation. The
body of the second candles has to be within the body of the first and the close has
to be above the first close. The last candle confirms the uptrend. It is short or even
a "Spinning Top" on page 115 or a "Doji" on page 115 and opens with a gap up.
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TASUKI GAP

Ó BEARISH AND BULLISH TASUKI GAPS

Tasuki gap is formed by three candles,
whereby the second following candles opens
with a gap from the first one. The last two
candles have the same size. The direction of
the gap or "Window" on page 116 and the
colors of the candles define if the pattern is
bullish or bearish. The bullish variation starts
with a white candles followed by a white candle
which opens with a rising window. A black candles closes the pattern. The
bearish variation is built from two black and one white candles and the gap is a
falling window.

TWO WHITE LINES
Two white lines can be a bullish or a bearish pattern and the characteristic
depends on the "Window" on page 116 between the first and second candle and
the colors of the first candle.

The bearish pattern starts with a black candle followed by a white candle which
opens with a falling window. The high of the second candle is higher than the low
of the first candle. The last candle is a white and the low is higher than the high of
the second candle.

On the opposite, the bullish pattern starts with a white candle followed by a white
candle which opens with a rising window. The high of the second candle is higher
than the low of the first candle. The last candle is a white and the low is higher
than the high of the second candle.

BEARISH UPSIDE GAP TWO CROWS
This pattern is a bearish trend reversal pattern. The first white candle is big and
the second black candle opens with a rising "Window" on page 116. The last
black candle opens at or above the open of the prior candle. The close is below
the close of the prior candle, but still above the close of the first candle, so the gap
to the first candle is still open. The two black candles show that the trend is not
strong enough anymore.

CANDLESTICK PATTERNS WITH MORE THAN THREE CANDLES

FALLING THREE/RISING THREE
The falling three and rising three are two opposite patterns. Both of the them
consist out of five candles and confirms the continuation either of a bearish trend
or a bullish trend.
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For a bearish trend, two black candles surround three small white candles. The
first black candle is long. The three white candles are within the high-low range of
the first candle. The last candle is black and theirs close builds a new low.

For a bullish trend the colors are the other way round. The first and last candles
are white and the candles in the middle are black. The middle black candles are
within the high-low range of the first candle. The close of the last white candle
builds a new high.

TRADING ALONG WITH CANDLE PATTERNS

Candle Patterns often predict trend reversal and are therefore a useful tool for
swing traders. Western technical analysis tools are behind the trend and only
indicate a trend change with a delay. The disadvantage of candles is that the
signal is only shown, when the candle is finished and closed. So for daily candles
you will get the result only at the end of the day. There is no unanimous
recommendation with which period candle patterns work at best. Different traders
use candle pattern on different periods simultaneous or individually.

When interpreting candle patterns please consider the current market situation in
addition. Several patterns have bullish and bearish variations, which are only
valid in down- or upwards trends. As long as no valid trend is established in the
market, the signals are invalid. In addition some candle patterns work better in a
certain market as in another.

You can also combine the signals of multiple candle patterns. Multiple patterns
indicate a trend reversal whereas a single candle pattern indicates often a
support or resistance line. As a "Candlestick Chart" on page 110 uses the same
values as a normal "Bar Chart" on page 109, you can use western technical
analysis tools in addition. Candle patterns do not indicate any price targets.
Different traders use in addition western techniques like "Pivot Points Analysis"
on page 737, "Relative Strength Index" on page 753 and moving averages as
"MACD" on page 675.

If you use our build-in strategies please ensure that you use strategies that
complement each other, short entry and short exit. Most of the time a bullish
strategy has to be combined with a bearish strategy and vice versa, to build a
complete system.
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LINE CHART

Ó LINE CHART

Line charts are a classic type of chart, in which
data points are connected by a line, e.g.
physical data in axes of coordinates. The line
chart can be set as the default chart type in
Tradesignal.

Tip: For more information see chapter "Chart" on page 96

In Tradesignal, line charts are used for
displaying

à time lines for symbols, e.g. for Open, High, Low or Close

à indicator results

à performance development of a trading system

à additional information like fundamental data and market depth
indices.

The line chart is the simplest chart type for stocks. From trading period to trading
period, the line is extended for new prices.

For symbols, the lines are usually drawn for closing prices.

GENERAL CHART PROPERTIES
When the chart is active, you can edit the chart properties in the toolbox, for
example the history length, the axes and legends.

You can also

à set the period and time span, see the chapter "Time Spans
and Periods" on page 218.

à change the chart look, see the chapter "Settings" on
page 157.

CONTENT-DEPENDENT CHART SETTINGS
In the properties of the displayed stock (symbol), you can find additional
parameters. Apart from the Standard Properties you can find specific parameters
for this chart type.

INSTRUMENT PROPERTIES
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Input Select which data to use for calculating the chart (Open, High, Close, Low,
Volume).

LINE PROPERTIES

Color Here you can select a color for the line.

Width Here you can set a line width by entering a number.

Style Here you can select a line style, e.g. solid or dotted.

Shadow Here you can set a shadow for emphasizing the line with a 3D effect. Four
settings are available.

For more information see chapter

STEPPED LINE CHART

Ó STEPPED LINE CHART

The stepped line chart is a variation of the
normal line chart. The price levels are
connected not by direct lines but at right
angles. Stepped line charts can only be used
for stocks.

GENERAL CHART PROPERTIES
When the chart is active, you can edit the chart
properties in the toolbox, for example the
history length, the axes and legends.

You can also

à set the period and time span, see the chapter "Time Spans
and Periods" on page 218.

à change the chart look, see the chapter "Settings" on
page 157.

CONTENT-DEPENDENT CHART SETTINGS
In the properties of the displayed stock (symbol), you can find additional
parameters. Besides the Standard Properties, you can find specific parameters
for this chart type.

INSTRUMENT PROPERTIES

Input Select which data to use for calculating the chart (Open, High, Close, Low,
Volume).
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STEPPED LINE PROPERTIES

Color Here you can select a color for the line.

Width Here you can set a line width by entering a number.

Style Here you can select a line style, e.g. solid or dotted.

Shadow Here you can set a shadow for emphasizing the line with a 3D effect. Four
settings are available.

SYMBOL CHART

Ó SYMBOL CHART

The symbol chart is a variation of a normal line
chart, displaying the chosen input (open, close,
high...) as unconnected symbols. Several
symbol types can be set for the display.

GENERAL CHART PROPERTIES
When the chart is active, you can edit the chart
properties in the toolbox, for example the
history length, the axes and legends.

You can also

à set the period and time span, see chapter "Time Spans and
Periods" on page 218.

à change the chart look, see chapter"Settings" on page 157.

CONTENT-DEPENDENT CHART SETTINGS
In the properties of the displayed stock (symbol), you can find additional
parameters. Beside the Standard Properties, you can find specific parameters for
this chart type.

INSTRUMENT PROPERTIES

Input Select which data to use for calculating the chart (Open, High, Close, Low,
Volume).

DOTTED LINE PROPERTIES

Style Here you can select a symbol style, e.g. circles, squares etc.

Size Here you can set the symbol size.

Border Color Here you can select a border color for the symbol.

Fill Color Here you can select a fill color for the symbol.
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Connect Here you can select whether the symbols should be connected.

Anchor Here you select to what the symbols should be aligned to.

FILLED AREA CHART

Ó FILLED AREA CHART

Filled area charts, as indicated by the name,
are charts in which filled areas between
selected input data is displayed. You can use
filled area charts for:

à Drawing a filled area between the
prices and the base line (default)

à Drawing a filled area between
different price levels

Filled area charts are not useful for detailed
symbol analysis, as too much information is lost in this kind of charting.

GENERAL CHART PROPERTIES
When the chart is active, you can edit the chart properties in the toolbox, for
example the history length, the axes and legends.

You can also

à set the period and time span, see chapter "Time Spans and
Periods" on page 218.

à change the chart look, see chapter"Settings" on page 157.

CONTENT-DEPENDENT CHART SETTINGS
In the properties of the displayed stock (symbol), you can find additional
parameters. Besides the Standard Properties, you can find specific parameters
for this chart type.

INSTRUMENT PROPERTIES

Baseline Here you can set a value for the price baseline, e.g. raise the baseline to
"40".

Input A Select the data to be used as upper line of the area (Open, High, Close,
Low or Volume).

Input B Select the data to be used as lower line of the area (Open, High, Close,
Low, Volume or Baseline).
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FILLED AREA PROPERTIES

Color 1 Here you can select a color for the top line.

Color 2 Here you can select a color for the bottom line.

Area Color Here you can set a color and transparency for the filled area.

FOREST CHART

Ó FOREST CHART

Forest charts are histograms. For each input
value in the timeline, a bar (also called
"needle") is drawn.

Forest charts are not useful for detailed symbol
analysis, as too much information is lost in this
kind of charting. They are more commonly
used for indicators, where relative changes per
day can be emphasized by needles in different
colors.

In Tradesignal, forest charts can be used for:

à symbol prices (by selecting the entry in the chart menu)

à the trading Volume (in the stock properties in the toolbox; this
is available as an addition for every chart type)

à indicators; however, for those, the equilla scripts have to be
adapted. You can find a tutorial for doing so in the "Tutorial:
Indicator as Forest" on the next page.

GENERAL CHART PROPERTIES
When the chart is active, you can edit the chart properties in the toolbox, for
example the history length, the axes and legends.

You can also

à set the period and time span, see chapter "Time Spans and
Periods" on page 218.

à change the chart look, see chapter"Settings" on page 157.

CONTENT-DEPENDENT CHART SETTINGS
In the properties of the displayed stock (symbol), you can find additional
parameters. Besides the Standard Properties, you can find specific parameters
for this chart type.

128



INSTRUMENT PROPERTIES

Input Select which data to use for calculating the chart (Open, High, Close, Low,
Volume).

HISTOGRAM PROPERTIES

Histogram Color Here you can select a color for the histogram bars.

TUTORIAL: INDICATOR AS FOREST

Ó FOREST CHART

To display indicators as a forest chart, the
indicator code has to be adapted accordingly.
In the following tutorial, we show you how to set
up a Momentum indicator as a forest chart with
the needles in two different colors, depending
on their direction.

THE TRADITIONAL MOMENTUM
INDICATOR
You can find the traditional Momentum
Indicator in the list of all indicators in the Toolbox. Right-click the indicator to open
the context menu and choose Edit. The editor with the indicator's equilla code
opens.

Meta:
Synopsis( "The Momentum indicator utilizes price and volume statistics

for predicting the strength or weakness of a current market and any
overbought or oversold conditions, and may indicate turning points within
the market." ),

ShortCode( "MOM" ),
SubChart( True );

Inputs:
Price( Close ),
Period( 10, 1 ),
ShowAlerts( False );

DrawLine( Momentum( Price, Period ), "MOM" );
DrawLine( 0, "Zero Line", StyleDot );

CheckForCrossAlert( Plot1, 0, "Momentum", "Zero Line", ShowAlerts );
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COPY THE MOMENTUM INDICATOR CODE AS BASIS FOR THE NEW
INDICATOR

01. Click on New Indicator in the Related Tasks area of the
toolbox to start a new indicator.

02. Name the new indicator Momentum Forest.

03. Select the complete code by clicking CTRL+A.

04. Copy the contents by clicking CTRL+C.

05. Click in the new, empty editor window and press CTRL+V to
insert the copied contents.
Alternatively, you can find all these functions in the context
menu of the editor, which you can open by right-clicking the
editor window.

EDITING THE MOMENTUM FOREST INDICATOR FOR DISPLAY AS A
FOREST CHART
First, you have to delete some lines in the code we do not want to use:

ShowAlerts( False ); (make sure that the line above ends with a semicolon
";")

CheckForCrossAlert( Plot1, 0, "Momentum", "Zero Line", ShowAlerts );

Then you need two variables for your indicator:

à one variable to save the momentum calculation

à one variable to save the color setting for the forest display

For this, enter the following lines beneath the Inputs area:

Variables:
momValue, forestColor;

Below, enter the formula for the momentum calculation:

//Calculate Momentum
momValue = Momentum( Price, Period );

Now you need the condition for the needle colors. If the Momentum rises in
comparison to the previous day, the needle should be displayed in green;
otherwise, the needle should be red.

130



//Set color depending on the change in comparison to the previous day
if momValue > momValue[1] then

forestColor = DarkGreen
else

forestColor = Red;

To display the result as forest chart, you have to substitute the first DrawLine line
with the following:

//Drawing command with color variable
DrawForest(0, momValue,"Zero","MomentumUp",thick,forestColor,true);

The color of the needle is given by the dynamically set variable forestColor. The
base line remains unchanged.

In the META area of the code you can now edit the synopsis and enter a specific
ShortCode. With the latter, you can later call up your new indicator from the
command line.

COMPILING AND APPLYING THE MOMENTUM FOREST INDICATOR

Meta:
Synopsis( "The Momentum Forest is a variation of the Momentum Indicator,

displaying the values in Forest fashion with color coding for up/down
development. The Momentum indicator utilizes price and volume statistics for
predicting the strength or weakness of a current market and any overbought
or oversold conditions, and may indicate turning points within the market."
),

ShortCode( "MOMF" ),
SubChart( True );

Inputs:
Price( Close ),
Period( 10, 1 );

Variables:
momValue, forestColor;

//Calculate Momentum
momValue = Momentum( Price, Period );

//Set color depending on the change in comparison to the previous day
if momValue > momValue[1] then
forestColor = DarkGreen
else
forestColor = Red;

//Drawing command with color variable
DrawForest(0, MomValue,"Zero","MomentumUp",thick,forestColor,true);
DrawLine( 0, "ZeroLine", StyleDot)
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Compile the indicator by pressing the F7 key or by clicking the Compile Script
button in the Equilla menu in the toolbar.

The indicator is now available in the indicator list in the toolbox. From there, you
can apply it to a chart by either pulling it into a chart via drag-and-drop or by
selecting Apply from the context menu.

LINKED FOREST CHART

Ó LINKED FOREST CHART

The linked forest differs only marginally from
the Forest Chart. The top of the needles are
connected by a line. Other than that, the chart
is identical to the forest chart.

This chart is less helpful for symbol charting, as
the connection with the baseline can lead to
distorted values for longer histories.

GENERAL CHART PROPERTIES
When the chart is active, you can edit the chart properties in the toolbox, for
example the history length, the axes and legends.

You can also

à set the period and time span, see chapter "Time Spans and
Periods" on page 218.

à change the chart look, see chapter"Settings" on page 157.

CONTENT-DEPENDENT CHART SETTINGS
You can find the symbol parameters in the properties of the displayed stock
(symbol), see the chapter "Forest Chart" on page 128.

CANDLE VOLUME CHART

Ó CANDLE VOLUME CHART

Candle volume charts combine charts of prices
and volumes. The following information is
available:

à The high of the trading period, given
by the end of the upper shadow.

à The low of the trading period, given
by the end of the lower shadow.
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à The open price, given by the body edge; either the bottom line
in the case of an upwards development, or the top line in the
case of a downwards development.

à The close price, given by the body edge; either the top line in
the case of an upward development, or the bottom line in the
case of a downward development.

à The direction of the price movement, given by the body color.
Colors are usually red or black for falling and green or white
for rising prices. The color settings can be changed.

à The magnitude of the price movement, given by the length of
the body and the shadows. The total length of a candlestick
between the wicks is the difference between high and low.

à The trading volume, given by the width of the candle body.

Candle volume charts are a mixture of candlestick and equi volume charts. The
candle interpretation is the same as for Candlestick Charts, but the width of the
candle depends on volume, not on time. The difference to an "Equi Volume
Chart" on the next page is that, as opposed to that chart type, the open and close
prices are still available in the candle volume charts.

LIMITATIONS
At each end of the quarter, there is an expiration date on which futures of stocks,
indices and commodities expire and/or new futures are issued. On these days,
there are often extremely high trading volumes for symbols. Candle volume
charts may be overly influenced by them, resulting in no sensible values for these
dates. To avoid this issue, ignore these dates.

GENERAL CHART PROPERTIES
When the chart is active, you can edit the chart properties in the toolbox, for
example the history length, the axes and legends.

You can also

à set the period and time span, see chapter "Time Spans and
Periods" on page 218.

à change the chart look, see chapter"Settings" on page 157.

CONTENT-DEPENDENT CHART SETTINGS
In the properties of the displayed stock (symbol), you can find additional
parameters. Besides the Standard Properties, you can find specific parameters
for this chart type.
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CANDLE VOLUME PROPERTIES

Border Color Here you can select a color for the border.

Show Frame Here you can select whether the candle frame will be displayed or
hidden.

Bullish Color Here you can select a color and opacity for upward candles.

Bearish Color Here you can select a color and opacity for downward candles.

EQUI VOLUME CHART

Ó EQUI VOLUME CHART

Equivolume charts are a combination of price
movement and trading volume charts. The
chart gives information on high, low, volume
and price direction per trading period.

Equivolume charts were introduced by Richard
W. Arms Jr. It was well-known that the trading
volume was an important criterion for
assessing the current and future situation in the
market. Arms consequently introduced the
volume - which up to that date was only
displayed as an additional histogram - into the
chart itself by plotting price versus volume. This way, information about open and
close prices and the normal time line are lost.

TRADING INFORMATION IN EQUI VOLUME CHARTS
The following information is available in the boxes:

à The high per trading period, given by the top line of the box

à The low per trading period, given by the bottom line of the box

à The trading volume, given by the width of the box. Because of
this display choice, the timeline information is distorted.

à The direction of the price movement, given by the box color.
Colors are usually red or black for falling and green or white
for rising prices. The color settings can be changed.

à The open and close prices are not given in this chart type.
However, this limitation is compensated by the strong visual
display of buying powers and selling pressures within a
market.
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EQUI VOLUME CHART PATTERNS
In equi volume charts, four typical patterns can be found that give information on
the current market and trends, similar to single candles in candlestick charts. See
the graphic for more details.

NARROW BARS

Usually seen in balanced markets. The price movements result from relatively
small trading volumes. Several consecutive narrow bars may signal a distinctive
trend setting in, though not as strong as one indicated by power bars, see below.

SQUARES

The price spans are small although there is significant trading activity. The pattern
may indicate resistance areas in the chart or appear exactly at the point of trend
or resistance lines. Insecurity rules the market, and the resulting wins and losses
were achieved under counter pressure.

OVERSQUARES

Both sides of the market are strongly into trading. Large ask volumes have met
large bid volumes. The price span is very small. The pattern can be interpreted as
trend reversal and be combined with other triggers in charts.

POWER BARS

Named after the snack food. In an equivolume chart, Power Bars result from a
large price movement based on an active market. They can be interpreted as
important breaks and be combined with other triggers in charts.

GENERAL CHART PROPERTIES
When the chart is active, you can edit the chart properties in the toolbox, for
example the history length, the axes and legends.

You can also

à set the period and time span, see chapter "Time Spans and
Periods" on page 218.

à change the chart look, see chapter"Settings" on page 157.

CONTENT-DEPENDENT CHART SETTINGS
In the properties of the displayed stock (symbol), you can find additional
parameters. Besides the Standard Properties, you can find specific parameters
for this chart type.
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EQUI VOLUME PROPERTIES

Border Color Here you can select a color for the border.

Show Frame Here you can select whether the candle frame will be displayed or
hidden.

Bullish Color Here you can select a color and opacity for upward boxes.

Bearish Color Here you can select a color and opacity for downward boxes.

KAGI CHART

Ó KAGI CHART

Kagi charts originated in Japan like the
Candlestick Charts. They are related to "Renko
Chart" on the next page and "Three Line Break
Chart" on page 139.

A Kagi chart consists of vertical lines that are
connected by horizontal lines. The direction of
the vertical lines is drawn depending on the
price movements. The time relation, trading
volume and chart information such as high and
low prices are not taken into account.

Kagi charts display the bid and ask, i.e. the trend of the market.

CONSTRUCTION AND INFORMATION IN A KAGI CHART
In a Kagi chart, a vertical line is drawn as long as the current price direction is
maintained. If a trend reversal takes place in the price development, the price has
to be at least as large as the defined reversal amount to cause a trend reversal in
the chart. In case of a trend reversal, a horizontal line is drawn to the next
"column" and a vertical line is started in the other price direction.

The time elapsed is unimportant for this kind of charting. The time axis is not
linear.

Increasing and decreasing prices are shown in different colors, e.g. black/red.
The colors can be set in the properties.

When trading with Kagi charts, remember that the filtering effect inherent to the
method leads to delayed signal generation.
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GENERAL CHART PROPERTIES
When the chart is active, you can edit the chart properties in the toolbox, for
example the history length, the axes and legends.

You can also

à set the period and time span, see chapter "Time Spans and
Periods" on page 218.

à change the chart look, see chapter"Settings" on page 157.

CONTENT-DEPENDENT CHART SETTINGS
In the properties of the displayed stock (symbol), you can find additional
parameters. Besides the Standard Properties, you can find specific parameters
for this chart type.

INSTRUMENT PROPERTIES

Reversal Enter a reversal value here. In case of a trend change, the price has to
move by at least the reversal amount before a new vertical line in the opposite
direction is drawn in the Kagi chart.

KAGI PROPERTIES

Bullish Color Here you can select a color for the bullish line.

Bullish Width Here you can set a bullish line width by entering a number.

Bearish Color Here you can select a color for the bearish line.

Bearish Width Here you can set a bearish line width by entering a number.

RENKO CHART

Ó RENKO CHART

Renko charts originated in Japan like the
Candlestick Charts. They are related to "Kagi
Chart" on the previous pageand "Three Line
Break Chart" on page 139. The name derived
from the Japanese word Renga for bricks.

A Renko chart consists of bricks. Only one
input, e.g. the daily close is necessary for
drawing a Renko chart. The time relation,
trading volume and chart information such as
high and low prices are not taken into account.

Renko charts show the trend of the market.
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CONSTRUCTION AND INFORMATION IN A RENKO CHART
In a Renko chart, a brick is drawn if the price moved by a defined amount, called
the bricksize. The price of the current day is always compared to the price of the
last brick (which can be much older than a day). The Renko chart drops all price
movements smaller than the bricksize. Therefore, only major trends of a stock are
visible in the Renko chart. Small movements fall out of the graph.

The time elapsed is unimportant for this kind of charting. The time axis is not
linear.

Bricks of downward and upward direction are displayed in different colors, e.g.
black/red. The colors can be set in the properties.

When trading with Renko charts, remember that the filtering effect inherent to the
method leads to delayed signal generation.

GENERAL CHART PROPERTIES
When the chart is active, you can edit the chart properties in the toolbox, for
example the history length, the axes and legends.

You can also

à set the period and time span, see chapter "Time Spans and
Periods" on page 218.

à change the chart look, see chapter"Settings" on page 157.

CONTENT-DEPENDENT CHART SETTINGS
In the properties of the displayed stock (symbol), you can find additional
parameters. Besides the Standard Properties, you can find specific parameters
for this chart type.

INSTRUMENT PROPERTIES

Input Select which data to use for calculating the chart (Open, High, Close, Low,
Volume).

Bricksize Enter how many ticks give a brick, or enter a percentage value (e.g.
"10%"). The bricksize works like a noise filter. It defines how much the input has
to move from the last given brick value before a new brick is drawn.

Reversal Enter the number of bricks that have to be generated in the reverse
direction to cause a change in trend. The higher the value, the stronger the trend
reversal has to be to be displayed in the Renko chart.
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Compress Bricks Here you can select whether bricks of the same price will be
merged.

Daily Restart Here you can select whether the Renko chart calculation should start
anew each day.

Startvalue from Open Here you can select whether instead of the input given above,
the open value should always be used as start value.

RENKO PROPERTIES

Color Here you can select a color for the line border.

Bullish Color Here you can select a color and opacity for the bullish brick.

Bearish Color Here you can select a color and opacity for the bearish brick.

Open Color Select the color for open bricks, i.e. if no close price is available yet.

Show Thresholds Here you can select whether the price levels that have to be
crossed to result in new bricks should be displayed as small, right-aligned lines in
the chart.

Artificial Brick Highlight Here you can select whether bricks that were artificially
created due to price gaps between bricks should be highlighted by transparent
colors. Select a transparency from the list.

THREE LINE BREAK CHART

Ó THREE LINE BREAK CHART

Three Line Break charts originated in Japan
like the Candlestick Charts. They are related to
"Kagi Chart" on page 136 and "Renko Chart"
on page 137.

A Three Line Break chart consists of vertical
lines ("boxes") connected to each other. The
direction of the lines is drawn based on price
movements. The time relation, trading volume
and chart information such as high and low
prices are not taken into account.

Three Line Break charts are especially useful for detecting changes in trends.

CONSTRUCTION AND INFORMATION IN A THREE-LINE-BREAK
CHART
A Three Line Break chart differs from traditional chart types.
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à In principle, a new line is drawn when the price exceeds the
previous price's high or low. If the price does not exceed the
price benchmarks of the day before, no line is drawn.

à For a "Three Line Break", the same rule applies; however,
after three lines of the same color, the price must reverse the
amount of the last three lines to cause a trend change in the
graph. Price movements that lead neither to a reversal nor to
a line of the current direction are ignored.

The number of lines taken into account for the break is given by the Reversal
parameter. For short-term trades it might be smaller than 3, for long-term trades 4
or higher. The setting "3" is the default value that gave the method its name.
Please note that the Reversal parameter gives the number of lines to be taken
into account, not a fixed price value as for the related methods Kagi and Renko.
Therefore, the price at which the trend change occurs in the chart is relative.

The time elapsed is unimportant for this kind of charting. The time axis is not
linear.

Lines (boxes) of downward and upward direction are displayed in different colors,
e.g. black/red. The colors can be set in the properties.

For a Three Line Break chart, a typical 'buy' signal is a trend change after three
downwards lines, while a 'sell' signal is a trend change after three upwards.
Remember that the filtering effect inherent to the method leads to delayed signal
generation.

GENERAL CHART PROPERTIES
When the chart is active, you can edit the chart properties in the toolbox, for
example the history length, the axes and legends.

You can also

à set the period and time span, see chapter "Time Spans and
Periods" on page 218.

à change the chart look, see chapter"Settings" on page 157.

CONTENT-DEPENDENT CHART SETTINGS
In the properties of the displayed stock (symbol), you can find additional
parameters. Besides the Standard Properties, you can find specific parameters
for this chart type.
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INSTRUMENT PROPERTIES

Reversal Enter the number of lines to be taken into account for determining trend
reversals.

Input Select which data to use for calculating the chart (Open, High, Close, Low,
Volume).

THREE LINE BREAK PROPERTIES

Border Color Here you can select a color for the line border.

Bullish Color Here you can select a color for the bullish line.

Bearish Color Here you can select a color for the bearish line.

HEIKIN ASHI CHART

Ó HEIKIN ASHI CHART

At first glance Heikin Ashi charts are very
similar to "Candlestick Chart" on page 110. It is
also a charting style originally from Japan and
uses candles to visualize prices and their
movement. Heikin Ashi charts are based on
averaged prices, a result of this is the
noticeable absence of gaps between candle
bodies which makes it easier to recognize price
trends.

Like other candlestick charts it gives information about the open, high, low and
close prices and about the direction and magnitude of the price movement. It is
this wealth of information and the distinct patterns that makes the candlestick
charts so interesting. The direction and movement of prices can be better
perceived than by using bars. More complex candlestick patterns are often used
as the basis for trading decisions.

FORMULAS
The Heikin Ashi chart type uses the following formulas to compute each candle's
values.

In the following equations let open, close, high, low denote the input values and
haOpen, haClose, haHigh and haLow the corresponding Heikin Ashi values.
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For the first candle Heikin Ashi uses for its haOpen-value the open-value of the
input, subsequent candles use the arithmetic average of the previous candle's
haOpen and haClose-values.

TRADING INFORMATION IN HEIKIN ASHI
The following information is available in the candle body and the shadows (the
lines on bottom and top, also called wicks):

à The high of the trading period, given by the end of the upper
shadow.

à The low of the trading period, given by the end of the lower
shadow.

à The open price, given by the body edge; either the bottom line
in the case of an upwards development, or the top line in the
case of a downwards development.

à The close price, given by the body edge; either the top line in
the case of an upward development, or the bottom line in the
case of a downward development.

à The direction of the price movement, given by the body color.
Colors are usually red or black for falling and green or white
for rising prices. The color settings can be changed.

à The magnitude of the price movement, given by the length of
the body and the shadows. The total length of a candlestick
between the wicks is the difference between high and low.
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More information can be gathered when several candlesticks are seen in context.
Patterns of up to three candles are used to take a closer look at the price
movements and their quality. For example, candles with bodies of the same color
show more pronounced trends. Trading is often done based on a mixture of
candlestick pattern analysis and other methods.

GENERAL CHART PROPERTIES
When the chart is active, you can edit the chart properties in the toolbox, for
example the history length, the axes and legends.

You can also

à set the period and time span, see chapter "Time Spans and
Periods" on page 218.

à change the chart look, see chapter"Settings" on page 157.

CONTENT-DEPENDENT CHART SETTINGS
In the properties of the displayed stock (symbol), you can find additional
parameters. Besides the Standard Properties, you can find specific parameters
for this chart type.

CANDLES PROPERTIES

Border Color Here you can select a color for the border.

Show Frame Here you can select whether the candle frame will be displayed or
hidden.

Bullish Color Here you can select a color and opacity for upward candles.

Bearish Color Here you can select a color and opacity for downward candles.

INDICATORS AND STRATEGIES
In the indicator overview, you can find the indicator Candle Pattern which includes
a long list of typical candlestick patterns to choose from. You can edit these
patterns in the graph properties in the toolbox. The set pattern is displayed in the
graph.

In the strategies overview, you can find strategies such as Candle Bearish
Engulfing - Exit, Candle Big White Candlestick - Exit, and many more that you can
apply to your candlestick chart.
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POINT AND FIGURE CHART

Ó POINT AND FIGURE CHART

Point and Figure Charts (P&F charts) are an
old charting type that is independent of time.

P&F charts show two kinds of symbols.
Depending on the price movement and range,
a number of symbols are drawn. The time
relation and trading volume are not taken into
account.

Point and Figure charts are helpful for trend
detection, as they show trends as well as easily
identifiable resistance and support zones.
There are also Equilla indicators for 45 degree trend lines and support resistance
levels.

For more information see chapter "Using Indicators" on page 372.

TRADING INFORMATION IN A P&F CHART
A P&F chart consists of columns of symbols of the same type.

à Rising prices are drawn with crosses (also called Xs).

à Falling prices are drawn with circles (also called Os).

In a P&F chart these symbols are called boxes and cover a certain price range
known as the box size. A new symbol is added to a column once the price
movement of the instrument exceeds the box size of the box in trend direction, i.e.
in an X-column (rising prices) a new box is drawn when the prices reaches a
value above the new box's price range. Movements below that value are ignored.
This way, the box size determines how much the price movements are filtered.
Large box sizes filter many movements. Small box sizes show movements better,
but also have a smaller filter effect.

The reversal parameter of a P&F chart dictates by how many box sizes the price
movement has to change in order to establish a new trend which also entails
drawing a new column of the opposite type of boxes. For example: for a Reversal
value of "3", after a breakout, the counter trend has to exceed three box sizes to
change the trend in the chart. Please note that the Reversal parameter gives the
number of boxes to be taken into account, not a fixed price value as for the related
methods Kagi and Renko. Therefore, the price at which the trend change occurs
in the chart is relative. Price movements that lead neither to a reversal nor to a
new symbol of the current direction are ignored.
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The time elapsed is unimportant for this kind of charting. The time axis is not
linear.

Alternating months are displayed in different colors, e.g. black/red. The colors can
be set in the properties. (The months are not relevant for the method, but are
displayed for a better overview.)

GENERAL CHART PROPERTIES
When the chart is active, you can edit the chart properties in the toolbox, for
example the history length, the axes and legends.

You can also

à set the period and time span, see chapter "Time Spans and
Periods" on page 218.

à change the chart look, see chapter"Settings" on page 157.

Select the grid style Graph Paper in the "Settings" on page 157 if you want the
boxes of a P&F chart to be enclosed by grid lines.

CONTENT-DEPENDENT CHART SETTINGS
In the properties of the displayed instrument, you can find additional parameters.
Besides the Standard Properties, you can find specific parameters for this chart
type.

INSTRUMENT PROPERTIES

Boxsize Mode Enter a method to calculate the box size

à Constant price

à Constant points

à Percentage of close, close value on Base Date is used

à Average True Range, values up to Base Date are used

à Logarithmic, i.e. box size increases for rising prices, initial box
size is based on the open value on Base Date

Boxsize Dependent on the selected Boxsize Mode this value is interpreted as

à Constant price: a price

à Constant points: a number of points

à Percentage of close: a percentage value
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à Average True Range: the period of the ATR, i.e. a weighting
factor applied to the EMA

à Logarithmic: the percentage by which box sizes increase for
rising prices

à For the percentage based values, note that the % sign is
implied.

Recalculate Boxsize This controls whether the suggested box size is recalculated in
case the underlying instrument changes. Designed for situations where the
Boxsize Mode is set to Constant Price or Constant Points. Upon instrument
change the scale of value will adapt to the new instrument and the boxsize will be
recalculated, e.g. if you switch from an index to one of its constituents. If the
property is set to After Instrument Replace and the instrument in the chart is
replaced, the box size will be recalculated to a suitable value to fit the price range
of the new instrument. If the property is set to Never the Box Size will keep its
automatic or manually set value irrespective of other changes to the chart.

Base Date This property is used for Percentage of close, Average True Range and
Logarithmic. If an invalid date is specified or the date is no longer available, it will
be adjusted.

Reversal Enter the number of boxes to be taken into account for a trend reversal.

1-Box reversal If the reversal property is set to one, this property determines if one-
box reversals are compressed into the next column (Standard option), or if a new
column is always created (New Column option).

High-Low Select if boxes and reversals should be calculated against the high and
low values instead of the close value.

Initial Trend Here you can choose how the to establish the initial trend. Possible
methods are:

à High-Low Range: At least reversal boxes must be spanned by
the highest high and lowest low to establish a trend. If this
happens on the first bar, the close value is compared to the
midrange of high and low to determine if an X or O is drawn. If
the trend is established on a later bar, the most recently
updated extreme value (highest high or lowest low)
determines whether the first column contains X or O. This will
always draw at least reversal boxes in the first column.

à High-Low Range (simplified): This is similar to High-Low
Range, but establishes a trend on the first price movement, so
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it may start a column with just one box. (note: this mode was
called Traditional in previous versions)

à Close Range: This mode also requires reversal boxes to be
spanned by the highest and lowest value, but only considers
close prices. This will always draw at least reversal boxes in
the first column. (note: this mode was called Smoothed in
previous versions)

à Two Box Method: This method compares the high and low
prices of the first bar against high and low prices of
subsequent bars. If the high values are found to be at least
one box apart, Xs will be drawn. If this is not the case the lows
are compared and if they are at least one box apart, Os will be
drawn. This will always draw at least two boxes in the first
column.

P&F PROPERTIES

Color Change Specifies under which circumstances the colors alternate. This
property is available in Tradesignal 7.3 and above.

à Yearly: The color changes as soon as a new year starts

à Monthly: The color changes as soon as a new month starts.

à Weekly: The color changes as soon as a new week starts.

à Daily: The color changes as soon as a new day starts.

à Hourly: The color changes as soon as a new hour starts.

à Every Column: The color changes for every column. X
columns are drawn using Color 1 and O columns are drawn
using Color 2.

Color 1 / Color 2 Set the symbol colors for alternating months. The displayed
symbols toggle between Color 1 and Color 2. In Tradesignal 7.3 and above the
Color Change property controls how the colors alternate.

INDICATORS IN POINT & FIGURE CHARTS
Indicators and strategies can be applied to a Point & Figure chart like any other
chart type. The main issue to be aware of is how the values for Open, High, Low
and Close are interpreted. The box value at the top and bottom of a column will
determine the high and low respectively. The open will be equal to the low value
for an X column and equal to the high for an O column. The close will be equal to
the high value for an X column and equal to the low for an O column. An additional
field called Midpoint is available for input to an indicator, this will be the value of
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the middle box in a column, or the mean value between the two middle boxes if a
column has an even number of boxes.

To apply a Simple Moving Average to a Point & Figure chart using the column
Midpoint

01. Drag and drop the indicator Moving Average Simple from the
Indicator Toolbox onto the point and figure chart.

02. Click on the moving average line in the chart (or the legend),
to select the average.

03. In the mini toolbar, locate the Price property for the moving
average and change it to Midpoint.

MARKET PROFILE

Market Profile charts were invented in the 1980s. The goal was to offer a better
analysis method to traders at the US commodity markets. The development was
done in cooperation between the trader Peter Steidlmayer and the Chicago Board
of Trade (CBOT).

Market Profile charts are different from the normal display of the price movements
versus the time line. While the prices are still given on the x-axis, the time line is
given in units of "Time Price Opportunities" (TPO) that are marked with letters.
This results in a more or less bell-shaped distribution of the TPOs over the price
span of the trading day.

Use the Market Profile chart for

à Analyzing the distribution of trading activity

à Analyzing the "Fair Value" span with most of the trading
activity

à Analyzing the volume distribution over the trading day

à Analyzing of trend movements

Tradesignal offers you Market Profile charts as a designated chart type. However,
it is not available for all versions. As an alternative for displaying the volume/price
correlation, you can use the indicator "Price Volume Profile" that is delivered with
Tradesignal.

Due to the special focus of the tick-based Market Profile, it is usually only
displayed for one or two trading days. If you want to display more than two trading
days, the history length has to be set to the maximal value of 500000 ticks. If your
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data provider offers this history length, you can display up to eight days as Market
Profile.

CREATING A MARKET PROFILE
For a Market Profile, stocks, futures, commodities, currencies etc. can be used as
long as they show a high trading frequency per day.

For a quick look at the chart type, right-click on an index in the symbol list and
selectOpen in Market Profile.

CONSTRUCTION AND INFORMATION IN A MARKET PROFILE
The time units for the graph are fixed intervals called "Time Price Opportunities"
(TPOs). They are basically trading periods. The standard setting is 30 minutes
but can also be set to one hour.

For each TPO, a letter is used, starting with a capital "A". When the start of the
trading is entered correctly, the "A" is displayed in the chart for the first price in the
first TPO. For each new price level traded in that TPO, the letter "A" is added. The
size of each price level is set in the Scale factor. For example, for a scale factor
of "2", the price has to change 2 points (or cents) to open a new price level.

After the first TPO, the price levels traded in the second TPO are displayed in the
chart with a "B", in the third with "C" and so forth.

The result of this continuous recording is a pictorial representation of the trading
activity in relation to the time line. In the chart given as example below, the price
had a very small range for a while until it broke out. The large protrusion for the
letters D and E shows that in the range of 6370 points, an equilibrium was formed.
Such an equilibrium is called the Fair Value Area. At the end of the trading day,
the position of the Fair Value Areas in regard to their position in the total price
range can be evaluated.

As additional information, a brown and a black bar are displayed. The black bar
spans 70% of the time with the highest trading activity. The brown bar spans 70%
of the highest trading activity (in volume). The two rectangles mark the respective
maxima.

ELEMENTS IN A MARKET PROFILE CHART

BLACK FRAMED AREA IN THE EXAMPLE GRAPH

Here, the price versus time is displayed. Each letter stands for a TPO (Time Price
Opportunity). Above this area, in the header of the chart, the following data is
displayed (from top to bottom):
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à The highest price level traded

à The lowest price level traded

à The ratio of number of letters and the high/low span

LIGHT-GREEN FRAMED AREA IN THE EXAMPLE GRAPH

Here you can find the number of traded contracts (contract volume) or the tick
volume for each price level. In the example, 1302 contracts were traded (bought
and sold) in the price span 6381-6382. The displayed volume is specified with the
parameter Volume Type in the properties.

DARK-GREEN FRAMED AREA IN THE EXAMPLE GRAPH

Here you can find a brown bar that marks the range of 70 % of volume activity.
The small rectangle marks the price level with the highest volume activity. This
point is called Volume Point of Control. Above this area, in the header of the chart,
the following data is displayed (from top to bottom):

à Volumes traded above the Point of Control

à Volumes traded below the Point of Control

à Total trading volume

LIGHT-BLUE FRAMED AREA IN THE EXAMPLE GRAPH

Here you can find the sum of TPOs (periods) in which the respective price levels
were traded. For example, the range 6376-6377 was traded in a total of six
periods.

DARK-BLUE FRAMED AREA IN THE EXAMPLE GRAPH

Here you can find the black bar that marks the range of 70% activity in the time
line. The small rectangle marks the price level with the highest trading activity.
This point is called TPO Point of Control.

MARKET PROFILE CHART PROPERTIES
The general properties are available via "Settings" on page 157 in the home tab.

History Length The Market Profile is created on a tick basis. Enter the number of
ticks to be loaded into the Market Profile. The history length determines how
many days will be displayed as Market Profile.

Interval This is the interval that each TPO represents in the chart. The default
value is 30 minutes but can also be set to 1 hour.
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Scale Factor Enter the price span units. When the price moves by this span during
a TPO, the current letter is drawn at that price level. For example, if the scale
factor is "2" and the current price is at "6370" in the TPO "C", a new "C" is drawn in
the line above the original one if the price moves up to 6372.

Show Gaps Select here whether gaps in the trading (TPOs without trades) are to
be displayed.

Initial Balance Enter the number of TPOs that should be part of the start period.
TPOs in the start period are labeled in a special color.

Start Time Here the time for the market start has to be entered, i.e. "9:30" for stock
trading. This is important for a correct display of the Market Profile.

Volume Type Select here whether the volume should be displayed as Contract
Volume (number of traded contracts) or as Tick Volume (number of ticks = trades
for this price span; necessary for currencies, for example). The traded volumes
are displayed to the left of the letters (light-green area in the example chart).

Zoom Factor Here you can enter an optical zoom factor. The higher the number,
the more the profile is magnified.

RANGE BAR CHART

Ó RANGE BAR CHART

Range bar charts are a version of "Bar Chart"
on page 109 with a fixed price range for each
bar. The bars contains only ticks within the set
price range. Due to this behavior the time axis
is not linear.

The range bar chart can be set as the default
chart type in Tradesignal, see chapter "Chart"
on page 96.

TRADING INFORMATION IN RANGE BAR CHARTS
The following information is available in a range bar chart:

à The highest price, given by the top point of the bar within the
set price range

à The lowest price, given by the lowest point of the bar within
the set price range

à The open price, given by the left vertical line

à The close price, given by the right vertical line
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à The direction of the price movement, given by the relative
positions of the left and right vertical lines. If the left one is
below the right one, prices have risen during the trading
period. Otherwise, prices have fallen.

à The direction of the price movement, given by the color of the
bars. The usual color setting is red for falling and black for
rising prices. The colors can be edited in the chart properties.

à The length of the bar is defined by the fixed price range.

GENERAL CHART PROPERTIES
When the chart is active, you can edit the chart properties in the toolbox, for
example the history length, the axes and legends.

You can also

à set the trading period and time span, see the chapter "Time
Spans and Periods" on page 218.

à change the chart look, see the chapter "Settings" on
page 157.

CONTENT-DEPENDENT CHART SETTINGS
In the properties of the displayed stock (symbol), you can find additional
parameters. Besides the standard properties, you can find specific parameters for
this chart type.

Input Here you can select the input for the range bars, e.g. Close.

Range Here you can define the difference between High and Low which closes the
bar.

Restart Period Here you define whether and when the calculation of the bars
should be restarted, e.g. never, daily.

Phantom Bars Here you can define whether phantom bars should be drawn. If true,
the new bars will always open one tick above or below the close of the previous
bar, so there will be no gaps between the bars.
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Ó RANGE BAR CHARTWITH PHANTOM
BARS

RANGE BAR PROPERTIES
Chart Style Here you can select whether bars or
candlesticks should be drawn.

Bullish Color Here you can select a color and
transparency for upward bars.

Bearish Color Here you can select a color and
transparency for downward bars.

Shown Prices Here you can define which prices
should be used for the bars.

FORWARD CURVE

Ó FORWARD CURVE

A Forward Curve in Tradesignal allows
commodity traders to obtain a visualization of
the forward or futures prices on a given date for
a given commodity.

The Forward Curve plots the current price of a
given forward contract against the expiration
date of the contract. The current prices or
prices from any previous day may be plotted in
such a way.

Forward Curves are available in Tradesignal, making them usable in the same
way as other charts, i.e. you can apply indicators and strategies to them.

Tip: For more information see chapter "Using Indicators" on page 372 and "Using
Strategies" on page 381.

FORWARD CURVES IN TRADESIGNAL

CREATING A FORWARD CURVE CHART
You can access the Forward Curve Wizard from the Toolbar by clicking on the
Forward Curve button in the Insert tab. It allows you to select symbol lists
containing commodities or other futures and the contracts, which are included.
Additional set the Date alignment and Displacement properties.
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You can also drag a symbol list of commodities onto a chart, this will prompt you if
you want to create a Forward Curve or insert all symbols contained in the list into
the chart. If you enter the symbol shortcut for a continuous contract, e.g. "Sc1" for
a contract series for soy beans, into the "Command Line" on page 38, you can
select the option New Forward Curve from the drop-down menu.

You can also create a forward curve from a user-defined list of forward contract
symbols. Please be aware that for this feature to work, it will be necessary to
manually mark existing user-defined lists as supporting forward curves using the
Allow Forward Curves option in the list's context menu.

If you want to display the names of each contract as a label near each price point,
you can apply the supplied Forward Curve Label indicator.

PROPERTIES OF A FORWARD CURVE CHART
You can edit the properties of a Forward Curve chart either during its creation in
the wizard or in the "Mini Toolbar" on page 45.

There are two properties specific to Forward Curves:

Date Alignment The expiry date of each contract will be aligned according to this
setting, useful if you want to align multiple different forward curves.

Displacement The displacement property governs what value to show for each
contract in the forward curve. A value of 0 means use the current value, 1 means
use the value of the previous bar, etc.

PERCENT PERFORMANCE

Ó PERCENT PERFORMANCE CHART

A percent performance chart offers an easy
way to "Comparing Symbols" on page 106 the
performance of multiple symbols.

It shows the percentage increase or decrease
of a symbol relative to its price at a given start
date, which may be selected globally in Chart
Properties in the section "Global Percent
Performance Properties" on the next page or
for each symbol in the "Symbol Percent
Performance Properties" on the next page .

You can create a percent performance chart either by setting the properties on an
existing chart or by using the percent performance wizard in the toolbar to create
a new chart.
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PERCENT PERFORMANCE WIZARD

The Percent PerformanceWizards allows you to select up to 50 symbols from
your symbol lists and to choose between several chart styles for your new chart.

You can also set the global start date in the wizard. If you do not select a start
date, the first available price will be used.

GLOBAL PERCENT PERFORMANCE PROPERTIES

Found in the "Chart Settings" on page 158 this group of properties allows you to
enable/disable the percent performance transformation for all symbols in your
chart and to select a new start date.

% Performance Can be set to Active or Inactive.

Start Date The price at this date will be used as a base value from which the
percent increase/decrease is calculated. If none is selected the first price is used.

SYMBOL PERCENT PERFORMANCE PROPERTIES

The properties in the group % performance of the "Symbol Properties in the Mini
toolbar" on page 46 apply only to the selected symbol.

% Performance - Default This uses the global setting, On/Off are always on/off
ignoring the global setting, On (Custom Start Date) uses the Start Date below.

Custom Start Date The price at this date will be used as a base value from which the
percent increase/decrease is calculated if in On (Custom Start Date. Otherwise
the global Start Date is used.

Base Value Select which price field (close, open, ...) you want to use.

SEASONAL CHART

Ó SEASONAL CHART

With the seasonal mode, Tradesignal offers
you the ability to overlay the prices of different
years for one or more symbols. Comparing the
symbols this way emphasizes seasonal
pattern, e.g. if used with commodities that have
seasonal variations.

While seasonal charts are commonly only used
for future/forward contract series, they can also
be used for a single instrument. This will create
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a seasonal chart based on the single instrument, using the Seasonal Projection
indicator to overlay historic years and the seasonal average.

CREATE A SEASONAL CHART

Click the Seasonal Chart button in the toolbar.

The Seasonal Chart Wizard opens, allowing you to select monthly futures/forward
contracts, a single instrument or contract spreads. Depending on your selection,
more steps follow before the seasonal chart is created.

To see an average, apply the indicator "Seasonal Average" afterwards.

PROPERTIES OF A SEASONAL CHART

If enabled, the seasonal properties group will be displayed in the chart properties,
allowing you to customize the seasonal view:

End Month The end month on the seasonal date scale.

End Day The day of the month to be the final day on the seasonal date scale.

Preceding Months The number of preceding months to be displayed on the
seasonal date scale.

Displacement Displays the symbols displaced, so that they align to the selected
end day with/without any weekend gaps closed.

Legend Controls whether the offsets or the contract years are displayed in the
chart legend.

If using the Seasonal chart for futures, the input options are:

ContractMonth The month in which the contract is written forward.

NumberOfYears The number of years to be used in the projection.

If using the Seasonal chart for a single instrument, only the number of years can
be selected. Beyond that, the options come from the recommended indicator
"Seasonal Projection" on page 768.
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Ó SEASONAL CHART FOR A SINGLE
INSTRUMENT

EXAMPLE

Example on how to compare expired wheat
future contracts in seasonal mode:

01. Open a chart with the expired
December wheat contract from
2007,W 2007Z.

02. Add a previous year contract which
also expired in December, e.g.W
2006Z.

03. Select the chart. In the chart properties of the date axis,
change the Mode property to Seasonal.

The symbols will now be displayed below each other.

SETTINGS

Ó CHART SETTINGS

Just as every chart analysis is governed by the
individual preferences of each trader, the chart
properties like colors, fonts and other optical
settings can be adjusted to personal likings.
You can use the chart properties and the
"Styles" on page 224 and "Using Templates" on
page 223 functions to do the following:

à Adapt the charts to personal color
and font preferences

à Optimize charts for usage in print or web media

à Re-use the settings for other charts

à Enhance the recognition factor of your work in publications

à Define and use templates for the chart configuration

à Define and use Style properties for Charts and other
documents like "Scanner" on page 71, "Watchlist" on page 77
or "Portfolio" on page 251.
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SETTING THE CHART PROPERTIES

Ó SETTINGS IN THE TOOLBAR

As "Chart Properties", the following options
should be included here:

à You can edit the chart properties. To
do this, click on Settings in the
upper toolbar to see the parameters
for axes, grid, legend, history length etc. In case of strategies,
more settings are available.

à Some settings of the symbols, like volume, are also reflected
in the chart. To access these settings, click on the symbol in
the chart to see the "Mini Toolbar" on page 45.

à You can set up the optical chart properties by using styles
(pre-set or your own). If you have saved templates, you can
also apply those to new charts.

CHART SETTINGS

Beside the color selectors for the background, date and value axis, you can also
find parameters for the grid and the chart legend.

GENERAL SETTINGS

Ó GENERAL SETTINGS

Font Here you can select a font type (Tahoma,
Arial...), font style (bold, italic...) and font size.
Click on the entry to open the dialog in which
you can edit the values.

Auto-Hide Scales If activated, the scales are
hidden if the chart is displayed in a very small
size.

Refresh on Historic Updates Set to Yes if the
indicators/strategies should be recalculated
when changing the data history.

Min. Referenced Bars Enter the minimum number of bars that should be used for
calculating the values of indicators and strategies.

Target Cursor Style Here you can edit the style of the target cursor, Thin Line or
Whole Column.

Replace Symbols Control how a symbol replace operation is performed with regard
to unit and currency conversion.
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Template Shows if this chart is currently linked to a template file.

SquaringAs default Point &Figure chart are squared. The squared mode can be
disabled here.

GRID
A grid can be set up in the background of the chart. You can define the grid
properties like line art, style (points, vertical, horizontal...), and mode of the grid
(plain or every second column colored). You can also set the background and
column colors.

SCATTER ORIGIN
Here you can define settings for a scatter chart like style and color.

LEGEND
Here you can define the font settings and the way symbols, indicators and
strategies are to be displayed in the legend. The available parameters depend on
the selected chart type. You also have the option to display net and percent
change (relative to previous bar).

RISK ORDER APPEARANCE
If strategies are applied to the graph, you can define the optical qualities of the
trading system signals here. You can set the colors of the arrows (pointing at
events in the curve) and also define how much information should be displayed
for the trades.

TRADE LABELS
Here you can define settings for trend labels: font, vertical distance and trade
arrow size.

ALERTS
Here you can enable and disable e-mail alerts for the respective chart. You can
also enter an e-mail address to which alerts will be sent.

Note: Configuring the alert settings locally, i.e. for individual charts, will override the "Global
Alert Settings in Tradesignal" on page 333.
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DATE AXIS

Ó CONTEXT MENUOF DATE AXIS

For the date axis, you can set the history
length, preference for gaps, the background
color and font properties. In addition, you can
also set whether the scrollbar should be active.
In Tradesignal you can toggle between the
panoramic scrollbar and the normal one or adjust the height of the panoramic
scrollbar.

In addition, common used parameters like preference for gaps, history length and
color settings are also available via the context menu. All changes are applied live
to the chart.

VALUE AXIS

Ó CONTEXT MENUOF VALUE AXIS

For the value axis, you can set the background
color, font properties and further settings like
compact prices and thousand separator. In
addition, you can set the axis to invisible to
have more room for your graph. Percent
Performance allows you to set global percent
performance properties which are used by all
symbols in your chart. Percent performance charts allow you to easily compare
the relative performance of multiple symbols.

In addition, common used parameters like inverted or logarithmic scale, auto
scale and color settings are also available via the context menu. All changes are
applied live to the chart.

STYLES AND TEMPLATES

Tradesignal offers two functions for saving and re-using settings for the contents
and display of charts.

à Use styles to save the optical settings only.

à Use templates to save optical settings as well as indicators,
strategies and history length. Even the symbol is saved too,
but only applied to empty charts.

For more information see chapter "Styles" on page 224 and "Using Templates" on
page 223.
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SETTINGS FOR OTHER ITEMS

General settings for items like tables e.g. "Scanner" on page 71 and "Watchlist"
on page 77 are also available in the Settings. The settings are then adapted to the
selected item. For more details about the properties, see the help article of the
specific item.

CHART TOOLS

Ó CHART TOOLS

Chart tools are the basic tools for your chart
analysis. Tradesignal offers you a wide variety
of chart tools that are flexible and can be
individually configured. Many of the tools offer
additional features like duplicating, extending,
mirroring and free positioning. You can also change the graphic display settings
of tools.

Tip: The right-click context menu for a chart will always show a mini toolbar containing the
available chart tool. This way, even if the Toolbar is hidden, tools are easily accessible.

Name Description

"Text" on page 167 Text object in the chart.

"Fibonacci
Retracements" on
page 199

Grid consisting of retracement and projection lines on the
basis of two anchor points spaced by Fibonacci numbers.

"Fibonacci
Extensions" on
page 202

Grid consisting of extension lines on the basis of three
anchor points.

"Fibonacci Time
Projection" on
page 205

Grid projection of the distance between two anchor points
in the future (time axis).

"Fibonacci Time
Zones" on
page 207

Vertical grid of line spaced by Fibonacci numbers.

"Fibonacci Arcs"
on page 209

Arc above a base line with two anchor points whose
spacing corresponds to Fibonacci ratios.

"Fibonacci Fans"
on page 210

Fan above a base line with two anchor points whose angle
spacing corresponds to Fibonacci ratios.
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Name Description

"Trend Line" on
page 168

Line between two freely settable anchor points.

"Trend Channel"
on page 171

Trend channel between two freely settable anchor points.

"Stop Line" on
page 174

Horizontal line for marking price levels.

"Andrew's
Pitchfork" on
page 176

Three lines (median, support, resistance) based on the
analysis method by Andrew.

"Linear
Regression
Channel" on
page 179

Trend channel on the basis of a regression line between
two anchor points.

"Gann Line" on
page 182

45 degree line based on the analysis method by Grad W.
Gann.

"Arrow" on
page 183

Arrow between two anchor points (automatic labeling
possible).

"Guide Line" on
page 185

Simple vertical line with date and time.

"Ellipse" on
page 186

Ellipse with arbitrary dimensions.

"Rectangle" on
page 187

Rectangle with arbitrary dimensions.

"Circle" on
page 188

Circle with arbitrary diameter.

"arc" on page 189 Semi-circle with arbitrary dimensions.

"Triangle" on
page 190

Filled triangle with arbitrary dimensions.

"Triangle Pattern"
on page 191

Shaded triangle projection based on four anchor points.

"ABCD Pattern" on
page 192

ABCD pattern based on four anchor points.
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Name Description

"XABCD Pattern"
on page 193

XABCD or Cypher pattern based on five marked points.

"Elliott Wave 5
Line" on page 195

Either an Elliott impulse wave, Elliott Triangle Wave or
Elliott Triple ComboWave based on six anchor points.

"Elliott Wave 3
Line" on page 197

Either an Elliott correction wave or Elliott Double Combo
Wave based on four anchor points.

"Glyph" on
page 212

Draws a glyph into the chart.

"Fibonacci Wedge"
on page 213

Calculates and draws Fibonacci bands within a wedge
shaped projection.

"Point and Figure
Vertical Target" on
page 215

Draws vertical price target in a Point and Figure chart.

"Point and Figure
Horizontal Target"
on page 217

Draws horizontal price target in a Point and Figure chart.

WORKING WITH CHART TOOLS

INSERTING A DRAWING OBJECT
To use a chart tool for entering a drawing or text object, click the respective icon.
Then click into the chart and enter the object. The detailed proceeding depends
on the tool: for a line, you have to enter two anchor points, for a circle you only
have to click into the chart once and then drag the cursor to draw the circle.

OPENING THE CONTEXT MENU
To open the context menu of a drawing object, right-click the object.

MOVING AND SHAPING DRAWING OBJECTS
Drawing objects can be moved freely and shaped in the chart, as long as the snap
mode isn't active.

à To move whole objects, click on the object. A small hand or,
depending on the object, a double arrow appears. Keep the
left mouse button pressed and drag and drop the object.
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à To change the shape of a drawing object, e.g. for moving a
single anchor point or for changing the dimensions of a circle,
click the anchor or boundary point, keep the mouse button
pressed, and move the point.

In the case of trend lines, trend channels and Fibonacci retracements, you can
also extend the line into the moving direction by double-clicking one of the
anchors points. Alternatively, you can also choose Extend left or Extend right
from the context menu. The extended line ends at the edge of the chart. No
additional anchor points are inserted.

DUPLICATING OBJECTS
You can duplicate every drawing or text object by double-clicking the object or by
choosing Duplicate from the context menu. Upon duplication, all graphic
properties like color, opacity, style, entered text or other specific settings are
copied 1:1.

In the case of trend lines and channels, three additional duplication methods are
available:

à When you press the CTRL key while double-clicking the
object, the object is duplicated and the resulting copy is
mirrored on the y-axis. This way, the moving direction is
inverted.

à When you press both the CTRL and Shift keys while double-
clicking the object, the object is duplicated and the resulting
copy is mirrored on the x-axis.

à When you press the SHIFT key while double-clicking the
object, the object is duplicated and the resulting copy is
moved to the end point of the original object in moving
direction. This way, lines and channels of the same direction
and angle can be lined up with the first object.

DELETING DRAWING OBJECTS
To delete a single drawing or text object, select the object (in select mode) and
press the Del key. Alternatively you can choose Delete from the context menu. If
there are several objects under the mouse cursor, a selection list will be
displayed. There will be no further confirmation dialog.

DELETING TOOLS FROM THE MANAGE OBJECTS DIALOG
To delete all drawing and text objects in the chart, click the Delete icon in the
chart tools group, you will be shown the Manage Objects dialog where all tools in
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the chart can be selected or removed.

The Manage Objects dialog also provides functions to perform bulk remove
operations based on the selected tool in the dialog:

à Remove all tools

à Remove only tools before the selected tool

à Remove all tools of the same type as the selected tool

Multiple tools in the Manage Objects dialog can selected at once by holding the
Ctrl key when clicking on them. Selecting the Delete option with multiple selected
items will delete them all.

Items will only be deleted when theOK button is clicked. If a tool should not be
removed, either click the Undo button next to a tool selected for deletion, or click
Cancel to abort all changes.

TOOLS BEHAVIOR WHEN REPLACING A SYMBOL
Tools on chart objects are saved and replaced when the symbol is replaced. The
tools will be restored when the previous symbol is present again, e.g. by replacing
it back into the chart.

In addition, when the option Permanent is set to "True", the tool will not be
replaced when the symbol is replaced, but remains in the chart. This feature may
be useful when, for example, a guide line is being used to keep a fixed point in
time visible, or a text tool is being used like a notebook.

SELECTING SPECIFIC TOOLS IN A CHART
The tools tab of the Manage Objects dialog shows all tools in the selected chart.
This list can be sorted, grouped and filtered as desired in order to locate the
required tools.

Once an item of interest has been located, clicking on the Select the tool button
next to the gear will select this tool in the chart. Clicking on the gear Show tool
settings will show the full overview of the settings. Selecting the Scroll to tool
button will scroll the chart to the location of the tool.

à To sort the tools by a specific column, click on the column's
header (click a second time for a reverse sort).

à To group by a specific column, drag the column header to the
area above the list (drag the column away form this area to
remove the grouping)
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à To filter the list, hover the mouse over a column header, and
click on the little filter icon that appears in the top right of the
header. A list of possible filters will be displayed and can be
freely selected.

LEAVING THE DRAWING MODE
You can leave the chart tool mode by

à right-clicking within the chart

à by clicking the select tool in the chart tools group.

Note: With the auto-reset button in the chart tools group, you set a configuration so that
after each chart tool use, the application automatically reverts into the select mode.

SETTINGS AND PROPERTIES

SNAP MODE
Click the magnet icon to activate the snap mode. In the snap mode, the anchor
points are drawn to the closest high or low point for exact positioning.

Example

If you set the first anchor point of a trend line close to a low point and then move the second
anchor point across the chart, it will move along the other low points.

AUTO RESET
The standard setting is that once you selected a chart tool, you can enter as many
objects into the chart as you want. This is the optimal setting for e.g. entering a
multiple line chart analysis.

However, if you don't want to do that, you can use the auto reset mode. To set this
option, click the icon. Upon auto reset, the application automatically reverts
into select mode after each use of a chart tool. To add another drawing object,
you then have to select a chart tool again.

Click the icon again to leave the auto reset mode.

DISPLAY PREFERENCES
In the mini toolbar you can edit various display settings for the objects. To change
these settings, select the object and then click the respective property.
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ALERTS AND DRAWING OBJECTS
You can assign alerts to drawing objects.

Tip: For more information see chapter "Alerts" on page 329.

SAVE YOUR SETTINGS AS STANDARD
To save your personal settings as the new default for a tool, click the disc icon at
the top of the property inspector and confirm the prompt with OK.

Note: Your saved settings will be applied to the next use of a chart tool.

TEXT

Ó TEXT

With the text tool, you can enter notes or
captions into a chart, e.g. before publishing it in
the Tradesignal web forum.

You can find the text tool in the Chart Tools
group in the "Toolbar" on page 42.

ENTERING TEXT

01. Open a symbol chart.

02. Click on the text tool in the toolbar.

03. Click into the chart. A text field with four anchor points
appears.

04. Enter the text.

EDITING TEXT

à To edit the text, click on it with the mouse (so that it is
selected) and then click once again, so that the text field is
highlighted. Now you can edit the text.

à To move the text, drag it with the mouse (the mouse pointer
turns into a hand symbol) and move it freely. Release the
mouse button when done.

à To duplicate the text by double-clicking it.

à When the text is selected, you can edit the text properties in
the toolbox.
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à To delete the text, right-click on it and select Delete from the
context menu. Alternatively, select the text and press the DEL
key.

PROPERTIES
Font Here you can change the font type and size, e.g. to Arial bold 10.

Color Here you can change the text color, e.g. to red.

Background Here you can set a background color and opacity for the text object,
e.g. black.

Frame Here you can select whether you want to display a frame (in the same color
as the text) around the text.

Anchor Here you can select how the text is placed in relation to the chart data.
Choose an option from the drop-down list.

TREND LINE

Ó TREND LINE

The simplest tool for a chart analysis is the
trend line. With it, trends in price movements
can be visualized and emphasized. Trading
decisions may be based on analysis of trend
lines. Trend lines may be used for:

à Visualizing trends

à Marking market phases

à Marking resistance and support
levels

You can find the trend line tool in the Chart Tools group in the "Toolbar" on
page 42.

ENTERING A TREND LINE

01. Open a symbol chart.

02. Click on the trend line tool in the toolbar.

03. Click into the chart to set the starting point of the trend line.

04. Keep the mouse button pressed and move the pointer to the
end point of the trend line.

05. Release the mouse button.
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You can align the anchor points of the trend line to a certain price level. To do so,
activate the Snap Mode by clicking on the magnet symbol in the toolbar. Now
when you draw a trend line in the chart, it is positioned exactly at high and/or low
points.

EDITING A TREND LINE
To move the trend line:

01. Drag it with the mouse (the mouse pointer turns into a hand
symbol) and move it freely.

02. Release the mouse button when done.

To change the trend line angle:

01. Click the anchor points of the line (the mouse pointer turns
into an axis of coordinates symbol).

02. Drag into another position.

Note: The trend line cannot be moved freely if the Snap Mode is active. If necessary, switch
it off by clicking the magnet symbol in the toolbar.

You can duplicate a trend line in two ways (see "Chart Tools" on page 161):

à Double-click on the respective anchor point at the end of the
trend line to extend the length of the trend line until the right or
left edge of the chart.

à When the trend line is selected, you can edit the properties in
the toolbox.

An alert function is available for the trend line. To set an alert, set the Alert Mode
from Disabled to one of the options (see below).

To delete the trend line:

à Right-click on it and select Delete from the context menu.
Alternatively, select the trend line and press the DEL key.

USING THE MEASUREMENT FUNCTION

In the trend line properties, you can switch on the measurement function.

The following information is displayed for the time axis:
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à Number of bars (trading periods) between the two anchor
points

à Number of calendar days between the two anchor points

Example:

"47 Bars (2d)"

The following information is displayed for the price axis:

à Absolute price difference between the price levels of the
anchor points

à Relative price movement between the price levels of the
anchor points

à Relative gradient between periods for the slope between the
two anchor points

Example:

"3.48 (+5.7)"

"0.07/Bar"

PROPERTIES

TREND LINE PROPERTIES

Extend Left/Extend Right Select whether the line is to be extended to the left and/or
right until the edge of the chart.

GRAPHIC PROPERTIES

The following properties can be set for the trend line tool:

Color Here you can select a color for the line.

Width Here you can set a line width by entering a number.

Style Here you can select a line style, e.g. solid or dotted.

Shadow Here you can set a shadow for emphasizing the line with a 3D effect. Four
settings are available.

Label Here you can set the value label for the last data point to visible or hidden.
The label is only displayed when the trend line is drawn through, below or above
the last data point (candle, bar etc.). In Tradesignal you can also specifiy the
location at which the label should be displayed.
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Measurement Here you can switch the measurement function on or off.

ALERT PROPERTIES

The trend line tool can be used with various kinds of alerts:

Alert Direction Here you can select from the list whether crossings of all types lead
to alerts or only crossings in a certain direction.

Alert Mode Here you can select an alert mode from the list. Select whether every
crossing is considered or only one crossing per trading period or trend line.

Alert Name Here you can specify a name for alerts generated by this tool. It will be
included in the signal field of the alert.

Alert Trigger Here you can select when an alert should be triggered.

Crossed Triggers when the price crosses the tool, e.g. goes from below the tool to
above the tool

Hit or Crossed Same as above, but also triggers when the price merely hits the
tool. This setting is useful for a "Point and Figure Chart" on page 144.

For more information see chapter "Alerts" on page 329.

TREND CHANNEL

Ó TREND CHANNEL

The trend channel is a standard tool in chart
analysis. It offers two parallel lines that are
helpful for visualizing trends. Trading decisions
may be based on the trend channel's alert
function.

Trend channels may be used for visualizing:

à strong price movements

à resistance and support levels

à chart patterns

à sidewards markets

You can find the trend channel tool in the Chart Tools group in the "Toolbar" on
page 42.

171



ENTERING A TREND CHANNEL

01. Open a symbol chart.

02. Click on the trend channel tool in the toolbar.

03. Click into the chart to set the starting point of the trend
channel.

04. Keep the mouse button pressed and move the pointer to the
end point of the trend channel. Release the mouse button.

You can align the anchor points of the trend channel to a certain price level. To do
so, activate the Snap Mode by clicking on the magnet symbol in the toolbar. Now
when you draw a trend channel in the chart, the middle line is positioned exactly
at high and/or low points.

EDITING A TREND CHANNEL

à To move the trend channel, drag it with the mouse (the mouse
pointer turns into a hand symbol) and move it freely. Release
the mouse button when done.

à To move the lines of the trend channels up or down, click the
center point of a line (the mouse pointer changes into a
double arrow) and drag it.

à To change the trend channel angle, click the anchor points of
the channel (the mouse pointer turns into an x-y axis symbol)
and drag into another position.

Note: The trend channel cannot be moved freely if the Snap Mode is active. If necessary,
switch it off by clicking the magnet symbol in the toolbar.

You can duplicate a trend channel in two ways (see the chapter "Chart Tools" on
page 161):

à Double-click on anchor points at the right or left end of the
channel to extend the length of the trend channel to the right
or left edge of the chart.

à When the trend channel is selected, you can edit the
properties in the toolbox.

The alert function is available for the trend channel. To set an alert, set the Alert
Mode from Disabled to one of the options (see below).
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à To delete the trend channel, right-click on it and select Delete
from the context menu. Alternatively, select the trend channel
and press the DEL key.

PROPERTIES

TREND CHANNEL PROPERTIES

Distance Here you can enter a distance between the two lines of the trend
channel. The value changes if you move the lines independently. You can also
directly enter the value here.

Always parallel Select whether the lines of the trend channel are always be kept
parallel. (If you change the chart display from linear to logarithmic, the drawing
elements in the chart may "bend" and change their angles. In the case of trend
channels, this may lead to non-parallel lines. Set the option to true to avoid this
distortion.)

Extend Left/Extend Right Select whether the lines are to be extended to the left
and/or right until the edge of the chart.

GRAPHIC PROPERTIES

The following properties can be set for the trend line tool:

Color Here you can select a color for the lines.

Width Here you can set a line width by entering a number.

Style Here you can select a line style, e.g. solid or dotted.

Shadow Here you can set a shadow for emphasizing the lines with a 3D effect.
Four settings are available.

Fill Color Here you can select a color and opacity for the channel area.

Label Here you can set the value label for the last data point to visible or hidden.
The label is only displayed when the trend line is drawn through, below or above
the last data point (candle, bar etc.). In Tradesignal you can also specifiy the
location at which the label should be displayed.

ALERT PROPERTIES

The trend channel tool can be used with various kinds of alerts.

Alert Direction Here you can select from the list whether crossings of all types lead
to alerts or only crossings in a certain direction.
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Alert Mode Here you can select an alert mode from the list. Select whether every
crossing is considered or only one crossing per trading period or trend line.

Alert Name Here you can specify a name for alerts generated by this tool. It will be
included in the signal field of the alert.

Alert Trigger Here you can select when an alert should be triggered.

Crossed Triggers when the price crosses the tool, e.g. goes from below the tool to
above the tool

Hit or Crossed Same as above, but also triggers when the price merely hits the
tool. This setting is useful for a "Point and Figure Chart" on page 144.

Break-in/Break-out Treats the tool not as two separate lines but as a channel
instead and triggers an alert, when the price breaks into or out of the tool's
channel.

For more information see chapter "Alerts" on page 329.

STOP LINE

Ó STOP LINE

The stop line is a simple horizontal line that is
defined by only the value on the price axis.
Entered for one level, the line is extended to
both sides of the chart. The stop line has an
alert function and can be used for precise
timing of buy and sell orders. The stop line may
be used for

à drawing horizontal lines

à marking resistance and support levels

à exactly measuring price movements

à placing a line at a user-defined price level

Identically named stop lines in the same workspace can also be synchronized.

ENTERING A STOP LINE

01. Open a symbol chart.

02. Click on the stop line tool in the toolbar.

03. Click into the chart. A horizontal stop line is drawn. The
current value is given at the left side of the chart.
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You can align the anchor points of the stop line to a certain price level. To do so,
activate the Snap Mode by clicking on the magnet symbol in the toolbar. Now
when you enter a stop line in the chart, it is positioned exactly at a high or low
point.

EDITING A STOP LINE

à To move the stop line, drag it with the mouse (the mouse
pointer turns into a double arrow) and move it up or down.
Release the mouse button when done.

Note: The stop line cannot be moved freely if the Snap Mode is active. If necessary, switch it
off by clicking the magnet symbol in the toolbar.

à You can duplicate the stop line by double-clicking it.

à When the stop line is selected, you can edit the properties in
the toolbox.

à For the stop line, the alert function is available. To set an alert,
set the Alert Mode in the properties in the toolbox from
Disabled to one of the options, see below.

à To delete the stop line, right-click on it and select Delete from
the context menu. Alternatively, select the stop line and press
the DEL key.

PROPERTIES

GRAPHIC PROPERTIES

The following properties can be set for the trend line tool:

Color Here you can select a color for the line.

Width Here you can set a line width by entering a number.

Style Here you can select a line style, e.g. solid or dotted.

Label Alignment Here you can set the value label to visible or hidden and align it to
the stop line.

ALERT PROPERTIES

The stop line tool can be used with various kinds of alerts.

Alert Direction Here you can select from the list, if crossings of all kinds lead to
alerts or only crossings of a certain direction.
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Alert Mode Here you can select an alert mode from the list. Select if every crossing
is considered or only one crossing per trading period or trend line.

Alert Name Here you can specify a name for alerts generated by this tool. It will be
included in the signal field of the alert.

Alert Trigger Here you can select when an alert should be triggered.

Crossed Triggers when the price crosses the tool, e.g. goes from below the tool to
above the tool

Hit or Crossed Same as above, but also triggers when the price merely hits the
tool. This setting is useful for a Point&Figure Chart.

For more information see chapter "Alerts" on page 329.

SYNCHRONIZE STOP LINE VALUES
Stop lines in the same or in different charts in the same workspace can have their
values synchronized when one is changed.

To enable this behavior, ensure the setting File > Options > Advanced > Chart
Style> Sync value of stop lines with the same name in the same workspace is
checked (it is unchecked by default) and set the Alert Name property of each line
to exactly the same, non-empty name (case sensitive).

ANDREW'S PITCHFORK

Ó ANDREW'S PITCHFORK

Andrew's Pitchfork (originally called median
line studies) is a drawing tool which, if correctly
aligned, is also a geometric indicator. Andrew's
Pitchfork consists of three parallel lines and is
especially useful for finding resistance and
support levels.

You can find the tool in the Chart Tools group in
the "Toolbar" on page 42.

ENTERING ANDREW'S PITCHFORK
Three points are necessary to enter a Andrew's Pitchfork.

à The start (pivot) point of a trend (high or low). This is the
starting point of the handle.

à The two corner points of a major correction against the trend.
These will be the starting points of the prongs.
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Proceed as follows:

01. Open a symbol chart.

02. Click on the Andrew's Pitchfork tool in the toolbar.

03. Click into the chart on one of the corners of the correction
movement.

04. Keep the mouse button pressed and move the pointer to the
second corner of the correction movement. Release the
mouse button.

05. Drag the start point (anchor point of the handle) to the correct
position by moving it to the start point of the trend.

The resulting pitchfork consists of a handle with a middle line and two prongs. All
lines can serve as resistance and support levels in price movements.

EDITING ANDREW'S PITCHFORK

à To move Andrew's Pitchfork, drag it with the mouse (the
mouse pointer turns into a hand symbol) and move it freely.
Release the mouse button when done.

à To change the direction of Andrew's Pitchfork, click the pivot
point of the handle (the mouse pointer changes into an x-y
axis symbol) and move it. This will make the fork rotate.

à You can edit the corner points of the prongs. Click these
anchor points (the mouse pointer turns into an x-y axis
symbol) and drag them to another position. Due to the line
coupling, the fork's appearance changes.

à You can duplicate Andrew's Pitchfork by double-clicking on it.

à When Andrew's Pitchfork is selected, you can edit the
properties in the toolbox.

The alert function is available for Andrew's Pitchfork. To set an alert, set the Alert
Mode from Disabled to one of the options (see below).

à To delete Andrew's Pitchfork, right-click on it and select
Delete from the context menu. Alternatively, select Andrew's
Pitchfork and press the DEL key.

PROPERTIES

GRAPHIC PROPERTIES

The following properties can be set for the Andrew's Pitchfork tool:
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Handle Color Here you can select a color for the handle line.

Prongs Color Here you can select a color for the prong lines.

Width Here you can set a width for all lines by entering a number.

Handle Style Here you can select a line style for the handle, e.g. solid or dotted.

Prongs Style Here you can select a line style for the prongs, e.g. solid or dotted.

Shadow Here you can set a shadow for emphasizing all lines with a 3D effect. Four
settings are available.

Base Here you can select whether the base line (the line connecting the two
anchor points of the prongs) is to be visible or hidden.

Label Here you can set the value label for the current data point to visible or
hidden. In Tradesignal you can also specifiy the location at which the label should
be displayed

ALERT PROPERTIES

The Andrew's Pitchfork tool can be used with various kinds of alerts.

Alert Direction Here you can select from the list whether crossings of all types lead
to alerts or only crossings in a certain direction.

Alert Mode Here you can select an alert mode from the list. Select whether every
crossing is considered or only one crossing per trading period or trend line.

Alert Name Here you can specify a name for alerts generated by this tool. It will be
included in the signal field of the alert.

Alert Trigger Here you can select when an alert should be triggered.

Crossed Triggers when the price crosses the tool.

Hit or Crossed Same as above, but also triggers when the price merely hits the tool.
This setting is useful for a Point&Figure Chart.

Break-in/Break-out Treats the tool not as two separate lines but as a channel instead
and triggers an alert, when the price breaks into or out of the tool's channel.

For more information see chapter "Alerts" on page 329.
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LINEAR REGRESSION CHANNEL

Ó LINEAR REGRESSION CHANNEL

The linear regression channel is a drawing tool
with a calculation function. You as the user
define the start and end point of the channel as
well as the calculation method for the outer
lines. The definite position of the channel in the
chart, however, results from the calculation of
the mid-line.

The mid-line of the channel is calculated on the
basis of linear regression with the least square
method. In this method, the line that is drawn
through a number of data points effectively reflects the trend. The channel is
constructed with lines above and below the mid-line, in defined distances.

The linear regression channel may be used for:

à visualizing trends

à searching swing points

à finding resistance and support levels

You can find the tool in the Chart Tools group in the "Toolbar" on page 42.

ENTERING A LINEAR REGRESSION CHANNEL

01. Open a symbol chart.

02. Click on the linear regression channel tool in the toolbar.

03. Click into the chart to set the starting point of the linear
regression channel.

04. Keep the mouse button pressed and move the pointer to the
end point of the linear regression channel. Release the mouse
button.

By default, the linear regression channel is drawn with a standard deviation of 2
from the linear regression line. Therefore, the width of the channel depends on
the price volatility over the time span between the channel start and end.

Since the linear regression channel is based on calculation, it aligns to the data
points almost as if in Snap Mode.
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EDITING A LINEAR REGRESSION CHANNEL

à To move the linear regression channel, drag it with the mouse
(the mouse pointer turns into a hand symbol) and move it.
Release the mouse button when done. Note that since the
linear regression channel is based on calculation, it aligns to
the data points almost as if in Snap Mode.

à To extend the length of the linear regression channel, i.e. the
data points used for calculation, click an anchor point at the
end of the middle line (the mouse pointer changes into a
double arrow) and drag it.

à To extend the length of the channel until the right or left edge
of the chart, double-click on the respective anchor point at the
end of the middle line.

à You can duplicate a linear regression channel by double-
clicking on it.

à When the linear regression channel is selected, you can edit
the properties in the toolbox.

à You can edit the width of the linear regression channel either
by changing the StdDev parameters for the Standard
Deviation or by selecting another calculation method for the
channel (see below).

à The alert function is available for the linear regression
channel. To set an alert, set the Alert Mode from Disabled to
one of the options (see below).

à To delete the linear regression channel, right-click on it and
select Delete from the context menu. Alternatively, select the
linear regression channel and press the DEL key.

PROPERTIES

REGRESSION CHANNEL PROPERTIES

Extend Left/Extend Right Select if the channel is to be extended to the left and/or
right until the edge of the chart.

Channel Method Select the method that will be used for calculating the channel:

Standard Deviation The width of the channel is given by the measured standard
deviation in the channel's time span. The StDvs up and StDvs down parameters
give the offset (above and below) from the regression line.
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High / Low The channel includes the highest and lowest price within the time span.
This channel method is similar to the classic Trend Channel.

Percentage The width is given as percentage of the price at the last anchor point.
The % parameter gives the offset from the regression line.

GRAPHIC PROPERTIES

The following properties can be set for the linear regression tool:

Color Here you can select a color for the lines.

Width Here you can set a line width by entering a number.

Style Here you can select a line style, e.g. solid or dotted.

Shadow Here you can set a shadow for emphasizing the lines with a 3D effect.
Four settings are available.

Fill Color Here you can select a color and opacity for the channel area.

Label Here you can set the value label for the current data point to visible or
hidden. In Tradesignal you can also specifiy the location at which the label should
be displayed.

ALERT PROPERTIES

The linear regression channel tool can be used with various kinds of alerts.

Alert Direction Here you can select from the list whether crossings of all types lead
to alerts or only crossings in a certain direction.

Alert Mode Here you can select an alert mode from the list. Select whether every
crossing is considered or only one crossing per trading period or trend line.

Alert Name Here you can specify a name for alerts generated by this tool. It will be
included in the signal field of the alert.

Alert Trigger Here you can select when an alert should be triggered.

Crossed Triggers when the price crosses the tool, e.g. goes from below the tool to
above the tool

Hit or Crossed Same as above, but also triggers when the price merely hits the
tool. This setting is useful for a Point&Figure Chart.

Break-in/Break-out Treats the tool not as two separate lines but as a channel instead
and triggers an alert, when the price breaks into or out of the tool's channel.

For more information see chapter "Alerts" on page 329.
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GANN LINE

Ó GANN LINE

The Gann line is a drawing tool based on the
analysis methods of W.D. Gann. In his
publications around 1929 Gann presented
methods based on the premise that the market
obeys mathematical - geometrical - laws.

He proposed a relation between the price
dimension and time dimension, which construct
a price pattern. Thus the idea of constructing
trend lines based on angles and time was born.

You can use Gann lines for

à Marking trends in price movements

à Searching support and resistance price levels

à You can find the Gann line in the Chart Tools group in the
"Toolbar" on page 42.

ENTERING A GANN LINE

01. Open a symbol chart.

02. Click on the Gann line tool in the toolbar.

03. Click into the chart to set the starting point.

The Gann line is drawn. The default setting of the Gann line is an angle of 45°.
This complies to a 1:1 ratio of time and price. The angle results from the property
Runs (Rises is a calculated value). Change the Runs value to change the
angles. With a Runs value of 2, a 1:2 ratio results.

EDITING A GANN LINE

à To move the Gann line, drag the line, i.e. the anchor point,
with the mouse (the mouse pointer turns into a hand symbol)
and move it freely. Release the mouse button when done.

à You can duplicate a Gann line by double-clicking on it.

à When the Gann line is selected, you can edit the properties in
the toolbox.

à To delete the Gann line, right-click on it and select Delete
from the context menu. Alternatively, select the Gann line and
press the DEL key.
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PROPERTIES
Runs Here you can enter how many candles/bars a price on the price axis should
represent.

Rises This value is calculated from the Runs value and the line properties when
first drawing the Gann line. Will not be adapted when you move or edit the Gann
line.

Color Here you can edit the line color, e.g. to red.

Width Here you change the thickness of the guide line in pixels, e.g. to "3".

Style Here you can edit the line style, e.g. set it to "Dot".

ARROW

Ó ARROW

Like the guide line and other tools, the arrow
helps you to illustrate special situations in
charts. This, in addition with analysis tools,
allows you to create more meaningful charts.

You can find the arrow tool in the Chart Tools
group in the "Toolbar" on page 42.

ENTERING AN ARROW

01. Open a symbol chart.

02. Click on the arrow tool in the toolbar.

03. Click into the chart to set the starting point.

04. Keep the mouse button pressed while moving the pointer to
the end point, and release it there.

At the start point, a text box appears. It includes general chart information and analysis
results (open, high, low...) for the data encompassed by the arrow.

You can align the anchor points of the arrow to a certain price level. To do so,
activate the Snap Mode by clicking on the magnet symbol in the toolbar. Now
when you draw an arrow in the chart, it is positioned exactly at high and/or low
points.

EDITING AN ARROW

à To move the arrow, drag it with the mouse (the mouse pointer
turns into a hand symbol) and move it freely. Release the
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mouse button when done. Note that although the text box will
move with the arrow, the text box contents will not be
refreshed. This might mislead you in interpretation.

à To change the arrow angle, click an anchor point of the arrow
(the mouse pointer turns into an x-y axis symbol) and drag it to
another position.

à Note that the arrow cannot be moved freely if the Snap Mode
is active. If necessary, switch it off by clicking the magnet
symbol in the toolbar.

à You can duplicate an arrow by double-clicking on it.

à When the arrow is selected, you can edit the properties in the
toolbox.

à To delete the arrow, right-click on it and select Delete from
the context menu. Alternatively, select the trend line and
press the DEL key.

PROPERTIES
User Text Here you can enter a title for the text box, which will be displayed as its
header line.

Width Here you can enter the thickness of the arrow in pixel, e.g. "3".

Arrowhead Angle Here you can set how narrow (small number) or wide (high
number) the arrowhead will be.

Arrowhead Size Here you can set the length of the arrowhead.

Step Mode Here you can select whether the line between the start and end point is
to be straight or stepped (bent shortly below the end point).

Arrowhead Shape Here you can select between four different shapes, e.g.
"triangular".

Style Here you can select the line style of the arrow, e.g. "Dot".

Arrow Border Color Here you can edit the arrow color.

Arrow Fill Color Here you can edit the fill color for the arrowhead.

Autotext Here you can set how many details are displayed in the text box. The box
can include basic chart information or also indicator data etc.

Autotext Fill Color Here you can edit the background color for the text box.
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Autotext Color Here you can edit the text color in the text box.

Guide Line Select if the guide line should always be visible. Otherwise it will be
temporarily displayed to help you setting the exact arrow's end point.

GUIDE LINE

Ó GUIDE LINE

The guide line is a tool for marking events in a
trading period. With it, you can easily
emphasize a candle, a bar or the signal of an
indicator. In Tradesignal, the guide line comes
with a date label.

You can find the guide line in the Chart Tools
group in the "Toolbar" on page 42.

ENTERING A GUIDE LINE

01. Open a symbol chart.

02. Click on the guide line tool in the toolbar.

03. Click into the chart to set the anchor point of the guide line.

The guide line is drawn into the graph. The default setting of the tool is that a guide line
drawn in a chart will be displayed in all subcharts. However, you can move or delete this
guide line only in the chart in which it was originally drawn, because only there can you take
hold of it with the mouse.

You can align the guide line to a certain price level. To do so, activate the Snap
Mode by clicking on the magnet symbol in the toolbar. Now when you draw the
guide line in the chart, it is positioned exactly at high and/or low points.

EDITING A GUIDE LINE

à To move the guide line, drag it with the mouse (the mouse
pointer turns into a vertical double arrow symbol) and move it
freely. Release the mouse button when done.

à Note that the guide line cannot be moved freely if the Snap
Mode is active. If necessary, switch it off by clicking the
magnet symbol in the toolbar.

à You can duplicate a guide line by double-clicking on it.

à When the guide line is selected, you can edit the properties in
the toolbox.
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à To delete the guide line, right-click on it and select Delete
from the context menu. Alternatively, select the trend line and
press the DEL key.

PROPERTIES
Color Here you can edit the line color, e.g. to red.

Style Here you can edit the line style, e.g. set it to "Dot".

Width Here you change the thickness of the guide line in pixel, e.g. to "3".

Scope Here you can select whether the guide line is displayed only in the graph in
which it was drawn or in all of them (default).

Label Here you can select whether the data point label with date and time (for
shorter periods) is visible or hidden in the chart. In Tradesignal you can also
specify the the text orientation.

Label Alignment Here you can select at which location the label should be
displayed.

ELLIPSE

Ó ELLIPSE

The ellipse is a simple drawing object. Typically
ellipses are used for highlighting the expansion
of a consolidation zone, based on the idea of a
harmonic price movement.

You can find the ellipse tool in the Chart Tools
group in the "Toolbar" on page 42.

ENTERING AN ELLIPSE

01. Open a symbol chart.

02. Click on the ellipse line tool in the toolbar.

03. Click into the chart to set the anchor point.

04. Keep the mouse button pressed and draw the ellipse.
Release the mouse button when done.

EDITING AN ELLIPSE

à To move the ellipse, drag it with the mouse (the mouse pointer
turns into a hand symbol) and move it freely. Release the
mouse button when done.
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à You can duplicate an ellipse by double-clicking on it.

à When the ellipse is selected, you can edit the properties in the
toolbox.

à To delete the ellipse, right-click on it and select Delete from
the context menu. Alternatively, select the ellipse and press
the DEL key.

PROPERTIES
Fill Color Here you can set up which color and opacity you want to use for the
ellipse area. The higher the opacity, the lower the transparency, i.e. the less you
can see the original chart behind it.

Border Color Here you can set the border color of the ellipse.

RECTANGLE

Ó RECTANGLE

The rectangle is a simple drawing tool.
Typically rectangles are used for highlighting
mean-reverting markets, support and
resistance price levels or chart patterns.

You can find the rectangle tool in the Chart
Tools group in the "Toolbar" on page 42.

ENTERING A RECTANGLE

01. Open a symbol chart.

02. Click on the rectangle tool in the toolbar.

03. Click into the chart to set the anchor point.

04. Keep the mouse button pressed and draw the rectangle.
Release the mouse button when done.

EDITING A RECTANGLE

à To move the rectangle, drag it with the mouse (the mouse
pointer turns into a hand symbol) and move it freely. Release
the mouse button when done.

à To move single sides of the rectangle up/down or left/right,
click an anchor point in the middle of a side and drag it.

à To change the size of the rectangle, click an anchor point in
the corner of the rectangle and drag it.
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à You can duplicate a rectangle by double-clicking on it.

à When the rectangle is selected, you can edit the properties in
the toolbox.

à To delete the rectangle, right-click on it and select Delete
from the context menu. Alternatively, select the rectangle and
press the DEL key.

PROPERTIES
Fill Color Here you can set up which color and opacity you want to use for the
rectangle area. The higher the opacity, the lower the transparency, i.e. the less
you can see the original chart behind it.

Border Color Here you can set the border color of the rectangle.

CIRCLE

Ó CIRCLE

The circle is a simple drawing object. Typically
circles are used for highlighting intersections of
trend lines, chart patterns or target prices.

You can find the circle tool in the Chart Tools
group in the "Toolbar" on page 42.

ENTERING A CIRCLE

01. Open a symbol chart.

02. Click on the circle tool in the toolbar.

03. Click into the chart to set the anchor point.

04. Keep the mouse button pressed and draw the circle. Release
the mouse button when done.

EDITING A CIRCLE

à To move the circle, drag it with the mouse (the mouse pointer
turns into a hand symbol) and move it freely. Release the
mouse button when done.

à You can duplicate a circle by double-clicking on it.

à When the circle is selected, you can edit the properties in the
toolbox.
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à To delete the circle, right-click on it and select Delete from the
context menu. Alternatively, select the circle and press the
DEL key.

PROPERTIES
Fill Color Here you can set the color and opacity for the circle area. The higher the
opacity, the lower the transparency, i.e. the less you can see the original chart
behind it.

Border Color Here you can set the border color of the circle.

ARC

Ó ARC

The arc is a simple drawing object useful for
highlighting special situations in a chart.

You can find the arc tool in the Chart Tools
group in the "Toolbar" on page 42.

ENTERING AN ARC

01. Open a symbol chart.

02. Click on the arc tool in the toolbar.

03. Click into the chart to set the anchor point.

04. Keep the mouse button pressed and draw the arc. Release
the mouse button when done.

EDITING AN ARC

à To move the arc, drag it with the mouse (the mouse pointer
turns into a hand symbol) and move it freely. Release the
mouse button when done.

à To change the size of the arc, click on an anchor point
surrounding the arc and drag it.

à You can duplicate an arc by double-clicking on it.

à When the arc is selected, you can edit the properties in the
toolbox.

à To delete the arc, right-click on it and select Delete from the
context menu. Alternatively, select the arc and press the DEL
key.
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PROPERTIES
Fill Color Here you can set the color and opacity for the arc area. The higher the
opacity, the lower the transparency, i.e. the less you can see the original chart
behind it.

Border Color Here you can set the border color of the arc.

TRIANGLE

Ó TRIANGLE

The triangle is a drawing tool. Typically
triangles are used for highlighting triangle
patterns in continuation analysis.

You can find the triangle tool in the Chart Tools
group in the "Toolbar" on page 42.

ENTERING A TRIANGLE

01. Open a symbol chart.

02. Click on the triangle tool in the
toolbar.

03. Click into the chart to set the anchor point.

04. Keep the mouse button pressed and draw the triangle.
Release the mouse button when done.

EDITING A TRIANGLE

à To move the triangle, drag it with the mouse (the mouse
pointer turns into a hand symbol) and move it freely. Release
the mouse button when done.

à To change the size of the triangle, click an anchor point in the
corner of the triangle and drag it.

à You can duplicate a triangle by double-clicking on it.

à When the triangle is selected, you can edit the properties in
the toolbox.

à To delete the triangle, right-click on it and select Delete from
the context menu. Alternatively, select the triangle and press
the DEL key.

PROPERTIES
Price 1 / Price 2 / Price 3 The three anchor points of the triangle.
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Permanent Here you can select whether the triangle should be displayed
permanently. The default value is false.

Pattern Here you can select a pattern, either closed or open (top or bottom side
without line).

Line Color Here you can select a line color.

Line Width Here you can set a line width, e.g. "1".

Line Style Here you can select a line style, e.g. "Solid" or "Dot".

Fill Color Here you can select a color and opacity for the triangle area. The higher
the opacity, the lower the transparency, i.e. the less you can see the original chart
behind it.

TRIANGLE PATTERN

Ó TRIANGLE PATTERN

The triangle pattern tool draws a shaded
triangle projection based on four anchor points.

You can find the triangle pattern tool in the
Chart Tools group in the "Toolbar" on page 42.

ENTERING A TRIANGLE PATTERN

01. Open a symbol chart.

02. Click on the triangle pattern tool in the toolbar.

03. Click into the chart to set the first anchor point A.

04. Keep the mouse button pressed and draw the triangle pattern.
Release the mouse button when done.

EDITING A TRIANGLE PATTERN

à To move the triangle pattern, drag it with the mouse (the
mouse pointer turns into a hand symbol) and move it freely.
Release the mouse button when done.

à To change the size of the triangle pattern, click an anchor
point and drag it.

à You can duplicate a triangle pattern by double-clicking on it.

à When the triangle pattern is selected, you can edit the
properties in the toolbox.
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à To delete the triangle pattern, right-click on it and select
Delete from the context menu. Alternatively, select the
triangle and press the DEL key.

PROPERTIES
Price 1 / Price 2 / Price 3 / Price 4 The four anchor points of the triangle pattern.

Permanent Here you can select whether the triangle pattern should be displayed
permanently. The default value is false.

Font Here you can set the font type, weight and size for the anchor labels.

Line Color Here you can select a line color.

Line Width Here you can set a line width, e.g. "1".

Line Style Here you can select a line style, e.g. "Solid" or "Dot".

Fill Color Here you can select a color and opacity for the triangle pattern area. The
higher the opacity, the lower the transparency, i.e. the less you can see the
original chart behind it.

ABCD PATTERN

Ó ABCD PATTERN

The ABCD pattern tool draws the ABCD
pattern based on four anchor points.

Typically this harmonic pattern is used for
determining trade exit or entry points.

You can find the ABCD pattern tool in the Chart
Tools group in the "Toolbar" on page 42.

ENTERING AN ABCD PATTERN

01. Open a symbol chart.

02. Click on the ABCD pattern tool in the toolbar.

03. Click into the chart to set the first anchor point A.

04. Keep the mouse button pressed and draw the ABCD pattern.
Release the mouse button when done.
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EDITING AN ABCD PATTERN

à To move the ABCD pattern, drag it with the mouse (the mouse
pointer turns into a hand symbol) and move it freely. Release
the mouse button when done.

à To change the size of the ABCD pattern, click an anchor point
and drag it.

à You can duplicate a ABCD pattern by double-clicking on it.

à When the ABCD pattern is selected, you can edit the
properties in the toolbox.

à To delete the ABCD pattern, right-click on it and select Delete
from the context menu. Alternatively, select the ABCD pattern
and press the DEL key.

PROPERTIES
Price 1 / Price 2 / Price 3 / Price 4 The four anchor points of the ABCD pattern.

Permanent Here you can select whether the ABCD pattern should be displayed
permanently. The default value is false.

Font Here you can set the font type, weight and size for the anchor labels.

Line Color Here you can select a line color.

Line Width Here you can set a line width for the main pattern A-B-C-D, e.g. "1".

Line Style Here you can select a line style for the main pattern A-B-C-D, e.g.
"Solid".

Line Width 2 Here you can set a second line width for the distances A-C and B-D,
e.g. "2".

Line Style 2 Here you can select a second line style for the distances A-C and B-D,
e.g. "Dot".

XABCD PATTERN
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Ó XABCD PATTERN

The XABCD pattern tool draws either the
XABCD or the Cypher pattern based on five
anchor points.

Typically this harmonic pattern is used for
determining trade exit or entry points.

You can find the XABCD pattern tool in the
Chart Tools group in the "Toolbar" on page 42.

ENTERING AN XABCD PATTERN

01. Open a symbol chart.

02. Click on the XABCD pattern tool in the toolbar.

03. Click into the chart to set the first anchor point X.

04. Keep the mouse button pressed and draw the XABCD
pattern. Release the mouse button when done.

EDITING AN XABCD PATTERN

à To move the XABCD pattern, drag it with the mouse (the
mouse pointer turns into a hand symbol) and move it freely.
Release the mouse button when done.

à To change the size of the XABCD pattern, click an anchor
point and drag it.

à You can duplicate an XABCD pattern by double-clicking on it.

à When the XABCD pattern is selected, you can edit the
properties in the toolbox.

à To delete the XABCD pattern, right-click on it and select
Delete from the context menu. Alternatively, select the
XABCD pattern and press the DEL key.

PROPERTIES
Price 1 / Price 2 / Price 3 / Price 4 / Price 5 The five anchor points of the
XABCD pattern.

Permanent Here you can select whether the XABCD pattern should be displayed
permanently. The default value is false.

Pattern Here you can select the pattern, either XABCD pattern or Cypher pattern.

Font Here you can set the font type, weight and size for the anchor labels.
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Line Color Here you can select a line color.

Line Width Here you can set a line width for the main pattern X-A-B-C-D, e.g. "1".

Line Style Here you can select a line style for the main pattern X-A-B-C-D, e.g.
"Solid".

Line Width 2 Here you can set a second line width for the distances A-C and X-D,
e.g. "2".

Line Style 2 Here you can select a second line style for the distances A-C and X-D,
e.g. "Dot".

Fill Color Here you can select a color and opacity for the XABCD pattern area. The
higher the opacity, the lower the transparency, i.e. the less you can see the
original chart behind it.

DIFFERENCE BETWEEN XABCD AND CYPHER
The two patterns differ in the way they are calculated, resulting in slightly different
distances for A-C and X-D.

XABCD:

A – C: (price(C) – price(B)) / (price(B) – price(A))

X – D: (price(A) – price(D)) / (price(X) – price(A))

Cypher:

A – C: (price(X) – price(C)) / (price(X) – price(A))

X – D: (price(C) – price(D)) / (price(X) – price(C))

ELLIOTT WAVE 5 LINE

Ó ELLIOTTWAVE 5 LINE

The Elliott Wave 5 Line tool draws either an
Elliott Impulse Wave, Elliott Triangle Wave or
Elliott Triple ComboWave based on six anchor
points.

You can find the Elliott Wave 5 Line tool in the
Chart Tools group in the "Toolbar" on page 42.
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ENTERING AN ELLIOTT WAVE 5 LINE

01. Open a symbol chart.

02. Click on the Elliott Wave 5 Line tool in the toolbar.

03. Click into the chart to set the anchor point.

04. Keep the mouse button pressed and draw the Elliott Wave 5
Line. If a rule-conforming wave can be plotted when drawing
with the tool, it will attempt to do so, otherwise it will infer
points based on a local highs/lows approach. Release the
mouse button when done.

EDITING AN ELLIOTT WAVE 5 LINE

à To move the Elliott Wave 5 Line, drag it with the mouse (the
mouse pointer turns into a hand symbol) and move it freely.
Release the mouse button when done.

à To change the size of the Elliott Wave 5 Line, click an anchor
point and drag it.

à You can duplicate an Elliott Wave 5 Line by double-clicking on
it.

à When the Elliott Wave 5 Line is selected, you can edit the
properties in the toolbox.

à To delete the Elliott Wave 5 Line, right-click on it and select
Delete from the context menu. Alternatively, select the Elliott
Wave 5 Line and press the DEL key.

PROPERTIES
Price 1 / Price 2 / Price 3 / Price 4 / Price 5 / Price 6 The six anchor points of the Elliott 5
Wave Line pattern.

Permanent Here you can select whether the pattern should be displayed
permanently. The default value is false.

Pattern Here you can select the pattern, either Elliott Impulse Wave, Elliott
Triangle Wave or Elliott Triple ComboWave.

Wave Degree Here you can select the wave degree (time scale), between
GrandSuperCycle and Subminuette. Default: Intermediate.

Font Here you can set the font type, weight and size for the anchor labels.

Line Color Here you can select a line color.
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Labels Only Here you can select whether lines and anchor labels should be
displayed (False) or only the labels (True).

Line Width Here you can set a line width, e.g. "1".

Line Style Here you can select a line style, e.g. "Solid" or "Dot".

DIFFERENCE BETWEEN THE ELLIOTT PATTERNS
Elliott Impulse Wave: This wave consists of five sub-waves that make net movement
in the same direction as the trend of the next-largest degree. It consists of five
waves labeled 1-2-3-4-5.

Elliott Triangle Wave: A triangle wave is typical for a sideways movement, associated
with decreasing volume and volatility. It consists of five waves labeled a-b-c-d-e.

Elliott Triple ComboWave: This is a combination of three corrective structures. It
consists of five waves labeled W-X-Y-X-Z.

All three patterns follow specific rules. If a rule-conforming wave can be plotted
when drawing with the tool, it will attempt to do so, otherwise it will infer points
based on a local highs/lows approach. After the wave is drawn, all anchor points
can be manipulated so that the pattern might no longer follow the wave theories.

ELLIOTT WAVE 3 LINE

Ó ELLIOTTWAVE 3 LINE

The Elliott Wave 3 Line tool draws either an
Elliott Correction Wave or an Elliott Double
ComboWave, based on four anchor points.

You can find the Elliott Wave 3 Line tool in the
Chart Tools group in the "Toolbar" on page 42.

ENTERING AN ELLIOTT WAVE 3 LINE

01. Open a symbol chart.

02. Click on the Elliott Wave 3 Line tool in the toolbar.

03. Click into the chart to set the anchor point.

04. Keep the mouse button pressed and draw the Elliott Wave 3
Line. If a rule-conforming impulse wave can be plotted when
drawing with the tool, it will attempt to do so, otherwise it will
infer points based on a local highs/lows approach. Release
the mouse button when done.
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EDITING AN ELLIOTT WAVE 3 LINE

à To move the Elliott Wave 3 Line, drag it with the mouse (the
mouse pointer turns into a hand symbol) and move it freely.
Release the mouse button when done.

à To change the size of the Elliott Wave 3 Line, click an anchor
point and drag it.

à You can duplicate an Elliott Wave 3 Line by double-clicking on
it.

à When the Elliott Wave 3 Line is selected, you can edit the
properties in the toolbox.

à To delete the Elliott Wave 3 Line, right-click on it and select
Delete from the context menu. Alternatively, select the Elliott
Wave 3 Line and press the DEL key.

PROPERTIES
Price 1 / Price 2 / Price 3 / Price 4 The four anchor points of the Elliott 3 Wave Line
pattern.

Permanent Here you can select whether the pattern should permanently be
displayed. The default value is false.

Pattern Here you can select the pattern, either Elliott Correction Wave or Elliott
Double ComboWave.

Wave Degree Here you can select the wave degree (time scale), between
GrandSuperCycle and Subminuette. Default: Intermediate.

Font Here you can set the font type, weight and size for the anchor labels.

Line Color Here you can select a line color.

Labels Only Here you can select whether lines and anchor labels should be
displayed (False) or only the labels (True).

Line Width Here you can set a line width, e.g. "1".

Line Style Here you can select a line style, e.g. "Solid" or "Dot".

DIFFERENCE BETWEEN THE ELLIOTT PATTERNS
Elliott Correction Wave: This is a main correction declining pattern, also called
ZigZag. It consists of three waves labeled A-B-C.
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Elliott Double ComboWave: This is an extension of the correction wave. It consists of
three waves labeled W-X-Y.

Both patterns follow specific rules. If a rule-conforming wave can be plotted when
drawing with the tool, it will attempt to do so, otherwise it will infer points based on
a local highs/lows approach. After the wave is drawn, all anchor points can be
manipulated so that the pattern might no longer follow the wave theories.

FIBONACCI RETRACEMENTS

Ó FIBONACCI RETRACEMENTS

Fib. Retracements are a drawing tool with a
calculation function. You as the user define the
start and end point of the price levels that are to
be used for the calculation. You can base your
decision on price or correction movements.

Between these two price levels, the
retracement lines are drawn according to the
numerical proportion of the Fibonacci
numerical series. The calculation is based on
the golden section. The theory behind using
Fib. Retracements for chart analysis is that price movements have rhythms
similar to natural processes.

Fib. Retracements may be used for:

à finding course aims of correction movements

à finding course aims of trend movements

à finding price targets of breakouts

à judging the market and its trends

à finding potential entry points at swing points

You can find the tool in the Chart Tools group in the "Toolbar" on page 42.

ENTERING FIBONACCI RETRACEMENTS

01. Open a symbol chart.

02. Click on the Fib. Retracements tool in the toolbar.

03. Click into the chart to set the start point of the price
development (this is the 0% level).
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04. Keep the mouse button pressed and move the pointer to the
end point of the price development (this is the 100% level).
Release the mouse button.

Between the 0 and 100% levels, the calculated lines are drawn. The horizontal
position of the anchor points can be changed without effect. Only the distance
between the resulting lines is important.

For extrapolating values beyond the 100% level, you can set the corresponding
lines to visible (e.g. for 138.2% and 161.8%). To do so, select the check boxes in
the full overview in the "Mini Toolbar" on page 45.

DIRECTION-DEPENDENT ANALYSIS
For the sensible usage of the Fib. Retracements, it is important to enter the lines
correctly into the chart. The start and end points have to be placed differently
depending on whether you wish to analyze correction movements or trend
movements.

ANALYSIS OF UPWARDS MOVEMENTS

à For finding possible correction levels in an upwards
movement, draw the line from the high to the low point of the
movement. This puts the 0% level at the high and the 100%
level at the low point. The standard lines that are displayed
separate the trend movement into the possible correction
levels.

à To find possible future price levels of an upwards movement,
however, draw the line from the low to the high point. Then set
the levels beyond 100% to visible by selecting them in the
properties.

ANALYSIS OF DOWNWARDS MOVEMENTS

à For finding possible correction levels in a downwards
movement, draw the line from the low to the high point of the
movement. This puts the 0% level at the low and the 100%
level at the high point. The standard lines that are displayed
separate the trend movement into the possible correction
levels.

à To find possible future price levels of a downwards
movement, however, draw the line from the high to the low
point. Then set the levels beyond 100% to visible by selecting
them in the properties.
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EDITING FIBONACCI RETRACEMENTS

à To change the 0% and 100%marks, click the anchor point of
the respective line (the mouse pointer changes into an x-y
axis symbol) and move it. The line positions will be adapted
accordingly.

à To move Fib. Retracements, drag them with the mouse (the
mouse pointer turns into a hand symbol) and move it freely.
Release the mouse button when done.

à You can edit the ratio of each Fib. line in the retracements. To
do so, click on the numbers next to the check boxes (in the
properties) and enter new values.

à You can duplicate the Fib. Retracements by double-clicking
on them.

à When the Fib. Retracements are selected, you can edit the
properties in the toolbox.

à The alert function is available for Fib. Retracements. To set an
alert, set the Alert Mode from Disabled to one of the options
(see below).

à To delete the Fib. Retracements, right-click on them and
select Delete from the context menu. Alternatively, select the
Fib. Retracements and press the DEL key.

PROPERTIES

FIB. RETRACEMENTS PROPERTIES

% 1, % 2... Select from the list of available Fib. levels the ones you want to display.
You can edit the values by clicking on the numbers to the right of the check boxes
and entering new ones. For each level you can set a different color. In order to set
the color back to one default color, select None in the color picker.

Extend Left/Extend Right Select whether the lines are to be extended to the left
and/or right until the edge of the chart.

Modus Select whether the lines are to be displayed in linear or logarithmic scale.

GRAPHIC PROPERTIES

The following properties can be set for the Fib. Retracements tool:

Color Here you can select a line color.

Width Here you can set a width for all lines by entering a number.
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Style Here you can select a line style, e.g. solid or dotted.

Labels Here you can set the value label for the lines to visible or hidden. In
Tradesignal you can also specifiy the location at which the label should be
displayed.

Show Guide Line Here you can select whether the guide line (the line connecting
the two anchor points of the 0% and 100% lines) is visible or hidden.

ALERT PROPERTIES

The Retracements tool can be used with various kinds of alerts.

Alert Direction Here you can select from the list whether crossings of all types lead
to alerts or only crossings in a certain direction.

Alert Mode Here you can select an alert mode from the list. Select whether
crossing raises an alert always, once per bar or once overall.

Alert Name Here you can specify a name for alerts generated by this tool. It will be
included in the signal field of the alert.

Alert Trigger Here you can select when an alert should be triggered.

Crossed: Triggers when the price crosses the tool, e.g. goes from below the tool to
above the tool

Hit or Crossed Same as above, but also triggers when the price merely hits the tool.
This setting is useful for a Point&Figure Chart.

For more information see chapter "Alerts" on page 329.

FIBONACCI EXTENSIONS

Ó FIBONACCI EXTENSION

Fibonacci Extensions is a drawing tool with a
calculation function. You as the user define the
start on a significant swing low, then drag your
mouse and click on the most recent swing high.
Finally, drag your mouse down and click on any
of the retracement levels.

Between these three price levels, the extension
lines are projected according to the numerical
proportion of the Fibonacci numerical series.
The calculation is based on the golden section.
The theory behind using Fibonacci Extensions

202

https://en.wikipedia.org/wiki/Fibonacci_number
https://en.wikipedia.org/wiki/Golden-section_search#Fibonacci_search


for chart analysis is that price movements have rhythms similar to natural
processes.

Most traders use Fibonacci Extensions in combination with other technical
indicators/patterns to help them determine appropriate target prices.

You can find the tool in the Chart Tools group in the "Toolbar" on page 42.

ENTERING FIBONACCI EXTENSIONS

01. Open a symbol chart.

02. Click on the Fibonacci Extensions tool in the toolbar.

03. Click into the chart to set the low swing point.

04. Keep the mouse button pressed and move the pointer to a
swing high. Release the mouse button.

The third point will be automatically calculated, but may be repositioned later by
clicking and dragging it. For extrapolating values beyond the 100% level, you can
set the corresponding lines to visible (e.g. for 138.2% and 161.8%). To do so,
select the check boxes in the full overview in the "Mini Toolbar" on page 45.

DIRECTION-DEPENDENT ANALYSIS
For the sensible usage of the Fibonacci Extensions, it is important to enter the
lines correctly into the chart. The start and end points have to be placed
appropriately depending on whether you wish to analyze correction movements
or trend movements.

EDITING FIBONACCI EXTENSIONS

à To change the marks, click the anchor point of the respective
line (the mouse pointer changes into an x-y axis symbol) and
move it. The line positions will be adapted accordingly.

à To move Fibonacci Extensions, drag them with the mouse
(the mouse pointer turns into a hand symbol) and move it
freely. Release the mouse button when done.

à You can edit the ratio of each Fibonacci line in the extension.
To do so, click on the numbers next to the check boxes (in the
properties) and enter new values.

à You can duplicate the Fibonacci Extensions by double-
clicking on them.
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à When the Fibonacci Extensions is selected, you can edit the
properties in the toolbox.

à The alert function is available for Fibonacci Extensions. To set
an alert, set the Alert Mode from Disabled to one of the
options (see below).

à To delete the Fibonacci Extensions, right-click on them and
select Delete from the context menu. Alternatively, select the
Fibonacci Extensions and press the DEL key.

à You can extend the Fibonacci lines by either clicking and
dragging an end on either side, or enabling the Extend Left or
Extend Right properties in the Inspector.

PROPERTIES

FIBONACCI EXTENSIONS PROPERTIES

%1, % 2... Select from the list of available Fib. levels the ones you want to display.
You can edit the values by clicking on the numbers to the right of the check boxes
and entering new ones. For each level you can set a different color. In order to set
the color back to one default color, select None in the color picker.

Extend Left/Extend Right Select whether the lines are to be extended to the left
and/or right until the edge of the chart.

Mode Select whether the lines are to be displayed in linear or logarithmic scale.

GRAPHIC PROPERTIES

The following properties can be set for the Fibonacci Extensions tool:

Color Here you can select a line color.

Width Here you can set a width for all lines by entering a number.

Style Here you can select a line style, e.g. solid or dotted.

Labels Here you can set the value label for the lines to visible or hidden. In
Tradesignal you can also specify the location at which the label should be
displayed.

Show Guide Line Here you can select whether the guide line is visible or hidden.

ALERT PROPERTIES

The Extensions tool can be used with various kinds of alerts.
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Alert Direction Here you can select from the list whether crossings of all types lead
to alerts or only crossings in a certain direction.

Alert Mode Here you can select an alert mode from the list. Select whether
crossing raises an alert always, once per bar or once overall.

Alert Name Here you can specify a name for alerts generated by this tool. It will be
included in the signal field of the alert.

Alert Trigger Here you can select when an alert should be triggered.

CrossedTriggers when the price crosses the tool, e.g. goes from below the tool to
above the tool

Hit or CrossedSame as above, but also triggers when the price merely hits the tool.
This setting is useful for a "Point and Figure Chart" on page 144.

For more information see chapter "Alerts" on page 329.

FIBONACCI TIME PROJECTION

Ó FIBONACCI TIME PROJECTION

Fib. Time Projection is a drawing tool with a
calculation function. You as the user define two
anchor points at extremes, i.e. either high or
low points in the chart.

The Fib. Time Projection then extends the
distance between the two anchor points in the
time line with a number of vertical lines. The
lines are calculated by multiplying the distance
between the anchor point with the Fibonacci
numbers. The result is a number of projection
lines that can be useful for finding swing points in charts.

Fib. Time Projections may be used for:

à finding possible swing points

à finding time aims for current price movements

You can find the tool in the Chart Tools group in the "Toolbar" on page 42.

ENTERING FIBONACCI TIME PROJECTION

01. Open a symbol chart.

02. Click on the Fib. Time Projection tool in the toolbar.

205

https://en.wikipedia.org/wiki/Fibonacci_number
https://en.wikipedia.org/wiki/Fibonacci_number


03. Click into the chart on a high or low point to set the first anchor
point.

04. Keep the mouse button pressed and move the pointer to
another high or low point of a similar price level in the chart.
Release the mouse button.

In a time projection, the Fib. lines are drawn to the right of the anchor points. The
vertical position of the anchor points can be changed without effect. Only the
distance between the anchor points is important.

For extrapolating values beyond the 100% level, you can set the corresponding
lines to visible (e.g. for 138.2% and 161.8%). To do so, select the check boxes in
the full overview in the "Mini Toolbar" on page 45.

EDITING FIB. TIME PROJECTION

à To move the anchor points, click on the respective point (the
mouse pointer changes into an x-y axis symbol) and move it.
The line positions will be adapted accordingly.

à To move the Fib. Time Projection, drag it with the mouse (the
mouse pointer turns into a hand symbol) and move it freely.
Release the mouse button when done.

à You can edit the ratio of each Fib. line in the retracements. To
do so, click on the numbers next to the check boxes (in the
properties) and enter new values.

à You can duplicate the Fib. Time Projection by double-clicking
on it.

à When the Fib. Time Projection is selected, you can edit the
properties in the toolbox.

à To delete the Fib. Time Projection, right-click on it and select
Delete from the context menu. Alternatively, select the
Fibonacci Time Projection and press the DEL key.

PROPERTIES

FIB. TIME PROJECTION PROPERTIES

% 1, % 2... Select from the list of available Fib. levels the ones you want to display.
You can edit the values by clicking on the numbers to the right of the check boxes
and entering new ones. For each level you can set a different color. In order to set
the color back to one default color, select None in the color picker.
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GRAPHIC PROPERTIES

The following properties can be set for the Fib. Time Projection tool:

Color Here you can select a line color.

Width Here you can set a width for all lines by entering a number.

Style Here you can select a line style, e.g. solid or dotted.

Label Placement Here you can set whether and where the value labels for the lines
will be displayed, bottom or top.

Show Guide Line Here you can select whether the guide line (the line connecting
the two anchor points) is to be visible or hidden.

FIBONACCI TIME ZONES

Ó FIBONACCI TIME ZONES

Fibonacci Timezones is a drawing tool with a
calculation function. You as the user define two
anchor points at extremes, i.e. either high or
low points in the chart.

The Fibonacci Timezones then extends the
distance between the two anchor points in the
time line with a number of vertical lines. The
lines are calculated by multiplying the distance
between the anchor point with the Fibonacci
numbers. The result is a number of timezone
lines that can be useful for finding swing points
in charts.

Fibonacci Timezones may be used for:

à finding possible swing points

à finding time aims for current price movements

You can find the tool in the Chart Tools group in the "Toolbar" on page 42.

ENTERING FIBONACCI TIMEZONES

01. Open a symbol chart.

02. Click on the Fibonacci Timezones tool in the toolbar.

03. Click into the chart on a high or low point to set the anchor
point.

207

https://en.wikipedia.org/wiki/Fibonacci_number
https://en.wikipedia.org/wiki/Fibonacci_number


04. Keep the mouse button pressed and move the pointer to
position the Fibonacci Timezones. Release the mouse button.

In a timezone projection, the Fibonacci lines are drawn to the right of the anchor
point. The vertical position of the anchor points can be changed without effect.
Only the distance between the anchor points is important.

For extrapolating values beyond the 100% level, you can set the corresponding
lines to visible (e.g. for 138.2 and 161.8%). To do so, select the check boxes in
the full overview in the "Mini Toolbar" on page 45.

EDITING FIBONACCI TIMEZONES

à To move the anchor points, click on the respective point (the
mouse pointer changes into an x-y axis symbol) and move it.
The line positions will be adapted accordingly.

à To move the Fibonacci Timezones, drag it with the mouse
(the mouse pointer turns into a hand symbol) and move it
freely. Release the mouse button when done.

à You can edit the ratio of each Fibonacci line in the
retracements. To do so, click on the numbers next to the
check boxes (in the properties) and enter new values.

à You can duplicate the Fibonacci Timezones by double-
clicking on it.

à When the Fibonacci Timezones is selected, you can edit the
properties in the toolbox.

à To delete the Fibonacci Timezones, right-click on it and select
Delete from the context menu. Alternatively, select the
Fibonacci Timezones and press the DEL key.

PROPERTIES
The following properties can be set for the Fibonacci Timezones tool:

Color Here you can select a line color.

Width Here you can set a width for all lines by entering a number.

Style Here you can select a line style, e.g. solid or dotted.
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FIBONACCI ARCS

Ó FIBONACCI ARCS

Fibonacci Arcs are a drawing tool with a
calculation function. You as the user define the
start and end point of the price levels that are to
be used for the calculation. The Fibonacci Arcs
are then calculated and drawn, similar to the
Fibonacci Retracements. The theory behind
using Fibonacci numbers for chart analysis is
that price movements have rhythms similar to
natural processes.

You may use Fibonacci Arcs for

à finding consolidation aims in price movements

à finding resistance and support levels

You can find the tool in the Chart Tools group in the "Toolbar" on page 42.

ENTERING FIBONACCI ARCS

01. Open a symbol chart.

02. Click on the Fibonacci Arcs tool in the toolbar.

03. Click into the chart, for example a high point.

04. Keep the mouse button pressed and move the pointer to the
next low point.

05. Release the mouse button.

Between the anchor points, the calculated arcs are drawn.

For extrapolating values beyond the 100% level, you can set the corresponding
arcs to visible (e.g. for 138.2 and 161.8%). To do so, select the check boxes in the
full overview in the "Mini Toolbar" on page 45.

EDITING FIBONACCI ARCS

à To move the baseline, click the respective anchor point (the
mouse pointer changes into an x-y axis symbol) and move it.
The arcs will be adapted accordingly. Depending on the
position of the middle to the outer anchor point, the arcs are
drawn upwards or downwards.
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à To move Fibonacci Arcs, drag them with the mouse (the
mouse pointer turns into a hand symbol) and move them
freely. Release the mouse button when done.

à You can edit the ratio of each Fibonacci line in the arcs. To do
so, click on the numbers next to the check boxes (in the
properties) and enter new values.

à You can duplicate the Fibonacci Arcs by double-clicking on
them.

à When the Fibonacci Arcs are selected, you can edit the
properties in the toolbox.

à To delete the Fibonacci Arcs, right-click on them and select
Delete from the context menu. Alternatively, select the
Fibonacci Arcs and press the DEL key.

PROPERTIES

FIBONACCI ARCS PROPERTIES

% 1, % 2... Select from the list of available Fibonacci levels the ones you want to
display. You can edit the values by clicking on the numbers to the right of the
check boxes and entering new ones. For each level you can set a different color.
In order to set the color back to one default color, select None in the color picker.

GRAPHIC PROPERTIES

The following properties can be set for the Fibonacci Arcs tool:

Color Here you can select a line color.

Width Here you can set a width for all lines by entering a number.

Style Here you can select a line style, e.g. solid or dotted.

FIBONACCI FANS

Ó FIBONACCI FANS

Fibonacci Fans are a drawing tool with a
calculation function. You as the user define the
start and end point of the price levels that are to
be used for the calculation. The Fibonacci Fans
are then calculated and drawn, similar to the
Fibonacci Retracements. The theory behind
using Fibonacci numbers for chart analysis is
that price movements have rhythms similar to
natural processes.
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You may use Fibonacci Fans for

à finding support lines in upwards movements

à finding resistance levels in downwards movements

You can find the tool in the Chart Tools group in the "Toolbar" on page 42.

ENTERING FIBONACCI FANS

01. Open a symbol chart.

02. Click on the Fibonacci Fans tool in the toolbar.

03. Click into the chart to set an extreme point, for example at a
high.

04. Keep the mouse button pressed and move the pointer to the
next diametrical extreme, for example a low point.

05. Release the mouse button.

Between the anchor points, the calculated fans are drawn. They can be seen as
resistance and support levels.

For extrapolating values beyond the 100% level, you can set the corresponding
fans to visible (e.g. for 138.2% and 161.8%). To do so, select the check boxes in
the full overview in the "Mini Toolbar" on page 45.

EDITING FIBONACCI FANS

à To move the baseline, click the respective anchor point (the
mouse pointer changes into an x-y axis symbol) and move it.
The fans will be adapted accordingly. Depending on the
position of the middle to the outer anchor point, the fans are
drawn upwards or downwards.

à To move Fibonacci Fans, drag them with the mouse (the
mouse pointer turns into a hand symbol) and move them
freely. Release the mouse button when done.

à You can edit the ratio of each Fibonacci line in the fans. To do
so, click on the numbers next to the check boxes (in the
properties) and enter new values.

à You can duplicate the Fibonacci Fans by double-clicking on
them.
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à When the Fibonacci Fans are selected, you can edit the
properties in the toolbox.

à To delete the Fibonacci Fans, right-click on them and select
Delete from the context menu. Alternatively, select the
Fibonacci Fans and press the DEL key.

PROPERTIES

FIBONACCI FANS PROPERTIES

% 1, % 2... Select from the list of available Fibonacci levels the ones you want to
display. You can edit the values by clicking on the numbers to the right of the
check boxes and entering new ones. For each level you can set a different color.
In order to set the color back to one default color, select None in the color picker.

GRAPHIC PROPERTIES

The following properties can be set for the Fibonacci Fans tool:

Color Here you can select a line color.

Width Here you can set a width for all lines by entering a number.

Style Here you can select a line style, e.g. solid or dotted.

GLYPH

Ó GLYPH

With the Glyph tool a variety of glyphs can be
added to your charts.

You can find the Glyph tool in the Chart Tools
group in the "Toolbar" on page 42.

ENTERING A GLYPH

01. Open a symbol chart.

02. Click on the Glyph tool.

03. Click on the chart where the glyph
should be placed.

EDITING A GLYPH

à To move the Glyph, drag it with the mouse (the mouse pointer
turns into a hand symbol) and move it freely. Release the
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mouse button when done.

à To change the size of the Glyph, select the Glyph, click on the
shown circle and drag it.

à To change the glyph itself, change the style at the properties in
the toolbox.

à You can duplicate a Glyph by double-clicking on it.

à When the Glyph is selected, you can edit the properties in the
toolbox.

à To delete the Glyph, right-click on it and select Delete from
the context menu. Alternatively, select the Glyph and press
the DEL key.

PROPERTIES
Style Here you can select the used glyph.

Size Here you can adjust the size of the glyph.

Color Here you can select the color of the glyph.

FIBONACCI WEDGE

Ó FIBONACCI WEDGE

Fibonacci Wedge is a drawing tool that
calculates and draws Fibonacci bands within a
wedge shaped projection. You define the
anchor and end point of the levels that are used
for the calculation. The Fibonacci Wedge is
then calculated and drawn, very similar to the
Fibonacci Retracements. The theory behind
using Fibonacci numbers for chart analysis is
that price movements have rhythms similar to
natural processes.

You can find the Fibonacci Wedge tool in the Chart Tools group in the "Toolbar"
on page 42.

ENTERING A FIBONACCI WEDGE

01. Open a symbol chart.

02. Click on the Fibonacci Wedge tool in the toolbar

03. Click into the chart to set the anchor point for the wedge.
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04. Keep the mouse pressed and move the pointer to end point of
the wedge.

TheWedge is drawn clockwise between the anchor point (1) and the end point (2)
and several Fibonacci lines are also drawn in the Wedge. If you press CTRL
during the drawing the wedge is drawn count-clockwisen.

For additional extrapolating values, the corresponding level can be activated in
the full overview in the "Mini Toolbar" on page 45.

EDITING A FIBONACCI WEDGE

à To change the angle and radius of the Fibonacci Wedge,
select it and drag the main tool line (solid) between the start
point (1) and low point (2).

à To adjust only the angle of the Fibonacci Wedge, select it and
drag the help line (stepped line) at the help point (3).

à To define the used Fibonacci levels change the values in the
properties. 

à To reflect the Fibonacci Wedge on the main tool line press
Shift and double-click on the tool. To reflect the Fibonacci
Wedge on the start point press CTRL and double-click on the
tool.

à To spin the tool around the anchor point (1), select it on the
square on the main tool line, so that cursor is shown as a
circled arrow.

à To extend the wedge to the end of the chart double-click on
the low point (2) or the help point (3).

PROPERTIES
Permanent Here you can select whether the Fibonacci Wedge should be displayed
permanently. The default value is false.

Start Value Here you can change the anchor point.

End Value Here you can change the end point for the pivot wedges.

% 1, % 2... Select from the list of available Fibonacci levels the ones you want to
display. You can edit the values by clicking on the numbers to the right of the
check boxes and entering new ones. For each level you can set a different color.
In order to set the color back to one default color, select None in the color picker.
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Style Here you can select a line style, e.g. solid or dotted. The default value is
solid.

Linecolor Here you can select a line color.

Fillcolor Here you can select a fill color.

Extend Lines Here you can select whether the wedge should be extended until the
edge of the chart. The default value is false.

Show base lines Here you can select whether the base lines are displayed. The
default value is true.

Font Here you can set the font type, weight and size for the labels of the levels.

Labels Here you can select whether the labels of the levels are displayed. The
default value is hidden.

Width Here you can set a line width, e.g. "1".

POINT AND FIGURE VERTICAL TARGET

Ó POINT AND FIGURE VERTICAL
TARGET

The Point and Figure Vertical Target Tool
draws price targets in order to predict the
stability of a trend and to confirm signals from
other indicators or strategies.

You can find the Point and Figure Vertical
Target tool in the Chart Tools group in the
"Toolbar" on page 42.

ENTERING A POINT AND FIGURE
VERTICAL TARGET

01. Open a symbol chart.

02. Click on the Point and Figure Vertical
Target tool in the toolbar.

03. Click into the chart to set the anchor
column of the tool.

04. Release the mouse and the target is drawn.

EDITING A POINT AND FIGURE VERTICAL TARGET

à To move the Point and Figure Vertical Target tool, drag it with
the mouse (the mouse pointer turns into a hand symbol) and
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move it freely to another column with the same symbols.
Release the mouse button when done.

à You can duplicate a Point and Figure Vertical Target tool by
double-clicking. The duplicate will be moved to the previous
column with the same symbols.

à When the Point and Figure Vertical Target tool is selected,
you can edit the properties in the toolbox.

à To delete the Point and Figure Vertical Target tool, right-click
on it and select Delete from the context menu. Alternatively,
select the Point and Figure Vertical Target tool and press the
DEL key.

PROPERTIES
Permanent Here you can select whether the pattern should be displayed
permanently. The default value is false.

Line Color Here you can select a line color.

Line Width Here you can set a line width, e.g. "1".

Line Style Here you can select a line style, e.g. "Solid" or "Dot".

Font Here you can set the font type, weight and size for the label.

CALCULATION
The calculation of vertical price targets is based on the selected column. The
anchor price is the highest or lowest price of the previous column.

Vertical target for upside targets (columns of Xs):

Anchor Price + Number of Boxes * Box Size * Reversal

Vertical target for downside targets (columns of Os):

Anchor Price - Number of Boxes * Box Size * Reversal
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POINT AND FIGURE HORIZONTAL TARGET

Ó POINT AND FIGURE HORIZONTAL
TARGET

The Point and Figure Horizontal Target Tool
draws price targets in order to predict the
stability of a trend and to confirm signals from
other indicators or strategies.

You can find the Point and Figure Horizontal
Target tool in the Chart Tools group in the
"Toolbar" on page 42.

ENTERING A POINT AND FIGURE
HORIZONTAL TARGET

01. Open a symbol chart.

02. Click on the Point and Figure Horizontal Target tool in the
toolbar.

03. Click into the chart to set the anchor column of the tool.

04. Keep the mouse button pressed and move the mouse to set
the width of the pattern.

05. Release the mouse and the target is drawn with the selected
width.

If you just click into the chart, the tool will be automatically drawn to the next
column with the other symbol considering the set pattern width.

EDITING A POINT AND FIGURE HORIZONTAL TARGET

à To move the Point and Figure Horizontal Target tool, drag it
with the mouse (the mouse pointer turns into a hand symbol)
and move it freely to another column with the same symbols.
Release the mouse button when done.

à You can duplicate a Point and Figure Horizontal Target tool by
double-clicking on the left line. The duplicate will be moved to
the previous column with the same symbols.

à To change the width of the tool, drag the right point of the line
with the label and move it freely to the next column with the
same symbols. Release the mouse button and the new width
is applied.

à When the Point and Figure Horizontal Target tool is selected,
you can edit the properties in the toolbox.
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à To delete the Point and Figure Horizontal Target tool, right-
click on it and select Delete from the context menu.
Alternatively, select the Point and Figure Horizontal Target
tool and press the DEL key.

PROPERTIES
Permanent Here you can select whether the pattern should be displayed
permanently. The default value is false.

Columns Here you can select how many additional columns to the selected
column should be part of the pattern.

Line Color Here you can select a line color.

Line Width Here you can set a line width, e.g. "1".

Line Style Here you can select a line style, e.g. "Solid" or "Dot".

Font Here you can set the font type, weight and size for the label.

CALCULATION
The calculation of horizontal price targets is based on number of columns and the
anchor price. The anchor price is the maximal or minimal price in the selected
zone. The zone includes the selected column and the following columns defined
by the property columns.

Horizontal price target with congestion top and downside reversal breakout (X to
O):

Anchor Price - Columns * Box Size * Reversal

The anchor price is the maximal price in the zone.

Horizontal price target with congestion base and upside reversal breakout (O to
X):

Anchor Price + Columns * Box Size * Reversal

The anchor price is the minimal price in the zone.

TIME SPANS AND PERIODS
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Ó PERIODMENU

For analyzing stocks and securities, not only
the navigational features of the chart but also
other settings are important, like the period and
time span settings. Change them to:

à Analyze price movements and trends over various time
resolutions

à Detect trends over longer time periods (days, months, years)

à Compare the performance of normalized time spans

à Optimize the chart display according to your preferences

à Change the signal generation frequency of a trading system

à Adapt the visible data to the analysis horizon

You can set the trading period not only in the chart but also in the "Portfolio" on
page 251, the "Scanner" on page 71 and the "Watchlist" on page 77. All
paragraphs in this text apply analogously.
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CHANGING THE PERIOD

Ó PERIODMENU

You can change the period for all instruments
in an active chart in two ways:

à Via the button Period under Home >
Data on the "Toolbar" on page 42.
Click on the button to open the
button menu and select a period.

à Via the command line by entering
certain shortcuts, for example "w" for
week, "5h" for five hours, "25t" for 25
ticks. For a list of all shortcuts see
chapter "Command Line" on
page 38.

If you want to change the period for all
instruments in all charts, press Ctrl while
selecting a period.

To change the period of a single instrument in a
chart, right-click on the chart legend of the
instrument and change the Period for Object
in the context menu.

A trading period is the unit that corresponds to
a price in the plot. Trading periods are
necessary for the financial market to be able to
compare analysis methods, trading systems
and price patterns independently of the actual
value or day of time.

TRADING PERIOD TYPES
There are three types of trading periods:

à Periods based on price fixing - in this
case, the price is plotted for a
defined number of ticks. This kind of
period results in a non-linear time
scale in the chart. Three periods are
available: 1, 10 or 25 ticks.
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à Time-dependent period - In this case, time units are used, like
hour, day, month and year. Several standard time units are
offered as quick settings.

à Periods based on traded shares - In this case, a defined
number of shares are accumulated to a trading period for this
security. For example, you can set that for each 1000 shares,
a price should be plotted. This kind of period results in a non-
linear time scale in the chart. Several quick settings are
available, from 1000 to 50000 shares.

DEFINING YOUR OWN TRADING PERIOD
You can define your own trading period by selecting the entryOther Period in the
period button menu.

As a trading period, you can set every number divisible by 1 as a time and
calendar unit, or set an arbitrary number for ticks and shares.

When using a 1 hour intra-bar period, it is possible to enter a Shift in Minutes
from the natural clock the bar should close on. This feature could be used e.g. to
offset hourly candles to generate signals some minutes before the clock hour. It
also could be used to align the first hourly candle to the start of the day's trading.
E.g. set the minute offset to 30 if the trading day starts at 8:30, so the first bar will
be drawn aligned at 9:30.

The offset can also be set individually for an item in a chart, watchlist, portfolio or
scanner. For this, open the context menu of the item and select Period > Other
Period to open the Change Period dialog for this item and to adjust this offset.
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CHANGING THE TIME SPAN

Ó TIME SPANMENU

For an active chart, you can find the time span
button in the Chart group in the "Toolbar" on
page 42. Click on the small arrow to open the
time span menu. Select a setting.

If you want to change the time span for all
instruments in all charts, press Ctrl while
selecting a "Toolbar" on page 42.

The time span is the span visible in the chart
history without scrolling. You can use given
settings or define your own time spans.

TIME SPAN TYPES
Several settings are available for the time span:

Current (Minute, Hour...) Display only the current
minute, hour etc.

Recent (F8, default) In all chart types in which
trading periods are linear with time, the
"Recent" history is a length of 63 past trading
periods and 7 empty periods of free space to
the right of the current period. In chart types with non-linear time axes, the view is
adapted to what viewers might perceive as optimal arrangement.

Full (Ctrl + F8) Show the data as set in History Length under Date Axis in the
"Settings" on page 157 (default 1000, maximum 500000).

DEFINING CUSTOM TIME SPANS
To set exact time spans, select Absolute or Moving in the time span button menu.

Absolute Here you can define a start point for a time span of a fixed length. Pre-set
values are the current time and date. Click the arrow next to the Date From field
to open a calendar to choose a date from. For the time span, any number divisible
by 1 is possible. By default, the time span is displayed from the start point into the
future. Select "Span backwards from specified date" to display the time span from
the start point into the past.

Moving Here you can define a time span of a fixed length that constantly begins
with the last price of the current trading period. For the time span, any number
divisible by 1 is possible.
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With the key F8 or a click on the axes symbol on the lower right of the chart you
return to the standard setting Recent History.

USING TEMPLATES

Ó TEMPLATE MANAGER IN THE
TOOLBOX

In templates you can save all graphic settings
of a chart as well as any included indicators,
strategies, and the history length as a template
for future charts.

Templates are handled like documents in the
"Toolbox" on page 49. Therefore, functions like
package management and color tagging are
available.

SAVING A TEMPLATE

01. Select Save Template in the context menu of the chart
legend. Alternatively, click on Home > Style > Template >
Save Template in the "Toolbar" on page 42.

02. Enter a name.

03. Either select Create in to choose an existing package for
saving the template, or set up a new one.

04. Confirm withOK to save the template.

You can find all available templates in the toolbox under Templates.

Note: To save a template, a chart has to be active.

APPLYING A TEMPLATE

01. Click the button Templates in the toolbox.

02. Drag and drop a template into a selected chart or double click
on it. All previously saved settings (including the securities,
parameters of indicators and strategies, and the history
length) are displayed in the chart. Alternatively, choose Apply
from the context menu of the template.

If you apply a template to an existing chart, the symbols of the chart are used
instead of the symbols saved in the template.
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Once a template has been applied to a chart, the chart is linked to that template.
Any changes to the template will be automatically applied to the chart. The
template used by a chart can be seen in the full overview via the "Mini Toolbar" on
page 45.

à To detach a chart from its template select the chart and then
click on Home > Style > Templates > Detach Template on the
Toolbar.

à To temporarily disable the automatic updating of charts when
the template changes, uncheck the box in the options under
File > Options > Advanced > Templates.

MANAGING TEMPLATES

In the template manager in the toolbar, you can access various functions via the
context menu:

à You can apply the template to the current chart or open it in a
new chart.

à You can rename or delete templates.

à You can define a template as default with Set Default. The
default template is then applied to all new charts. To return to
the Tradesignal default, select Clear Default.

à You can use color tags on templates.

STYLES
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Ó STYLES MENU

With styles, you can edit the graphic properties
of "Chart" on page 96, "Scanner" on page 71,
"Watchlist" on page 77, "Portfolio (Classic)" on
page 261, "Market Depth" on page 90, and
"News" on page 365.

You can do the following:

à assign existing styles

à save current settings as a new
custom style

à edit styles in style management

APPLYING STYLES

Styles button menu in the toolbar

When a document of a type listed above is
open, you can find the Style area in the "Toolbar" on page 42.

Click on the Styles button to open the menu.

à To apply a style to a single document, simply click on it in the
list.

à To apply a style to all currently open documents (in all
workspaces), press the Ctrl key while clicking on the style.

The style is applied immediately.

SAVING STYLES

01. Open the Styles button menu and click Save Style.
A dialog opens.

02. Enter a name for the style.

03. Enter a description (optional). This is the text that will later
appear in the Styles button menu.

04. Choose whether this style should be used as standard for this
document type. In addition, you can choose whether the style
should be applied to all open documents of this type.

05. Save the style by clickingOK.

225



MANAGING STYLES

Ó STYLES MENU

01. Open the Styles button menu and
choose the entryManage Styles.
A dialog opens.

02. Open the tab of the document type
for which you want to edit the styles.

03. Click Set as Default to use the
selected style as new standard for
documents of that type. If you click
Clear Default, the Tradesignal standard is used again.

04. If you have saved your own styles, you can edit them (only
name and description) and delete them.
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TRADING SYSTEMS AND ORDER
ROUTING

USING TRADING STRATEGIES
A trading system is a collection of rules and functions from which trading
decisions of any kind result. To this collection, rules for money and risk
management are added. Modern computer software also supports the fully
mechanized trade, up to the order routing to the broker. Trading systems are
used to:

à Test a set of rules for future real trade

à Guarantee the smooth execution of trading decisions

à Sidestep human weaknesses like fear and insecurity

à Procure stable results based on clear rules

à Automate trades based on a complex set of rules

à Trade many different symbols or systems at the same time.

Tradesignal offers you a broad range of tools for the development, testing, and
operation of complex trading systems:

à "Using Strategies" on page 381 are written in Equilla and can
be edited and adapted to your needs.

à An "Order Editor" on page 233 which allows you to manually
manage your orders

à "Money Management" on page 236 with options for position
sizing and risk management.

à Analysis of the possible trading system turnover in the
"Performance Report" on page 287.

à Search for the most profitable and stable trading system
configuration with the "Optimizer" on page 274.

à Mechanical trading with "Automatic Order Routing" on
page 307.

à "Alerts" on page 329 issued when critical limits (values or
graphic lines) are intersected in defined directions.

227



à An easy start with the "Trading Strategy Wizard" below that
offers more than 300 strategies in a modular system, as well
as new indicators and strategies for download from
Tradesignal.

All of these tools are intended to help you configure and optimize your own
systems.

TRADING STRATEGY WIZARD

Ó TRADING STRATEGYWIZARD

Trading strategies are an important tool for
many traders who seek success at the market
independent of their personal feelings, fears
and insecurities. For this aim, Tradesignal
offers many pre-defined indicators and
strategies, which can be expanded by adjusting
existing strategies or developing new
strategies in Equilla.

As an alternative, Tradesignal offers a Trading
Strategy Wizard to support you in assembling a strategy. Instead of scripting,
simply combine lists, conditions, expressions and patterns. The wizard helps you
to

à swiftly create trading strategies

à modify your strategies and customize it

Strategies created in the wizard can be used in the "Chart" on page 96, "Scanner"
on page 71, "Watchlist" on page 77, "Portfolio" on page 251 or the "Optimizer" on
page 274. For all adjustable parameters, the wizard automatically creates "Input
Declarations" so that you can edit the parameters in the "Mini Toolbar" on
page 45 and the Optimizer.

CREATING A TRADING STRATEGY

01. In the toolbox, click on the Strategies button.

02. In the Related Tasks area, select New Strategy.

03. In the next dialog, select the option Use the Trading
Strategy Wizard.
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In the following window, the strategy rules are defined. Rules can be assigned to
each trading order, and several trading orders can be set up for the strategy. For
condition details, see below.

01. Click New to enter a new order.

02. Enter a name for the order (optional), to distinguish between
different entry and exit methods.

03. Select an entry or exit method and enter an order type.

04. SelectGenerate reversed trading condition to generate
also the reversed order (for example, for a "buy long"
generate a "sell long" with reversed conditions).

05. Enter the Order Settings and click on Next.

06. In the next window, enter the conditions.

You can now edit the conditions further by clicking on Edit next to the Expression
fields. The Build Expression dialog opens. Here you can define how the value is
to be calculated. Select the optionMake an input to make this value appear as
parameter in the strategy properties and the Optimizer.

You can also change the operators that link the expressions. Select one from the
list.

Click the Done buttons to save the expressions/strategy.

ENTRY AND EXIT METHODS

The trading methods are roughly divided into exit and entry orders.

ENTRY METHODS
The following two methods create orders that open a position.

Enter Long (Buy) A buying order is created.

Enter Short (Sell) A short sale order is created.

EXIT METHODS
The following two methods create orders that close an existing position.

Exit Long (Sell) A selling order is created to close a long position (a fraction or all of
it).

Exit Short (Cover) A buying order is generated to cover a short position.
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STOP LOSS, TRAILING STOP AND PROFIT TARGET
Stop Loss An order is created that closes the current position after reaching the
defined loss.

Profit Target An order is created that closes the position after reaching the defined
profit.

Break Even An order is created that prevents a position from causing losses after
having made a profit.

Trailing Stop (Amount) An order is created that follows the position development.
When the position moves with the desired trend, the order "trails" behind. When
the position moves against the desired trend, the position is closed after a certain
decline in profit, defined as amount.

Trailing Stop (Percent) An order is created that follows the position development.
After a defined profit target, the stop order is activated. The position is closed after
a certain decline in profit, defined in percent.

TRADING TYPES
An order type has to be assigned to each order. It defines when the order is
executed. For two order types, additional conditions are available to control the
execution.

This Bar on Close (TBOC) The order is submitted at the end of the trading. In the
settings of the Order Routing in the "Tradesignal Options" on page 319, you can
define at what distance to the real trading end a TBOC order is created and
possibly routed. In backtests, the close price of the trading period is taken as
execution price.

Next Bar at Market (NBAM) The order is submitted at the opening of the next trading
period. In backtests, the open price of the trading period is taken as execution
price.

Next Bar at Price Stop (NBPS) The order is submitted during the next trading period.
For a buy order, the price has to cross the given price limit, for a short sale the
price has to be undercut. This way, the position is opened when the trend moves
into the preferred direction.

Next Bar at Price Limit (NBPL) The order is submitted during the next trading period.
For a buy order, the price has to undercut the given price limit, for a short sale the
price has to be crossed.
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This Bar at Market (TBAM) The order is submitted during the current trading period.
It is executed instantly.

ORDER SETTINGS

For each order, either you can define it so that the quantity of shares to be traded
can be entered in the "Money Management" on page 236, or you can enter a fixed
quantity here.

Setting quantities in the Money Management has the benefit of making it possible
to use "Position Sizing" on page 301 methods that are offered in Tradesignal.
This way, the quantities can be adapted dynamically in your trading system.

TRADING CONDITION TEMPLATES

The trading conditions are largely based on pre-defined Equilla scripts that
include indicators, calculate chart patterns or search for candlestick patterns. For
the signal generation, there are typically two expressions necessary, for example
"indicator XYZ crosses over the average ABC". The calculation of the indicator
and its average are all included in Equilla scripts that are combined and
connected by operators in the Wizard.

The templates for signal generation are roughly listed by categories. At the top of
the list, you can find three categories that generate signals based on the
Standard Price Series, Position based, or based on Date and Time. Below
these entries, you can find a long list of indicators, followed by candlestick
patterns and chart patterns.

STANDARD PRICE SERIES
These signals are based on the price of the underlying stock. The signals are
generated depending on comparisons of the current price to past prices. This
way, changes in directions and the highest and close prices can be calculated.

POSITIONS BASED
These signals are based on the developments of existing positions.

DATE AND TIME
These signals are connected to certain dates or times. This way, you can create
seasonal entries, for example. You can also create intraday strategies that are
traded only within or outside of a certain time frame.
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INDICATORS
This is the largest category. Here you can find all indicators included in the
delivery. For each indicator, a folder with various signal variations is available.
Crossings with lines, values or extremes, changes in directions and comparisons
to historic values like averages are offered.

CANDLESTICK PATTERN
Here you can find a number of candlestick patterns. For each pattern, a folder
with various signal variations is available. Usually, these consist of bullish and
bearish patterns. Some signals are also available with trend filters.

Candlestick patterns offer one to two parameters. The first is used to define a
candle body. The body is compared to the average candle body size of the given
period. If a second parameter is available, it defines the period for an average that
is used as trend filter. In this case, the pattern only causes a signal if it is complete
and has the right position for the trend filter.

CHART PATTERN
Some common chart patterns are available here. For each pattern, a folder with a
bullish and bearish pattern is available.

EDITING A GENERATED SYSTEM

WITH THE WIZARD
Any trading system generated in the Strategy Wizard can also be edited in the
Strategy Wizard again. For this, right-click on the strategy in the chart legend or
the toolbox to open the context menu, and select Edit with Strategy Wizard.

In the Strategy Wizard, click on Edit to edit the trading system. You can enter new
conditions and rules or edit and delete old ones.

MANUALLY IN THE EDITOR
You can also open and edit a strategy in the Equilla Editor. However, please note
that you will not be able to open the wizard for this strategy again if you made
changes to it in the editor.

To open the trading system in the editor, right-click on the name of the strategy in
the chart legend or the toolbar, and select Edit from the context menu. The
Equilla Editor opens in which you can edit the source code.

A strategy may look as follows in the editor:
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// Automatically generated by the Trading Strategy Wizard (1541647255)

Inputs:
CandleRawBigWhitePeriod( 5 ),
CandleRawBigBlackPeriod( 5 ),
Price1( Close ),
XAveragePeriod1( 30 ),
XAveragePeriod2( 60 );

Variables:
TRUEVALUE_VAR1,
XAVERAGE_VAR1,
XAVERAGE_VAR2;

TRUEVALUE_VAR1 = TrueValue( );
XAVERAGE_VAR1 = XAverage( Price1, XAveragePeriod1 );
XAVERAGE_VAR2 = XAverage( Price1, XAveragePeriod2 );

If CandleRawBigWhite( CandleRawBigWhitePeriod ) = TRUEVALUE_VAR1 Then
Buy ( "Long Candle" ) Next Bar At Market;

If CandleRawBigBlack( CandleRawBigBlackPeriod ) = TRUEVALUE_VAR1 Then
Short ( "Short Candle" ) Next Bar At Market;

If XAVERAGE_VAR1 Crosses Under XAVERAGE_VAR2 Then
Sell ( "Long Exit" ) Next Bar At Market;

If XAVERAGE_VAR1 Crosses Over XAVERAGE_VAR2 Then
Cover Next Bar At Market;

ORDER EDITOR

Ó ORDER EDITORWINDOW

The Order Editor allows you to

à recalculate full or partial backtesting
data after the original backtest has
been done,

à modify or delete automatically
generated orders and

à manually add additional orders.

There is always exactly one Order Editor
associated with each chart. Changes made in the chart will automatically reflect in
the Order Editor.
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Caution: Multiple manual changes made in the Order Editor must be committed using the
Apply Changes Button. Changes will otherwise be lost.

To open the Order Editor, proceed as follows:

01. Open a chart.

02. Switch to the Insert tab on the main ribbon.

03. Under Trading, click the buttonOrder Editor.

The Order Editor opens.

EDITING AND DELETING STORED ORDERS

EDITING STORED ORDERS

à Double-click the order you want to edit or

à click the button Edit (1) on the right-hand side.

The Edit Order window opens.

The following options are available:

Order The order command and trade mode you wish to apply to this trade. The
trade mode controls how the actual trade is being processed.

ORDER COMMANDS

Buy Places an order to buy a number of shares using a given trade mode.

Sell Short Places an order to sell short a number of shares using a given trade
mode.
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Sell Places an order to go close a long position or reduce it by a number of shares
using a given trade mode.

Buy To Cover Places an order to go close a short position or reduce it by a number
of shares using a given trade mode.

TRADE MODES

This Bar Market The trade is executed immediately.

This Bar Price The trade is executed at the specified price.

This Bar Stop Places a stop order. This order is only valid on this bar.

This Bar Limit Places a limit order. This order is only valid on this bar.

This Bar Close The trade is executed when the current bar closes.

Next Bar Market The trade is executed at the next bar's opening price.

Next Bar Stop Places a stop order. If the price is equal or higher than price on the
next bar, the order is executed. Otherwise it gets cancelled. This order is only
valid on the next bar.

Next Bar Limit Places a limit order. If the price is equal or lower than price on the
next bar, the order is executed. Otherwise it gets cancelled. This order is only
valid on the next bar.

Stop Price The stop price for this trade.

Quantity The quantity by which to exit the current position. Select Total to exit the
current position by the specified quantity, deducting from each entry in the order
they were entered, until the quantity is reached. Select Per Entry to reduce each
entry in the current position by the specified quantity.

Exit From The position to exit from, leave blank to exit from any position.

Name The name attached to this order.

Fill Timestamp Time and date of the point in time at which the order was filled.

Filled Price type at which the order was filled.

Fill Price (€) The price at which the order was filled.

Fill Exchange Rate Exchange rate from instrument currency to account currency.

Commission (€) The commission to be taken into account for this order.

Slippage (€) The slippage to be taken into account for this order.
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DELETING STORED ORDERS

à Click Delete in the context menu of the trade or

à click the Delete (2) Button to the left of the trade.

APPLY CHANGES
à To apply changes using currently available data, click the

Apply Changes (3) on the top bar of the Order Editor or

à click Recalculate From in the context menu of an order.

Caution: This action will remove all existing trades and cannot be undone.

ADDING ORDERS
à To add an order, click on Click here to add an order (4)

above the orders list.

Ó ADD ORDERWINDOW

The Add Order Window opens.

For an overview of available options see
"Editing and deleting stored orders" on
page 234

STRATEGY ORDERS

For information on historic orders generated by
trading strategies see chapter "Persistence of
executed strategy orders" on page 387.

MONEY MANAGEMENT

Ó MONEYMANAGEMENT

Any method for sensible capital and risk
management is assembled under the concept
Money Management. You can use Money
Management for the following:

à Setting the initial capital of a trading
system

à Setting the trading costs
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à Controlling the fundamental trading system functions

à Controlling the alerts generated by the trading system

à Setting basic risk parameters

Tradesignal offers Money Management functions for "Chart" on page 96,
"Scanner" on page 71, "Portfolio" on page 251 and "Watchlist" on page 77. You
can also read them out with Equilla code and use them in your own trading
systems. This way, you always have access to information like initial capital,
trading costs etc. Other functionalities that are not part of the standard settings
can be set up with strategies that are partly included in the delivery.

CONFIGURING THE MONEY MANAGEMENT

In the Home tab in the "Toolbar" on page 42 are all settings for the Money
Management available.

GENERAL
Risk Free Rate of Return Here you can specify the expected rate of return for a risk-
free investment. Used in the Sharpe Ratio and the Sortino Ratio calculations.

Start Date Here you can set a date at which the trade engine should start trading. If
not set, it will start trading at the first available data point.

End Date Here you can set a date at which the trade engine should stop trading. If
not set, it will continue trading indefinitely.

Automatic Trade Recalculation Here you can define whether trades should
automatically be recalculated based on the settings in File > Options > Advanced
> Strategy Orders or should be manually recalculated from the button Recalculate
Trades (Never).

Initial Capital Here you can set the initial capital for the current trading system. This
is an extremely important value for calculating performance, profits, losses, etc. A
system that is profitable for $100.000 might well be a losing system at $10.000.

Intrabar Backtesting Enter the datapoint resolution for "Intrabar Backtesting" on
page 243.

Persisted Trade Data Mode If Standard is activated, the same amount of data points
as set in history length is used for backtesting. With Extended is the amount of
data points increased.

Intrabar Tick Simulation % Enter the percentage of the price span (high-low) that is
used for the generation of an artificial tick in case of a stop or limit order being
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executed. This way, the behavior of the real price is simulated even though only
the high, low, open and close values are available. The default value is "10%".

The Generate Orders property specifies when orders can be generated by the
running strategies.

Intrabar Orders can be generated with every intra-bar update (for every tick).

On Bar Close Orders can only be generated when the bar closes. This mode is
especially useful when a signal might be invalidated before the bar closes, which
typically happens when the signals are generated based on compressed chart
types like Point and Figure, Renko, Three Line Break and Kagi (these chart types
can all remove bars resulting in trades being executed at prices that may not be
reflected in a bar when it is closed).

The Realtime Price Source property controls which prices are used to fill orders in
real time. Tradesignal supports two modes: bid/ask and last.

Bid/Ask Tradesignal uses the best bid / best ask data provided by either the broker
(if an order routing module has been connected) or the data provider. If neither
the broker nor the data provider is delivering bid/ask prices, Tradesignal uses the
last price instead (for example in the case of indices). Best bid and best ask prices
are generated when a market participant wants to buy or sell a number of
shares/contracts while a last price represents an actual trade that has been
made. Therefore this option has the benefit of more accurate fills for your orders.
The caveat is however that the results collected in real time will not match the
results of back-testing which will always only use the last price.

Last Tradesignal uses the last price delivered by the data provider. This is the
same price as the one used to back-test the strategy. A last tick represents a
trade that has been made in the market. When using this mode, Tradesignal can
only fill and order after a trade has been made, even if there was a matching
offer/request in the market prior to the trade. This mode ensures that real time
results are closer to back-test results.

Single Entry per Trade for Statistics Set to true, in which case trades will be based on
an entry/exit pair. The property can also be set to false, in which case trades will
be based solely on exits (for example and exit that exits two entries would be a
single trade).

STATISTICS CURRENCY
When trading multiple instruments that are quoted in different currencies,
aggregated statistic values can become meaningless.For example when adding
the net profit of $5 and ¥10 it is not enough to simply add the two numbers. In
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order to solve this both values need to be converted to the same currency before
adding them.This can be either of the two given currencies or a third one. In the
example both values could be converted to $, ¥ or something else like €.

Currency The currency global statistic values should be calculated in. The
available currencies are depended on your selected data provider.

Calculation Mode Selects the method that is used to calculate the currency
conversion factors for the current bar.

Close of Previous Bar Use the currency values at the close of the previous bar.

Arithmetic Mean Calculates the arithmetic mean of Open, High, Low and Close at
the current bar.

Midrange Uses the average of the highest and lowest currency value at the current
bar.

Arithmetic Mean without Open The average of High, Low and Close currency values at
the current bar.

Close Weighted Mean Calculate the arithmetic mean of High, Low and 2x Close at
the current bar.

OpenWeighted Mean Calculate the arithmetic mean of 2x Open, High and Low at the
current bar.

Apply To Risk When this option is enabled currency conversion options will also be
applied to automatic stop calculations. All numeric values in the "Total
Commission and Slippage" on page 297 and the "Risk" on page 241 sections are
assumed to be given in the global statistics currency.
SLIPPAGE AND COMMISSION
For realistic results in the backtest and the performance evaluation of a trading
system, it is important to include the trading costs in the calculation.

Split over each trade in an Exit Order If true, and if an order exits multiple entries,
commission and slippage will be distributed evenly across each trade. If set to
false, commission and slippage will be applied in full for each trade exited by an
order.

Two parameters are available:

SLIPPAGE

The slippage is the possible difference between the price at the trading signal and
the real price at order execution. Usually, some time passes between the order
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signal and the actual order execution, in which the price might move against the
trader. You can enter the slippage per trade or share.

Slippage Source Set to Settings & Assets to use slippage from the instrument
assets if available, otherwise to use the slippage from the properties. Set to
Settings to only use the slippage specified in the properties. Set to None to ignore
slippage.

Slippage/Trade Assumed Slippage per Order (independent of the number of
shares), either as absolute number or as percent value (for this, enter a %
character after the number).

Slippage/Contract Assumed Slippage per Contract or Share (independent of the
number of trades), either as absolute number or as percent value (for this, enter a
% character after the number).

Slippage/Lot Assumed Slippage per Contract Lot (independent of the number of
trades), either as absolute number or as percent value (for this, enter a %
character after the number).

COMMISSION

The commission includes all costs of the stock exchange and broker. You can
enter the commission per trade or share. In addition, you can enter a commission
flat rate, if your broker offers such trading conditions.

Commission/Trade Commission per order (independent of the number of shares),
either as absolute number or as percent value (for this, enter a % character after
the number).

Commission/Contract Commission per Contract or Share (independent of the
number of trades), either as absolute number or as percent value (for this, enter a
% character after the number).

Commission/Lot Commission per Contract Lot(independent of the number of
trades), either as absolute number or as percent value (for this, enter a %
character after the number).

Min. Commission Minimum commission costs per order (if set by your broker).

Max. Commission Maximum commission costs per order (if set by your broker).

POSITION SIZING
Default Quantity Enter the minimum number of shares that should be traded per
order.
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Max Shares Enter the maximum number of shares for this position (maximum
position size). Orders that would lead to a higher position size will not get placed.

Pyramiding Some trading systems work with position legs, meaning that after a
first trading signal, newer signals will lead to further trading activities depending
on the market movement. For example, the position size may be increased or
decreased for a high volatility. As default, this option is inactive. If you choose
pyramiding, two settings are available:

Yes, Different Further shares will be purchased in case of trading signals different to
the one that caused the first action.

Yes, All Further shares will be purchased in case of trading signals of any kind.

If you select pyramiding, you can enter a maximum number of open entries (Max.
Open Entries).

RISK
Here you can find static risk settings like Stop Loss and Trailing Stop and also
more dynamic parameters. In the following, the parameters in the Money
Management properties and their corresponding "Equilla Functions" on page 415
are given.

Stop Mode Stop Mode has to be chosen in combination with the Stop Loss and
Trailing Stop.

à In Contract mode (corresponding to Share), the settings of
Stop Loss and Trailing Stop are interpreted in relation to each
share. For example, a Stop Loss of "100" is taken into account
for each contract, independent of the position size. If the price
drops by 100 from the starting value, the Stop Loss is set off.

à In Position mode, the settings of Stop Loss and Trailing Stop
are interpreted in relation to the complete position. For
example, a Stop Loss of "100" will cause a position to be
closed when the total loss is 100. This might actually be four
points per share for Futures or one dollar for one hundred
stocks.

à In Lot mode, the settings of Stop Loss and Trailing Stop are
interpreted in relation to each contract lot.

SetStopMode(Mode)
SetStopShare // Alias to SetStopContract
SetStopContract
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SetStopPosition
SetStopLot

Profit Target This value in currency or points (depending on the security) gives the
profit the position has to reach to be closed instantly. Profit targets may help you
to stabilize your trading results over a longer time span.

SetStopProfitTarget(Value)

Stop Loss This value in currency or points (depending on the security) gives the
maximum acceptable loss after the entry, at which point the position is instantly
closed. A Stop Loss can protect you from overly high losses and secure your
financial ability to act in the future.

SetStopLoss(Value)

Break Even This value in currency or points (depending on the security) gives the
profit of the position that has to be reached before a position is closed once the
market moves against it. It is based on the idea that positions that were once in
the profit area should not move into a loss. Instead, they are closed, for example
to cover the trading expenses.

SetStopBreakEven(Value)

Profit Trailing This value in currency or points (depending on the security) gives the
maximum drawback of a position profit before the position is closed. This is a
simple method with which to avoid losing achieved profit.

SetStopProfitTrailing(Value)

% Trailing (Floor) This is a more flexible version of the Profit Trailing stop. With the
Floor parameter you enter a profit target at which the trailing stop will get
activated. With the % Trailing (%) parameter you set the maximum loss (in
percent) of the position profit before the position is closed.

SetStopPercentTrailing(ProfitTarget, PercentLoss)

Include Commission/Slippage Here you can choose whether the values for
commission and slippage you entered in the above areas of the Money
Management should be taken into account for the risk calculation.

ALERTS
Here you can select four possible situations (Order added, changed, cancelled,
filled) in which an alert shall be issued. You can find more information in the Alerts
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chapter.

INTRABAR BACKTESTING

Tradesignal allows you to use lower period data for backtesting in order to find
more accurate prices for fills and to approximate real-time trading results. Using
this feature will considerably shorten the available back testing history to that of
the smallest period chosen and can increase the time it takes to perform the
backtest (especially when performing optimization).

To enable this feature:

01. Go to Money Management > General > Intrabar Backtesting.

02. Select the desired period for the chart, watchlist, scanner or
portfolio in the mini toolbar.

Available periods include Tick, 1 Minute, 5 Minutes, Hourly and Daily. When using
Intrabar Backtesting, it is important to always select a period that is smaller than
the period of the instrument in the chart.

Backtesting will only begin at the point where there is sufficient historic data
available for both the original and lower period data sets. When using cumulated
periods (such as hourly), the normal algorithm for determining the order of price
flow within a bar will be used (for more information see the section on Order
Processing in the Equilla Formula Language documentation).

Note: This bar at market orders will continue to be treated as This bar on close orders for
historic bars when using a lower period for backtesting.

The Strategy Equity Combined Indicator has been enhanced to indicate the range
of data covered by the backtest, where this is less than the amount of visible data
in the chart. The property HighlightBacktestingRange can be set to False to
disable this indication.

STRATEGIES FOR MONEY MANAGEMENT

In the scope of delivery for Tradesignal, several strategies can be found that you
can use for Money Management.

STOPS AND EXITS
Fast Profit Exit Exits a position if it yields profit the day after entry.
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Peak Exit Exits a position if it made a profit and the trade changes direction against
you. It is based on a complex calculation that includes an Average True Range
indicator.

Percent Trailing Stop Corresponds to the setting in the Money Management area.

Profit Target Exit Corresponds to the setting in the Money Management area.

Profit Trailing Stop Corresponds to the simple Trailing Stop in the Money
Management area.

Stop Loss Corresponds to the Stop Loss setting in the Money Management area.

Timed Exit Exits a position at a given time of day, e.g. "1900".

Timed Exit (Bars) Exits the position at a given number of trading periods.

POSITION SIZING
Position Sizing - Fixed Fractional Sets the position size depending on given fractions
of capital.

Position Sizing - Fixed Fractional Percent Uses a combination of the method above
and other methods to define the fraction size.

Position Sizing - Fixed Percent Uses a defined percentage of the capital for defining
the position size.

Position Sizing - Fixed Risk Measures the volatility in the market and scales the
position size accordingly. Especially useful in combination with a Volatility Stop.

Position Sizing - Market's Money Sets the position size depending on the
performance of the trading system. If the total performance is in the profitable
area, more positions are entered. If the performance is negative, the position size
is reduced.

Position Sizing - Percent Volatility This is a variant of the Fixed Risk method, in which
position sizing is scaled depending on the volatility of the market.

MONEY MANAGEMENT AND EQUILLA
Several parameters that have to do with Money Management can be read out or
set with Equilla commands. This way, you are in complete control of share
numbers, open prices, commissions and slippage.

Read slippage:
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//Gives the slippage according to the Money Management parameters
Value1 = Slippage( Price, Quantity );

Read commission:

//Gives the commission according to the Money Management parameters
Value1 = Commission( Price, Quantity);

Read initial capital:

//Gives the initial capital according to the Money Management parameters
Value1 = InitalCapital;

In addition, you can read out many more parameters of open and close positions.
See the chapter Equilla Functions for more information.

EXAMPLE: PARAMETERS FOR A SIMPLE TRADING SYSTEM

The following parameters could be used for a trading system with Money
Management based on Candlestick Engulfing Patterns:

Chart:

à .NDX.X

à History Length in the chart properties to "2000"

Strategies:

à Candle Bearish Engulfing - Entry

à Candle Bullish Engulfing - Entry

Money Management:

à Slippage/Trade to 2 points

à Commission/Trade to 2 points

à Default Quantity to 10 contracts

à Stop Mode to "Contract"

à Profit Target activate with a value of "225" (click on the
number next to the checkbox and edit it)

à Stop Loss activate with a value of "40" (click on the number
next to the checkbox and edit it)
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à %Trailing (Floor) to 75 points

à %Trailing (%) to 5 points

Now a first trading system is configured. You can find more strategies for Stops,
Position Sizing and Statistics under Add Strategy in the toolbar.

POSITION MANAGER

Ó POSITIONMANAGER

The Position Manager is the central hub for
trading system information. In case several
trading systems are active in one or more
charts, all information about held positions,
pending orders etc. is displayed. This allows for
a complete overview of your current trading
system activities.

You can use the Position Manager for the
following:

à Keeping an overview of open positions

à Keeping an overview of working orders

à Keeping an overview of filled or canceled orders

à Tracking the current position development

USING THE POSITION MANAGER

ACCESSING THE POSITION MANAGER
In order to use the Position Manager, do the following:

01. Set up a chart.

02. Set up a trading system with strategies.

03. Open the Position Manager by clicking the button Position
Manager in the toolbar.

The new Position Manager group appears.

Note: By default, the Position Manager is linked to opened charts. You can find the current
positions on the tab Positions.
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The Position Manager collects all information from its start to its closing. It will
resume collecting new information upon startup of the workspace.

Caution: No data from the Position Manager is saved when closing a workspace.

POSITION MANAGER PROPERTIES
The general properties are available via "Settings" on page 157 in the home tab.

Monitor All Workspaces Usually, the Position Manager only collects information on
the trading system of the currently active workspace. Click this button to collect
information for all workspaces.

Print on separate pages Select this if the grids should be displayed on separate
pages.

Show Flat Positions Select this if flat positions should also be displayed.

In Appearance you can define settings like background, text and grid colors as well
as the font size.

UNLINKING THE POSITION MANAGER FROM A CHART
To sever the connection between Position Manager and chart, do the following:

01. Click the small plug symbol on the lower right of the chart to
open the menu Strategy Automation Options.

02. Choose the entry No Broker.

The connection between Position Manager and charts is now severed. To
reconnect, open the menu Strategy Automation Options again and click Position
Manager Only.

POSITION MANAGER TABS

ORDER TRACKER
Here you can find a list of all generated orders. It lists information on the time and
date of the purchase, the entry price, the profit/loss and the strategy that caused
the order. In the Order Tracker you can follow all trading system activities in the
workspace.

POSITIONS
Here you can find all currently held positions. It lists information on time and date
of the purchase, the entry price, current price and profit/loss, the strategy that
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effected the order and the broker (in case it was bought via Automatic Order
Routing). The minimum size of each position is defined by the Default Quantity
parameters in the Money Management of the chart.

ACTIVE ORDERS
Here you can find all pending orders, e.g. orders with a limited validity to be filled
in at a certain time or for a certain price

FILLED ORDERS
Here you can find all orders that have been filled, together with information on the
time, price, quantity, the strategy that effected the order to be submitted and the
broker.

CANCELLED ORDERS
Here you can find all orders that were canceled before being filled. This may
include Stop Orders or other order types that were canceled by the trading
system prematurely.

COLUMN SUMMARIES

Ó ADDING A NEW SUMMARY FOR THE
COLUMN "ENTRY/HILL PRICE"

The Positions category supports column
summaries. The Profit/Loss sum is added by
default. Right-clicking on the shaded bar at the
bottom of the positions tab window below a
column opens a context menu with various
predefined summary values that may be shown
for that column (if applicable):

à Sum

à Minimum Value

à Maximum Value

à Row Count

à Average Value (Mean)

Multiple summaries may be displayed for a column via the option New Summary
from the context menu (only available after a first summary has been added).

To remove summaries, either right-click a summary and select None to remove it,
or select Clear Summary Items to remove all of them (only available if more than one
summary is being displayed).
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CONDITIONAL ROW COLORING

All categories support conditional row coloring and styling.

01. Select the category to configure.

02. Click Home > Table > Columns > Conditional Formatting
on the Toolbar to display the conditional formatting dialog.

03. Click the Add new condition... link to add a new condition
and name the rule.

04. In the condition field on the right, type the condition or use the
... button to start the condition editor.

05. Select fore and background colors and optional font changes
to use if the condition is met.

06. Add more conditions if desired

07. SelectOK to apply the formatting.

Conditions may be removed by clicking the x next to the conditions name in the
conditional formatting dialog.

Note: Conditional formatting will be saved with a style template for the Position Manager.

FILTERING RESULTS

There are multiple ways to filter the results displayed a category in the Position
Manager

à Quick filtering by clicking on Home > Find > Find on the
Toolbar, and typing a keyword, matching items will be
highlighted, not matching rows will be hidden.

à Show the Filter Editor by clicking on Home > Table > Filter >
Edit Filter. The filter builder allows a filter to be visually
constructed using various Boolean operations and interactive
components arranged in a tree structure. All following
commands will also be visible in the Filter Editor if shown.

à Show the Auto Filter Row by clicking on Home > Table >
Filter > Show Auto Filter Row on the toolbar. Only rows
containing matching text entered in the filter row at the top of
the column will be displayed.
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à Clicking the filter icon when hovering the mouse over a
column title displays a list of possible filters for the selected
column.

If any filtering method other than Quick Filtering is active, a row will be displayed
at the bottom of the Position Manager pane showing the active filter conditions.

This row has the following options.

à A check box to temporarily disable/enable the filter.

à An x button to permanently remove the filter.

à A button labelled Edit Filter that will show the Filter Editor
dialog.

ADDING, REMOVING AND REORDERING COLUMNS

Columns may be resized or repositioned via drag-and-drop.

à To add or remove columns, select Home > Table > Columns
> Add/Remove Columns on the Toolbar, and drag and drop
columns to and from the displayed dialog as desired.

EXPORTING POSITION MANAGER DATA

The table contents of the Position Manager can be copied to other programs. For
more information, see the chapter Copying Documents via the Windows
Clipboard.

EXAMPLE FOR SETTING UP THE POSITION MANAGER

With the following parameters you can follow a security with a MACD Crossover System
intraday.

CHART

01. Select a security with a high turnover, e.g. "Apple Inc"
(AAPL NAS)

02. Set Period to hourly
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STRATEGY

01. Apply the MACD Crossover with Bearish on short entry
to the chart.

02. In the Insert group in the toolbar, click Position
Manager.

03. Click on the tab Positions in the Position Manager to see
the currently open positions.

PORTFOLIO

Ó PORTFOLIO

Note: The following chapter describes the completely
redesigned Portfolio approach published with Tradesignal
10. For the older, no longer recommended approach, see
Portfolio (Classic).

The Portfolio in Tradesignal is a basket of
securities that are traded by one or more
trading systems. You can use the Portfolio to
do the following:

à Trade several securities in a trading system

à Use trading systems for a list of securities

à Trade an account of several securities by defined rules for
money and risk management

à Trade with trading systems automatically via a broker

Like the Watchlist, the Portfolio is updated automatically.

The Portfolio is a type of chart that splits the view between a list of instruments on
the left side, and the chart, subcharts and tools of the selected item on the right
side.

The important difference from Scanner andWatchlist is that the Portfolio is
intended to handle the included instruments as a structurally unified whole.
(However, this can be changed by you.) This results in the following:

à In indicators and strategies, you can access data of other
instruments in the Portfolio. (This is not possible in a
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Watchlist.)

à Indicators and strategies are each applied to all instruments in
the Portfolio. For example, indicator 1 is applied to all
instruments, then indicator 2 etc. This allows you using scripts
to filter the instruments for the next steps. (In comparison, in
the Scanner, Watchlist and Chart, the indicators/strategies
are applied to each instrument, i.e. indicator 1 and 2 to
instrument A, then both to instrument B etc.) However, every
instrument has its own chart and can be set up to have other
indicators/strategies and parameters applied than the others
instruments while still remaining in the Portfolio.

à The Money Management in the Portfolio refers to the
complete Portfolio. (In Scanner andWatchlist, the Money
Management applies to the single instruments.)

An important new feature is the Portfolio History; by tracking removed symbols as
"deactivated" entries, every portfolio state can be seen, edited and reactivated in
the Portfolio History. It is now also possible to import histories of instruments, e.g.
the full history of the DAX including joiners, leavers and splits, and use this in the
evaluation.

For the idea of using scripts as filters in the Portfolio analysis, two strategies are
available in Tradesignal: "Portfolio Top Dogs Picker" and "Portfolio Top Dogs
Trader". First, apply the picker to pick the ten best instruments of the last year and
invest into them in equal shares, then use the trader to trade these ten
instruments.

Note: It is not possible to create a portfolio template, and templates cannot be applied to
portfolio charts.

CREATING A PORTFOLIO

You can open a Portfolio and add symbols to existing ones in various ways.

à Click on the Portfolio button in the Insert tab of the toolbar.

à Open the context menu of a symbol list in the toolbox and
choose the entryOpen in Portfolio.

à In the command line, enter a symbol shortcut, e.g. "DD NYS"
and select Add Symbol to add it to an existing Portfolio, or
New Portfolio for a new one.
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à Via the symbol search. For this, click on the Symbol Search
button, find a symbol and select Insert the symbol into the
selected workspace item to add it to the Portfolio, or Create
a new Portfolio for a new one.

à You can also add symbols to a Portfolio via drag-and-drop
from the toolbox or other documents into either the list or the
chart.

All portfolio changes have to be confirmed with Done. This creates a new history
entry, see "Portfolio History" on page 255.

Tip: When you select a symbol list (e.g. the Nasdaq), ensure that the index itself is not
included in the Portfolio. It makes no sense to include an index in a list of symbols when
searching for optimal trading parameters.

WORKING WITH THE PORTFOLIO

Ó PORTFOLIO LISTWITH STRATEGY
APPLIED

The Portfolio list has two columns - the
checkmark column and the Name column. In
the Name column, the green up arrow indicates
the position "long" followed by position size, the
red down arrow the position "short" followed by
position size. No icon and size means a flat
position.

By clicking the star icon , you can toggle the
display between instrument name and symbol.

By clicking the arrow icons, you can toggle
whether the respective positions will be
displayed. The last icon is for toggling the
display of the flat positions.

For filtering the list, enter free text in the search
field for a wildcard search. The list will be
filtered dynamically while typing.

In the footer, there is an information on the number of items that will be
considered for actions. Examples:

à When using a display filter: "2 of 10 selected"

à When only some items are checked: "1/10 checked"
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à When a very long history is being loaded: information about
the load progress

For the currently selected entry (visible from the small red arrow in addition to
the checkmark), the chart is displayed to the right, with all its
indicators/strategies/subcharts/drawing tools.

THE PORTFOLIO LOGIC
By default, all items in the list are always active and contribute to each evaluation.
In this so-called unified mode (see below), indicators and strategies will be added
to each portfolio constituent, even the unchecked ones.

Regardless of unification mode, the following will only apply to checked items:

à changes to indicator/strategy properties (one exception are
global portfolio strategies (e.g. Top Dogs Portfolio), changing
properties for such strategy will apply to all entries, checked or
not)

à operations such as add, remove, edit the item itself

à drawing tools and repositioning items

Note that the currently selected (highlighted) entry is always implicitly
selected, so property changes will always be effective for that entry even when it
was actually unselected.

Indicators that have no visible parent objects will be visible irrespective of the
selected item. This way it is possible to add benchmarks or global statistics once
instead of one time for each instrument.

THE CONCEPT OF "UNIFY PORTFOLIO"
In the Columns & Rows button menu, there is the option Unify Portfolio which is
selected by default (gray row).

Every portfolio starts as unified portfolio, meaning that the application will strive to
apply the operation to all symbols in the portfolio. However, if a change is not
applicable to some checked items (for example, because it has been individually
modified to no longer be similar), these items will be deemphasized in the list by a
grayed-out checkmark . The easiest way to have a grayed-out list is when you
select a drawing tool. (Because changes of the drawing tool cannot be applied to
the list items.)
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Unselecting the option Unify Portfolio is the manual way to fragment the portfolio.
In a non-unified portfolio, every entry has to be selected and edited for itself.
Indicators and strategies will only be applied to the selected entries.

If a Portfolio is no longer unified, this can be seen via the buttonManage
Objects, see "Changing the Evaluation Order of Indicators and Strategies" on
page 378. For every un-unified sample, there will be a row with an indicator or
strategy and the number of symbols this applies to.

Tip: Depending on the structural differences between the list entries it may not be possibly
to re-unify a portfolio by clicking on Unify Portfolio. The best way to re-unify a fractured
portfolio is by deleting at least some of the applied indicators and strategies, for example via
theManage Objects overview.

DELETING SYMBOLS FROM A PORTFOLIO
When you delete a symbol from the Portfolio, it will only be deactivated. Adding
the same symbol again will recover the deactivated symbol. You can display
deactivated symbols in the list via Columns & Rows > Show Inactive Portfolio
Items.

To deactivate a symbol, click on a row and either press the DEL key or right-click
on the entry and select Delete from the context menu.

Deleting a symbol completely is possible in two ways:

à When the symbol is freshly added and removed before the
change is confirmed with Done.

à When you delete the symbol from a portfolio in the Portfolio
History, see next section.

PORTFOLIO HISTORY
Portfolios will maintain their trade history even if one of the portfolio items is
deleted (deactivated), if the Money Management property Automatic Trade
Recalculation is set to “None”. In this case, the trade history for a portfolio that
changes over time will remain intact and be visible in the performance report. To
regenerate executed historic trades manually, the Order Editor or the Home >
Strategies > Recalculate Trades command must be used.
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Ó PORTFOLIO HISTORY

The option Portfolio History in the toolbar
gives you a detailed history of the Portfolio,
including Leavers & Joiners over time.

à In the left column, every change in
the Portfolio is displayed with date
and time stamp and changes. Click
on the small button [...] to change the
activation time, or click the revert
button to revert all the changes made
to the respective section to the state
when the Portfolio History dialog was
opened.

à In the right column, the composition of the Portfolio state
selected to the left is displayed. Portfolio items can be deleted
here by selecting one or more entries (via Shift+click or
Ctrl+click) and clicking Remove.
To remove the item from all saved states, check the option
Delete symbol from all portfolios in the history. Otherwise it will
only be deleted from the selected portfolio.

Tip: To backtest portfolio changes over time, enter the initial portfolio to generate the history.
Next, enter the changed portfolio and select a bar from which this new portfolio takes effect.
At this point, the chart automatically recalculates the trades based on the Portfolio change, if
the Money Management property Automatic Trade Recalculation is set to “Default”. (The
automatic recalculation will adhere to what is set up in the advanced options, see "Strategy
Orders" on page 327.)

The Leavers & Joiners Portfolio History can be exported and also imported. This
e.g. makes it possible to import the DAX stock data from the last 30 years
including symbol name changes, to backtest strategies against it.

The Leavers & Joiners Symbol List files will appear in a folder of the same name
in the Symbol Lists in the toolbox, if a directory is defined in the advanced options,
see "Leavers & Joiners Symbol Lists" on page 323. From the file context menu,
the options Insert Symbol List (for inserting it into an existing portfolio) and
Open in Portfolio (for creating a new portfolio) are available.

IMPORT PORTFOLIO HISTORY WIZARD

When importing a Portfolio History, a wizard starts, asking you how to handle the
merge between the existing history and the one to import. If you start with an
empty portfolio, just click Finish.
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Keep the existing history and combine it with earlier entries of the
imported history.

Keep the existing history and combine it with later entries of the imported
history.

Discard the existing history, except the current portfolio, and combine it
with the imported history.

Discard the existing portfolio history and replace it with the imported
history.

In the next step, you need to define how to apply strategies to the new items:

Do not copy any strategy

Copy all strategies common to all existing items

Copy all strategies common to from a specific items

Select the strategies for every new item separately

PORTFOLIO SORTING
The order of the Portfolio determines how well a strategy works, as the symbols
are processed in the given order.

Therefore, if you start changing the order and your Portfolio is being recalculated
because the Money Management property Automatic Trade Recalculation is
set to “Default” , you will lose the historical trades.

To prevent this, no automatic sorting is available. Symbols can only be sorted
manually by drag-and-drop.

GROUPING IN THE PORTFOLIO

Ó PORTFOLIO GROUPING

It is possible to group entries in the Portfolio.
Grouping allows e.g. for weighted investments,
in which you use 66% of investments in
Group1, and 33% in Group2, see the "Group
Alloc Portfolio Strategy" on page 666. The
group information can also be used in Equilla
scripts via the PortfolioGroup function.

For grouping, use the Set Group function from
the context menu or via Columns & Rows > Set
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Group in the toolbar. You are asked for a group name.

If chosen from the context menu, this adds a group above the row your mouse cursor was
positioned in. Otherwise, the new group is created as a new row on top.

You can move symbols between groups. For this, select one or more entries (via
Shift+click or Ctrl+click) and drag-and-drop them to another group.

To remove a group, click the group name line and select Columns & Rows > Set
Group. Delete the group name and confirm withOK. This will instantly remove the
grouping and the symbols are joined with the group above, if any exists.

Note: Groups cannot be moved as whole and cannot be minimized or folded.

ADDING STRATEGIES TO THE PORTFOLIO

When a strategy is added to the Portfolio, the indicators "Strategy Equity
Portfolio" and "Strategy Drawdown Portfolio" are added automatically as
subcharts, unless you change this in the advanced options (see "Indicators &
Strategies" on page 327).

In addition, the strategy "Portfolio Leave Exit" is also added, so that a position will
be exited when the symbol is deactivated (see "Portfolio Leave Exit Strategy" on
page 739). This can also be changed in the advanced options.

Adding further strategies will apply them to all items, unless the Portfolio is no
longer unified.

PORTFOLIO PROPERTIES

As the portfolio is chart-based, it does not have properties of its own but is set up
in the Chart "Settings" on page 157. All settings will be applied to each chart of
every Portfolio item.

Important parameters are:

History Length Enter the length of the history here (max. 500000).

Min. Referenced Bars Enter the minimum number of bars that should be used for
calculating the values of indicators and strategies.

Settings of symbols, indicators and strategies themselves are accessible in the
"Mini Toolbar" on page 45.
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PLACING ORDERS
This can be done through "Manual Order Routing" on page 317.

BUTTONS IN THE TOOLBAR

Ó PORTFOLIO OPTIONS IN THE
TOOLBAR

Period Here you can set the period that is to be
used in the Portfolio (this corresponds to the
period settings for a chart). The symbols in the
Portfolio are always called up with the default
period at first.

Columns & Rows Open the menu for the column
settings of the Portfolio. For activation or deactivation of several columns select
the columns and use check or uncheck at the bottom.

Set Group Here you can group the parameters for better overview. Select a
number of rows in the table and click on the button. You can then enter a name for
the group.

ANALYZE THE PORTFOLIO

You can apply indicators and strategies to the Portfolio. In addition, the Portfolio
contents can be combined with other functions.

OPTIMIZE A STRATEGY IN A PORTFOLIO
You can start the Optimizer directly from within the Portfolio. This way, you can
optimize the strategies for all symbols of the Portfolio.

Click on the buttonOptimize in the group Strategies of the toolbar to start the
Optimizer. You have the choice between several methods, and you can choose
the parameters that should be used for optimizing. The Optimizer then runs
through all chosen parameters for the symbols included in the Portfolio.

For more information see chapter "Optimizer" on page 274.

ACTIVATE THE ORDER ROUTING FOR A PORTFOLIO
You can use Automatic Order Routing for a Portfolio. The following conditions
have to be met:

à The Order Routing has to be set up correctly. See chapter
"Automatic Order Routing" on page 307.
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à The Option Strategy Automation Option has to be set. For
this, click on the small plug symbol in the lower right corner of
the equity subchart to open the menu, and select your broker.

The Order Routing can now be started by clicking Start Automatic Order
Routing in theOrder Routing tab in the toolbar.

USE THE POSITION MANAGER WITH THE PORTFOLIO
As soon as you have assigned strategies to a Portfolio, you can also open the
Position Manager for it. If not defined otherwise, the Position Manager uses the
position information of the current workspace, in this case the symbols in the
Portfolio. To avoid losing the overview, it is useful to use the filter function for
searching information for specific symbols. With a double-click at a specific row
the traded symbol is focused at the portfolio itself.

Tip: You can find more information in the chapter "Position Manager" on page 246.

USE THE PERFORMANCE REPORT WITH A PORTFOLIO
You can generate a Performance Report for a Portfolio. The resulting report will
include performance information for the complete Portfolio as well as for each
symbol.

Tip: You can find more information in the chapter "Performance Report" on page 287.

MONEY MANAGEMENT
The global Money Management settings can also be used for the Portfolio. Note
that in the Portfolio, the Money Management is applied to all instruments as a
whole. You can enter the initial capital and values for Stop Loss and Trailing Stop.
It is also reasonable to use some of the Position Sizing strategies offered by the
software. This allows you to distribute the available capital onto the symbols in the
Portfolio as positions of the same size.

Tip: You can find more information in the chapter "Money Management" on page 236.

CHANGE THE HISTORY LENGTH OF THE PORTFOLIO
You can set the history length of the Portfolio in the properties of the chart, setting
History Length. Keep in mind that for long histories and large portfolios, a
considerable computational effort results, which may impair your computer's free
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resources. Therefore, it is recommended that backtests and the real trades
should be performed in separate workspaces with different history lengths.

OPEN A CHART FROM THE PORTFOLIO AND PAGE THROUGH
CHARTS
To view the chart for a symbol, click on the entry.

Ó TURN BUTTONS

If you want to go through the whole list of
symbols in a Portfolio to see each chart, use
the red arrow buttons on the top left of the
header. As soon as you open one chart of a
Portfolio entry, you can page through the full list
of symbols this way.

USE SYMBOLS IN ANOTHER TABLE
You can reuse symbols from a Portfolio in a Watchlist, a Scanner or another
Portfolio.

In a similar way, you can drag symbols from a Scanner or Watchlist into a
Portfolio.

PORTFOLIO (CLASSIC)

Note: As of Tradesignal 10, the Portfolio approach has been completely redesigned,
offering many more capabilities than in the past. Therefore we recommend that you use the
new Portfolio from here on.
However, you can still work with classic portfolios. For this, activate the option "Show the
deprecated Portfolio (Classic) in the ribbon" viaOptions > Personalize > Ribbon Toolbar
in the "Tradesignal Options" on page 319. When this option is activated, the Portfolio
(Classic) entry will become available as addition to the Portfolio entry, e.g. when right-
clicking a symbol list and selecting Open in Portfolio (Classic).

Ó PORTFOLIO (CLASSIC)

The Portfolio (Classic) in Tradesignal is a
basket of securities that are traded by one or
more trading systems. You can use the
Portfolio (Classic) to do the following:

à Trade several securities in a trading
system.
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à Use trading systems for a list of securities

à Trade an account of several securities by defined rules for
money and risk management

à Trade with trading systems automatically via a broker

Like the Watchlist, the Portfolio (Classic) is updated automatically. The data is
displayed in realtime. The cells with the latest changed values are displayed with
colored background.

The important difference from Scanner andWatchlist is that the Portfolio (Classic)
handles the included instruments as a whole. This results in the following:

à In indicators and strategies, you can access data of other
instruments in the Portfolio (Classic). (This is not possible in a
Watchlist.)

à Indicators and strategies are each applied to all instruments in
the Portfolio (Classic). For example, indicator 1 is applied to
all instruments, then indicator 2 etc. This allows you using
scripts to filter the instruments for the next steps. This is also
the reason why a Portfolio (Classic) cannot be displayed in a
chart. (In comparison, in the Scanner, Watchlist and Chart,
the indicators/strategies are applied to each instrument, i.e.
indicator 1 and 2 to instrument A, then both to instrument B
etc.)

à The Money Management in the Portfolio (Classic) refers to
the complete portfolio. (In Scanner andWatchlist, the Money
Management applies to the single instruments.)

For the idea of using scripts as filters in the Portfolio (Classic) analysis, two
strategies are available in Tradesignal: "Portfolio Top Dogs Picker" and "Portfolio
Top Dogs Trader". First, apply the picker to pick the ten best instruments of the
last year and invest into them in equal shares, then use the trader to trade these
ten instruments.

The document type Portfolio (Classic) has the following design parameters:

à The maximum history length (in this case of the equity chart)
is 500000.

à The maximum number of instruments is 101.

à The maximum number of indicators/strategies is 32.
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à Indicators and strategies are processed vertically, i.e. each is
applied to all instruments before the next indicator/strategy is
applied (see above).

PORTFOLIO (CLASSIC) SETUP

Tip: The Portfolio (Classic) should only be used for existing classic Portfolios before
Tradesignal 10. See Portfolio for the new, more flexible portfolio management.

If the option Show the deprecated Portfolio (Classic) in the ribbon is
activated, you can open a Portfolio (Classic) with symbols in various ways.

WITH THE WIZARD
When choosing one of the following methods, the wizard will open:

à Click on the Portfolio (Classic)button in the Insert tab of the
toolbar.

à Open the context menu of a symbol list in the toolbox and
choose the entryOpen in Portfolio (Classic). (If selecting
this for a single symbol, it opens without a wizard.)

The Create Item wizard opens, in which you can select indicators and strategies in two more
steps. Click on Done to close the wizard and save the settings.

ADDING ONE OR MORE SYMBOLS MANUALLY
You can also add single symbols or open a new Portfolio (Classic) without using
the wizard.

à Open the context menu of a symbol or symbol list in the
toolbox and choose the entry Insert Symbol to add it to the
active Portfolio (Classic).

à In the command line, enter a symbol shortcut, e.g. "DD NYS"
and select Add Symbol to add it to a Portfolio, or New
Portfolio (Classic) for a new one.

à Via the symbol search. For this, click on the search button and
select Insert the symbol into the selected workspace
item to add it to the Portfolio (Classic), or Create a new
Portfolio (Classic) for a new one.

à You can also add symbols to a Portfolio (Classic) via drag-
and-drop from the toolbox or other documents.
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The History Length (candles/bars) that is regularly taken into account is 2. When
you add an indicator, the length may be increased if necessary for the indicator
calculation. E.g., the Chande Momentum Oscillator sets the length to 16. If you go
below this necessary length, indicators may not give results anymore. In this
case, increase the length again.

When you select a symbol list (e.g. the Nasdaq), ensure that the index itself is not
included in the Portfolio. It makes no sense to include an index in a list of symbols
when searching for optimal trading parameters.

PORTFOLIO (CLASSIC) PROPERTIES

The general properties are available via "Settings" on page 157 in the home tab.

Important parameters are:

History Length Enter the length of the history here (max. 500000).

Min. Referenced Bars Enter the minimum number of bars that should be used for
calculating the values of indicators and strategies.

In the Appearance area, you can enter the colors for changing values in the table.

Update Indications Set the background color for table cells with values changed
since the last update, e.g. gray. Up Move and Down Move – Set the colors for
increasing/decreasing values, e.g. green for up, red for down.

In the areas Equity and Equity Chart , you can change the settings for the equity
chart.

Settings of symbols, indicators and strategies themselves are accessible in the
"Mini Toolbar" on page 45.

DELETING SYMBOLS FROM A PORTFOLIO (CLASSIC)
You can delete symbols from a Portfolio (Classic).

Select the symbols. You have the following options:

à Press Ctrl+A to select all.

à Press Ctrl and click on single instruments to select them.

à Press Shift and click on two instruments to select the
instruments between them..

à Press the Del key to delete the selected instruments.
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PLACING ORDERS
This can be done though "Manual Order Routing" on page 317.

PORTFOLIO (CLASSIC) BUTTONS IN THE TOOLBAR

Ó PORTFOLIO (CLASSIC) OPTIONS IN
THE TOOLBAR

Period Here you can set the period that is to be
used in the Portfolio (this corresponds to the
period settings for a chart). The symbols in the
Portfolio are always called up with the default
period at first.

Columns & Rows Open the menu for the column settings of the Portfolio (Classic).
With the option Set Group you can group the parameters for better overview.
Select a number of rows in the table and click on the button. You can now enter a
name for the group. A button appears on top of the table that allows you to
open/close the group views like a folder tree in Windows Explorer.

COLUMNS IN THE PORTFOLIO (CLASSIC)

The table shows different columns depending on the indicators and strategies
you are using. The number of columns added for each indicator or strategy
depends on the number of output data.

à For each indicator, all columns with a non-static output are
displayed. For example, for the "Bollinger Band" indicator
there are three columns, for the "Elder Ray" indicator two
columns (and two invisible columns with static values).

à For strategies, the two columns "Position" and "Position Size"
are displayed over all strategies. The parameters of the single
strategies are usually set to invisible in the Equilla code
("visuals" are "inactive"). If they were displayed, they might
also interfere with the statistics, which is usually not desired.
When at least one strategy is available, you can add columns
for statistical output like "Total Net Profit".

SORTING THE COLUMNS
You can sort the columns in the Portfolio (Classic) by clicking on the column
header. A little triangle appears, pointing up or down depending on the sorting
direction. To change the direction, click on the column header again.

Alternatively, right-click into the column and select the sort direction in the context
menu.

265



COLUMN GROUPING
This function in the Columns button menu leads to a new row in the table top. If
groups are already defined, a button appears for them.

You can start a group by dragging a table row in this new row at the table top, or
by selecting a row and clicking on Set Group under Home > Table > Columns on
the toolbar.

ADD/REMOVE COLUMNS
With this function in the Columns button menu you can set columns in the table to
visible or invisible.

In the list, all available columns are sorted by categories. Standard columns like
price or symbol information are available, as well as a large numbers of statistical
values for trading systems. If an indicator offers additional information, it appears
as an entry here too.

Select the entries for all columns you want to display, or click on Show All for
selecting all entries.

MANAGE STRATEGIES AND INDICATORS
With this function in the Columns button menu you can

à set the processing order of the indicators and strategies by
selecting an entry and clicking on Sort Ascending or Sort
Descending. Remember that indicators/strategies are
processed vertically, i.e. each is applied to all instruments
before the next indicator/strategy is applied.

à delete indicators and strategies by selecting an entry and
clicking on Remove.

FORMAT OPTIONS

In the Portfolio (Classic), the following Format buttons are available in the toolbar.

Styles Here you can set the display options of the table, e.g. gray background with
orange and yellow text. You can find more information in the chapter Styles.

Sessions Here you can set the trading times. You can find more information in the
chapter Sessions, Holidays and Properties.

Edit Prices Here you can manually edit prices of symbols. You can find more
information in the chapter Price Editor.
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ANALYZE THE PORTFOLIO (CLASSIC)

You can apply indicators and strategies to the Portfolio (Classic). In addition, the
Portfolio (Classic) contents can be combined with other functions.

OPTIMIZE A STRATEGY IN A PORTFOLIO (CLASSIC)
You can start the "Optimizer" on page 274 directly from within the Portfolio
(Classic). This way, you can optimize the strategies for all symbols of the Portfolio
(Classic).

Click on the buttonOptimize in the group Strategies of the toolbar to start the
Optimizer. You have the choice between several methods, and you can choose
the parameters that should be used for optimizing. The Optimizer then runs
through all chosen parameters for the symbols included in the Portfolio.

For more information see chapter "Optimizer" on page 274.

ACTIVATE THE ORDER ROUTING FOR A PORTFOLIO (CLASSIC)
You can use Automatic Order Routing for a Portfolio (Classic). The following
conditions have to be met:

à The Order Routing has to be set up correctly. See chapter
"Automatic Order Routing" on page 307.

à The Option Strategy Automation Option has to be set. For
this, click on the small plug symbol in the lower right corner of
the equity subchart to open the menu, and select your broker.

The Order Routing can now be started by clicking Start Automatic Order
Routing in theOrder Routing tab in the toolbar.

USE THE POSITION MANAGER WITH THE PORTFOLIO (CLASSIC)
As soon as you have assigned strategies to a Portfolio (Classic), you can also
open the Position Manager for it. If not defined otherwise, the Position Manager
uses the position information of the current workspace, in this case the symbols in
the Portfolio (Classic). To avoid losing the overview, it is useful to use the filter
function for searching information for specific symbols.

Tip: You can find more information in the chapter "Position Manager" on page 246.

USE THE PERFORMANCE REPORT WITH A PORTFOLIO (CLASSIC)
You can generate a Performance Report for a Portfolio (Classic). The resulting
report will include performance information for the complete Portfolio as well as
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for each symbol.

Tip: You can find more information in the chapter "Performance Report" on page 287.

MONEY MANAGEMENT
The global Money Management settings can also be used for the Portfolio
(Classic). Note that in the Portfolio (Classic), the Money Management is applied
to all instruments as a whole. You can enter the initial capital and values for Stop
Loss and Trailing Stop. It is also reasonable to use some of the Position Sizing
strategies offered by the software. This allows you to distribute the available
capital onto the symbols in the Portfolio (Classic) as positions of the same size.

Tip: You can find more information in the chapter "Money Management" on page 236.

CHANGE THE HISTORY LENGTH OF THE PORTFOLIO (CLASSIC)
You can set the history length of the Portfolios in the properties of the Portfolio
(Classic), setting History Length. Keep in mind that for long histories and large
portfolios, a considerable computational effort results, which may impair your
computer's free resources. Therefore, it is recommended that backtests and the
real trades should be performed in separate workspaces with different history
lengths.

SORT THE COLUMNS
You can sort the Portfolio (Classic) columns by clicking on the respective column
header. A small triangle appears (pointing up or down, depending on the sorting
direction). To change the direction, click on the column header again. Alternative
you can use the sorting from the context menu. Click with the right mouse button
inside of the column and choose the sort direction.

OPEN A CHART FROM WITH THE PORTFOLIO (CLASSIC) AND
PAGE THROUGH CHARTS
To view the chart for a symbol from within the Portfolio (Classic), open the context
menu of the table row and selectOpen for the entry Chart. The chart is opened
with the selected symbol, its period and all included indicators and strategies. The
chart will also be linked automatically to the Portfolio (Classic) via symbol linking.
Please note that in contrast to "Scanner" on page 71 and "Watchlist" on page 77,
the history length of the portfolio will not be used.

If you want to go through the whole list of symbols in a Portfolio (Classic) to see
each chart, use the red, arrow buttons on the top left of the header. As soon as
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you open one chart of a Portfolio (Classic) entry, you can page through the full list
of symbols this way.

USING THE RESULTS WITH DRAG-AND-DROP

USE SYMBOLS IN ANOTHER TABLE
You can reuse symbols from a Portfolio (Classic) in a Watchlist, a Scanner or
another Portfolio.

If you want to start with a new table, open one by clicking the button Portfolio (or
Scanner or Watchlist) in the Insert tab of the toolbar and closing the wizard with
Done. An empty table is opened. Alternatively, you can use existing tables.

In the Portfolio (Classic), click into a table cell of the symbol you want to reuse. A
little plus sign and a rectangle appear under the mouse cursor. Now drag the
cursor into the other table. The symbol is copied into the table.

In a similar way, you can drag symbols from a Scanner or Watchlist into a
Portfolio.

SAVING SYMBOLS IN A PORTFOLIO (CLASSIC) AS SYMBOL LIST
From within the Portfolio (Classic), you can save interesting symbols as a new
symbol list.

01. To save the symbols as a new list, click on the entry New
Symbol List in the Related Tasks area of the symbol
manager in the toolbox. Choose the option User-Defined
Symbol List and name the list but keep it empty.

02. In the Portfolio, click into a table cell of the symbol you want to
reuse. (By pressing Shift or Ctrl while clicking with the
mouse, you can select more than one row.) A small plus sign
and a rectangle appear below the cursor.

03. Since a first click opens the properties tab, click again on the
button Symbol Lists in the toolbox to open the symbol
manager.

04. Drag the selected symbols to the new symbol list. The
symbols are added to the list.

EXPORTING PORTFOLIO (CLASSIC) DATA

The table contents of the Portfolio (Classic) can be copied to other programs.

For more information see chapter "Publish to Office" on page 346
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CORRELATION MATRIX

Ó CORRELATIONMATRIX

The Correlation Matrix document is a type of
scanner that calculates the results of a chosen
correlation-type function for each item in a
symbol list against each other item in the same
(or different) symbol list.

Any indicator that takes two data inputs can be
selected for the correlation function, and any
predefined or user-defined symbol list may be
selected for either the row or column list.

Either list may contain formula, combined or continuation symbols in addition to
normal symbols. After changes are made to the composition of the Correlation
Matrix, select Home > Table > Start Scan.

Multiple indicators (or the same indicator multiple times with different inputs) can
be added to the Correlation Matrix.

The correlation document provides a comprehensive set of conditional formatting
tools, see "Formatting the Correlation Matrix Output" on page 272.

Correlation Matrix documents, like other scanners, can be scheduled via Home >
Table > Start Scan > Schedule Scan. Scheduled scans can be managed by
clicking on the Scheduled Jobs button to the right above the ribbon (next to the
connection status and clock). For details, see "Schedule Jobs" on page 349.

CREATING A CORRELATION MATRIX

01. Click on the Correlation Matrix button in the Insert tab of the
toolbar to open the wizard.

02. Add the symbol list or symbols to appear as a row.

03. Add the symbol list or symbols to appear as a column. As
default the option Use the row symbol list is checked.

04. Select the indicator(s) to be used in the correlation.

05. Click on Finish. A pop-up appears, asking if the calculation
should be started.
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PROPERTIES OF THE CORRELATION MATRIX

Ó SETTINGS FOR CORRELATION
MATRIX AND INDICATOR

The general properties are available via
"Settings" on page 157 in the home tab.

Settings of the indicators themselves are
accessible in the "Mini Toolbar" on page 45
with a click on the indicator.

APPEARANCE
Font Size Here you can select the font size.

Show Symbols Select whether the symbol short
codes or the display names should be
displayed in the grid

Strip Common Prefix If not false, are the titles of
columns, rows or both automatically shorted by removing any common prefix

Sort Order Select whether the sorting should be based on either the display name
(the default) or the order of the items added

Display Units Here you can change the display units, e.g. with how many decimal
places or fractions the prices should be displayed. The default display unit will be
read from the symbol properties. You can customize the default display unit via
sessions.

Autosize after Scan Select to what the autoscaling should align to after the scan:
manual only (no resize), widest (data) cell or widest header or cell

GENERAL
Currency By default, the currency related to the exchange on which the symbol is
traded will be displayed; you can change the default currency to your preferred
one.

History Length Enter the length of the price history here. The maximum length in
Tradesignal is 500000 data points, which effectively means the length is limited
by your data provider.

Only closed bars If true, are only closed bars used for the calculation of the
indicators
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SCAN BUTTON IN THE TOOLBAR

Ó START SCANMENU

In the toolbar, the Start Scan button is available
with the following options.

Start Scan Start the scan.

Stop Scan End the scan.

Pause Scan Pause to get an intermediate result
of the scan. You can start the scan again by
clicking on Resume.

Resume Scan Resume the optimization.

Schedule Scan Schedule the scan. For this, the workspace needs to be saved first.
For details, see "Schedule Jobs" on page 349.

FORMATTING THE CORRELATION MATRIX OUTPUT

Ó CORRELATIONMATRIX CONTEXT
MENU

To make the interpretation of the Correlation
Matrix visually easier, rules for colors and
highlights can be created and applied to the
Correlation Matrix.

There are two ways to access the formatting:

à Via the toolbar, Home > Table >
Columns & Rows > Conditional
Formatting.

à Via the context menu. For this, right-
click on the Correlation Matrix.

EXAMPLE: CORRELATION MATRIX WITH CUSTOM COLOR SCALE
In a Correlation Matrix, your goal usually is to distinguish symbols that are highly
correlated (directly or inversely) from symbol combinations that are correlated
very little. To achieve this, the Correlation Matrix comes with two pre-defined
rules.

However, it is also possible to adjust the color scale to your preferences.
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Ó ADDING A FORMATTING RULE

01. Create a new Correlation Matrix for a
list of symbols (e.g. a watchlist).
Choose the Correlation indicator.

02. Right-click on the Correlation Matrix
and choose Manage Rules.... The
Conditional Formatting Rules
Manager opens

03. Click on Add to create a new rule.
The New Formatting Rule window
opens.

04. Choose the Format Style "3-Color-Scale", switch all to type
"Number" and enter the values -1, 0 and 1 as can be seen in
the screenshot. The closer to 0, the less correlation, while the
extreme values are more correlated.

05. ClickOK when done to return to the Conditional Formatting
Rules Manager.

06. In it, set the row and column it should apply to (in our example,
Data1 and Data2).

07. Select the rule and click Apply. The color set is applied to the
Correlation Matrix, and the most and least correlated
combinations are instantly visible.
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Ó CORRELATIONMATRIXWITH GRADED COLORS

REMOVING RULES
To remove a rule from the display, select some cells, right-click to open the
context menu, choose Clear Rules and then specify whether you want to remove
the applied rule from just some or all measures.

To delete a rule completely, right-click to open the context menu, choose Manage
Rules, select the rule and click Delete Rule.

OPTIMIZER

Ó OPTIMIZER

With the Optimizer, you can do the following:

à Evaluate the performance of a newly
developed trading system

à Select the settings that give the best
performance for a trading system

à Test trading systems for stability and
profitability
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à Generate statistical results for different parameter settings

à Configure trading systems for the usage in the Portfolio

In Tradesignal, the Optimizer is also able to optimize "in-sample" and "out-of-
sample" ranges with the start and end bars defined by you. This way you can see
how the trading system acts over a defined time span and if the parameter
settings could also be applied successfully to other time spans.

The Optimizer can only be used when you already have applied a strategy.

START THE OPTIMIZER

To start the Optimizer Wizard you can

à Click on the Optimize button in the Strategies area in the
Toolbar or

à Select the menu entry Optimize... in the context menu of a
symbol or symbol list in the Symbol Lists toolbox

The Optimizer Wizard can be resized so that you have a better overview. Click on the lower right
corner, keep the mouse button pressed and enlarge by dragging the mouse.

In addition it is possible to start and rerun the optimizer via an Equilla script.
Please see the Equilla help for OptimizerPresets, Optimize and RequestOptimization
for more information.

CALL UP THE OPTIMIZER AND CHOOSE A METHOD
The Optimizer in Tradesignal offers you several optimization methods from which
you have to select the best one depending for your goals. Also note that some
methods take longer to calculate the results than others.

Brute Force Depending on the parameters to be optimized and the set boundary
values, the Optimizer runs through all possible combinations of parameters. This
method is especially useful if you want to use the results for further analysis, e.g.
in Excel. The disadvantage is the possibly high number of combinations, which
may lead to a long calculation time.

Genetic Depending on the parameters to be optimized and the set boundary
values, the Optimizer runs through the possible combinations of parameters with
genetic algorithms that strive to find the best results. The advantage of the
method is its lesser calculation time. The disadvantage is that the table of results
does not include all possible combination of parameters.
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Monte Carlo Depending on the parameters to be optimized and the set boundary
values, the Optimizer runs through the selected number of random-without-
duplicates simulations (per symbol in the case of symbol list optimization). The
advantage of this method is identifying quickly a representative set of data. The
disadvantage is that the table of results does not include all possible combination
of parameters; non-tested combinations will be shown as white. The Monte Carlo
optimizer will not repeat combinations it has already simulated.

Walk Forward Depending on the parameters to be optimized and the set boundary
values, this method outputs complete results over defined ranges. You can define
the length of the ranges. Tradesignal lists the results as "in-sample" and "out-of-
sample" values. This way, you get an overview of the trading system works for
smaller time samples and how stable the results are. The advantages and
disadvantages are the same as for "Brute Force".

Walk Forward Genetic This method combines the defined ranges with the genetic
algorithm. The advantages and disadvantages are the same as for "Genetic".

Walk Forward Monte Carlo This method combines the defined ranges with the Monte
Carlo algorithm. The advantages and disadvantages are the same as for "Monte
Carlo".

SET UP PARAMETER

Ó SELECTING PARAMETERS

After choosing the method, you have to select
the parameters you want to optimize.

à In the list on the left, you can find all
optimizable inputs visually grouped
by their corresponding strategy,
indicator or money management
items. (Note that in the default
settings, strategies come with
automatic application of Strategy
Drawdown and Strategy Equity
indicators and the Portfolio Leave Exit strategy.) 
If you optimize for multiple symbols, e.g. in a Portfolio, the
option "Unify similar parameters" unifies the parameter sets
so that all instances of the parameter will use the same value
(although still being independent of each other). An additional
result column will be added containing a combined summary
of the unified values. Uncheck the option to see all
parameters per symbol.
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à In the list on the right, the parameters to be optimized are to
be found.

à To move a parameter from the right to the left and vice versa,
either select it and click on the respective double-arrow
button, or double-click the parameter.

à You can also move a whole group by clicking on its heading
and then clicking on the double-arrow button.

à You can also select more than one parameter at the same
time by holding down the Shift key (selecting several
consecutive parameters) or the Ctrl key (selecting several
parameters) while clicking on the parameters. To move all
parameters at once from one side to the other, select Add All
or Remove All.

à For the selected parameters, you can enter further values,
e.g. for start, end and steps. For that, select the parameter in
the list on the right. The fields for the adjustable values show
up at the bottom of the dialog.

à For selected parameters, e.g. Active, values may be set to
False which excludes the related strategy from the individual
optimization process.

à When optimizing the Active property of several scripts for both
true and false values (e.g. when applying more than one
indicator), only a single script can have the true (active) value
during a given run. If this happens, the Values area and the
information text "Multiple activation parameters are applied mutually
exclusive" appears. This feature allows the optimization of a
strategy component without generating additional
unnecessary combinations that consume significant time.
Example: Indicators A, B, C in the optimization means that
there will be three optimization rounds: 1) for A true (active), B
and C false (inactive); 2) B true, A and C false; 3) C true, A
and B false. Note that you can have an always active indicator
in your document, but you cannot optimize for that indicator.
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Ó MULTIPLE ACTIVATOR
PARAMETERS

Note: Depending on the current chart type, different chart
type properties are available for optimization.

(GENETIC OPTIMIZER) STATISTIC AND
FINISHING CONDITION
For the genetic optimizer, you have to select which
statistic should measure the success of the
optimization.

à Select whether the highest or lowest
value should be used.

à Select the parameter that should be used as the key
parameter for the evaluation (default: Total Net Profit).

à Select the instrument from which the statistic should be taken.
To have a list of options here, independent graphs and
strategies have to be available in the current document.

In the next step, you have to set the stop point for the genetic optimization:

After no better result was found (in minutes) This can result in a long optimization
duration, since you only set the time limit after finding the optimal value.

After a fixed period of time (in minutes) This allows for a very quick optimization, but
might yield suboptimal results.

DEFINE THE DATA RANGE
Define how much of the historic data should be used for the optimization:

Use all available data This corresponds to the History Length in the chart properties.

Use data within the following range of bars Set a range of data to be used. The
maximum range is also given by the History Length in the chart properties.

Use data between the following dates Set a Start and End date for the optimization.
To change the dates, either click on the calendar to select a date, or click in the
area of day/month/year to change each of the values.

(WALK FORWARD) DEFINE THE SAMPLES
For the Walk Forward methods, you can define the in-samples and out-of-
samples bars per sample. The method works as follows:
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01. If you set in-sample to "100" and out-of-sample to "50", the
optimizer will use the first 100 bars after the start point for the
optimization, and then calculate the values for the next 50
bars with the results from the first 100.

02. After this, the starting point is moved forward by the range of
the out-of-sample length, and the optimization calculation
above described will be executed again. This will be repeated
as long as enough data is available to fill the in- and out-of-
sample ranges.

The wizard also provides a method to calculate the in- or out-of-sample width,
based on the corresponding sample size and the desired number of samples. For
example, to have a single out-of sample with a width of 100 bars, enter "100" in
the out-of-sample field, then click on the Calc in-sample link and enter the
number "1" for the number of samples. The in-sample value will then be set to the
remaining bars in the selected data history.

If you choose the option Anchor in-sample: Start always at the beginning of
specified data range, the start point is not moved. Instead, the in-sample starts
always at the beginning of the data range, so the in-sample increases in size over
time.

The Number of calculatable samples (approximated) shows how many samples
are approximately available with your data set.

START THE OPTIMIZER
Start the optimization by clicking on the Optimize button in the wizard.

OPTIMIZER BUTTONS IN THE TOOLBAR

Ó OPTIMIZER GROUP IN THE TOOLBAR

In the toolbar, the Table group offers the
following functions:

Columns&Rows Via this button menu you can
find the following options:

Toggle Column Toggles between enable and disable column grouping.

Add/Remove ColumnHere you can define which columns should be displayed (on
the right) and which not (on the left). The indicators correspond to the ones in the
"Performance Report" on page 287.

Start Optimizer
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Ó START OPTIMIZER

Start Optimizer Start the opimization.

Stop Optimizer End the optimization.

Pause Optimizer Pause to get an intermediate
result of the optimization. You can start the
optimizer again by clicking on Resume.

Resume Optimizer Resume the optimization.

Schedule Optimization Schedule the optimization. For this, the workspace needs to
be saved first. For details, see "Schedule Jobs" on page 349.

View in Chart Apply the values selected in the table. Use the context menu on the
optimizer grid to open a new chart.

PROPERTY INSPECTOR SETTINGS
The general properties are available via "Settings" on page 157 in the home tab.

Runs Here you can find a list of all runs of the optimizer with date and time. Select
an entry from the list to call up the data of that run. Note that the list only displays
multiple runs of a specific optimization (called up with Start). When you create
another optimization, the counter starts anew for this optimization and another
graph and table with results will be displayed.

Heatmap Color 1 / Heatmap Color 2 / Heatmap Color 3 Set the colors for the heatmap
for the lowest, middle and highest values.

Graph Color Set the color of the Optimizer results graph.

Heatmap Scaling Set the scale of the points in the heatmap.

Show Graph Controls whether the Optimizer results graph is displayed or hidden.

Include recent chart/portfolio changes Set to "Yes" if the latest changes in the source
chart or portfolio should be imported before the optimization run.

Automatically apply top results Set to "True" if the top filtered and sorted results from
the optimization run should be applied automatically to the chart or portfolio. The
default is "False". This option will be respected when using scheduled
optimization.

ADVANCED OPTIMIZER SETTINGS
Via the Advanced button you can open a dialog with more options.
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ADVANCED GENERAL OPTIMIZER OPTIONS

Number of optimizer threads Enter a number higher than one, if several optimization
routes should be calculated at the same time. You should change the value only if
you have a computer with a multi-processors and should ideally not be higher
than the amount of CPUs.

Thread Priority Select high, normal or low. This regulates how much system
resources the Optimizer is allowed to use.

Use a longer history length when optimizing Allows you entering a history length
independent of the chart properties.

Auto-start Excel after optimization If you select this option, the calculation results will
be opened automatically in Excel after the optimization.

ADVANCED GENETIC OPTIMIZER OPTIONS

Only keep better results Only the best results are kept and displayed.

Show all Results This will keep and display all results. This may lead to a very long
table.

POSSIBLE OPTIMIZATIONS

OPTIMIZING A SINGLE SECURITY
You can optimize a trading system for a single chart or symbol.

à If you have an active chart with a strategy, theOptimize
button in the symbol bar is available. Click on it to start the
Optimizer wizard.

à Alternatively, you can choose the entry Optimize in the
context menu of a symbol.

OPTIMIZING A SYMBOL LIST
You have several choices for starting the Optimizer for a list of symbols.

FULL SYMBOL LISTS

The easiest method is optimizing a complete symbol list. To do this, choose the
entryOptimize in the context menu of a symbol list.

LIST IN THE SCANNER OR WATCHLIST

The second way is optimizing from within a "Scanner" on page 71 or "Watchlist"
on page 77. When you have a list of symbols in the Scanner/Watchlist, click on
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theOptimize button in the "Toolbar" on page 42.

SEVERAL SYMBOLS IN A CHART

The third way is optimizing a chart that includes on or more symbols. To do this,
click on theOptimize button in the "Toolbar" on page 42 while the chart is active.

PORTFOLIO

Another possibility is the optimization of a Portfolio. To start optimizing a Portfolio,
click on the Optimize button in the Toolbar while the Portfolio is active.

The difference between a "Portfolio" on page 251 and a "Scanner" on page 71,
"Watchlist" on page 77 or "Chart" on page 96 with several symbols is the
combination of strategies and a single account with several symbols in the
Portfolio. This way, you can trade several symbols in one Portfolio and generate
global trading statistics. Therefore, you receive realistic results for the
superposition of trading several symbols at various times in the Optimizer. It
allows you to test various trading systems and gives you access to all statistics
resulting from all possible parameter combinations.

ANALYZING AND INTERPRETING THE OPTIMIZATION
RESULTS

USE THE TABLE
On the right side of the optimization window, a table with the optimization results
is displayed.

à You can change the sorting order by clicking on the column
header. For example, sort for the longest period of a positive
trade.

à You can also group columns. For this, drag the column
header into the very top of the table. This way, you can group
any columns to one single group, which can be opened and
closed much like the folder tree in Windows Explorer.

USE THE FILTER
Especially in large tables it is hard to keep the overview. It is also often preferable
to ignore certain indicator values. To filter the view, click on the Edit Filter button.
A simple example would be filtering for "Total Net Profit > 0".

You can find more information in the chapter "Filter" on page 94.
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APPLY RESULTS TO OTHER DOCUMENTS
To apply optimized values to the optimized chart/portfolio, double-click the
respective table row. You will be asked if you really want to apply the values. Note
that you cannot apply single cell contents, only the full row. The used row will be
highlighted and with Goto Line the used is focused. In addition it is possible to apply
the results via drag-and-drop to the chart. Thereby the result of the optimizer can
be applied to any chart which contains the optimized strategy.

To use the values in a new chart or portfolio, choose the options you prefer in the
button menu View in Chart in the Toolbar.

EXPORT OF OPTIMIZER RESULTS
The results of the Optimizer can be exported via the file menu. Choose the menu
entry Export Data in the Toolbar. If more than one run exists, a request appears.
Choose whether you want to export all runs or only the latest. The file dialog
opens in which you can specify the directory, file name and file type for the export
file before saving it.

GRAPHIC ANALYSIS
The interpretation of statistic data is often easier when the data is visualized in a
diagram. Tradesignal offers a visualization function. As soon as the Optimizer has
finished (or is paused), you can find diagrams on the left of the table. Three axes
are available; values can be set via the drop-down lists. There are two kinds of
diagrams:

3D (SURFACE) DIAGRAM

This is the standard setting. It shows parameters of the trading system for both
the x- and y- axes, and a key figure like "Total Net Profit" for the z-axis. You can
always select other parameters from the lists. If you set the z-axis to "none", only
the 2D diagram described below will be displayed.

The colored surface shows the development of the key figure in relation to the
parameter combination. The different colors mark different values of the key
figure (green = positive, yellow = neutral, red = negative). Therefore, the diagram
can be read as an elevation profile. When you click on a colored square, the
corresponding row in the optimization results table is focused.

In the properties of the optimizer different parameters like colors and heatmap
scaling can be changed.
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2D DIAGRAM

The simpler variant is the 2D profile. It is automatically displayed below the 3D
profile as diagram with the key figure for the y-axis and one of the parameters for
the x-axis. Here you can have a look at the effect of a single parameter in the
trading system. The height of the columns shows the maximum values. The black
lines in the columns mark the trading systems results.

The 2D chart style can be selected from the options Points, Line, Bars and Range
Bars. Note that not all chart styles make sense for all parameters.

The values of the tables and the diagrams are connected.

à If you click on a value in the table, cross-hairs mark the
corresponding position in the diagram.

à If you click on a position in the surface or the column diagram,
the corresponding value in the table is focused.

In addition, you can see the numeric values of the position beneath the mouse
cursor to the right of the diagram headlines.

EXAMPLE: OPTIMIZING THE STRATEGY BOLLINGER BAND
BREAKOUT FOR APPLE COMPUTER, INC. (AAPL NAS)

01. Call up the Apple Computer, Inc. (AAPL NAS) symbol (e.g. via
the NASDAQ 100) and chooseOpen in Chart from the
context menu - or alternatively, double-click the symbol, or
drag and drop the symbol into the workspace.

02. In the Strategies group in the toolbar, click on Add Strategy.

03. On the tab Complete Systems, select the strategy Bollinger
Band Breakout.

04. On the tab Position Sizing, select the strategy Pos Sizing -
Percent Volatility.

05. ClickOK to apply the strategies.

06. In the next windows, select the data inputs for both strategies
to be Apple.

The next step is to optimize these settings to yield a higher net profit for historic
values.

01. In the toolbar, click on theOptimize button.

02. Select the method Genetic.
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03. Remove all select parameters from the list except Period and
StdDevs (for example by double-clicking the parameters in
the right list).

04. You can select different ranges and step sizes for each
parameter, but in this example we use the default settings.
Confirm with Next.

05. For the finishing condition, select the fixed period of time and
set it to "1" minute.

06. For the data range, use all.

07. Start the Optimizer.

The Optimizer calculates the best results for the strategy. After one minute, the
Optimizer stops and the table of results and the diagrams are displayed.

Ó OPTIMIZER RESULTS

CONDITIONAL EVALUATION OF
STRATEGIES

Tradesignal allows you to generate optimizer
results where the strategies in the chart are
selectively enabled and disabled in the same
way as other parameters are varied. For
example, to determine the most successful among a range of strategies for a
specific optimization period.

01. Add the Active property of each strategy in the optimization
wizard.

02. Select both True and False as possible values.

After the optimization is complete, all combinations of activations of the selected strategies
will be included in the result set.

COMPARING THE PERFORMANCE OF STRATEGIES
The Active Count and Active Items columns contain the number and name of all
chart items that were made explicitly active during a run. Adding a filter on this
column where the Active Count value equals one is a simple way to compare the
results of exactly one of the selected strategies being active at a time.

STEP 1: OPTIMIZING

01. Add two or more strategies to a chart.

02. Optimize the Active parameters for the selected strategies.
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03. Run the optimizer.

The optimizer results are displayed.

STEP 2: ADDING A FILTER

01. Add a filter by clicking Filter > Edit filter.

02. Delete existing expressions.

03. Click New.

04. From the drop-down menu, select Active Count as the column
to test.

05. Enter 1 as the value to test against.

06. ClickOK, then Finish.

The Total Net Profit for each strategy is displayed.

TIPS ON IMPROVING OPTIMIZATION TIME

The Active property allows users to optimize a set of strategies while having the
optimizer turn specific strategies on and off. Chart objects that have no effect on
optimization results can be selectively disabled in the optimizer wizard in order to
improve the optimization time of the chart.

01. In the optimizer wizard, select the Active property of those
chart objects that should be disabled.

02. Select False as the only possible value for this property.

Note: Disabling chart objects should only be done on items that have no effect on the
strategies in the chart. Indicators that set global variables or form inputs into strategies
should not be disabled.

Note: Applying a result row containing disabled indicators to a chart will disable the indicator
in the chart.
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PERFORMANCE REPORT

Ó PERFORMANCE REPORT

The Performance Report offers statistical data
from the operation or backtest of a trading
system. Use the Performance Report for the
following:

à Evaluating the profitability of your
trading system

à Finding out if a real trade would be
reasonable

à Evaluating the risks that can develop during the trade

à Estimating the need for capital

à Comparing the distribution of profits over time

à Keeping an eye on the development of real trading results

In the Performance Report, statistical results are offered as tables and diagrams.

The navigation to the left of the performance report can be toggled by clicking on
the small arrow to the right of the title.

Control of which items get printed can be found in the Publish group of the
property inspector.

Where values for per-trade Drawdown and Runup are calculated a property
exists to configure if this is calculated Entry to Valley (or Peak), or Peak to Valley
(or Valley to Peak). In general, Max Adverse/Favorable Excursion graphs benefit
from the Entry-to-Valley method despite the Peak-to-Valley being more correct.

CALLING UP THE PERFORMANCE REPORT

Note: The Performance Report is available for "Chart" on page 96 and "Portfolio" on
page 251.

à Click on the Performance button in the Strategies group in
the "Toolbar" on page 42 to open it.

The results are calculated for the current workspace.
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AVAILABLE INFORMATION

STATISTICS
This is the default setting. In this view, you can see the results for the complete
history length as a Strategy Performance Report. The results are offered in three
columns:

à The first column shows the respective key figure for all trades.

à The second shows the key figure for long trades only.

à The third shows the key figure for short trades.

Key Figure Explanation

Total Net
Profit

Sum of all trades (profit and loss trades) after subtraction of all
costs and slippages

Gross Profit Sum of all winning trades

Gross Loss Sum of all losing trades

Select Net
Profit

Select Net Profit is the sum of Select Gross Profit and Select
Gross Loss, excluding trades more than three standard
deviations from the average trade during the specified period.

Select Gross
Profit

Gross profit, excluding trades more than three standard
deviations from the average trade during the specified period.

Select Gross
Loss

Gross loss, excluding trades more than three standard
deviations from the average trade during the specified period.

Profit Factor
The ratio of Gross Profit and the negative Gross Loss. This
factor is a benchmark for how large the expected profit per
units of capital would have been in the test data.

Open Position
P/L

Value of an open position during the analysis

Total Number
of Trades

Total number of trades

Percent
Profitable

Percentage of profitable trades for the total number of trades

Number of
Winning Number of profitable trades
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Trades

Number of
Losing Trades

Number of unprofitable trades

Number of
Even Trades

Number of trades closed with neutral result

Number of
Winning Bars

Number of trading periods/candles/bars over which the
profitable trades lasted

Number of
Losing Bars

Number of trading periods/candles/bars over which the
unprofitable trades lasted

Number of
Even Bars

Number of trading periods/candles/bars over which the neutral
trades lasted

Average
Trade Net
Profit

Average result of all trades, calculated as Net Profit/Total
Number of Trades

Average
Trade Net
Profit per
Share

Average result of all trades, calculated as Net Profit/Total
Number of Shares

Standard
Deviation of
Trade Net
Profit

As name implies

Average
Winning Trade

Average profit of the winning trades, calculated as Gross
Profit/Number Winning Trades

Standard
Deviation of
Winning
Trades

As name implies

Average
Losing Trade

Average profit of the losing trades, calculated as Gross
Loss/Number Losing Trades

Standard
Deviation of
Losing Trades

As name implies
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Ratio Average
Win. / Average
Los.

Ratio of Average Profit/Average Loss

Largest
Winning Trade

The largest profit

Largest Losing
Trade

The largest loss

Max.
Consecutive
Winning
Trades

Longest series of profitable trades

Max.
Consecutive
Losing Trades

Longest series of unprofitable trades

Average Bars
in Total
Trades

Average number of periods per trade

Total Bars in
Trade

Sum of all trading periods/candles/bars over which open
positions were held

Average Bars
in Winning
Trades

Average duration of profitable trades in periods/candles/bars

Average Bars
in Losing
Trades

Average duration of unprofitable trades in
periods/candles/bars

Average Bars
in Even
Trades

Average duration of neutral trades in periods/candles/bars

Max. Shares /
Contracts
Held

Biggest single position

Total Shares /
Contracts
Held

Sum of all traded shares
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Total
Commission

Sum of all costs

Total Slippage Sum of slippage over all trades

Account Size
Required

Necessary account size to trade the system

Return on
Initial Capital

Percentage return of the Total Net Profit to the initial starting
capital (including commissions and slippage).

Return on
Account

Percentage development of the invested capital, essentially
the amount of money you would make (net profit) versus the
amount of money required to trade the strategy (account size
required).

Annual Rate of
Return

Rate of return of all trades over the time period shown as an
annualized percentage (based on initial capital)

Sharpe Ratio Index for the profitability of an investment compared to the risk

Sortino Ratio Index for the profitability of an investment compared to the risk
(modified Sharpe ratio)

Froehlich
Factor

Complex indicator for evaluating the quality of the trading
system results

Reward/Risk
Ratio

The ratio of Select Total Net Profit to percent time in the market
and average drawdown.

Return
Retracement
Ratio

Similar to Sharpe Ratio, but distinguishes the difference
between upside and downside return fluctuation

Start Date Date of the first period

End Date Date of the last period

Trading Period Timespan of the data (History Length)

Time in the
Market

Number of days or intraday periods in which positions were
open, including weekends and holidays (absolute value)

Percent of
Time in the
Market

Percentage of days with open positions
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Max.
Drawdown

Largest cutback in profit

Max.
Drawdown
Date

Date of the largest cutback in profit

Net Profit as %
of Max.
Drawdown

Total Net Profit divided by Max Drawdown

Max.
Drawdown as
% of Initial
Capital

Largest cutback in profit as a percentage of initial capital

Max. Intraday
Drawdown

Largest cutback of profit since the last open equity maximum

Max. Intraday
Drawdown
Date

Date of the largest cutback in intraday profit

Net Profit as %
of Max.
Intraday
Drawdown

Total Net Profit divided by Max Intraday Drawdown

Max. Intraday
Drawdown as
% of Initial
Capital

Largest intraday cutback in profit as a percentage of initial
capital.

Average
Drawdown

Average drawdown of all closed out trades

Max Trade
Drawdown

Largest Intraday drawdown experienced on a single closed out
trade.

Max Run-up
The greatest profit run-up (across all trades) from the lowest
previous equity drawdown.

Max.
Drawdown
Date

Date of the largest run-up in profit
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Max. Run-up
as % of Initial
Capital

Largest profit run-up as a percentage if initial capital.

Total Positions
Number of held positions. If partial trades are used, higher
values result than for full trades.

Position
Changes

Number of switches between Long and Short trades

Total Closed
Positions

Number of positions kept by the system. If partial trades are
used, this key figure is higher than the Total Number of Trades.

RETURNS
The returns are shown in three ways. As key figures, the % Gain (return for the
period relative to prior periods, as if all positions were implicitly closed at the end
of the period), Closed Profit, Realized Profit, Number of Trades and Percent
Profitable are displayed.

Monthly Display the performance development for each month of the test period.

Quarterly Display the performance development for each quarter (three months) of
the test period.

Yearly Display the performance development for each year of the test period.

It is possible to show column summaries in the footer of this view by right-clicking
on a column's footer and selecting one or more of the summary calculations.

TRADES

DISPLAY BY TRADES

Column Description

# Serial number of the trade

Quantity Number of items traded.

Command Labeling whether the trade was sell or buy, short or long.

Symbol Traded security

Signal
Part of the trading system that set off the trade, for
example entry or stop indicators
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Fill Date Day of the trade

Fill Price Exact price of the purchase

Profit Absolute profit of the trade

Duration Absolute duration of the trade

% Profit
Normalized profit of the trade with respect to initial
investment

Drawdown/Runup
The maximum drawdown and runup that the trade
experienced.

% Drawdown/runup
The normalized maximum drawdown and runup that the
trade experienced with respect to initial investment.

Commission Commission as entered in Money Management

Slippage Slippage as entered in Money Management

It is possible to show column summaries in the footer of this view by right-clicking
on a column's footer and selecting one or more of the summary calculations.

For the entry and exit fill price summary are following options available: WAverage,
Sum, Min, Max, Count and Average. WAverage is quantity weighted average
base don the following calculation:

SUM( Price * Quantity ) / SUM(Quantity)

DISPLAY BY FILLED ORDERS

Column Description

# Serial number of the trade

Command Labeling whether the trade was sell or buy, short or long.

Symbol Traded security

Fill Date Day of the trade

Fill Price Exact price of the purchase

Profit Absolute profit of the trade

Signal
Part of the trading system that set off the trade, for example entry
or stop indicators

Com. Commission as entered in Money Management

Slip. Slippage as entered in Money Management
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It is possible to show column summaries in the footer of this view by right-clicking
on a column's footer and selecting one or more of the summary calculations.

GRAPHS
The general properties are available via "Settings" on page 157 in the home tab.

Ó DISPLAY BY FILLED ORDERS

The chart type can be set for all equity graphs
to area, line, step line or bar.

Equity by Trade The equities are shown in the
trade sequence.
The option Monte Carlo Trade Shuffling will
randomly order the trades based on a Monte
Carlo simulation. Monte Carlo Samples defines the number of curves and any
change will trigger a recalculation. The option is disabled by default.

Equity by Date The equities are shown in the sequence of dates. The mode of that
graph can be set to Equity (default), monthly, quarterly or yearly return which
represent the % gain by month, quarter or year chart.

Graph - Equity Underwater, this means the drawdown/cutback:

Equity Underwater (Monthly) Phases in which the profit was declining, in absolute
values of the traded currencies or units.

Equity Underwater % (Monthly) Phases in which the profit was declining, in
percentage values. This diagrammakes it possible to compare drawdown phases
over longer time spans.

Note: The chart styles and colors can be changed by selecting the options in the property
inspector.

Maximum Adverse Excursion Plots trade drawdown against profit/loss for each
trade. Can use absolute or percentage values.

Maximum Favorable Excursion Plots trade runup against profit/loss for each trade.
Can use absolute or percentage values.

INFORMATION
General information about the optimized chart are found her.
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VIEWING RELATED TRADES IN CHARTS/TRADES LISTS

VIEWING RELATED TRADES IN CHARTS

This option is available in the

à Trades List

à Filled Order List

à Maximum Adverse Excursion Graph

à Maximum Favorable Excursion Graph

Ó VIEW IN CHART

To view a trade from the Trades/Filled Orders
list in the chart

à click on View in chart in the context
menu of the respective trade or

à select the respective trade and click
on View in chart in the toolbar or

à double-click on the respective trade.

To view a trade from the Maximum Adverse Excursion/Maximum Favorite
Excursion graph in the chart

à click on View in chart in the context menu of the respective
point in the graph or

à double-click on the respective point in the graph.

VIEWING RELATED TRADES IN TRADES LISTS

This option is available in the

à Equity by Trade graph

à Maximum Adverse Excursion graph

à Maximum Favorable Excursion graph

To view an element in a trades list

à click onGo to source in the context menu of the respective
element.
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TOTAL COMMISSION AND SLIPPAGE

Here you can find detailed information on the commission and slippage key
figures in the "Performance Report" on page 287.

TOTAL COMMISSION
This sum is an important, but often overlooked key figure. It shows you how much
money you spent only for the trading activities. Usually, this sum has to be set in
relation to the system profit . The ratio should lie far on the profitable side.

TOTAL SLIPPAGE
Usually, the slippage is seen as an uncertainty factor. Between signal generation,
order entry and order filling there is a time in which the price moves, possibly
against you.

To see the effects of such price movements in the backtest, the slippage is
subtracted from the profit or is added to the loss. The sum shows you how much
smaller the realized profit would be in comparison to the maximum in the
backtest.

MAX DRAWDOWN

Ó PERFORMANCE REPORT

Here you can find detailed information on the
drawdown key figures in the "Performance
Report" on page 287.

MAX. DRAWDOWN
A phase of declining profit is called a drawdown
phase. The key figure Max. Drawdown displays
the highest absolute profit drawdown in the time range of the test. The
Performance Report also shows the date on which that max. drawdown occurred.

A drawdown phase starts when at a profit maximum a declining development
starts with one negative trade. Often, a series of losses and overly small profits
adds up to a longer drawdown phase. The size and time range of the drawdown
are important criteria for evaluating a trading system.

The drawdown is calculated on basis of closed positions. Therefore, it does not
reflect that for held positions, much larger drawdowns might take place.

MAX. INTRADAY DRAWDOWN
The key figure is calculated on basis of the complete profit, including open
positions. Therefore, it includes all price movements that cause a drawdown for
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open positions, although these drawdowns might be reduced or neutral once the
position is closed.

With the help of this key figure you get an impression of the maximum loss of your
system, i.e. the losses you should be prepared for financially and mentally.

FROEHLICH FACTOR

Ó FROEHLICH FACTOR IN
PERFORMANCE REPORT

The Froehlich Factor (FF) is a complex key
figure that is supposed to measure the quality
of the trading system results.

Using the Froehlich Factor, the changes in
quality of a system can be investigated. This
key figure also takes into account that rare
extreme values can distort the system
performance. Because of this, the biggest
deviations from the standard are used as
divisors in the calculation.

The formula of the FF is calculated as follows:

Netto Profit * Percent Winning Trades * (Profit Factor + (Average Win /
Average Loss)

Max. Winning Trade + Max. Losing Trade + Max. Drawdown

A value of FF = 5 for intraday and of FF > 10 for EOD systems should be
expected, according to Stefan Froehlich.

SHARPE RATIO

Ó PERFORMANCE REPORT - SHARPE
RATIO

The Sharpe Ratio is a key figure for the
profitability of an investment in relation to its
risk. It gives a feeling for the profit/risk ratio
during the trade.

The calculation is based on a reference value
for a "risk-free investment", for example a bond
or a fixed deposit account. On this basis, the
resulting interest for the investment is
calculated. When calculating the risk of a trade, the standard deviation is used as
a measure of the volatility.

Sharpe ratio = sqrt(12) * avg(all monthly returns) / stdev(all monthly returns)
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The Sharpe Ratio is calculated for monthly periods, like the profits and the
volatility. It is always calculated for the whole portfolio.

It may be queried from Equilla or used for optimization.

SORTINO RATIO

Ó PERFORMANCE REPORT - SORTINO
RATIO

The Sortino ratio is used to score a portfolio's
risk-adjusted returns relative to an investment
target using downside risk.

It is a modification of the Sharpe ratio but
penalizes only those returns falling below a
user-specified target or required rate of return,
while the Sharpe ratio penalizes both upside
and downside volatility equally.

The calculation is based on the difference between the realized returns and the
target return (also known as the minimum acceptable return) divided by the target
semi-deviation (downside deviation). The latter is used as a measure of the
volatility.

Sortino ratio = (realized returns - target returns) / downside deviation

The Sortino ratio is calculated for monthly periods, like the profits and the
volatility.

It may be queried from Equilla or used for optimization.

PERCENT PROFITABLE

Ó PERFORMANCE REPORT

Percent Profitable is a key figure in the
Performance Report. With this key figure you
get an information about the percentage of
profitable trades in relation to all trades. This
value is an important piece of information for
testing and optimizing your trading system.

However, it cannot be evaluated without
context. Depending on the configuration of the
trading systems, completely different hit rates
can result.

à Trend-following systems usually show lower hit rates, but the
profit/loss ratio is higher.
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à Trading systems with higher hit rates often have a smaller
profit/loss ratio, which is additionally influenced by the
increased cost caused by larger trading volumes.

Percent Profitable Trades = (Number of Winning Trades / Total Number of
Trades) * 100

AVERAGE TRADE NET PROFIT

Ó PERFORMANCE REPORT

Here you can find detailed information about
the Average Trade key figures in the
"Performance Report" on page 287.

In the Performance Report, all figures are
displayed as cumulated valued for all trades
and also for long and short trades separately.

AVERAGE TRADE NET PROFIT
This value gives the average profit of all trades for the data. For this, the Total
Net Profit is divided by the Total Number of Trades. The Average Trade Net
Profit is a key figure of the trading system statistics. With its help, different results
for one or several systems can be compared. The value should also be compared
to the commission and slippage per trade. It helps you estimate the probability
that after deducting all costs, the trading system will still be profitable.

Average Trade Netto Profit = Total Net Profit / Total Number of Trades

AVERAGE TRADE NET PROFIT PER SHARE
This value gives the average profit of all shares for the data. For this, the Total
Net Profit is divided by the Total Number of Shares.

Average Trade Net Profit per Share = Total Net Profit / Total Number of
Shares

AVERAGE WINNING TRADE
This key figure gives the average of all profitable trades. Compare this value with
the average of all losing trades to get an impression of the trading system
performance.

Average Winning Trade = Gross Profit / Number of Winning Trades
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AVERAGE LOSING TRADE
This key figure gives the average of all losing trades. Compare this value with the
average of all winning trades to get an impression of the trading system
performance.

Average LosingTrade = Gross Loss / Number of Losing Trades

RATIO AVERAGE WINNING TRADE / AVERAGE LOSING TRADE
This key figure gives the ratio of the two key figures above. It is important for
judging the system performance. By combining it with further figures, e.g. for the
number of loss and win trades, the potential of the system can be estimated.

LARGEST WINNING TRADE
This key figures gives the largest single profit of the data set. It is often preferable
to ignore this value and to remove it from the backtest result. This way, random
results are less likely to influence your system.

LARGEST LOSING TRADE
This key figures gives the largest single loss of the data set. The explanation
given above applies. It is often preferable to ignore this value.

POSITION SIZING

Ó POSITION SIZING

In the course of their career, many traders
realize that their success at the market is less
governed by entry signals, filter techniques or
analysis routines. Money management, i.e.
controlling the risks and the investment of
capital are the crucial factors for successful
trading. One of the most important aspects of
the money management is the position sizing,
i.e. the number of shares/contracts per
position.

In the following chapter, various methods are
given for position sizing.

ADDING THE POSITION SIZING STRATEGIES

01. In the Trading Systems area of the toolbar, click on the Add
Strategies button.
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02. Click on the tab Position Sizing.

Now you can select up to six strategies for position sizing to be added to your chart or
portfolio.

METHODS

FIXED FRACTIONAL
This position sizing model uses fixed fractions of capital the to specify position
size. There are four methods to specify the fraction multiplier.

FixedFracModel Here you can choose between four models for the calculation of
the fixed fractions:

UnitsHere you can enter a fixed amount of capital; for instance, use 5000 to trade
1 contract for every 5000 euro (%Toinvest = 1 / X).

MaxRisk Here you can specify the expected biggest loss in points to use this
model.

CapitalThis is used for future trading only, you can take the margin into account.

FixRisk

FractionofCapital Enter what fraction of capital (according to the calculation above)
is to be used per trade.

BiggestLoss For the MaxRisk model, enter the biggest loss in points here.

X For the Units model, enter the "X" value here.

FixedRisk When using the model Fixed Risk, enter the value for the fixed risk in
points here.

InitialMargin Here you can enter the initial margin. It determines how much you can
invest in order to ensure your account has sufficient reserves to cover a potential
margin call

MaxLeverage Here you can enter the maximum leverage as multiplier that you
have available. If you use 2x leverage, you get a loan from the broker equivalent
to 100% of your investment.

Reduce Some of the options may lead to overstepping the originally calculated
investment capital or risk parameters. For such cases, you can activate this
option to ensure that the position sizes are reduced to meet the criteria of the
main method.
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Instrument Count Here you can enter the number of instruments in the chart. This
way, a portfolio can be simulated in a single chart. It allows you to distribute your
available funds across multiple instruments in one chart.

FIXED FRACTIONAL - PERCENT
This position sizing model uses fixed fractions in percent of capital to specify
position size. There are four methods to specify the fraction multiplier.

FixedFracModel Here you can choose between four models for the calculation of the
fixed fractions:

UnitsHere you can enter a fixed amount of capital; for instance, use 5000 to trade
1 contract for every 5000 euro (%Toinvest = 1 / X).

MaxRiskHere you can specify the expected biggest loss in points to use this
model.

CapitalThis is used for future trading only, you can take the margin into account.

FixRisk

FractionofCapital Enter what fraction of capital (according to the calculation above)
is to be used per trade.

BiggestLossPercent For the MaxRisk model, enter the biggest loss in percent here.

X For the Units model, ener the "X" value here.

FixedRisk When using the model Fixed Risk, enter the value for the fixed risk in
points here.

InitialMargin Here you can enter the initial margin. It determines how much you can
invest in order to ensure you account has sufficient reserves to cover a potential
margin call.

MaxLeverage Here you can enter the maximum leverage as multiplier that you
have available. If you use 2x leverage, you get a load for the broker equivalent to
100% of your investment.

Reduce Some of the options may lead to overstepping the originally calculated
investment capital or risk parameters. For such cases, you can activate this
option to ensure that the position sizes are reduced to meet the criteria of the
main method.

303



Instrument Count Here you can enter the number of instruments in the chart. This
way, a portfolio can be simulated in a single chart. It allows you to distribute your
available funds across multiple instruments in one chart.

FIXED PERCENT
This method is one of the simplest. It invests a fixed percentage of the available
capital and equity in the next trade. Neither the current market situation nor any
information about past trades are considered.

The example chart shows the strategy Stochastic Momentum - Entry (delivered
with Tradesignal). The position sizing strategy invests a fixed 5% of the initial
capital of 10000 USD into the first trade. The broker offers a leverage of 1:20, so
that with a capital of 10000 EUR, 7784 shares at a quote of 1.2846 USD can be
traded.

OPTIONS

PercentToInvest Percent of initial capital to invest in the next trade.

FixedMargin Here you can enter a fixed margin, e.g. when trading currencies.

MaxShares Here you can set a maximum share per position.

Reset Here you can specify after which time you take your profits from the market
and the invested capital is reset to the original initial capital. You can choose
between yearly, monthly, Never (all capital is reinvested continuously) or No
Position Sizing.

Instrument Count Here you can enter the number of instruments in the chart. This
way, a portfolio can be simulated in a single chart. It allows you to distribute your
available funds across multiple instruments in one chart.

FIXED RISK
This position sizing model tries to determine what the risk of the next trade will be.
A fixed percentage of the initial capital is risked with the next trade.

This method is especially useful when you define a stop loss for each trade. The
method calculates the volatility of the base value and multiplies it with a factor set
by you. This way, the position size can optimally be linked to the market
conditions.

The method assumes that you are using a stop loss. It is recommended that you
use a volatility-driven stop. The position size is calculated so that the maximum
loss per trade set by you is not exceeded.
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The example chart shows the strategy Stochastic Momentum - Entry (delivered
with Tradesignal). Once the program has measured the volatility, the risked
capital is divided by the volatility. If a leverage is used, it is included in the
calculation. If you have set a fixed margin, the risked capital is divided by the fixed
margin. In all other cases, the calculated risked amount is divided by the current
close price of the base value.

OPTIONS

PercentToInvest Percent of initial capital to invest in the next trade.

FixedMargin Here you can enter a fixed margin, e.g. when trading currencies.

MarketRiskMeasure To measure the volatility of the base value, you can either use
the standard deviation or the Average True Range.

RiskTiming Set the calculation period for the volatility measurement.

Reset Here you can specify after which time you take your profits from the market
and the invested capital is reset to the original initial capital. You can choose
between yearly, monthly, Never (all capital is reinvested continuously) or No
Position Sizing.

Instrument Count Here you can enter the number of instruments in the chart. This
way, a portfolio can be simulated in a single chart. It allows you to distribute your
available funds across multiple instruments in one chart.

PERCENT VOLATILITY
This method works similar to the "Fixed Risk" method. It measures the volatility of
the base value and scales the position sizing accordingly. As additional
parameter, you have to enter a multiplier for the maximum expected loss. The
result of the multiplication of this factor and the measured volatility is used as
basis for the calculation of the position sizing.

OptionsFractionofCapital Enter how much fraction of capital is to be used for each
trade.

VolatilityModel To measure the volatility of the base value, you can use the
Average True Range or the momentum. The momentum is given as absolute
value from one bar to the next one. With the result, a moving average over the
"volatility period" is calculated for smoothing.

VolatilityPeriod Enter the period over which the volatility is calculated.

BiggestVolaLoss Enter a multiplier for the measured volatility. This value gives the
highest maximum loss possible as multiple of the volatility.
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Profit (Factor Profit) With this multiplier, the amount of accumulated gain is included
in the calculation of position sizes.

MaxLeverage Enter the maximal leverage.

Reduce Some of the options may lead to overstepping the originally calculated
investment capital or risk parameters. For such cases, you can activate this
option to ensure that the position sizes are reduced to meet the criteria of the
main method.

Instrument Count Here you can enter the number of instruments in the chart. This
way, a portfolio can be simulated in a single chart. It allows you to distribute your
available funds across multiple instruments in one chart.

MARKET'S MONEY
This method works similar to the "Percent Volatility" on the previous page
method. In addition to it, it reinvests profits with leverage. If your capital has
decreased, the position size will be reduced.

If FactorProfit is set to the same value as BiggestVolaLoss, the method reacts
identical to the "Percent Volatility" method.

OPTIONS

FractionofCapital Enter how much fraction of capital is to be used for each trade.

VolatilityModel To measure the volatility of the base value, you can use the
Average True Range or the momentum. The momentum is given as absolute
value from one bar to the next one. With the result, a moving average over the
"volatility period" is calculated for smoothing.

VolatilityPeriod Enter the period over which the volatility is calculated.

BiggestVolaLoss Enter a multiplier for the measured volatility. This value gives the
highest maximum loss possible as multiple of the volatility.

Profit (Factor Profit) With this multiplier, the amount of accumulated gain is included
in the calculation of position sizes.

MaxLeverage Enter the maximal leverage.

Reduce Some of the options may lead to overstepping the originally calculated
investment capital or risk parameters. For such cases, you can activate this
option to ensure that the position sizes are reduced to meet the criteria of the
main method.
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Instrument Count Here you can enter the number of instruments in the chart. This
way, a portfolio can be simulated in a single chart. It allows you to distribute your
available funds across multiple instruments in one chart.

AUTOMATIC ORDER ROUTING
Under order routing, the routing of trading signals of a mechanical trading system
to a connected broker is understood. The function can be used to:

à Route signals of a trading system automatically to the stock
exchange via a broker

à Route signals of a trading systemmanually to the stock
exchange via a broker

à Test a trading system under live conditions via the demo
access of a broker

Note: Automatic order routing is not available for every data provider.

Note: Data vendors (and 3rd party data files) may deliver erroneous data that may be
represented as valid data. Data vendors may change their interface at any time and without
prior notice, such an update can introduce breaking changes. Access to data from a data
vendor may be delayed or fail due to network congestion, network errors, server outages,
power failure and other factors.

HOW THE ORDER ROUTING WORKS

To use the order routing function, a number of preferences have to be set:

à Create an account and configure settings in the "Order
Routing Options" on the next page

à Activating the order routing for a chart or portfolio in the
Automation Options of the Trading System

à Starting and stopping the order routing via the Order Routing
toolbar, see the section Button Menu Order Routing.

Several levels of automation are possible, up to fully automated trading without
interference from outside.
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Tip: When automatic order routing is active a small routing icon will be displayed above the
toolbar, to the left of the clock. This icon may be clicked to Stop All Order Routing.

ORDER ROUTING OPTIONS

Tip: Some brokers do not provide a mechanism to take multiple manageable positions in the
same security. Without this feature, it is not possible to correctly manage multiple
independent strategy positions for the same security on the same physical account.
Tradesignal will prevent order routing from being started if it is already active for a given
security on the same physical account in such cases.

BROKER ACCOUNTS

Ó ORDER ROUTING OPTIONS

A Broker Account is the terminology used in
Tradesignal to refer to a connection to an
account with a specific broker and associated
settings. It is possible to have multiple named
broker accounts to the same physical account
at the same broker but with different settings.
Doing so allows different strategies to be
created for trading different security types with
the same physical account for example.

Add a new broker account Accounts are added in the options menu under File >
Options > Order Routing > Broker Accounts by clicking on the Add new broker
account link.

Remove Account Accounts can be removed by clicking the X button next to the
account in the list of accounts.

Edit Account Account settings can be modified by clicking on the account name
listed below Order Routing under File > Options.

CONFIGURATION OF THE ORDER ROUTING ACCOUNT
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Ó ORDER ROUTING ACCOUNT
SETTINGS

In this menu, all settings for the broker account
and the general handling of the orders are
entered. Do not change the port number and IP
address.

Selection of the Broker and name for the
account are only available in the wizard when
first creating the account.

Enter a name for the order routing account Enter an
account name that is used for this broker within
Tradesignal.

Port Port number of the broker's trading application, e.g. in IB TWS.

Note: If you use more than one TWS on one machine, you have to change the portnumbers
in the TWS. After this enter these Portnumber here. Otherwise the orders can appear in both
TWS

IP Address IP of the broker's trading application.

Account Code Your account at the broker, e.g. the "Interactive Brokers Account
Code" for IB.

Note: The correct Account Number is only for synchonizing neccessary. The Orders will be
directed to the TWS via the correct Portnumber

Order Transmission Select here whether the orders are routed in the Automatic or
Manual mode.

Action on Session End Configure here how orders shortly before the session end
will be handled. They are either routed to the broker as a market order (Map
Close Orders to Market Order) before session end (also see section "On-Close
Orders" on page 314) or routed as Map Close Orders to Market-On-Close Order.
In the latter case, the execution depends on the definition for this order type at
your broker. A "Market Order" is routed instantly, while a ""Market on Close
Order" is routed at a certain time before the session end.

Log Level Here you can set the log level for details of the order processing and
related tasks. The level System logs the least detailed data, the level Details the
most. We recommend that you keep the default setting.
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The information appears in the output window in the lower area of the window. It
can be opened by a click on the grip bar.

Note: Brokers may deliver erroneous data that may be represented as valid data. Brokers
may change their interface at any time and without prior notice, such an update can
introduce breaking changes. Instructions sent to a broker or access to quotes may be
delayed or fail due to congestion, network errors, server outages, power failure and other
factors. Broker-supplied software may be required for connection between Tradesignal and
a broker. Such software may have stability issues or exhibit errors under some
circumstances.

ORDER CONFIRMATION
In this menu, you define whether Tradesignal should send the orders
automatically to the broker or if certain constraints should be applied to the order
routing.

Note: In the settings of the broker account, similar settings for order routing are entered.
However, those determine the behavior of the order software of the broker.

Ó ORDER CONFIRMATION

Manually confirm all orders Select this option for
manual confirmation of automatically
generated orders. There are several settings
available, some of them depending on time.
The options range from indefinite waiting to
order cancellation. If this is not set, orders will
be automatically sent.

The remaining settings configure exceptions to manual confirmation, namely:

à Send order cancellations without manual confirmation

à Send order modifications without manual confirmation

à Wait only a specific period of time to obtain manual
confirmation and then take a default action:

01. Do not place order

02. Do not place order and stop order routing

03. Place the order
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INITIAL SYNCHRONIZATION

Ó INITIAL SYNCHRONIZATION

In this menu, you can define which actions are
to be undertaken during the start process of the
order routing.

When starting the order routing, Tradesignal is
able to synchronize the positions in the trading
system with the account positions. Several
options are available.

Do not modify the account position Positions are not changed.

Modify account to strategy position with the first entry order from the strategy The
positions are only synchronized with the first entry order. This standard setting
minimizes the trading costs.

Cancel pending orders and modify account position with the first entry order Pending
orders are canceled and the positions are synchronized with the first entry order
after the start. This may cause increased trading costs.

Cancel pending orders and modify account position with a market order Pending orders
are canceled and the positions are instantly synchronized with an order. This may
cause increased trading costs.

STOPPING ORDER ROUTING

Ó STOPPING ORDER ROUTING

Here you can set what is to happen when the
order routing is stopped.

Cancel pending orders Pending orders are
canceled without closing positions.

Cancel pending orders and close positions Pending
orders are canceled and open positions are closed.

Do not modify account position Positions are not changed.

SYNCHRONIZATION

Ó POSITION SYNCHRONIZATION
SETTINGS

Here you can define how Tradesignal will react
when the account positions are no longer
synchronized with the positions in the trading
system. Several settings are available, from
automatic synchronization with market orders
to the stop of the automatic order routing with
an alert.
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If the account and strategy positions are no longer synchronized:

Cancel all pending orders and generate a market order to synchronize positions Pending
orders are canceled and a new order is issued to instantly synchronize the
positions. This may cause increased trading costs, especially if the
synchronization is frequently lost.

Cancel all pending orders, generate exit orders and synchronize with the next entry order
Pending orders are canceled, current positions are closed and new entry
positions are opened. This may cause increased trading costs, especially if the
synchronization is frequently lost.

Synchronize position on the next entry order Pending orders remain open, and the
positions are synchronized only with the next entry order issued from the trading
system. The entry order is changed (increased/decreased) to include the position
synchronization. Note that this can only be done with a market order or one
limit/stop order. Systems with several limit orders, e.g. with limit order above and
below the current quote, cannot be synchronized this way.

Cancel all pending orders, close account position and synchronize position with the next
entry order Pending orders are canceled, current positions are closed and new
entry positions are opened. This may cause increased trading costs, especially if
the synchronization is frequently lost.

Stop automatic order routing and notify user with an alert The order routing is stopped
(any pending orders and positions remain open).

Notify user with an alert The order routing is not stopped but an alert is issued.

Do nothing

Seconds to wait for account and strategy positions to synchronize Enter the duration in
seconds that the synchronization may take. If synchronization fails, the timeout
counter below starts. An out-of-sync chart will be highlighted.

Seconds to wait for account and strategy positions before synchronization timeout Enter
the duration in seconds before the above entered settings for handling the
synchronization loss are applied.

Note: If the Send On-Close orders a few minutes before session end option is enabled, the
position sizes will not be checked within the specified number of minutes before session end.
As soon as the session is closed, Tradesignal will continue to check the position sizes in
order to ensure the strategy and account positions are synchronous.
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DATAFEED

Ó DATAFEED

Action to take if the datafeed loses connection or
any instrument becomes stale for an extended
period.

à Send an alert and turn off automatic
order routing - All automatic order
routing will shut down, an alert will be generated.

à Send an alert - Automatic order routing continues, an alarm is
generated.

à Do nothing - No action is taken.

Stale duration before action is taken An instrument is stale if either the connection to
the upstream data provider has been lost, or the upstream data provider has
indicated that the price information for this instrument is no longer up-to-date.

STOP AND LIMIT ORDER

Ó STOP AND LIMIT ORDER

Tradesignal offers you two methods for how
generated stop or limit orders are to be treated
at the session end. These options determine
how much the back test results may differ from
real trading results.

à Wait for Tradesignal to report a fill then send as a Market
Order - Tradesignal issues a stop or limit order only after the
last order was confirmed as filled by the broker.

à Send the order to the broker as-is; take no actions if the order
is not filled as expected - Tradesignal issues stop or limit
orders independently of fill confirmations.

à When using the IB TWS, this option should be deactivated.
When the option is deactivated, the existing stop or limit
orders are updated at every new bar/tick in Tradesignal. If the
option is active, all existing orders are canceled and new
orders are issued. This may result in problems, especially for
fast-trading stocks or futures, as the orders cannot be
canceled quickly enough by the trading software.
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ON-CLOSE ORDERS

Ó ON-CLOSE ORDERS

Here you can define how an order is routed
when it is classified as "on-close" by the trading
system.

à Send on-close orders at the end of
the session

à Send On-Close orders a few minutes before session end -
Select this option if the on-close order is to be issued before
the set session end. You can enter a time in Number in
Minutes or click on the spin buttons. Please note that you can
set similar order routing settings in the account settings of the
broker. If your broker supports real on-close orders, you may
be able to send them right at the session end.

à Cancel active limit and stop orders after on-Close orders are
generated - Select this option if unfilled stop or limit orders are
to be canceled when an on-close order is generated. This will
keep the system from accidentally filling several orders.

TIME-IN-FORCE

Ó TIME-IN-FORCE

à Orders should stay active until
canceled - If selected, the order may
stay active for longer than the trading
day.

à Orders should stay active for the trading day - If selected, the
order is only active for the current day and deleted at session
end, if not filled.

à Always generate new orders when a bar opens - Select so
that pending orders are canceled and new orders are
generated at each new bar. This option should not be used for
short time periods, but may make sense for trading systems
with long periods, e.g. weekly.

SYMBOL MAPPING

Ó SYMBOLMAPPING

Symbol Mapping in Tradesignal means
mapping the symbols of the online data
provider and the broker that refer to the same
underlying instrument.
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For the order routing to work, the program has to know this mapping. The correct
settings are very important for trading.

Caution: If the wrong symbols are entered or mapped here, the wrong symbol may be
traded by the broker.

Editing Symbol Maps

New Enter a new symbol map. A dialog opens, see next section.

Edit Edit the selected symbol map.

Delete Delete the selected symbol map.

Delete All Delete all symbol maps.

Ó ORDER ROUTING SYMBOLMAPPING
DIALOG BOX

Configuring Order Routing Symbol Mapping

In this dialog you can create a new symbol map
or edit an existing map.

ENTER THE SYMBOL FROM THE DATA
PROVIDER:

When a chart with a symbol is open and
selected, this symbol is automatically entered
here. Otherwise, click on the Browse button to
start the symbol search in Tradesignal. Note
that many symbol names are a combination of symbol shortcut and exchange
name.

ENTER THE SYMBOL DETAILS FOR THE BROKER:

Underlying Enter the asset's underlying ticker symbol.

Exchange Select the exchange from the list at which the symbol is traded.

Security Type Select the symbol type from the list. Most brokers use this setting to
assign the shortcut to the right exchange.

Currency Select the currency delivered against the purchase of the underlying
currency.

Expiry Date Enter an expiry date for the underlying, if available.

Caution: Please check the settings to ensure that the right symbols are ordered.
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ORDER ROUTING TOOLBAR

Open this toolbar by clicking on the Order
Routing tab above the toolbar.

Start Automatic Order Routing Start the order
routing for the selected chart or portfolio. To
start all order routings, press the Ctrl key while clicking.

Stop Automatic Order Routing Stop the order routing for the selected chart or
portfolio.

Stop All Automatic Order Routing Stop the order routing for all charts and portfolios.

Order Routing Options Opens the "Order Routing Options" on page 308 in the
Tradesignal Options.

STRATEGY AUTOMATION OPTIONS

This menu is opened by clicking on the small plug symbol on the lower right of the
chart or a portfolio. Here you can activate different levels of automation for the
order routing. The following settings are available:

NO ORDER ROUTING

Select this option if no automatic order routing is used. No signals are output by
the strategy. The Position Manager remains empty.

POSITION MANAGER ONLY

Select this option to send the signals generated by the strategy to the Position
Manager. To submit the orders, you have to enter themmanually into your
broker's order software.

BROKER

Select this option to route the orders automatically. The signals of the trading
system are displayed in the Position Manager and also routed to the broker. The
limitations for this automation are set in the Order Verification settings of the
Order Routing Settings in the Tradesignal Options, see above.

After selecting an option, you can start the order routing from the Order Routing
button menu. Click Start Automatic Order Routing.

CONTROLLING HOW AND WHEN ORDERS GET FILLED

When using order routing the one of the major issues is ensuring that fills
generated in the strategy closely match fills in the brokerage account. The
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"Money Management" on page 236 property Realtime Price Source can be
used to tell Tradesignal to use best bid and best ask prices from the Broker
instead of using last prices from the data source. The following settings are
available:

Bid/Ask Tradesignal uses the best bid / best ask data provided by either the broker
(if an order routing module has been connected) or the data provider. If neither
the broker nor the data provider is delivering bid/ask prices, Tradesignal uses the
last price instead (for example in the case of indices). Best bid and best ask prices
are generated when a market participant wants to buy or sell a number of
shares/contracts while a last price represents an actual trade that has been
made. Therefore this option has the benefit of more accurate fills for your orders.
The caveat is however that the results collected in real time will not match the
results of back-testing which will always only use the last price.

Last Tradesignal uses the last price delivered by the data provider. This is the
same price as the one used to back-test the strategy. A last tick represents a
trade that has been made in the market. When using this mode, Tradesignal can
only fill and order after a trade has been made, even if there was a matching
offer/request in the market prior to the trade. This mode ensures that real time
results are closer to back-test results.

MANUAL ORDER ROUTING
Tradesignal allows users to manually place orders (such as limit orders in
Trayport Joule) directly from your workspace. This is done via an external dialog
window accessible from a number of locations. Accessing this feature will trigger
Tradesignal to show the appropriate third-party order entry mask.

Note: This option is only available if the respective symbol's feed supports this capability.

à To access the order window, select
the desired option underOrder
Entry Form on the Order Routing
Tab on the main ribbon.

à To access the order window from charts, watchlists,
portfolios, market profile, level II, the output window or from
trading alerts, clickOrder Entry Form from the respective
context menu.
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Ó EXAMPLE OF A THIRD PARTY ORDER
FORM.

OpenConnect feed developers can also
implement the order form interfaces to expose
this functionality (in the same way the Trayport
Joule feed does), with the addition of market
limit, market stop and stop limit orders.
Additional information can be found in the
Tradesignal OpenConnect API guide.
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MISCELLANEOUS FEATURES

TRADESIGNAL OPTIONS

Ó TRADESIGNAL OPTIONS

In the Tradesignal options, you can find general
settings for Tradesignal, for example

à preferred view and chart type

à data connections and order routing

à timescale and scope of data backup

You can open the window Tradesignal Options

à by clicking on the File menu in the
header bar and selecting Options
from the menu, or

à by double-clicking on the connection icon above the toolbar.

In the following chapter, you will find information about the settings or links to
other chapters with detailed information.

SEARCHING THE OPTIONS

In addition to drilling down search for an option by label, it is possible to use the
search box located to the top left of the options pane to search for an option by
keyword.

à Enter the search term, e.g. "Excel"

The available options matching the keywords will be displayed as you type

To reset the search click the X button next to search box, or click on a options
category.

PERSONALIZE

ON STARTUP
Which workspaces to open, which layout to use or to show the backstage
automatically on start up.
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LANGUAGE
Which application language to use, changing this setting will require a restart of
the application.

TIMEZONE
Set the local timezone. This setting is used to adjust time values in charts to the
local timezone.

THEME
Which application theme to use.

EMAIL
The settings to use when the application needs to send an email. There are two
methods:

SMTP Requires the SMTP servers details to be added. Most reliable solution for
sending emails from the application.

MAPI Will use the locally installed email software to send emails. May cause
problems with security settings.

RIBBON TOOLBAR
Tool to configure the "Quick Access Toolbar" on page 48. All possible functions
are listed in a tree in the left pane. These functions can be added to the right pane
and will appear in the Quick Access Toolbar above the regular toolbar. Options
next to each Toolbar item allow it to be repositioned, removed or grouped.

PRINTING
Options to configure standard printing options, most notably the default
watermark and header/footer layout.

RESTORE DEFAULTS
Clicking on this button will restore all system settings to their default values, a
dialog will be displayed to confirm this action.

Individual settings may be restored to their factory setting by right-clicking on the
label for the option and selecting Reset.

DATAFEEDS

DATAFEED
The settings and login to be used for the datafeed connection.
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CSV FILES
Define one or more folders that contain CSV files for import.

AUTOSAVE & BACKUP

AUTO SAVE

AUTOMATICALLY MAKE A PERIODIC RECOVERABLE BACKUP OF ANY
OPEN DOCUMENTS

This is the default setting. When selected, the work is saved in regular intervals
(given by the parameter Frequency in minutes to save open items) and available
as backup. You can edit the frequency value.

APPLICATION BACKUP
Here you can enter settings for the backup of your current configuration. The
following information is saved:

à Packages with all their files, including information whether
they are write-protected (date and time are not saved!)

à Symbol lists

à Symbol settings for automatic order routing

à User settings

à Edited quotation data

This way you can save the current state of Tradesignal and then use the resulting
backup to restore your settings on another computer - or on your computer, for
example after a new installation of the operating system.

The following options are available:

Create daily backup at Here you can enter a time at which the backup will take
place. Note that this only will be done as long as the application is running.

Create a backup when the application shuts down When selected, the data is saved as
backup before shutdown.

Backup Location This is the folder where the backups are saved to. To enter
another one, click on Browse and select one in the Windows file dialog.

Number of recent backups to keep This is the maximum number of backups that will
be kept. When going beyond this number, old backups will be overwritten, starting
with the oldest. Max. number is 100.
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à Click on Create a backup now to create a backup for the current
settings and data.

à Click on Restore a previous backup to restore an old backup. For
this to work, all open workspaces have to be closed. This is
done fastest when you select Close All Workspaces from the file
menu.
Select one of the available backup files from the dialog. Then
choose whether you want to Restore all files including settings
restore all saved data as listed above or Restore all package files
restore the package files only.
In addition, you can select the option Restore exclusively
missing files so that already available files are not overwritten.
Confirm the warning. After the restoration, the application is
closed so that the new settings can take effect upon restart.

ALERTS

Detailed information about the alert setting options can be found in the chapter
"Alerts" on page 329.

FOLDERS

PACKAGES
Detailed information about the package options can be found in the chapter
"Package and File Management" on page 334.

SHARED SYMBOL LIST FOLDERS
Here you can add/remove folders containing symbol lists in XML format as
exported from Tradesignal, see "Managing Symbols and Symbol Lists" on
page 63.

By having these folders on a network share, you can share symbol lists between
users. Shared symbol lists are read-only.

EQUILLA PATHS
C-API Extension DLLs In this folder, special Equilla interface files are saved. Do not
change this path.

PrintToFile output In this folder, files are written by Equilla scripts (see chapter
"Data Output via File Interface" on page 451).
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RSS FEED
Here you can configure RSS feeds. RSS feeds are added to the news displayed
in the news window.

New Add a new feed. A dialog opens where you can enter the URL of the feed.
Make sure that it starts with "http://".

Edit Edit the URL of the selected RSS feed.

Delete Remove the selected RSS feed from the list.

ORDER ROUTING MODULES
Folder where order routing modules are located.

LEAVERS & JOINERS SYMBOL LISTS
Folder where joiners and leavers symbol lists created by export of the Portfolio
history will be saved, see "Portfolio History" on page 255.

ORDER ROUTING

Detailed information about the order routing options can be found in the chapter
"Order Routing Options" on page 308.

ADVANCED TRADESIGNAL OPTIONS

Many options to configure default behavior are found in this section organized by
the following categories

EQUILLA EXTENSION
These options are available in and offer the option to enable or disable support for
Equilla extension DLLs.

No extensions allowed

Only C API extensions allowed Allows Equilla extensions that use the C API. This is
the default setting.

Only COM API extensions allowed Allows Equilla extensions that use the COM API.

Both C and COM API extensions allowed Extensions for both APIs are allowed.

Check Use isolated Python version to run a cut-down, isolated version of Python that
is independent of any other Python version installed on this system. The isolated
version has no access to any non-default Python modules unless they are copied
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into the python folder below the Tradesignal installation folder. This option should
be checked if no full Python version is installed on the system.

CHART STYLE
Default style The chart type that will be used for all newly created charts (excluding
tick-by-tick charts).

Tick chart style The chart style to use for new tick-by-tick charts.

Value scale mode The value scale mode to use for newly created charts (Linear or
Logarithmic).

Allow panning by grabbing charts with the right mouse button When checked, the chart
can be moved directly.

Sync value of stop lines with the same name in the same workspace see also
"Synchronize stop line values" on page 176.

Query empty symbol input properties when adding an indicator or strategy

INSTRUMENTS
This section allows configuration of the default history length to use for charts and
other document types in various periods.

Default history length The default history length to use for newly opened charts and
portfolios.

Default period The default period to use for newly opened charts and lists. The
default period is daily.

Open instruments in a new subchart Check this box to always add new instruments
as a sub chart to an existing chart. Uncheck the box to always add the new
instrument to the main chart.

Resolve ambiguous symbols When a symbol is entered on the command line or in
an inline instrument, this option determines how the symbol should be resolved to
an instrument if the symbol is multiply defined.

Display a warning if instrument currencies in a portfolio do not match Check this to be
warned of diverse currencies within a portfolio. Not all strategies work on such
portfolios.

Display a warning if a chart is created from a watchlist with different history length
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WORKSPACES
Maximum number of open workspaces Increase this number to allow more
simultaneously open workspaces, the default is 30. Please note that opening
more workspaces will require more system resources.

Maximum number of items in a workspace Increase this number to open more items
in a workspace. The default value is 30. Please note that opening more items in a
workspace will require more system resources.

Show close button on selected workspace tab Otherwise, workspace tabs have to be
closed via the context menu.

Hide titles of non-selected workspace items If checked, titles of items within the
workspace will be hidden.

Show unremove bar at the bottom of the screen Otherwise, the unremove option will
be displayed to the right of the title bar of the application.

Automatically close a floating desktop when the last workspace has been closed If
checked, empty desktops are closed automatically, which reduces system load.

Automatically save a closed workspace if it only contains modified trades or serialized
variables

Set the workspace tab button size Select an option from the list. This setting only
refers to the buttons, not the workspace tabs.

Target cursor highlighting when Ctrl is held Select an option from the list.

PROPERTY INSPECTOR
Show deprecated property inspector When checked, the property inspector in the
toolbox is acivated

Always show properties when a new item is selected (only available for deprecated property
inspector)When checked, the property settings are instantly opened upon
selecting an item.

COMMAND LINE
Generate OHLC outputs for one-line formula-based symbols When this item is selected
and a spread formula is entered on the command line, an instrument will be
created with open, high, low and close values based on the entered formula,
instead of just using the close value.

Display security name for one-line formula-based symbols When this option is checked,
the application will substitute a symbols display name for the symbol in formulas.
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Correct symbols used in formulas used on the command line This option prepends the
prefix to a symbol used in a formula if it has been forgotten.

Clear command line history Resets the command line history.

SYMBOL LISTS
Show Symbol Lists toolbox after inserting a chart into a workspace

Use preferred period and FID when opening new charts from a symbol list Some symbols
in a symbol list may also specify a preferred period and FID. If they do, and this
option is selected, the instrument added to a chart will override the charts default
FID and period and use the preferred settings instead.

Show all symbols collected on a DataConnect server in a separate symbol list

Symbol display format How symbols in the Symbol List toolbox show be displayed.

PERFORMANCE
Prevent system suspension/hibernation while the application is running When checked,
the system will not go to sleep during your work with Tradesignal.

Prevent log-off if there are unsaved changes in any workspace Otherwise, changes will
be lost.

Allow full-text searching of help files When checked, all help file contents will be
searchable.

Unload optimizer results for non-visible documents When checked, memory
consumption of optimizers will be reduced by unloading the results after the
specified delay time.

Reduce the evaluation frequency for non-visible charts When checked, this might
improve performance. Note that alerts and signals will also be delayed by the
given Evaluation interval time.

Initial evaluation delay (in milliseconds) Controls the delay (in milliseconds) before a
new sequence of ticks will trigger the initial Equilla evaluation

Consecutive evaluation delay (in milliseconds) Controls the delay (in milliseconds)
before a new sequence of ticks will trigger the subsequent evaluations for the
same uninterrupted stream of ticks

Maximum visible instruments The maximum number of instruments that may be
simultaneously open.
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Minimum memory for optimizer/scanner (MB) The minimum amount of system
memory that must be available to start a new scan or optimization task.

Log memory and handle usage When checked, the application log will contain details
on memory and handle usage.

INDICATORS & STRATEGIES
Automatically add the following items when a strategy is added to a chart

Click on Add new item... to add further items. To edit an item, click on it and then
select another item from the dropdown list, or delete it by clicking on x. By default,
Strategy Equity Portfolio and Strategy Drawdown Portfolio are added.

Automatically add the following items when a strategy is added to a portfolio

Click on Add new item... to add further items. To edit an item, click on it and then
select another item from the dropdown list, or delete it by clicking on x. By default,
Portfolio Leave Exit strategy, Strategy Equity Portfolio and Strategy Drawdown
Portfolio are added.

Do not show the input mapping dialog if all inputs can be automatically mapped
Otherwise, the mapping dialog will always be shown, which makes it easier to
apply the element to unopened symbols.

Clicking on Recompile all user indicators and strategies will force all user indicators
and strategies to be recompiled. Progress will be shown and the result of the
compilation indicated.

STRATEGY ORDERS
Select under which conditions historic trades generated by trading strategies
should be recalculated, e.g. on Insert, Replace, Delete of items.

Generate order from the last save point, when a workspace is opened

Tip: For manual changes of orders, see the "Order Editor" on page 233.

SESSIONS
Period before session end that strategies may generate on-close orders (when enabled to
use a virtual session end) Set here exactly when On-close orders are generated in
order routing.
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CSV FILE EXPORT
Field separator when exporting data Choose between comma and semicolon as
separator. Default is the semicolon character.

Language used for formatting numeric values Choose between
Application Language, System Language and US English.

Enclose values in quotes Enable to enclose values in quotes

Export all optimizer runs in the optimizer results Check this to export all run results
(see chapter "Optimizer" on page 274).

CLIPBOARD
Field separator when copying data Choose between comma, semicolon or tab (\t) as
separator. Default is the tab character.

Language used for formatting numeric values Choose between
Application Language, System Language and US English.

Enclose values in quotes Enable to enclose values in quotes

TEMPLATES
Allow to update the templated charts when the base template change If this option is
checked, charts that have been created based on a template will automatically be
updated when the template is changed and saved. It is checked by default.

Show formula symbol templates in the toolbox Enable to display templates for formula
symbol in the toolbox under Indicators.

Show default symbol templates in the formula wizard Enable to display templates for
formula symbols in the wizard

TELEMETRY
Enable Telemetry Enable Telemetry to send data about the usage, analogous to the
support information, in order to help with the development and improvement of
Tradesignal.

Anonymize Data Enable to exclude information that allows a personal identification.

ADVANCED INSTALLATION OPTIONS
The information in this article is only relevant for system administrators who need
to use different settings or additional features of Tradesignal.

328



During installation of Tradesignal you can select Show the advanced
installation options page (recommended only for administrators) which allows
you to specify some additional options.

PASSWORD PROTECT DACS ID

With this option you can select a password for the DACS ID.

DATA PATHS

You can change both the application data and the user data path.

If you leave either of these fields blank, the default settings will be used.

SHARED DATACONNECT SETTINGS

You can specify the file location of an INI file containing connection settings for
the Tradesignal DataConnect and "Importing External Data in Tradesignal" on
page 513. This way there is a central point at which to configure connection
settings for all your installations and new installations are easily configured to use
your existing data sources.

This option sets the registry key
HKLM\Software\Tradesignal\TradeSignalEnterprise\ConnectionSettingsFile.

UPDATE WEB SERVICE

This allows you to specify an URL which is to be checked periodically for updates
of Tradesignal.

If you select this option, the registry key
HKLM\Tradesignal\SystemSoft\TradeSignalEnterprise\SiteUpdateService will be
set.

ALERTS

Ó ALERT AREA

The alert function helps you keep an overview
even when working with a large number of
running processes and functions. Use the alert
function in Tradesignal for the following:

à Trading systems that alert you of
certain activities

à Indicators that offer an inbuilt alert function in their codes
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à The chart tools trend line, trend channel, regression channel,
stop line and the Fibonacci Retracement

à Your own programs in which you can include offer alerts

à Placing orders through "Manual Order Routing" on page 317

ALERT WINDOW

ALERT AREA IN THE WORKSPACE
There is a specific alert window on the bottom of the workspace. The displays
differ slightly depending on the alert category. In Tradesignal you can choose
which columns to display for each category by selecting Add/Remove columns
from the alert window's context menu.

à Alerts coming from chart tools or indicators are listed in the
"Indicators & Tools" tab, with the triggering symbol and
reason, for example a trend line crossing or an indicator
crossing a signal line.

à Alerts coming from trading systems are listed in the
"Strategies" tab. Here, the triggering symbol and all events of
the trading system are listed, like opened or canceled orders,
and also feedback from your broker in case of activated
automatic order routing. The latter depends on your settings
in the Order Routing options.

à Application level alerts such as losing the connection to your
data feed are shown in the "Application" tab.

Each tab will show the number of unread alerts next to the tab's icon.

MAXIMIZING THE ALERT PANE
The small maximize icon shown directly below the alert pane tabs can be used to
maximize the alert pane to fill the entire main application window (with the
exception of Toolbar and toolboxes). Clicking the same button a second time will
restore the alert pane to its original position.

COLLAPSING THE ALERT PANE
The small minimize icon shown below the alert pane maximize button can be
used to collapse the alert pane. When collapsed the alert pane will be shown as a
single button (bearing an i icon) to the far right of the workspace tabs. If there are
any unread alerts, the will be displayed next to this button.
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FLOATING ALERT WINDOW
In the context menu the alert window can be shown as a floating window. It is
possible to open up to ten floating windows which duplicates all alerts triggered by
the application, indicators, tools and strategies. The floating window can be
positioned freely. The position and the size of a floating window are saved and will
be restored.

OUTPUT WINDOW

Ó OUTPUT AREA SHOWING COMPILER
ERRORS

Output area in the workspace showing
compiler errors

The tab labeled "Output" contains the output of
Equilla's Print() command and also the errors
and warnings generated by the Equilla
compiler. The text box at the top allows filtering
of its entries to show only matching lines.

The output window contains a maximum
number of 100,000 entries. If you need a larger
number of entries, you can edit the file tse.ini in
the application data folder of Tradesignal by
adding a value up to 10,000,000 for the setting MaxOutputMessage in the
General section. However be advised that increasing this number may negatively
affect your performance.

ALERTS IN TRADING SYSTEMS

Ó ALERTS IN SETTING

General alerts for trading systems are set in
"Tradesignal Options" on page 319. Additional
settings are available in the"Settings" on
page 157.

ALERT FUNCTIONS IN INDICATORS
Many indicators included in the software are
equipped with an alert functionality. As default,
the alerts are deactivated. However, you can
switch on the alerts in the "Mini Toolbar" on
page 45 via setting the option ShowAlerts to
Yes. As of that moment, signals like line
crossing or extremes are reported as alerts.

ALERT FUNCTIONS IN MONEY MANAGEMENT
The Money Management alerts in four different situations:
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à Order added

à Order changed

à Order cancelled

à Order filled

The alerts are reported by the trading system.

ALERT FUNCTIONS IN CHART TOOLS ALARM

Ó ALERT MODE OPTIONS

For tools please enable the alerts also in the
"Mini Toolbar" on page 45.

SET AN ALERT MODE
For the chart tools trend line, trend channel,
regression channel, stop line and Fibonacci
Retracement, the following alert modes are
available:

Always An alert is always set off when the condition is met, e.g. a line crossing. In
realtime operation, this can result in multiple alerts from the same tool, if the stock
crosses the line several times.

Once Per Bar An alert is only set off once per Bar. For example, if the price crosses
the threshold several times during the period, only one alert is issued and all
others are ignored. Once a new Bar has been created, a new alert will be issued
when the condition is met.

Once An alert is set off only the first time the condition is met. All other events are
ignored.

SET AN ALERT DIRECTION
You can also set an alert direction for the chart tools to define in which "direction"
the crossing has to take place to set off an alert.

All Alerts are set off no matter whether the lines are crossed downwards or
upwards.

Support (downwards) Alerts are only set off in the case of a downwards crossing.

Resistance (upwards) Alerts are only set off in the case of an upwards crossing.

SET AN ALERT TRIGGER
You can define when the alert should be triggered.
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Crossed An alert is triggered when the price crosses the tool.

Hit or Crossed An alert is triggered when the price crossed or hits the tool.

Break-in / Break-out (only available for channel type tools) An alert is triggered when the
price breaks into/out of the tool's channel.

GLOBAL ALERT SETTINGS IN TRADESIGNAL

Ó ALERT OPTIONS IN TRADESIGNAL

In the "Tradesignal Options" on page 319, you
can define several global settings for the alert
output, like an E-Mail address or the behavior
for each type of alert. For this, open the file
menu and select the "Tradesignal Options" on
page 319.

EMAIL ALERTS
You have the option to enable or disable email
alerts:

Alerts can send emails to the following recipient Tradesignal will send an email in
case an alerts occurs.

Alerts must not send emails Tradesignal will not send an email in case an alerts
occurs.

Recipient The email address email alerts will be sent to.

Minimum interval between emails (in minutes) The minimum time between email
alerts.

Add a screenshot to chart alerts Tick the checkbox if you want to include
screenshots in email alerts.

Width/Height The dimensions of the screenshots.

Maximum screenshots per mail The maximum number of screenshots allowed in a
single email.

ALERT SETTINGS
Active Here you can enable or disable alerts of this type.

Highlight With this option enabled, alerts are highlighted in the alert window and if
Pop-up is enabled too, the pop-up window will not close automatically.
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Pop-up If this option is enabled, the alert is displayed in a special pop-up on the
bottom of your screen. If Highlight is also enabled, the pop-up will be shown until
closed, otherwise it will hide after a short amount of time.

E-mail Enable this to send an E-Mail when an alert of this type is triggered. It is
only sent when Send an E-Mail when an alert occurs is enabled.

Sound Here you can select whether an alert sound shall be played for each alert.
Click on ... to choose a different sound file from a file dialog. To preview the
sound, click on the triangle button.

Keep pop-up visible until alerts have been marked as readIf unselected, the pop-up will
hide after a short amount of time.

PACKAGE ALERTS
Show updates to packages as a refreshable top-most dialog instead if a popup window.If
selected, updates to packages are shown as top-most dialog.

PACKAGE AND FILE MANAGEMENT
Packages correspond to folders on the computer and offer some additional
functions for organizing and managing your data.

You can use packages for the following:

à Setting up a folder structure in the Tradesignal data folder

à Sharing data with other users

à Saving data for backup

à Export Data

The following data can be saved in a package:

à Indicators

à Strategies

à Functions

à Templates

à Saved workspaces

Packages are compressed on export to reduce the file size. Equilla functions are
automatically added to the package if necessary.
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When working with packages, please remember that they correspond to physical
folders on your computer. Therefore, you can - by intention or by accident -
rename, move or delete these folders with a program like the Windows Explorer.
The result of such actions may be that the packages are no longer visible in the
package management of Tradesignal. As long as the folders still exist, however,
you can set up packages again, see the section "Package Management in the
Tradesignal Options" on page 337.

NEW PACKAGE
à In the toolbox, click on New Package in the area Related

Tasks to set up a new, empty package. A file dialog appears
in which you can either choose an existing folder or set up a
new one via the button New Folder.

à Alternatively, you can set up a new package by way of its
contents, as shown in the following example.

EXAMPLE: SETTING UP NEW INDICATORS IN A NEW PACKAGE

01. Click the button Indicators in the "Toolbox" on page 49.

02. Click on New Indicator in the Related Tasks area. The Create
ItemWizard opens.

03. Choose the option Download an existing indicator from
Tradesignal Online.

04. Select one or more indicators.

05. Confirm with the button Done.

06. Either save the new indicators in an existing package or in a
new one by clicking the button New Package. Start a new
package.

Tradesignal sets up a new folder in which it saves the downloaded indicators. The
new folder can be managed with the package and folder management in
Tradesignal and also with the normal folder functions of the Windows file system.

SHOW AND HIDE PACKAGES

With the help of packages you cannot only set up a file system with a subfolder
structure, but also organize the contents of the toolbox windows. For the latter,
however, the packages have to be displayed.

You can toggle the package display by clicking on Show/Hide Packages in the
Related Tasks area.
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à If packages are shown, the objects (indicators, strategies,
workspaces or Equilla functions) are sorted by packages. This
is of little importance as long as you are only using the
packages provided by Tradesignal.

à If packages are hidden, all objects are listed alphabetically
without any further breakdown.

MOVE PACKAGE CONTENTS

You can move contents like indicators or functions between packages. For this,
the packages have to be displayed.

01. Open a tool window in the toolbox, for example Indicators.

02. Select an entry in the list and drag and drop it from one folder
to the other.

The entry (e.g. the indicator) is moved between the Tradesignal packages as well
as physically between the folders on the computer.

EXPORT OR MAIL PACKAGES

Ó EXPORTING PACKAGES

Packages can be exported. During export, the
folder with all its contents (workspaces,
indicators etc.) and all necessary Equilla
functions is saved as a compressed file. You
can then use this file as a local backup or mail it
to other users for sharing.

01. Select File > Options > Folders >
Packages > Export Package file.
A dialog opens.

02. In the Choose Package area to the
left, select the folder to be exported.
The list will show all folders that are
registered by Tradesignal. (It is
possible that folders below the main folder Tradesignal Files
will not be shown because they were hidden in the package
management, see below.)

SET THE EXPORT OPTION
Select what you want to have exported:
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Export source code and compiled code Select this option if the source code should be
included, e.g. when sharing the package content with another user.

Export only compiled code Select this option if the source code should not be
included upon export, e.g. if you want to share the data with other users without
giving them access to the original source code.

Make exported packages read-only when imported If you select this option, the
contents of the package cannot be edited after import.

SET THE EXPORT ROUTE
Send via E-Mail If you select this and then click the Export button, your default mail
program will be opened and the file will be attached to a new mail.

Export file Select this if you want to save the file to your computer. '''

Browse and selecting another one (or changing the file name). Click the Export
button to start the export.

IMPORT PACKAGE

Ó IMPORTING PACKAGES

An exported package can be imported into
Tradesignal. For this, the package file has to be
available on the hard drive of your computer or
on a removable storage drive that can be
accessed from your computer.

à You can import a package by
double-clicking on it in Windows
Explorer. (If you received the
package as an E-Mail attachment,
you can either save it on your desktop or import it directly into
Tradesignal by double-clicking on it.)

à Alternatively, you can select File > Options > Folders >
Packages > Import package file. Select the package file in the
file dialog and confirm the import.

The program then decompresses the data in the package file and creates a new
folder with the package name below the main folder Tradesignal Files. The new
folder will appear in the toolbox window and the package management.

PACKAGE MANAGEMENT IN THE TRADESIGNAL OPTIONS

Tradesignal offers you several functions for the management of packages.
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To access these functions, navigate to File > Options > Folders > Packages.

Ó PACKAGEMANAGEMENT

You have the following options:

Add a new package Here you can add a
completely new package.

Attach to an existing package Access a previously
hidden package. In this case, a file dialog
opens in which you can find and select the
package.

Remove If you select a package and click the X next to it, you can either choose

Remove this package, but leave its contents untouched so that other users can still access them In
this case the package is only removed from the folder structure in Tradesignal but
the physical folder is still available.

Remove this package and permanently delete its contents In this case, all data will be
removed from Tradesignal and also physically deleted from the hard drive.

Rename Select the package a click the edit (pen) icon. The function renames both
the package and the folder on the hard drive.

Move up/Move down With these buttons you can change the folder sequence in
Tradesignal. Note that if you have functions/indicators/strategies of the same
name in different folders, changes in sequence may have effects on the
processing order. When compiling an indicator/strategy, Tradesignal tries to find
the necessary functions/indicators in the same package. If they cannot be found
there, all packages are searched according to the given sequence, and the first
find is used for the compilation.

Shared Tick this check box to enable notifications in case files are added, removed
or modified by another user. In combination with the checkbox File > Options >
Alerts > Package Alerts > Show updates to packages as a top-most dialog with
refresh option this allows you to refresh packages as soon as they are updated.

If a change to a shared folder is detected a dialog window will be displayed. This
dialog window will contain information on the detected changes as well as an
option to update packages in the toolbox and/or affected workspaces.

Refresh contents of all packages The contents of the package folders are checked
by Tradesignal only upon start. Therefore, if Tradesignal is running and files are
changed outside of Tradesignal (added, renamed, or deleted), you need to click
Refresh so that the package contents are updated in Tradesignal. This is
especially important in cases such as:
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à While Tradesignal was running, you received a workspace
attached to an E-mail and saved it into a package folder.

à You are working with packages on a network drive and other
users changed the package contents.

Ask to reload shared workspaces after modification by another user Tick this check box
to enable notifications in case an open workspace from a shared package is
modified by another user. Notifications will show an option to automatically
update the open workspace. If the user decides to reload the modified shared
workspace the currently open version of the workspace will be closed an
reopened with the new changes.

Note: Any modifications by the user will be lost if a copy of the workspace is not saved
before reloading.

Note: Updating an open workspace will discard any scroll positions and/or other local
changes.

Tip: You can find the Refresh function also in the context menu of packages in the toolbox.

Tip: You can also create, rename or delete packages in theOpen dialog. You can call up
this dialog by opening the file menu and selecting Open, or by pressing the key combination
Ctrl + O.

SHARING WORKSPACES
Tradesignal allows you to share workspaces with other users and automatically
subscribe to changes made to them.

Note: In order for workspaces to be shared, they must be included in a folder designated as
a shared folder.

To add a shared folder, proceed as follows:

01. Go to File > Options > Folders > Shared symbol list folders.

02. Click Add a shared symbol list folder.
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03. Select the folder on your network drive which contains the
symbol list.

04. ClickOK.

The selected folder is now designated as shared. You will automatically be
notified of any changes made to workspaces contained in it and any other shared
folder.

PRINT
Your charts, strategies, indicators or Equilla codes do not have to be limited to
your computer. All documents can be published right out of Tradesignal (as
printouts or files), for example in Internet forums, print media or by E-Mail. In the
other direction, it is also possible to import documents in Tradesignal from
Internet forums or by E-Mail .

This way, you can exchange content with friends, colleagues and supervisors and
work on Equilla code together, for example.

For exchanging complete packages, please see the chapters "Export or Mail
Packages" on page 336 and "Package and File Management" on page 334.

PRINTING CHARTS AND TABLES

Ó PRINT OVERVIEW

You can print all documents (Charts, Scanner,
Watchlist, Equilla code etc.). Click on the Print
button in the File menu. The Print Wizard
opens. Here you can choose what in the
currently selected workspace should be
printed.

After selection, a Print Preview pane opens.
Here you have the following options:

Print Start the printing. The standard Windows
printer dialog opens.

Copies Number of copies of the workspace to print.

Printer The printer to which to print.
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Printer Properties Advanced configuration of the selected printer.

Items to Print List of items in the workspace to print (including an extra page
containing the workspace as a whole. The items are printed in the order listed.
The arrow buttons can be used to change the print order of the items.

Chart Scaling Determines how charts should be scaled to fit the printed page.

Compress to one page width (only for a single item) When you have selected only one
item, this option leads to a horizontally fit print output. This feature is of particular
use when printing wide grid-based items like watchlists with many columns.

Pages Enter page numbers if only a certain range should be printed.

Duplex Mode Depending on the duplex/simplex capabilities of the printer.

Collation Options to control how pages are collated.

Paper Size Selection of the paper size.

Orientation Portrait or landscape.

Color Mode Select whether the document should be printed in Full Color (with
transparency) (24 bit RGB with alpha channel), Full Color (without transparency)
(24 bit RGB without alpha channel) or as Black andWhite. If the image is scaled
on your printer (e.g. into a larger format), select Full Color (without transparency)
for better results.

Margins Some predefined margin options. Margins can also be manually adjusted
using click and drag directly in the preview pane.

Ó EDITING THE HEADER/FOOTER

Edit Header/Footer Shows the Header and Footer
dialog where text and various macros can be
set for the page header and footer. The
alignment of text and font can also be changed.
The following macros are available:

Document title

Page Number

Page Count

Print Date

Print Time

Print User

341



Ó EDITING THEWATERMARK

Edit Watermark Show the Watermark dialog
where a watermark based on text or an image
can be specified for each page on the printed
output. The Watermark dialog presents many
options to configure how the watermark is
displayed, including

Text, Text direction, Font, Color and Size

Image file and alignment

Translucency

Positioned in front or behind

Page range to apply watermark to

For a chart and performance report, you can find additional print-out options in the
toolbox, category Publish. You can change the axes' colors and the header.

The print options selected for a workspace will be remembered following printing.
General options for printing (including setting a standard watermark and
header/footer) are available in the options under File > Options > Personalize >
Printing.

PRINT AND SCAN SCHEDULE

Ó PRINT SCHEDULE

If you want to print documents on a regular
basis, e.g. an overview of important indexes
every morning, you can use the scheduling
function of Tradesignal.

To be available for this function, the documents
have to be saved as a package in workspaces.
If the documents are not found there, either the
wrong documents or none may be printed. We
recommend that you test each print schedule
after its set-up.

Set up the print schedule via

File > Print > Print and scan schedule > Add
new schedule

For details, see "Schedule Jobs" on page 349.
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PUBLISHING WITH THE WINDOWS CHART VIEWER

If you are often confronted with the task of creating publications with chart
analysis, you can ease the work by using Tradesignal documents as Chart
Viewer Object objects. This is a Windows Object that can be used in many
programs, e.g. word processing.

In the following paragraphs, you can find the step-by-step instructions for MS
Word (up to Word 2003) and MSWord 2007.

MS WORD (UP TO WORD 2003)

01. Open your word processor.

02. From the Insert menu, select theObject entry.

03. From the list of objects, select Tradesignal Chart Viewer.

04. Right-click on the newly appearing border in the text
document.
The context menu opens.

05. From the context menu, select Tradesignal Chart Viewer
Object and then select Properties from the submenu.

Here you have to enter the package in which the requested workspace is saved.
For example:

à Package: Tradesignal Files

à Workspace: Chart Nasdaq

You can edit the format of the graph by editing the height and width. It is possible
to enter more than one chart in the new document.

Save your document, e.g. as a template for your analysis. The name and folder
can be freely chosen.

When you open the document again, the following steps are necessary to update
the graph.

01. Start Tradesignal.

02. Right-click in the graph in your document (e.g. in MSWord) to
open the context menu.

03. In the context menu, select the Properties of the Chart
Viewer.

04. Click on Update and then onOK.
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The chart is now refreshed with the data given by Tradesignal.

MS WORD 2007
When using MSWord 2007, the Developer tab has to be available. If this is not
the case, proceed as follows:

01. Click on theMicrosoft Office button and then click on
[program] Options. The program is the name of the current
program, i.e. "Word".

02. Click on Popular and check Show Developer Tab in the
Ribbon.

03. Click on the tab Developer.

04. In the controls, select Legacytools. Then, underMore
Controls, select Tradesignal Chart Viewer.

05. In the configuration window, enter the package in which the
requested workspace is saved.

For example:

à Package: Tradesignal Files

à Workspace: Chart Nasdaq

You can edit the format of the graph by editing the height and width. It is possible
to enter more than one chart in the new document.

Save your document, e.g. as a template for your analysis. The name and folder
can be freely chosen.

When you open the document again, the following steps are necessary to update
the graph.

01. Start Tradesignal.

02. Right-click in the graph in your document (e.g. in MSWord) to
open the context menu.

03. In the context menu, select the Properties of the Chart
Viewer.

04. Click on Update and then onOK.

The chart is now refreshed with the data given by Tradesignal.
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MS WORD 2010+
When using MSWord 2010 or above, the Developer tab has to be available. If
this is not the case, proceed as follows:

01. Click on the File tab on the toolbar and then click onOptions.

02. Click on Customize Ribbon and in the box on the far right
that lists all ribbon tabs, check the option labelled Developer,
then clickOK.

03. Click on the tab Developer.

04. Ensure design mode is active by clicking on Design Mode
button in the Controls group if it is not highlighted.

05. In the Controls group, select Legacy Tools. Then, under
More Controls, select Tradesignal Chart Viewer. The chart
viewer object will be inserted into your document.

06. Right-click on the inserted object and select Tradesignal
Chart Viewer Object > Edit to show the Properties dialog.

07. In the Properties dialog, enter the package in which the
requested workspace is saved.

For example:

à Package: Tradesignal Files

à Workspace: Chart Nasdaq

You can edit the format of the graph by editing the height and width. It is possible
to enter more than one chart in the new document.

Save your document, e.g. as a template for your analysis. The name and folder
can be freely chosen.

When you open the document again, the following steps are necessary to update
the graph.

01. Start Tradesignal.

02. Right-click in the graph in your document (e.g. in MSWord) to
open the context menu.

03. In the context menu, select the Properties of the Chart
Viewer.

04. Click on Update and then onOK.

The chart is now refreshed with the data given by Tradesignal.
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Note: ActiveX Objects and Add-Ins from third-parties, will generally not work with 64-bit
versions of Microsoft Office.

PUBLISH TO OFFICE
The Publish to Office capability lets you add charts contained in your workspaces
to Microsoft® Word, Microsoft® Excel and Microsoft® PowerPoint documents.
Changes made to charts will automatically reflect in the respective documents.
This feature is especially useful when including charts in publications or
presentations. Please be aware that the folder where the workspace is saved has
to be added to the packages, see "Package and File Management" on page 334.

Note: This feature only supports 32-bit and 64-bit versions of Microsoft® Office 2013 and
Microsoft® Office 2016.

ACCESSING THE PUBLISH TO OFFICE FEATURE

01. Open the File menu.

02. Click Publish to Office.

THE PUBLISH TO OFFICE INTERFACE
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ADDING CHARTS TO A NEW OFFICE DOCUMENT

01. In the File menu, click Publish to Office.

02. Click Click here to add more Office documents in the
Document Pane (1).

03. Select Create new Office document, then click Next.

04. Select the document type (Word, Excel or PowerPoint) you
wish to create, enter a name for the document and specify a
storage location (folder) for the document, then click Next.
The Publish to Office Document Wizard opens. It shows charts in open
workspaces.
The new Office document opens in a new window. This may be behind the
currently open window.

05. From the wizard, drag-and-drop the charts you wish to publish
to the newly created document.

06. Click Finish.

ADDING CHARTS TO AN EXISTING OFFICE DOCUMENT

01. Select the document to which you want to add charts in the
Document Pane.

02. Click Click here to add more charts to the document (2) in
the Workspace Pane.
The selected Office document opens in a new window. This may be behind
the currently active window.

03. Drag-and-drop the charts you want to add to the document.

04. Click Back or save the document from the Office application
to finish the process.

ADDING MORE CHARTS TO A KNOWN DOCUMENT

01. In the File menu, click Publish to Office.

02. Click Click here to add more Office documents (2).

03. Select Add to an existing Office document, then click
Next.

04. In the file explorer, select the document to which you want to
add charts, then clickOpen.
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The selected Office document opens in a new window. This may be behind
the currently active window.

05. From the dialog window, drag-and-drop the charts you wish to
publish to the newly created document.

06. Click Finish.

UPDATING CHARTS

UPDATING CHARTS MANUALLY

Note: Updating documents while the data feed is interrupted will produce empty charts.

To update charts after editing a document, proceed as follows:

01. In the Document Pane, select the Office document containing
the charts you want to update.

02. Click Update Charts (3) in the Workspace Pane.

SCHEDULING AUTOMATIC UPDATES

Note: Tradesignal needs to be running in order for the charts to be updated automatically.

01. In the Document Pane, select the Office document for which
you want to schedule automatic updates.

02. Click Click here to schedule a new automatic update (4)
in the Scheduling Pane.

03. Tick the corresponding check box for each day on which you
want to trigger automatic updates.

04. Specify a time of day at which the update should be triggered
by entering the desired time into the input box.

Tip: An overview of scheduled jobs can be accessed by clicking on the Scheduled Jobs
Button on the top-right of the application's title bar.
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SPECIFYING IMAGE DIMENSIONS FOR CHARTS

The width and height settings can be used to modify the size of the images that
are generated before being inserted into the Office document. Changing the width
and height does not change the size of the image in the document. This can only
be done by resizing it directly within the Office application.

Tip: Setting the width and height to a value much larger than displayed in the Office
document will show more information in the chart, but the image will lose some sharpness.

01. In the Document Pane, select the Office document for which
you want to specify image dimensions for charts (5).

02. Enter the desired image dimensions into the input fields.

The new image settings will be applied to the next publishing procedure.

DELETING DOCUMENTS

To delete a document, click on the Delete Button next to the document name
in the Document Pane.

SCHEDULE JOBS

Ó SCHEDULE SCAN

In Tradesignal, four job types can be
scheduled. Depending on the desired jobs,
start the scheduling from the following starting
points:

Print: File > Options > Print > Print and scan
schedule > Add new schedule

Scanner, Chart, Correlation Matrix: Ribbon >
Start Scan > Schedule Scan

Optimizer: Ribbon > Start Optimizer >
Schedule Optimization

The prerequisite for scheduling is that the activities to be scheduled have to be
saved as a package in workspaces. We recommend that you test each schedule
after its set-up.
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OPTIONS FOR SCHEDULED JOBS

Ó EDIT SCHEDULE FOR PRINT JOB

When the Edit Schedule dialog is displayed,
the following options are available.

Days On which days of the week the job should
run.

Time At which time to print. To run a job at
multiple times on the same day, add a second
schedule.

Dropdown selection for the job type

Relevant only for print schedules:

Items to print This option offers various ways to
print different items in a workspace

Items listed in the print preview

Every item in the workspace

All charts

All lists (Watchlists, etc.)

All lists and all charts

Copies Howmany copies of the document to print.

Orientation When not using the normal print settings, it is also possible to set the
orientation for printing.

Use the following printer and settings If you want to use another printer as usual, set
up the printer, sheet size and side options here.

ClickOK to save the schedule settings.
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MANAGING EXISTING SCHEDULES

Ó JOBS SCHEDULED FOR THE
WORKSPACE

Existing schedules for a workspace can be
recognized by the "Jobs scheduled" icon on the
top right next to the connection status.

Move the mouse over the icon to see the job
information (number of jobs for which
workspace, next run).

Click on the job information so see the full list.
At the right of each job, you can click on [...] to
edit the job or on [x] to delete the scheduled
job.

Ó SCHEDULED JOBSWINDOW

SAVE & SEND

SENDING A WORKSPACE BY EMAIL

Ó SENDINGWORKSPACES BYMAIL

You can send workspaces via Email right out of
Tradesignal.

01. Click File > Save & Send > Send
Using Email .
The E-Mail wizard opens.

02. Select whether to include a preview
image of the workspace.

03. Click Send Email to open a new email and attach the
workspace.

SENDING EQUILLA SCRIPTS VIA EMAIL
To send an Equilla script and its dependent function files via email:
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01. Open the desired Equilla script.

02. Select Editor > Export > Send by Email on the "Toolbar" on
page 42.

The Email client with attached portable script file and a code preview opens.

IMPORTING WORKSPACES OR EQUILLA CODE FROM AN EMAIL
When you received an E-mail with Tradesignal documents, you can import them
into Tradesignal.

01. Save the E-mail attachment in a folder that is also a package
in Tradesignal.

02. In Tradesignal, open the "Toolbox" on page 49.

03. With packages displayed, right-click on the package and
select Refresh from the context menu.

When the display is refreshed, you can find the new documents in the package.

SAVING DOCUMENTS AS IMAGES

Ó SAVING DOCUMENTS AND
WORKSPACES AS IMAGES

You can save the workspace as image, e.g. to
use it later in text documents or E-Mails.

à Click File > Save & Send > Save.

The Save Image pane opens. At the bottom of the pane
you will see a preview of the image.

OPTIONS FOR SAVING AS IMAGE

à Pick what you would like to save an
image of, the entire workspace or a
single element in it.

à Enter an image size in pixels, inches or millimeters. Take care
that the freely adjustable height and width of the image do not
lead to distortion.

à Select the Color Mode, either Color (color image with 24 bit
RGB and alpha channel) or Black andWhite (no colors).

à Select the resolution for the image. 96 DPI (dots per inch) is
normal screen resolution, use higher resolutions if the image
is intended for print output or zooming out using interpolation
is intended.

352



à Select whether to use interpolation. Interpolation will
essentially render the image at the selected resolution, then
scale it down to fit the desired dimensions. This will create a
zoomed-out look to an image at the cost of some precision.

Finally, click on of the following buttons:

à Save Image This saves the selected item as an image file. A
new dialog opens. Choose the target folder and the file
format. Six image formats are available: jpg, png, bmp, gif, tif
and emf (emf is a scalable, vector format, although the
generated image may not be identical to the preview).

à Copy to Clipboard This generates a copy of the image in the
Windows clipboard in bmp format.

à Send Email Create the image in png format and attach it to a
new email.

SAVING PDF DOCUMENTS

Ó PDFWIZARD

Any items that can be printed can also be
saved as a PDF file. To save a PDF file, click
on File > Save & Send > Create PDF to display the
PDF preview pane.

The PDF preview pane present most of the
same options that the print preview pane offers,
and uses previously saved settings associated
with a workspace.

Save as PDF Save the PDF file.

Send by Email Create a PDF file and attach it to a new Email.

Items to Print List of items in the workspace to print (including an extra page
containing the workspace as a whole. The items are printed in the order listed.
The arrow buttons can be used to change the print order of the items.

Chart Scaling Determines how charts should be scaled to fit the printed page.

Paper Size Selection of the paper size.

Orientation Portrait or landscape.

Color Mode Select whether the document should be printed in Full Color (with
transparency) (24 bit RGB with alpha channel), Full Color (without transparency)
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(24 bit RGB without alpha channel) or as Black andWhite. If the image is scaled
on your printer (e.g. into a larger format), select Full Color (without transparency)
for better results.

Margins Some predefined margin options. Margins can also be manually adjusted
using click and drag directly in the preview pane.

Edit Header/Footer Shows the Header and Footer dialog where text and various
macros can be set for the page header and footer. The alignment of text and font
can also be changed. The following macros are available:

Document title

Page Number

Page Count

Print Date

Print Time

Print User

Edit Watermark Show the Watermark dialog where a watermark based on text or an
image can be specified for each page on the printed output. The Watermark
dialog presents many options to configure how the watermark is displayed,
including

Text, Text direction, Font, Color and Size

Image file and alignment

Translucency

Positioned in front or behind

Page range to apply watermark to

Document Properties Title, subject, author and keywords meta data that will be
embedded in the PDF file.

Protect file with a password When checked and the PDF is saved, a dialog will be
displayed where the following passwords can be set.

Password to open the PDF document

Password to edit the PDF document

Restrictions on printing

354



Restrictions on editing

Restrictions on copy portions of the file

COPYING DOCUMENTS VIA THE WINDOWS CLIPBOARD

If you want to transfer graphs and tables quickly to other documents, for example
to further analyze the data, you can use the Windows clipboard. This way, you
can copy a chart into a text document or copy the results of the Optimizer into a
table. This copying also works with other tables or with Equilla codes. Instead of
using the key combinations, you can also use the buttons in the Edit group of the
toolbar.

COPYING CHARTS

01. In an active chart, press the key combination Ctrl + C to copy
the chart.

02. Switch to the target document, e.g. publishing software.

03. There, press the key combination Ctrl + V to paste the chart.

The chart is inserted in bitmap format.

If the target document is a table, for example in MS Excel, you can copy the price
data as well as any indicators or strategies included in the chart into the Excel
table. To do so, select the price data in Tradesignal and then drag the data into
the Excel table with the mouse.

COPYING TABLES

01. Select the rows in the source table that you want to copy (the
source may be a Scanner, Watchlist, Portfolio or Optimizer).
To select all rows, press Ctrl + A.

02. Press Ctrl + C to copy the rows.

03. Switch to the target document, for example a Microsoft Excel
table.

04. Press Ctrl + V to paste the table contents into the target
document.

COPYING TEXT

01. Select the lines that you want to copy, either in an Equilla
Editor, an HTML Editor or a News window. To select all lines,
press Ctrl + A.
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02. Press Ctrl + C to copy the lines.

03. Switch to the target document, for example a text editor, and
press Ctrl + V to paste the contents.

WEB BROWSER
The scope of the stock market is not limited to one's own office. Information from
all over the world has to be gathered and exchanged with other users or
colleagues. To do so, Tradesignal offers you an integrated web browser. This
way, you have access to the web contents of tradesignal.com and every other
web page in the Internet. Use the web browser for

à surfing the Internet

à communicating in Internet forums

à contacting the support staff

à displaying web-based help contents

Tradesignal also offers an"HTML Editor" on the next page as a language
interface to JavaScript. With it, many functions of the Tradesignal software can be
controlled. You can program your own tools to make working with Tradesignal
easier and faster.

For information about distributing content on the Internet, for example in forums,
please refer to the chapter Publishing.

USING THE WEB BROWSER
à In the Insert tab in the toolbar, click on the buttonWeb

Browser.

à You can also open a web browser by entering a URL in the
command line and selecting New Browser from the menu.

à To replace an existing website, enter the URL in the
command line and select Replace Web Page from the
menu.

à To navigate back and forth between sites, click on the small
green arrows to the right of the entry field in the command
line.

à To close a browser window, either press Ctrl + F4 or open the
context menu of the tab and select the entry Close [window
name...].
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HTML EDITOR

Ó HTML EDITOR

Tradesignal possesses a built-in HTML editor.
With it, you can do the following:

à Use HTML code to design a GUI or
control elements like buttons, lists or
entry fields

à Use active elements written in
JavaScript (JS), for example to list all
active workspaces. This way you can
write control elements that use
program functions of Tradesignal.

USE THE HTML EDITOR
à On the Insert tab on the toolbar, choose HTML Page.

An editor window opens. In the toolbar, the Editor tab appears with the following buttons:

Undo Undo the last action (multiple undoes possible).

Redo Repeat the last action (multiple repeats possible).

Select All (Ctrl+A) Selects all code. You can use the standard Windows key
commands to copy the code with "Ctrl+C" and then paste with "Ctrl+V", e.g. into a
text editor.

Toggle Comments Switches between commenting/uncommenting the selected
lines using HTML comment syntax.

Browser Mode Interprets the HTML or JavaScript Code and displays the result in a
browser. Click on it again to switch back to the editor.

SEARCH AND REPLACE
For editing the code, the Find group in the toolbar is available.

à Click on Find to enter a search term in a search pane.

à With Replace you can replace one or all appearances of a
code text with another text.

à For very long scripts, you can useGoto Line to jump to a
code line.
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JAVASCRIPT IN THE HTML EDITOR
JavaScript offers you a connection to the inner workings of Tradesignal. With JS
and a number of interface commands it is possible to control various functions of
Tradesignal. Here a list of possible script commands:

// Global variable to access the TSEPublic object, e.g.:
//
// var selectedWorkspace = TradeSignal.GetSelectedWorkspace();
//
TradeSignal

// The Tradesignal script root element, reachable with JavaScript by either
using window.external or the TradeSignal global variable
class TSEPublic

// Returns a collection of all saved workspaces
GetSavedWorkspaces() : TSEWorkspaceCollection

// Returns a collection of all open workspaces
GetOpenWorkspaces() : TSEWorkspaceCollection

// Returns the currently selected workspaces
GetSelectedWorkspace() : TSEWorkspace

// Returns the last selected workspace, selected before the
// current workspace was selected, this is useful for operating
// on a target workspace from within an HTML page in another
// desktop
GetLastSelectedWorkspace() : TSEWorkspace

// Returns the total RAM managed and used by Tradesignal
GetTotalMemory() : int

// Returns the current timezone set by the user in
// Olsen format (e.g. Europe/Berlin)
GetUserTimeZone() : string

// Returns the current version number of Tradesignal (x.y.z)
GetVersion() : string

// Like the Bang! Command !new
Create( whatToCreate : string, parameters : string ) : TSEDocument

// Opens a new chart and returns it with an instrument
CreateNewChart( symbol : string ) : TSEDocument

// Opens a new chart with an instrument optionally allowing
// the chart type and scale alignment to be set.
// Use a parameter string of the form:
//
// "charttype=line(open); scale=left; subchart=false"
//
// valid values for scale are left|right|both
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// valid values for charttype are:
// line(field), bar, candlestick, candlevolume,
// equivolume, symbol(field), stepped(field),
// area(field1, field2), forest(field), linkedforest(field),
// renko(field), pointfigure, heikinashi, kagi, tlb
// valid values for subchart are true|false
// valid values for field are open|close|high|low|volume|openinterest
CreateNewChartEx(symbol : string, parameters : string) : TSEDocument

// Opens a new Market Profile and returns it with an instrument
CreateNewMarketProfile( symbol : string ) : TSEDocument

// Opens a new chart and returns it with an indicator
CreateNewInstantIndicator( equillaCode : string ) : TSEDocument

// Opens a new chart and returns it with an indicator series
CreateNewInstantIndicatorSeries( equillaCode : string ) : TSEDocument

// Opens and returns a new webbrowser containing the given url
CreateNewBrowser( url : string ) : TSEDocument

// Opens and returns a new scanner with an instrument
CreateNewMarketScanner( symbol : string ) : TSEDocument

// Opens and returns a new workspace
CreateNewWorkspace() : TSEWorkspace

// Passes the entered key string as the value of an additional
// parameter called sessionkey that will be appended to all
// TXML data requests to a server identified by the URL
// parameter
SetMixinDataSessionKey(url : string, key : string)

// Shows the Tradesignal Help
ShowHelp()

// Shows the Equilla Help
ShowEquillaHelp()

// A collection of workspaces. The collection is zero (0) based
class TSEWorkspaceCollection

// Returns the workspace of a certain position in the collection
ItemAt( index : int ) : TSEWorkspace

// Returns the number of workspaces in the collection
GetLength() : int

// Returns the workspace with a certain name
Find( workspaceName : string ) : TSEWorkspace

// An element representing a certain workspace in Tradesignal
class TSEWorkspace
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// Returns the workspace title
GetTitle() : string

// Returns true in case the workspace is open, otherwise false
IsOpen() : bool

// Returns true in case the workspace is included in the currently open
file list, otherwise false

IsRecent() : bool

// Returns true if the workspace was open at the last shutdown of
Tradesignal, otherwise false

WasPreviouslyOpen() : bool

// Opens the workspace or activates it, if it is already open
Open() : bool

// Closes the workspace; optionally other saving dialogs can be
suppressed

Close( suppressDialogs : bool ) : bool

// Like the Bang Command !new except that it selects the workspace first
Create( whatToCreate : string, parameters : string ) : bool

// Selects the workspace if it is open
Select() : bool

// Returns a collection of all documents in the workspace
GetDocuments() : TSEDocumentCollection

// Returns the currently selected document in the workspace
GetSelectedDocument() : TSEDocument

// A collection of workspace elements (documents), the collection is zero
(0)
// based
class TSEDocumentCollection

// Returns the document of a certain position in the collection
ItemAt( index : int ) : TSEDocument

// Returns the number of documents in the collection
GetLength() : int

// Returns the document with a certain name
Find( wokspaceName : string ) : TSEDocument

// An object which represents an element in the workspace, this could be
// a Chart, Browser, Scanner, etc.
class TSEDocument

// Returns the document name
GetDocumentTitle() : string
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// Returns the name of the selected element in the document
GetSelectedItemTitle() : string

// Returns the document type: Chart, Browser, TextEditor, PriceEditor,
//MarketProfile, MarketScanner, WorkspaceInterfaceScript, Statistics,

Trades or Optimiser
GetDocumentType() : string

// Selects the document
Select() : bool

// Selects the document and executes !replace
Replace( itemToReplaceSelectedItem : string ) : bool

// Selects the document and executes !replaceall
ReplaceAll( itemToReplaceAllCurrentItems : string ) : bool

// Selects the document and executes !add
Add( itemToAdd : string ) : bool

// Selects the document and adds an item optionally allowing
// the chart type, scale alignment and subchart to be set.
// Use a parameter string of
// the form:
//
// "charttype=line(open); scale=left; subchart=false"
//
// valid values for scale are left|right|both
// valid values for charttype are:
// line(field), bar, candlestick, candlevolume,
// equivolume, symbol(field), stepped(field),
// area(field1, field2), forest(field), linkedforest(field),
// renko(field), pointfigure, heikinashi, kagi, tlb
// valid values for subchart are true|false
// valid values for field are open|close|high|low|volume|openinterest
AddEx( itemToAdd : string, parameters : string) : bool

// Selects the document and executes a setp property action,
// valid property names and values are:
//
// "period" - period in seconds (0 for tick, 86400 for daily)
// "dateaxismode" - normal|seasonal
// "historylength" - number of bars of data to load
Set( propertyName : string, value : string ) : bool

// Selects the document and executes sets the value for all
// instruments in all subcharts, see Set() for available
// properties
SetAll (propertyName : string, value : string) : bool

// Evaluates the Equilla Code and adds it to the document
Eval( equillaScript : string ) : bool

// Evaluates the Equilla Code Series and adds it to the document
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EvalSeries( equillaScript : string ) : bool

// Selects the document and executes !close document
Close() : bool

EXAMPLE: LISTING ALL AVAILABLE WORKSPACES WITH
JAVASCRIPT

In this tutorial we will design a simple JavaScript that will display a list of all
available workspaces.

STEP 1: START A HTML PAGE AND ENTER THE PAGE FRAME
Open a new, empty workspace. Then on the Insert tab on the toolbar, choose
HTML Page.

An empty HTML editor opens.

For a correct page frame, please enter the following source code:

<html>
<head>

<title>List Workspaces</title>
</head>
<body>

</body>
</html>

STEP 2: ADDING THE LIST ELEMENT AND THE SCRIPTING AREA
Now copy the following line between the Body Tags:

<select name="Workspaces" style="position:absolute; left:10px; top:20px;
width:150px" >
</select>

The line includes the HTML code for the list with position and width values. When
you now click on Browser Mode in the toolbar, you can see the new page with an
empty list. Click on Browser Mode once more to edit the code again.

Now we can define the area for the JavaScript source code. Copy the following
code into the line below the list. The code assigns the collection of all saved
workspaces to a variable.

<script language="JavaScript" type="text/javascript">
//Array with workspaces and number of elements
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var savedCollection = TradeSignal.GetSavedWorkspaces();
var maxIter = savedCollection.GetLength();

</script>

STEP 3: DESIGNING AND TESTING THE JAVASCRIPT
In the upper part we have set up a HTML page and the basis for a JavaScript. The
list of workspaces was copied into a variable. To be able to read out the list later,
we need the number of included elements. This value is also saved as a variable.

In the following script, a reference to the list is set, so that we can add a list entry
for every workspace in the collection. To read out the collection, we need a loop
that runs over all workspaces. Add the following lines in the script area:

//Reference to the list
var listRef = document.getElementById("Workspaces");
//loop
for( iter = 0; iter < maxIter; iter++ )
{

//Read the workspace names
var wsName = savedCollection.ItemAt(iter).GetTitle();
//Generate a list entry
var listEntry = new Option(wsName, iter );
//Add the list entry to the list
listRef.options[listRef.options.length] = listEntry;

}

THE COMPLETE SCRIPT
Here you can see the complete code of the script.

<html>
<head>

<title>List Workspaces</title>
</head>
<body>

<select name="Workspaces" style="position:absolute; left:10px; top:20px;
width:150px" >

<script language="JavaScript" type="text/javascript">
//Array with workspaces and number of elements
var savedCollection = TradeSignal.GetSavedWorkspaces();
var maxIter = savedCollection.GetLength();
//Reference to the list
var listRef = document.getElementById("Workspaces");

//loop
for( iter = 0; iter < maxIter; iter++ )
{

363



//Read the workspace names
var wsName = savedCollection.ItemAt(iter).GetTitle();
//Generate a list entry
var listEntry = new Option(wsName, iter );
//Add list entry to list
listRef.options[listRef.options.length] = listEntry;

}
</script>

</select>
</body>
</html>

To view the result, click on Browser Mode again. A list of all workspaces
appears.

Note: You cannot save the HTML script itself, only the workspace in which it was created.

PYTHON MODULE EDITOR

Ó PYTHONMODULE EDITOR

Tradesignal possesses a built-in Python
Module editor. With it, you can create, modify
and view Python packages and modules.

Most standard text editor commands are
supported, including Python syntax
highlighting.

The Python modules can then be called in
Equilla via the command "PyExec".

OPEN THE PYTHON MODULE EDITOR
à On the Insert tab in the toolbar, choose Python Module

Editor.

à Alternatively, right-click on Python functions in the Equilla
editor and select Open in New Editor (F12).

Ó PYTHONMODULEWITH DEMOCODE

The Python Module Editor opens. On the
bottom left side, choose between:

Add Folder Open the file selection window to
select a folder with existing Python modules.
The folder and files are displayed on the left in

364



a tree view. (Note that the Python modules delivered with the application are
read-only and can only be viewed, not edited.)

New Module Select a folder and enter a new file name. The mandatory file ending
is .py. The code area for the new module opens on the right and code can be
entered. When more than one module is opened, a tab is visible for each.

EDITING THE PYTHON CODE

When the editor is open, the Editor tab similar to the Equilla editor appears in the
toolbar.

For details, see "Editing the Equilla Code" on page 400 and the keyboard
shortcuts for "Programming and Debugging" on page 57.

EXAMPLE USAGE
à Create a new Python module with the name

"my_module" and the example code.

def my_function():
print("Hello from a python module function")

à Create a new function (see "Equilla Editor" on page 399) and
enter the following code to import and call the module.

Once PyExec
import my_module

End

If IsLastBar Then
PyExec my_module.my_function()

End;

Tip: See the Equilla code of the Target Return Portfolio strategy on how to include Python
modules.

NEWS

Ó NEWS READER

News is an important tool for the fundamental
chartist to have at their disposal and can be
accessed from Tradesignal either from a
traditional news reader or as a study within a
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chart. Tradesignal allows you to view both realtime news from your data feed and
also to subscribe to RSS sources available via the Internet or a local intranet.

The news reader uses a split display to show recent headlines in the top pane,
and the selected story in the bottom pane. The window sizes can easily be
adjusted by dragging the separator between the two panes.

Use the news tools to:

à View realtime news as it happens

à View current news for a specific security

à View historic news in your charts

à Connect to RSS feeds to view any event-based information

NEWS SETUP

You can view news stories in one of the following ways:

à To view all recent news headlines, click on the News button in
the Insert tab of the toolbar.

à To view all headlines for a specific security, right-click on a
security in a "Chart" on page 96, "Watchlist" on page 77,
"Portfolio" on page 251, "Scanner" on page 71 or "Symbol
Lists" on page 62 to show the context menu, then select the
optionOpen, entry News.

à To view news stories in a chart, drag and drop the News
indicator from the toolbox onto a security in your chart.

LINKING THE NEWS READER TO A WATCHLIST OR CHART

If you want to link a news reader so that it displays relevant news depending on
what is currently selected in a watchlist or chart, do the following:

01. Right-click on the tab above the chart or watchlist and pick a
color under the Symbol Link menu.

02. Click on News in the Insert tab of the toolbar to display a news
reader.

03. Right-click on the tab above the news reader and pick the
same color link you chose in the chart or watchlist.

The headline list will now only show stories related to the selected item in the watchlist or
chart.
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To change the displayed headline, just select a new item in your watchlist, or
replace the item in your chart.

WORKING WITH NEWS IN A CHART

By applying the news indicator to a security in a chart as described above, you will
get a historic overview of headlines related to that security displayed as
hyperlinks above the bar on which the news was published. Just click on one of
the hyperlinks to open a news reader in which you will see the full news story.

The news indicator is written in Equilla using the news API. Programmers can
make use of this API to create their own indicators or indeed trading strategies
based around realtime news. Please refer to the Equilla help system within
Tradesignal for more information on this API.

SETTINGS

The general properties are available via "Settings" on page 157 in the home tab.

FORMATTING OPTIONS
The following settings can be used to customize the news window to your
preference:

Back color Change the background color for news headlines and stories.

Text color Change the text color.

Font size Change the size of the text in headlines and stories.

Show time Displays the time of the news story in the headline list.

Show source Displays the source (feed) of the news story in the headline list.

Browser alignment Display the headline list to the top, right, bottom or left of the
news story pane.

Scroll to New Headline Enable to scroll to newest headline.

FILTER OPTIONS
Show All available news headlines; Headlines for a selected symbol; Stories for a
given symbol on a specific day.

Symbol Displays the currently selected security for which headlines are shown.

Days Howmany days of headlines should be displayed.

Keyword Show only headlines containing the entered keywords.
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RSS FEED
RSS Feeds Displays how frequently (in seconds) the headlines from RSS feeds
should be updated.
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FUNCTIONS, INDICATORS AND
STRATEGIES

INTRODUCTION TO FUNCTIONS, INDICATORS
AND STRATEGIES
The hub of all analysis methods in Tradesignal is the available functions,
indicators and strategies.

All three tools are written in "Equilla Basics" on page 397. This is a Tradesignal-
specific programming language similar to Algol or Visual Basic. No programming
knowledge is necessary as long as you use the delivered functions, indicators or
strategies. However, if you are interested in programming, see the "Equilla
Basics" on page 397 chapters for details.

TOOL CHARACTERISTICS

FUNCTIONS

à Functions are subordinate portions of the code in which
regularly used calculations and subroutines are sourced out.
For example, instead of writing the code for the standard
deviation again and again, the calculation is put into a
function. By calling up the function by its name - and passing
the relevant parameter(s) for calculation - the user receives
the return value as a result.

à A function cannot be applied to a chart directly.

Tip: You can find more information in chapter "Equilla Functions" on page 415.

INDICATORS

à Indicators are mathematical calculations that can be applied
to symbol data for technical analysis.

à Indicators can be applied to charts or other indicators,
watchlists, portfolios etc.

Tip: You can find more information in chapter "Using Indicators" on page 372.
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STRATEGIES

à Strategies combine the results of indicators with certain rules
and conditions for signal generation, to help setting up a
sophisticated trading system.

à Strategies can be applied to charts, indicators, watchlists,
portfolios etc.

Tip: You can find more information in chapter "Using Strategies" on page 381.

EXAMPLE VOLATILITY
à The function "Volatility" calculates the standard deviation from

the moving average of the close price.

à The indicator "Volatility Ratio" uses the Volatility function over
two different periods and then calculates the ratio of the two
results. A Volatility Ratio above 0.5 signals a breakout.

à The strategy "Volatility Ratio Breakout - Exit" combines the
indicator with an Ehlers filter, so that long or short positions
are closed depending on the development of the volatility.

EXAMPLE BOLLINGER BANDS
à The function "BollingerBands" calculates a simple moving

average and an upper and lower standard deviation as bands.

à The indicator "Bollinger Bands" calculates and draws the
resulting bands. In the mini toolbar, the parameters price
(close, high...), period, and standard deviation can be edited.

à The strategy "Bollinger Lower Band - Entry" combines the
results of the indicator with entry signal generation.

EQUILLA CODE OF THE BOLLINGERBANDS FUNCTION

Meta:
Synopsis( "[Bollinger Bands] Calculates the Bollinger band values for

the upper and lower deviation bands and the simple moving average and
returns them as output parameters. Bollinger Bands are an indicator that
allows users to compare volatility and relative price levels over a period
time. The three calculated values are designed to encompass the majority of
a security's price action. Sharp price increases or decreases (volatility)
will lead to a widening of the band. Consolidation will result to a thinning
of the bands." );
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Inputs:
Price( NumericSeries ),
Period( NumericSimple ),
StdDevs( NumericSimple ),
RefMidBand( NumericRef ),
RefUpperBand( NumericRef ),
RefLowerBand( NumericRef );

Variables:
distance, sumSqr, i;

RefMidBand = AverageFC( Price, Period );

sumSqr = 0;
For i = 0 To Period - 1 Do

sumSqr = sumSqr + Sqr( Price[i] - RefMidBand );

If sumSqr > 0 And Period > 0 Then
distance = Sqrt( sumSqr / Period ) * StdDevs

Else
distance = 0;

RefUpperBand = RefMidBand + distance;
RefLowerBand = RefMidBand - distance;

BollingerBands = 1;

EQUILLA CODE OF THE "BOLLINGER LOWER BAND - ENTRY"
STRATEGY

Meta:
Synopsis( "Generates a long entry signal when the Close crosses over the

Bollinger Lower Band value, and/or generates a short entry signal when the
Close crosses under the Bollinger Lower Band value. Bollinger Bands are an
indicator that allows users to compare volatility and relative price levels
over a period time. The indicator consists of a moving average and two bands
drawn two standard deviations from the average. These three bands are
designed to encompass the majority of a security's price action. Sharp price
increases or decreases (volatility) will lead to a widening of the band.
Consolidation will result to a thinning of the bands." );

Inputs:
Price( Close ),
Period( 20, 1 ),
StdDevs( 2.0, 0.0 ),
EntryMethod ( LongEntry, ShortEntry, Both ) = Both,
Visuals( False );

Variables:
longSig, shortSig, avg, upperBand, lowerBand;

BollingerBands( Price, Period, StdDevs, avg, upperBand, lowerBand );
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longSig = ( Close Crosses Over lowerBand ) And ( EntryMethod <> ShortEntry
);
shortSig = ( Close Crosses Under lowerBand ) And ( EntryMethod <> LongEntry
);

If longSig Then
Buy( "BollingerLWR" ) Next Bar at Market

Else If shortSig Then
Short( "BollingerLWR" ) Next Bar at Market;

If Visuals Then
DrawLine( lowerBand, "BollingerLowerBand", StyleSolid, 2 );

USING INDICATORS

Ó INDICATOR VIEW IN THE TOOLBOX

Technical indicators are mathematical
calculations based on securities and additional
data. You can use indicators for

à Signal generation in mechanical
trading systems

à Detecting trends in symbol charts

à Supporting trading decisions

à Supporting chart analysis

In Tradesignal, indicators are available which
were developed based on material from
various sources (publications, media or in-
house development). For all indicators,
additional information on the source, the
calculation basis, the interpretation of results
and the appliance is offered.

The indicators in Tradesignal are written in
Equilla. You can find more information in the
chapter "Equilla Basics" on page 397.

APPLYING INDICATORS

APPLYING INDICATORS TO CHARTS
OR INDICATORS
You can apply an indicator to a chart (or an
indicator) in various ways.
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FROM THE INDICATOR LIST IN THE TOOLBOX

à Drag-and-drop the indicator to the chart.

à Double-click on the indicator.

à Right-click on the indicator and choose Apply from the context
menu.

Ó ENTERING A SHORTCODE INTO THE
COMMAND LINE

Via the command line in the toolbar:

01. Enter a shortcode in the command
line, for example "BBD".

02. Select the Add Indicator option in the
drop-down menu.

DATA INPUT SELECTION
If you apply an indicator which uses more than one data input, the Data Input
Selection dialog (see image) is displayed. It allows you to select either an already
existing chart object or to open a new symbol via the "Symbol Lists" on page 62 or
"Symbol Search" on page 59. There also is an option to always display this dialog
so you can apply indicators to symbols which are not themselves displayed.

Ó DATA INPUT SELECTION DIALOG

APPLICATION RULES

à The indicator is applied to the active
chart or subchart, except when using
drag and drop.

à By default, indicators are applied to
the top entry in the chart or subchart
legend.

à When you drag the indicator onto a
certain entry in the legend of a chart
or subchart (for example another
indicator), the indicator is applied to this entry.

à Whether a subchart is created for an indicator depends on the
meta tag "subchart" in the Equilla Code of the indicator (see
chapter "Equilla Program Structure and Syntax" on
page 408).

You can see in the legend how to which entry the indicator is applied. It is
constructed as Indicator[Var1, Var2...] value {applied to}.
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EXAMPLE:

à Chart: DAX P-IN. [.DAX LAST 1 hour]...

à Subchart#1: Accelerator [Close, 10, 13] 32.02 {.DAX}

à Subchart#2: Average True Range [14] 122.44 {Accelerator}

EXAMPLE: APPLYING BOLLINGER BANDS TO A CHART

01. Open the .NDX in a chart and set the time span to "1 Year"
(via the "Fixed Data Range" entry).

02. In the indicator list in the toolbox, search for "Bollinger Bands".

03. Drag the indicator into the graph. The Bollinger Bands are
calculated for the .NDX and enfold the line.

EXAMPLE: APPLYING BOLLINGER BANDS TO AN INDICATOR

A popular combination is the "Relative Strength Index" (RSI) with added Bollinger
Bands. Proceed as follows:

01. To your chart, apply the "Relative Strength Index" (RSI)
indicator as described above. The result is displayed in a
subchart.

02. Select the RSI subchart by clicking into the subchart.

03. Now apply the "Bollinger Bands" (BBD) indicators to the RSI
subchart. The Bollinger Bands are calculated for the RSI and
enfold its line.

APPLYING INDICATORS TO SCANNER, WATCHLIST OR
PORTFOLIO
You can also apply indicators to symbol tables such as the "Scanner" on page 71,
"Watchlist" on page 77 or "Portfolio" on page 251.

à When creating a new Scanner, Watchlist or Portfolio, you can
directly add indicators (and strategies).

à For existing tables, you can add indicators to the selected
table by using one of the methods described above. A new
column is added for the results.

AUTOMATIC APPLICATION OF INDICATORS AND STRATEGIES
By default, the Strategy Equity Portfolio indicator and the Strategy Drawdown
Portfolio indicator are added to a chart with the first strategy. In case of a portfolio,
the Portfolio Leave Exit strategy is added in addition to these two indicators.
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This can be customized in the options at File > Options > Advanced > Indicators &
Strategies > Automatically insert the following items when a strategy is added to a
chart and Automatically insert the following items when a strategy is added to a
portfolio, see "Indicators & Strategies" on page 327.

EXAMPLE: SCANNER WITH INDICATOR

The Scanner is intended for screening a high number or securities for certain
criteria. For example, create a Relative Strength list for the hundred Nasdaq
values by adding the "Relative Strength Levy" (RLS) to the Scanner and starting
the scan. The new column is added and displays the RLS for each instrument.

EXAMPLE: WATCHLIST WITH INDICATOR

TheWatchlist is intended for realtime data. For example, drag the Momentum
indicator into the table, enter a short trading period and activate the alert function
of the indicator. Now Tradesignal issues an alert any time a value in the Watchlist
triggers a Momentum signal.

APPLYING INDICATORS VIA THE COMMAND LINE

SHORTCODES

All indicators delivered with Tradesignal feature a shortcode. These are part of
the original programming in the Equilla code and should not be changed. Via the
command line, an indicator can be applied to Charts, Scanners, Watchlists, and
Portfolios. This is faster than applying indicators from the toolbox.

The shortcodes can be looked up in the tooltips of indicators in the toolbox. To
display a tooltip, move the mouse over the indicator entry.

EQUILLA CODE

Basically, indicators are constructed so that the calculations are done in
functions. An Equilla function can be entered in the "Equilla Editor" on page 399
as well as the command line. With a bit of practice, it is possible to enter creative
combinations without spending much time on programming. You can find the list
of available Equilla functions in the toolbox by clicking on Functions. Most names
are constructed to make the connections between the indicators and their
functions obvious.

EXAMPLE FOR DIRECTLY ENTERING AN INDICATOR

To apply an RSI (smoothed by an Exponential Moving Average), proceed as
follows:
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01. Open or activate a chart.

02. Enter the following code in the command line

Drawline(XAverage(RSI(Close,14),5))

and select the option Add formula in the drop-down menu.

Tip: You can find more information in the chapter "Command Line" on page 38.

DELETING INDICATORS

DELETING AN INDICATOR FROM THE CHART
There are two ways to delete an indicator from a chart:

à The indicator is displayed in the legend at the top left of the
chart or subchart. Right-click on the entry to open the context
menu and select Delete.

à Alternatively, select the entry in the legend and press the DEL
key.

To delete a complete subchart of an indicator, click on the X button on the top
right. Empty subcharts are closed automatically.

DELETING AN INDICATOR FROM A SCANNER, WATCHLIST OR
PORTFOLIO
To delete an indicator from a table, right-click on the table header and select
Add/Remove Columns.

Alternatively, click on the Columns button and select Add/Remove Columns
from the button menu.

Tip: You can find more information in the chapters "Scanner" on page 71, "Watchlist" on
page 77 and "Portfolio" on page 251.

REMOVING AN INDICATOR FROM TRADESIGNAL
To delete an indicator from the list in Tradesignal, right-click the indicator in the
toolbox and select Delete from the context menu.
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CREATING A NEW INDICATOR

To create a new indicator, click New Indicator in the Related Tasks area of the
toolbox.
AWizard opens, offering two options:

Use the Equilla Formula Language to write the indicator Select this option if you want to
write the indicator yourself.

Tip: You can find more information in chapter "Writing Indicators" on the next page.

Download indicator Select this option if you want to download the indicator from a
Extension Repository.

DOWNLOADING AN INDICATOR FROM A EXTENSION REPOSITORY
Browse the provided indicators and subscribe the indicator you want to use. To see
more information about the indicators itself, please activate Show Synopsis.
After subscribing the indicator you can see the code with a click on Show and the
indicator is available in the toolbox.

If there are updates available, you will get a notification and you can decide,
whether you want to update or not.

Ó EXTENSION BROWSER

EDITING THE EQUILLA CODE OF AN
INDICATOR

à To edit the source code of an
indicator, right-click the indicator in
the chart legend and select Edit
Equilla Code from the context menu.

à Alternatively, right-click the indicator
in the toolbox and select Edit from
the context menu.

The source code is opened in the "Equilla Editor" on page 399.

Tip: You can find more information in the Equilla chapters.

INDICATOR PROPERTIES

The indicator properties are available in the "Mini Toolbar" on page 45 which is
automatically shown when an indicator is selected.
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Each indicator offers various parameters like display units, period, weighting
factors, multipliers etc. Often, values for additional scale units like oversold or
overbought levels are available. Enter all necessary parameters.

For each element in an indicator (i.e. the indicator or its signal lines, graphic
symbols or extrema), display properties can be entered such as line widths,
colors or shadows. You can also define a custom display name within the legend.

For some Tradesignal indicators it is possible to set an alert, which will be created
as soon as a defined condition is met, e.g. for SMA (when the Moving Average
Simple crosses the main data curve). Alerts will be displayed as a flashing icon in
the system tray and as a pop-up window by default. Furthermore, you can find
information about all alerts generated by an indicator in the alert window on the
chart alerts tab.

CHANGING THE EVALUATION ORDER OF INDICATORS AND
STRATEGIES

In some circumstances, indicators and strategies must be evaluated in a specific
order. Normally this is taken care of by Tradesignal, however there are cases
where it is not possible to automatically determine which item should go first. For
example if multiple indicators use the same Global Variables. By default,
indicators and strategies are evaluated in the order they are added to the chart,
watchlist, scanner or portfolio. To change this order

01. Click on Home > Chart > Manage Objects on the toolbar to
show the Manage Objects dialog.

02. Click on the item in the list that needs to be evaluated
differently.

03. Click on theMove Up orMove Down buttons to reposition
the item. Items closer to the top are evaluated earlier.

04. ClickOK to commit the changes.

WRITING INDICATORS
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Ó WRITING AN INDICATOR

In Tradesignal, many indicators are available,
either delivered with the software or offered for
download from the website.

However, wishes may remain unfulfilled or you
may have new ideas that need to be tested. In
these cases, you can always program new
indicators in Tradesignal by using the Equilla
language.

In the following you will find an example showing how to write an indicator using
Equilla. It is only intended to give you a basic introduction. For details on Equilla,
please refer to the Equilla Basics chapters.

PROGRAMMING TRADING BASED ON A RELATIVE STRENGTH
INDEX

CREATING THE INDICATOR

01. In the toolbox, click on the Indicators button.

02. In the Related Tasks area, select New Indicator.

03. In the next dialog, select the option Use the Equilla Formula
Language to write the indicator.

04. Select a folder, e.g. "Tradesignal Files".

05. Type the name "RSI-Bands".

06. Click on Done.

Now you can enter the source code of the indicator in the "Equilla Editor" on
page 399.

ENTERING THE META INFORMATION
In the meta area, global information about the indicator and its display are
entered. These are declared using meta tags.

Meta:
Subchart(false);

DECLARING THE INPUT PARAMETERS
In the input area, parameters are declared that can later be edited and changed
by the user during indicator runtime. In this case, these are mainly a smoothing
factor and the calculation period.
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Inputs:
Period( 20 , 1 ),
Smoothing( 10 , 1 ),
Factor( 1.0 );

DECLARING THE VARIABLES
Variables are data containers in which the values of calculation results are
temporarily saved and therefore available for future use.

Variables:
rsiValue, upperBand, lowerBand, medLine;

PERFORMING THE CALCULATIONS
In this area, the actual calculations are done, whose results are displayed later. In
our example, the continuous regression line is taken as mid-line. With it, the
Relative Strength Index is calculated, which is a measure for the strength and
dynamics of the trend. The actual bands result from simply adding and
subtracting the RSI from the mid-line.

medLine = LinRegValue( Close, Smoothing, 0);
rsiValue = RSI( Close, Period );
upperBand = medLine + ( rsiValue * factor );
lowerBand = medLine - ( rsiValue * factor );

INSERTING THE GRAPH
Finally, the calculation results have to be displayed. This is usually done at the
end of the indicator code.

DrawLine( medLine, "Average", StyleSolid, 1, black);
DrawLine( upperBand, "Upper", StyleSolid, 2, red );
DrawLine( lowerBand, "Lower", StyleSolid, 2, darkgreen );

THE COMPLETE CODE

Meta:
Subchart(false);

Inputs:
Period( 20 , 1 ),
Smoothing( 10 , 1 ),
Factor( 1.0 );

Variables:
rsiValue, upperBand, lowerBand, medLine;
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medLine = LinRegValue( Close, Smoothing, 0);
rsiValue = RSI( Close, Period );
upperBand = medLine + ( rsiValue * factor );
lowerBand = medLine - ( rsiValue * factor );

DrawLine( medLine, "Average", StyleSolid, 1, black);
DrawLine( upperBand, "Upper", StyleSolid, 2, red );
DrawLine( lowerBand, "Lower", StyleSolid, 2, darkgreen );

APPLYING THE INDICATOR
Compile the code either by pressing F7 or by clicking on the button Compile
Script in the Equilla Editor group. The code is checked for errors, saved and then
available in the list of indicators in the toolbox by the name "RSI-Bands".

You can now apply it to a chart as described in "Using Indicators" on page 372, for
example with drag and drop.

USING STRATEGIES
In the traditional sense, trading systems are compilations of rules from which
trading decisions of any kind result.

Tip: You can find more information in the chapter "Using Trading Strategies" on page 227.

One of the important aspects of trading systems is the strategies. Strategies
combine indicators with entry and exit rules.

In Tradesignal, strategies are available which were developed based on material
from various sources (publications, media or in-house development). For all
strategies, additional information on the source, the calculation basis, the
interpretation of results and the appliance is offered.

The strategies in Tradesignal are written in Equilla. You can find more information
in the chapter "Equilla Basics" on page 397.
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APPLYING STRATEGIES

Ó WINDOWVIEW ADD STRATEGY

Applying Strategies to Charts or Indicators

à You can apply a strategy to a chart
by clicking on the Add Strategy
button in the Home > Strategies
group on the toolbar. This opens a
new dialog in which the strategies
are sorted in categories and
synopses are displayed (if the
corresponding option is selected).

à You can also apply a strategy to a chart (or an indicator) from
the strategies list in the toolbox:

01. Open the strategy list in the toolbox by clicking on the
Strategies button.

02. Do one of the following:

à Drag-and-drop the strategy to the chart.

à Double-click on the strategy.

à Right-click on the strategy and choose Apply from the context
menu.

Ó STRATEGY VIEW IN THE TOOLBOX

Application Rules

à The strategy is applied to the active
chart or subchart, except when using
drag and drop.

à By default, strategies are applied to
the top entry in the chart or subchart
legend.

à When you drag the strategy onto a
certain entry in the legend of a chart
or subchart (for example an
indicator), the strategy is applied to this entry.

à Whether a subchart is created for a strategy depends on the
meta tag "subchart" in the Equilla Code of the strategy (see
the chapter Equilla Program Structure and Syntax).

You can see in the legend how to which entry the strategy is applied. It is
constructed as
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Strategy[Var1, Var2...] value {applied to}.

Example:

Chart: DAX P-IN. [.DAX LAST 1 hour]...

Accelerator - Entry [10, 13, 5] {.DAX}

Since a strategy combines indicators with various conditions, more parameters
are possible than for indicators, e.g. for risk control.

EXAMPLE: APPLYING A DMI CROSSOVER SYSTEM TO THE
NASDAQ

OPEN AND EDIT A CHART

01. Enter the shortcut for the US Nasdaq ".NDX.X" in the
"Command Line" on page 38.

02. Select the option New Chart from the drop-down menu.

03. Right-click into the empty area of the chart and select the
Properties from the context menu.

04. Set the History Length to "2500" and press ENTER .

05. Double-click the time axis to display the full history.

SELECT THE STRATEGY

01. Click on the Strategies button in the "Toolbox" on page 49.

02. Search for the two "DMI Cross Over" systems and drag them
into the chart.

Ó MONEYMANAGEMENT (DETAIL)

ENTER SIMPLE RULES FOR RISK
CONTROL

01. Click onMoney Management in the
toolbar.

02. Go to the area Risk in the properties.

03. Set Stop Mode to Contract.

04. Select Stop Loss and enter 75.

05. Select Break Even and enter 50.

06. Select Profit Target and enter 300.

The strategy is now configured.
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APPLYING STRATEGIES TO SCANNER, WATCHLIST OR
PORTFOLIO
You can apply strategies also to symbol tables such as the "Scanner" on page 71,
"Watchlist" on page 77or "Portfolio" on page 251.

à When creating a new Scanner, Watchlist or Portfolio, you can
directly add strategies (and indicators).

à For existing tables, you can add strategies to the selected
table by using one of the methods described above. A new
column is added for the results.

AUTOMATIC APPLICATION OF INDICATORS AND STRATEGIES
By default, the Strategy Equity Portfolio indicator and the Strategy Drawdown
Portfolio indicator are added to a chart with the first strategy. In case of a portfolio,
the Portfolio Leave Exit strategy is added in addition to these two indicators.

This can be customized in the options at File > Options > Advanced > Indicators &
Strategies > Automatically insert the following items when a strategy is added to a
chart and Automatically insert the following items when a strategy is added to a
portfolio, see "Indicators & Strategies" on page 327.

DELETING STRATEGIES

DELETING A STRATEGY FROM THE CHART
There are two ways to delete a strategy from a chart:

à The strategy is displayed in the legend at the top left of the
chart or subchart. Right-click on the entry to open the context
menu and select Delete.

à Alternatively, select the entry in the legend and press the DEL
key.

To delete a complete subchart of a strategy, click on the X button on the top right.
Empty subcharts are closed automatically.

DELETING A STRATEGY FROM A SCANNER, WATCHLIST OR
PORTFOLIO

à To delete a strategy from a table, right-click on the table
header and select Add/Remove Columns.

à Alternatively, click on the Columns button and select
Add/Remove Columns from the button menu.
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Tip: You can find more information in the chapters "Scanner" on page 71, "Watchlist" on
page 77 and "Portfolio" on page 251.

REMOVING A STRATEGY FROM TRADESIGNAL

à To delete a strategy from the list in Tradesignal, right-click the
strategy in the toolbox and select Delete from the context
menu.

CREATING A NEW STRATEGY

Ó STRATEGYWIZARD

To create a new strategy, click on New
Strategy in the Related Tasks area of the
toolbox.
AWizard opens, offering two options:

Use the Equilla Formula Language to write the
strategy Select this option if you want to write
the strategy yourself. You can find more
information in the chapter Writing Strategies.

Use the Trading Strategy Wizard to create the
strategy Select this option to use the Trading Strategy Wizard. It supports you in
creating your own strategies without having to code in Equilla.

Download Strategy Select this option if you want to download a ready-made
strategy from a Extension Repository.

For more information see chapter "Trading Strategy Wizard" on page 228.

DOWNLOADING A STRATEGY FROM A EXTENSION REPOSITORY
Browse the provided strategies and subscribe the strategy you want to use. To see
more information about the strategies itself, please activate Show Synopsis. After
subscribing the strategy you can see the code with a click on Show and the
strategy is available in the toolbox.

If there are updates available, you will get a notification and you can decide,
whether you want to update or not.
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Ó EXTENSION BROWSER

EDITING THE EQUILLA CODE OF A
STRATEGY

à To edit the source code of a strategy,
right-click the strategy in the chart
legend and select Edit Equilla Code
from the context menu.

à Alternatively, right-click the strategy
in the toolbox and select Edit from
the context menu.

The source code is opened in the "Equilla Editor" on page 399.

Tip: You can find more information in the Equilla chapters.

STRATEGY PROPERTIES

The strategy properties are available in the "Mini Toolbar" on page 45.

Each strategy offers various parameters such as display units, period, uplevel,
entry/exit methods etc. Enter all necessary parameters.

You can also edit the display properties of the trading system, e.g. the colors for
long/short entries, price indicators, trade labels etc. You can also define a custom
display name within the legend.

For some Tradesignal strategies it is possible to set an alert, which will be created
as soon as a defined condition is met. "Alerts" on page 329 will be displayed as a
flashing icon in the system tray and as a pop-up window by default. Furthermore,
you can find information about all alerts in the alert window. Added, cancelled or
filled orders will be displayed on the all alerts tab.

Tip: Strategies can be disabled and exempt from evaluation by setting the Active property to
False.

CONTROLLING HOW AND WHEN ORDERS GET FILLED

In addition to the strategy properties, order execution is affected by the global
trading properties located in the "Money Management" on page 236 section. This
section controls how orders get generated and filled, specifies how the slippage
and commission that should be taken into account and defines the standard risk
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stop settings. The following settings directly affect how orders generated in a
strategy get executed:

The Realtime Price Source property controls which prices are used to fill orders
in real time. Tradesignal supports two modes: bid/ask and last.

Bid/Ask Tradesignal uses the best bid / best ask data provided by either the broker
(if an order routing module has been connected) or the data provider. If neither
the broker nor the data provider is delivering bid/ask prices, Tradesignal uses the
last price instead (for example in the case of indices). Best bid and best ask prices
are generated when a market participant wants to buy or sell a number of
shares/contracts while a last price represents an actual trade that has been
made. Therefore this option has the benefit of more accurate fills for your orders.
The caveat is however that the results collected in real time will not match the
results of back-testing which will always only use the last price.

Last Tradesignal uses the last price delivered by the data provider. This is the
same price as the one used to back-test the strategy. A last tick represents a
trade that has been made in the market. When using this mode, Tradesignal can
only fill and order after a trade has been made, even if there was a matching
offer/request in the market prior to the trade. This mode ensures that real time
results are closer to back-test results.

TheGenerate Orders property specifies when orders can be generated by the
running strategies.

Intrabar Orders can be generated with every intra-bar update (for every tick).

On Bar Close Orders can only be generated when the bar closes. This mode is
especially useful when a signal might be invalidated before the bar closes, which
typically happens when the signals are generated based on compressed chart
types like Point and Figure, Renko, Three Line Break and Kagi (these chart types
can all remove bars resulting in trades being executed at prices that may not be
reflected in a bar when it is closed).

PERSISTENCE OF EXECUTED STRATEGY ORDERS

Tradesignal will save all historic trades generated when a strategy is first added to
a chart or subsequently added in real-time until a user-specified action causes
them to be regenerated. This applies to all symbols contained in the respective
workspace regardless of these symbols having been actively traded or not.
However, historic trades will be regenerated any time the configuration, structure
or properties of a chart or its contents change.
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When opening a saved workspace containing historic trades new trades will only
be regenerated from the current bar forward.

Note: The "Order Editor" on page 233 can be used to manually manipulate and/or
regenerate historic trades.

DISABLING RECALCULATION OF HISTORIC ORDERS

Tradesignal provides a way to suspend the recalculation of orders and to
configure which actions will cause an automatic full regeneration of historic
trades. This is helpful in situations where you want to perform backtests with a set
of changed parameters. It allows you to reoptimize (e.g. on a weekly basis)
without recalculating previously generated orders. By default all of the available
actions will trigger a full regeneration of historic trades.

To instruct Tradesignal not to recalculate orders in case certain actions occur,
proceed as follows:

01. Go to File > Options > Advanced > Strategy Orders.

02. Select the events not to trigger automatic recalculation of
orders by unticking the respective check box.

On Insert Symbol If checkbox is ticked, historic orders will be recalculated in case a
symbol is inserted into the chart.

On Insert Indicator If checkbox is ticked, historic orders will be recalculated in case
an indicator is inserted into the chart.

On Insert Strategy If checkbox is ticked, historic orders will be recalculated in case a
strategy is inserted into the chart.

On Replace Symbol If checkbox is ticked, historic orders will be recalculated in case
a symbol is replaced.

On Compile Indicator If checkbox is ticked, historic orders will be recalculated in
case a strategy is compiled.

On Compile Strategy If checkbox is ticked, historic orders will be recalculated in
case a strategy is compiled.

On Symbol Property If checkbox is ticked, historic orders will be recalculated in
case one or more symbol properties have changed.
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On Indicator Property If checkbox is ticked, historic orders will be recalculated in
case one or more indicator properties have changed.

On Strategy Property If checkbox is ticked, historic orders will be recalculated in
case one or more strategy properties have changed.

On Money Management If checkbox is ticked, historic orders will be recalculated in
case one or more money management properties have changed.

On Delete Symbol If checkbox is ticked, historic orders will be recalculated in case a
symbol is deleted.

On Delete Indicator If checkbox is ticked, historic orders will be recalculated in case
an indicator is deleted.

On Delete Strategy If checkbox is ticked, historic orders will be recalculated in case
a strategy is deleted.

On Evaluation Order Changed If checkbox is ticked, historic orders will be
recalculated in case of a changed evaluation order.

On Symbol Lotsize Change If checkbox is ticked, historic orders will be recalculated
in case of a changed symbol lotsize.

On Rollover of rolling, non-continuous contract If checkbox is ticked, historic orders
will be recalculated in case of a rollover of rolling, non-continuous contract.

Generate orders from the last save point, when a workspace is opened. If checkbox is
ticked, historic orders will be recalculated from the last save point on, when the
workspace is opened again.

Note: By default all of the available actions will trigger a full regeneration of historic trades.

EDITING AND DELETING STORED ORDERS

The "Order Editor" on page 233 allows you to modify stored orders.

To open the Order Editor, proceed as follows:

01. Open a chart.

02. Switch to the Insert tab on the main ribbon.

03. Under Trading, click the buttonOrder Editor.

The Order Editor opens.
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Note: For more information on how to modify stored orders see chapter "Order Editor" on
page 233.

WRITING STRATEGIES

Ó WRITING A STRATEGY

In Tradesignal, many strategies are available,
either delivered with the software or offered for
download from the website.

However, wishes may remain unfulfilled or you
may have new ideas that need to be tested.
You can always use the "Trading Strategy
Wizard" on page 228 to design a new strategy.
You can also program new strategies (or edit
available ones) in Tradesignal by using the Equilla language.

In the following you will find an example showing how to write a strategy using
Equilla. It is only intended to give you a basic introduction. For details on Equilla,
please refer to articles in the Equilla Basics category.

PROGRAMMING A BOLLINGER BAND - RSI SYSTEM

Writing a new strategy

The strategy calculates the Relative Strength Index for an instrument. Based on
these values, Bollinger Bands are then constructed. The crossings between the
RSI and the Bollinger Bands are used as trading signals. In addition, Stop Loss
and Trailing Stop are calculated. The idea behind this setup is to substitute the
static extremes of the Relative Strength Index with more flexible zones that adapt
to the movements of the indicator.

CREATING THE STRATEGY

01. In the toolbox, click on the Strategies button.

02. In the Related Tasks area, select New Strategy.

03. In the next dialog, select the option Use the Equilla Formula
Language to write the strategy.

04. Select a folder, e.g. Tradesignal Files.
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05. Type the name Bollinger-RSI-Bands.

06. Click on Done.

Now you can enter the source code of the strategy in the "Equilla Editor" on
page 399. The areas are described in the following sections. The complete code
can be found at the end of this article.

ENTERING THE HEADER
In the header area, the input parameters of the used indicators and necessary
variables are declared. In addition, we enter the meta information for the subchart
creation.

//Creating a subchart
Meta:

SubChart( true );

//Defining the input parameters for the indicators
Inputs:

PeriodAvg( 20 , 1 ),
PeriodStd( 10 , 1 ),
FactorStd( 2.0 , 0.0 ),
PeriodRSI( 14 , 1 ),
PeriodATR( 10, 1 ),
FactorAtr( 1.5, 0.0 ),
PeriodTrail( 20 , 1 ),
TradeMode( outsideIn, insideOut );

//Declaring the variables that we need for storing calculation results
Variables:

avgValue, upperBand, lowerBand, rsiValue, stdValue, atrValue,
stopValue, trailValue, activeStop;

PROGRAMMING THE CALCULATIONS FOR THE INDICATORS AND
STOPS
In this part, the indicator calculations are entered. For most of them, we will use
available Equilla Functions. However, a new calculation is written for the Bollinger
Bands, as we want to use the RSI as their basis.

//Calculating the RSI
rsiValue = RSI( Close, PeriodRSI );
//Calculating the Bollinger Bands constituents (based on the RSI)
avgValue = Average( rsiValue, PeriodAvg );
stdValue = StdDeviation( rsiValue, PeriodStd );
//The upper band is calculated with the average and the added standard
deviation
upperBand = avgValue + ( FactorStd * stdValue );
//The lower band is calculated with the average and the subtracted standard
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deviation
lowerBand = avgValue - ( FactorStd * stdValue );

//Calculating the Average True Range for the Stop Loss
atrValue = Average( TrueRange, PeriodAtr );
//Calculation the Average as Trailing Stop
trailValue = XAverage( Close, PeriodTrail );

DEFINING TRADING CONDITIONS AND PROGRAMMING ORDER
GENERATION
In this part, the conditions for trading signals are defined and the orders are
generated. Two modes are defined:

à The mode outsideIn is designed so that the RSI has to cut
the Bollinger Bands from outside in for signal generation. This
mode is preferable for correction movements.

à The mode insideOut is designed so that the RSI has to cut
the Bollinger Bands from inside out, i.e. in trend direction. This
mode is optimal for strong trends.

//Setting the trading conditions
//Signals are generated when the RSI crosses the bands from outside in
If TradeMode = 0 Then

Begin
//Sale when the RSI crosses the lower band from outside in.
If rsiValue crosses over lowerBand Then

Begin
Buy("LongIn") Next Bar at Market;
//Calculating the price for the Stop Loss
stopValue = Close - ( FactorAtr * atrValue );

End;

//Short sale when the RSI crosses the upper band from outside in.
If rsiValue crosses under upperBand Then

Begin
Short("ShortIn") Next Bar at Market;
//Calculating the price for the Stop Loss
stopValue = Close + ( FactorAtr * atrValue );

End;
End

Else
//Signals are generated when the RSI crosses the bands from inside out
Begin

//Sale when the RSI crosses the lower band from inside out.
If rsiValue crosses over upperBand Then

Begin
Buy("LongOut") Next Bar at Market;
//Calculating the price for the Stop Loss
stopValue = Close - ( FactorAtr * atrValue );
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End;
//Short sale when the RSI crosses the upper band from inside out.
If rsiValue crosses under lowerBand Then

Begin
Short("ShortOut") Next Bar at Market;
//Calculating the price for the Stop Loss
stopValue = Close + ( FactorAtr * atrValue );

End;
End;

HANDLING OF THE STOP LOSS PRICES
For the Stop Loss, the Average True Range (ATR) is calculated. The value for the
initial stop results from the ATRmultiplied with a factor. As Trailing Stop, the
Exponential Moving Average based on the instrument is calculated. If the price
cuts this average inverse to the trade, the trade is closed. The program uses both
stop values and compares which one is better positioned and more protective of
the trade. That value is finally output as a stop order for the next trading period.

/* Here the handling of stop values is done: For long positions: The stop
loss is valid as long as the trailing stop is below it. For short positions:
The stop loss is valid as long as the trailing stop is above it. */

//Recognizing long positions
If MarketPosition = MarketPositionLong Then

Begin
//If the stop loss is better positioned than the trailing stop
//the stop loss is set
If ( stopValue > trailValue ) Then

Sell("Stop Loss") Next Bar at stopValue Stop;
//If the trailing stop is better positioned than the stop loss
//the trailing stop is set
If ( trailValue > stopValue ) And ( trailValue < Close ) Then

Sell("Trail") Next Bar at trailValue Stop;
End;

//Recognizing short positions
If MarketPosition = MarketPositionShort Then

Begin
//If the stop loss is better positioned than the trailing stop
//the stop loss is set
If ( stopValue < trailValue ) Then

Cover("Stop Loss") Next Bar at stopValue Stop;
//If the trailing stop is better positioned than the stop loss
//the trailing stop is set
If ( trailValue < stopValue ) And ( trailValue > Close ) Then

Cover("Trail") Next Bar at trailValue Stop;
End;
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DISPLAYING THE INDICATORS IN SUBCHARTS
This is the easiest part. Only the indicators that are used for signal generation are
displayed here.

//Graphic display of indicators
DrawLine( rsiValue, "RSI", StyleSolid, 1, blue );
DrawLIne( upperBand, "Upper Band", StyleSolid, 1, darkGreen );
DrawLIne( lowerBand, "Lower Band", StyleSolid, 1, red );

APPLYING THE STRATEGY
Compile the code either by pressing F7 or by clicking on the button Compile
Script in the Equilla Editor group. The code is checked for errors, saved and then
available in the list of strategies in the toolbox by the name "Bollinger-RSI-
Bands".

You can now apply it to a chart it as described in "Using Strategies" on page 381,
for example with drag and drop.

THE COMPLETE CODE

//Creating a subchart
Meta:

SubChart( true );

//Defining the input parameters for the indicators
Inputs:

PeriodAvg( 20 , 1 ),
PeriodStd( 10 , 1 ),
FactorStd( 2.0 , 0.0 ),
PeriodRSI( 14 , 1 ),
PeriodATR( 10, 1 ),
FactorAtr( 1.5, 0.0 ),
PeriodTrail( 20 , 1 ),
TradeMode( outsideIn, insideOut );

//Declaring the variables that we need for storing calculation results
Variables:

avgValue, upperBand, lowerBand, rsiValue, stdValue, atrValue,
stopValue, trailValue, activeStop;

//Calculating the RSI
rsiValue = RSI( Close, PeriodRSI );
//Calculating the Bollinger Bands constituents (based on the RSI)
avgValue = Average( rsiValue, PeriodAvg );
stdValue = StdDeviation( rsiValue, PeriodStd );
//The upper band is calculated with the average and the added standard
deviation
upperBand = avgValue + ( FactorStd * stdValue );
//The lower band is calculated with the average and the subtracted standard

394



deviation
lowerBand = avgValue - ( FactorStd * stdValue );

//Calculating the Average True Range for the Stop Loss
atrValue = Average( TrueRange, PeriodAtr );
//Calculation the Average as Trailing Stop
trailValue = XAverage( Close, PeriodTrail );

//Setting the trading conditions
//Signals are generated when RSI crosses the bands from outside in
If TradeMode = 0 Then

Begin
//Sale when the RSI crosses the lower band from outside in.
If rsiValue crosses over lowerBand Then

Begin
Buy("LongIn") Next Bar at Market;
//Calculating the price for the Stop Loss
stopValue = Close - ( FactorAtr * atrValue );

End;

//Short sale when the RSI crosses the upper band from outside in.
If rsiValue crosses under upperBand Then

Begin
Short("ShortIn") Next Bar at Market;
//Calculating the price for the Stop Loss
stopValue = Close + ( FactorAtr * atrValue );

End;
End

Else
//Signals are generated when RSI crosses the bands from inside out

Begin
//Sale when the RSI crosses the upper band from inside out.
If rsiValue crosses over upperBand Then

Begin
Buy("LongOut") Next Bar at Market;
//Calculating the price for the Stop Loss
stopValue = Close - ( FactorAtr * atrValue );

End;
//Short sale when the RSI crosses the lower band from inside out.
If rsiValue crosses under lowerBand Then

Begin
Short("ShortOut") Next Bar at Market;
//Calculating the price for the Stop Loss
stopValue = Close + ( FactorAtr * atrValue );

End;
End;

/* Here the handling of stop values is done: For long positions: The stop
loss is valid as long as the trailing stop is below it. For short positions:
The stop loss is valid as long as the trailing stop is above it. */

//Recognizing long positions
If MarketPosition = MarketPositionLong Then

Begin
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//If the stop loss is better positioned than the trailing stop
//the stop loss is set
If ( stopValue > trailValue ) Then

Sell("Stop Loss") Next Bar at stopValue Stop;
//If the trailing stop is better positioned than the stop loss
//the trailing stop is set
If ( trailValue > stopValue ) And ( trailValue < Close ) Then

Sell("Trail") Next Bar at trailValue Stop;
End;

//Recognizing short positions
If MarketPosition = MarketPositionShort Then

Begin
//If the stop loss is better positioned than the trailing stop
//the stop loss is set
If ( stopValue < trailValue ) Then

Cover("Stop Loss") Next Bar at stopValue Stop;
//If the trailing stop is better positioned than the stop loss
//the trailing stop is set
If ( trailValue < stopValue ) And ( trailValue > Close ) Then

Cover("Trail") Next Bar at trailValue Stop;
End;

//Graphic display of indicators
DrawLine( rsiValue, "RSI", StyleSolid, 1, blue );
DrawLIne( upperBand, "Upper Band", StyleSolid, 1, darkGreen );
DrawLIne( lowerBand, "Lower Band", StyleSolid, 1, red );
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WORKING WITH EQUILLA

EQUILLA BASICS
With the programming language Equilla, Tradesignal offers you an easy to learn
but powerful programming language. With its help, you can easily perform even
complex tasks.

Equilla resembles programming languages like Pascal or Visual Basic. All
functions, indicators and strategies in Tradesignal are written in Equilla. (For the
relationship between these three, see the chapter "Introduction to Functions,
Indicators and Strategies" on page 369).

The special benefits of Equilla are the extensions for the trading business. They
allow you to translate your ideas about finance and analyses into executable
routines. This way, you can write your own strategies, indicators or other
applications for the various software components of Tradesignal. Equilla helps
you to solve your individual problems, to test new trading ideas and to work
outside the box of externally defined, inflexible procedures.

To quickly get accustomed to Equilla, we recommend familiarity with a
programming language. However, you can also learn to tap the potential of
Equilla by analyzing and editing available Equilla code (e.g. customizing an
indicator).

Equilla scripts are edited in the Equilla Editor, which supports you with color-
coding of the Equilla source code. In the editor, you can also retrieve detailed
information for Equilla functions via the context menu.

The Equilla chapters in this help are intended to be more of an introduction to the
various topics. For an extensive documentation of all features, please refer to
Tradesignal help under the menu entry Equilla Formula Language.

SEQUENCE OF EVENTS WHEN COMPILING EQUILLA CODE

When compiling Equilla code into an executable Equilla program, it is important to
remember that all Equilla scripts are saved in packages. The compilation
sequence partly depends on the sequence of these packages, which you can
change in the "Package and File Management" on page 334.
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CALLING UP FUNCTIONS FROM INDICATORS/STRATEGIES
For indicators and strategies, functions are called up by their name (without
information about their package). Tradesignal searches for the function in the
following sequence:

01. in the same package as the indicator/strategy

02. in all packages, in the sequence given in the "Package and
File Management" on page 334

As soon as a function with the correct name is found, the search ends and this
function is used.

Therefore, if you move indicators/strategies to another package, it may give
different results if another function is used due to the changed package
sequence.

Exporting packages can also lead to problems, if packages exchanged with other
users use functions from another package. If the user has no function with the
same name, the script will not compile; if the user has another or older version,
the results for the users may differ.

CALLING UP INDICATORS/STRATEGIES FROM SAVED
DOCUMENTS
When saving a chart, scanner, watchlist or portfolio, not only all settings but also
all applied indicators and strategies (including their respective package names)
are saved.

When the documents are opened again, Tradesignal checks whether a newer
version of the indicator/strategy is available, and will use that one if possible.
Tradesignal searches in the following sequence:

01. in the packages as given in the saved document

02. in all packages, in the sequence given in the "Package
Management in the Tradesignal Options" on page 337

If no newer version is to be found, the indicator/strategy as saved in the document
is used.
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EQUILLA EDITOR

Ó EQUILLA EDITOR

For writing and editing scripts written in the
Equilla language (which is in-built in
Tradesignal), an Equilla editor is available. It
supports programming by highlighting code
areas and comments in different colors.

OPENING THE EQUILLA EDITOR

You can open the Equilla editor in two ways:

à The editor opens when you edit a function, indicator or
strategy. To do so, open the respective list (functions,
indicators or strategies) in the toolbox. Then call up an entry
for editing by either double-clicking on it or by selecting Edit
Equilla Source Code from the context menu. The Equilla
editor opens with the source code of the script.

à To open an empty editor, you have to start a new script. To do
so, select New Indicator / New Strategy / New Function in the
Related Task area in the toolbox (available entry depends on
the currently opened area). A window opens. Enter a name
and select a location for saving. Finish withOK.
An empty editor opens.

COLOR CODING IN THE EDITOR

The source code is color-coded. The following colors are possible:

Blue Signal words in the code (begin, end), declaration areas (meta, variables...),
input types, commands (if then...), formatting (StyleSolid...), drawing commands
(DrawText...).

Red Content of synopsis, numeric values (e.g. close or true numbers like 1, 10,
30), true/false.

For blue and bold red Equilla expressions, you can find additional information in
Tradesignal. To display it, right-click on the operator in question in the Equilla
Editor, e.g. Begin, and choose Lookup Keyword from the context menu. A browser
window opens with information on the operators and links to related functions.

Lilac Names of other functions.
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You can open these functions in the Equilla Editor. To do so, right-click on the
function and chooseOpen from the context menu. The source code is opened in
the Equilla Editor.

Green Comments

Black Anything else, like text, declared variables etc.

EDITING THE EQUILLA CODE

Ó TEXT EDITOR GROUP

When the Equilla editor is open, the Editor tab
appears in the toolbar, with the following
buttons:

Compile (F7) Use this to compile the script. Only
compiled scripts can be used. Uncompiled
scripts are grayed out in the toolbox. In case of script errors, error descriptions will
be given in the lower area of the workspace. For delivered scripts, compiling may
lead to error messages if the scripts are protected against overwriting.

Undo (Ctrl+Z) Undo the last action (multiple undoes possible, but none after
compiling). This way, you can undo an unintended deletion, for example.

Redo (Ctrl+Shift+Z) Repeat the last action (multiple repeats possible, but none after
compiling). This way, you can insert a copied text multiple times, for example.

Select All (Ctrl+A) Selects all code. You can use the standard Windows key
commands to copy the code with "Ctrl+C" and then paste with "Ctrl+V", e.g. into a
text editor.

Toggle Comments Toggle the selected line(s) between being a comment (leading
//) or not. The button is only active for scripts that can be edited (i.e. not for
delivered scripts).

Find All References Find all other uses of a user function in all Equilla scripts know
to the application. For this button to be active, place the mouse on a user function
in the Equilla editor or debugger, e.g. "Momentum" in the Momentum indicator,
and then click the button. A list of all findings will be displayed in the output
window. In case of "Momentum", this amounts to "182 use(s)", while a function
like "ADO" has only 6 findings. Double-click on a finding to open the referenced
script. The action searches all of the script, code as well as comments, so there
can be more than one finding for a script.
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Tip: To open only the function itself, right-click on the function and choose Open in New
Editor from the context menu.

Browser Mode Toggle between HTML edit mode and the browser mode.

SEARCH AND REPLACE
To edit the code, the Find group in the toolbar is available.

à Click on Find to enter a search term in the search pane.

à With Replace you can replace one or all appearances of a code
text with another text. The button is only active for scripts that
can be edited.

à For long scripts, you can use Goto Line to jump to a code line.

ADDING SYMBOLS
Symbols can added into the Equilla script via drag-and-drop from the symbol list
or via typing in the symbol name.

APPLYING YOUR EQUILLA SCRIPT

Scripts can only be applied once they have been compiled. After that, the new
script can be used like any delivered function, indicator or strategy. You can find
more information in the chapter "Introduction to Functions, Indicators and
Strategies" on page 369.

EQUILLA DEBUGGER

Ó DEBUGGER

The Equilla debugger can be used to find and
resolve problems in your Equilla scripts. It
allows you to stop execution of your scripts,
step through your source code and examine
the state of variables used in your code.

CREATING A DEBUGGER
DOCUMENT

To create a new debugger document, select
the Insert group on the Toolbar and click on the
Debugger button.After clicking on the
Debugger debugger, a dialog will be displayed
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asking you which document you would like to debug. The dialog shows a list of all
open desktops, workspaces and documents and presents the following options:

Skip Do not attach to a document yet. This is typically used if the document you
want to debug isn’t open yet. You may execute the debuggers Attach command
from the ribbon as soon as the document you want to debug is ready to be used.

Attach Attaches the new debugger to the selected document.

Cancel Abort the operation and do no create a new debugger document.

Note: A debugger can only debug one document at a time and only one debugger can be
attached to a specific document. You may create multiple debuggers simultaneously and
attached each of them to a separate document.

Note: In order to be able to debug an indicator or strategy it has to be compiled using
Tradesignal 7.0 or higher. Equilla scripts that have been compiled with earlier versions of
Tradesignal will not show up in the debugger document.

Note: Only chart documents can be debugged.

THE DEBUGGER DOCUMENT

The debugger document enables you to debug your Equilla scripts. It consists of
the following components:

Scripts The debugger loads all scripts that are referenced in the debugged
document.

Watch windows A set of watch windows that help you inspect the state of your
indicator or strategy. There are three predefined windows, showing common
information and one window where you can enter debug expressions on your
own.

Call Stack Shows the nesting level of your scripts while debugging.

Breakpoints Shows a list of all breakpoints that have been set up.

Objects Provides a list of all Equilla indicators and strategies that are contained in
the debugged document. You may enable or disable the debugging of specific
objects as you need.
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SCRIPTS
Every script referenced in the debugged document will be loaded automatically.
Here you can inspect the source code, add or manipulate breakpoints or examine
the state of variables as you need.

The debugger editor has all the same functionality as the normal "Equilla Editor"
on page 399.

To add a breakpoint, click on the left margin of the editor, select the Toggle
Breakpoint command from the ribbon or use the corresponding context menu
entry.

While the execution is paused, you can examine the state of variables or evaluate
Equilla expression by hovering over the corresponding text with your mouse. To
evaluate an Equilla expression containing space characters, you have to select
the whole expression in the editor before hovering over it.

Note: If a script has been changed since the indicator or strategy has been compiled, the
scripts tab will show a corresponding image. Please be aware that breakpoints and variables
may behave unexpected in such a case.

If the evaluation is paused, the source code line that is about to be evaluated will
be highlighted in the source code editor. Additionally the margin will show an
arrow icon on the corresponding line.

WATCH WINDOWS
The Equilla debugger provides a quick way to check the state of the document as
a whole or of specific elements in it.

Virtual Machine This is a predefined view and cannot be modified. It shows
information of all elements within the virtual machine. This includes all the
indicator and strategies that have been created as well as the instruments that
are used to evaluate your scripts.

This This is a predefined view and cannot be modified. It provides access to the
state of the currently debugged indicator or strategy. This includes general
properties as well as the referenced parents and generated output data. You may
also get access to child objects that have been applied to this indicator or
strategy.

Locals This is a predefined view and cannot be modified. This view provides
access to all variables that are used in the currently debugged indicator, strategy
or Equilla function. While stepping through your code, this view will be updated
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automatically to show only the variables that are relevant for the script that is
about to be evaluated.

Watch Use this view to track specific variables or Equilla expressions. The list of
expressions will not change automatically while stepping through your code. To
add an expression, simply type it into the list or use drag-and-drop to copy an
expression from the source code editor or another watch window. The Quick
Watch is an alternative to this view when the information for the inspected object
or variable does not fit into the available space.

CALL STACK
The call stack shows the currently evaluated script and line number. The currently
evaluated script is displayed on the top and the indicator or strategy script is
displayed at the bottom.

For Equilla functions, the passed parameters will be displayed as well. Please be
aware that the same limitations as for the evaluation of debug expression apply.
Therefore the list of parameters might not be complete.

To navigate through the call stack, simple double click on an entry in the list.

BREAKPOINTS
This view shows a list of all the breakpoints that have been set up for a debugger.
The displayed information includes the script file and line number, the breakpoint
belongs to, as well as information about the state, conditions and the action that
should be taken when the breakpoint is hit.

State

The breakpoint is valid and enabled.

The breakpoint is valid, but currently disabled.

The breakpoint cannot be mapped to any executable code.

To modify an existing breakpoint, either enable or disable it using the check box
at the front of the entry or right click on an entry to show up a context menu.The
context menu provides access to the following commands:

Enable/Disable breakpoint - Enable or disable the selected breakpoint

Remove Breakpoint - Delete the selected breakpoint

Goto - Go to the source code line the breakpoint is attached to.

Properties - Modify the breakpoint condition and action.
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BREAKPOINT PROPERTIES
Every breakpoint supports a range of properties to control its behavior. To
examine or modify these properties, right click on a breakpoint and select
Properties from the context menu.

Breakpoints can be configured to only pause evaluation under a certain condition.
To make a breakpoint conditional, check the Active the breakpoint based on
the following condition option. Type the condition as Equilla code in the
corresponding editor and specify how to interpret the condition.

Beside conditions, you can also specify what to do when the break point is hit.
The default behavior is to pause evaluation, but you can also specify that the
debugger should simply print a message to the output window. Available options
are:

Break Pauses the evaluation when the breakpoint is hit. This is the default
behavior.

Print a message on historic bars Prints the specified message when the breakpoint
is hit while evaluating historic bars.

Print a message on real-time bars Prints the specified message when the breakpoint
is hit while evaluating real-time bars.

Print a message on every bar Always prints the specified message when the
breakpoint is hit.

Continue execution Specifies if the debugger should continue execution when the
breakpoint is hit or if the evaluation should be paused as it is done for standard
breakpoints.

BREAKING ON RUNTIME ERRORS
By default, if a runtime error occurs, the debugger will automatically break on the
instruction that caused the error. This allows the developer to identify exactly
what went wrong, without having to manually set breakpoints to stop just before
the error.

This feature may be enabled or disabled in the property inspector, using the
Break on Runtime Error property.

In the case that runtime errors are disabled in a Equilla Script, the break point will
still be triggered, although the execution can then be resumed afterwards.
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OBJECTS
The objects view shows what objects are available for debugging. It also enables
you to filter what items should be debugged.

To enable or disable debugging for an object, simply set or clear the check box in
front of it.

Use the context menu to toggle between these two modes.

DEBUGGER COMMANDS

The debugger document supports the following commands:

DEBUG GROUP
Break Pauses the execution when the next evaluation starts. Please be aware that
some new data has to arrive in order to trigger an evaluation. If the market is
closed, the debugger will pause with the next tick that arrives.

Continue Continues evaluation when the evaluation is paused.

Restart Restarts the evaluation of the complete chart. All scripts will be
reevaluated starting with bar 1.

Step In Steps into an Equilla script function, entering the next level in the call stack.
If the next instruction is not an Equilla script function, this command acts like the
Step Over command.

Step Over Steps over the next line.

Step Out Steps out of the current Equilla script, going back one level in the call
stack.

Quick Watch Shows the quick watch dialog that can be used to evaluate Equilla
expressions or inspect the state of variables and objects.

Attach Attaches the debugger to a document.

Detach Detaches the debugger from the currently debugged document.

BREAKPOINTS GROUP
Toggle Breakpoint Adds a new or removes an existing breakpoint.

Enable/Disable Enables or disables an existing breakpoint.

Remove Breakpoint Removes an existing breakpoint.
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PROPERTIES

The general properties are available via "Settings" on page 157 in the home tab.

Trace Order State Changes (Historic) Enables or disables the tracing of order state
changes while evaluating historic data. The default value is false.

Trace Order State Changes (Real-time) Enables or disables the tracing of order state
changes while evaluating real-time bars. The default value is false.

Break on Runtime Error Enables or disables if the execution of the Equilla script
should be paused automatically if a runtime error occurs.

QUICK WATCH

The Quick Watch can be used to inspect the state of variables and object and to
evaluate Equilla expressions.

While providing the same functionality as the Watch view it allows the resizing of
the output area without affecting the general layout of the debugger document.
Therefor it can be used to quickly inspect the state of a variable or object even if
the information does not fit into the space available for the Watch view.

DEBUG EXPRESSIONS

The Equilla debugger supports a wide range of debug expressions that can be
evaluated in theWatch view or the Quick Watch dialog. This includes some
predefined expressions that provide information about the debugged document
or the currently debugged object.

PREDEFINED EXPRESSIONS
VM This expression provides access to the state of the debugged document. This
includes settings, references to all instruments used in the document as well as
all elements in the chart, like instruments, indicators, strategies and tools. When
debugging strategies it also provides information about positions, orders and
statistics.

This This expression provides access to the state of the currently debugged
object. This includes parent objects and input instruments, as well as, error
information, generated output data and trading related data.

EQUILLA EXPRESSIONS
In addition to the predefined debug expressions, you can evaluate standard
Equilla code and evaluate it in the debugger. While you can use all build-in Equilla
functions, you cannot use any Equilla script function.
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Valid examples, using only build-in functions or standard operators:

Sum(close, 10) / 10

(Close[1] + Close) / 2

Invalid example, using a script function rather than a build in function:

Average(Close, 10)

Please be aware that some variable might not be available in the debugger. This
is caused by code optimizations that are applied to the source code when
compiling it. This may result in variables being removed or replaced in order to
save resources and increase the evaluation speed. Additionally the compiler may
reorder the instructions in its optimization phase, leading to unexpected jumps
while stepping through the code.

CHART

Ó DEBUGGED CHART

When attaching a debugger to a chart
document, the chart will display a
corresponding hint below the standard legend.

EQUILLA PROGRAM STRUCTURE AND SYNTAX

META TAGS

The so-called meta properties define the global functions of your indicator, for
example if the indicator should be displayed in a window of its own or within
another chart. You can also add information about how the indicator is calculated
(Synopsis) and define a ShortCode. The meta information area can usually be
found in the beginning of the source code. You should adhere to this convention.
The area has to be introduced with the tag

Meta:

The three most important pieces of meta information are:
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Meta:

//Description for the code
Synopsis( " Text " ),
//Define whether the indicator will be displayed in a separate sub-chart

or not
Subchart(True/False),
//Define a ShortCode. By entering it in the command linethe indicator is

called up.
ShortCode("MyIndicator");

INPUT DECLARATION

When applying an indicator to a chart, one or more parameters are available in
the indicator properties. These parameters can be calculation periods,
multiplications or lists. User-specific parameters have to be declared in the input
area of the source code. The area has to be introduced with the tag

Inputs:

AVAILABLE INPUT TYPES

Inputs:
//Switch for true/false /yes/no) choice.
Visuals (true, false),

//Input field for integers, followed by lower and upper
//end of range.
Period(10, 1, 100),

//Input field for decimal value; note that the
//decimal point of the defining criterion.
FactorOffSet( 1.25, 1.0, 5.0 ),

//Input field for string; note that
//the quotation marks are the defining criterion.
UserName( "John Smith" ),

//Input field for colors; the dialog is system-dependent.
//The dialog generation also works for colors entered as
//RGB values ( redValue, greenValue, blueValue ).
//The values for redValue, greenValue und blueValue have to be between
//0 and 255.
PreferredColor( red ),

//Generates a selection list for time lines. The list automatically
//includes all time lines for the basic symbol. Usually, these are the
//Open, High, Low, Close and Volume data.
PriceValue( Close ),
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//Generates a selection list for the given words or strings.
//The list is zero-based.
Weekdays( Monday, Tuesday, Wednesday, Thursday, Friday, Saturday, Sunday

);

Examples for Using the Input Types

//Example for querying a true/false (yes/no) boolean switch
//When the switch is set to true (yes), a line is drawn:
If Visuals = True Then

DrawLine ( (High+Low)/2);

//Example for using an integer input
//The parameter 'Period' is declared as input, the given
//value 10 for the period is passed to the average function.
avgValue = Average( Close, Period );
Drawline( avgValue );

//Example for using a decimal number
//The drawing function draws a continuous line which
//corresponds to the value 'close * 1.25'.
DrawLine( FactorOffSet * Close );

//Example for using a string input
//In the output window, 'John Smith' is displayed.
Print( "UserName" );

//Example for using a color value as input
//A red, solid line is drawn.
DrawLine( Close, "Close Line", StyleSolid, 2, PreferredColor );

//Example for using a time line input
//A line is drawn on the level of the close prices.
DrawLine( PriceValue );

//Example for querying the selected entry in a list
//In the output window, 'Monday' appears when selected.
If Weekdays = "Monday" Then

Print( "Monday" );

//In lists, index numbers are assigned to the entries.
//As already mentioned, lists are zero-based, so Monday is "0" and Sunday is
"6".
//Instead of querying the string, the index number can be used instead.
If Weekdays = 0 Then

Print( "Monday" );
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VARIABLE DECLARATION

WHAT ARE VARIABLES?
Variables are data containers. To be able to use values like numbers, calculation
results, user entries or prices, the values have to be saved temporarily in
variables. This way, each value has its own storage space and can be called up
by the variable name. Imagine variable to be like containers on a cargo ship. Each
container has its own unique ID, with which to find the contents. When the booker
needs to know the information in a container, he enters the unique ID into a
computer, which returns the wanted information.

VALIDITY OF VARIABLES
Variables are only valid within the script in a chart. It is not possible to use the
value of variable "Period1" of the indicator "Indicator1" in "Indicator2", since the
second script has no access to the variable - not even when both indicators are
used in the same chart.

The only exceptions to the rule are global variables.

INITIALIZATION OF VARIABLES, AND FOR HOW LONG DO THEY
KEEP THEIR VALUE?
Each Equilla script, e.g. an indicator, is processed once for each trading period. If
the indicator is used in a daily chart, the indicator is calculated once for each day
in the chart. The variable is initialized at the first trading day in the chart.

If in the days following that, no new value is set for the variable, the value is kept
until the last trading day in the chart. If a new value is set for the variable in
between, it is kept until a new value is assigned or until the last trading day.

GENERATING VARIABLES
Variables are generated by being declared, i.e. given a name. Variables can only
be defined within a certain code area. It has to be introduced with the tag

Variables:

You have the following possible methods to declare a variable:

//Declare a variable by assigning a name
Variables:

myFirstVariable, mySecondVariable;

//Declare a variable by assigning a name and value
Variables:
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myFirstVariable( 10 ), mySecondVariable( myFirstVariable / 2 );

//Declare a variable by entering a string
Variables:

myFirstString ( "" ), mySecondString( "String test" );

//Declare a variable with color values
Variables:

myFirstColor( red ), mySecondColor( RGB (10, 20, 30) );

GLOBAL (SCRIPT-INDEPENDENT) VARIABLES
As opposed to the statement above, you can use global variables under special
circumstances. The limitation is that the scripts have to be in the same chart or
portfolio. A sub chart, for example an indicator chart, does not count as a full
chart. Therefore, you can pass data between main and sub charts and between
several Equilla scripts that are used within the same main/sub charts.

To do so, global variables are available. A global variable consists of a
"Namespace", which can be seen as the name of the cargo ship, and a variable
name, which can be seen as the container ID. Since global variables are valid
across several scripts, they do not have to be defined in the "Variables:" area. It is
enough to name the global variable in one script and assign a value this way.

//This is the way to set up a global variable
//The global variable with the Namespace 'global' and the name
//'myFirstGlobalVar' is generated by assigning a value.
//From this moment on, the value can be used in all
//scripts in the same chart.
global::myFirstGlobalVar = 100;

//This is the way to read the value of a global variable.
//In the output window, '100' is displayed.
Variables:

myNewVar;

myNewVar = global::myFirstGlobalVar ;
Print( myNewVar );

DECLARATION DETAIL FOR VARIABLES AND INPUTS

For variables as well as inputs, you can either enter several declarations in one
line or each declaration in its own line. The declarations have to be separated by
commas. After the last declaration, a semi-colon has to be entered.

//Declare inputs in one line
Inputs:

MyName( "Caspar David" ), YourName( "Peter King" ), HerName ( "Barbara
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Myers" );

//Declare inputs in several lines
Inputs:

MyName( "Caspar David" ),
YourName( "Peter King" ),
HerName ( "Barbara Myers" );

STRUCTURING SOURCE CODE

For a better readability and overview in the Equilla code, the source code should
be well-structured. This also makes it easier to find errors in the coding. For
structuring, make use of indentions, comments and empty lines. Declare the
variables and inputs in separate lines instead of one line.

INDENTING SOURCE CODE
It is a standard programming technique to indent certain parts of the code by
using the Tab key. This way it is much easier to understand the relations between
code parts. This is especially useful in cases of loops or conditions.

//Indenting the code that is only run if the condition is met
If Bronto = "Saurus" Then

DrawText( Close, "Run away!" );

//Cascading indenting of code to keep a better overview
If condition = "met" Then

Begin
myFirstVar = 100;
mySecondVar = 7;
DrawLine( myFirstVar + mySecondVar );

End;

//Each consecutive condition should also be indented
If condition = "met" Then

Begin
myFirstVar = 100;
mySecondVar = 7;
//additional condition
if Visuals = True Then

DrawLine( myFirstVar + mySecondVar );
End;

BRACKETING EXPRESSIONS
It is also recommended that you use bracketing for conditional queries or loops.
This way, you avoid overly complicated code and malfunctioning which may
result from logical errors.
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//Expressions in queries should be bracketed for two reasons
//a) For better overview
If ( myFirstVar = 100 ) and ( mySecondVar = 100 ) Then

Begin
//Here follow...
//...expressions

End;

//b) For program logic
If (myFirstVar = 100) AND ((mySecondVar = 100) OR (myThirdVar = 0)) Then

Begin
//This block is only executed if
//myFirstVar and mySecondVar both have the value 100
//or if myFirstVar has the value 100 and if myThirdVar has the value

0
End;

Take a closer look at the second example. If the two brackets around the
expressions linked by OR were not there, another meaning would result. The
condition would be met if "myFirstVar = 100 and mySecondVar = 100" OR
"myThirdVar = 0". In this case, the code would only be executed if "myFirstVar"
were 100 and "mySecondVar" were 100 OR "myThirdVar" were 0, which was not
meant to be according to the definition given in the comments.

In addition to the examples above, it may also be useful to set brackets around
mathematical operators.

//Are you sure what's meant here?
myFirstVar = 100 * ( x + y * ( 10 / z ) );

//This way it is easier to read.
myFirstVar = 100 * ( x + ( y * ( 10 / z ) ) );

INSERTING COMMENTS
As already seen, you can enter comments in the code. This is especially useful
for two reasons

à Even in case of longer source code and more complex
structures, good readability and comprehensibility are given.
This way, you can correct or edit the code even after years.

à Outsiders are able to understand the code much faster.
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EQUILLA FUNCTIONS

WHAT IS A FUNCTION?

In programming languages, functions are subordinate portions of the code in
which regularly used calculations and subroutines are sourced out. For example,
instead of writing the calculation of standard deviation again and again, the
calculation is put into a function. By calling up the function by its name - and
passing the relevant parameter(s) for calculation - the user receives the return
value as result.

The call may look as follows:

/* With the following function you receive the standard deviation over a 10
day range. 'StandardDev' is the Equilla function that contains the actual
calculation. */

myStdAbw = StandardDev( Close, 10 , 0 );

This is the source code of the Equilla StandardDev:

Meta:
Synopsis( "[Standard Deviation 1] Returns the Standard Deviation value

for the current bar." );

Inputs:
Price( NumericSeries ),
Period( NumericSimple ),
DataType( NumericSimple );

Variables:
divisor, sumSquare, avg, i;

StandardDev = 0;

If DataType = 1 Then
divisor = Period

Else
divisor = Period - 1;

If divisor > 0 Then Begin
avg = AverageFC( Price, Period );
sumSquare = 0;
For i = 0 To Period - 1 Do

sumSquare = sumSquare + Sqr( Price[i] - avg );
If sumSquare > 0 Then

StandardDev = Sqrt( sumSquare / divisor );
End
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Another big advantage of functions is that you can call up the same functions from
indicators and strategies. In fact, all indicators are based on functions - just as
strategies are based on indicators.

You can find the functions that came with the program by clicking on the button
Functions in the toolbox. To see the code of the function, right-click on it to open
the context and select Edit.

FUNCTION STRUCTURE

For the programming of Equilla functions, the same conditions apply as for all
Equilla scripts, see the chapter Equilla Program Structure and Syntax. Minor
divergences are given in the following paragraphs.

FUNCTION NAME
The function name is necessary to a) save the function in the file system and b)
call up the function from within an Equilla script. When choosing the name, take
care that the name

à is short and concise

à relates to the contents

à is not yet in use for another function (this might cause
problems)

//The function Momentum gives the indicator of the same name as result
myFirstVar = Momentum( PriceSerie, CalculationPeriod );

PASSING PARAMETERS UPON FUNCTION CALL
For the calculation of indicators, statistics and other values, certain information
has to be given:

à which data is to be used for calculation

à which time range is to be used for calculation

When calling up the function, these parameters (separated by commas) have to
be passed in brackets.

/* The function 'Momentum' gives the indicator of the same name as result As
parameter the function demands the data to be used for the Momentum and the
time range over which to calculate. */

myFirstVar = Momentum( Close, 20 );
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INPUT DECLARATION IN FUNCTIONS
In the source code of the function, any inputs from outside have to be declared.
As opposed to the definition of indicators, the type of the input parameters has to
be declared in functions.

Inputs:
//A data series, e.g. prices, has to be declared as NumericSeries
PriceValue( NumericSeries ),

//Simple numeric values are declared as NumericSimple
PeriodFast( NumericSimple ),

//Booleans as true/false (yes/no) value are declared TrueFalseSimple
DrawVisuals( TrueFalseSimple ),

//Strings like words or symbols are declared as StringSimple
UserName( StringSimple ),

//If you want to pass data that will be modified within the function and
the

//resulting modified value is to be used outside of the function, you
have

//to declare this as NumericRef
AdjustedPeriod( NumericRef ),

//Arrays can have multiple dimensions in Equilla, each dimension also
//declares an additional input for the function, in this example the
//function expects a 2-dimensional array as input which will be

accessible
//with the name Array2D and the numeric inputs Rows and Columns which

are
//initialized to contain the lenght of the array in this dimension.
Array2D [ Rows, Columns ] ( NumericArray ),

//If you want to pass an extension object to a function, you have to
declare

//the input as ObjectSimple (available in Tradesignal 6.3 and above).
ExtensionObject ( ObjectSimple );

Make sure to use the parameters in the same sequence as they are declared in
the function. The names of parameters used inside of functions are independent
of parameter names that are passed. Therefore you can use the parameter
'Period', which is passed when calling the function, under another name within the
function. You only have to take care that the sequence of values passed is the
same as in the declaration.

VARIABLE DECLARATION IN FUNCTIONS
The same conventions apply as described in Equilla Basics. You can also use
variable names that are already in use in the main program, as there is no danger
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of collision.

RETURNING VALUES
Values that were calculated in the function usually should be available for further
processing. To do so, the values have to be "returned". The actual way of
returning depends on which kind of value has to be returned.

RETURNING A SINGLE VALUE

If only a single value has to be returned, this is usually done with the name of the
function. In the calling script, the function is assigned to a declared variable. The
variable takes up the calculation result and makes it available for further
operations.

// In the calling script, the result of the Momentum calculation
// is assigned to the variable myFirstVar

myFirstVar = Momentum( Close, 20 );

In the source code of the function, the calculation result has to be assigned to the
name of the function.

Meta:
Synopsis( "[Momentum] Returns the momentum of a series over a specified

period." );

Inputs:
Price( NumericSeries ),
Period( NumericSimple );

//Assignment, i.e. returning the value

Momentum = Price - Price[ Period ];

RETURNING SEVERAL VALUES

When you want to return more than one result from a function, you must use so
called reference parameters. These parameters will be passed into your function,
modified within the function and then can be used. The following function shows
two such reference parameters that are set to the result of two different moving
averages:

//Function: TwoSmoothMA
Inputs:

FastMA(NumericRef), // Notice how we declare the type of the inputs as
numeric references

SlowMA(NumericRef); // instead of numericseries or numericsimple.
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Variables:
smoothMA;

smoothMA = Average(Close, 5);
FastMA = Average(smoothMA, 10);
SlowMA = Average(smoothMA, 50);
TwoSmoothMA = 1; // A dummy return value that will not be used in this case.

We can now use our new function in the following way:

//Indicator: Two Smooth Averages
Meta:

SubChart(False);
Variables:

slowMA, fastMA;

TwoSmoothMA(slowMA, fastMA); // The values for slowMA and fastMA are set in
the function

DrawLine(slowMA, "Slow");
DrawLine(fastMA, "Fast");

The advantage of using multiple output functions is that related operations can be
nicely encapsulated, but more importantly that if the result of each output rely on a
shared calculated value, it is more efficient to do the shared part once rather than
twice in two functions that return single values.

RETRIEVING PAST VALUES WITH DISPLACEMENTS
By using displacements, for example "Price[i]", you can retrieve older function
results. A good example for this would be the search for a breakout within the last
20 days' high or low. Please note that with the displacement attribute, past values
are retrieved. Therefore "[1]" gives the value for yesterday, [2] the value of two
days ago etc.

Caution: Trying to retrieve values of functions that are not calculated continuously may
result in wrong indicator results. This would be the case, for example, when the function call
is in a subroutine that is not executed for each bar.

ADDITIONAL INFORMATION FOR FUNCTIONS

For all Equilla functions, you can find additional information in Tradesignal. To
display it, open the source code in the Equilla Editor. Then right-click on the
function in question, e.g. DateTime, and choose Lookup Equilla Function from
the context menu. A window opens with information on the command and links to
related functions.
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EQUILLA OPERATORS
An important part of the scripts is the calculation of values. Often only basic
arithmetic is necessary for these calculations, but sometimes the tasks are more
complex. Equilla places many operators for calculating and comparing values at
your disposal.

CALCULATIONS

BASIC ARITHMETICS
For calculating values, the four basic arithmetic operations are available. These
are used most often.

Variables:
myFirstVar, mySecondVar, myThirdVar;

//Adding two values
myFirstVar = mySecondVar + myThirdVar;

//Subtracting two values
myFirstVar = mySecondVar - myThirdVar;

//Multiplying two values
myFirstVar = mySecondVar * myThirdVar;

/* When dividing two values, care has to be taken that no division by zero
occurs (which may happen if price series are faulty and include a zero). In
this case, Tradesignal instantly reports an error and stops the calculation.
After a simple example for a division, two examples are given that are
designed to prevent a division by zero. */

//Simple Division
myFirstVar = mySecondVar / myThirdVar;

//Query if Divisor = NULL
If myThirdVar <> 0 Then

myFirstVar = mySecondVar / myThirdVar

//If myThirdVar is zero, the result of the
//preceding trading period is used.
//The alternative block starting with 'Else'
//may be left out
Else

myFirstVar = myFirstVar [ 1 ];

//The Equilla function ''Divide' is available for this task
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//The two operands have to be passed in brackets
myFirstVar = Divide( mySecondVar , myThirdVar );

MATHEMATICAL FUNCTIONS FOR COMPLEX CALCULATIONS
With some effort, every calculation can be performed. However, you can reduce
the programming load by using functions already provided for special tasks. You
can find a list of all functions by clicking the Function button in the toolbox. To
see the code, double-click the function or select Edit from the context menu.

In the following, excerpts of some important functions and their use are given.

//No subchart
Meta:

Subchart( false );

//Declare period for calculation and variables
Inputs:

Period( 10 );

Variables:
myFirstVar, mySecondVar, myThirdVar;

/* This way you can find the highest value in a series. Please note:
Parameter 1: The used data has to be given as a continuous series, either a
price series or a value that is calculated or existent at each bar.
Parameter 2: The calculation span gives the number of values from the past
that are used in the calculation. In the example, period is set to '10'. */

//Example 1: finding the highest close
myFirstVar = HHV( Close, Period );

//Example 2: finding the highest price span
mySecondVar = High - Low;
myFirstVar = HHV( mySecondVar, Period );
/* There is a similar function you can use for finding the lowest price in a
series. Besides the different function name, all statements from above
apply. */

//Example 1: finding the lowest close price
myFirstVar = LLV( Close, Period );

//Example 2: finding the lowest price span
mySecondVar = High - Low;
myFirstVar = LLV( mySecondVar, Period );

/* When working with data, you often do not know during the programming
which values are less or greater than others. However, it is often important
to pursue calculations with the greater or lesser of two values. For this
task, the two functions MaxItems and MinItems are available. In both cases,
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two or more comma-separated values have to be passed in brackets. The
functions then give the greatest or smallest value from a list of values. */

//Calculating the height of a candlestick body
//without knowing if the close is below or above the open

myFirstVar = MaxItems( Open, Close ) - MinItems( Open, Close );

//Extracting the decimal places of a value
If isLastBar Then

Begin
myFirstVar = Frac( 5.5 );
Print( myFirstVar ); //0,5 is output

End;

//Finding the biggest integer that is smaller than the given value
If isLastBar Then

Begin
myFirstVar = Floor( 5.5 );
Print( myFirstVar ); //5 is output

End;

//Finding the smallest integer that is greater than the given value
If isLastBar Then

Begin
myFirstVar = Ceiling( 5.5 );
Print( myFirstVar ); //6 is output

End;

//Calculating the cosine of a value
If isLastBar Then

Begin
myFirstVar = Cos( 5.5 );
Print( myFirstVar ); //0,7086697742913 is output

End;

COMPARISONS

When calculating an indicator, it is often necessary to compare values and then
execute certain functions. For value comparison, several operators are available.

SIMPLE COMPARISONS BETWEEN TWO VALUES

//No subchart
Meta:

Subchart( false );

//Declare variables
Variables:

myFirstVar, mySecondVar, myThirdVar;

//Query if two values are identical
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If isLastBar Then
Begin

If myFirstVar = mySecondVar Then
Print( "Hello World" ); //Data is output if values are identical

End;

//Query if two values are unequal
If isLastBar Then

Begin
If myFirstVar <> mySecondVar Then

Print( "Hello World" ); // Data is output if values are unequal
End;

//Query if the first value is greater or equal to the second
If isLastBar Then

Begin
If myFirstVar >= mySecondVar Then

Print( "Hello World" ); // Data is output if the value is
// greater or equal to the
// second value

End;

//Query if the first value is smaller or equal to the second
If isLastBar Then

Begin
If myFirstVar <= mySecondVar Then

Print( "Hello World" ); // Data is output if the value is
// smaller or equal to the
// second value

End;

COMPARISONS BETWEEN SEVERAL VALUES THROUGH
COMBINATION

//No subchart
Meta:

Subchart( false );

//Declare variables
Variables:

myFirstVar, mySecondVar, myThirdVar;

//Combining two comparisons with the AND operator
If isLastBar Then

Begin
If ( myFirstVar = mySecondVar ) AND ( myFirstVar = myThirdVar ) Then

Print( "Hello World" ); //Data is output if both comparisons are
true

End;

//Combining two comparisons with the OR operator
If isLastBar Then

Begin
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If ( myFirstVar = mySecondVar ) OR ( myFirstVar = myThirdVar ) Then
Print( "Hello World" ); //Data is output if one comparison or

both
//are true

End;

//Combining two comparisons with the XOR operator
If isLastBar Then

Begin
If ( myFirstVar = mySecondVar ) XOR ( myFirstVar = myThirdVar ) Then

Print( "Hello World" ); //Data is output if one comparison is
true

//but not both
End;

FINDING CROSSING TIME SERIES
One of the most important problems in indicators and strategies is the search for
intersections between prices and averages, indicators and alert lines etc.
Tradesignal offers several functions for this task.

//No subchart
Meta:

Subchart( false );

//Set periods for calculation
Inputs:

PeriodFast( 10 , 1 ),
PeriodSlow( 20 , 1 );

//Declare variables
Variables:

fastAvg, slowAvg;

//Calculating a short average of close prices
fastAvg = Average( Close, PeriodFast );
//Calculating a longer average of close prices
slowAvg = Average( Close, PeriodSlow );

If isLastbar then
Begin

//Query if the faster average crosses over slower
If fastAvg Crosses Over slowAvg Then

Alert( "Average moves upwards" );
//Query if the faster average crosses under slower
If fastAvg Crosses Under slowAvg Then

Alert( "Average moves downwards" );
End;
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EQUILLA LOOPS
Loops serve to call functions multiple times without having to enter the function
code again and again. This is especially useful in cases in which the number of
necessary runs for the loop is calculated during program execution.

In this chapter, all loop types available in Equilla are described.

For all Equilla operators, you can find additional information in Tradesignal. To
display it, open the source code in the Equilla Editor. Then right-click on the
operator in question, e.g. Begin, and choose Lookup Equilla Function from the
context menu. A window opens with information on the operators and links to
related functions.

LOOPS WITH A DEFINITE NUMBER OF CYCLES (FOR...TO...DO)

For this type of loop, start and end values are given. The number of cycles is
given by their difference.

//This loop repeats the command 10 times
For counter = 0 to 9 Do

command;

//This loop repeats the block of commands 10 times
For counter = 0 to 9 Do

Begin
command1;
command2;
...
commandX;

End;

You also have the option to rule with which steps the loop have to run. The
standard for the step is 1.

//This loop repeats the command 5 times
For counter = 0 to 9 Step 2 Do

command;

//This loop repeats the command 10 times with a negative incrementation
For counter = 9 to 0 Step -1 Do

Print(Counter);

You also have the option to give the start and end value of the loop as variables.
This way, the loop is more flexible and results of partial calculations or functions
can be used as counters.
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//This loop repeats the command 13 times
Variables:

startCount( 0 ), endCount( 12 );

For counter = startCount to endCount Do
command;

//This loop repeats the block of commands 13 times
For counter = startCount to endCount Do

Begin
command1;
command2;
...
commandX;

End;

CONDITION-CONTROLLED LOOPS

The above presented type of loop uses a fixed value as a counter for the number
of cycles. The values can be set by variables, but these variables cannot be
changed from within the loop. However, this is necessary in cases, for example,
in which the number of cycles depends on the result of a calculation within the
loop itself.

For these cases, other types of loops exist. These loops run until a certain result
or value in the cycle meets a certain condition. There are two different subtypes of
these loops:

LOOP WITH THE CONDITION BEFORE THE EXECUTION
(WHILE...DO)
The condition for the loop is checked before the loop is executed.

//This loop runs 10 times ( 0-9 )
Variables:

counter(10), sumCounter(0);

While ( counter < sumCounter ) Do
sumCounter = sumCounter + 1;

//You can also run several commands as a block.
Variables:

counter(10), sumCounter(0);

While ( counter < sumCounter ) Do
Begin

sumCounter = sumCounter + 1;
Print( sumCounter );

End;
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LOOPS WITH THE CONDITION AFTER THE EXECUTION
(REPEAT...UNTIL)
The condition for the loop is checked after each cycle run, i.e. after the
calculation.

//This loop runs 10 times ( 0-9 )
Variables:

counter(10), sumCounter(0);

Repeat
sumCounter = sumCounter + 1;

Until ( sumCounter < counter );

//You can also run several commands as a block.
Variables:

counter(10), sumCounter(0);

Repeat
Begin

sumCounter = sumCounter + 1;
Print( sumCounter );

End;
Until ( sumCounter < counter );

EQUILLA CONDITIONS
One of the most important aspects of programming indicators, strategies or other
routines is the reaction to certain events, like calculation results or user inputs.
Without the control, activation or deactivation of program parts depending on
those events, no complex programming would be possible.

For all Equilla conditions, you can find additional information in TradeSignal. To
display it, open the source code in the Equilla Editor. Then right-click on the
operator in question, e.g. Else, and choose Lookup Equilla Function from the
context menu. A window opens with information on the operators and links to
related functions.

SIMPLE CONDITION (IF ... THEN)

You can use the key words If...Then to encapsulate one or more conditions.
Depending on the results, different actions are performed. The conditions can be
combined by using the three operators And, Or and Xor (see the chapter "Equilla
Operators" on page 420).

427



//No subchart
Meta:

Subchart( false );

//A list with two input parameters is declared

Inputs:
commodities( Silver, Gold );

//Query if the first list entry is selected
If Commodities = 0 Then

Print( "Silver price rises." )
Else //If not selected, the alternative is processed

Print( "Gold price rises." );

CONDITIONS WITH BRANCHING (IF...THEN...ELSE)

By entering an alternative command, your script can react to met and not met
conditions likewise. When testing several cases at once, it is sensible to process
them within the same context.

//No subchart
Meta:

Subchart( false );

//A list with three input parameters is declared

Inputs:
commodities( Silver, Gold, Platin );

//Query if the first list entry is selected
If Commodities = 0 Then

Print( "Silver price rises." )
Else //If not selected, the alternative is processed

Print( "Gold price rises." );

//Query if the first list entry is selected
If Commodities = 0 Then

Print( "Silver price rises." )
Else If Commodities = 1 Then //If not selected, the second alternative is
checked

Print( "Gold price rises." )
Else //Is it not selected, only the last possibility is left.

Print( "Platin price rises." );

Note: The line before the Else statement must not end with a semi-colon.
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NESTED CONDITIONS

You can put several statements into a block and nest queries. The following
example shows how to write begin-end blocks and nested conditions.

//Important, this is not a working program. Do not attempt
//to compile it in the editor.
//We check the cucumber and want to buy a really fresh one only
If cucumber = green Then

Begin
//The color meets our first condition, but is it also fresh?
If ( cucumber = fresh ) Then

Begin
//The cucumber is fresh, we use it
"Cut in slices";
"Add tomato slices";
"Add dressing";
//If it's Friday, add garlic
If Today = Friday Then

"Put lots of garlic in the dressing"
Else //If it's not Friday, do not use garlic

"Skip garlic";
End

Else //The cucumber was too soft and squashy, we try to buy another
one.

"Drive to another store";
End;

EQUILLA QUOTATIONS AND TIME PERIODS
This entry is about quotations that are delivered by the provider and that you need
as input values for the calculation of functions, indicators and strategies. It also
offers information on working with date and time date. In the end, you can find
information and examples on how to find distinct bars in a chart.

For all Equilla functions, you can find additional information in Tradesignal. To call
it up, open the source code in the "Equilla Editor" on page 399. Then right-click on
the function in question, e.g. Accelerator, and choose Lookup Equilla Function
from the context menu. A window opens with information on the function and links
to related functions.

DATA IN QUOTATION SERIES

The most important data needed for indicators are the quotations. These are
delivered by the data provider and can be displayed in a chart. In addition, you
can use external quotations from locally saved files in Tradesignal. Frommost
providers, you will receive the following data:
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Open Opening price for each trading period

High High price for each trading period

Low Low price for each trading period

Close Closing price for each trading period

Volume Trading volume for each trading period

Open Interest Open interest in the case of futures

PARTICULARITIES OF VOLUME DATA
Two different definitions of trading volume are in existence, which are often
confused.

à The more meaningful definition is that the trading volume is
given by the number of traded stocks multiplied with its traded
price. This way, the volume represents the amount of capital
that was traded in the period.

à Differing from this, sometimes the trading volume is only given
as turnover in traded pieces. This means only the number of
traded stocks is taken as volume, without information on the
traded prices. The problem is that in this case, 100 stocks at
0.20 cents would yield the same volume as 100 stocks traded
at $164.40. The number of pieces does not represent the
capital used for the trades.

Make sure to ask your data provider which kind of volume data is delivered.
Depending on the volume interpretation, indicator data and statistics have to be
adapted or put into perspective.

EXAMPLE: USING QUOTATIONS SERIES WITHOUT VOLUME

/* The following example demonstrates the usage of quotations series without
volume. Four variables are declared which will be used for each of the
quotation series. Following this, an average is calculated for each series,
saved in the variables and displayed as a candlestick chart in a new window.
Remember that Equilla scripts are processed once for each trading period. */

Meta:
Subchart ( true );

//The trading period for the average calculation is declared as input.
//You can later edit the value in the properties of the indicator.

Inputs:
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Period( 10, 1 );

//Variables are declared

Variables:
myOpenValue, myCloseValue, myLowValue, myHighValue,
avgOpen, avgClose, avgLow, avgHigh;

//Day for day is processed. For each trading day, the price is assigned to
//the variables.
myOpenValue = Open;
myCloseValue = Close;
myLowValue = Low;
myHighValue = High;

/* Now the average calculation follows, which is done once per trading day.
The passing of the quotations to the calculation functions is especially
complicated to demonstrate the underlying principle. Alternatively, you can
pass the quotations to the functions directly. avgOpen = Average ( Open,
Period ); avgClose = Average ( Close, Period ); avgLow = Average ( Low,
Period ); avgHigh = Average ( High, Period ); */

avgOpen = Average ( myOpenValue , Period );
avgClose = Average ( myCloseValue, Period );
avgLow = Average ( myLowValue, Period );
avgHigh = Average ( myHighValue, Period );

//With the result of the average calculations
//candlesticks are drawn
DrawCandleStick( avgOpen, avgHigh, avgLow, avgClose, Yellow, Red, DarkBlue
);

INLINE INSTRUMENTS AND DATA INPUTS

Ó INLINE INSTRUMENTS

Indicators can be used for more than just the
quotations of a single basic symbol in the chart.
Many indicators use the quotation series of
more than one stock. The same applies to
strategies, many of which are based on several
symbols or different quotation series. For these
calculations, the tools Inline Instruments and
Data Inputs are available.

INLINE INSTRUMENTS

An inline instrument is a reference to the stock data which is used directly in the
source code. You have to give the symbol and the relevant quotation series. The
following example calculates the difference between the quotations of Puma and
Adidas Salomon. The result is displayed in a candlestick chart. It does not matter
to which chart you apply this indicator - it always uses the given quotations of
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those two companies. Therefore, inline instruments can be used for calculation
with quotations that are not a part of the current chart or portfolio.

//Generate a subchart
Meta:

Subchart( true );

//Declare variables
Variables:

openValue, highValue, lowValue, closeValue;

/* Subtract the time series. By giving the symbol in the series, quotations
can be used that are not part of the current chart. */
openValue = Open of 'pum ger' - Open of 'ads ger';
highValue = High of 'pum ger' - High of 'ads ger';
lowValue = Low of 'pum ger' - Low of 'ads ger';
closeValue = Close of 'pum ger' - Close of 'ads ger';

//Display result as candlesticks
DrawCandleStick( openValue, highValue, lowValue, closeValue, White, Red,
Black );

DYNAMIC INLINE INSTRUMENTS

Tradesignal 6 offers you the ability to create inline instruments based on runtime
information, e.g. the string inputs of an indicator or strategy may be used instead
of a constant string expression.

See the Equilla Formula Language reference entry Instruments in Tradesignal
for more details on importing symbols.

//Import a single instrument and reference it in the script by using
DrawLine on its variable
Input:

Symbol( "" );

Instruments:
mySymbol( Symbol );

DrawLine( mySymbol );

You can also create a list of inline instruments and reference any of the symbols
in the list via its index which starts at zero.

//Import a list of instruments and calculate the average price
Input:

ListSymbol( "" );

Instruments:
myInstruments( List( ListSymbol ) );
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Variables:
prices( 0 ), i( 0 );

prices = 0;

For i = 0 to Len( myInstruments ) - 1 Begin
prices = prices + Close of myInstruments( i );

End;

If Len( myInstruments ) != 0 Then
DrawLine( prices / Len( myInstruments ), "Average" );

DATA INPUTS

Ó USING DATA INPUTS IN A CHART

With data inputs, you can access different
quotation series or other data in the chart or
portfolio. The only condition is that those series
are available in the same chart or portfolio
during runtime. For example, you can write an
indicator displaying the spread between two
time series without defining beforehand to
which symbols the series belong. You simply
start a chart with two symbols and then apply
the indicator.

To recreate the indicator from above with data inputs instead of input instruments,
create a chart with Puma AG and Adidas Salomon AG. Now enter a new
indicator. The quotations are used as data inputs. The first quotation series is
referred to as "Data1", the second as "Data2" etc. Since up to twelve symbols can
be displayed in a chart, you can enter up to 12 data inputs.

//Generate subchart
Meta:

Subchart(true);

//Using the data input parameters for the spread
DrawCandleStick( Open of Data1 - Open of Data2,
High of Data1 - High of Data2,
Low of Data1 - Low of Data2,
Close of Data1 - Close of Data2,
white, red, black);

DATE AND TIME FOR QUOTATION SERIES

The information is delivered with the price data, online or in files. For correct
display of quotations, date and time are necessary. This information is also often
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necessary for other functions, e.g. to recognize day change-overs or certain days
of time.

HOW A CHART IS DRAWN
The quotations are displayed linearly, from the first period (in the past) to the last.
Usually, this is the current day or hour, depending on the time base of the chart.
Within an Equilla script, the navigation is done with the consecutive number of the
period (not the date or time). Therefore, if you want to use the close price of three
days ago in your indicator, you need to write the script so that is goes three
periods back in time.

The date cannot be used for this kind of navigation. You cannot retrieve data such
as price or volume with a date. However, you can read the date and time of each
period for other uses, for example the output of date and time of certain price
levels in a chart.

WHICH DATA IS OFFERED BY TRADESIGNAL?
Date The date for the current period as numeric value: 1060609 ( this is the
09.06.2006 )

Time The time of the current period as numeric value: 1645 ( this is 16:45 )

DateTime A combined expression that is already formatted: 2006/07/05
17:25:00.000 ( this is the 05.07.2006 1725)

Extracting the data with code:

//Date of the current trading day in a daily chart
Variables:

myDate;

myDate = Date

//In the output window, the date for each trading day in the chart
//is displayed continuously.
Print( myDate );

//Time of the current period in an intraday chart
Variables:

myTime;

myTime= Time;

//In the output window, the time for each trading period in the chart
//is displayed continuously.
Print( myTime);
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FUNCTIONS FOR FORMATTING AND WORKING WITH DATE AND
TIME
Above, the three basic time series for date and time are given. These data can be
read for every period and be used further. In the example above, the date and
time were read and printed in the output window. However, it is often necessary to
find out single components of the date, for example the day of week, the calendar
month or the current year. You may also want to use the given date and time
values in another format than the one offered by the system.

FUNCTIONS FOR SPLITTING DATE AND TIME

The following functions are not a complete list of all available functions. Only the
most important ones are listed.

For returning date components, you can use the simple functions Year(date),
Month (date) etc. When entering "now" for the date, the current date is used.

Instead of day, the function DayOfMonth can be used.

//Example: Write the components of the current date and time to the output
window:
If IsLastBar Then

Begin
ClearDebug();
Print( "Year=" + CStr( Year( Now ) ) );
Print( "Month=" + CStr(Month( Now ) ) );
Print( "Day=" + CStr( Day( Now ) ) );
Print( "Hour=" + CStr( Hour( Now ) ) );
Print( "Minute=" + CStr( Minute( Now ) ) );
Print( "Second=" + CStr( Second( Now ) ) );
Print( "MilliSecond=" + CStr( MilliSecond( Now ) ) );

End;

To return parts of the DateTime, the function DatePart has to be used, defined as
DatePart( DateInterval, DateTime ). For the definition of DateTime, see above.

The DateInterval is a numeric constant representing a certain part of the
DateTime. It is always constructed with a leading Interval followed by a date or
time expression.

Interval Time
Interval_Year Year
Interval_Month Month of Year (1-12)
Interval_Day Day of Month (1-31)
Interval_DayOfMonth Day of Month (1-31)
Interval_DayOfWeek Day of Week (0-6)
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Interval Time
Interval_DayOfYear Day of Year (1-365)
Interval_Hour Hours
Interval_Minute Minutes
Interval_Seconds Seconds

//Example: Write a date or time part to the output window:

Input:
Interval( iYear, iMonth, iDay, iHour, iMinute, iSecond );

Variables:
name, part;

If Interval = iYear Then Begin
name = "Year";
part = Interval_Year;

End Else If Interval = iMonth Then Begin
name = "Month";
part = Interval_Month;

End Else If Interval = iDay Then Begin
name = "Day";
part = Interval_Day;

End Else If Interval = iHour Then Begin
name = "Hour";
part = Interval_Hour;

End Else If Interval = iMinute Then Begin
name = "Minute";
part = Interval_Minute;

End Else If Interval = iSecond Then Begin
name = "Second";
part = Interval_Second;

End;

Print( name + "=" + CStr( DatePart( part, DateTime ) ) );

FUNCTIONS FOR FORMATTING DATE AND TIME DATA
The basic date and time entries are dry figures. The DateTime component is also
not formatted according to European standard. To allow you to generate various
date and time formats, complex formatting functions are available. Two important
ones are described here.

/* With the following function, you can format a date so that it includes
the full name of the month. The function has the DateTime parameter as
input. The formatting possibilities are quite unlimited. */

//No subchart; output in the main chart
Meta:

Subchart ( false );
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//Declaring variables for date and day
Variables:

myDate, myDay;

//Reformatting the date, for example to
myDate = FormatDate ( DateTime, "dd/mm/yyyy");

//Here the day is read
myDay = DayOfWeek ( Date );

//Check if it is Monday - if yes, the text is
//output in the chart
if myDay = 1 Then

DrawText ( High + Range(), "Monday", "Monday," + mydate, 10, blue );

/* The following function is similar to the FormatDate function. It serves
for formatting the time data in user-defined formats. It is recommended to
take a look at the Equilla help for further information. */

//No subchart; output in the main chart
Meta:

Subchart( false) ;

//Declaring the variables for time and the formatted time
Variables:

myTime, myFormatTime;

//Here the time is read
myTime = Time;

//Here the time is reformatted with a separator
myFormatTime = FormatTime( DateTime, "hh:mm");

//At five past nine, a message is displayed in the chart
If Time = 0905 Then

DrawText ( High + Range(); "Good morning!", "It is " +myFormatTime,
10, blue);

//At one o'clock, it's time for the lunch break
If Time = 1300 Then

DrawText ( High + Range(); "Lunch time!", "Go and have something to eat,
it is " +myFormatTime, 10, blue);

//At half past five, it's time for knocking off
If Time = 1730 Then

DrawText ( High + Range(); "Bye!", "Call it a day, it is "
+myFormatTime,
10, blue);

437



INFORMATION ABOUT SPECIFIC PERIODS AND BARS

In Equilla Graphs, Outputs and Alerts you can find information on how the
navigation in a chart can be controlled by an Equilla script. Reference values are
used that can also be interpreted as step sizes. Much as in a game, where a
figure makes 6 steps forwards or backwards, the program navigates through the
time series.

//Reading the date of three days ago
myPrevDate = Date[ 3 ];

//Reading the close price of five days ago
myPrevClose = Close[ 5 ];

From each period in a chart, you have access to all other data and prices in the
chart by going back or forward in the data. To do so, some useful functions are
available in Tradesignal, which can be used with Equilla.

/* The parameter 'CurrentBar' gives the reference number of the current
period The number is listed consecutively, as can be seen in the chart. */

//Output to be done in the main chart
Meta:

Subchart( false );

Variables:
myBarNum;

//The numeric value CurrentBar is converted into a string
myBarNum = CStr( CurrentBar );

DrawText( High + Range(), "Bar numbers", myBarNum, 10, blue);

For many applications it is important to execute a specific action at the very
beginning or ending of a chart. For example, variables are often set at the first
bar. Two important functions are offered by Tradesignal for this purpose.

à With the first function, you can read out how many bars
(periods, candlesticks) are loaded in the chart.

à With the second function, a flag is set which is "true" when the
last bar is reached.

//We set two variables at the first bar
Variables:

myEntryCondition, myExitCondition, myBarNums;

//We look for the first bar
If CurrentBar = 1 Then
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Begin
myEntryCondition = false;
myExitCondition = false;

End;
/* We look for the last bar. This time we use the number of total bars in
the chart which we get with the variable 'LastBar'. */

If CurrentBar = LastBar Then
Begin

myBarNums = LastBar;
Print ( myBarNums );

End;

//To find the last bar, you can also use the
//function 'IsLastBar' which is a boolean.

If isLastBar = True Then
Begin

myBarNums = LastBar;
Print ( myBarNums );

End;

Last not least it is often important to know the current time base of the indicator.
For this, the constant "TimeBase" is available. With it you get the number of
seconds spanned by each bar. With some mathematics, we can quickly find out if
the indicator is in a day chart or one with a five minute span.

Variables:
outputString("");

If CurrentBar = 1 Then
Begin

//Checking for a day chart
if TimeBase = 86400 Then

outputString="d";
//Checking for a one hour time base
if TimeBase = 3600 Then

outputString="1h";
//Checking for a five minute time base
if TimeBase = 300 Then

outputString="5m";
//Checking for a one minute time base
if TimeBase = 60 Then

outputString="1m";
End;

//At the last bar, the output is written
//into the output window
If isLastBar Then

Print ( outputString );
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EQUILLA GRAPHS, OUTPUTS AND ALERTS
There are several ways to offer data, calculation results, symbols and reports to
the users. One of the most important functions is the graphic display of indicators
and other information. Tradesignal offers output functions for text and reports and
an alert function.

For all Equilla operators, you can find additional information in Tradesignal. To
display it, open the source code in the Equilla Editor. Then right-click on the
operator in question, e.g. Begin, and choose Lookup Equilla Function from the
context menu. A window opens with information on the operators and links to
related functions.

DRAWING LINES, AREAS, SYMBOLS OR TEXT IN A CHART

With the drawing statements, usually indicators and graphs related to them are
generated. An indicator usually consists of a line or histogram. Some indicators
also use filled areas or symbols or offer information as text.

In this chapter, you can find general information on using colors, line width,
symbols and their most important applications. When you enter a drawing
statement in the editor, you can find all parameters and their sequence in the
tooltip. Parameters that are not mandatory are labeled with "optional".

BASICS OF DRAWING STATEMENTS
Here you can find information on using drawing statements, why they should
have captions and how the displacement function can be used to move the
graphic display in the timeline. The most important parameters are given.

CAPTIONS

A caption should be entered for each statement. This is especially useful when
several drawing statements are used in the same chart. The captions have two
important functions:

The drawing statements are more easily identified in the property inspector.

In the tooltips and the target cursor mode in the chart, values are displayed for all
graphic objects under the cursor. The value interpretation is easier when the
drawing statements are named.

If no caption is given, each drawing statement is labeled with "Plot" and a
consecutive number.
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DISPLACEMENT

Ó DISPLACEMENT EXAMPLE

Equilla scripts are executed once per bar. By
using so-called displacements, for example
"Price[i]", you can retrieve older function
results. In a similar way, drawing statements
can be displaced. For this, the Displacement
parameter has to be added directly after the
statement. Enter a positive value in square
brackets [ ] to move it into the past, and a
negative value to move it into the future.

Example for a displacement:

// Generate no subchart
Meta:

Subchart( false );

//Execute at last bar
If isLastBar Then

Begin
DrawSymbol[3] (Low[3], "Past", SymbolSquare, 30, black, blue );
DrawSymbol[-3] (Low, "Future", SymbolSquare, 30, black, blue );

End;

PARAMETERS

For all drawing statements, optional parameters can be specified. These are
caption, line width, symbol size, colors etc. These parameters can be given by
variables which can be changed at runtime (see some of the examples below).
Feel free to experiment with the options.

Especially interesting is using dynamic color values. Each component of the color
values of RGB and HSVmodes can be changed. The opacity can also be set.

Design parameters like line or symbols styles can also be entered numerically.
However, while this saves space, the full parameter names are easier to read and
remember.

DRAWING STATEMENTS AND SYNTAX
Below, the most commonly used drawing statements and their syntax are listed.
In the thumbnails, screenshots with graphs and source code are given.
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DRAWLINE ( )

Ó LINE EXAMPLE

With this statement, a line is drawn. Style, size
and color can be specified. Constant values or
definable parameters (e.g. results or
calculations) can be used.

DrawLine[ Displacement ]( Value, "caption", Style, LineWidth, Color );

Example for a sine curve:

// Generate subchart
Meta:

Subchart( true );

//Declare variables
Variables:

mySinValue, counter;

//Assign a value to the variable
mySinValue = Sin(counter);
counter = counter + 1;

//Draw the values as a solid red 2 pixel line
DrawLine( mySinValue, "Sinus", StyleSolid,2, Red );

DRAWFOREST ( )

With this statement, a line is drawn. Style, size and color can be specified.
Constant values or definable parameters (e.g. results or calculations) can be
used.

DrawForest[ Displacement ]( StartValue, EndValue, "caption1", "caption2",
NeedleSize, NeedleColor, LinkForest True/False );

Example for an indicator displayed as forest:

// Generate no subchart
Meta:

Subchart( false );
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Inputs:
Period( 20, 1 );

//Declare variables
Variables:

myOwnIndicator;

//Create the indicator
myOwnIndicator = RSI ( Momentum (Close, Period), 5 );

//Display indicator as forest
DrawForest( 0, myOwnIndicator, "Basis", "MEI", thick, blue, false );

DRAWAREA ( )

With this statement, an area is drawn between two values of the scale. Colors and
opacity can be set.

DrawArea[ Displacement ]( Value1, Value2, "caption1", "caption2", FillColor,
LineColor1, LineColor2 );

Example for drawing an area with color gradient:

// Generate a subchart
Meta:

Subchart( true );

//Declare variables
Variables:

counter, colorValue;

//Change the counter in a loop
if counter <= 254 then

counter = counter + 1;

//Reset the counter at 255
Else

counter = 0;

//Set the RGB color value with a dynamic value.

colorValue = RGB( counter, 150, 150 );

//Set opacity.

colorValue = TransparentColor ( colorValue, counter );

//Draw the area between the positive and negative values of
//'counter', with black border lines.

DrawArea( counter, Neg( counter ), "Up", "Down", colorValue, Black, Black);
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DRAWSYMBOL ( )

Symbols example

With this statement, symbol charts with circles, start, dots, triangles etc. can be
drawn. The size and colors can be controlled dynamically.

DrawSymbol[ Displacement ]( Value, "caption", SymbolStyle, SymbolSize,
SymbolBorderColor, SymbolFillColor );

Example for drawing triangles (pointing up or down, depending on the curves):

// Generate no subchart
Meta:

Subchart( false );

//Declare input
Inputs:

Period( 20, 1 );

//Declare variables
Variables:

avgValue;

//Calculate the average close price
avgValue = XAverage ( Close, Period );

//Display an triangle pointing upward, if
//the price crosses above the average.
If Close Crosses over avgValue Then

DrawSymbol( High, "CrossUp", SymbolTriangleUp, 20, black, darkgreen);

//Display an triangle pointing downward, if
//the price crosses below the average.
If Close Crosses under avgValue Then

DrawSymbol( Low, "CrossUp", SymbolTriangleDown, 20, black, darkgreen);

//The average itself is displayed as line.
DrawLine( avgValue, "Average", StyleSolid, 2, black );

DRAWTEXT ( )

Output text example

With this statement, text is output. Variables like font size, color, style etc. can be
specified.

DrawText[ Displacement ]( Value, "caption", textoutput, FontSize, FontColor,
FontStyle, URL );

Example for text output:
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//Generate no subchart
Meta:

Subchart( false );

//Declare input
Inputs:

Period( 10, 1 );

//Declare variables
Variables:

avgValue;

//Calculate the average close price
avgValue = WAverage ( Close, Period );

//When the average turns up, text is added to the
//Low of the last day.
If TurnsUp( avgValue, 2, 1 ) Then

DrawText[1]( Low[1], "Up", "Bottom", 10, Darkgreen);

//When the average turns down, text is added to the
//High of the last day.
If TurnsDown( avgValue, 2, 1 ) Then

DrawText[1]( High[1], "Down", "Top", 10, Red );

DRAWBAR ( )

With this statement, a bar chart is drawn. Each of the four values - open, high,
low, close - can be chosen freely. This way, indicators can also be drawn as bars.

In this statement no caption needs to be specified, as it can only be used once in
each script.

DrawBar[ Displacement ]( Open, High, Low, Close, BullishColor, BearishColor
)

Example for modified OHLC values as bars (Heikin Ashi method):

//Generate a subchart
Meta:

Subchart( true );

//Declare input
Inputs:

Period( 14, 1 );

//Declare variables
Variables:

avgOpen, avgHigh, avgLow, avgClose;

//Calculate the average for all quotes.
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avgOpen = XAverage( Open, Period );
avgHigh = XAverage( High, Period );
avgLow = XAverage( Low, Period );
avgClose = XAverage( Close, Period );

//Display bars.
DrawBar ( avgOpen, avgHigh, avgLow, avgClose, DarkGreen, Red );

DRAWCANDLESTICK ( )

Ó CANDLESTICK EXAMPLE

With this statement, a candlestick chart is
drawn. Each of the four values - open, high,
low, close - can be set freely. This way,
indicators can also be drawn as candlesticks.

In this statement no caption needs to be
specified, as it can only be used once in each
script.

DrawCandleStick[ Displacement ]( Open, High, Low, Close, BullishColor,
BearishColor,
BorderColor )

Example for modified OHLC display as candlesticks (Heikin Ashi method):

//Generate a subchart
Meta:

Subchart( true );

//Declare input
Inputs:

Period( 14, 1 );

//Declare variables
Variables:

haOpen, haHigh, haLow, haClose;

//Calculate the Heikin Ashi values
If ( CurrentBar = 1 ) Then

Begin
haOpen = Open;
haClose = Close;

End
Else

Begin
haOpen = (haOpen[1] + haClose[1]) / 2);
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haClose = (open + high + low + close) / 4);
End;

haHigh = MaxItems( high, haOpen, haClose );
haLow = MinItems( low, haOpen, haClose );

//Draw the Heikin Ashi values as candlesticks.
DrawCandlestick ( haOpen, haHigh, haLow, haClose, DarkGreen, Red, DarkGray
);

DRAWPRICEMARKER ( )
This draws a horizontal marker at the given price next to the price scale or aligned
to the last bar. Price markers will only be drawn on the last bar of a chart.
Additionally, price markers are only valid for one evaluation run. When an update
occurs, all existing price markers will be deleted. Price markers are always drawn
behind any other chart.

DrawPriceMarker( Price1, Price2, Width, FillColor, BorderColor,
BorderThickness, Alignment, Label, LabelSize, LabelColor, LabelOptions )

In contrast to drawing functions like DrawLine(), DrawPriceMarker () does not
procure series data. Therefore the output from this function cannot be used from
client scripts.Example for markers for all stop and limit order active on the current
bar:

Meta:
SubChart( False );

Variables:
order, price, type, extent( 10 );

If IsLastBar Then Begin
For order = 1 To GetActiveOrderCount Begin
price = GetActiveOrderPrice( order );
type = GetActiveOrderType( order );
If type = OrderTypeLimit Then
DrawPriceMarker( price, price, extent, Blue, Blue )
Else If type = OrderTypeStop Then
DrawPriceMarker( price, price, extent, Red, Red );
End;
End;

DRAWING TOOLS WITH SPECIAL FUNCTIONS
For the two drawing tools DrawTrendLine() and DrawRectangle(), special
functions are available in Equilla to draw with and manipulate these tools.
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These special functions are passed as (tool) flags. They allow actions, for
example expanding a rectangle into the "past" with "ToolLeftExtend".

In contrast to drawing functions like Drawline(), the output generated by the tool
functions is valid for display in a chart only.

You can find more information on DrawTrendLine(), DrawRectangle() and the
flags in Tradesignal help under Equilla Formula Language, menu entry Tools.

DRAWTRENDLINE ( )

This draws a trendline into a chart.

DrawTrendline( StartDate, StartTime, StartPrice, EndDate, EndTime, EndPrice,
Style, Width, Color, Flags )

The flags are special functions like ToolExtendLeft, ToolExtendTop etc.

Example for a trendline drawn at the highest high of the last bars:

Input:
Price( High ),
Period( 10, 1 );

Variables:
highVal;

If IsLastBar Then
Begin
// Remove any trendline from the previous bars
While ( ToolGetFirst() <> -2 )
ToolDelete( ToolGetFirst() );

// calculate the highest high
highVal = HHV( Price, Period );

// draw the trendline
DrawTrendline( DateTime[10], highVal, DateTime, highVal );
End;

DRAWRECTANGLE ( )

This draws a rectangle into the chart.

DrawRectangle( StartDate, StartTime, StartPrice, EndDate, EndTime, EndPrice,
BorderColor, FillColor, Flags )

The flags are special functions like ToolExtendLeft, ToolExtendTop etc.
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Input:
LongColor( ColorGreen ),
FlatColor( Transparent ),
ShortColor( ColorRed );

Variables:
color,
flags( ToolDrawInBackground + ToolExtendBottom + ToolExtendLeft +
ToolExtendRight + ToolExtendTop );

// Select the background color
If MarketPosition = MarketPositionLong Then
farbe = LongColor
Else If MarketPosition = MarketPositionFlat Then
farbe = FlatColor
Else If MarketPosition = MarketPositionShort Then
farbe = ShortColor;

// Remove all previously drawn rectangles
While ( ToolGetFirst() <> -2 )
ToolDelete( ToolGetFirst() );

// Draw a rectangle in the background
DrawRectangle( Date, Time, Close, Date, Time, Close, color, color, flags );

CHANGE THE CHART TYPE OF AN INDICATOR/STRATEGY

You can change the output of an indicator or strategy in a chart (which is using
one of the drawing functions described above) without changing or recompiling
the script. For this, select the indicator or strategy and open the "Chart" on
page 96 button menu in the Chart group in the toolbar. Then select the new chart
type from the list.

SMALL EXCURSION IN CHROMATICS

In Equilla, there are several ways to enter colors. A number of color definitions
can be entered as names. The usual ones are the standard colors like red,
darkgreen, blue, black, magenta etc. The list of predefined colors offers many
more colors.

Beyond that, the two color models HSV and RGB are available. When you define
a color, for example in the color dialog in the mini toolbar, the RGB and HSV
values are given below the color areas. With these values, every possible color
can be entered.

THE TWO COLOR MODELS

//Ouput in a subchart
Meta:

449



Subchart( true );

//Color values can be saved in variables
Variables:

myFirstRGBColor, myFirstHSVColor;

//Color as RGB value
myFirstRGBColor = RGB( 100, 30, 250 );

//Color as HSV value
myFirstHSVColor = HSV( 100, 230, 250 );

//Lines in RGB color
DrawLine( 100, "RGB color", StyleSolid, 5, myFirstRGBColor );

//Lines in HSV color
DrawLine( -100, "HSV color", StyleSolid, 5, myFirstHSVColor );

USING OPACITY (TRANSPARENCY)
For every color, you can define an opacity value. This works for all colors, the
standard colors as well as colors given by RGB or HSV values. Once again, color
values can be given by variables which can be combined with opacity.

//Open a subchart
Meta:

Subchart( true );

//Change this input value to see the opacity
//effect in the chart
Inputs:

Transparency( 200, 1 );

//Color settings can be given as variables
Variables:

myFirstRGBColor, MyFirstTransparentColor;

//Compose an RGB value
myFirstRGBColor = RGB( 100, 30, 250 );

//Add Opacity
myFirstTransparentColor = TransparentColor( myFirstRGBColor, Transparency );

//Draw an area with a transparent fill color
DrawArea( 100, -100, "Up", "Down", myFirstTransparentColor, black, black );

OUTPUT OF DATA IN THE OUTPUT WINDOW

The output window is used for the output of data or text with the Print statement.
For example, you can output your own statistical or temporary results.
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As a developer, it is often necessary to have detailed information about the
program flow. With the Print function, a parameter output can be generated
(emulating a debug mode) that helps finding eventual errors.

//Let the program communicate
Variables:

myDate, myFutureDate;

myDate = FormatDate( DateTime, "dd.mm.yyyy");
myFutureDate = FormatDate( DateTime, "dd.mm.yyyy")[-1];

Print( "I'm just editing the: " + myDate + ", after that, " +
myFutureDate + " will be next.");

/* In the output window, the following appears: I'm just editing the:
2007/06/12, after that, 2007/06/14 will be next. */

DATA OUTPUT VIA FILE INTERFACE

Tradesignal offers the option to write data directly into a file. You can find the
setting for the target folder of the PrintToFile function in the Tradesignal Options,
tab Equilla. In the statement, only the file name can be specified.

Variables:
fileName("UserStat.txt");

if isLastBar Then
PrintToFile( fileName, "Indicator was last used at: " +

FormatDate( DateTime, "yyyy/mm/dd"));
/* A file is created with the entry: 'Indicator was last used at 2006/04/30'
*/

As long as you do not change or delete the file, Tradesignal appends each new
line to the end of the file. This way, a history of entries results. If you want to
ensure by way of a script that an existing file is used, you can delete that file.

Variables:
fileName("UserStat.txt");

if isLastBar Then
Begin

//RemoveFile deletes the file
RemoveFile( fileName );
PrintToFile( fileName, "Indicator was last used at: " +

FormatDate( DateTime, "yyyy/mm/dd"));
End;

/* A file is created with the entry: 'Indicator was last used at 2006/04/30'
At each start of the indicator, the existing file is deleted first. */
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ALERT OUTPUT

Ó ALERTWINDOW

General information on how to set up and use
the alert function can be found in "Alerts" on
page 329. You also have the option to output
alerts via Equilla. Please note that an alert is
only output if generated at the last bar of the
chart. Therefore it does not matter at which
position in the script the alert function is placed, since it is only executed when the
last bar is reached.

Variables:
myAlertText("");

If isLastBar Then
Begin

myAlertText = "The prices break down!"
alert( myAlertText );

End;

EQUILLA ARRAYS
The following article offers an introduction to arrays in Equilla.

Arrays in Equilla are similar to those in other programming languages. They are
data fields designed to contain large quantities of data. Each piece of data can be
retrieved via the unique position (index) in the array. With the help of additional
functions delivered with Tradesignal, a wide range of applications can be covered
with arrays.

Arrays are set to replace the "Equilla Vectors" on page 459 of earlier Tradesignal
versions. Any current script with vectors can easily be modified to use arrays
instead.

WHAT IS AN ARRAY?

In the basic Equilla article, variables were introduced as being "containers with an
identification number". Via the name of the variable, existing contents can be
called up or new contents can be assigned to the variable.
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While you can only save one value per variable, arrays are a lot more flexible - an
infinite number of values can be put into an array. To expand the container
comparison: arrays are containers that include an unlimited number of storage
spaces, like boxes in a container. Each box can be retrieved by its index (unique
position in the array).

By taking this container analogy one step further to a stack of containers, we get
to multidimensional arrays, most commonly described as arrays of arrays.

ARRAY DECLARATION

An array is treated similar to a variable. They are declared in a special declaration
block starting with the keyword Arrays. The name of the array variable has to be
followed by a pair of square brackets.

Arrays:
myVeryFirstArray[];

This array is initally empty and can later be resized to hold as many items as you
wish to store in it.

If you know in advance how many items you want to store in your array and don't
want to be able to resize it at a later time, you can declare it in this way.

Arrays:
myFixedSizeArray[10];

This creates an array with a maximum valid index of 10, but since indices start at
0, you can store 11 items in this array. Builtin functions ignore index 0, so you
should not use this place if you plan to use the builtin functions.

The declaration of a multidimensional array looks like this:

Arrays:
my2DArray[3,4];

This array can be interpreted as a spreadsheet having rows and columns.

[0,0] [0,1] [0,2] [0,3] [0,4]

[1,0] [1,1] [1,2] [1,3] [1,4]

[2,0] [2,1] [2,2] [2,3] [2,4]

[3,0] [3,1] [3,2] [3,3] [3,4]
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A built-in function would ignore any index containing a 0, but you are free to use
these items to store e.g. sums per row and column.

As with variables, you can create a global array. This way it is possible to call up
the array from several scripts. Global array are defined just like global variables
by adding a namespace for your global variables and :: in front of the array name.

Arrays:
myGlobals::myGlobalArray[];

ACCESSING ITEMS IN AN ARRAY

The storage places inside an array are adressed using the array name followed
by the unique index in square brackets.

Arrays:
myArray[10];

// assigns 23 to the storage place with index 1
myArray[1] = 23;
// prints the value contained in storage place with index 1, i.e. 23
Print( myArray[1] );

Arrays can include all data types available in Equilla.

OUTPUT CATENATED DATA
If you want to output the complete content of a array in a quick and easy way, you
can use several builtin functions. You can just use the print command and all
items stored in the array will be printed.

Arrays:
myArray[];

// fill the array with some values
FillArray( myArray, 12, 4, 2, 23 );
// output all values using the print command
Print( myArray );
// Print( myArray ) does the same as
// Print( myArray[1], myArray[2], myArray[3], myArray[4] )

In the output window appears

12 4 2 23

Or you can use Join() and have all items printed on a separate line using the
string constant NewLine.
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Arrays:
myArray[];

// fill the array with some values
FillArray( myArray, 12, 4, 2, 23 );
// output all values separated by a newline
Print( Join( NewLine, myArray ) );

Output window shows

12
4
2
23

READING THE ARRAY PROPERTIES

Some useful functions are available for reading the array properties. For
example, by using the ArrayLength( ) function, you receive the array size, i.e. the
number of items in it.

With other functions you gain information about the highest or lowest value in an
array (and their unique index in the array).

ArrayLength( ArrayName ) Returns the size of the array.

HighestArray( ArrayName ) Returns the highest value in the array.

IndexOfHighestArray( ArrayName ) Returns the index of the highest value in the
array.

LowestArray( ArrayName ) Returns the lowest value in the array.

IndexOfLowestArray( ArrayName ) Returns the index of the lowest value in the array.

With the following little routine you can test the functions listed above. When you
change the content of the FillArray( ) function, different values will be output.

Variables:
OutputText;

Arrays:
myArray[];

If isLastBar Then
Begin

//Fill the array with values
FillArray( myArray, 2, 4, 6, 8, 10, 2, 3, 5 );
//Output array contents
Print( "Array Contents: " + Join( ", ", myArray ) );
//Read the number of elements
OutputText = "Number of Elements: " + ArrayLength( myArray);
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//Output in the output window
Print( OutputText);
//Retrieve the highest value
OutputText = "Highest Value: " + HighestArray( myArray);
//Retrieve unique ID / position of highest value
OutputText = OutputText + " - at position No.: " +

IndexOfHighestArray( myArray);
//Output in the output window
Print( OutputText);
//Retrieve the lowest value
OutputText = "Lowest Value: " + LowestArray( myArray);
//Retrieve unique ID / position of lowest value
OutputText = OutputText + " - at position No.: " +

IndexOfLowestArray( myArray);
//Output in the output window
Print( OutputText);

End;

In the output window, the following appears:

Array contents: 2, 4, 6, 8, 10, 2, 3, 5
Number of elements: 8
Highest value: 10 - at position No.: 5
Lowest value: 2 - at position No.: 1

OVERVIEW OF ALL ARRAY FUNCTIONS

In the following you can find a list of all array functions in Equilla. More information
and examples for each function you can find in the Tradesignal help under
Equilla Formula Language, menu entry Arrays.

To open the Tradesignal help, click on the button with the yellow question mark in
the toolbox or in the header bar. In the Equilla editor, you can also right-click on
an Equilla function and select Lookup Equilla Function.

Function Description

AppendArray
Apppends an array or a single variable
to another array.

ArrayLength
Returns the length (and maximum
index) of an array.

Array_Copy
Copies some elements from one array
to another.

Array_GetType Returns the type of the array elements.

Array_Sort Sorts a range of elements in an array.
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Array_Sum
Returns the sum of all elements or the
number of true values in case of
booleans.

AverageArray
Returns the (mean) average of all or
some elements of the array.

AvgDeviationArray
Returns the average deviation of all or
some elements of the array.

BinarySearchArray
Returns the position of a given value
using a binary search.

ClearArray
Clears an array and resets it to its
initial state.

CompareArray Compares one array to another.

CopyArray
Copy all or some elements from one
array to another.

CreateSortedIndexArray
Creates a sorted index into another
array.

FillArray Fills an array with the given values.

GetArrayDimensions
Returns the number of dimensions of
an array.

HarmonicMeanArray
Returns the harmonic mean of all or
some elements of the array.

HighestArray Returns the highest value in the array.

IndexOfHighestArray
Returns the index of the highest value
in the array.

IndexOfLowestArray Returns the lowest value in the array.

InsertAtArray
Inserts a value into an array at a given
index.

InsertSortedArray
Inserts a value into an array keeping it
sorted.

KurtosisArray
Returns the Kurtosis value of all or
some elements of the array.

LowestArray Returns the lowest value in the array.
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MedianArray
Returns the median of all or some
elements of the array.

RemoveAtArray
Removes an element at a given index
from the array.

SearchArray Returns the position of a given value.

SetArrayLength Shrinks or grows a dynamic array.

SetValRangeArray
Sets a range of elements to a given
value.

SkewnessArray
Returns the skewness of all or some
elements of the array.

Sort2DArray
Sorts a 2-dimensional array by
columns.

SortArray Sorts some or all elements of an array.

StdDeviationArray
Returns the standard deviation of all or
some elements of the array.

StdErrorArray
Returns the standard error of all or
some elements of the array.

SummationArray
Returns the sum of all or some
elements of the array.

SummationRecArray
Returns the sum of reciprocals of all or
some elements of the array.

SummationSqrArray
Returns the sum of squares of all or
some elements of the array.

VarianceArray
Returns the variance of all or some
elements of the array.
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EQUILLA VECTORS
The following article offers an introduction to vectors in Equilla. Vectors are
deprecated in Tradesignal and are superseded by arrays.

Vectors in Equilla are the same kind of construction as those called arrays in
other programming languages. They are data fields designed to contain large
quantities of data. Each piece of data can be retrieved via the unique position
(index) in the vector. With the help of additional functions delivered with
Tradesignal, a wide range of applications can be covered with vectors.

WHAT IS A VECTOR?

In the "Equilla Basics" on page 397 article, variables were introduced as being
"containers with an identification number". Via the name of the variable, existing
contents can be called up or new contents can be assigned to the variable.

While you can only save one value per variable, vectors are a lot more flexible -
an infinite number of values can be put into a vector. To expand the container
comparison: vectors are containers that include an unlimited number of storage
spaces, like boxes in a container. Each box can be retrieved by its index (unique
position in the vector).

VECTOR DECLARATION

A vector is treated similar to a variable. In the variable declaration, the vector has
to be defined and named. The keyword Vector has to be added in brackets.

Variables:
myVeryFirstVector( Vector );

When you forget the keyword Vector, a variable of this name is available but
without the vector properties.
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As with variables, you can create a global vector. This way it is possible to call up
the vector from several scripts. Global vectors are defined as follows:

Variables:
myVeryFirstGlobalVector( GlobalVector );

READ AND WRITE DATA

Vectors offer the two basic features ReadVector() and WriteVector(). Both
functions need the name and the unique index to address the right storage place.
When writing a vector, you also need to pass the content to be written.

Vectors can include all data types available in Equilla.

WRITE DATA
Data is written into the vector with the WriteVector ( ) function. As parameters, the
vector name and the value to be written have to be passed. The size of the vector
is automatically adapted to the highest used index. Therefore, the possible length
of the future vector is irrelevant for the calculation.

Variables:
myVeryFirstVector( Vector );

If isLastBar Then
Begin

//The string 'Hello' is written at the position with ID 0
WriteVector( myVeryFirstVector, 0, "Hello");
//The string 'Rene' is written at the position with ID 1
WriteVector( myVeryFirstVector, 1, " Rene");

End;

OUTPUT CATENATED DATA
If you want to output the complete content of a vector in a quick and easy way,
you can use the function FormatVector. It is part of the delivered functions and
catenates all elements of a vector to one string. This can then be output with the
print command. The function is especially useful if you want to keep track of the
values while programming.

We expand the source code given above:

Variables:
myVeryFirstVector( Vector );

If isLastBar Then
Begin

//The string 'Hello' is written at the position with ID 0
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WriteVector( myVeryFirstVector, 0, "Hello");
//The string 'Rene' is written at the position with ID 1
WriteVector( myVeryFirstVector, 1, " Rene");
Print( FormatVector( myVeryFirstVector ));

End;

In the output window, the line "Hello Rene" appears.

READ DATA
Vector data can be read with the ReadVector ( ) function. As parameters, the
vector name and the index have to be passed.

Make sure that the program does not try to read from non-existing positions.
When this happens, Tradesignal aborts the execution with an error message in
the chart legend.

Variables:
myVeryFirstVector( Vector ), OutputText;

If isLastBar Then
Begin

//The string 'Hello' is written at the position with ID 0
WriteVector( myVeryFirstVector, 0, "Hello");
//The string 'Rene' is written at the position with ID 1
WriteVector( myVeryFirstVector, 1, " Rene");
OutputText = ReadVector( myVeryFirstVector, 0 );
OutputText = OutputText + ReadVector( myVeryFirstVector, 1 );
Print( OutputText );

End;

In the output window, the line "Hello Rene" appears.

READING THE VECTOR PROPERTIES

Some useful functions are available for reading the vector properties. For
example, by using the VectorLength( ) function, you receive the vector size, i.e.
the number of included elements.

With other functions you gain information about the highest or lowest value in a
vector (and their unique IDs in the vector). Please note that a vector indexing
always starts at zero. The first index is zero, the second is one and so on.

VectorLength( VectorName ) Offers the number of elements.

HighestVector( VectorName ) Offers the highest value in the vector as result.

IndexOfHighestVector( VectorName ) Offers the unique ID of the highest value in the
vector.
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LowestVector( VectorName ) Offers the lowest value in the vector as result.

IndexOfLowestVector( VectorName ) Offers the unique ID of the lowest value in the
vector.

With the following little routine you can test the functions listed above. When you
change the content of the FillVector( ) function, different values will be output.

Variables:
myVeryFirstVector ( Vector ), OutputText;

If isLastBar Then
Begin

//Fill the vector with values
FillVector( myVeryFirstVector , 2,4,6,8,10,2,3,5 );
//Output vector contents
Print( "Vector Contents: " + FormatVector( myVeryFirstVector ));
//Read the number of elements
OutputText = "Number of Elements: " + VectorLength( 

myVeryFirstVector );
//Output in the output window
Print( OutputText);
//Retrieve the highest value
OutputText = "Highest Value: " + HighestVector( myVeryFirstVector );
//Retrieve unique ID / position of highest value
OutputText = OutputText + " - at position No.: " +

IndexOfHighestVector( myVeryFirstVector );
//Output in the output window
Print( OutputText);
//Retrieve the lowest value
OutputText = "Lowest Value: " + LowestVector( myVeryFirstVector );
//Retrieve unique ID / position of lowest value
OutputText = OutputText + " - at position No.: " +

IndexOfLowestVector( myVeryFirstVector );
//Output in the output window
Print( OutputText);

End;

In the output window, the following appears:

Vector contents: '2', '4', '6', '8', '10', '2', '3', '5'

Number of elements: 8

Highest value: 10 - at position No.: 4

Lowest value: 2 - at position No.: 0
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FILL VECTORS WITH CONTENT AND DELETE CONTENT

To write a defined number of values into a vector, use the function FillVector( 
VectorName, Value1, Value2, ..). This function was already used in the example
above.

To delete the content of a vector, use the function ClearVector(VectorName).
This function deletes all elements in a vector and resets its size to zero. Use this
function when you reuse vectors in your program, except in cases when you want
to use old vector data.

Let us expand the source code of the example above by adding the delete
function:

Variables:
myVeryFirstVector ( Vector ), OutputText;

If isLastBar Then
Begin

//Fill the vector with values
FillVector( myVeryFirstVector , 2,4,6,8,10,2,3,5 );
//Output vector contents
Print( "Vector Contents: " + FormatVector( myVeryFirstVector ));
//Read the number of elements
OutputText = "Number of Elements: " + VectorLength( 

myVeryFirstVector );
//Output in the output window
Print( OutputText);
//Retrieve the highest value
OutputText = "Highest Value: " + HighestVector( myVeryFirstVector );
//Retrieve unique ID / position of highest value
OutputText = OutputText + " - at position No.: " +

IndexOfHighestVector( myVeryFirstVector );
//Output in the output window
Print( OutputText);
//Retrieve the lowest value
OutputText = "Lowest Value: " + LowestVector( myVeryFirstVector );
//Retrieve unique ID / position of lowest value
OutputText = OutputText + " - at position No.: " +

IndexOfLowestVector( myVeryFirstVector );
//Output in the output window
Print( OutputText);

Print( "Vector deleted!" );
ClearVector( myVeryFirstVector );

Print( "Vector contents: " + FormatVector( myVeryFirstVector ));

//Repeat all analysis:
OutputText = "Number of Elements: " + VectorLength( 

myVeryFirstVector );
//Output in the output window
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Print( OutputText);
//Retrieve the highest value
OutputText = "Highest Value: " + HighestVector( myVeryFirstVector );
//Retrieve unique ID / position of highest value
OutputText = OutputText + " - at position No.: " +

IndexOfHighestVector( myVeryFirstVector );
//Output in the output window
Print( OutputText);
//Retrieve the lowest value
OutputText = "Lowest Value: " + LowestVector( myVeryFirstVector );
//Retrieve unique ID / position of lowest value
OutputText = OutputText + " - at position No.: " +

IndexOfLowestVector( myVeryFirstVector );
//Output in the output window

End;

In the output window, the following appears:

Vector contents: '2', '4', '6', '8', '10', '2', '3', '5'

Number of elements: 8

Highest value: 10 - at position No.: 4

Highest value: 2 - at position No.: 0

Vector deleted!

Vector contents:

Number of elements: 0

Highest value: 0 - at position No.: -1

Highest value: 0 - at position No.: -1

As you can see, the vector is empty after the deletion. Due to this, some functions
output an error with the result "-1".

FINDING AND SORTING DATA

Some useful functions are available to navigate in a vector.

To find data in a vector, use the function SearchVector( VectorName,
SearchedValue).

To sort data, use the function SortVector( VectorName, SortAscending ).

To demonstrate the sorting, we modify the indicator of the deletion example. We
simply exchange the ClearVector( VectorName ) function with the sorting function
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SortVector( VectorName, SortAscending ). You can change the sorting direction
with true/false. Enter true for ascending and false for descending order.

Variables:
myVeryFirstVector ( Vector ), OutputText;

If isLastBar Then
Begin

//Fill the vector with values
FillVector( myVeryFirstVector , 2,4,6,8,10,2,3,5 );
//Output vector contents
Print( "Vector Contents: " + FormatVector( myVeryFirstVector ));
//Read the number of elements
OutputText = "Number of Elements: " + VectorLength( 

myVeryFirstVector );
//Output in the output window
Print( OutputText);
//Retrieve the highest value
OutputText = "Highest Value: " + HighestVector( myVeryFirstVector );
//Retrieve unique ID / position of highest value
OutputText = OutputText + " - at position No.: " +

IndexOfHighestVector( myVeryFirstVector );
//Output in the output window
Print( OutputText);
//Retrieve the lowest value
OutputText = "Lowest Value: " + LowestVector( myVeryFirstVector );
//Retrieve unique ID / position of lowest value
OutputText = OutputText + " - at position No.: " +

IndexOfLowestVector( myVeryFirstVector );
//Output in the output window
Print( OutputText);

SortVector( myVeryFirstVector , true );

//Repeat the analysis:
Print( "Vector contents: " + FormatVector( myVeryFirstVector ));
//Fill the vector with values
FillVector( myVeryFirstVector , 2,4,6,8,10,2,3,5 );
//Output vector contents
Print( "Vector Contents: " + FormatVector( myVeryFirstVector ));
//Read the number of elements
OutputText = "Number of Elements: " + VectorLength( 

myVeryFirstVector );
//Output in the output window
Print( OutputText);
//Retrieve the highest value
OutputText = "Highest Value: " + HighestVector( myVeryFirstVector );
//Retrieve unique ID / position of highest value
OutputText = OutputText + " - at position No.: " +

IndexOfHighestVector( myVeryFirstVector );
//Output in the output window
Print( OutputText);
//Retrieve the lowest value
OutputText = "Lowest Value: " + LowestVector( myVeryFirstVector );
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//Retrieve unique ID / position of lowest value
OutputText = OutputText + " - at position No.: " +

IndexOfLowestVector( myVeryFirstVector );
//Output in the output window
Print( OutputText);

End;

In the output window, the following appears:

Vector content: '2', '4', '6', '8', '10', '2', '3', '5'

The wanted value 10 is at position No.: 4

OVERVIEW OF ALL VECTOR FUNCTIONS

In the following you can find a list of all vector functions in Equilla. More
information and examples for each vector you can find in the Tradesignal help
under Equilla Formula Language, menu entry Vectors.

To open the Tradesignal help, click on the button with the yellow question mark in
the toolbox or in the header bar. In the Equilla editor, you can also right-click on
an Equilla function and select Lookup Equilla Function.

Vector Function

AppendVector()
Appends the contects of one vector
onto the end of another vector.

AverageVector()
Returns the average value (mean) of
the elements in a vector.

AvgDeviationVector()
Returns the average deviation of the
elements in a vector.

BinarySearchVector()
Returns the position of an element with
a specific value in a vector using a
binary search.

ClearVector()
Clears the contents of a vector and
sets its size to zero (0).

CompareVector()
Compares the elements in one vector
to those in another vector.

CopyVector()
Copies some or all of the elements
from one vector to another.

CreateSortedIndexVector() Creates a sorted index to a vector. The
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vector containing the actual data will
remain unchanged.

FillVector()
Fills a vector with the specified
elements.

GlobalVector()
Returns a newly created vector that
can be shared between scripts.

HarmonicMeanVector()
Returns the harmonic mean of the
values in a vector.

HighestVector()
Returns the highest element in a
vector.

IndexOfHighestVector()
Returns the zero based index of the
first occurrence of the highest element
in a vector.

IndexOfLowestVector()
Returns the zero based index of the
first occurrence of the lowest element
in a vector.

KurtosisVector()
Returns the Kurtosis value of the
elements in a vector.

LowestVector() Returns the lowest element in a vector.

MedianVector()
Returns the median of the elements in
a vector.

ReadVector()
Returns the value stored at a specific
index within a vector.

ReadVectorIndirect()
Returns the value stored at a certain
index within the data vector.

SearchVector()
Returns the position of an element with
a specific value in a vector.

SetMaxIndexVector()
Sets the largest index value for this
vector.

SetValRangeVector()
Sets a range of elements in a vector to
a specified value.

SkewnessVector()
Returns the skewness (the degree of
asymmetry) of the elements in a
vector.
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SortVector() Sorts the contents of the vector.

StdDeviationVector()
Returns the standard deviation of the
elements in a vector.

StdErrorVector()
Returns the standard error of the
elements in a vector.

SummationRecVector()
Returns the sum of reciprocals of each
element in a vector.

SummationSqrVector()
Returns the sum of squares of each
element in a vector.

SummationVector()
Returns the sum of all, or a range of
elements in the vector.

VarianceVector()
Returns the variance of the elements
in a vector.

Vector() Returns a newly created vector.

VectorLength()
Returns the number of elements
stored in a vector..

WriteVector()
Writes a value to a specific index
within a vector.

WriteVectorIndirect()

Writes a value to a specific index
within a vector. The index into the data
vector will be looked up via the index
vector.

EXTENDING EQUILLA
Tradesignal offers two ways of extending the equilla programming language.

C-API EXTENSIONS

C-API extensions are supported for backwards compatibility. They work by
exporting functions from dlls that are placed in a special folder. These functions
can be referenced from equilla using the Import statement. For a detailed
documentation read the article "C-API Extensions" on page 472.
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COM-API EXTENSIONS

These Extensions have been introduced with Tradesignal 6.3 and are the
preferred way of extending equilla. You can implement these extensions using
programming languages like C#, C++ or any other language that can output COM
compatible dlls. COM Extensions allow an Object style syntax to access the
implemented methods. For a detailed documentation read the article "COM-API
Extensions" on page 482.

EQUILLA TEXTFILEREADER
The TextFileReader object is an "COM-API Extensions" on page 482 that is
included as part of the standard Tradesignal installation. The TextFileReader
object presents an Application Programmers Interface (API) for reading text files
from the local workstation or network.

The full Visual Studio project and source code for the TextFileReader object are
included in the Tradesignal install directory under the Samples folder. The sample
project demonstrates how to create an Equilla COM-based extension using
unmanaged C++.

The TextFileReader will try to determine the encoding of the text file (ASCII, UTF-
8, UTF-16, etc.).

USAGE EXAMPLE

This example indicator will read a text file (identified by filename input) and output
the file line by line to the Tradesignal output window with line numbering:

Input:
Filename( "C:\MyTextFile.txt" ); // Replace this with a path to an

existing text file.

Object:
textFileReader( "EquillaExt.TextFileReader" );

Variables:
currentLine( "" ), lineNumber( 0 );

If CurrentBar = 1 Then Begin
If textFileReader.OpenTextFile( Filename ) Then Begin

While textFileReader.IsEOF() = False Begin
currentLine = textFileReader.ReadLine();
lineNumber = lineNumber + 1;

// Do something with the line, e.g.:
Print( lineNumber, currentLine );
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End;

textFileReader.CloseFile();
End;

End;

Note: Before you can compile the above sample, you may need to enable Equilla
extensions using the option under File > Tradesignal Options > Equilla.

TEXTFILEREADER INTERFACE

[ProgId("EquillaExt.TextFileReader")]
interface ITextFileReader
{

// Tries to open a text file with the specified name, returns true if
file is opened

bool OpenTextFile(string Filename);

// Ensures any previously opened file is closed, returns true if file is
closed

bool CloseFile();

// Tries to read a line of text from the currently open text file. The
resulting text

// does not contain line end markers.
string ReadLine();

// Tries to read a specific number of characters from the currently open
file. The resulting

// text may contain line end markers.
string ReadChars(int NumberOfChars);

// Returns the creation date and time of the currently open text file.
DateTime GetCreateDate();

// Returns the last write date and time of the currently open text file.
DateTime GetModifyDate();

// Returns the length in bytes of the currently open text file.
int GetFileLength();

// Returns the current read position for the currently open text file.
int GetFilePosition();

// Moves the read position for the currently open text file to the
specified value,

// returns true if successful
bool SetFilePosition(int Position);

// Returns true if the read position for the currently open text file
has reached
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// the end of the file.
bool IsEOF();

// Returns if the text file is currently open.
bool IsOpen();

// Returns the name and path of the currently open text file.
string GetFilename();

}
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EXTENDING EQUILLA

C-API EXTENSIONS
Equilla, the formula language of Tradesignal, is a powerful way to describe your
trading strategies. There are cases when you may need additional functionality
which is not directly available in Equilla. To address this issue the language can
be extended via Dynamic Link Libraries (DLLs) using the Equilla Extension
Application Programmer's Interface (API).

WHAT IS AN EQUILLA EXTENSION

Equilla Extension libraries are DLLs containing one or more functions. These
functions must have a specific signature in order to be compliant with Equilla.

HOW TO ACCESS AN EQUILLA EXTENSION FROM EQUILLA

To use an extension function from a script you have to first make sure the DLL is
in the correct place on your system, and then you must add a reference to the
function at the start of your Equilla script.

WHERE TO PUT THE EQUILLA EXTENSION
All Equilla Extension libraries have to be placed in the directory where
Tradesignal is installed.

You can specify a different directory for Extension DLLs in the options under File
> Options > Folders > Equilla Paths.

HOW TO USE EXTENSION FUNCTIONS
Assuming you have an Equilla Extension DLL called MyEquillaExtension.dll
containing a function called MyMovingAverage that takes price and period
parameters, you would first import the function using the following Equilla
command:

Import( "MyMovingAverage", "MyEquillaExtension.dll" );

You can then use the function as you would use a normal Equilla function.

DrawLine( MyMovingAverage( Close, 10 ), "Avg" );

Note: Each function from the DLL must have it's own import statement.
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HOW TO IMPORT A FUNCTION THAT HAS THE SAME NAME AS AN
EXISTING EQUILLA FUNCTION
You can easily import a function and give it an alternate name as a third
parameter to the Import command.

Import( "MyMovingAverage", "MyEquillaExtension.dll", "RenamedMovingAverage"
);

DrawLine( RenamedMovingAverage( Close, 10 ), "Avg" );

HOW TO WRITE AN EQUILLA EXTENSION IN MICROSOFT
VISUAL C++ 2005

The Equilla Extension API is described in the EquillaApi.h file, which is located in
the Include sub-directory of your Tradesignal installation. In order to create
Equilla Extension libraries you have to add the directory to the Include files
directory of Visual Studio under Tools > Options > Projects and Solutions > VC++
Directories.

Follow these steps to create a sample project:

à Create a new Visual C++ DLL project

01. File > New > Project... > Visual C++ > Win32 Console
Application

02. Type a name for the new project for example
MyEquillaExtension.

03. PressOK

04. Select the Application Settings and set the application type
to DLL

05. Press Finish

à Include the Equilla interface description and dependencies by
adding the following lines to the top of the
MyEquillaExtension.cpp file, below the #include "stdafx.h"
line:

#include <wtypes.h>
#include <oleauto.h>
#include <EquillaApi.h>
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à Add the following function to the bottom of the
MyEquillaExtension.cpp file:

Note: All Equilla Extension functions must be declared with the following function prototype.

EQUILLA_API int MyMovingAverage( DWORD scriptID, int argc, EqVariable*
variables[],

VARIANT* result )
{

// check that the number of parameters passed to this function is two
(Price and Period)

if (argc != 2)
return EQUILLA_ARGUMENT_ERROR;

// extract the period value from the second parameter
VARIANT vPeriod;
VariantInit(&vPeriod);
variables[1]->GetValue(&vPeriod); // read the latest value from the

variable

// ensure the period parameter is valid
if (V_I4(&vPeriod) < 1)

return EQUILLA_ARGUMENT_ERROR;

// calculate the sum of all prices for the given period
double sum = 0.0;
VARIANT vPrice;
VariantInit(&vPrice);
for (int index = 0; index < V_I4(&vPeriod); ++index)
{

variables[0]->GetValue(index, &vPrice); // read a historic value
from the variable

sum += V_R8(&vPrice);
VariantClear(&vPrice); // release any allocated memory

}

// write the equilla result and set the type to a 8-byte floating point
value

V_VT(result) = VT_R8;
V_R8(result) = sum / V_I4(&vPeriod);

// clean up and return successfully
VariantClear(&vPeriod);

return EQUILLA_SUCCESS;
}

à Compile the project and copy the DLL to the Equilla Extension
DLLs directory
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Note: Ensure you are compiling a 32-bit DLL otherwise it can not be used from Equilla!

You can now access this function from Equilla as described above.

EXTENSION FUNCTION ARGUMENTS AND RETURN VALUE
All Equilla Extension functions have the same prototype as shown above. The
parameters are:

Parameter Description

DWORD scriptID
A value that uniquely identifies the
instance of an Equilla script calling this
function

int argc
The number of parameters being
passed into this function from the
Equilla script

EqVariable* variables[]
An array of the parameters passed into
this function from the Equilla script

VARIANT* result
A pointer to a variable receiving the
result of the function that will be
passed to the Equilla script

The return value is an integer that must be one of the following constants:

Return value Description

EQUILLA_SUCCESS The function has completed successfully

EQUILLA_
ARGUMENT_ERROR

The is a problem with one or more of the parameters
passed into the function

EQUILLA_GENERAL_
ERROR

Any other error has occurred

WORKING WITH EQUILLA VARIABLES
The EqVariable object represents a variable that has been passed to this function
from an Equilla script. You can use the object to access the latest value of the
variable or a historic value (from a previous bar). All values accessed via the
EqVariable object will be returned as VARIANTs.
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Note: A VARIANT is generic variable that can hold data of various different types; for an
overview of working with VARIANTs see below.

à To access the latest value of the variable:

VARIANT vValue;
VariantInit(&vValue);
variables[0]->GetValue(&vValue);

// convert the value into a string
VariantChangeType(&vValue, &vValue, VT_BSTR);

// include windows.h to use the MessageBoxW function
MessageBoxW(NULL, V_BSTR(&vValue), L"The value is", MB_OK);

VariantClear(&vValue);

à To access the value of the variable from the previous bar
(assuming this is a series variable):

VARIANT vPreviousValue;
VariantInit(&vPreviousValue);
variables[0]->GetValue(1, &vPreviousValue);

// do something with the variable here

VariantClear(&vPreviousValue);

HOW TO DEBUG AN EQUILLA EXTENSION IN MICROSOFT
VISUAL STUDIO 2005

Caution: Before you start the debugger, ensure that Visual Studio is in native debugger
mode. This can be enabled as followed:

01. Right-Click on the project in the Solution Explorer and select
Properties

02. Click on the Configuration Properties > Debugging in the tree
view on the left

03. Locate the Debugger Type property and change it's value to
Native Only

04. ClickOK to close the dialog.

à To start debugging your DLL:
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01. Start Tradesignal and change the property File > Tradesignal
Options > Equilla > File Locations > Equilla Extension DLLs to
the build directory of your project (this will normally be in the
sub folder called Debug).

02. ClickOK. Then shut down Tradesignal.

03. In Visual Studio ensure that this is the Debug build
configuration and select Debug > Start Debugging from the
menu.

04. A dialog will open asking you for the executable to run. Enter
the location of the tse.exe file from the Tradesignal installation
directory on your system and clickOK.
The application will now start, you should use your extension function in a
new script as described above.

05. Set breakpoints in visual studio and then apply your Equilla
script to a Chart, Watchlist or Scanner. Execution will be
automatically interrupted when one of your breakpoints is hit.

ADVANCED TOPICS

HOW DO I INITIALIZE AND CLEANUP GLOBAL DATA IN MY
EQUILLA EXTENSION
If you want to write a library of functions that maintain some global state from call
to call you will need to use global variables in your DLL. This can cause problems
in determining when to initialize and free these global variables. To solve this
problem, there are two optional functions that you can add to your extension DLL
that will be called once when a script containing functions from your DLL is added
to a chart, and once when it is removed from a chart. The following example
illustrates how these functions are used:

Note: The prototypes and names of the DllAttachScript() and DllDetachScript() functions
must be exactly the same as in the example.

#include "stdafx.h"
#include <wtypes.h>
#include <oleauto.h>
#include "EquillaApi.h"
#include <map>

BOOL APIENTRY DllMain(HMODULE hModule, DWORD dwReason, LPVOID lpReserved)
{

return TRUE;
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}

class CGlobalCounter
{
public:

static CGlobalCounter& Instance()
{

// This is not thread-safe, included only for the brevity of the
example

static CGlobalCounter singleton;
return singleton;

}

void Add(DWORD nScriptId)
{

EnterCriticalSection(&m_hCS);
m_barCounts[nScriptId] = 0;
LeaveCriticalSection(&m_hCS);

}

void Remove(DWORD nScriptId)
{

EnterCriticalSection(&m_hCS);
m_barCounts.erase(nScriptID);
LeaveCriticalSection(&m_hCS);

}

int Increment(DWORD nScriptId)
{

EnterCriticalSection(&m_hCS);
int nResult = ++m_barCounts[nScriptId];
LeaveCriticalSection(&m_hCS);
return nResult;

}
private:

CGlobalCounter()
{

InitializeCriticalSection(&m_hCS);
}

CGlobalCounter(const CGlobalCounter&);
CGlobalCounter& operator=(const CGlobalCounter&);

std::map<DWORD, int> m_barCounts;
CRITICAL_SECTION m_hCS;

};

EQUILLA_API void DllAttachScript(DWORD nScriptId)
{

CGlobalCounter::Instance().Add(nScriptId);
}

EQUILLA_API void DllDetachScript(DWORD nScriptId)
{
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CGlobalCounter::Instance().Remove(nScriptID);
}

//call this function once on each bar to get the current bar count
EQUILLA_API int BarCount(DWORD nScriptID, int argc, EqVariable* variables[],
VARIANT* result)
{

V_VT(result) = VT_I4;
V_I4(result) = CGlobalCounter::Instance().Increment(nScriptId);
return EQUILLA_SUCCESS;

}

Note: Because this DLL can be used by multiple scripts instances at the same time it is
important to separate the global data of each script in some way. In the example above we
use a map that stores the bar count against a given scriptID. We recommend you use a
similar approach in your own DLLs changing the int data type to whichever data you need to
store.

WORKING WITH THE VARIANT DATA TYPE
A VARIANT is a variable that can hold any type of data, it maps quite closely to
the types of variables that are used in Equilla. The trick to using variants in your
Extension DLL is in correct initialization/de-initialization and in accessing the
correctly typed data.

DECLARING AND RELEASING VARIANTS

Whenever you declare a variant in your code you should always initialize it in the
following way:

VARIANT vPrice;
VariantInit(&vPrice);

Whenever you have finished with the variant (even in an error case) you should
clear the variant in the following way:

VariantClear(&vPrice);

READING AND WRITING DATA

The following example demonstrates the important variant functions to use to
read and write various data types from and to a variant:

// initialize the variant
VARIANT vValue;
VariantInit(&vValue);
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// Write and read a double value (like a price) to a variant
double nPrice = 12.1;
V_VT(&vValue) = VT_R8; // set the underlying type of the variant
V_R8(&vValue) = nPrice;
double nNewPrice = V_R8(&vValue);
VariantClear(&vValue);

// Write and read an integer value (like a period) to a variant
int nPeriod = 14;
V_VT(&vValue) = VT_I4; // set the underlying type of the variant
V_I4(&vValue) = nPeriod;
int nNewPeriod = V_I4(&vValue);
VariantClear(&vValue);

// Write and read a Boolean value (a true/false value) to a variant
bool bValue = true;
V_VT(&vValue) = VT_BOOL; // set the underlying type of the variant
V_BOOL(&vValue) = bValue ? VARIANT_TRUE : VARIANT_FALSE;
bool bNewValue = V_BOOL(&vValue) != VARIANT_FALSE;
VariantClear(&vValue);

// Write and read a string value to a variant
LPCWSTR sValue = L"Text";
V_VT(&vValue) = VT_BSTR; // set the underlying type of the variant
V_BSTR(&vValue) = SysAllocString(sValue); // you have to create a BSTR from
the input string
BSTR sNewValue = SysAllocString(V_BSTR(&vValue)); //SysFreeString needs to
be called once sNewValue is not required anymore
VariantClear(&vValue);

// Write and read a date/time (OLE Datetime) to a variant
SYSTEMTIME stLocal = {0};
DATE dtOle = 0;
GetLocalTime(&stLocal);
SystemTimeToVariantTime(stLocal, &dtOle);
V_VT(&vValue) = VT_DATE;
V_DATE(&vValue) = dtOle;
DATE dtNewOle = V_DATE(&vValue);
VariantClear(&vValue);

CHECKING FUNCTION PARAMETERS ARE THE CORRECT TYPE

Due to the data types used by the Equilla engine, you should always check if the
type of a given parameter is what you expect. If the type differs from what you
expect you can use the VariantChangeType function to perform the conversion
as the following sample demonstrates (this is the same moving average example
as shown above but with this checking added):

EQUILLA_API int MyMovingAverage( DWORD scriptID, int argc, EqVariable*
variables[],

VARIANT* result )
{
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// check that the number of parameters passed to this function is two
(Price and Period)

if (argc != 2)
return EQUILLA_ARGUMENT_ERROR;

// extract the period value from the second parameter
VARIANT vPeriod;
VariantInit(&vPeriod);
variables[1]->GetValue(&vPeriod); // read the latest value from the

variable

// ensure the period parameter is an integer
if (V_VT(&vPeriod) != VT_I4 && FAILED(VariantChangeType(&vPeriod,

&vPeriod, VT_I4)))
{

VariantClear(&vPeriod);
return EQUILLA_ARGUMENT_ERROR;

}

// ensure the period parameter is valid
if (V_I4(&vPeriod) < 1)

return EQUILLA_ARGUMENT_ERROR;

// calculate the sum of all prices for the given period
double sum = 0.0;
VARIANT vPrice;
VariantInit(&vPrice);
for (int index = 0; index < V_I4(&vPeriod); ++index)
{

variables[0]->GetValue(index, &vPrice); // read a historic value
from the variable

// ensure the price is a double
if (V_VT(&vPrice) != VT_R8 && FAILED(VariantChangeType(&vPrice,

&vPrice, VT_R8)))
{

VariantClear(&vPeriod);
VariantClear(&vPrice);
return EQUILLA_ARGUMENT_ERROR;

}

sum += V_R8(&vPrice);
VariantClear(&vPrice); // release any allocated memory

}

// write the equilla result and set the type to a 8-byte floating point
value

V_VT(result) = VT_R8;
V_R8(result) = sum / V_I4(&vPeriod);

// clean up and return successfully
VariantClear(&vPeriod);

return EQUILLA_SUCCESS;
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}

CONVERTING VARIANTS TO STRINGS

One of the most common conversion tasks is taking a variant (such as a price)
and converting it into a string for output, this can be accomplished in the following
way:

double nPrice = 12.1;

VARIANT vPrice;
VariantInit(&vPrice);
V_VT(&vPrice) = VT_R8;
V_R8(&vPrice) = nPrice;

// convert the value into a string
VariantChangeType(&vPrice, &vPrice, VT_BSTR);

// include windows.h to use the MessageBoxW function
MessageBoxW(NULL, V_BSTR(&vPrice), L"The value is", MB_OK);

VariantClear(&vPrice);

COM-API EXTENSIONS
The following article offers an introduction to COM-API Extensions for Equilla
(note: available in Tradesignal 6.3 and above)

WHAT ARE COM-EXTENSION OBJECTS
Equilla COM-Extensions are COM-Objects that implement a special set of
interfaces. Each COM-Object can provide one or more Extension objects by
implementing one or more interfaces derived from the "IEquillaExtension
Interface" on page 491. These objects are referenced from equilla by using the
Prog-ID or the CLSID and an optional interface name. Extension COM-Objects
need to be registered with the system so they can be instantiated via the
Windows CoCreateInstance mechanism. For a detailed step-by-step guide to
create COM-Extensions read the section "How to write a COM Extension" on
page 485 and check out the samples projects installed with Tradesignal.

HOW TO USE COM-EXTENSION OBJECTS
Equilla objects are created similar to Variables, by adding an Objects:-Block to
the script and declaring the objects you want to use. For every object within a
script one extension object will be instantiated. If you use the same indicator
multiple times separate extension objects will be created for every script instance.
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Objects:
myObject("ProgID");

myObject.MyMethod();

For a detailed description of the Object syntax see the Equilla help.

Caution: COM API Extension modules must be enabled in the options by selecting the
setting at File > Options > Advanced > Equilla Extension.

LIFETIME OF AN EXTENSION OBJECT
All extension objects go through a common life cycle.

à Creation

à There are multiple reasons why an extension object can be
created.

à By the equilla editor to provide auto completion support.

à By the compiler to validate that the script is correct.

à Because the compiled script is loaded (e.g. indicator added to
a chart)

à If the extension object was loaded by the compile or editor no
further actions will be performed and the object will be
released shortly after. In case it was created by loading script
the following actions will occur.

à Attach Session (optional)

à After loading a compiled script the virtual machine will first
attach a session object. This is an optional step that is only
performed if your extension implements the
"ISupportSessions Interface" on page 493.

à Attach Host Object (IEquillaExtension)

à This call on the "IEquillaExtension Interface" on page 491 is
done before the actual script evaluation starts. It supplies the
extension object with a thread safe Host-Object that can be
used to trigger reevaluation of the script an provides
information about the executing context.

à Script Evaluation Phase

à While a script is evaluated bar-by-bar, methods will be called
and signals will be passed to the extension object.
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à Methods called by script evaluation
Once the script evaluation has started the virtual machine will
call methods of your object as instructed by the script. These
methods can contain multiple arguments of different type and
a return value, as explained in "Extension Supported
Parameter Types" on page 500.

à Signals received (optional)
If your COM-Object implements any one of the Signal-Sink
interfaces ("Extension Signals and Sinks" on page 495)
signals will be passed to your extension after a bar is
evaluated. SymbolStateChanged and interactive script alerts
can be received at any time.

à Detach (IEquillaExtension)

à After script evaluation has stopped (e.g. indicator was
removed from a chart) the Detach() method will be called on
the IEquillaExtension Interface. Shortly after this the COM
object will be released. All necessary clean up work should be
performed at this point.

YOUR EXTENSION INTERFACE
The extension interface has to be derived from IEquillaExtension Interface and it
should be the default interface of your COM-Object. If it is not the default interface
the user will have to explicitly name it every time he wants to instantiate an equilla
object.

Equilla extension interfaces requirements and limitations:

à Limited set of return and argument types (see "Extension
Supported Parameter Types" on page 500)

à Properties are not supported

à default values are not supported

à only 'dual' interfaces are supported

EXAMPLE PROJECTS
A few sample projects are shipped with Tradesignal. They are located in the
install folder of Tradesignal.

à ExcelOrderTracker (C#)

à Demonstrates direct data transfer to Microsoft-Excel.
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à RSSExtension (C#)

à Query of RSS 2.0 and Atom 1.0 data feeds, reacting on user
interaction and display of custom user interface elements.
This Extension is accompanied by the RSS-Indicator that can
be found int the standard Tradesignal package.

à TextFileReader (C++)

à Reading and processing of text file from an equilla script.

HOW TO WRITE A COM EXTENSION
In this tutorial we will focus on using C# with Visual Studio 2008 (other versions of
Visual Studio will work in much the same way). It is also relatively straight-forward
to create extension objects in unmanaged C++ using ATL, and is preferable
where raw performance is required. The TextFileReader sample project found in
the installation directory of Tradesignal demonstrates how this is done.

OBJECTIVE

Create an Equilla extension object that can compute a Simple Moving Average
and play a sound from the local hard disk.

CREATING A PROJECT FILE

The first task is to create an appropriate project:

à Start Visual Studio 2008 (as administrator when running
Windows Vista or above)

à Select File > New > Project... > Visual C# > Class Library

à Enter a name for the Project (e.g. "SoundAverage") and click
OK.

à A project containing a single class called Class1 should have
been created

Once the project is created we must add a reference to the EquillaExtension.dll:

à Select Project > Add Reference... > COM > Tradesignal
EquillaExtension 1.0 Type Library and clickOK.
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DEFINING THE INTERFACE

The next task is to define what the interface for our new object will be and then to
make it visible via COM:

Open the Class1.cs file if it is not already open and inside the namespace
SoundAverage block add the following:

namespace SoundAverage
{

public interface ISoundAverage
{

double SimpleAverage(EquillaExtension.IDoubleSeries prices, int
length);

void PlaySound(string path);
}

public class Class1
{
}

}

Next we must make the interface visible to COM, this requires us to indicate it is
COM visible and to specify a unique class ID (a GUID). Both of these can be set
by specifying attributes as follows:

using System.Runtime.InteropServices;

namespace SoundAverage
{

[ComVisible(true)]
[Guid("E4AF0866-A1DB-462f-A304-4ED46EB7C2E6")]
public interface ISoundAverage
{

double SimpleAverage(EquillaExtension.IDoubleSeries prices, int
length);

void PlaySound(string path);
}

public class Class1
{
}

}

Caution: All classes and interfaces that we create must have a unique GUID, the tool under
Tools > Create GUID is a simple way to create a new GUID.
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Caution: Once an interface is created and deployed it must never change, it is one of the
ground rules of COM development. If you want to add more methods to a deployed interface
you must create new interfaces.

ADDING HELP STRINGS TO THE INTERFACE

Extension objects are supported by the auto suggest and insight help features of
the Equilla Editor. In order to display help messages we must adorn our interface
and members with Description attributes:

using System.Runtime.InteropServices;
using System.ComponentModel;

namespace SoundAverage
{

[ComVisible(true)]
[Guid("E4AF0866-A1DB-462f-A304-4ED46EB7C2E6")]
[Description("Calculates a moving average and plays sounds")]
public interface ISoundAverage
{

[Description("Returns the result of a simple moving average")]
double SimpleAverage(EquillaExtension.IDoubleSeries prices, int

length);

[Description("Asynchronously plays the .WAV file specified by the
file name")]

void PlaySound(string path);
}

public class Class1
{
}

}

IMPLEMENTING THE EXTENSION OBJECT

Now that we have our interface, we can create a class that uses it.

First of all we must implement our interface (we will ignore error handling for the
sake of brevity, and because the Equilla compiler and runtime engine will display
exceptions in a useful way if they occur):

public class Class1 : ISoundAverage
{

double ISoundAverage.SimpleAverage(EquillaExtension.IDoubleSeries
prices, int length)

{
double sum = 0;
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for (int i = 0; i < length; ++i)
sum += prices.GetValue(i);

return sum / length;
}

void ISoundAverage.PlaySound(string path)
{

System.Media.SoundPlayer player = new System.Media.SoundPlayer
(path);

player.Play();
}

}

Next we must implement the IEquillaExtension interface, without this interface
Tradesignal will not recognize the object:

public class Class1 : ISoundAverage, EquillaExtension.IEquillaExtension
{

double ISoundAverage.SimpleAverage(EquillaExtension.IDoubleSeries
prices, int length)

{
double sum = 0;
for (int i = 0; i < length; ++i)

sum += prices.GetValue(i);

return sum / length;
}

void ISoundAverage.PlaySound(string path)
{

System.Media.SoundPlayer player = new System.Media.SoundPlayer
(path);

player.Play();
}

void EquillaExtension.IEquillaExtension.Attach
(EquillaExtension.IEquillaHost Host)

{
}

void EquillaExtension.IEquillaExtension.Detach()
{
}

}

We do not need to use the IEquillaExtension methods in this case.

We must next make the class visible to COM, indicate the default COM interface,
and provide a suitable name (Prog ID) with which we will create the object from
Equilla:
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[ComVisible(true)]
[Guid("516024B3-0D76-4d5b-97AE-65F3A30E0C8A")]
[ComDefaultInterface(typeof(ISoundAverage))]
[ProgId("SoundAverage.Class1")]
public class Class1 : ISoundAverage, EquillaExtension.IEquillaExtension
{

double ISoundAverage.SimpleAverage(EquillaExtension.IDoubleSeries
prices, int length)

{
double sum = 0;
for (int i = 0; i < length; ++i)
sum += prices.GetValue(i);

return sum / length;
}

void ISoundAverage.PlaySound(string path)
{

System.Media.SoundPlayer player = new System.Media.SoundPlayer
(path);

player.Play();
}

void EquillaExtension.IEquillaExtension.Attach
(EquillaExtension.IEquillaHost Host)

{
}

void EquillaExtension.IEquillaExtension.Detach()
{
}

}

Our COM-based extension object is almost ready, we just need to build it and
register it.

01. First indicate it should be registered automatically after it is
built by checking the option: Project > SoundAverage
Properties... > Build > Output > Register for COM interop

02. Now, select Build > Build Solution to build the DLL.

Now we have a built and registered COM-based Equilla Extension Object which
could now be "How to deploy a COM Extension" on the next page.

USING THE EXTENSION FROM EQUILLA

To use the object from Equilla we must first create a new indicator called
LoudSMA after starting Tradesignal.

Next we must create an instance of our object as follows:
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Object:
soundAverage( "SoundAverage.Class1" );

Notice how we use the same ID string as we declared in the ProgID attribute
when we created the object.

Finally we can call the functions on the soundAverage object to plot a SMA and
make an audio alert based on a sound file when a cross over occurs (we assume
the file exists at the specified location).

Inputs:
Price( Close ),
Length( 14, 1 ),
AlertFile( "C:\alert.wav" );

Object:
soundAverage( "SoundAverage.Class1" );

Variable:
lsma;

lsma = soundAverage.SimpleAverage( Price, Length );

DrawLine( lsma, "LSMA" );

If Price Crosses Over lsma Then
soundAverage.PlaySound( AlertFile );

HOW TO DEPLOY A COM EXTENSION
Once a COM Equilla extension has been created, it must be deployed to a target
workstation. Deployment is fairly straight-forward, consisting of the following
steps:

à Ensure prerequisites are installed (e.g. Tradesignal and
correct version of C or .NET runtimes if Visual Studio 2008 is
not used)

à Copy the Extension DLL

à Register the Extension DLL (either with regsvr32.exe for C++
DLLs or regasm.exe for .NET DLLs)

à Copy any indicator package created with Tradesignal

à Register the indicator package for auto discovery on
Tradesignal start
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These steps are best combined into a setup for ease of distribution. Packages
such as InstallShield can handle all of the registration issues automatically.

DEPLOYING AN EXTENSION WITH A SETUP

The best way to distribute a library of indicators and/or strategies that include one
or more Equilla extension DLLs is to use a setup.

First create the package in Tradesignal and copy the extension DLLs into the
folder that contains the package contents using Windows Explorer.

Next, add this package folder including indicators, functions, strategies, manifest
file and extension DLLs to a setup project (for example InstallShield). Already
compiled indicators and strategies make it easier to use the deployed extension.

Mark any Extension DLLs as requiring registration:

à In InstallShield C++ DLLs should be marked as Extract COM
Information at Build

à In InstallShield .NET DLLs should be marked as Register for
.NET COM interop

Now instruct the setup to add a string value to the following registry key, with a
unique name (GUID) and a value that contains the folder path on the target
machine of the installed package:

HKEY_LOCAL_
MACHINE\Software\Tradesignal\TradeSignalEnterprise\Packages

This will make Tradesignal automatically add the package when it is next started.

Finally, build and test the setup.

IEQUILLAEXTENSION INTERFACE
An extension object must implement the IEquillaExtension interface so that
Tradesignal will recognize the object as a valid extension.

interface IEquillaExtension
{

void Attach(IEquillaHost Host);
void Detach();

}
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When an object is first created the Attach() method will be called by Tradesignal
with a deployed to other users workstations "IEquillaHost Interface" below object
as the only parameter. The majority of initialization should be performed in the
Attach() method rather than the objects constructor. The Host object is a thread-
safe object that allows an extension module to communicate with the hosting
chart or list.

When the Equilla script that declares the extension object is removed from a chart
or list, the Detach() method will be called, allowing the extension object to preform
clean-up. The majority of the clean-up of the object should be done in the Detach
() method rather than the objects destructor.

IEQUILLAHOST INTERFACE
The interface provides access to methods on the chart or list that is hosting the
"COM-API Extensions" on page 482.

interface IEquillaHost
{

void ScheduleEvaluation( bool Incremental );
string TimeZone { get; }
int OwnerHandle { get; }

}

The IEquillaHost interface is implemented by the Host object that is passed to
each extension module shortly after creation. The Host object is thread-safe
(neutral threaded) and may be passed between and used from various threads
without restriction.

VOID SCHEDULEEVALUATION( BOOL INCREMENTAL )
Call this method to instruct the hosting chart or list to perform a new evaluation of
the Equilla script that created the extension object. This method is non-blocking
and the evaluation will occur in the near future in much the same way as if a tick
had been received.

If Incremental is set to true only the current bar will be reevaluated, if Incremental
is set to false, the entire price history and any dependencies will be reevaluated.

Note: Performing frequent non-incremetal evaluations will result in a severe reduction in
system performance.
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STRING TIMEZONE
Returns the current application timezone in Windows Timezone ID Format. This
string can be be used directly by the .NET
System.TimeZoneInfo.FindSystemTimeZoneById() method.

System.TimeZoneInfo equillaTimeZone =
System.TimeZoneInfo.FindSystemTimeZoneById( Host.TimeZone );

INT OWNERHANDLE
Returns the windows handle of an object that may be used as the parent of any
windows that the extension object wants to show.

// Helper object to convert a windows ID to a IWin32Window object.
class WindowWrapper : IWin32Window
{

public WindowWrapper( int handle )
{

Handle = new IntPtr( handle );
}

public IntPtr Handle { get; private set; }
}

// Show a message box that is owned by the Tradesignal application
System.Windows.Forms.MessageBox.Show( new WindowWrapper( Host.OwnerHandle ),
"A message from an extension" );

ISUPPORTSESSIONS INTERFACE
An extension object may implement the ISupportSessions interface in order to
share a common "IEquillaExtensionSession Interface" on the next page object
between all instances of the extension object used inside a single chart (or
portfolio). Sessions provide a mechanism for multiple indicators within a chart to
share a common resource, for example a connection to an external server.

interface ISupportSessions : IDispatch
{

IEquillaExtensionSession CreateSessionObject();
void AttachSession(IEquillaExtensionSession Session);

}

The first time an extension object is created that implements this interface, a chart
will call the CreateSessionObject() factory method, which must return an object
that implements the "IEquillaExtension Interface" on page 491. The newly

493



created session will immediately be passed back to the extension object via a call
to AttachSession().

Following the creation of other extension objects of the same type within the
same chart, the AttachSession() method will also be called with the original
session passed as the only parameter.

The example project RSSExtension uses a session object to manage a pool of
RSS feeds so that the same data does not need to be re-requested by each use
of the RSS indicator within a chart.

The example project ExcelOrderTracker uses a session object to manage a
single Excel workbook that all instruments within a chart will forward strategy data
to.

IEQUILLAEXTENSIONSESSION INTERFACE
A session object may be created and shared between all instances of an
extension object used within a single chart (or portfolio). Such a session object
must implement the IEquillaExtensionSession interface.

interface IEquillaExtensionSession
{

void Attach();
void Detach();

}

An extension session object will only ever be created by an extension object that
implements the "ISupportSessions Interface" on the previous page interface.

Shortly after the session object is returned from the
ISupportSessions.CreateSessionObject() method, the Attach() method will be
called. It is expected that the majority of the construction logic for the session
object will be performed in this method instead of the object's constructor.

When the last extension object that uses a session is removed from the chart (or
portfolio), the Detach() method will be called, so that the extension session can
perform clean-up. It is expected that the majority of the destruction logic for the
session object will be performed in this method instead of the object's destructor.

EQUILLACONSTANTS CLASS
The EquillaConstants object provides access to standard values used within
Equilla scripts that may be needed within an extension object.
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interface IEquillaConstants
{

double InvalidValue { get; }
DateTime InvalidDate { get; }

}

The InvalidValue constant can be used to test if a price parameter is set to the
Equilla Invalid value.

The InvalidDate constant can be used to test if a date/time parameter is set to the
Equilla Invalid value.

// Test if a price is valid
bool IsValidPrice( double price )
{

EquillaConstants eqConsts = new EquillaConstantsClass();
return price != eqConsts.InvalidValue;

}

EXTENSION SIGNALS AND SINKS
Extension objects can register interest in certain "Alerts" on page 329and other
events that may be generated by a chart (or portfolio) that are not directly related
to an Equilla script evaluation. These signals are broken down into four main
categories that can be independently hooked by the extension object: Equilla
script alerts, tool alerts, strategy events and instrument events.

To register interest in a specific class of signals, the extension object must
implements a Sink interface of the corresponding type:

interface IScriptSignal
{

void ScriptSignalRaised( IScriptSignal Signal, bool MoreToFollow );
}

interface IStrategySignalSink
{

void StrategySignalRaised( IStrategySignal Signal, bool MoreToFollow );
}

interface IToolSignalSink
{

void ToolSignalRaised( IToolSignal Signal, bool MoreToFollow );
}
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In each of the above cases, the implemented method will be called when a signal
is raised, containing an interface to an object the contains details of that signal
(see below), the MoreToFollow flag will indicate if more signals are pending, so
that the signals may be queued and processed in a batch when MoreToFollow is
set to false (this is of special importance with strategy orders).

interface ISymbolStateChangedSink
{

SymbolStateChanged( string Symbol, string DisplayName, bool Active );
}

Implementation of the ISymbolStateChangedSink allows an extension object to
respond when instruments transition from an active to an inactive state (inactive
can mean the instrument is stale, or that the data connection has been lost).

ISCRIPTSIGNAL
Contains details about an Equilla alert that has occurred as the result of calling
the Equilla Alert() function, or clicking on a chart hyperlink generated by DrawText
() using the signal protocol.

Please refer to the sample project RSSExtension and the corresponding indicator
RSS for how to hook and generate script alerts.

interface IScriptSignal
{

string SourcePath { get; } // Unique workspace location of the
event source

string DisplaySource { get; } // User visible location of the event
source

string ScriptName { get; } // Name of the script that generated
the event

string SignalName { get; } // Name of the event
string AlertText { get; } // Test specified in the Alert()

function
string ParentSymbolName { get; } // Symbol of the script parent

instrument
DateTime BarTimestamp { get; } // Chart timestamp of the bar on which

the alert was generated
double BarPrice { get; } // Parent instrument price when the

alert was generated
DateTime TimestampUTC { get; } // UTC Timestamp of the signal
string ParentDisplayName { get; } // Display name of the script parent

instrument
}

A simple way to generate an alert would be to use the following Equilla code:
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If IsLastBar Then
Alert( "It is the last bar: " + CStr( CurrentBar ) );

To generate script alerts from a user clicking on a hyperlink in the chart, do the
following:

If IsLastBar Then
DrawText( High, "LinkTest", "Click 4 Alert", Default, Default, AlignTop,

"signal:It is the last bar: " + CStr( CurrentBar ) );

ISTRATEGYSIGNAL
Contains details about a strategy event that has occurred. Strategy events are
generated when a chart is running Equilla strategies that use the Buy, Sell, Short,
Cover and ExitPosition functions to build and backtest a trading system.

Please refer to the sample project ExcelOrderTracker and the corresponding
indicator OrderTracker for how to hook generated strategy alerts.

interface IStrategySignal
{

EStrategySignalType SignalType { get; } // See below
string SourcePath { get; } // Unique workspace location

of the event source
string DisplaySource { get; } // User visible location of

the event source
string ScriptName { get; } // Name of the script that

generated the event
string SignalName { get; } // Name of the event
string OrderId { get; } // Unique ID of the order to

which the event belongs (placed, filled, etc.)
EStrategySignalOrderType OrderType { get; } // See below
double OrderPrice { get; } // Price of the order (valid

for limit and stop orders)
double OrderQuantity { get; } // Size of the order
string ParentSymbolName { get; } // Symbol of the traded

security
DateTime BarTimestamp { get; } // Chart timestamp on which

the order occurred
double BarPrice { get; } // Chart price at which the

order occurred
DateTime TimestampUTC { get; } // UTC timestamp of the

order
string RelatedOrders { get; } // XML list of orders that

will be generated if this order is filled
string ParentDisplayName { get; } // Display name of the

traded security
}

enum EStrategySignalType
{
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eqSignalTypeLongEntryPlaced,
eqSignalTypeLongExitPlaced,
eqSignalTypeShortEntryPlaced,
eqSignalTypeShortExitPlaced,
eqSignalTypeOrderCancelled,
eqSignalTypeOrderFilled,
eqSignalTypeOrderModified,
eqSignalTypeOrderModifiedTrailing,

}

enum EStrategySignalOrderType
{

eqSignalTypeMarketLongEntry,
eqSignalTypeMarketLongExit,
eqSignalTypeMarketShortEntry,
eqSignalTypeMarketShortExit,
eqSignalTypeStopLongEntry,
eqSignalTypeStopLongExit,
eqSignalTypeStopShortEntry,
eqSignalTypeStopShortExit,
eqSignalTypeLimitLongEntry,
eqSignalTypeLimitLongExit,
eqSignalTypeLimitShortEntry,
eqSignalTypeLimitShortExit

}

ITOOLSIGNAL
Contains details about a tool alert that has occurred.

interface IToolSignal
{

EToolSignalType SignalType { get; } // See below
string SourcePath { get; } // Unique workspace

location of the event source
string DisplaySource { get; } // User visible

location of the event source
string ScriptName { get; } // Name of the script

that generated the event
string SignalName { get; } // Signal text

associated with the tool
string ParentSymbolName { get; } // Symbol of the

script parent instrument
DateTime BarTimestamp { get; } // Chart timestamp of

the bar on which the alert was generated
double BarPrice { get; } // Parent instrument

price when the alert was generated
EToolSignalToolType ToolType { get; } // See below
EToolSignalLine Line { get; } // See below
EToolSignalPriceDirection PriceDirection { get; } // See below
string ToolText { get; } // Text associated

with the tool
DateTime TimestampUTC { get; } // UTC Timestamp of
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the signal
string ParentDisplayName { get; } // Display name of the

script parent instrument
}

enum EToolSignalType
{

eqSignalTypeCrossed,
eqSignalTypeBreakIn,
eqSignalTypeBreakOut,

}

enum EToolSignalLine
{

eqToolLine,
eqToolUpperLine,
eqToolMiddleLine,
eqToolLowerLine,
eqToolLineChannel,
eqToolLineFibo1,
eqToolLineFibo2,
eqToolLineFibo3,
eqToolLineFibo4,
eqToolLineFibo5,
eqToolLineFibo6,
eqToolLineFibo7,
eqToolLineFibo8,
eqToolLineFibo9,
eqToolLineFibo10,
eqToolLineFibo11,
eqToolLineFibo12,
eqToolLineFibo13,
eqToolLineFibo14,
eqToolLineFibo15,
eqToolLineFibo16,

};

enum EToolSignalToolType
{

eqToolTypeTrendLine,
eqToolTypeFiboRetracement,
eqToolTypeStopLine,
eqToolTypeTrendChannel,
eqToolTypePitchfork,
eqToolTypeRegressionChannel,

};

enum EToolSignalPriceDirection
{

eqDirectionUpwards,
eqDirectionDownwards,
eqDirectionSideways,

};
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EXTENSION SUPPORTED PARAMETER TYPES
Extension objects must declare an interface that may only contain methods (no
properties or events). These methods may only accept as parameters the types
listed below, and only as input. The methods may only return a value that is one of
the simple types with the exception of object. A method may also have a return
type of void - to return nothing at all.

SIMPLE TYPES

bool (IDL: VARIANT_BOOL)
int (IDL: long)
double (IDL: double)
string (IDL: BSTR)
DateTime (IDL: DATE)
object (IDL: VARIANT)

The object type should only be used when a function accepts different types for a
specific parameter. The actual type of these parameters may change from call to
call and can be of any of the supported types including extension objects
(IEquillaExtension). Determining the actual type present is therefore a task for the
extension object author. The object type is not the same as a parameter that
accepts an extension object which should use the IEquillaExtension type (see
below).

EXTENSION OBJECT TYPES

Any object that implements the "IEquillaExtension Interface" on page 491 can be
passed to a method that has an IEquillaExtension parameter.

SERIES TYPES

Accepting a series type as input allows the extension object to access historic
values of the parameter. There is no length value associated with the series types
because the BackBuffer of the Equilla Script will be determined by how much
historic data is accessed by the script and any extension objects. So for example
if a script only needs 14 bars of data to process, this value should be provided to
the extension object to ensure it does not blindly access historic data on a series
variable and artificially elongate the BackBuffer (which could lead to severe
performance problems).

In each of the below interfaces a single method exists, that when called will return
the value at the supplied offset in the series variable. An offset of zero (0) implies
the current value, one (1) the prior value and so on.
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interface IDateTimeSeries
{

DateTime GetDate( int Offset );
}

interface IDoubleSeries
{

double GetValue( int Offset );
}

interface IIntegerSeries
{

int GetValue( int Offset );
}

interface IStringSeries
{

string GetValue( int Offset );
}

interface IBooleanSeries
{

bool GetValue( int Offset );
}

interface IVariantSeries
{

object GetValue( int Offset );
}

The IVariantSeries should only be used when a variable can contain a mixture of
the other basic types (which is never a good thing to do). Determining the actual
type present is therefore a task for the extension object author.

ARRAY TYPES

Array types accept as input Equilla Arrays (declared using the Array: block in an
Equilla script). The extension API provides dedicated support for one- and two-
dimensional arrays, and a generic version for n-dimensional arrays.

For each basic type supported by an array there is a corresponding series type
with the same behavior as described for series types above. Array interfaces
have a method to access a value at a given index (and offset in the case of series)
and a property for determining the maximum index possible. Arrays are zero-
based.

Arrays that hold Variant types should only be used when a variable can contain a
mixture of the other basic types (which is never a good thing to do). Determining
the actual type present is therefore a task for the extension object author.
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ONE-DIMENSIONAL ARRAYS

interface IDateTimeArray
{

DateTime GetDate(int Index);
int MaxIndex { get; }

}

interface IDateTimeArraySeries
{

DateTime GetDate(int Offset, int Index);
int MaxIndex { get; }

}

interface IDoubleArray
{

double GetValue(int Index);
int MaxIndex { get; }

}

interface IDoubleArraySeries
{

double GetValue(int Offset, int Index);
int MaxIndex { get; }

}

interface IIntegerArray
{

int GetValue(int Index);
int MaxIndex { get; }

}

interface IIntegerArraySeries
{

int GetValue(int Offset, int Index);
int MaxIndex { get; }

}

interface IStringArray
{

string GetValue(int Index);
int MaxIndex { get; }

}

interface IStringArraySeries
{

string GetValue(int Offset, int Index);
int MaxIndex { get; }

}

interface IBooleanArray
{

bool GetValue(int Index);
int MaxIndex { get; }
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}

interface IBooleanArraySeries
{

bool GetValue(int Offset, int Index);
int MaxIndex { get; }

}

interface IVariantArray
{

object GetValue(int Index);
int MaxIndex { get; }

}

interface IVariantArraySeries
{

object GetValue(int Offset, int Index);
int MaxIndex { get; }

}

TWO-DIMENSIONAL ARRAYS

interface IDateTimeArray2D
{

DateTime GetDate(int Row, int Column);
int GetMaxIndexOfDimension(int Dimension);

}

interface IDateTimeArray2DSeries
{

DateTime GetDate(int Offset, int Row, int Column);
int GetMaxIndexOfDimension(int Dimension);

}

interface IDoubleArray2D
{

double GetValue(int Row, int Column);
int GetMaxIndexOfDimension(int Dimension);

}

interface IDoubleArray2DSeries
{

double GetValue(int Offset, int Row, int Column);
int GetMaxIndexOfDimension(int Dimension);

}

interface IIntegerArray2D
{

int GetValue(int Row, int Column);
int GetMaxIndexOfDimension(int Dimension);

}

interface IIntegerArray2DSeries
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{
int GetValue(int Offset, int Row, int Column);
int GetMaxIndexOfDimension(int Dimension);

}

interface IStringArray2D
{

string GetValue(int Row, int Column);
int GetMaxIndexOfDimension(int Dimension);

}

interface IStringArray2DSeries
{

string GetValue(int Offset, int Row, int Column);
int GetMaxIndexOfDimension(int Dimension);

}

interface IBooleanArray2D
{

bool GetValue(int Row, int Column);
int GetMaxIndexOfDimension(int Dimension);

}

interface IBooleanArray2DSeries
{

bool GetValue(int Offset, int Row, int Column);
int GetMaxIndexOfDimension(int Dimension);

}

interface IVariantArray2D
{

object GetValue(int Row, int Column);
int GetMaxIndexOfDimension(int Dimension);

}

interface IVariantArray2DSeries
{

object GetValue(int Offset, int Row, int Column);
int GetMaxIndexOfDimension(int Dimension);

}

N-DIMENSIONAL ARRAYS

interface IDateTimeArrayND
{

DateTime GetDate(int[] Indices);
int GetMaxIndexOfDimension(int Dimension);
int Dimensions { get; }

}

interface IDateTimeArrayNDSeries
{

DateTime GetDate(int Offset, int[] Indices);
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int GetMaxIndexOfDimension(int Dimension);
int Dimensions { get; }

}

interface IDoubleArrayND
{

double GetValue(int[] Indices);
int GetMaxIndexOfDimension(int Dimension);
int Dimensions { get; }

}

interface IDoubleArrayNDSeries
{

double GetValue(int Offset, int[] Indices);
int GetMaxIndexOfDimension(int Dimension);
int Dimensions { get; }

}

interface IIntegerArrayND
{

int GetValue(int[] Indices);
int GetMaxIndexOfDimension(int Dimension);
int Dimensions { get; }

}

interface IIntegerArrayNDSeries
{

int GetValue(int Offset, int[] Indices);
int GetMaxIndexOfDimension(int Dimension);
int Dimensions { get; }

}

interface IStringArrayND
{

string GetValue(int[] Indices);
int GetMaxIndexOfDimension(int Dimension);
int Dimensions { get; }

}

interface IStringArrayNDSeries
{

string GetValue(int Offset, int[] Indices);
int GetMaxIndexOfDimension(int Dimension);
int Dimensions { get; }

}

interface IBooleanArrayND
{

bool GetValue(int[] Indices);
int GetMaxIndexOfDimension(int Dimension);
int Dimensions { get; }

}

interface IBooleanArrayNDSeries
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{
bool GetValue(int Offset, int[] Indices);
int GetMaxIndexOfDimension(int Dimension);
int Dimensions { get; }

}

interface IVariantArrayND
{

object GetValue(int[] Indices);
int GetMaxIndexOfDimension(int Dimension);
int Dimensions { get; }

}

interface IVariantArrayNDSeries
{

object GetValue(int Offset, int[] Indices);
int GetMaxIndexOfDimension(int Dimension);
int Dimensions { get; }

}

EXAMPLE: PASSING AN ARRAY TO AN EXTENSION DLL
C# interface and code for the extension DLL (all other series and array types are
used in much the same way):

public interface ISoundAverage
{

[Description("Asynchronously plays the .WAV files specified by the array
of file names")]

void PlaySounds(IStringArray paths);
}

[ProgId("SoundAverage.Class1")]
public class Class1 : ISoundAverage, EquillaExtension.IEquillaExtension
{

void ISoundAverage.PlaySounds(IStringArray paths)
{

for(int i = 1; i < paths.MaxIndex; ++i)
{

System.Media.SoundPlayer player = new System.Media.SoundPlayer
(paths.GetValue(i));

player.Play();
}

}

void EquillaExtension.IEquillaExtension.Attach
(EquillaExtension.IEquillaHost Host)

{
}

void EquillaExtension.IEquillaExtension.Detach()
{
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}
}

Usage from Equilla:

Inputs:
Price( Close ),
Length( 14, 1 );

Array:
pathArray[]();

Object:
soundAverage( "SoundAverage.Class1" );

If CurrentBar = 1 Then
FillArray( pathArray, "c:\file1.wav", "c:\file2.wav" );

If Price Crosses Over Average( Price, Length ) Then
soundAverage.PlaySound( paths );
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DATA MANAGEMENT

DATA FEEDS
These types of datafeeds are supported:

à Bloomberg where the Bloomberg Professional Terminal is
installed

à Refinitiv supporting Elektron, TREP/ADS (with RDP or TS1),
Eikon, Datastream, Tick History CSV data
(TRTH), Workspaces and Cloud

à Trayport as trading gateway, for direct-broker connections as
well as through a local Joule Terminal, Joule Direct and
server-based Trading Gateway

à Morningstar

à Nasdaq Data Link, former known as Quandl

à CSV Data generic CSV files in any data quality

à Teletrader (not via TECS/TIM)

à OpenConnect as middleware for open interoperability

MISSING A DATA PROVIDER?

You would like to see the list of data providers expanded? No problem - contact
us at sales@tradesignal.com to discuss the possibility of connecting another data
provider to Tradesignal.

SESSIONS, HOLIDAYS AND PROPERTIES
Information on basic data properties, sessions, time zones and holidays are
usually offered by the data provider together with the quotations. However, the
data may contain errors - for whatever reason - or the data may cause unwanted
side effects in your trading system or the chart display. For cases like these,
Tradesignal offers you the possibility to add missing information or even overwrite
the delivered data. Use the editing for:

à Adjusting currency data to your working hours

à Adding the right trading times (sessions) to quotations
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à Adding time zone information for quotations

à Adding missing holidays or other days without trading

MODIFY SESSIONS AND PROPERTIES WINDOW

Ó SESSIONS

The window for editing the sessions, holidays
and properties can be called up for an
instrument (a symbol). This can be done in a
"Chart" on page 96, or from a selected row in
the "Scanner" on page 71, "Watchlist" on
page 77 or "Portfolio" on page 251. You can
open the window in two ways:

à Click on the Sessions button in the
Home > Data group on the "Toolbar"
on page 42.

à Alternatively, right-click on the chart legend or the selected
row and choose the option Show Session Manager in the
context menu.

The window opens. The name of the currently edited instrument is displayed in the window
header.

DEFINING SESSIONS

Ó SESSIONMANAGER

On the tab Sessions you can set up which
times should be used for trading. You have two
options:

Use session information from the data provider
Select this option if you want to use the
information delivered by the provider. E.g., the
trading hours of the NYSE are 9:30 16:00 local
time.

Use session information defined below for all charts
displaying this instrument Select this option to set up your own trading times for a
symbol.

The trading hours are displayed as blue areas in the session display. Move the
mouse over the cells to see which time range they represent.

You can select the trading hours as follows (repeating the actions removes the
selection again):
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à Click on the name of each weekday to add (or remove)
complete days from the selection.

à Keep the mouse button pressed and move the mouse over
the upper edge of the session display to select a time block,
e.g. 08:00 to 15:00.

à Click on a column header to select a cell column.

à To define session times to the minute, right-click a cell and
select another start time from the list.

à To select a continuous region, keep the mouse button
pressed while moving over the cells in the session display.

You can select a Time Zone for which the quotations are displayed. This setting
is important when you are using external quotations from distant exchanges and
the original data does not include the time information. You can also set the time
zone when defining external data sources (see the chapter Data Sources);
however, in this case the settings affect all data in the defined folder, even when
they do not belong to the same time zone.

When you want to display trading information after the official end of the session
without new bars/candles being generated, select the option Session
Extension. Enter a number of bars or click on the small arrows to enter the
numbers. The information for high, close, low and volume are added to the last
bar. When you select the additional option Disable volume cumulation in
session extension period, only the prices, not the volume are added to the last
bar.

DEFINE HOLIDAYS

On the tab Holidays you can define which holiday options should be used. There
are two options:

Use holiday information from the data provider Select this option to use information
delivered by the provider. (Note: not every Dataprovider delivers holiday
information)

Use holiday information defined below for all such instruments Select this option to
enter holidays. You can define any day as "holiday", i.e. day without trading
activity, for example bridging days.

à To add a new holiday, click on New.
A dialog opens. To enter the date, click on the arrow button to open a
calendar in which you can select a date. Then enter a name for the holiday.
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à To edit a holiday, select it in the list and click on Edit.
A dialog opens in which you can edit the date and/or the name.

à To delete a holiday, select it in the list and click on Delete.

à To import a holiday defined from another symbol, click
Import.
A dialog opens which lets import user-defined holidays created for other
symbols.

EDIT SECURITY PROPERTIES

On the tab Properties you can change four settings for the instrument data. This is
especially useful when the external data does not include this information. As
default, the Standard settings are selected.

Instrument Name Here you can change the name of the symbol as displayed in the
chart.

Lot Size The Lot Size is the smallest number of pieces traded, for example 100
pieces for a security. For futures, it is usually 1 piece. To simulate a leverage
effect that is caused by multipliers, you can edit the lot size. For the Dax Future
that would be 25 Euro, for the Bund Future 1000 Euro.

Tick Size There you can change the smallest possible price movement of a
security. For stocks and some indices, it is 0.01 Cent. For some futures it is 0.5
points, for other futures 0.01 ticks or for currencies 0.0001 pips.

Display Unit Here you can change the smallest unit of the value scale.

Slippage/Lot The slippage specific to this security per contract lot (or share).

Contract Weight The Contract Weight is specially important for energy traders. Not
every data provider provides this information. If the Contract Weight should not be
taken into account for calculation in Equilla, please switch it off here.

CURRENCY AND UNIT CONVERSION

Ó UNIT AND CURRENCY CONVERSION
IN THE PROPERTIES

Tradesignal can also convert the currency or
the unit of your symbol into another currency or
unit. The settings for the currency and unit
conversion are visible in the "Mini Toolbar" on
page 45 or the full overview of all "Settings" on
page 157.
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If you are using Tradesignal with Tradesignal DataConnect, you have to specify
the datafeed which should be used for the currency conversion in the Tradesignal
DataConnect. Tradesignal will use Spot FX prices as default for the currency
conversion.

Ó CUSTOMCURRENCY CONVERSION

In addition it is possible to define custom
currency conversion in Tradesignal for specific
currencies. These settings are available in the
datafeeds settings.

To easily use the same currency conversion as
another user the custom currency conversion
settings can be exported and imported (1).

IMPORTING EXTERNAL DATA
Nowadays, all charting software is connected to the internet and thus also to a
data provider. This data is called "primary data feed" in Tradesignal. For intraday
trading, it is important to have up-to-date and self-refreshing data.

For some trading methods or for developing trading systems and tests, however,
it is important to have long histories and a high time resolution. These histories
are often expensive and can only be purchased as monthly subscriptions. A less
expensive and more individual solution is the inclusion of historic data of files
saved on hard drives, removable storage or web servers. For such quotation
data, many free and pay sources are available. This allows the users to retrieve
and pay only for the histories they need for their analysis.

Offline quotations from external sources can be used for:

à Extending the price histories of the online data provider

à Inserting instruments not offered by the online data provider

à Inserting data other than quotations (business or sentiment
indicators, statistics)

External data is treated the same as data from the online provider. You can apply
all functions like "Chart" on page 96 Analysis, "Using Indicators" on page 372,
"Using Strategies" on page 381, "Portfolio" on page 251and "Scanner" on
page 71.
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In the following, you can find information about the import of external data and the
necessary structure of the file name and the data of such quotation files.

IMPORTING EXTERNAL DATA IN TRADESIGNAL

Ó ENTRY DATAFEED IN THE
TRADESIGNAL OPTIONS

EDITING THE DATA FEEDS
You can open the settings for the data feed in
two ways:

à Double-click the connection icon in
the top-right corner of the
Tradesignal window.

à Alternatively, open the file menu,
select theOptions entry and click on
Datafeeds.

The area for data connection appears in the right side of the window. At the top
you can find settings for the data connection to online providers. Below you can
find the settings for the "additional data sources" that are available offline.

DATAFEED

Here you setup the connected server with an installed Tradesignal DataConnect
and if needed a an additional password.

à Click on Configure Feeds... will guide you through the setup
of the feeds, see User Guide for Tradesignal DataConnect.

à Click onManage Data... opens the Tradesignal
DataConnect.

à Click on Configure Logging... opens the Logging Wizard ton
enhance the logging.

à Click on the Show more options link to show less critical
configuration options.

When you make changes to the data feed, a link will appear offering the chance to
reconnect now. Alternatively, clicking on the connection button at the top right
above the toolbar will show a menu with a reconnect option.

ADDING AND EDITING ADDITIONAL DATA SOURCES
If you want to use CSV files to obtain additional data in Tradesignal, please use
the CSV feed in Tradesignal DataConnect, see User Guide for Tradesignal
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DataConnect. If you want to use CSV files to add historical data, please import
the data in the Tradesignal DataConnect directly to the symbol.

Top-up data as an additional data source is only used in rare cases.

Set up the type of the additional data source:

Add a folder containing CSV data To configure the folder, click on Browse. Select the
folder in which the imported files are located. This may be any folder available on
your computer or via intranet. You can also create a new folder for future import.
The folder is also called "top-Up service", as it works like a data provider.

Note: External quotation files can only be used when they are located in the configured
folder and adhere to both the "File Names for Quotation Data" on page 516 for Files and the
"Data Format of External Quotations" on page 518.

Select the Timezone from the list (see above).

You can enter a Text that is added to the legend name of an instrument. The
default string is "top-up". You can enter any other string or delete the entry and
leave the field empty. The additional label on the offline data is intended to help
you distinguish them from online data. This is especially useful if both data sets
have the same shortcut. Additional label won't be visible when extending the price
histories of the online data.

Only use data to back-fill missing historic data (default setting) Usually, the online data
provider offers all instruments needed. However, the available history is often too
short or no intraday data is available. If you want to fill the missing history by data
of offline sources, the files have to be saved in the folder configured above and
the data shortcut has to be the same as for the instrument of the online provider.
Only if both conditions are met, Tradesignal can concatenate the data. The
program attempts to fill the history into the past. The additional data is inserted at
the point where the history of the online data provider ends.

Always overwrite historic data This setting is only sensible if you have enough offline
data for this instrument, so that most or all of the online data is unnecessary.
Alternatively, you could also enter a new instrument name so that no collision or
concatenation could take place. However, if you want to use a general shortcut
for the data without using the online data, this is the right option.

CONDITIONS FOR THE CORRECT DISPLAY OF TRADING PERIODS
For Tradesignal to recognize the time resolution (period) of your data, certain
conditions have to be met for the File Names and the Data Format. In cases of
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display problems or certain trading periods missing in the chart although the data
is available, the error can usually be tracked down to one of these conditions.

EXAMPLE: CONFIGURE AN ADDITIONAL DATA SOURCE IN
TRADESIGNAL

STEP 1: OPENING THE CONNECTION SETTINGS IN TRADESIGNAL

01. Open the file menu to the left of the command line.

02. Click on the menu point Options.

03. Click on the tab Datafeeds.

STEP 2: DEFINE A FILE FOLDER AS DATA SOURCE

01. Click on Add a folder containing CSV data to configure a new
connection.

02. Click on Browse to open the folder list.

03. Browse to the folder "Tradesignal Files", select it and click on
New Folder to create a new folder.

04. Enter the name "Ascii Data" and click on Create.

05. Confirm with OK.

06. As Time Zone, select "Europe/Berlin".

07. Confirm with OK.

STEP 3: IMPORT AND SAVE FILE

Save the file Sample02-1d.txt in the folder described above (right-click the link
and "save as target").

If you have read the article about File Names, you can see that the shortcut for the
instrument is Sample02 and that the data has a resolution of one day. Keep this
instrument name for now. You can always change it later, if desired.

STEP 4: OPEN CHART

01. Enter the shortcut "Sample02" in the command line.

02. Select the option New Chart from the drop-down menu.

The chart with the "Sample02" data is opened.
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FILE NAMES FOR QUOTATION DATA

File names have an important function - ideally, they tell the user what kind of
data is included and how it is to be displayed. The operating system automatically
opens the program assigned to the file extension.

In the case of quotation data like in our case, the file name has another important
function. It shows us and the software to which instrument the data belongs,
which trading period is used and more. If you have a problem displaying data, this
is probably caused by an error either in the file name or in the Data Format.

Please note where the information in a filename is used and if it is mandatory or
optional.

FILE NAMES
The file name can/must include the following information:

à Shortcut (mandatory)

à Period (mandatory)

à Field Identifier (optional)

File names can be constructed in the following ways:

à Shortcut.FileExtension

à Shortcut-Period.FileExtension

à Shortcut-FID-Period.FileExtension

As a separator between the parameters, the minus sign is used. If you want to
use a shortcut that already includes a minus sign, substitute it with a comma or
semicolon. Valid file extensions recognized by Tradesignal are .csv, .asc and .txt.

SHORTCUT
If you want to be able to use the file name in the "Command Line" on page 38 of
Tradesignal, e.g. to open a chart with the data, the shortcut has to follow a certain
convention. The shortcut is also important if you want to combine data from your
online provider with offline data.

Note: If you want to use a shortcut independent of your online provider, you may freely
choose the filename. However, if you want to combine data from your online provider with
offline data (for example to extend the history or to add intraday data for an instrument), the
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shortcut of the offline data has to be identical to the one used by the online provider.
Otherwise, the external offline data will not be assigned correctly.

For shortcuts with a leading point (e.g. many indices), a trick has to be used since
Windows does not allow filenames with a leading point. Just add a plus sign
before the point.

Example for an instrument with leading point: +.gdaxi-5m.csv

PERIOD
The period is optional in a file name. If no period is given, Tradesignal
automatically displays the data in daily intervals, even if intraday data is available
in the file. The software can display the data correctly only if the period parameter
is used. If you receive an error when changing the period settings of your external
data in the Chart or Scanner, it is very likely that this error results from a missing
or invalid period value.

Period Shortcode Example

Tick Data tick, 0, t, tick, ticks, 1t aaa-tick.csv

1 Minute
60, 1m, m, min, minute,
minutes, minuten

pumg.de-60.csv

5 Minutes
300, 5m, 5min, 5mins,
5minute, 5minuten,
5minutes

adsg.de-5m.csv

30 Minutes
1800, 30m, 30min,
30mins, 30minute,
30minuten, 30minutes

depfa-30min.csv

1 Hour
3600, 1h, h, hour, hourly,
1hour, stunde, stunden

eurusd-hour.csv

1 Day
86400, 1d, d, day, daily,
tag

+.rut-1d.txt

1 Week
604800, 1w, w, week,
weekly, woche

+.gdaxi-w.csv

1 Month
2592000, month, mothly,
monat

dowjones-monthly.csv

517



FIELD IDENTIFIER
The Field Identifier is only mandatory if instead of the normal quotations (open,
high, low and close) the bid, ask, or last prices are given in the file. These prices
can only be displayed with the correct identifier. The following identifiers are valid:

à last

à bid

à ask

Example for a file with bid prices: +.gdaxi-bid-5min.csv

Example for a file with ask prices: +.gdaxi-ask-5min.csv

DATA FORMAT OF EXTERNAL QUOTATIONS

In files of quotation data, the data format (i.e. the sequence of elements such as
date, time, prices and volume) defines the data display and whether the program
can handle it at all. Since there are many possible combinations, import problems
may be caused by data in the wrong format. Often, a simple wrong separator or a
non-supported date format can cause havoc with the data.

When you need to edit the data format, you can do this with a text editor. For
exchanging complete columns, however, usually programs like Excel or Access
are necessary.

A file with quotation data has the following components:

à Header - recommended but optional

à Data columns separated by separators (by default semicolon
or comma)

Tradesignal recognizes the following column types:

à Date

à Time - optional

à Open - optional

à High - optional

à Low - optional

à Close

à Volume - optional

à Open Interest - optional
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For the display of intraday data, time and date stamps are necessary. Otherwise,
the data is filled in beginning with the current trading day, which may not always
give correct results. If you want to add information to the history of your online
data provider, make sure that your file has the same data elements as the file
from your provider.

HEADER
The first segment of the file should be the header. It contains information about
the data columns, their order and the used separators. The header is optional;
when no header is given, Tradesignal attempts to interpret and display the
segments. However, this may cause errors.

In the header, information about the columns is given in the way of identifiers. The
identifiers have to be separated by the same separator as the data columns. For
each column type, several identifiers are possible, as you can see in the following
list:

NOTATION

à Date - d, date, datetime (when date and time are combined)

à time - t, time

à Open - o, op, open

à High - h, hi, high

à Low - l, lo, low

à Close - c, cl, close

à Volume - v, vo, vol, volume

à OpenInterest - oi, openint, ointerest, openinterest

Example Header: Date;Time;Open;High;Low;Close;Volume

If no header is given, Tradesignal uses the following masks to analyze the column
grouping:

à d,o,h,l,c

à d,o,h,l,c,v

à d,o,h,l,c,v,oi

à d,c

à d,c,v

à d,c,v,oi
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Some data sources, for example Internet offers, contain data in additional
columns. Since Tradesignal cannot display those, the data has to be skipped. For
this, the word "Skip" can be used in the header. In the following header example,
the last column is skipped.

EXAMPLE FOR A FILE WITH AN ADDITIONAL COLUMN THAT IS SKIPPED:

Date,Open,High,Low,Close,Volume,Adj.
Close*09.11.05,10539.24,10637.78,10466.24,10546.21,22144600,10546.21

results in:

Date,Open,High,Low,Close,Volume,Skip09.11.05,10539.24,10637.78,10466.24,105
46.21,22144600,10546.21

DATA AND TIME FORMATS
For date and time, many different formats exist.

DATE FORMAT

à European Format - Example: 01.04.2006

à English (US) Format - Example: 04/01/06

à Standard ISO Format - Example: 1998-12-22T01:02:03:987

When the European format is recognized, a comma has to be used as decimal
separator. In the case of an English format, a decimal point has to be used as
decimal separator.

Additional differences may exist in the day, month, year sequence, especially in
the case of UK/US formats. See the example below for combinations recognized
by Tradesignal.

TIME STAMP

No flexibility is given regarding the time stamp format. The separator has always
to be a colon. If necessary, the separators of an external data file have to be
exchanged to a colon in a text editor.

COMPONENTS OF THE TIME STAMP

à hour

à minute

à second

one-tenth of a second (for tick data)
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For English time zones, "AM" or "PM" can be used if the hours are given in a 12
hour interval.

EXAMPLES FOR VALID DATE AND TIME STAMPS IN TRADESIGNAL

ENGLISH FORMATS

à 1998/1/11 11:05:00

à 5/17/1998 11:05:00 AM

à 5/17/1998 8:05:00 PM

à 2005/10/25 12:25:11 PM

à 2005/10/25 11:05:00:124 AM

à 5-17-1998

à 1998-12-22

à 1998-12-22 01:02 PM

à 98-12-22

EUROPEAN FORMATS

à 04.12.98

à 04.12.1998

à 04.12.1998 12:23

à 04.12.1998 12:23:12

à 04.12.1998 12:23:14:122

à 04.12.1998 12:23:14.122

à ISO Formats

à 1998-12-22T01:02:03

à 1998-12-22T01:02:03:987

ISO FORMATS

à 1998-12-22T01:02:03

à 1998-12-22T01:02:03:987
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TRADESIGNAL DATA IN EXCEL
Extending Equilla via "COM-API Extensions" on page 482 allows you to get
periodically updated data from Tradesignal into your Excel spreadsheets.

In Tradesignal 7, we've added a COM-API extension LiveExport and indicator of
the same name to help you accomplish this. The extension enables the indicator
to write price data into an Access database file which can be imported into an
Excel worksheet. To get periodic updates to the data displayed, you can specify
how often Excel updates from the database.

Ó EQUILLA EXTENSION OPTIONS

WRITING DATA FROM A CHART TO
AN ACCESS DATABASE

01. Make sure that COM-API extensions
are enabled, File > Options >
Advanced > Equilla Extension.

02. Apply indicator LiveExport from the
Tradesignal package to an
instrument or indicator on a chart.

03. Set path and table name prefix in the properties of the
indicator. You can use macros for some commonly used
folders on your machine, see source code of the indicator for
details.

ACCESSING DATABASE FROM EXCEL 2010

01. Data > From Access on the ribbon allows you to pick the
database file and table.

02. Make sure to pick DB_MODE_READ to open the database as
read-only, otherwise Tradesignal will not be able to write to
this database.

03. In the properties of the connection, you can enable periodic
refresh and change the refresh interval.

EXPORTING PRICE DATA
If your data provider allows exporting of price data, you can export data displayed
in Tradesignal by
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à dragging the symbol from the chart legend to another
application which can handle CSV data input, e.g. most
spreadsheet applications

à or by selecting the Home > Data > Export Data found in the
"Toolbar" on page 42.

à The file format for export is CSV which can be parsed by a
wide range of applications and is also human readable.

PRICE EDITOR

Ó PRICE EDITOR

Price data can be obtained from various
sources. On the one hand, data is supplied to
the software from the default data provider via
the Internet, on the other hand data can be
imported via a data interface, as text files or in
other data formats.

When receiving data, errors may happen and
make it necessary to edit the price data manually. Use the Price Editor to:

à enter stock splits retroactively

à rectify faulty ticks and corrupt data records

The Price Editor is available in the Chart, Scanner and Portfolio.

OPEN THE PRICE EDITOR
à Click on the button Edit Prices under Home > Data on the

"Toolbar" on page 42.

à Alternatively, open the context menu of the documents and
select Edit Price.

The Price Editor opens. The Prices group appears in the toolbar.

EDIT DATA

CHANGE DATA
You can edit the values of a line (single trading period).
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à Double-click the line.

à Alternatively, right-click the line and select Edit from the
context menu.

DELETE DATA
You can delete lines (single trading periods) from the price table.

à Select one or more lines and press the Del key.

à Alternatively, right-click the selected lines and select Delete
Row(s) from the context menu.

Depending on file size, the process may take several minutes, as backups are
created.

ENTER STOCK SPLITS
You can enter stock splits manually, if the data provider offers no corrected data
or if you downloaded data without split correction from the Internet.

01. Select the lines you want to edit.

02. Open the split function by clicking the Split button in the
symbol bar or selecting the entry Split in the context menu.

03. Select a Data Adjustment Mode:

Absolute The value is subtracted from the selected prices.

Relative Here you can enter a multiplier or the split ratio. Many stocks are split in a
1:2 or 1:3 ratio. The preview window displays the effects of the entered split
settings on example data.

ClickOK to save the settings and start the process. The data is changed. This
may take a few minutes.

RESET CHANGES
Changed or deleted prices can be reset to their original values at any time (with
the exception of DataConnect data). Tradesignal keeps backups of the data.

01. Select one or more lines with changed data. Changed data
are underlined in orange in the table.

02. Open the context menu and select Reset Edited Data. The
program restores the backup and overwrites the changes.
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DIFFERENCE BETWEEN LOCAL DATA AND TRADESIGNAL
DATACONNECT

Tradesignal DataConnect is a product from Tradesignal that collects and
organizes data from many commercial data feeds. It is only relevant to
Tradesignal institutional users.

The functions described above are available for local data or data offered from
the provider, and also for the price data of DataConnect.

The sole difference is that in the case of DataConnect data, no backup and data
restoration is available. If you want to change DataConnect data, save the data as
personal backup before editing it.

BLOOMBERG DATA

SYMBOL SYNTAX

Bloomberg Symbol syntax differs from the Reuters syntax. In general, you only
have to enter the symbol short code in the command line, for example

à short code + security type (e.g. SIE EQUITY)

Other short codes are:

à GOVT for government bonds

à CORP for corporate bonds

à CRNCY for currency

à INDEX for indices

à CMDTY for futures

Due to the fact that instruments are traded on different exchanges, you have to
enter additional commands, otherwise the most profitable exchange will be
offered automatically.

à short code + exchange + security type (e.g. SIE GY EQUITY
for xetra)

In addition to those short codes, you can add more commands, e.g. period
information.

For example:
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à short code + exchange + security type + period (e.g. SIE GY
EQUITY 5m opens Siemens on xetra in 5min. period)

Continuous Future contracts are indicated with "1", e.g. GX1 COMDTY for dax
future or RX1 COMDTY for Bund future.

Single contracts are entered as follows:

à short code + expiry month + expiry year + security type
e.g. for dax future Dec. 2007, it would be GXZ7 COMDTY

You can recall more short codes and infos within the Bloomberg terminal. Enter
the commands as follows:

à DOCS + Go formal documents

à BLP + Go Bloomberg Launch Pad

à PDF + Go personal default settings

à BBXL + Go all about Bloomberg und Excel G + Go

A list of all mayor symbol codes you can find here: Bloomberg Symbollists

DATA HISTORY

All data comes directly from Bloomberg. There will be no local caching or saving.

Generally there will be the following data history be available:

- Daily Intraday Ticks
Stocks 20 - 25 Years 50 Days 5 Days
Futures (adj.) ca. 15 Years 50 Days 50 Days
Indizes Dt up to 1960 (Dax) 50 Days 50 Days
Indizes US up to 1900 (DJI) 50 Days 50 Days
Indizes US up to 1980 (NDX) 50 Days 50 Days

SYMBOL LISTS

When starting TradeSignal for the very first time, you are asked if you want to
receive lists from your data provider. If you confirm this, you will use the Symbol
List wizard for the first time. However, you can start the wizard any time to create
a new list.

à In the toolbox, click the Symbol Lists button.

à In the Related Task area, click on New Symbol List.
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The Symbol List wizard opens. Choose Predefined Symbol List from Your
Data Provider. On the upper left side you will find a search box. Enter the
shortcode of the wanted index and hit Search. Now the result will be displayed.
Make a check into the checkbox next to the result and hitOK. Now the new
Symbol List will be added to your list.

Use the shortcode, you will use to open the Index as chart.

Please use:

DAX for the Dax 30
MDAX for the M Dax
TDXP for the TecDax
UKX for the FTSE 100 Index
CAC for the CAC 40 Index
BEL20 for the Bell 20 Index
AEX for the AEX Amsterdam Index
IBEX for the Ibex 35 Index
INDU for the Dow Jones Industrial Index
CCMP for the Nasdaq Composite Index
SPX for the S&P 500 Index
SPTSX for the TSX COMPOSITE INDEX
IBOV for the Ibovespa - Bovespa Index
HSI for the Hang Seng Index
NKY for the Nikkei Stock Average 225
SMI for the SMI Index
ATX for the Österreichischen ATX Index
MIB30 for the Italian Mibtel
MADX for the Madrid General Index
OMX for the Stockholm All Share Index
HEX for the Helsinki All Share Index
KFX for the Copenhagen 20 Index
OBX for the Oslo Exchange All-share Index
BUX for the Budapest Stock Exchange Index
SX5P for the DJ Stoxx 50 ETF
SX5E for the DJ Euro Stoxx 50 ETF
AS30 for the Australian All Ordinaries Index
KOSPI for the South Korean KOSPI Index
KLCI for the KLSE Composite Index
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SET for the Thai SET Composite Index
JCI for the Jakarta Composite
PCOMP for the Philippine PSE Composite Index
KSE100 for the Karachi SE 100 Index
SHCOMP for the Shanghai Composite Index

TELETRADER DATA

SYMBOL SYNTAX

TeleTrader Symbol syntax differs from the Reuters or Bloomberg syntax. In
general, you only have to enter the symbol short code in the command line, for
example

à short code + exchange (e.g. SIE GER)

Other short codes are:

à GER - Xetra

à FRA - Frankfurt

à MUN - München

à STU - Stuttgart

In addition to those short codes, you can add more commands, e.g. period
information.

For example:

à short code + exchange + period (e.g. SIE GER 5m opens
Siemens on xetra in 5min. period)

Continuous Future contracts are not available, but you can create them easily on
your own. Please look into help file to learn how to do it: "User-defined
continuations" on page 84.

Single contracts are entered as follows:

à short code + expiry year + expiry month
e.g. for dax future Dec. 2009, it would be FDAX 2009Z

Indices always have a dot before the short code, for example:
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à DAX.de for Dax Index

à DJX.us for Dow Jones Index

DATA HISTORY

All data comes directly from TeleTrader. There will be no local caching or saving.

Generally there will be the following data history be available:

- Daily Intraday Ticks
Stocks 12 - 14 Years 3 Years 12 Days
Futures (cont.) 8 - 10 Years 3 Years 12 Days
Indices Ger up to 1950 3 Years 12 Days
Indizes US up to 1990 3 Years 12 Days

SPECIALS
à With the TeleTrader Data Provider its possible to create your

own "User-defined continuations" on page 84

à With the TeleTrader Data Provider its possible to create your
"Seasonal Chart" on page 155

à With the TeleTrader Data Provider its possible to create
spread charts

SYMBOL LISTS

When starting TradeSignal for the very first time, you are asked if you want to
receive lists from your data provider. If you confirm this, you will use the Symbol
List wizard for the first time. However, you can start the wizard any time to create
a new list.

à In the toolbox, click the Symbol Lists button.

à In the Related Task area, click on New Symbol List.

The Symbol List wizard opens. Choose Predefined Symbol List from Your
Data Provider. Now the result will be displayed. Make a check into the checkbox
next to the result and hit OK. Now the new Symbol List will be added to your list.
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THOMSON REUTERS DATA

SYMBOL SYNTAX

Reuters Symbol syntax differs from the Bloomberg syntax. In general, you only
have to enter the symbol short code in the command line, for example

à short code + exchange (e.g. Siegn.DE)

The short code behind the colon refers to the exchange, e.g. the following:

à .DE - Xetra

à .FRA – Frankfurt

à .MU - Munich

à .STU – Stuttgart

In addition to those short codes, you can add more commands, e.g. period
information.

For example:Siegn.de 5m (opens Siemens at xetra in 5minute period)

Continuous Future contracts are indicated with "c1", e.g. FDXc1 for dax future or
FGBLc1 for Bund future.

Single contracts are entered as follows:

à short code + expiry month + expiry year
e.g. for dax future dec. 2007, it would be FDXZ7

Indices always have a dot before the short code, for example:

à .GDAXI for dax index

à .DJI for dow jones index

à .GSPC for s&p index

A list of all mayor symbol codes you can find here: Reuters Symbollists

SYMBOL LISTS

When starting TradeSignal for the very first time, you are asked if you want to
receive lists from your data provider. If you confirm this, you will use the Symbol
List wizard for the first time. However, you can start the wizard any time to create
a new list.
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à In the toolbox, click the Symbol Lists button.

à In the Related Task area, click on New Symbol List.

The Symbol List wizard opens. Choose Predefined Symbol List from Your
Data Provider. On the upper left side you will find a search box. Enter the RIC of
the wanted index and hit Search. Now the result will be displayed. Make a check
into the checkbox next to the result and hit OK. Now the new Symbol List will be
added to your list.

Use the RIC, you will use to open the Index as chart.

Please use:

à .GDAXI for the Dax 30

à .MDAXI for the MDax

à .TECDAX for the TecDax

à .FTSE for the FTSE 100 Index

à .FCHI for the CAC 40 Index

à .BFX for the Bell 20 Index

à .AEX for the AEX Amsterdam Index

à .IBEX for the Ibex 35 Index

à .DJI for the Dow Jones Industrial Index

à .IXIC for the Nasdaq Composite Index

à .SPX for the S&P 500 Index

à .BVSP for the Ibovespa - Bovespa Index

à .HSI for the Hang Seng Index

à .N225 for the Nikkei Stock Average 225

à .SSMI for the SMI Index

à .MIBTEL for the Italian Mibtel

à .SMSI for the Madrid General Index

à .OMXSPI for the Stockholm All Share Index

à .OMXHPI for the Helsinki All Share Index

à .OMXC20 for the Copenhagen 20 Index

à .OSEAX for the Oslo Exchange All-share Index
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à .BUX for the Budapest Stock Exchange Index

à .STOXX50 for the DJ Stoxx 50 ETF

à .STOXX50E for the DJ Euro Stoxx 50 ETF

à .AORD for the All Ordinaries Index

à .KS11 for the KOSPI Index

à .KLSE for the KLSE Composite Index

à .SETI for the SET Composite Index

à .JKSE for the Jakarta Composite

à .PSI for the PSE Composite Index

à .KSE for the Karachi SE 100 Index

à .SSEC for the Shanghai Composite Index
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INDICATOR AND STRATEGY
REFERENCE

ACCUMULATION DISTRIBUTION
Shortcode: ACD

DESCRIPTION

This indicator measures the difference
between buying pressure and selling
pressure. It is a momentum indicator that
gauges supply and demand by determining
whether investors are generally accumulating
(buying) or distributing (selling) a certain
stock. It helps to identify divergences between stock price and volume flow and
points out weaknesses in the current price performance.

PARAMETERS

This indicator requires a single parent instrument that has data fields for Open,
High, Low, Close available.

CALCULATION

On a daily chart, yesterday’s closing is compared to today’s closing price. If
today’s closing price lies above yesterday’s closing price (accumulation) the new
indicator value is calculated by adding yesterday’s indicator value to the
difference between closing price and True Low. If today’s closing price lies below
yesterday’s closing price (distribution) the new indicator value is calculated by
adding yesterday’s indicator value to the difference between closing price and
True High.

USAGE

The Accumulation Distribution points out weaknesses in the current price
performance by identifying divergences between the indicator and the underlying
security. Divergences between indicator and security point to a weakening of the
prevailing trend. Keep in mind that a possible trend reversal must be confirmed by
the price. A "bullish divergence" occurs when the significant lows of the price lie
on a falling line but the significant highs of the indicator on a rising line. A "bearish
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divergence" occurs when the significant highs of the price lie on a rising line but
those of the indicator are on a falling line. Once a divergence has been identified,
separate technical indicators should be used for confirmation. Accumulation
Distribution can be generalized to bars of any period.

Ó SLIGHTLY BULLISH DIVERGENCE.

ACCUMULATION DISTRIBUTION LINE
Shortcode: ADL

DESCRIPTION

This indicator measures the cumulative flow
of money in and out of a security. The line is a
running total of each period's money flow
volume. The indicator is designed to
illuminate the forces behind price movements
by factoring in volume and spot divergences
and to confirm the strength and sustainability of a price move.

CALCULATION

The indicator is a cumulative measure of each period's volume flow, or money
flow. To calculate the indicator, the Closing Location Value (CLV) (which can take
values between -1 and +1) is calculated by subtracting the difference between
daily high and closing price from the difference between closing price and daily
low, and dividing the result by the difference between daily high and daily low.
This value is multiplied by volume and added to the previous day's indicator value
to form the Accumulation Distribution Line.

CLV = [(Close - Low) - (High - Close)] /(High - Low)
ADL = ADL t-1 + (CLV * Volume)
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USAGE

The indicator is used to spot divergences between indicator and underlying
instrument, i.e. to either reinforce the underlying trend or cast doubts on its
sustainability. An uptrend in prices with a downtrend in the Accumulation
Distribution Line suggests underlying selling pressure (distribution) that could
foreshadow a bearish reversal on the price chart. A downtrend in prices with an
uptrend in the Accumulation Distribution Line indicate underlying buying pressure
(accumulation) that could foreshadow a bullish reversal in prices.

Ó A BULLISH DIVERGENCE AND THE
SUBSEQUENT TREND REVERSAL.

Ó A BEARISH DIVERGENCE AND THE
SUBSEQUENT TREND REVERSAL.

ACCUMULATION DISTRIBUTION OSCILLATOR
Shortcode: ADO

DESCRIPTION

This indicator measures the buying and
selling pressure in a market by analyzing the
range of price moves resulting from bullish or
bearish market tendencies over the course of
the trading period.
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CALCULATION

The opening price is subtracted from the daily high, the daily low is subtracted
from the closing price. Both results are added together. This result is divided by
the double trading range for the period:

ADO(t) = ( High(t) – Open(t) ) + ( Close(t) – Low(t) ) / ( 2 * Range(t) )

Depending on whether the indicator is calculated for up (bullish) or down
(bearish) periods the indicator value will be higher or lower.

USAGE

Higher values indicate increased buying pressure with values over 70 usually
indicating the security is overbought. Lower values indicate increased selling
pressure with values below 30 usually indicating the security is oversold.

Ó THE INDICATOR IS FAST-MOVING AND
SENSITIVE BUT MAY BE USED TO
ANTICIPATE TREND REVERSALS.

ADAPTIVE MOVING AVERAGE SIMPLE
STRATEGY

DESCRIPTION

This complete strategy is a simple crossover
of the price with the "Moving Average
Adaptive" on page 691, also known as
Kaufman's Adaptive (KAMA). The indicator
focused more on trend efficiency then on
volatility. When you want to use this strategy
in a "Portfolio" on page 251, use the portfolio
optimized version "Adaptive Moving Average Simple Portfolio Strategy" on
page 538.
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PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

Period
The number of bars used to calculate

Default: 38

Bullish
Defines what kind of orders are placed.

Default: LongEntry

Bearish
Defines what kind of orders are placed.

Default: LongExit

CALCULATION

Ó KAMAWITHOUT ANDWITH A TREND
IN THEMARKET

The indicator uses a Moving Average
Exponential with an adaptive weighting factor
to calculate the signal line. For the calculation
of the indicator itself, see "Moving Average
Adaptive" on page 691. A crossover of the price
with the KAMA generates trading signals.

USAGE

The strategy shows a lot of signals and
whipsaws which can be useful for swing traders. When the market shows no
strong trend, the strategy can produce false signals. You could use the strategy
along with additional indicators like "Relative Strength Index" on page 753 to
identify overbought and oversold levels.

For short and long-term traders different periods are suggested, so you can use
the "Optimizer" on page 274 to find a suitable period for your trading system. The
advantage of the KAMA is the adaptive weighting factor, which leads to the fact
that the strategy does not have to be constantly re-optimised.
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ADAPTIVE MOVING AVERAGE SIMPLE
PORTFOLIO STRATEGY

DESCRIPTION

This complete strategy is a simple crossover
of the price with the "Moving Average
Adaptive" on page 691, also known as
Kaufman's Adaptive (KAMA). The indicator
focused more on trend efficiency then on
volatility. This strategy is optimized for a
"Portfolio" on page 251.

PARAMETERS

Period
The number of bars used to calculate

Default: 38

LongEntry
Defines what kind of orders are placed.

Default: True

LongExit
Defines what kind of orders are placed.

Default: True

ShortEntry
Defines what kind of orders are placed.

Default: False

ShortExit
Defines what kind of orders are placed.

Default: False
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CALCULATION

Ó KAMAWITHOUT ANDWITH A TREND
IN THEMARKET

The indicator uses a Moving Average
Exponential with an adaptive weighting factor
to calculate the signal line. For the calculation
of the indicator itself, see"Moving Average
Adaptive" on page 691. A crossover of the price
with the KAMA generates trading signals.

USAGE

The strategy shows a lot of signals and
whipsaws which can be useful for swing traders. When the market shows no
strong trend, the strategy can produce false signals. You could use the strategy
along with additional indicators like "Relative Strength Index" on page 753 to
identify overbought and oversold levels.

For short and long-term traders different periods are suggested, so you can use
the "Optimizer" on page 274 to find a suitable period for your trading system. The
advantage of the KAMA is the adaptive weighting factor, which leads to the fact
that the strategy does not have to be constantly re-optimised.

ADAPTIVE MA CROSS - ENTRY STRATEGY

DESCRIPTION

The strategy uses as tradings signals
crossovers between a fast and a slow
"Moving Average Adaptive" on page 691,
also known as Kaufman's Adaptive (KAMA).
The indicator itself is based on different "Moving Average Exponential" on
page 699 and focused more on trend efficiency then on volatility. For Exit signals
with the same trigger, please use the "Adaptive MA Cross - Exit Strategy" on the
next page.

PARAMETERS

Period1
The number of bars used to calculatefor the fast moving average adaptive

Default: 20

Period2
The number of bars used to calculatefor the slow moving average adaptive
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Default: 60

EntryMethod
Defines what kind of orders are placed

Default: Both

CALCULATION

Ó STRATEGYWITH THE TWOMOVING
AVERAGE EXPONENTIAL

The indicator uses two moving average
exponential with an adaptive weighting. For the
calculation of the indicator itself, see "Moving
Average Adaptive" on page 691.

The strategy generates a long entry signal
when a fast adaptive moving average crosses
a slow adaptive moving average. In contrast,
the strategy generates a short entry signal
when a fast adaptive moving average crosses
under a slow adaptive moving average.

USAGE

The strategy shows a lot of signals and whipsaws which can be useful for swing
traders. When the market shows no strong trend, the strategy can produce false
signals. You could use the strategy along with additional indicators like "Relative
Strength Index" on page 753 to identify overbought and oversold levels.

For short and long-term traders different periods are suggested, so you can use
the "Optimizer" on page 274 to find a suitable period for your trading system. The
advantage of the KAMA is the adaptive weighting factor, which leads to the fact
that the strategy does not have to be constantly re-optimised.

ADAPTIVE MA CROSS - EXIT STRATEGY

DESCRIPTION

The strategy uses as tradings signals
crossovers between a fast and a slow
"Moving Average Adaptive" on page 691,
also known as Kaufman's Adaptive (KAMA).
The indicator itself is based on different "Moving Average Exponential" on
page 699 and focused more on trend efficiency then on volatility. For Entry
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signals with the same trigger, please use the"Adaptive MA Cross - Entry
Strategy" on page 539.

PARAMETERS

Period1
The number of bars used to calculate for the fast moving average adaptive

Default: 20

Period2
The number of bars used to calculate for the slow moving average adaptive

Default: 60

ExitMethod
Defines what kind of orders are placed

Default: Both

CALCULATION

Ó STRATEGYWITH THE TWOMOVING
AVERAGE EXPONENTIAL

The indicator uses two moving average
exponential with an adaptive weighting. For the
calculation of the indicator itself, see"Moving
Average Adaptive" on page 691.

The strategy generates generates a long exit
signal when a fast adaptive moving average
crosses under a slow adaptive moving
average. In contrast, the strategy generates a
short exit signal when a fast adaptive moving
average crosses over a slow adaptive moving average.

USAGE

The strategy shows a lot of signals and whipsaws which can be useful for swing
traders. When the market shows no strong trend, the strategy can produce false
signals. You could use the strategy along with additional indicators like "Relative
Strength Index" on page 753 to identify overbought and oversold levels.

For short and long-term traders different periods are suggested, so you can use
the "Optimizer" on page 274 to find a suitable period for your trading system. The
advantage of the KAMA is the adaptive weighting factor, which leads to the fact
that the strategy does not have to be constantly re-optimised.
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ADAPTIVE MA SLOPE - ENTRY STRATEGY

DESCRIPTION

The strategy uses the slope of the "Moving
Average Adaptive" on page 691, also known
as Kaufman's Adaptive (KAMA). The
indicator itself is based on different "Moving
Average Exponential" on page 699 and
focused more on trend efficiency then on
volatility. For Exit signals with the same
trigger, please use the "Adaptive MA Slope - Exit Strategy" on the next page.

PARAMETERS

Period
The number of bars used to calculate

Default: 20

LookBack
Defines the lookback period for the slope

Default: 5

EntryMethod
Defines what kind of orders are placed

Default: Both

CALCULATION

Ó KAMAWITH RSI

The indicator uses a Moving Average
Exponential with an adaptive weighting factor
to calculate the signal line. For the calculation
of the indicator itself, see "Moving Average
Adaptive" on page 691.

The strategy generates a long entry signal
when the slope of the Adaptive Moving
Average is positive. In contrast, the strategy
generates a short entry signal when the slope
of the Adaptive Moving Average is negative.
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USAGE

The strategy shows a lot of signals and whipsaws which can be useful for swing
traders. When the market shows no strong trend, the strategy can produce false
signals. You could use the strategy along with additional indicators like "Relative
Strength Index" on page 753 to identify overbought and oversold levels.

For short and long-term traders different periods are suggested, so you can use
the "Optimizer" on page 274 to find a suitable period for your trading system. The
advantage of the KAMA is the adaptive weighting factor, which leads to the fact
that the strategy does not have to be constantly re-optimised.

ADAPTIVE MA SLOPE - EXIT STRATEGY

DESCRIPTION

The strategy uses the slope of the "Moving
Average Adaptive" on page 691, also known
as Kaufman's Adaptive (KAMA). The
indicator itself is based on different "Moving
Average Exponential" on page 699 and
focused more on trend efficiency then on
volatility. For Entry signals with the same trigger, please use the"Adaptive MA
Slope - Entry Strategy" on the previous page.

PARAMETERS

Period
The number of bars used to calculate

Default: 20

LookBack
Defines the lookback period for the slope

Default: 5

ExitMethod
Defines what kind of orders are placed

Default: Both
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CALCULATION

Ó KAMA ENTRY AND EXIT STRATEGIES
WITH KAMA

The indicator uses a Moving Average
Exponential with an adaptive weighting factor
to calculate the signal line. For the calculation
of the indicator itself, see "Moving Average
Adaptive" on page 691.

The strategy generates a long exit signal when
the slope of the Adaptive Moving Average is
negative. In contrast, the strategy generates a
short exit signal when the slope of the Adaptive Moving Average is positive.

USAGE

The strategy shows a lot of signals and whipsaws which can be useful for swing
traders. When the market shows no strong trend, the strategy can produce false
signals. You could use the strategy along with additional indicators like "Relative
Strength Index" on page 753 to identify overbought and oversold levels.

For short and long-term traders different periods are suggested, so you can use
the "Optimizer" on page 274 to find a suitable period for your trading system. The
advantage of the KAMA is the adaptive weighting factor, which leads to the fact
that the strategy does not have to be constantly re-optimised.

ADX MA
Shortcode: ADXMA

DESCRIPTION

This indicator adds a smoothing component
to the Average Directional Index to filter non-
representative extreme values. The "Average
Directional Index" on page 551 evaluates the
strength of the current trend. The direction of
the trend is not measured.

PARAMETERS

Period
The number of bars used to calculate the smoothed ADX value.

Default: 14

544



CALCULATION

The calculation of this indicator is largely identical to that of the Directional
Movement Index. Its basis are two partial indicators:

à +DI (Upward Directional Indicator), which is calculated by
determining the +DM (Upward Directional Movement). The
+DMmeasures the difference between today's high and
yesterday's high and dividing it by the True Range based on
the selected period.

à -DM (Downward Directional Indicator), which is calculated by
determining the -DM (Downward Directional Movement). The
-DMmeasures the difference between today's low and
yesterday's low and dividing it by the True Range based on
the selected period.

The difference between the +DI and -DI is divided by the sum of the +DI and -DI.
The result is multiplied by 100 which produces the Directional Movement Index
percentage value. To calculate the Average Directional Index value this value is
smoothed using a "Moving Average Simple" on page 705.

The Average Directional Index value is then smoothed and transformed into the
ADX MA by applying a "Moving Average Simple" on page 705.

USAGE

Like the ADX this indicator is used to measure trend strength. The ADX MA is an
oscillator that fluctuates between 0 and 100. Values below 20 indicate that a trend
is weak and likely to reverse, values above 40 indicate that a trend is strong and
possibly increasing its strength.

Ó THE ADXMA (CENTER) COMPARED TO
THE ADX (BOTTOM).
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AROON
Shortcode: ARO

DESCRIPTION

This indicator can be used to determine the
beginning of a new trend as well as how
strong the trend is. It consists of two separate
indicator lines which show the number of
periods since price recorded an x-day high or
low.

PARAMETERS

Period
The number of bars used to calculate the indicator.

Default: 10

DownLevel
The lower threshold level.

Default: 25

UpLevel
The upper threshold level.

Default: 75

CALCULATION

The two indicator lines, Aroon up and Aroon down, oscillate between 0 and 100.
The Aroon up measures the number of bars since an x-day high, the Aroon down
measures the number of bars since an x-day low. In other words, the indicator
reports the time it is taking for the price to reach, from a starting point, the highest
and lowest points over a given time period, each reported as a percentage of total
time.

Aroon up = 100 * ((Period - n) / Period)
n = Bars since last period high

Aroon down = 100 * ((Period - n) / Period)
n = Bars since last period low
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USAGE
à An up line located above a down line indicates an uptrend;

indicator values of 70% or higher indicate that the trend is
strong.

à A down line located above an up line indicates a downtrend;
indicator values of 70% or higher indicate that the trend is
strong.

à Crossovers indicate a possible trend reversal; an up line
crossing a down line bottom-up is regarded a bullish signal, a
down line crossing an up line bottom-up is regarded a bearish
signal.

The indicator does not measure price changes but changes related to time
periods, therefore its progression is rather straight-lined. The more stable a trend
is the more stable the indicator line. Both indicator lines running in their respective
extreme zones or moving top-down in parallel indicate a trendless phase.
Reoccurring patterns help in the analysis of the indicator, of few of which are:

à Stable up line at 70% or higher

à Stable down line a 70% or higher

à Both lines moving towards 0% in parallel

à Up line crosses down line bottom-up

à Down line crosses up line bottom-up

Ó AROONWITH A PERIOD SETTING OF
25.
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Ó THE SAME CHART, AROONWITH A
PERIOD SETTING OF 13.

AROON OSCILLATOR
Shortcode: AOS

DESCRIPTION

This indicator is directly based on the Aroon
indicator which can be used to determine the
beginning of a new trend as well as how
strong the trend is. The Aroon consists of two
separate indicator lines which show the
number of periods since price recorded an x-
day high or low. The Aroon Oscillator can be used as a trend filter as well as to
measure trend strength.

PARAMETERS

Period
The number of bars used to calculate the indicator.

Default: 10

ShowAlerts
Controls whether alerts are displayed if the threshold values are exceeded.

Default: No

CALCULATION

The indicator requires the calculation of the Aroon up and Aroon down values.
The Aroon up measures the number of bars since an x-day high, the Aroon down
measures the number of bars since an x-day low. In other words, the indicator
reports the time it is taking for the price to reach, from a starting point, the highest
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and lowest points over a given time period, each reported as a percentage of total
time.

Aroon up = 100 * ((Period - n) / Period)
n = Bars since last period high

Aroon down = 100 * ((Period - n) / Period)
n = Bars since last period low

The Aroon Oscillator is calculated by subtracting the Aroon down value from the
Aroon up value:

AroonOscillator = Aroon up - Aroon down

USAGE
à Like the Aroon indicator, the Aroon Oscillator can be used as

a trend-following indicator.

à When used as a trend filter, an indicator line located above
the zero line indicates an upward trend while an indicator line
located below the zero line indicated a downward trend.

à The greater the distance between indicator line and zero line
the stronger the current trend (similar to the "Average
Directional Index" on page 551).

à Crossings of indicator line and zero line point to trend
reversals.

Ó AROONOSCILLATOR COMBINEDWITH
THE VOLUME FLOW VOLUME
INDICATOR.
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AVERAGE BALANCE VOLUME
Shortcode: ABV

DESCRIPTION

This indicator calculates a simple average of
the "On Balance Volume" on page 713,
producing a smoothed variant of it. The On
Balance Volume calculates the trading
volume of a security and relates it to the
respective closing price. It calculates a
cumulative sum for each day and displays it as a line on the chart.

PARAMETERS

Period
The number of bars used to calculate this indicator.

Default: 10

CALCULATION

If the current close is higher than the previous period's close the volume is added
to the previous period's indicator value, if it is lower it is subtracted from the
indicator value. The result is a cumulative sum which is displayed as a line on the
chart.

USAGE

The On Balance Volume, on which this indicator is based, is used to analyze
divergences and convergences between security and indicator. The numerical
value of the indicator is irrelevant, only the direction of the line created bears
significance. A strong trend is indicated by an indicator line which confirms the
direction of the underlying security, i.e. by an indicator line that moves in the same
direction as the price of the security (convergence). Divergences indicate a
weakening of the trend or a possible trend reversal. Trend lines applied to the
indicator often generate trading signals even earlier than the security. Those
signals can be used to confirm signals from the security itself.
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Ó AVERAGE BALANCE VOLUME
(CENTER) AND ON BALANCE VOLUME
(BOTTOM) COMPARED.

Ó THE INDICATOR TREND LINE IS
CROSSED BEFORE THE TREND LINE
IN THE CHART.

AVERAGE DIRECTIONAL INDEX
Shortcode: ADX

DESCRIPTION

This indicator evaluates the strength of the
current trend. It is a smoothed variant of the
"Directional Movement Index" on page 661

PARAMETERS

Period
The number of bars used to calculate the smoothed DMI value, i.e. the ADX
value.
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Default: 14

HighLevel
Threshold value indicating an area of strong trend activity.

Default: 30

LowLevel
Threshold value indicating an area of weak trend activity.

Default: 10

CALCULATION

The calculation of this indicator is largely identical to that of the Directional
Movement Index. Its basis are two partial indicators:

à +DI (Upward Directional Indicator), which is calculated by
determining the +DM (Upward Directional Movement) which
measures the difference between today's high and
yesterday's high and dividing it by the True Range based on
the selected period.

à -DM (Downward Directional Indicator), which is calculated by
determining the -DM (Downward Directional Movement)
which measures the difference between today's low and
yesterday's low and dividing it by the True Range based on
the selected period.

The difference between the +DI and -DI is divided by the sum of the +DI and -DI.
The result is multiplied by 100 which produces the Directional Movement Index
percentage value. To calculate the Average Directional Index value this value is
smoothed using a "Moving Average Simple" on page 705.

USAGE

The ADX is an oscillator that fluctuates between 0 and 100. Values below 20
indicate that a trend is weak and likely to reverse, values above 40 indicate that a
trend is strong and possibly increasing its strength. Threshold values indicating
strong and weak trend activity respectively can be added; these values should be
based on the underlying security and chosen accordingly.
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Ó A STRONG TREND, INDICATED BY
HIGH INDICATOR VALUES.

AVERAGE PRICE BREAKOUT - ENTRY
STRATEGY

DESCRIPTION

The strategy uses the relation within the
current candle and the relation between the
average price and the "Moving Average
Simple" on page 705 to generate trading
signals. For Exit signals with the same trigger,
please use the "Average Price Breakout - Exit
Strategy" on the next page.

PARAMETERS

Period
The number of bars used to calculate

Default: 5

EntryMethod
Defines what kind of orders are placed.

Default: Both

553



CALCULATION

Ó STRATEGY BEFORE AND AFTER
OPTIMIZER

For the strategy is a Simple Moving Average
with the input Period calculated. This Simple
Moving Average, the average price and the
current candle are used for trading signals. For
the calculation of the indicator itself,
see"Moving Average Simple" on page 705

The strategy generates a long entry signal
when the average price is higher than a Simple
Moving Average and the close higher than the
open. The other way round, a short entry signal
is generated when the average price is less than a Simple Moving Average and
the close is less than the open.

USAGE

Strategies which are using an average of historical data like price for trading
signals are always depending on delay, noise and trend. The influence of all the
three factors can be reduced by choosing the right values for the input. The
optimizer in Tradesignal is very useful to find the right settings.

AVERAGE PRICE BREAKOUT - EXIT STRATEGY

DESCRIPTION

The strategy uses the slope of the Average
Price to generate trading signals. For Entry
signals with the same trigger, please use
the"Average Price Breakout - Entry Strategy"
on the previous page.

PARAMETERS

LookBack
The number of bars used to calculate

Default: 2

ExitMethod
Defines what kind of orders are placed.

Default: Both
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CALCULATION

Ó STRATEGY BEFORE AND AFTER
OPTIMIZER

The strategy uses the average price within the
defined look back period.

The strategy generates a long exit signal when
the slope of the average price is negative. The
other way round, a short exit signal is
generated when the slope of the average price
is positive.

USAGE

Strategies which are using an average of historical data like price for trading
signals are always depending on delay, noise and trend. The influence of all the
three factors can be reduced by choosing the right values for the input. The
optimizer in Tradesignal is very useful to find the right settings.

AVERAGE TRUE RANGE
Shortcode: ATR

DESCRIPTION

This indicator measures the degree of price
movement (volatility) of a security. Low
values indicate only minor price changes
while high values indicate pronounced price
changes. A sustained period of low values
might indicate consolidation. The average
true range is a smoothed moving average of the true range values over the set
period.

PARAMETERS

This indicator requires a single parent instrument that has data fields for Open,
High, Low, Close available.

Period
The number of bars used to calculate the smoothing of the true range value.

Default: 14
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CALCULATION

The true range values are determined by calculating the largest of

à the most recent period's high minus the most recent period's
low,

à the absolute value of the most recent period's high minus the
previous close and

à the absolute value of the most recent period's low minus the
previous close.

The result is then smoothed using a simple moving average based on the
selected period setting.

USAGE

The indicator displays the true trading range of a security and can thus be used to
analyze market volatility. Since it takes gaps into consideration it allows for a
thorough and realistic analysis of market activity. A large trading range indicates a
large amount of movement while a small trading range indicates a small amount
of movement. This information can be used to evaluate trends as well as the
relationships between trends and trading ranges.

The indicator can also be used to develop stop orders and trailing stops. It
prevents the premature closing of positions caused by fluctuations of price.

Ó THE AVERAGE TRUE RANGEWITH A
PERIOD SETTING OF 1 RESULTS IN A
MINIMAL SMOOTHING OF THE TRUE
RANGE VALUE.
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Ó A PERIOD SETTING OF 14.

AVERAGE VALUE AT TIME
Shortcode: AVAT

DESCRIPTION

This indicator shows deviations in value
(typically volume) at a given time of day
compared to the mean value over the past
few days.

PARAMETERS

This indicator requires an intraday period which is less than a day.

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Days
The number of prior bars over which the average is calculated.

Default: 5

ShowPartialAverages
Controls whether the average should be calculated and shown for bars with an
insufficient number of data points.

Default: No

ProjectPriorDays
Projects the average value calculated for the whole of the current day.

Default: Yes
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CALCULATION

For each of the past few days the Average Value at Time calculates the mean
value for each intraday bar at the same time of day.

USAGE

This indicator enables intraday traders to see how the current volume for a bar is
deviating from the average value at this time of day. Differences in volume can
easily be identified by combining the indicator with a volume bar indicator (see
image above).

This indicator also features a projection which allows intraday traders to
anticipate the price route for the day:

The projection creates a price route for the day.

BACK COLOR DAILY
Shortcode: BACKD

DESCRIPTION

This indicator displays different colors for the
background of subcharts based on
alternating days.

PARAMETERS

ColorA
The background color for one of the two alternating days.

ColorB
The background color for one of the two alternating days.
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USAGE

This indicator is used to analyze the relationship between significant volume or
price changes and day transitions. The following example shows a volume
indicator applied in combination with the Back Color Daily:

Ó A VOLUME HIKE OCCURRING AT THE
TRANSITION FROMONE DAY TO THE
NEXT.

BOLLINGER BANDS
Shortcode: BBD

DESCRIPTION

This indicator calculates the volatility of a
price as well as the relative price level. It
consists of a Simple Moving Average
represented by the center line and two outer
bands visualizing the volatility.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Period
The number of bars used to calculate the Simple Moving Average.

Default: 20

StdDevs
The number of standard deviations used in the calculation of the outer bands.

Default: 2
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CALCULATION

A Simple Moving Average is calculated and used to draw the center line. Adding
the standard deviation to the SMA produces the upper band, subtracting the
standard deviation from the SMA produces the lower band.

USAGE

Bollinger Bands are often used in combination with other indicators in order to
identify price changes and reversals. Some of the most common interpretations
are:

à When prices continually touch the upper band, they are
overbought, when prices continually touch the lower band
they are oversold.

à A large distance between the bands indicates high volatility, a
small distance between the bands indicates low volatility.

à Breakouts suggest a continuation of the price movement.

à When both bands move towards the Simple Moving Average,
a strong price movement is imminent.

à Tops or bottoms point to an impending trend reversal.

Ó NARROWBANDS (LOW VOLATILITY)
PRECEDED AND FOLLOWED BY
EXPANDING BANDS (HIGH
VOLATILITY).

Price breakouts suggest a continuation
of the price movement.
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BOLLINGER BAND BREAKOUT STRATEGY

DESCRIPTION

This complete strategy generates trading
signals when the current price breakouts from
the Bollinger Band channel. The Bollinger
Band itself consists of a Simple Moving
Average represented by the center line and
two outer bands visualizing the volatility, see
"Bollinger Bands" on page 559. When you
want to use this strategy in a "Portfolio" on page 251, use the portfolio optimized
version "Bollinger Band Breakout Portfolio Strategy" on the next page.

PARAMETERS

Period
The number of bars used to calculate

Default: 20

StdDevs
The number of standard deviations used in the calculation of the outer bands.

Default: 2.0

Bullish
Defines what kind of orders are placed

Default: LongEntry

Bearish
Defines what kind of orders are placed

Default: LongExit
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CALCULATION

Ó OPTIMIZER FOR BOTH INPUTS AND
FOR EACH INPUT INDIVIDUALLY

The Bollinger Band uses three SMA which use
the inputs Period and StdDevs. For the
calculation of the indicator itself, see "Bollinger
Bands" on page 559 or "Moving Average
Simple" on page 705.

A crossover between the price line and the
channel generates trading signals.

USAGE

The Bollinger Band shows the price
movements in the market in a given period.
Sharp price movements will lead to a wider channel. If the market is consolidated,
the bands will be thinner. The generated signals give hints if the market is
overbought or oversold.

John Bollinger itself stated several times that a crossover between the price and
the Bollinger Bands is only an indication for a trading signal. As a lot of traders are
using the Bollinger Bands, sometimes are profits self fulfilling prophecies.
Bollinger suggested to combine the strategy with additional indicators. Several
traders published already studies about useful combinations like Candle Patterns
or "Relative Strength Index" on page 753.

In addition it could be worth to try different StdDevs as the exact standard
deviation is not know for a specific symbol. The "Optimizer" on page 274 can
optimize both inputs, period and StdDevs, in one go. It is also possible to optimize
only one of the inputs individually. The different results are shown on the figure.

BOLLINGER BAND BREAKOUT PORTFOLIO
STRATEGY

DESCRIPTION

The complete strategy generates trading
signals when the current price breakouts from
the Bollinger Band channel. The Bollinger
Band itself consists of a Simple Moving
Average represented by the center line and
two outer bands visualizing the volatility, see
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"Bollinger Bands" on page 559. This strategy is optimized for a "Portfolio" on
page 251.

PARAMETERS

Period
The number of bars used to calculate

Default: 20

StdDevs
The number of standard deviations used in the calculation of the outer bands.

Default: 2.0

Bullish
Defines what kind of orders are placed

Default: LongEntry

Bearish
Defines what kind of orders are placed

Default: LongExit

CALCULATION

Ó OPTIMIZER FOR BOTH INPUTS AND
FOR EACH INPUT INDIVIDUALLY

The Bollinger Band uses three SMA which use
the inputs Period and StdDevs. For the
calculation of the indicator itself, see "Bollinger
Bands" on page 559 or "Moving Average
Simple" on page 705.

A crossover between the price line and the
channel generates trading signals.

USAGE

The Bollinger Band shows the price
movements in the market in a given period.
Sharp price movements will lead to a wider channel. If the market is consolidated,
the bands will be thinner. The generated signals give hints if the market is
overbought or oversold.

John Bollinger itself stated several times that a crossover between the price and
the Bollinger Bands is only an indication for a trading signal. As a lot of traders are
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using the Bollinger Bands, sometimes are profits self fulfilling prophecies.
Bollinger suggested to combine the strategy with additional indicators. Several
traders published already studies about useful combinations like Candle Patterns
or "Relative Strength Index" on page 753.

In addition it could be worth to try different StdDevs as the exact standard
deviation is not know for a specific symbol. The "Optimizer" on page 274 can
optimize both inputs, period and StdDevs, in one go. It is also possible to optimize
only one of the inputs individually. The different results are shown on the figure.

BOLLINGER BAND REVERSAL STRATEGY

DESCRIPTION

The complete strategy generates trading
signals based on a reversal price breakout
from the Bollinger Bands channel. The
Bollinger Band itself consists of a Simple
Moving Average represented by the center
line and two outer bands visualizing the
volatility, see "Bollinger Bands" on page 559.

PARAMETERS

Period
The number of bars used to calculate

Default: 20

StdDevs
The number of standard deviations used in the calculation of the outer bands.

Default: 2.0

Bullish
Defines what kind of orders are placed

Default: LongEntry

Bearish
Defines what kind of orders are placed

Default: LongExit
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CALCULATION

Ó STRATEGYWITH BOLLINGER BANDS

The Bollinger Band uses three SMA which use
the inputs Period and StdDevs. For the
calculation of the indicator itself, see"Bollinger
Bands" on page 559 or "Moving Average
Simple" on page 705.

A reversal price breakout from the Bollinger
Bands channel generates trading signals.

USAGE

The Bollinger Band shows the price movements in the market in a given period.
Sharp price movements will lead to a wider channel. If the market is consolidated,
the bands will be thinner. The generated signals give hints if the market is
overbought or oversold.

John Bollinger itself stated several times that a crossover between the price and
the Bollinger Bands is only an indication for a trading signal. As a lot of traders are
using the Bollinger Bands, sometimes are profits self fulfilling prophecies.
Bollinger suggested to combine the strategy with additional indicators. Several
traders published already studies about useful combinations like Candle Patterns
or "Relative Strength Index" on page 753.

In addition it could be worth to try different StdDevs as the exact standard
deviation is not know for a specific symbol. The "Optimizer" on page 274 can
optimize both inputs, period and StdDevs, in one go. It is also possible to optimize
only one of the inputs individually.

BOLLINGER LOWER BAND - ENTRY STRATEGY

DESCRIPTION

The strategy generates long entry signals
based on a crossover with the price and the
lower band of the Bollinger Band. The
Bollinger Band itself consists of a Simple
Moving Average represented by the center
line and two outer bands visualizing the
volatility, see "Bollinger Bands" on page 559.
For Exit signals with the same trigger, please use the "Bollinger Lower Band - Exit
Strategy" on page 567.
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PARAMETERS

Period
The number of bars used to calculate

Default: 20

StdDevs
The number of standard deviations used in the calculation of the outer bands.

Default: 2.0

EntryMethod
Defines what kind of orders are placed

Default: Both

CALCULATION

Ó STRATEGYWITH BOLLINGER BANDS

The Bollinger Band uses three SMA which use
the inputs Period and StdDevs. For the
calculation of the indicator itself, see "Bollinger
Bands" on page 559 or "Moving Average
Simple" on page 705.

The strategy generates a long entry signal
when the close crosses over the lower band.
When the close crosses under the lower band,
a short entry signal generated.

USAGE

The Bollinger Band shows the price movements in the market in a given period.
Sharp price movements will lead to a wider channel. If the market is consolidated,
the bands will be thinner. The generated signals give hints if the market is
overbought or oversold.

John Bollinger itself stated several times that a crossover between the price and
the Bollinger Bands is only an indication for a trading signal. As a lot of traders are
using the Bollinger Bands, sometimes are profits self fulfilling prophecies.
Bollinger suggested to combine the strategy with additional indicators. Several
traders published already studies about useful combinations like Candle Patterns
or "Relative Strength Index" on page 753.

In addition it could be worth to try different StdDevs as the exact standard
deviation is not know for a specific symbol. The "Optimizer" on page 274 can
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optimize both inputs, period and StdDevs, in one go. It is also possible to optimize
only one of the inputs individually.

BOLLINGER LOWER BAND - EXIT STRATEGY

DESCRIPTION

The strategy generates long exit signals
based on a crossover with the price and the
lower band of the Bollinger Band. For Entry
signals with the same trigger, please use the
"Bollinger Lower Band - Entry Strategy" on
page 565.

The Bollinger Band itself consists of a Simple Moving Average represented by the
center line and two outer bands visualizing the volatility, see "Bollinger Bands" on
page 559.

PARAMETERS

Period
The number of bars used to calculate

Default: 20

StdDevs
The number of standard deviations used in the calculation of the outer bands.

Default: 2.0

ExitMethod
Defines what kind of orders are placed

Default: Both

CALCULATION

Ó STRATEGYWITH BOLLINGER BANDS

The Bollinger Band uses three SMA which use
the inputs Period and StdDevs. For the
calculation of the indicator itself, see"Bollinger
Bands" on page 559 or "Moving Average
Simple" on page 705.
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A long exit signal is generated when the close crosses under the lower band.
When the close crosses over the lower band, is short exit signal generated.

USAGE

The Bollinger Band shows the price movements in the market in a given period.
Sharp price movements will lead to a wider channel. If the market is consolidated,
the bands will be thinner. The generated signals give hints if the market is
overbought or oversold.

John Bollinger itself stated several times that a crossover between the price and
the Bollinger Bands is only an indication for a trading signal. As a lot of traders are
using the Bollinger Bands, sometimes are profits self fulfilling prophecies.
Bollinger suggested to combine the strategy with additional indicators. Several
traders published already studies about useful combinations like Candle Patterns
or "Relative Strength Index" on page 753.

In addition it could be worth to try different StdDevs as the exact standard
deviation is not know for a specific symbol. The "Optimizer" on page 274 can
optimize both inputs, period and StdDevs, in one go. It is also possible to optimize
only one of the inputs individually.

BOLLINGER UPPER BAND - ENTRY STRATEGY

DESCRIPTION

The strategy generates long entry signals
based on a crossover with the price and the
upper band of the Bollinger Band. The
Bollinger Band itself consists of a Simple
Moving Average represented by the center
line and two outer bands visualizing the
volatility, see "Bollinger Bands" on page 559.
For Exit signals with the same trigger, please use the"Bollinger Upper Band - Exit
Strategy" on page 570.

PARAMETERS

Period
The number of bars used to calculate

Default: 20

StdDevs
The number of standard deviations used in the calculation of the outer bands.
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Default: 2.0

EntryMethod
Defines what kind of orders are placed

Default: Both

CALCULATION

Ó STRATEGYWITH BOLLINGER BANDS

The Bollinger Band uses three SMA which use
the inputs Period and StdDevs. For the
calculation of the indicator itself, see "Bollinger
Bands" on page 559 or "Moving Average
Simple" on page 705.

The strategy generates a long entry signal
when the close crosses over the upper band.
When the close crosses under the upper band,
a short entry signal generated.

USAGE

The Bollinger Band shows the price movements in the market in a given period.
Sharp price movements will lead to a wider channel. If the market is consolidated,
the bands will be thinner. The generated signals give hints if the market is
overbought or oversold.

John Bollinger itself stated several times that a crossover between the price and
the Bollinger Bands is only an indication for a trading signal. As a lot of traders are
using the Bollinger Bands, sometimes are profits self fulfilling prophecies.
Bollinger suggested to combine the strategy with additional indicators. Several
traders published already studies about useful combinations like Candle Patterns
or "Relative Strength Index" on page 753.

In addition it could be worth to try different StdDevs as the exact standard
deviation is not know for a specific symbol. The "Optimizer" on page 274 can
optimize both inputs, period and StdDevs, in one go. It is also possible to optimize
only one of the inputs individually.
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BOLLINGER UPPER BAND - EXIT STRATEGY

DESCRIPTION

The strategy generates long exit signals
based on a crossover with the price and the
upper band of the Bollinger Band. For Entry
signals with the same trigger, please use the
"Bollinger Upper Band - Entry Strategy" on
page 568.

The Bollinger Band itself consists of a Simple Moving Average represented by the
center line and two outer bands visualizing the volatility, see "Bollinger Bands" on
page 559.

PARAMETERS

Period
The number of bars used to calculate

Default: 20

StdDevs
The number of standard deviations used in the calculation of the outer bands.

Default: 2.0

ExitMethod
Defines what kind of orders are placed

Default: Both

CALCULATION

Ó STRATEGYWITH BOLLINGER BANDS

The Bollinger Band uses three SMA which use
the inputs Period and StdDevs. For the
calculation of the indicator itself, see "Bollinger
Bands" on page 559 or "Moving Average
Simple" on page 705.

A long exit signal is generated when the close
crosses under the upper band. When the close
crosses over the upper band, is short exit
signal generated.
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USAGE

The Bollinger Band shows the price movements in the market in a given period.
Sharp price movements will lead to a wider channel. If the market is consolidated,
the bands will be thinner. The generated signals give hints if the market is
overbought or oversold.

John Bollinger itself stated several times that a crossover between the price and
the Bollinger Bands is only an indication for a trading signal. As a lot of traders are
using the Bollinger Bands, sometimes are profits self fulfilling prophecies.
Bollinger suggested to combine the strategy with additional indicators. Several
traders published already studies about useful combinations like Candle Patterns
or "Relative Strength Index" on page 753.

In addition it could be worth to try different StdDevs as the exact standard
deviation is not know for a specific symbol. The "Optimizer" on page 274 can
optimize both inputs, period and StdDevs, in one go. It is also possible to optimize
only one of the inputs individually.

BUY & HOLD
Shortcode: n/a

DESCRIPTION

This indicator calculates the open equity of a
theoretical Buy & Hold strategy investing the
initial capital.

PARAMETERS

StartingDate
When the long position should be entered. Select TradingStart to use the date
configured in the Money Management properties. Select FirstStrategyEntry to
take a position when another strategy takes its first position.

Default: TradingStart

Mode
How the gain should be displayed. AbsoluteMoneyMgmt (show equity gain using
initial capital from Money Management properties), PercentMoneyMgmt (show
percent change using initial capital from Money Management properties),
Absolute (show equity gain using initial capital from the Capital input), Percent
(show percent change using initial capital from the Capital input).
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Default: AbsoluteMoneyMgmt

Capital
The starting capital to use when Mode is Absolute or Percent.

Default: 1000

CALCULATION

Depending on the money management settings, e.g. start date and initial capital,
this indicator calculates the open equity of a theoretical Buy & Hold strategy.

USAGE

In general, Buy & Hold means that an investor buys stocks and holds them for a
long period of time, completely disregarding market movements. Investors
employing a Buy & Hold strategy actively select stocks, but are not concerned
with short-term price movements and technical indicators. This indicator offers a
way to compare other strategies applied the underlying instrument to a theoretical
Buy & Hold strategy, visualizing the open equity based on the money
management settings.

Ó THE INDICATOR COMPARES A
THEORETICAL BUY & HOLD
STRATEGY TOOTHER STRATEGIES
APPLIED TO THE CURRENT CHART.
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BUY & HOLD BENCHMARK
Shortcode: n/a

DESCRIPTION

This indicator calculates the open equity of a
theoretical Buy & Hold strategy on a specified
benchmark symbol, investing the initial
capital.

It can be used in a chart or portfolio to
compare the equity of a strategy against a
benchmark Buy & Hold.

PARAMETERS

Benchmark
The instrument to be used for calculating the theoretical Buy & Hold open equity.

StartingDate
When the long position should be entered. Select TradingStart to use the date
configured in the Money Management properties. Select FirstStrategyEntry to
take a position when another strategy takes its first position.

Default: TradingStart

Mode
How the gain should be displayed. AbsoluteMoneyMgmt (show equity gain using
initial capital from Money Management properties), PercentMoneyMgmt (show
percent change using initial capital from Money Management properties),
Absolute (show equity gain using initial capital from the Capital input), Percent
(show percent change using initial capital from the Capital input).

Default: AbsoluteMoneyMgmt

Capital
The starting capital to use when Mode is Absolute or Percent.

Default: 1000

CALCULATION

Depending on the money management settings, e.g. start date and initial capital,
this indicator calculates the open equity of a theoretical Buy & Hold strategy on a
benchmark symbol.
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USAGE

In general, Buy & Hold means that an investor buys stocks and holds them for a
long period of time, completely disregarding market movements. Investors
employing a Buy & Hold strategy actively select stocks, but are not concerned
with short-term price movements and technical indicators. This indicator offers a
way to compare other strategies applied the underlying instrument to a theoretical
Buy & Hold strategy, visualizing the open equity based on the money
management settings.

Ó THE INDICATOR COMPARES A
THEORETICAL BUY & HOLD
STRATEGY TOOTHER STRATEGIES
APPLIED TO THE CURRENT CHART.

CANDLE BEARISH ENGULFING PATTERN -
ENTRY STRATEGY

DESCRIPTION

This strategy generates a short entry signal
when the candle pattern bearish "Engulfing
pattern" on page 117 is identified in the chart.
This pattern is a bearish trend reversal
pattern. For Exit signals with the same trigger,
please use the "Candle Bearish Engulfing
Pattern - Exit Strategy" on the next page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

OrderMethod
Defines the order method
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Default: atMarket

CALCULATION

Ó BULLISH AND BEARISH ENGULFING
PATTERN

The strategy identifies a "Engulfing pattern" on
page 117. For a description of the candle
pattern, see "Using Candlestick Patterns" on
page 113. If the pattern is identified, a short
entry signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.

USAGE

The strategy uses a candle pattern which is a signal for a trend reversal. The
identification of trend reversal are important for swing traders.

When you execute the trades immediately without the confirmation, the quick
trade can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE BEARISH ENGULFING PATTERN - EXIT
STRATEGY

DESCRIPTION

This strategy generates a long exit signal
when the candle pattern bearish "Engulfing
pattern" on page 117 is identified in the chart.
This pattern is a bearish trend reversal
pattern. For Entry signals with the same
trigger, please use the "Candle Bearish
Engulfing Pattern - Entry Strategy" on the
previous page.
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PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó BULLISH AND BEARISH ENGULFING
PATTERN

The strategy identifies a "Engulfing pattern" on
page 117. For a description of the candle
pattern, see "Using Candlestick Patterns" on
page 113. If the pattern is identified, a long exit
signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.

USAGE

The strategy uses a candle pattern which is a signal for a trend reversal. The
identification of trend reversal are important for swing traders.

When you execute the trades immediately without the confirmation, the quick
trade can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.
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CANDLE BELT HOLD BEARISH - ENTRY
STRATEGY

DESCRIPTION

This strategy generates a short entry signal
when the candle pattern bearish "Belt Hold"
on page 116 is identified in the chart. This
pattern is a bearish trend reversal pattern. For
Exit signals with the same trigger, please use
the "Candle Belt Hold Bearish - Exit Strategy"
on the next page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó BULLISH AND BEARISH BELT HOLD

The strategy identifies a "Belt Hold" on
page 116. For a description of the candle
pattern, see "Using Candlestick Patterns" on
page 113. If the pattern is identified, a short
entry signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last option the order is only executed, if
the bearish trend is confirmed with the price.
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USAGE

The strategy uses a candle pattern which is a signal for a trend reversal. The
identification of trend reversal are important for swing traders.

When you execute the trades immediately without the confirmation, the quick
trade can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE BELT HOLD BEARISH - EXIT
STRATEGY

DESCRIPTION

This strategy generates a long exit signal
when the candle pattern bearish "Belt Hold"
on page 116 is identified in the chart. This
pattern is a bearish trend reversal pattern. For
Entry signals with the same trigger, please
use the "Candle Belt Hold Bearish - Entry
Strategy" on the previous page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket
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CALCULATION

Ó BULLISH AND BEARISH BELT HOLD

The strategy identifies a "Belt Hold" on
page 116. For a description of the candle
pattern, see "Using Candlestick Patterns" on
page 113. If the pattern is identified, a long exit
signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last option the order is only executed, if
the bearish trend is confirmed with the price.

USAGE

The strategy uses a candle pattern which is a signal for a trend reversal. The
identification of trend reversal are important for swing traders.

When you execute the trades immediately without the confirmation, the quick
trade can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE BELT HOLD BULLISH - ENTRY
STRATEGY

DESCRIPTION

This strategy generates a long entry signal
when the candle pattern bullish "Belt Hold" on
page 116 is identified in the chart. This
pattern is a bullish trend reversal pattern. For
Exit signals with the same trigger, please use
the "Candle Belt Hold Bullish - Exit Strategy"
on page 581.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.
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Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó BULLISH AND BEARISH BELT HOLD

The strategy identifies a "Belt Hold" on
page 116. For a description of the candle
pattern, see "Using Candlestick Patterns" on
page 113. If the pattern is identified, a long
entry signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses over the highest
price of the pattern, atPriceTrigger. With the last option the order is only executed, if
the bearish trend is confirmed with the price.

USAGE

The strategy uses a candle pattern which is a signal for a trend reversal. The
identification of trend reversal are important for swing traders.

When you execute the trades immediately without the confirmation, the quick
trade can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.
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CANDLE BELT HOLD BULLISH - EXIT STRATEGY

DESCRIPTION

This strategy generates a short exit signal
when the candle pattern bullish "Belt Hold" on
page 116 is identified in the chart. This
pattern is a bullish trend reversal pattern. For
Entry signals with the same trigger, please
use the "Candle Belt Hold Bullish - Entry
Strategy" on page 579.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó BULLISH AND BEARISH BELT HOLD

The strategy identifies a "Belt Hold" on
page 116. For a description of the candle
pattern, see "Using Candlestick Patterns" on
page 113. If the pattern is identified, a short exit
signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses over the highest
price of the pattern, atPriceTrigger. With the last option the order is only executed, if
the bearish trend is confirmed with the price.
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USAGE

The strategy uses a candle pattern which is a signal for a trend reversal. The
identification of trend reversal are important for swing traders.

When you execute the trades immediately without the confirmation, the quick
trade can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE BIG BLACK BEARTREND - ENTRY
STRATEGY

DESCRIPTION

This strategy generates a short entry signal
when a big black candle appears in a bearish
trend. Big black candles show a strong sell
pressure. In a bearish trend that is a signal for
a trend reversal. For Exit signals with the
same trigger, please use the "Candle Big
Black Beartrend - Exit Strategy" on the next
page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket
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CALCULATION

Ó BIG BLACK CANDLE

The strategy uses a big black candle in a
downwards trend which is a signal for a trend
reversal. For the definition of a big black
candle, see "Using Candlestick Patterns" on
page 113. If the pattern is identified, a short
entry signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.

USAGE

The strategy uses a big black candle in a downwards trend which is a signal for a
trend reversal. The strategy includes therefor already the confirmation for the
trend reversal. When you execute the trades immediately without a confirmation,
the quick trade can result in a higher profit but is also riskier. The "Candle Big
Black Candlestick - Entry Strategy" on page 585 is the same strategy without a
confirmation.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE BIG BLACK BEARTREND - EXIT
STRATEGY

DESCRIPTION

This strategy generates a long exit signal
when a big black candle appears in a bearish
trend. Big black candles show a strong sell
pressure. In a bearish trend that is a signal for
a trend reversal. For Entry signals with the
same trigger, please use the "Candle Big
Black Beartrend - Entry Strategy" on the
previous page.
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PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó BIG BLACK CANDLE

The strategy uses a big black candle in a
downwards trend which is a signal for a trend
reversal. For the definition of a big black
candle, see "Using Candlestick Patterns" on
page 113. If the pattern is identified, a long exit
signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.

USAGE

The strategy uses a big black candle in a downwards trend which is a signal for a
trend reversal. The strategy includes therefor already the confirmation for the
trend reversal. When you execute the trades immediately without a confirmation,
the quick trade can result in a higher profit but is also riskier. The strategy "Candle
Big Black Candlestick - Exit Strategy" on page 586 is the same strategy without a
confirmation.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.
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CANDLE BIG BLACK CANDLESTICK - ENTRY
STRATEGY

DESCRIPTION

This strategy generates a short entry signal
when a big black candle appears. Big black
candles show a strong sell pressure and can
be a signal for a trend reversal. For Exit
signals with the same trigger, please use the
"Candle Big Black Candlestick - Exit
Strategy" on the next page.

PARAMETERS

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó BIG BLACK CANDLE

The strategy uses a big black candle as trading
signal. For the definition of a big black candle,
see "Using Candlestick Patterns" on page 113.
If the pattern is identified, a short entry signal is
generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.

USAGE

The strategy uses a big black candle without a confirmation as trading signal.
When you execute the trades immediately without a confirmation, the quick trade
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can result in a higher profit but is also riskier. If you want to use a strategy with
confirmation, please use "Candle Big Black Beartrend - Entry Strategy" on
page 582.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE BIG BLACK CANDLESTICK - EXIT
STRATEGY

DESCRIPTION

This strategy generates a long exit signal
when a big black candle appears. Big black
candles show a strong sell pressure and can
be a signal for a trend reversal. For Entry
signals with the same trigger, please use the
"Candle Big Black Candlestick - Entry
Strategy" on the previous page.

PARAMETERS

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket
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CALCULATION

Ó BIG BLACK CANDLE

The strategy uses a big black candle as trading
signal. For the definition of a big black candle,
see "Using Candlestick Patterns" on page 113.
If the pattern is identified, a short entry signal is
generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.

USAGE

The strategy uses a big black candle without a confirmation as trading signal.
When you execute the trades immediately without a confirmation, the quick trade
can result in a higher profit but is also riskier. If you want to use a strategy with
confirmation, please use "Candle Big Black Beartrend - Exit Strategy" on
page 583.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE BIG WHITE BULLTREND - ENTRY
STRATEGY

DESCRIPTION

This strategy generates a long entry signal
when a big white candle appears in a bullish
trend. Big white candles show a strong buy
pressure. In a bullish trend that is a signal for
a trend reversal. For Exit signals with the
same trigger, please use the "Candle Big
White Bulltrend - Exit Strategy" on page 589.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.
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Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó BIGWHITE CANDLE

The strategy uses a big white candle in a
upwards trend which is a signal for a trend
reversal. For the definition of a big white
candle, see "Using Candlestick Patterns" on
page 113. If the pattern is identified, a long
entry signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses over the highest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bullish
trend is confirmed with the price.

USAGE

The strategy uses a big white candle in a upwards trend which is a signal for a
trend reversal. The strategy includes therefor already the confirmation for the
trend reversal. When you execute the trades immediately without a confirmation,
the quick trade can result in a higher profit but is also riskier. The is the same
strategy without a confirmation "Candle Big White Candlestick - Entry Strategy"
on page 590.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.
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CANDLE BIG WHITE BULLTREND - EXIT
STRATEGY

DESCRIPTION

This strategy generates a short exit signal
when a big white candle appears in a bullish
trend. Big white candles show a strong buy
pressure. In a bullish trend that is a signal for
a trend reversal. For Entry signals with the
same trigger, please use the "Candle Big
White Bulltrend - Entry Strategy" on page 587.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó BIGWHITE CANDLE

The strategy uses a big white candle in a
upwards trend which is a signal for a trend
reversal. For the definition of a big white
candle, see "Using Candlestick Patterns" on
page 113. If the pattern is identified, a short exit
signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses over the highest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bullish
trend is confirmed with the price.
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USAGE

The strategy uses a big white candle in a upwards trend which is a signal for a
trend reversal. The strategy includes therefor already the confirmation for the
trend reversal. When you execute the trades immediately without a confirmation,
the quick trade can result in a higher profit but is also riskier. The "Candle Big
White Bulltrend - Exit Strategy" on the previous page is the same strategy without
a confirmation.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE BIG WHITE CANDLESTICK - ENTRY
STRATEGY

DESCRIPTION

This strategy generates a long entry signal
when a big white candle appears. Big white
candles show a strong buy pressure and can
be a signal for a trend reversal. For Exit
signals with the same trigger, please use the
"Candle Big White Candlestick - Exit Strategy" on the next page

PARAMETERS

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket
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CALCULATION

Ó BIGWHITE CANDLE

The strategy uses a big white candle as trading
signal. For the definition of a big white candle,
see "Using Candlestick Patterns" on page 113.
If the pattern is identified, a long entry signal is
generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses over the highest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bullish
trend is confirmed with the price.

USAGE

The strategy uses a big white candle without a confirmation as trading signal.
When you execute the trades immediately without a confirmation, the quick trade
can result in a higher profit but is also riskier. If you want to use a strategy with
confirmation, please use "Candle Big White Bulltrend - Entry Strategy" on
page 587.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE BIG WHITE CANDLESTICK - EXIT
STRATEGY

DESCRIPTION

This strategy generates a short exit signal
when a big white candle appears. Big white
candles show a strong buy pressure and can
be a signal for a trend reversal. For Entry
signals with the same trigger, please use the
"Candle Big White Candlestick - Entry
Strategy" on the previous page.

PARAMETERS

CandlePeriod
Determines average values of some candlestick components.
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Default: 5

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó BIGWHITE CANDLE

The strategy uses a big white candle as trading
signal. For the definition of a big white candle,
see "Using Candlestick Patterns" on page 113.
If the pattern is identified, a short exit signal is
generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses over the highest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bullish
trend is confirmed with the price.

USAGE

The strategy uses a big white candle without a confirmation as trading signal.
When you execute the trades immediately without a confirmation, the quick trade
can result in a higher profit but is also riskier. If you want to use a strategy with
confirmation, please use "Candle Big White Bulltrend - Entry Strategy" on
page 587.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.
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CANDLE BULLISH ENGULFING PATTERN -
ENTRY STRATEGY

DESCRIPTION

This strategy generates a long entry signal
when the candle pattern bullish "Engulfing
pattern" on page 117 is identified in the chart.
This pattern is a bullish trend reversal pattern.
For Exit signals with the same trigger, please
use the "Candle Bullish Engulfing Pattern -
Exit Strategy" on the next page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó BULLISH AND BEARISH ENGULFING
PATTERN

The strategy identifies a "Engulfing pattern" on
page 117. For a description of the candle
pattern, see "Using Candlestick Patterns" on
page 113. If the pattern is identified, a long
entry signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses over the highest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bullish
trend is confirmed with the price.

USAGE

The strategy uses a candle pattern which is a signal for a trend reversal. The
identification of trend reversal are important for swing traders.
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When you execute the trades immediately without the confirmation, the quick
trade can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE BULLISH ENGULFING PATTERN - EXIT
STRATEGY

DESCRIPTION

This strategy generates a short exit signal
when the candle pattern bullish "Engulfing
pattern" on page 117 is identified in the chart.
This pattern is a bullish trend reversal pattern.
For Entry signals with the same trigger,
please use the "Candle Bullish Engulfing
Pattern - Entry Strategy" on the previous
page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

OrderMethod
Defines the order method

Default: atMarket
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CALCULATION

Ó BULLISH AND BEARISH ENGULFING
PATTERN

The strategy identifies a "Engulfing pattern" on
page 117. For a description of the candle
pattern, see "Using Candlestick Patterns" on
page 113. If the pattern is identified, a short exit
signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses over the highest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bullish
trend is confirmed with the price.

USAGE

The strategy uses a candle pattern which is a signal for a trend reversal. The
identification of trend reversal are important for swing traders.

When you execute the trades immediately without the confirmation, the quick
trade can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE COUNTERATTACK BEARISH - ENTRY
STRATEGY

DESCRIPTION

This strategy generates a short entry signal
when the candle pattern bearish
"Counterattack " on page 116 is identified in
the chart during. This pattern is a bearish
trend reversal pattern. For Exit signals with
the same trigger, please use the "Candle
CounterAttack Bearish - Exit Strategy" on
page 597.

PARAMETERS

FilterPeriod
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The number of bars used to calculate the candle patterns.

Default: 10

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó BULLISH AND BEARISH
COUNTERATTACK

The strategy identifies a "Counterattack " on
page 116. For a description of the candle
pattern, see "Using Candlestick Patterns" on
page 113. If the pattern is identified, a short
entry signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.

USAGE

The strategy uses a candle pattern which is a signal for a trend reversal. The
identification of trend reversal are important for swing traders.

When you execute the trades immediately without a confirmation, the quick trade
can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.
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CANDLE COUNTERATTACK BEARISH - EXIT
STRATEGY

DESCRIPTION

This strategy generates a long exit signal
when the candle pattern bearish
"Counterattack " on page 116 is identified in
the chart. This pattern is a bearish trend
reversal pattern. For Entry signals with the
same trigger, please use the "Candle
CounterAttack Bearish - Entry Strategy" on
page 595.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó BULLISH AND BEARISH
COUNTERATTACK

The strategy identifies a "Counterattack " on
page 116. For a description of the candle
pattern, see "Using Candlestick Patterns" on
page 113. If the pattern is identified, a long exit
signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.
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USAGE

The strategy uses a candle pattern which is a signal for a trend reversal. The
identification of trend reversal are important for swing traders.

When you execute the trades immediately without a confirmation, the quick trade
can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE COUNTERATTACK BULLISH - ENTRY
STRATEGY

DESCRIPTION

This strategy generates a long entry signal
when the candle pattern bullish
"Counterattack " on page 116 is identified in
the chart during. This pattern is a bullish trend
reversal pattern. For Exit signals with the
same trigger, please use the "Candle
CounterAttack Bullish - Exit Strategy" on the
next page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

OrderMethod
Defines the order method

Default: atMarket
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CALCULATION

Ó BULLISH AND BEARISH
COUNTERATTACK

The strategy identifies a bullish "Counterattack
" on page 116. For a description of the candle
pattern, see "Using Candlestick Patterns" on
page 113. If the pattern is identified, a long
entry signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses over the highest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bullish
trend is confirmed with the price.

USAGE

The strategy uses a candle pattern which is a signal for a trend reversal. The
identification of trend reversal are important for swing traders.

When you execute the trades immediately without a confirmation, the quick trade
can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE COUNTERATTACK BULLISH - EXIT
STRATEGY

DESCRIPTION

This strategy generates a short exit signal
when the candle pattern bullish
"Counterattack " on page 116 is identified in
the chart. This pattern is a bullish trend
reversal pattern. For Entry signals with the
same trigger, please use the "Candle
CounterAttack Bullish - Entry Strategy" on the
previous page.

PARAMETERS

FilterPeriod
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The number of bars used to calculate the candle patterns.

Default: 10

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó BULLISH AND BEARISH
COUNTERATTACK

The strategy identifies a bullish "Counterattack
" on page 116. For a description of the candle
pattern, see "Using Candlestick Patterns" on
page 113. If the pattern is identified, a short exit
signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses over the highest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bullish
trend is confirmed with the price.

USAGE

The strategy uses a candle pattern which is a signal for a trend reversal. The
identification of trend reversal are important for swing traders.

When you execute the trades immediately without a confirmation, the quick trade
can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.
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CANDLE DARK CLOUD COVER - ENTRY
STRATEGY

DESCRIPTION

This strategy generates a short entry signal
when a dark cloud cover appears. A dark
cloud cover is a signal for a bearish trend
reversal. For Exit signals with the same
trigger, please use the "Candle Dark Cloud
Cover - Exit Strategy" on the next page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó DARK CLOUD COVERWITH OPPOSITE
PATTERN PIERCING LINE

The strategy uses a dark cloud cover in a
upwards trend which is a signal for a trend
reversal. For the definition of a dark cloud
cover, see "Piercing Pattern and Dark Cloud
Cover" on page 118. If the pattern is identified,
a short entry signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.
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USAGE

The strategy uses a candle pattern which is a signal for a trend reversal. The
identification of trend reversal are important for swing traders.

When you execute the trades immediately without the confirmation, the quick
trade can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE DARK CLOUD COVER - EXIT
STRATEGY

DESCRIPTION

This strategy generates a long exit signal
when a dark cloud cover appears. A dark
cloud cover is a signal for a bearish trend
reversal. For Entry signals with the same
trigger, please use the "Candle Dark Cloud
Cover - Entry Strategy" on the previous page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket
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CALCULATION

Ó DARK CLOUD COVERWITH OPPOSITE
PATTERN PIERCING LINE

The strategy uses a dark cloud cover in a
upwards trend which is a signal for a trend
reversal. For the definition of a dark cloud
cover, see "Piercing Pattern and Dark Cloud
Cover" on page 118. If the pattern is identified,
a long exit signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.

USAGE

The strategy uses a candle pattern which is a signal for a trend reversal. The
identification of trend reversal are important for swing traders.

When you execute the trades immediately without the confirmation, the quick
trade can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE DELIBERATION - ENTRY STRATEGY

DESCRIPTION

This strategy generates a short entry signal
when a "Deliberation" on page 121 appears.
In this strategy, the deliberation is used as a
signal for a bearish trend reversal. For Exit
signals with the same trigger, please use the
"Candle Deliberation - Exit Strategy" on
page 605.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.
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Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó BEARISH DELIBERATION

A "Deliberation" on page 121 can be both,
bearish and bullish. In this strategy it is used as
a bearish signal. For the definition of a
deliberation, see "Using Candlestick Patterns"
on page 113. If the pattern is identified, a short
entry signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.

USAGE

The strategy uses a candle pattern which is a signal for a trend reversal. The
identification of trend reversal are important for swing traders.

When you execute the trades immediately without the confirmation, the quick
trade can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.
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CANDLE DELIBERATION - EXIT STRATEGY

DESCRIPTION

This strategy generates a long exit signal
when a "Deliberation" on page 121 appears.
In this strategy, the deliberation is used as a
signal for a bearish trend reversal. For Entry
signals with the same trigger, please use the
"Candle Deliberation - Entry Strategy" on
page 603.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó BEARISH DELIBERATION

A "Deliberation" on page 121 can be both,
bearish and bullish. In this strategy it is used as
a bearish signal. For the definition of a
deliberation, see "Using Candlestick Patterns"
on page 113. If the pattern is identified, a long
exit signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses over the highest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.
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USAGE

The strategy uses a candle pattern which is a signal for a trend reversal. The
identification of trend reversal are important for swing traders.

When you execute the trades immediately without the confirmation, the quick
trade can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE DOJI - ENTRY STRATEGY

DESCRIPTION

This strategy generates a short or long entry
signal when the candle pattern "Doji" on
page 115 is identified in the chart. As this
pattern is neither bullish nor bearish the
strategy does not include a trend
confirmation. For Exit signals with the same
trigger, please use the "Candle Doji - Exit
Strategy" on the next page.

PARAMETERS

EntryMethod
Defines what kind of orders are placed.

Default: LongEntry
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CALCULATION

Ó BULLISH AND BEARISH DOJIS

The strategy identifies a "Doji" on page 115.
For a description of the candle pattern, see
"Using Candlestick Patterns" on page 113. If
the pattern is identified, a short or long entry
signal is generated as defined with the input
EntryMethod.

USAGE

The strategy uses a candle pattern which
shows the indecision of the market. However, it
gathers importance depending on the
surrounding patterns. Price movements taking
place after a doji often signal new trends or a
trend inversion. Therefore, dojis are good support signals for resistance and
support lines. A doji in an overbought or oversold market shows that the market is
vulnerable to corrections.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE DOJI - EXIT STRATEGY

DESCRIPTION

This strategy generates a short or long exit
signal when the candle pattern "Doji" on
page 115 is identified in the chart. As this
pattern is neither bullish nor bearish the
strategy does not include a trend
confirmation. For Entry signals with the same
trigger, please use the "Candle Doji - Entry
Strategy" on the previous page.

PARAMETERS

ExitMethod
Defines what kind of orders are placed.

Default: LongExit

607



CALCULATION

Ó BULLISH AND BEARISH DOJIS

The strategy identifies a "Doji" on page 115.
For a description of the candle pattern, see
"Using Candlestick Patterns" on page 113. If
the pattern is identified, a short or long exit
signal is generated as defined with the input
ExitMethod.

USAGE

The strategy uses a candle pattern which
shows the indecision of the market. However, it
gathers importance depending on the
surrounding patterns. Price movements taking
place after a doji often signal new trends or a
trend inversion. Therefore, dojis are good support signals for resistance and
support lines. A doji in an overbought or oversold market shows that the market is
vulnerable to corrections.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE DRAGONFLY DOJI - ENTRY STRATEGY

DESCRIPTION

This strategy generates a long entry signal
when the candle pattern Dragonfly "Doji" on
page 115 is identified in a bullish trend. For
Exit signals with the same trigger, please use
the "Candle Dragonfly Doji - Exit Strategy" on
the next page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

OrderMethod
Defines the order method
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Default: atMarket

CALCULATION

Ó DRAGONFLY DOJI

The strategy identifies a Dragonfly "Doji" on
page 115. For a description of the candle
pattern, see "Using Candlestick Patterns" on
page 113. The long lower shadow of the
Dragonfly Doji shows that trades are also made
in the lower trading range.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses over the highest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bullish
trend is confirmed with the price.

USAGE

The strategy uses a candle pattern which shows the indecision of the market.
However, it gathers importance depending on the surrounding patterns and the
special Dojis. Price movements taking place after a doji often signal new trends or
a trend inversion. Therefore, dojis are good support signals for resistance and
support lines. A doji in an overbought or oversold market shows that the market is
vulnerable to corrections.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE DRAGONFLY DOJI - EXIT STRATEGY

DESCRIPTION

This strategy generates a short exit signal
when the candle pattern Dragonfly "Doji" on
page 115 is identified in a bullish trend. For
Entry signals with the same trigger, please
use the "Candle Dragonfly Doji - Entry
Strategy" on the previous page.
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PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó DRAGONFLY DOJI

The strategy identifies a Dragonfly "Doji" on
page 115. For a description of the candle
pattern, see "Using Candlestick Patterns" on
page 113. The long lower shadow of the
Dragonfly Doji shows that trades are also made
in the lower trading range.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses over the highest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bullish
trend is confirmed with the price.

USAGE

The strategy uses a candle pattern which shows the indecision of the market.
However, it gathers importance depending on the surrounding patterns and the
special Dojis. Price movements taking place after a doji often signal new trends or
a trend inversion. Therefore, dojis are good support signals for resistance and
support lines. A doji in an overbought or oversold market shows that the market is
vulnerable to corrections.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.
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CANDLE DUMPLING TOP - ENTRY STRATEGY

DESCRIPTION

This strategy generates a short entry signal
when a dumpling top appears in a bullish
trend. Dumpling tops are a signal for a
bearish trend reversal. For Exit signals with
the same trigger, please use the "Candle
Dumpling Top - Exit Strategy" on the next
page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó DUMPLING TOP

The strategy uses a rounding top in a upwards
trend which is a signal for a bearish trend
reversal. If the pattern is identified, a short entry
signal is generated. A dumpling top shows that
the bulls are not convinced with the upwards
trend. The indecisive market can be
represented by "Doji" on page 115, "Hammer"
on page 114 or similar candles.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
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option the order is only executed, if the bearish trend is confirmed with the price.

USAGE

The dumpling top is built up slowly, so there is plenty time for some trades until
the pattern is closed. The price movements are indecisive and flat in the
meanwhile. Please consider that there is a hard sell-off at the end of the pattern.

The strategy includes already the confirmation for the trend reversal. When you
execute the trades immediately without a confirmation, the quick trade can result
in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE DUMPLING TOP - EXIT STRATEGY

DESCRIPTION

This strategy generates a long exit signal
when a dumpling top appears in a bullish
trend. Dumpling tops are a signal for a
bearish trend reversal. For Entry signals with
the same trigger, please use the "Candle
Dumpling Top - Exit Strategy" above.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket
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CALCULATION

Ó DUMPLING TOP

The strategy uses a dumpling top in a upwards
trend which is a signal for a bearish trend
reversal. If the pattern is identified, a long exit
signal is generated. A rounding top shows that
the bulls are not convinced with the upwards
trend. The indecisive market can be
represented by "Doji" on page 115, "Hammer"
on page 114 or similar candles.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.

USAGE

The dumpling top is built up slowly, so there is plenty time for some trades until
the pattern is closed. The price movements are indecisive and flat in the
meanwhile. Please consider that there is a hard sell-off at the end of the pattern.

The strategy includes already the confirmation for the trend reversal. When you
execute the trades immediately without a confirmation, the quick trade can result
in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE EVENING STAR - ENTRY STRATEGY

DESCRIPTION

This strategy generates a short entry signal
when an evening star appears in a bullish
trend, see "Morning/Evening Star" on
page 121. In a bullish trend that is a signal for
a bearish trend reversal. For Exit signals with
the same trigger, please use the "Candle
Evening Star - Exit Strategy" on page 615.
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PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó EVENING STARWITH THE OPPOSITE
CANDLE PATTERNMORNING STAR

The strategy uses an evening star in a upwards
trend which is a signal for a trend reversal. For
a description of the candle pattern, see "Using
Candlestick Patterns" on page 113. If the
pattern is identified, a short entry signal is
generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.

USAGE

The strategy uses an evening star in a upwards trend which is a signal for a trend
reversal. The evening star rises from the bright day into the dark night. The
strategy includes therefor already the confirmation for the trend reversal. When
you execute the trades immediately without a confirmation, the quick trade can
result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.
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CANDLE EVENING STAR - EXIT STRATEGY

DESCRIPTION

This strategy generates a long exit signal
when an evening star appears in a bullish
trend, see "Morning/Evening Star" on
page 121. In a bullish trend that is a signal for
a bearish trend reversal. For Entry signals
with the same trigger, please use the "Candle
Evening Star - Entry Strategy" on page 613.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó EVENING STARWITH THE OPPOSITE
CANDLE PATTERNMORNING STAR

The strategy uses an evening star in a upwards
trend which is a signal for a trend reversal. For
a description of the candle pattern, see "Using
Candlestick Patterns" on page 113. If the
pattern is identified, a long exit signal is
generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.
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USAGE

The strategy uses an evening star in a upwards trend which is a signal for a trend
reversal. The evening star rises from the bright day into the dark night. The
strategy includes therefor already the confirmation for the trend reversal. When
you execute the trades immediately without a confirmation, the quick trade can
result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE FALLING THREE METHODS - ENTRY
STRATEGY

DESCRIPTION

This strategy generates a long entry signal
when a falling three appears in a downtrend.
A falling three is a trend confirmation, see
"Falling Three/Rising Three" on page 122.
For Exit signals with the same trigger, please
use the "Candle Falling Three Methods - Exit
Strategy" on the next page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket
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CALCULATION

Ó FALLING THREEMETHODS

The strategy uses a falling three in a
downwards trend which is a signal for a trend
continuation. For a description of the candle
pattern, see "Using Candlestick Patterns" on
page 113. If the pattern is identified, a long
entry signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or only if next days price crosses over
the highest price of the pattern, atPriceTrigger. With the last option the order is only
executed, if the bearish trend is confirmed with the price.

USAGE

The strategy uses a candle pattern which is a signal for a trend continuation and
shows that the bulls are not confident enough to take over.

When you execute the trades immediately without the confirmation, the quick
trade can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE FALLING THREE METHODS - EXIT
STRATEGY

DESCRIPTION

This strategy generates a short exit signal
when a falling three appears in a downtrend.
A falling three is a trend confirmation, see
"Falling Three/Rising Three" on page 122.
For Entry signals with the same trigger,
please use the "Candle Falling Three Methods - Entry Strategy" on the previous
page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.
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Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó FALLING THREEMETHODS

The strategy uses a falling three in a
downwards trend which is a signal for a trend
continuation. For a description of the candle
pattern, see "Using Candlestick Patterns" on
page 113. If the pattern is identified, a short exit
signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or only if next days price crosses over
the highest price of the pattern, atPriceTrigger. With the last option the order is only
executed, if the bearish trend is confirmed with the price.

USAGE

The strategy uses a candle pattern which is a signal for a trend continuation and
shows that the bulls are not confident enough to take over.

When you execute the trades immediately without the confirmation, the quick
trade can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.
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CANDLE FALLING WINDOW BEARTREND -
ENTRY STRATEGY

DESCRIPTION

This strategy generates a short entry signal
when a falling window appears in a bearish
trend. A falling "Window" on page 116 is the
same as an downwards gap and can show
the strength of the downwards trend. For Exit
signals with the same trigger, please use the
"Candle Falling Window BearTrend - Exit
Strategy" on the next page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó RISING AND FALLINGWINDOWS

The strategy uses a falling window which is a
signal for the continuation of the downwards
trend. For the definition of a window, see
"Using Candlestick Patterns" on page 113. If
the pattern is identified in a downwards trend, a
short entry signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
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option the order is only executed, if the bearish trend is confirmed with the price.

USAGE

The strategy uses a falling window as a signal for the continuation of the bearish
trend. The strategy includes therefor already the confirmation for the trend
continuation. When you execute the trades immediately without a confirmation,
the quick trade can result in a higher profit but is also riskier. The "Candle Falling
Window - Entry Strategy" on the next page is the same strategy with a
confirmation.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE FALLING WINDOW BEARTREND - EXIT
STRATEGY

DESCRIPTION

This strategy generates a long exit signal
when a falling window appears in a bearish
trend. A falling "Window" on page 116 is the
same as an downwards gap and can show
the strength of the downwards trend. For
Entry signals with the same trigger, please
use the "Candle Falling Window BearTrend -
Entry Strategy" on the previous page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket
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CALCULATION

Ó RISING AND FALLINGWINDOWS

The strategy uses a falling window which is a
signal for the continuation of the downwards
trend. For the definition of a window, see
"Using Candlestick Patterns" on page 113. If
the pattern is identified in a downwards trend, a
long exit signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.

USAGE

The strategy uses a falling window as a signal for the continuation of the bearish
trend. The strategy includes therefor already the confirmation for the trend
continuation. When you execute the trades immediately without a confirmation,
the quick trade can result in a higher profit but is also riskier. The "Candle Falling
Window - Exit Strategy" on page 623 is the same strategy without a confirmation.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE FALLING WINDOW - ENTRY STRATEGY

DESCRIPTION

This strategy generates a short entry signal
when a falling window appears in the chart. A
falling "Window" on page 116 is the same as
an downwards gap and can show the
strength of the downwards trend. For Exit
signals with the same trigger, please use the
"Candle Falling Window - Exit Strategy" on
page 623.

PARAMETERS

CandlePeriod
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Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó RISING AND FALLINGWINDOWS

The strategy uses a falling window which is a
signal for the continuation of the downwards
trend. For the definition of a window, see
"Using Candlestick Patterns" on page 113. If
the pattern is identified, a short entry signal is
generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.

USAGE

The strategy uses a falling window as a signal for the continuation of the bearish
trend. The strategy does not include confirmation for the trend continuation.
When you execute the trades immediately without a confirmation, the quick trade
can result in a higher profit but is also riskier. The "Candle Falling Window
BearTrend - Entry Strategy" on page 619 is the same strategy with a
confirmation.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.
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CANDLE FALLING WINDOW - EXIT STRATEGY

DESCRIPTION

This strategy generates a long exit signal
when a falling window appears in the chart. A
falling "Window" on page 116 is the same as
an downwards gap and can show the
strength of the downwards trend. For Entry
signals with the same trigger, please use the
"Candle Falling Window - Entry Strategy" on
page 621.

PARAMETERS

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó RISING AND FALLINGWINDOWS

The strategy uses a falling window which is a
signal for the continuation of the downwards
trend. For the definition of a window, see
"Using Candlestick Patterns" on page 113. If
the pattern is identified, a long exit signal is
generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.

USAGE

The strategy uses a falling window as a signal for the continuation of the bearish
trend. The strategy does not include confirmation for the trend continuation.
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When you execute the trades immediately without a confirmation, the quick trade
can result in a higher profit but is also riskier. The "Candle Falling Window
BearTrend - Exit Strategy" on page 620 is the same strategy with a confirmation.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE GRAVESTONE DOJI - ENTRY
STRATEGY

DESCRIPTION

This strategy generates a short entry signal
when the candle pattern Gravestone "Doji" on
page 115 is identified in a bearish trend. For
Exit signals with the same trigger, please use
the "Candle Gravestone Doji - Exit Strategy"
on the next page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

OrderMethod
Defines the order method

Default: atMarket
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CALCULATION

Ó GRAVESTONE DOJI

The strategy identifies a Gravestone "Doji" on
page 115. For a description of the candle
pattern, see "Using Candlestick Patterns" on
page 113. The long upper shadow of the
Gravestone Doji shows that trades are also
made in the upper trading range.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.

USAGE

The strategy uses a candle pattern which shows the indecision of the market.
However, it gathers importance depending on the surrounding patterns and the
special Dojis. Price movements taking place after a doji often signal new trends or
a trend inversion. Therefore, dojis are good support signals for resistance and
support lines. A doji in an overbought or oversold market shows that the market is
vulnerable to corrections.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE GRAVESTONE DOJI - EXIT STRATEGY

DESCRIPTION

This strategy generates a long exit signal
when the candle pattern Gravestone "Doji" on
page 115 is identified in a bearish trend. For
Entry signals with the same trigger, please
use the "Candle Gravestone Doji - Entry
Strategy" on the previous page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.
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Default: 10

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó GRAVESTONE DOJI

The strategy identifies a Gravestone "Doji" on
page 115. For a description of the candle
pattern, see "Using Candlestick Patterns" on
page 113. The long upper shadow of the
Gravestone Doji shows that trades are also
made in the upper trading range.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.

USAGE

The strategy uses a candle pattern which shows the indecision of the market.
However, it gathers importance depending on the surrounding patterns and the
special Dojis. Price movements taking place after a doji often signal new trends or
a trend inversion. Therefore, dojis are good support signals for resistance and
support lines. A doji in an overbought or oversold market shows that the market is
vulnerable to corrections.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.
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CANDLE HAMMER - ENTRY STRATEGY

DESCRIPTION

This strategy generates a long entry signal
when a hammer appears in a chart, see
"Hammer" on page 114. In a bearish trend
that is a signal for a bullish trend reversal. For
Exit signals with the same trigger, please use
the "Candle Hammer - Exit Strategy" on the
next page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

Multiplier
Used to determine the relation between the lower shadow and the body

Default: 2.0

OrderMethod
Defines the order method

Default: atMarket
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CALCULATION

Ó HAMMER

The strategy uses a hammer which is a signal
for a bullish trend reversal. For a description of
the candle pattern, see "Using Candlestick
Patterns" on page 113. If the pattern is
identified, a long entry signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses over the highest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.

USAGE

The strategy uses a hammer which is a signal
for a trend reversal. The hammer is
"hammering a floor" and showing that the bulls
won. When you execute the trades immediately without a confirmation, the quick
trade can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE HAMMER - EXIT STRATEGY

DESCRIPTION

This strategy generates a short exit signal
when a hammer appears in a chart, see
"Hammer" on page 114. In a bearish trend
that is a signal for a bullish trend reversal. For
Entry signals with the same trigger, please
use the "Candle Hammer - Entry Strategy" on
the previous page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10
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Multiplier
Used to determine the relation between the lower shadow and the body

Default: 2.0

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó HAMMER

The strategy uses a hammer which is a signal
for a bullish trend reversal. For a description of
the candle pattern, see "Using Candlestick
Patterns" on page 113. If the pattern is
identified, a short exit signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses over the highest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.

USAGE

The strategy uses a hammer which is a signal
for a trend reversal. The hammer is
"hammering a floor" and showing that the bulls
won. When you execute the trades immediately without a confirmation, the quick
trade can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.
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CANDLE HANGING MAN - ENTRY STRATEGY

DESCRIPTION

This strategy generates a short entry signal
when a hanging man appears in a chart, see
"Hanging Man" on page 114. In a bullish trend
that is a signal for a bearish trend reversal.
For Exit signals with the same trigger, please
use the "Candle Hanging Man - Exit Strategy"
on the next page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

Multiplier
Used to determine the relation between the lower shadow and the body

Default: 2.0

OrderMethod
Defines the order method

Default: atMarket
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CALCULATION

Ó HANGINGMAN

The strategy uses a hanging man which is a
signal for a bearish trend reversal. For a
description of the candle pattern, see "Using
Candlestick Patterns" on page 113. If the
pattern is identified, a short entry signal is
generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.

USAGE

The strategy uses a hanging man which is a
signal for a trend reversal. Hanging man looks
like a man hanging from a gallows and shows that the bears won. When you
execute the trades immediately without a confirmation, the quick trade can result
in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE HANGING MAN - EXIT STRATEGY

DESCRIPTION

This strategy generates a long exit signal
when a hanging man appears in a chart, see
"Hanging Man" on page 114. In a bullish trend
that is a signal for a bearish trend reversal.
For Entry signals with the same trigger,
please use the "Candle Hanging Man - Entry
Strategy" on the previous page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.
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Default: 10

Multiplier
Used to determine the relation between the lower shadow and the body

Default: 2.0

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó HANGINGMAN

The strategy uses a hanging man which is a
signal for a bearish trend reversal. For a
description of the candle pattern, see "Using
Candlestick Patterns" on page 113. If the
pattern is identified, a long exit signal is
generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.

USAGE

The strategy uses a hanging man which is a
signal for a trend reversal. Hanging man looks
like a man hanging from a gallows and shows that the bears won. When you
execute the trades immediately without a confirmation, the quick trade can result
in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.
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CANDLE HARAMI BEARISH - ENTRY STRATEGY

DESCRIPTION

This strategy generates a short entry signal
when a bearish "Harami" on page 119
appears. In a bullish trend that is a signal for a
bearish trend reversal. For Exit signals with
the same trigger, please use the "Candle
Harami Bearish - Exit Strategy" on the next
page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó BEARISH AND BULLISH HARAMI

The strategy uses a bearish "Harami" on
page 119 in a upwards trend which is a signal
for a trend reversal. For a description of the
candle pattern, see "Using Candlestick
Patterns" on page 113. If the pattern is
identified, a short entry signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish trend is confirmed with the price.
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USAGE

The strategy uses a bearish Harami in a upwards trend which is a signal for a
downwards trend reversal. It shows the imbalance of the market's health.

The strategy includes therefor already the confirmation for the trend reversal.
When you execute the trades immediately without a confirmation, the quick trade
can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE HARAMI BEARISH - EXIT STRATEGY

DESCRIPTION

This strategy generates a long exit signal
when a bearish "Harami" on page 119
appears. In a bullish trend that is a signal for a
bearish trend reversal. For Entry signals with
the same trigger, please use the "Candle
Harami Bearish - Entry Strategy" on the
previous page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket
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CALCULATION

Ó BEARISH AND BULLISH HARAMI

The strategy uses a bearish "Harami" on
page 119 in a upwards trend which is a signal
for a trend reversal. For a description of the
candle pattern, see "Using Candlestick
Patterns" on page 113. If the pattern is
identified, a long exit signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish trend is confirmed with the price.

USAGE

The strategy uses a bearish Harami in a upwards trend which is a signal for a
downwards trend reversal. It shows the imbalance of the market's health.

The strategy includes therefor already the confirmation for the trend reversal.
When you execute the trades immediately without a confirmation, the quick trade
can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE HARAMI BULLISH - ENTRY STRATEGY

DESCRIPTION

This strategy generates a long entry signal
when a bullish "Harami" on page 119
appears. In a bearish trend that is a signal for
a bullish trend reversal. For Exit signals with
the same trigger, please use the "Candle
Harami Bullish - Exit Strategy" on page 637.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10
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CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó BEARISH AND BULLISH HARAMI

The strategy uses a bullish "Harami" on
page 119 in a downwards trend which is a
signal for a trend reversal. For a description of
the candle pattern, see "Using Candlestick
Patterns" on page 113. If the pattern is
identified, a long entry signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses over the highest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bullish trend is confirmed with the price.

USAGE

The strategy uses a bullish Harami in a downwards trend which is a signal for an
upwards trend reversal. It shows the imbalance of the market's health.

The strategy includes therefor already the confirmation for the trend reversal.
When you execute the trades immediately without a confirmation, the quick trade
can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.
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CANDLE HARAMI BULLISH - EXIT STRATEGY

DESCRIPTION

This strategy generates a short exit signal
when a bullish "Harami" on page 119
appears. In a bearish trend that is a signal for
a bullish trend reversal. For Entry signals with
the same trigger, please use the "Candle
Harami Bullish - Entry Strategy" on page 635.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó BEARISH AND BULLISH HARAMI

The strategy uses a bullish "Harami" on
page 119 in a upwards trend which is a signal
for a trend reversal. For a description of the
candle pattern, see "Using Candlestick
Patterns" on page 113. If the pattern is
identified, a short exit signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses over the highest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bullish trend is confirmed with the price.
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USAGE

The strategy uses a bullish Harami in a downwards trend which is a signal for an
upwards trend reversal. It shows the imbalance of the market's health.

The strategy includes therefor already the confirmation for the trend reversal.
When you execute the trades immediately without a confirmation, the quick trade
can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE HARAMI CROSS BEARISH - ENTRY
STRATEGY

DESCRIPTION

This strategy generates a short entry signal
when a bearish "Harami" on page 119 Cross
appears. In a bullish trend that is a signal for a
bearish trend reversal. For Exit signals with
the same trigger, please use the "Candle
Harami Cross Bearish - Exit Strategy" on the
next page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket

638



CALCULATION

Ó BEARISH AND BULLISH HARAMI
CROSS

The strategy uses a bearish "Harami" on
page 119 Cross in a upwards trend which is a
signal for a trend reversal. For a description of
the candle pattern, see "Using Candlestick
Patterns" on page 113. If the pattern is
identified, a short entry signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.

USAGE

The strategy uses a bearish Harami Cross in a upwards trend which is a signal for
a downwards trend reversal. It shows the imbalance of the market's health.

The strategy includes therefor already the confirmation for the trend reversal.
When you execute the trades immediately without a confirmation, the quick trade
can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE HARAMI CROSS BEARISH - EXIT
STRATEGY

DESCRIPTION

This strategy generates a long exit signal
when a bearish "Harami" on page 119 Cross
appears. In a bullish trend that is a signal for a
bearish trend reversal. "Candle Harami Cross
Bearish - Entry Strategy" on the previous
page.

PARAMETERS

FilterPeriod
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The number of bars used to calculate the candle patterns.

Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó BEARISH AND BULLISH HARAMI
CROSS

The strategy uses a bearish "Harami" on
page 119 Cross in a upwards trend which is a
signal for a trend reversal. For a description of
the candle pattern, see "Using Candlestick
Patterns" on page 113. If the pattern is
identified, a long exit signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.

USAGE

The strategy uses a bearish Harami Cross in a upwards trend which is a signal for
a downwards trend reversal. It shows the imbalance of the market's health.

The strategy includes therefor already the confirmation for the trend reversal.
When you execute the trades immediately without a confirmation, the quick trade
can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.
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CANDLE HARAMI CROSS BULLISH - ENTRY
STRATEGY

DESCRIPTION

This strategy generates a long entry signal
when a bullish "Harami" on page 119 Cross
appears. In a bearish trend that is a signal for
a bullish trend reversal. For Exit signals with
the same trigger, please use the "Candle
Harami Cross Bullish - Exit Strategy" on the
next page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó BEARISH AND BULLISH HARAMI
CROSS

The strategy uses a bullish "Harami" on
page 119 Cross in a downwards trend which is
a signal for a trend reversal. For a description
of the candle pattern, see "Using Candlestick
Patterns" on page 113. If the pattern is
identified, a long entry signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses over the highest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bullish
trend is confirmed with the price.
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USAGE

The strategy uses a bullish Harami Cross in a downwards trend which is a signal
for an upwards trend reversal. It shows the imbalance of the market's health.

The strategy includes therefor already the confirmation for the trend reversal.
When you execute the trades immediately without a confirmation, the quick trade
can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE HARAMI CROSS BULLISH - EXIT
STRATEGY

DESCRIPTION

This strategy generates a short exit signal
when a bullish "Harami" on page 119 Cross
appears. In a bearish trend that is a signal for
a bullish trend reversal. For Entry signals with
the same trigger, please use the "Candle
Harami Cross Bullish - Entry Strategy" on the
previous page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket
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CALCULATION

Ó BEARISH AND BULLISH HARAMI
CROSS

The strategy uses a bullish "Harami" on
page 119 Cross in a upwards trend which is a
signal for a trend reversal. For a description of
the candle pattern, see "Using Candlestick
Patterns" on page 113. If the pattern is
identified, a short exit signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses over the highest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bullish
trend is confirmed with the price.

USAGE

The strategy uses a bullish Harami Cross in a downwards trend which is a signal
for an upwards trend reversal. It shows the imbalance of the market's health.

The strategy includes therefor already the confirmation for the trend reversal.
When you execute the trades immediately without a confirmation, the quick trade
can result in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE IN NECK - ENTRY STRATEGY

DESCRIPTION

This strategy generates a short entry signal
when an In Neck appears in a chart, see "In
Neck and On Neck" on page 117. In a bullish
trend that is a signal for a bearish trend
reversal. For Exit signals with the same
trigger, please use the "Candle In Neck - Exit
Strategy" on page 645.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.
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Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó IN NECK

The strategy uses an In Neck which is a signal
for a bearish trend reversal. For a description of
the candle pattern, see "Using Candlestick
Patterns" on page 113. If the pattern is
identified, a short entry signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish trend is confirmed with the price.

USAGE

The strategy uses an In Neck which is a signal for a trend reversal. When you
execute the trades immediately without a confirmation, the quick trade can result
in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.
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CANDLE IN NECK - EXIT STRATEGY

DESCRIPTION

This strategy generates a long exit signal
when an In Neck appears in a chart, see "In
Neck and On Neck" on page 117. In a bullish
trend that is a signal for a bearish trend
reversal. For Entry signals with the same
trigger, please use the "Candle In Neck -
Entry Strategy" on page 643.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó IN NECK

The strategy uses an In Neck which is a signal
for a bearish trend reversal. For a description of
the candle pattern, see "Using Candlestick
Patterns" on page 113. If the pattern is
identified, a long exit signal is generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses under the lowest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish trend is confirmed with the price.
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USAGE

The strategy uses an In Neck which is a signal for a trend reversal. When you
execute the trades immediately without a confirmation, the quick trade can result
in a higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE INVERTED HAMMER - ENTRY
STRATEGY

DESCRIPTION

This strategy generates a long entry signal
when an inverted hammer appears in a chart,
see "Shooting Star/Inverted Hammer" on
page 115. In a bearish trend that is a signal
for a bullish trend reversal. For Exit signals
with the same trigger, please use the "Candle
Inverted Hammer - Exit Strategy" on the next page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10

CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket
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CALCULATION

Ó INVERTED HAMMER

The strategy uses an inverted hammer which is
a signal for a bullish trend reversal. For a
description of the candle pattern, see "Using
Candlestick Patterns" on page 113. If the
pattern is identified, a long entry signal is
generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses over the highest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.

USAGE

The strategy uses an inverted hammer which is
a signal for a trend reversal. When you execute
the trades immediately without a confirmation, the quick trade can result in a
higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.

CANDLE INVERTED HAMMER - EXIT STRATEGY

DESCRIPTION

This strategy generates a short exit signal
when an inverted hammer appears in a chart,
see "Hammer" on page 114. In a bearish
trend that is a signal for a bullish trend
reversal. For Entry signals with the same
trigger, please use the "Candle Inverted
Hammer - Entry Strategy" on the previous page.

PARAMETERS

FilterPeriod
The number of bars used to calculate the candle patterns.

Default: 10
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CandlePeriod
Determines average values of some candlestick components.

Default: 5

OrderMethod
Defines the order method

Default: atMarket

CALCULATION

Ó INVERTED HAMMER

The strategy uses an inverted hammer which is
a signal for a bullish trend reversal. For a
description of the candle pattern, see "Using
Candlestick Patterns" on page 113. If the
pattern is identified, a short exit signal is
generated.

With the input OrderMethod you can define if the
order is executed for all patterns, atMarket, or
only if next days price crosses over the highest
price of the pattern, atPriceTrigger. With the last
option the order is only executed, if the bearish
trend is confirmed with the price.

USAGE

The strategy uses an inverted hammer which is
a signal for a trend reversal. When you execute
the trades immediately without a confirmation, the quick trade can result in a
higher profit but is also riskier.

Candle patterns do not indicate any price targets. Different traders use in addition
western techniques like "Pivot Points Analysis" on page 737, "Relative Strength
Index" on page 753 and moving averages as "MACD" on page 675.
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CANDLE PATTERN
Shortcode: CANPAT

DESCRIPTION

The Candle Pattern indicator identifies
several candlestick patterns in a "Candlestick
Chart" on page 110.

PARAMETERS

Pattern
Set here the desired candlestick pattern

Default: Hammer

TrendFilter
Defines if the market is checked for a current up or down trend.

Default: True

TrendFilterPrice
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

TrendFilterPeriod
The number of bars used to calculate the candle patterns.

Default: 5

ShortWickFactor
Sets the value from which a wick is no longer considered.

Default: 0.01

CALCULATION

The indicator checks the market for trend, when TrendFilter is true because
candlestick patterns are only meaningful during a trend. Very short wicks are not
considered as wicks, defined by ShortWickFactor. For a description of the possible
candle patterns for this indicator, see "Using Candlestick Patterns" on page 113.
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USAGE

Ó CANDLE PATTERN BULLISH SUNRISE
WITH MACD

Candlestick Patterns are useful in predicting a
trend reversal and have the advantage over
western techniques that they are not behind the
trend. As candlestick patterns do not provide
any price targets, you can use western
techniques like "Relative Strength Index" on
page 753 and moving averages as "MACD" on
page 675 as additional resource.

In addition with the confirmed trend you can
use the candlestick patterns as good trading signals. Swing traders will profit from
the signals of the candlestick patterns. If you want to combine several candlestick
patterns to get stronger signals, use the "Candle Patterns" below indicator which
can identify more then pattern at once.

CANDLE PATTERNS
Shortcode: CANPATS

DESCRIPTION

The Candle Patterns indicator identifies
several candlestick patterns in a "Candlestick
Chart" on page 110.

PARAMETERS

TrendFilter
Defines if the market is checked for a current up or down trend.

Default: True

TrendFilterPrice
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

TrendFilterPeriod
The number of bars used to calculate the candle patterns.

Default: 5

ShortWickFactor
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Sets the value from which a wick is no longer considered.

Default: 0.01

CALCULATION

The indicator checks the market for trend, when TrendFilter is true because
candlestick patterns are only meaningful during a trend. Very short wicks are not
considered as wicks, defined by ShortWickFactor. For a description of the possible
candle patterns for this indicator, see "Using Candlestick Patterns" on page 113.

USAGE

Ó CANDLE PATTERNS TWEEZER TOPS
AND BOTTOMSWITH MACD

Candlestick Patterns are useful in predicting a
trend reversal and have the advantage over
western techniques that they are not behind the
trend. As candlestick patterns do not provide
any price targets, you can use western
techniques like "Relative Strength Index" on
page 753 and moving averages as "MACD" on
page 675 as additional resource.

In addition with the confirmed trend you can
use the candlestick patterns as good trading
signals. Swing traders will profit from the signals of the candlestick patterns. If you
want to identify only a single candlestick patterns for a better overview, use the
indicator "Candle Pattern" on page 649.

CHANNEL BREAKOUT STRATEGY

DESCRIPTION

This complete strategy generates trading
signals based on a breakout of the "High Low
Channel" on page 669. When you want to use
this strategy in a "Portfolio" on page 251, use
the portfolio optimized version "Channel
Breakout Portfolio Strategy" on the next
page.

PARAMETERS

Days
The number of bars used to calculate
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Default: 44

Bullish
Defines what kind of orders are placed.

Default: LongEntry

Bearish
Defines what kind of orders are placed.

Default: LongExit

CALCULATION

Ó STRATEGYWITH CORRESPONDING
CHANNEL

The strategy uses the high low channel over a
given period Days. For the calculation of the
indicator itself, see "High Low Channel" on
page 669

A breakout from the channel generates a
trading signal. With the inputs Bullish and
Bearish you can define if long or short signals
are generated.

USAGE

The channel is not so robust in a sideways or noisy markets as in a well-defined
market. The indicator is efficient in the identification of major trends in the market
but due to the calculation trend reversals are only shown with a delay. Depending
on the used period the lag is bigger or smaller.

CHANNEL BREAKOUT PORTFOLIO STRATEGY

DESCRIPTION

This complete strategy generates trading
signals based on a breakout of the "High Low
Channel" on page 669. This strategy is
optimized for a "Portfolio" on page 251.

PARAMETERS

Days
The number of bars used to calculate

Default: 44
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LongEntry
Defines what kind of orders are placed.

Default: True

LongExit
Defines what kind of orders are placed.

Default: True

ShortEntry
Defines what kind of orders are placed.

Default: True

ShortExit
Defines what kind of orders are placed.

Default: True

CALCULATION

Ó STRATEGYWITH CORRESPONDING
CHANNEL

The strategy uses the high low channel over a
given period Days. For the calculation of the
indicator itself, see "High Low Channel" on
page 669

A breakout from the channel generates a
trading signal. With the additional inputs you
can define if long and/or short signals are
generated.

USAGE

The channel is not so robust in a sideways or noisy markets as in a well-defined
market. The indicator is efficient in the identification of major trends in the market
but due to the calculation trend reversals are only shown with a delay. Depending
on the used period the lag is bigger or smaller.

CLENOW MOMENTUM PORTFOLIO STRATEGY
The Clenow Momentum Portfolio strategy is a momentum-based portfolio trading
strategy (created for the S&P 500). The strategy will buy symbols that show an
upward trend in an upward market, represented by a benchmark symbol (typically
the S&P 500 index). Positions are sized using risk parity allocation. All trades
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happen on a specific day of the week and positions are rebalanced on a fixed
interval.

This strategy can only be applied to portfolios with daily bars.

PARAMETERS

BenchmarkSymbol
Select which symbol should be used as benchmark.

TradingDay
Select the trading day.

Default: Wednesday

MomPeriod
Period used for calculating the momentum (in days).

Default: 90

SmaPeriod
Period for the simple moving average.

Default: 100

AtrPeriod
Period for the average true range.

Default: 20

BenchmarkSmaPeriod
Period for the moving average of the benchmark symbol.

Default: 200

BestBuyPercent
Percentage of the portfolio to buy based on the selection criteria.

Default: 20

GapPeriod
Number of bars used to check for big gaps between prices.

Default: 90

MaxGapPct
Maximum gap percentage that a symbol might have before it will be eliminated (a
high gap percentage corresponds to a high volatility).
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Default: 15

AvgDailyImpactPercent
Howmuch can investing in a security affect your daily investment? This is a
measure for risk exposure. The calculation uses the ATR value for deciding how
much to invest in a security you have decided to invest in.

Default: 0.1

Rebalance
Should the positions be rebalanced automatically (True) or not (False)?

Default: True

RebalanceWeeks
After how many weeks should be rebalanced?

Default: 2

TradingDays
Select the approximate number of trading days in a year.

Default: 252

CALCULATION

In its core, the calculation is an exponential regression, with the regression being
calculated on the log of prices over time.

Two factors are being considered: The regression coefficient is a measure of
trend strength; the R2 factor is a measure of the quality of the trend. These are
multiplied to result in:

Clenow Momentum = annualized slope of regression coefficient (%) * R2 of
regression (%)

The greater the Clenow Momentum value, the higher the rank.

USAGE

Buy symbols that show an upward trend in an upward market by following a
benchmark symbol of your choice.
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CORRELATION
Shortcode: COR

DESCRIPTION

This indicator calculates and visualizes the
correlation between two securities.

PARAMETERS

Price1
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Price2
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Period
The number of bars used to calculate the correlation between the two securities.

Default: 30

Method
The method used to calculate the correlation between the two securities.

CALCULATION

This indicator calculates and visualizes the correlation between two securities.

USAGE

The Correlation indicator can be used as a statistical tool that measures the
degree of how two securities move in relation to each other. The correlation
coefficient can assume values between -1 and +1:

à A value of exactly +1 indicates complete positive correlation.

à The closer the value is to 0, the smaller the correlation.

à A value of exactly -1 indicates complete negative correlation.
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Ó THE INDICATOR INSERTED TWICE.

CORRELATION BENCHMARK

DESCRIPTION

This indicator calculates and visualizes the
correlation between a security and a
benchmark.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Benchmark
The data field (e.g. index) to which to compare the security.

Period
The number of bars used to calculate the correlation between security and
benchmark.

Default: 30

Method
The Method used to calculate the correlation between security and benchmark.

CALCULATION

This indicator calculates and visualizes the correlation between a security and a
benchmark.

USAGE

The Correlation Benchmark indicator can be used as a statistical tool that
measures the degree of how a security moves in relation to a benchmark. The
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correlation coefficient can assume values between -1 and +1:

à A value of exactly +1 indicates complete positive correlation.

à The closer the value is to 0, the smaller the correlation.

à A value of exactly -1 indicates complete negative correlation.

Ó THE INDICATOR INSERTED TWICE.

COUNTER CLOCKWISE
Shortcode: CCW

DESCRIPTION

This indicator analyzes the relationship
between the value and volume of its parent
instrument and visualizes it. It produces a
chart that disregards time in favor of volume,
making it a helpful tool for identifying bearish
and bullish trends as well as trend changes.

PARAMETERS

This indicator requires a single parent instrument that has a data field for Volume
available.

PriceField
The price field from the parent instrument (or indicator) on which to calculate this
indicator.

VolumeField
The volume field from the parent instrument (or indicator) on which to calculate
this indicator.
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CALCULATION

Percentage differences in price between the current and the preceding bar are
added to or subtracted from the most recent line. Changes in volume effect a
movement of the endpoint to the right or the left. Surging prices are plotted
upward, falling prices downward on the x-axis. Increasing volume is plotted
leftward, decreasing volume is plotted rightward on the y-axis.
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USAGE

Trend changes are indicated by two crossing, opposing trendlines (x-reversal)
which may yield buy or sell signals. Please note that an x-reversal is only valid if
both lines are moving rightwards.

Both decreasing and ascending lines moving rightward are considered trendlines.
In addition, bearish and bullish trends can identified by this indicator (see below).

X Reversal Bearish Trend Bullish Trend

Tip: In order to be able to better follow the course of the indicator the trading volume should
be displayed in the chart.

DAY RANGE
Shortcode: DRG

DESCRIPTION

This indicator calculates and displays the
difference between the current price and the
opening price of a trading day as a bar chart.
The trading range of the resulting chart
parallels the range of price movements within
that day.

CALCULATION

The current period values are subtracted from the opening price of that day.

USAGE

This indicator offers a way to analyze the daily trading range between opening
and closing price. The calculation of the indicator values results in patterns
identical to those found in regular bar charts. An indicator line crossing the zero
line top down indicates a trend reversal; the price is now lower than the indicator
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value. Similarly, an indicator line crossing the zero line bottom-up also indicates a
trend reversal; the price is now higher than the indicator value.

Ó THE DAY RANGE INDICATOR IN AN
INTRADAY CHART.

DIRECTIONAL MOVEMENT INDEX
Shortcode: DMI

DESCRIPTION

This indicator analyzes the strength of a trend
and confirms or disproves its significance. It
consists of four lines, the DMI+ line, the DMI-
line, the DMI line and the ADX line.

PARAMETERS

Period
The number of bars used to calculate the indicator.

Default: 14

CALCULATION

The basis of this indicator are two partial indicators:

à +DI (Upward Directional Indicator), which is calculated by
determining the +DM (Upward Directional Movement). THe
+DMmeasures the difference between today's high and
yesterday's high and dividing it by the True Range based on
the selected period.

à -DI (Downward Directional Indicator), which is calculated by
determining the -DM (Downward Directional Movement). The
-DMmeasures the difference between today's low and
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yesterday's low and dividing it by the True Range based on
the selected period.

The difference between the +DI and -DI is divided by the sum of the +DI and -DI.
The result is multiplied by 100.

662



USAGE

The calculation of the indicator produces a percentage value which provides
information on the strength of the current trend. It does not say anything about the
direction of the trend. High values indicate strong trends, low values indicate
weak trends. The DMI is a fairly volatile indicator and usually smoothed and
transformed into the "Average Directional Index" on page 551.

Ó A STRONG DOWNWARD TREND
REFLECTED IN HIGH INDICATOR
VALUES.

Ó THE ADX LINE (IN GREEN,
HIGHLIGHTED) IS A SMOOTHED DMI.

DOGS OF THE DOW STRATEGY
This strategy will once per year find the index members (typically from the DJI
index) with the highest dividend yield and invest equally in each.

It can only be applied to portfolios in which all stocks have the same currency.

PARAMETERS

DogCount
In how many top performers should be invested?

Default: 10
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TradeMonth
Select at the end of which month in each year the highest dividend yield should be
calculated.

Default: Jan

USAGE

The Dogs of Dow strategy is a rather straightforward long-term strategy that
historically outperformed the stock market as measured by the Dow Jones
Industrial Index. Once per year the top stocks with the highest dividend yield are
found and the capital is rebalanced towards these top performers. Then for
another year, no trades take place (saving on tradings costs). The DogCount
ensures a lower portfolio volatility compared to investing in only 1-2 top
performers.

EASE OF MOVEMENT
Shortcode: EOM

DESCRIPTION

This indicator illustrates the relationship
between the rate of a security's price change
and its volume, attempting to identify the
amount of volume required to move prices.

PARAMETERS

SmoothingPeriod
The number of bars used to calculate the smoothing.

Default: 14

ShowAlert
Controls whether alerts are displayed for this indicator.

Default: False

CALCULATION

First, the trading range is calculated by subtracting the daily high from the daily
low.

Range(t) = High(t) – Low(t)
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Then, the scope and the direction of the trend are calculated by subtracting the
mean of today's trading range from the mean of yesterday's trading range. If
today's trading range value is higher than yesterday's the value is positive, if it is
lower the value is negative.

MedChange(t) = (High(t) + Low(t) / 2) – (High(t-1) + Low(t-1) / 2)

Now the box range is calculated, which is defined as the ratio of volume and
trading range.

BoxRange(t) = Volume(t) / Range(t)

Underlyings with a high volume such as indexes produce results that cannot be
displayed by the software; they need to be divided by a certain factor in order to
create a manageable result. The exact factor is not important.

The indicator value is calculated by dividing the mean movement by the box
range. The resulting line needs to smoothed, e.g. by applying a 13-day simple
moving average.

EOM(t) = Sum(n)(MedChange / BoxRange) / n

USAGE

Generally a value greater than zero is an indication that the security is being
accumulated (bought) and negative values are used to signal increased selling
pressure. A high positive value appears when prices move upward on low
volume. Strong negative numbers indicate that the price is moving downward on
low volume. A greater distance between indicator line and zero line indicates a
smaller amount of volume and a wide trading range. If the indicator line crosses
the zero line bottom-up it is regarded a buy signal, if it crosses the zero line top-
down it is regarded a sell signal.

Ó A 13-DAY SIMPLE MOVING AVERAGE
APPLIED TO THE INDICATOR.
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GROUP ALLOC PORTFOLIO STRATEGY
This strategy invests capital according to the order given to portfolio groups. Use
the Set Group option to define the individual groups. Up to ten groups in a
portfolio are supported.

It can only be applied to portfolios in which all stocks have the same currency.

PARAMETERS

RebalancePeriod
Define how often the investments should be rebalanced (each day, week, month,
quarterly or yearly).

Default: Yearly

Group1
Assign a first group to invest in.

Group2
Assign a second group to invest in.

Group3
Assign a third group to invest in.

Group4
Assign a fourth group to invest in.

Group5
Assign a fifth group to invest in.

Group6
Assign a sixth group to invest in.

Group7
Assign a seventh group to invest in.

Group8
Assign a eighth group to invest in.

Group9
Assign a nineth group to invest in.

Group10
Assign a tenth group to invest in.
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USAGE

Automatically allocate investments to groups defined by you in the portfolio. The
groups are processed from top to bottom until the available capital is distributed.
This may already happen at e.g. group 3 of 9, depending on your settings.

This strategy works similarly to the "Sector Alloc Portfolio Strategy" on page 770,
but instead of fixed sectors, the groups and their contained stocks are defined by
you.

HEIKIN-ASHI
Shortcode: HA

DESCRIPTION

This indicator is a variation of Japanese
candlestick charts. It increases the readability
of candlestick charts and helps to isolate
trends, making opportunities more visible.

PARAMETERS

This indicator requires a single parent instrument that has data fields for Open,
High, Low, Close available.

ClassicMode
Sets how the first candle is calculated. In classic mode, the bar's close price is
used instead of the average price.

Default: No

CALCULATION

The Heikin Ashi is often described as a weighted version of a candlestick chart. It
uses the open-close data from the prior period and the Open, High, Low, Close
data from the current period to create a combo candlestick. The following
formulae are used to calculate the individual bars:

à Close = (Open+High+Low+Close)/4

à Open = [xOpen(Previous Bar) + Close(Previous Bar)]/2

à High = Max(High, xOpen, xClose)

à Low = Min(Low, xOpen, xClose)
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USAGE

The Heikin Ashi is based on the standard Open, High, Low, Close values and
represents a different mode of visualization with the following characteristics
(based on the default settings):

à Hollow candles represent upward trends, filled candles
represent downward trends.

à The stronger the trend, the longer the candle body.

à Small candles indicate trend changes or neutral phases.

à Candles with two wicks are "unsafe" candles. They often
appear in phases of consolidation or at trend beginnings or
trend ends

à Quick alternation between red and green candles indicates
consolidation.

à Candles without bottom wick indicate a strong upward trend.

à Candles without top wick indicate a strong downward trend.

Ó THE HEIKIN ASHI ELIMINATES MARKET
NOISE

Ó ITS IMPROVED SIGNALS CAN BE USED
IN COMBINATIONWITH OTHER
INDICATORS SUCH AS THE RELATIVE
STRENGTH INDEX.
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HIGH LOW CHANNEL
Shortcode: HILOC

DESCRIPTION

This indicator displays a channel based on
the highest high and lowest low over a given
period.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: 10

Displacement
The number of bars to shift the regression curve into the past or future.

Default: 0

DisplacementMode
Determines, if the displacement is applied on the chart or the values.

Default: DisplaceChart

CALCULATION

Ó INDICATORWITH A LONG AND A
SHORT PERIOD

The indicator uses the highest high and the
lowest low in the given period to draw a
channel. The upper border is defined by the
highest high and the lower border by the lowest
low.

With the displacement, you can either displace
the values for the calculation or shift the whole
channel in the chart.

USAGE

Break-outs and break-ins can be trading signals. The channel is not so robust in a
sideways or noisy markets as in a well-defined market. The indicator is efficient in
the identification of major trends in the market but due to the calculation trend
reversals are only shown with a delay. Depending on the used period, the lag is
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bigger or smaller. Two channels with different periods can be helpful as well to
identify both, the long- and the short-term trends.

ICHIMOKU KINKŌ-HYŌ
Shortcode: IKH

DESCRIPTION

This indicator calculates a span called cloud
(Kumo) and consists of three graphs and a
cloud (Senkou Span A+B). The Ichimoku
Kinko Hyo indicator characterizes the market
trend, momentum, support and resistance
levels. Therefor it is used to improve the
accuracy of forecast price moves of trending markets. This indicator works best
with weekly and daily charts.

PARAMETERS

Period_K
The number of bars used to calculate the Tenkan-sen.

Default: 9

Period_L
The number of bars used to calculate the Kijun-sen.

Default: 26

Period_M
The number of bars used to calculate the Senkou Span Cloud.

Default: 52

Period_N
The number of bars used to to project the Chikou Span into the past.

Default: 26

CALCULATION

The Ichimoku Cloud is calculated from the average values of the highest and
lowest closing values of the defined periods.

Tenkan-sen: (highest high + lowest low)/2 for Period_K bars.
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Kijun-sen (highest high + lowest low)/2 for Period_L bars.

Senkou Span A: (Tenkan-sen + Kijun-sen)/2.

Senkou Span B: (M-day high + M-day low) / 2 for Period_M bars.

Chikou Span: Closing price with the negative offset of Period_N bars.

USAGE

The Tenkan-Sen line is s a trend indicator. A buy signal can be interpreted if the
Tenkan-Sen line crosses the Kijun-Sen-Linie upwards. A sell signal can be
interpreted, if the Tenkan-sen line crosses the Kijun-Sen line downwards. The
Kijun-Sen line is a signal line, if the actual price is above the Kijun-Sen a further
price increase is probable.

The Senkou-Span-A line and the Senkou-Span-B line define the support and
resistance lines. The Ichimoku Cloud is drawn between the Senkou Span A and
B.

Ó IF THE PRICE LIES ABOVE THE
SENKOU SPAN LINES, THE CLOUD IS
IN AN AREA OF SUPPORT

Ó IF THE PRICE LIES BELOW THE
SENKOU SPAN, THE CLOUD IS IN AN
AREA OF RESISTANCE
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KAHLER'S VOLATILITY
Shortcode: KVOLA

DESCRIPTION

This indicator plots a measure for volatility
derived from the expected return of a straddle
strategy.

Historical volatility uses standard deviation of
daily log returns to describe the volatility of
the market. Kahler's Volatility in comparison
uses a fair bet strategy. One of the resulting advantages is that singular events
have less effect on the resulting number. Another advantage is that e.g. in a
phase of high upside, Kahler's volatility will take note of the large change
compared to past returns, while the historical volatility will remain lower, as a
steady upside has one direction and no setbacks.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Period
The number of bars used to calculate Kahler's Volatility.

Default: 30

ReturnPeriod
The period in bars used to calculate the volatility.

Default: 5

Result
Enter the way the result is displayed, either as percent, absolute, or rank.

Default: Percent

Multiplier
Amultiplier for the standard deviation can be entered here.

Default: 1

RankPeriod
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The period in bars used to calculate the rank based on the highest high and
lowest low, if the Result option "Rank" is selected.

Default: 100

CALCULATION

Kahler's Volatility loops over the given past bars (i, Period value) and calculates
the returns of call and put.

Sum of call returns = sum + MaxItems( ( Price[i] - Price[i + ReturnPeriod] ) / Price[i
+ ReturnPeriod], 0 ); // % return of call

Sum of put returns = sum + MaxItems( ( Price[i + ReturnPeriod] - Price[i] ) / Price[i
+ ReturnPeriod], 0 ); // % return of put

Kahler's Volatility = (sum of call returns + sum of put returns) / period

USAGE

Kahler's Volatility can be used for analysis, for placing stop loss markers, for
calculating indicators, or for general risk assessment.

The higher the value, the stronger the periodic price changes. Usually the
volatility increases when a base value is in a consolidation phase (in which there
is no directional trend movement) or when the price is in a very strong downward
movement.

LINEAR REG CURVE
Shortcode: LINREG

DESCRIPTION

This indicator plots the linear regression
value for a bar as a continuous curve. It
highlights where the trend is going.

PARAMETER

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Period
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The number of bars used to calculate the linear regression. The number chosen
will determine the number of data points used in the calculation. The smaller the
value, the more closely the regression curve will follow the course of the price.

Default: 5

Displacement
The number of bars to shift the regression curve into the past or future.

Default: 0

CALCULATION

The Linear Regression curve is the result of plotting a line through each end point
of linear regression trend lines. Each trend line plots the minimal distance
between data points, using the "least squares" method, over the number of bars
defined in the Period input.

USAGE

This indicator determines where a market’s price might be in the near future using
current and past price history. If prices are trending up, linear regression attempts
to determine what the upward bias of the price may be relative to the current
price. If prices are trending down, it will attempt to determine the downward bias
of the price. Some analysts believe that when prices rise above or fall below the
linear regression line, they are overextended and will begin to move back towards
the line. Thus, the line is used to monitor when a price move may change
direction.

This indicator is often used in combination with the RSquare indicator in order to
determine the significance of the trend and to calculate its confidence level. It can
also be used to generate trading signals. A few examples are:
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à Going long if the regression curve is ascending, going short if
the regression curve is descending

à Signal generation based on the price relative to the regression
curve.

Ó THIS INDICATOR IS OFTEN USED IN
COMBINATIONWITH THE RSQUARE
INDICATOR. A VALUE OF 0.8 ORMORE
INDICATES A STRONG CONFIDENCE
LEVEL.

Ó THE INDICATOR INSERTED TWICE
WITH DIFFERENT PERIOD SETTINGS.

MACD
Shortcode: MACD

DESCRIPTION

This trend-following indicator is the result of
combining two exponentially smoothed
moving averages that are plotted above and
below a zero line. Crossovers, movements
through the zero line and divergences
generate buy and sell signals.
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PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

PeriodFast
The number of bars used to calculate the fast exponential moving average.

Default: 12

PeriodSlow
The number of bars used to calculate the slow exponential moving average.

Default: 26

Trigger
The number of bars used to calculate the trigger line.

Default: 9

CALCULATION

Two Exponential Moving Averages (EMAs) with different period settings, 12 (fast)
and 26 (slow), are calculated. The 26-bar EMA is then subtracted from the 12-bar
EMA. In addition, a 9-bar EMA of the MACD is plotted on top of the MACD,
serving as a trigger line for buy and sell signals.

USAGE

There are three common ways to interpret the indicator:

à Trigger Line Crossovers: An indicator line falling below the
trigger line is a bearish signal, indicating downward
momentum. An indicator line rising above the trigger line is a
bullish signal, indicating upward momentum.

à Zero Line Crossovers: An indicator line crossing the zero line
bottom-up is a bullish signal, an indicator line crossing the
zero line top-down is a bearish signal.

à Divergences: An indicator line diverging from the price of the
security (or vice versa) signals the end of the current trend.
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Ó A ZERO LINE CROSSOVER
INDICATING A TREND REVERSAL.

Ó DIVERGENCES BETWEEN INDICATOR
AND PRICE INDICATE THE END OF THE
CURRENT TREND.

MACD - EXIT STRATEGY

DESCRIPTION

This strategy is based on the "MACD" on
page 675 indicator, which uses two
exponentially smoothed moving averages
with different periods and a zero line. Trading
signals are generated, when the MACD value
crosses the signal line. For Entry signals with
the same trigger, please use the "MACD -
Entry Strategy" on page 679.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close
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PeriodFast
The number of bars used to calculate the fast exponential moving average.

Default: 12

PeriodSlow
The number of bars used to calculate the slow exponential moving average.

Default: 26

TriggerPeriod
The number of bars used to calculate the trigger line.

Default: 9

SigMethod
Defines which line should be used a second line for the crossover

Default: ZeroLine

ExitMethod
Defines what kind of orders are placed

Default: Both

CALCULATION

Ó MACD - EXIT STRATEGYWITH THE
CORRESPONDINGMACD INDICATOR

The strategy generates trading signals
depending on a crossover of the MACD line
with the chosen signal line. A long exit signal is
generated if the MACD value crosses under the
chosen signal line. If the MACD value crosses
over the chosen signal line, a short exit signal is
generated.

For the calculation of the indicator itself, see
"MACD" on page 675.

USAGE

The exponentially smoothed moving average with the short period reacts faster to
a upcoming trend then the exponentially smoothed moving average with the
longer period. The distance between the averages is bigger when the trend is
getting stronger. In this period this strategy does not generate a signal. A
crossover between the MACD line and the signal line is a hint for trend reversal.
Spikes and big gaps are more likely to happen during an active trend and both
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have a big and persistent impact on averages. Therefore, the strategy is more
useful in a trading range as in an active trend.

Different types of moving averages are always behind the trends due to the
calculation itself. Consequently, it would be worth to add some additional
indicators or conditions to the strategy to predict a trend reversal quicker. For
example, the zero line of the MACD indicator or chart pattern like wedges can be
used for this purpose.

MACD - ENTRY STRATEGY

DESCRIPTION

This strategy is based on the "MACD" on
page 675 indicator, which uses two
exponentially smoothed moving averages
with different periods and a zero line. Trading
signals are generated, when the MACD value
crosses the signal line. For Exit signals with
the same trigger, please use the "MACD - Exit Strategy" on page 677.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

PeriodFast
The number of bars used to calculate the fast exponential moving average.

Default: 12

PeriodSlow
The number of bars used to calculate the slow exponential moving average.

Default: 26

TriggerPeriod
The number of bars used to calculate the trigger line.

Default: 9
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SigMethod
Defines which line should be used a second line for the crossover

Default: ZeroLine

EntryMethod
Defines what kind of orders are placed

Default: Both

CALCULATION

Ó MACD - ENTRY STRATEGYWITH THE
CORRESPONDINGMACD INDICATOR

The strategy generates trading signals
depending on a crossover of the MACD line
with the chosen signal line. A long entry signal
is generated when the MACD value crosses
over the chosen signal line. If the MACD value
crosses under the chosen signal line, a short
entry signal is generated. For the calculation of
the indicator itself, see "MACD" on page 675.

USAGE

The exponentially smoothed moving average
with the short period reacts faster to a upcoming trend then the exponentially
smoothed moving average with the longer period. The distance between the
averages is bigger when the trend is getting stronger. In this period this strategy
does not generate a signal. A crossover between the MACD line and the signal
line is a hint for trend reversal. Spikes and big gaps are more likely to happen
during an active trend and both have a big and persistent impact on averages.
Therefore, the strategy is more useful in a trading range as in an active trend.

Different types of moving averages are always behind the trends due to the
calculation itself. Consequently, it would be worth to add some additional
indicators or conditions to the strategy to predict a trend reversal quicker. For
example, the zero line of the MACD indicator or chart pattern like wedges can be
used for this purpose.
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MACD CROSSOVER STRATEGY

DESCRIPTION

This complete strategy is based on the
"MACD" on page 675 indicator, which uses
two exponentially smoothed moving
averages with different periods and a trigger
line. Trading signals are generated, when the
MACD value crosses the trigger line.

This strategy is a complete system. If you would like to use two separate systems
for Exit and Entry signals based on a MACD indicator, please use "MACD - Entry
Strategy" on page 679 and "MACD - Exit Strategy" on page 677 instead. When
you want to use this strategy in a "Portfolio" on page 251, use the portfolio
optimized version "MACD Crossover Portfolio Strategy" on the next page.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

PeriodFast
The number of bars used to calculate the fast exponential moving average.

Default: 12

PeriodSlow
The number of bars used to calculate the slow exponential moving average.

Default: 26

Trigger
The number of bars used to calculate the trigger line.

Default: 9

Bullish
Defines what kind of orders are placed

Default: LongEntry

Bearish
Defines what kind of orders are placed
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Default: LongExit

CALCULATION

Ó MACD CROSSOVER STRATEGYWITH
THE CORRESPONDINGMACD
INDICATOR

The strategy generates trading signals
depending on a crossover of the MACD line
with the trigger line. A entry signal is generated
when the MACD value crosses over the trigger
line. If the MACD value crosses under the
trigger line, a exit signal is generated. For the
calculation of the indicator itself, see "MACD"
on page 675.

USAGE

The exponentially smoothed moving average
with the short period reacts faster to a upcoming trend then the exponentially
smoothed moving average with the longer period. The distance between the
averages is bigger when the trend is getting stronger. In this period this strategy
does not generate a signal. A crossover between the MACD line and the signal
line is a hint for trend reversal. Spikes and big gaps are more likely to happen
during an active trend and both have a big and persistent impact on averages.
Therefore, the strategy is more useful in a trading range as in an active trend.

Different types of moving averages are always behind the trends due to the
calculation itself. Consequently, it would be worth to add some additional
indicators or conditions to the strategy to predict a trend reversal quicker. For
example, the zero line of the MACD indicator or chart pattern like wedges can be
used for this purpose.

MACD CROSSOVER PORTFOLIO STRATEGY

DESCRIPTION

This complete strategy is based on the
"MACD" on page 675 indicator, which uses
two exponentially smoothed moving
averages with different periods and a trigger
line. Trading signals are generated, when the
MACD value crosses the trigger line.

This strategy is optimized for a "Portfolio" on page 251.
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PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

PeriodFast
The number of bars used to calculate the fast exponential moving average.

Default: 12

PeriodSlow
The number of bars used to calculate the slow exponential moving average.

Default: 26

Trigger
The number of bars used to calculate the trigger line.

Default: 9

Bullish
Defines what kind of orders are placed

Default: LongEntry

Bearish
Defines what kind of orders are placed

Default: LongExit

CALCULATION

Ó MACD CROSSOVER STRATEGYWITH
THE CORRESPONDINGMACD
INDICATOR

The strategy generates trading signals
depending on a crossover of the MACD line
with the trigger line. A entry signal is generated
when the MACD value crosses over the trigger
line. If the MACD value crosses under the
trigger line, a exit signal is generated. For the
calculation of the indicator itself, see "MACD"
on page 675.
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USAGE

The exponentially smoothed moving average with the short period reacts faster to
a upcoming trend then the exponentially smoothed moving average with the
longer period. The distance between the averages is bigger when the trend is
getting stronger. In this period this strategy does not generate a signal. A
crossover between the MACD line and the signal line is a hint for trend reversal.
Spikes and big gaps are more likely to happen during an active trend and both
have a big and persistent impact on averages. Therefore, the strategy is more
useful in a trading range as in an active trend.

Different types of moving averages are always behind the trends due to the
calculation itself. Consequently, it would be worth to add some additional
indicators or conditions to the strategy to predict a trend reversal quicker. For
example, the zero line of the MACD indicator or chart pattern like wedges can be
used for this purpose.

MACD FOREST
Shortcode: MACDF

DESCRIPTION

This indicator calculates and displays the
difference between the MACD indicator and
its trigger line. The resulting histogram
indicates trend strength and direction.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

PeriodFast
The number of bars used to calculate the fast exponential moving average.

Default: 12

PeriodSlow
The number of bars used to calculate the slow exponential moving average.

Default: 26
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Trigger
The number of bars used to calculate the trigger line.

Default: 9

CALCULATION

First, the MACD and its trigger line are determined by calculating the two
underlying exponential moving averages and subtracting the slow moving
average from the fast moving average. The result is the MACD. Another
exponential moving average is applied to the MACD to calculate the trigger line.
To calculate the MACDF, the trigger line is subtracted from the MACD.

Ema1(t) = Ema(x)(Close)

Ema2(t) = Ema(y)(Close)

MACD(t) = Ema1(t) – Ema2(t)

Trigger(t) = Ema(z)(MACD)

MACDHist(t) = MACD(t) – Trigger(t)

USAGE

This indicator is an additional means of analysis and usually not used to generate
trading signals (which would be identical to those generated by the underlying
MACD). The MACDF's zero line parallels the MACD's trigger line. A few
examples:

à Positive MACDF histogram values mean that the MACD
moves above its trigger line

à Negative MACDF histogram values mean that the MACD
moves below its trigger line

à Crossovers of MACDF histogram and zero line correlate with
the MACD crossing its trigger line

The use of the MACDF as an early warning system is based on the analysis of
divergences between MACDF and MACD.
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MOMENTUM
Shortcode: MOM

DESCRIPTION

The Momentum indicator is predicting the
strength or weakness of a current market
based on price statistics and indicates any
overbought or oversold market situations. In
addition the indicator indicates turning points
within the market with a crossing with the zero
line.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

Period
Defines the amount of bars for the lookback period of the calculation

Default: 10

ShowAlerts
Alerts are shown, if true

Default: False

CALCULATION

The calculation is relatively easy. The price from n days before is subtracted from
today's price:

Mom(t) = Close(t) – Close(t-n)

N is defined by Period.

USAGE

As seen on the image the indicator has a similar trend as the symbol itself. The
crossing with zero line indicates a market change and is sometimes quicker then
the market. If the Momentum is above the zero line is the current market cycle
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bullish. The stronger the Momentum converges to the zero line, so slower are the
movements in the market. After the crossing with the zero line is the Momentum
below the zero line and indicates a bearish market.

MOMENTUM ZERO LINE CROSSOVER
STRATEGY

DESCRIPTION

The Momentum Zero Line Crossover
Strategy generates signals if the momentum
indicator is crossing the zero line. The
Momentum is predicting the strength or
weakness of a current market based on price
statistics and indicates any overbought or oversold market situations, please see
"Momentum" on the previous page. When you want to use this strategy in a
"Portfolio" on page 251, use the portfolio optimized version "Momentum Zero Line
Crossover Portfolio Strategy" on the next page.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

Period
Defines the amount of bars for the lookback period of the calculation

Default: 10

Bullish
Defines what kind of orders are placed.

Default: LongEntry

Bearish
Defines what kind of orders are placed.

Default: LongExit
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CALCULATION

The crossing with zero line indicates a market change. If the Momentum is above
the zero line is the current market cycle bullish. The stronger the Momentum
converges to the zero line, so slower are the movements in the market. After the
crossing with the zero line is the Momentum below the zero line and indicates a
bearish market.

For the calculation of the indicator itself, see "Momentum" on page 686.

USAGE

As seen on the image the indicator has a similar trend as the symbol itself and the
strategy placed automatically orders along the trends. With the adjustment of the
period it is possible to decide whether short- or long-term trends should be used
for the trades.

MOMENTUM ZERO LINE CROSSOVER
PORTFOLIO STRATEGY

DESCRIPTION

The Momentum Zero Line Crossover
Portfolio Strategy generates signals if the
momentum indicator is crossing the zero line
for a portfolio. The Momentum is predicting
the strength or weakness of a current market
based on price statistics and indicates any
overbought or oversold market situations,
please see "Momentum" on page 686. This
strategy is optimized for a "Portfolio" on page 251.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

Period
Defines the amount of bars for the lookback period of the calculation

Default: 10
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Bullish
Defines what kind of orders are placed.

Default: LongEntry

Bearish
Defines what kind of orders are placed.

Default: LongExit

CALCULATION

The crossing with zero line indicates a market change. If the Momentum is above
the zero line, is the current market cycle bullish. The stronger the Momentum
converges to the zero line, so slower are the movements in the market. After the
crossing with the zero line is the Momentum below the zero line and indicates a
bearish market.

For the calculation of the indicator itself, see "Momentum" on page 686.

USAGE

As seen on the image the indicator has a similar trend as the symbol itself and the
strategy placed automatically orders along the trends. With the adjustment of the
period it is possible to decide whether short- or long-term trends should be used
for the trades.

MONTHLY PERF GRID
Shortcode: none

DESCRIPTION

This indicator shows a grid of the monthly
performance (over the prior month) of the
parent instrument. Years are displayed as
rows, and months are displayed as columns.

PARAMETERS

StartYear
Bottom year in the grid.

Default: 2000

EndYear
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Top year in the grid.

Default: 2050

TextSize
Set the text size within the grid.

Default: 9

Labels
Select which labels should be displayed: Both, Months, Years, None.

Default: None

TextColor
The color for the text.

BorderColor
The color for the border around the grid.

BackColor
The background color for the row and column heading and for empty fields.

UpColor
The color for months on which the instrument performance went up.

DownColor
The color for months on which the instrument performance went down.

MidColor
The color for months where the instrument performance moved very little.

Graduation
The number that defines the level of color change on performance differences.
The smaller the number, the sharper the color differences.

Default: 10

CALCULATION

The percentage of change based on the monthly close bars is calculated.

USAGE

The indicator shows the monthly instrument baseline performance over the years.

A calculation of a monthly return based on portfolios etc. is not possible.
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MOVING AVERAGE ADAPTIVE
Shortcode: KAMA

DESCRIPTION

The Moving Average Adaptive indicator was
invented by Perry J. Kaufmann is also known
as KAMA. The indicator focused more on
trend efficiency then on volatility. The
gradient of the signal line indicates the
current trend and has the same direction as
the trend itself.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

Period
The number of bars used to calculate

Default: 10

CALCULATION

The indicator uses a Moving Average Exponential to calculate the signal line. The
weighting factor a for the calculation is adaptive and based on the efficiency ratio
ER. This efficiency ratio is calculated with the net and gross price range in the
period. The net price range is the absolute difference between the first and the
last price in the period. The gross price range is the sum of all absolute price
ranges in the period.
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USAGE

Ó COMPARISON BETWEENMOVING
AVERAGE SIMPLE (SMA), MOVING
AVERAGE EXPONENTIAL (EMA) AND
MOVING AVERAGE ADAPTIVE (KAMA)

The indicator reacts due to the efficiency ratio
different to the current trend and movements in
the market. If the trend efficiency is high, is
thereby the weighting factor also high. With the
high weighting factor reacts the KAMA quick to
changes in the market. On the other hand
reacts the KAMA slower to changes in the
market if the trend efficiency is lower.

In comparison to the Moving Average Simple
and Moving Average Exponential is clearly to
see, how the adaptive element of the KAMA is reacting with changes in the
market.

The indicator can create signals, when the signal line is crossing the current
candles. In addition can the signal line also indicate a support or resistance line.

MOVING AVERAGE DOUBLE
Shortcode: SMA2

DESCRIPTION

The Moving Average Double indicator used
the arithmetic mean to calculate the signal
lines and is a variation of "Moving Average
Simple" on page 705. The indicator draws
two signal lines: one with a fast and one with
a slow moving average.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

PeriodFast
The number of bars used to calculate

Default: 10

PeriodSlow
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The number of bars used to calculate

Default: 18

ShowAlert
Alerts are shown, if true

Default: False

CALCULATION

The calculation of a simple moving average with the period n is as follows:

For this indicator are two moving averages calculated. The fast version is
calculated with a short period and brings fast results. On the other hand is the
slow version calculated with longer period and needs some time to show results.

USAGE

Ó MOVING AVERAGE DOUBLE

Ó MOVING AVERAGE DOUBLE IN
CONSOLIDATEDMARKET

The fast version reacts quick to trend reversal
in the market. The slow version indicates a
longer trend in the market.

A crossing of the signal lines indicates buying
pressure when crossed in the upward direction
and in the other way around a selling pressure.

If the market is currently in a consolidation and
is only moving sideways, is the indicator not
helpful, because it will create a lot of signals
without a solid trend or trend reversal.
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MOVING AVERAGE DOUBLE CROSS
PORTFOLIO STRATEGY

DESCRIPTION

This strategy is a complete strategy, which
uses a crossover with two "Moving Average
Simple" on page 705 as trading signals. The
periods of the two Moving Average Simple
should reflect a fast and a slow one. This
strategy is optimized for a "Portfolio" on page 251.

PARAMETERS

PeriodFast
The number of bars used to calculatefor the fast moving average adaptive

Default: 14

PeriodSlow
The number of bars used to calculatefor the slow moving average adaptive

Default: 38

LongEntry
Defines what kind of orders are placed.

Default: True

LongExit
Defines what kind of orders are placed.

Default: True

ShortEntry
Defines what kind of orders are placed.

Default: False

ShortExit
Defines what kind of orders are placed.

Default: False
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CALCULATION

Ó STRATEGY BEFORE AND AFTER
OPTIMIZER RUN

The strategy generates trading signals when a
crossover between the two Moving Averages
Simple occurs. For the calculation of the
indicator itself, see"Moving Average Simple" on
page 705

USAGE

Due to the Moving Average Simple used, the
strategy cannot predict trends and trend reversal, but is reacting to the ongoing
trend with a delay. Noise on the market like spikes or gaps can be handled with
the right periods for the Moving Average Simple. The optimizer in Tradesignal
helps to find the right period settings.

MOVING AVERAGE DOUBLE CROSSOVER
STRATEGY

DESCRIPTION

This strategy is a complete strategy, which
uses a crossover with two "Moving Average
Simple" on page 705 as trading signals. The
periods of the Moving Averages Simple
should reflect a fast and a slow one. When
you want to use this strategy in a "Portfolio" on page 251, use the portfolio
optimized version "Moving Average Double Cross Portfolio Strategy" on the
previous page.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

PeriodFast
The number of bars used to calculate for the fast moving average adaptive.

Default: 14

PeriodSlow
The number of bars used to calculate for the slow moving average adaptive.
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Default: 38

Bullish
Defines what kind of orders are placed.

Default: LongEntry

Bearish
Defines what kind of orders are placed.

Default: LongExit

CALCULATION

Ó STRATEGY BEFORE AND AFTER
OPTIMIZER RUN

The strategy generates trading signals when a
crossover between the two Moving Averages
Simple occurs. For the calculation of the
indicator itself, see "Moving Average Simple"
on page 705

USAGE

Due to the Moving Average Simple used, the
strategy cannot predict trends and trend reversal, but is reacting to the ongoing
trend with a delay. Noise on the market like spikes or gaps can be handled with
the right periods for the Moving Average Simple. The optimizer in Tradesignal can
help to find the right period settings.

MOVING AVERAGE DOUBLE SLOPE - ENTRY
STRATEGY

DESCRIPTION

This strategy uses a crossover with two
"Moving Average Simple" on page 705 and
the slope of the fast simple moving average
as trading signals. The periods of the Moving
Averages Simple should reflect a fast and a
slow one. For Exit signals with the same
trigger, please use the "Moving Average Double Slope - Exit Strategy" on
page 698.

PARAMETERS

PeriodMA1

696



The number of bars used to calculatefor the fast moving average adaptive

Default: 20

PeriodMA2
The number of bars used to calculatefor the slow moving average adaptive

Default: 40

LookBack
Defines the lookback period for the slope

Default: 2

EntryMethod
Defines what kind of orders are placed.

Default: Both

CALCULATION

The strategy relies for trading signals on a crossover between a fast and a slow
simple moving average and the slope of the fast simple moving average.

The strategy generates a long entry signal when a fast simple moving average is
less than a slow simple moving average and the slope of the fast one is positive.
The other way round, is a short entry signal generated when a fast simple moving
average is greater than a slow simple moving average and the slope of the fast
one is negative. For the calculation of the indicator itself, see "Moving Average
Simple" on page 705.

USAGE

Ó STRATEGY BEFORE AND AFTER
OPTIMIZER RUN

Due to the Moving Average Simple used, the
strategy cannot predict trends and trend
reversal, but is reacting to the ongoing trend
with a delay. Noise on the market like spikes or
gaps can be handled with the right periods for
the Moving Average Simple. The optimizer in
Tradesignal can help to find the right period
settings.

697



MOVING AVERAGE DOUBLE SLOPE - EXIT
STRATEGY

DESCRIPTION

This strategy uses a crossover with two
"Moving Average Simple" on page 705. The
periods of the Moving Averages Simple
should reflect a fast and a slow one. For Entry
signals with the same trigger, please use
the"Moving Average Double Slope - Entry
Strategy" on page 696.

PARAMETERS

PeriodMA1
The number of bars used to calculate for the fast moving average adaptive

Default: 20

PeriodMA2
The number of bars used to calculate for the slow moving average adaptive

Default: 40

ExitMethod
Defines what kind of orders are placed.

Default: Both

CALCULATION

The strategy relies for trading signals on a crossover between a fast and a slow
simple moving average. For the calculation of the indicator itself, see"Moving
Average Simple" on page 705.

The strategy generates a long exit signal when the slow simple moving average
crosses under a fast one. The other way round, a short exit signal is generated
when the slow simple moving average crosses over the fast one.
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USAGE

Ó STRATEGY BEFORE AND AFTER
OPTIMIZER RUN

Due to the Moving Average Simple used, the
strategy cannot predict trends and trend
reversal, but is reacting to the ongoing trend
with a delay. Noise on the market like spikes or
gaps can be handled with the right periods for
the Moving Average Simple. The optimizer in
Tradesignal can help to find the right period
settings.

MOVING AVERAGE EXPONENTIAL
Shortcode: EMA

DESCRIPTION

The Moving Average Exponential indicator is
based on a moving average with a weighting
factor which lays more stress on the recent
values then on the older values. In this way
decreases the weighted factor the delay of a
moving average, to which it is reacting to
changes on the market. The indicator is calculated consecutively.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

Period
The number of bars used to calculate

Default: 10

CALCULATION

The calculation of the indicator used the weighting factor EW with the set period
n. In this way is a weighted rate of today's close added to yesterday's EMA.
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Sometimes are 10-days-EMA used. The days are set with the period n and define
accordingly the weighting factor as follows:

USAGE

Ó COMPARISON BETWEENMOVING
AVERAGE EXPONENTIAL (EMA) AND
MOVING AVERAGE SIMPLE (SMA)

For the usage of any moving average as an
indicator are three factors important to classify
the significance: trend, noise, and delay, see
"Moving Average Simple" on page 705. The
Moving Average Exponential improves the
factor delay because the indicator reacts
quicker to the market as the "Moving Average
Simple" on page 705. The noise in the market
is still smoothed away and the trend is also
obviously.

MOVING AVERAGE EXPONENTIAL MODIFIED
Shortcode: MEMA

DESCRIPTION

The Moving Average Exponential Modified
indicator is based on a moving average with a
weighting factor which lays more stress on
the recent values then on the older values. In
this way decreases the weighted factor the
delay of a moving average, to which it is
reacting to changes on the market. The indicator is calculated consecutively. The
difference between "Moving Average Exponential" on the previous page and
Moving Average Exponential Modified is a different calculation of the weighting
factor, see Calculation.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.
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Default: Close

Period
The number of bars used to calculate

Default: 10

CALCULATION

The calculation of the indicator used the weighting factor EW with the set period
n. In this way is a weighted rate of today's close added to yesterday's EMA.

USAGE

Ó COMPARISON BETWEENMOVING
AVERAGE SIMPLE (SMA), MOVING
AVERAGE EXPONENTIAL (EMA) AND
MOVING AVERAGE EXPONENTIAL
MODIFIED (MEMA)

For the usage of any moving average as an
indicator are three factors important to classify
the significance: trend, noise, and delay, see
"Moving Average Simple" on page 705. The
Moving Average Exponential Modified
improves the factor delay because the indicator
reacts quicker to the market as the "Moving
Average Simple" on page 705. The noise in the
market is still smoothed away and the trend is
also obviously.

Compared to the "Moving Average
Exponential" on page 699 are the older values
less weighted. Therefore are the current values even more important for the
signal line of the modified version as for the standard version of the Moving
Average Exponential.
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MOVING AVERAGE INDEX DYNAMIC
Shortcode: VIDYA

DESCRIPTION

The Moving Average Index Dynamic indicator
is a variation of the "Moving Average
Exponential" on page 699 and invented by
Tushar S. Chande and Stanley Kroll. The
indicator is a variable-length exponential
moving average which is indexed to the
Chande Momentum Oscillator.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

Period
The number of bars used to calculate

Default: 9

Smoothing
Defines the smoothing factor

Default: 12

Percent Deviation
Defines the percent deviation for the additional bands

Default: 0.01

CALCULATION

The indicator includes a smoothing factor SC and the Chande Momentum
Oscillator CMO. The CMO can also have negative values and therefore the
calculation uses the absolute values.
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USAGE

Ó COMPARISON BETWEENMOVING
AVERAGE INDEX DYNAMIC (VIDYA)
ANDMOVING AVERAGE
EXPONENTIAL (EMA)

If the market is stable, is the CMO and
therefore the scaling factor as a whole low and
decrease the impact of price movements. If the
market is moving, are the CMO and the scaling
factor high and increase the impact of price
movements.

The comparison between the Moving Average
Index Dynamic (VIDYA) and Moving Average
Exponential (EMA) is the effect of the scaling
factor and the CMO obviously.

The bands which represent the VIDYA
adjusted with the percent deviation can be used similar to the "Bollinger Bands"
on page 559 for signals.

MOVING AVERAGE MODIFIED
Shortcode: MMA

DESCRIPTION

The Moving Average Modified indicator is a
variation of the "Moving Average modified"
above. For this indicator is only the value of
yesterday needed. Additionally is a
smoothing factor added to the calculation.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

Period
The number of bars used to calculate

Default: 10
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CALCULATION

The calculation of the indicator is similar to a "Moving Average Simple" on the
next page with a smoothing factor.

USAGE

For the usage of any moving average as an indicator are three factors important
to classify the significance: trend, noise, and delay. The factor delay is improved
because the indicator needs just the data of yesterday for the calculation.

MOVING AVERAGE MONTHLY
Shortcode: MSMA

DESCRIPTION

The Moving Average Monthly indicator used
the arithmetic mean to calculate the signal
line. As the name is already suggesting is the
arithmetic mean calculate for a whole month.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

Period
The number of bars used to calculate

Default: 1

MonthsToSkip
Defines the number of months which are ignored prior the current month

Default: 0
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CALCULATION

The calculation of the indicator is a simple moving average with the period n. Here
is the period n at least one month.

With the input MonthsToSkip is it possible to exclude months from the calculation.

USAGE

Ó MOVING AVERAGEMONTHLY IN A
LONG TIME FRAME

The indicator can be used as trend filter but is
more a supporting indicator then a signal
generator. If the current candles are above the
signal line, is the current trend more in a
upwards direction. Otherwise is the trend more
in downwards direction.

MOVING AVERAGE SIMPLE
Shortcode: SMA

DESCRIPTION

The Moving Average Simple indicator used
the arithmetic mean to calculate the signal
line. With the Moving Average Simple it is
possible to reduce the noise of the market but
at the same time is the Moving Average
Simple chasing the trend.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

Period
The number of bars used to calculate.
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Default: 10

ShowAlert
Alerts are shown, if true.

Default: False

CALCULATION

The calculation of indicator is a simple moving average with the period n.

USAGE

Ó MOVING AVERAGE SIMPLEWITH
DIFFERENT PERIODS

For the usage of any moving average as an
indicator are three factors important to classify
the significance: trend, noise, and delay. Trend
means what kind of signals should be
generated. Noise means how much noise in
the market will be smoothed away. Delay
means how long the indicator needs to react if
the market is changed. Concerning the Moving
Average Simple it is possible to reduce the
noise in the market with the use of a longer
period.

The Moving Average Simple weights every candle in the same way so that a
spike has the same weight as a normal candle. The effect of the spikes is
significant at two points of time: when the candle is the first or the last candle in
the period n.

MOVING AVERAGE SINGLE CROSSOVER
STRATEGY

DESCRIPTION

This strategy is a complete strategy which
uses a crossover between a "Moving
Average Simple" on the previous page and
the close as trading signals. When you want
to use this strategy in a "Portfolio" on
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page 251, use the portfolio optimized version "Moving Average Single Cross
Portfolio Strategy" on the next page.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

Period
The number of bars used to calculate for the simple moving average.

Default: 38

Bullish
Defines what kind of orders are placed.

Default: LongEntry

Bearish
Defines what kind of orders are placed.

Default: LongExit

CALCULATION

Ó STRATEGY BEFORE AND AFTER
OPTIMIZER RUN

The strategy generates trading signals when a
crossover between the simple moving average
and the close occurs. For the calculation of the
indicator itself, see "Moving Average Simple"
on page 705

USAGE

Due to the Moving Average Simple used, the strategy cannot predict trends and
trend reversal, but is reacting to the ongoing trend with a delay. Noise on the
market like spikes or gaps can be handled with the right periods for the Moving
Average Simple. The optimizer in Tradesignal can help to find the right period
settings.
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MOVING AVERAGE SINGLE CROSS PORTFOLIO
STRATEGY

DESCRIPTION

This strategy is a complete strategy which
uses a crossover between a "Moving
Average Simple" on page 705 and the close
as trading signals. This strategy is optimized
for a "Portfolio" on page 251.

PARAMETERS

Period
The number of bars used to calculate for the simple moving average

Default: 38

LongEntry
Defines what kind of orders are placed.

Default: True

LongExit
Defines what kind of orders are placed.

Default: True

ShortEntry
Defines what kind of orders are placed.

Default: False

ShortExit
Defines what kind of orders are placed.

Default: False

CALCULATION

Ó STRATEGY BEFORE AND AFTER
OPTIMIZER RUN

The strategy generates trading signals when a
crossover between the simple moving average
and the close occurs. For the calculation of the
indicator itself, see "Moving Average Simple"
on page 705

708



USAGE

Due to the Moving Average Simple used, the strategy cannot predict trends and
trend reversal, but is reacting to the ongoing trend with a delay. Noise on the
market like spikes or gaps can be handled with the right periods for the Moving
Average Simple. The optimizer in Tradesignal can help to find the right period
settings.

MOVING AVERAGE TRIPLE
Shortcode: SMA3

DESCRIPTION

The Moving Average Triple indicator used the
arithmetic mean to calculate the signal lines
and is a variation of "Moving Average Simple"
on page 705. The indicator draws three signal
lines with different periods.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

PeriodVeryFast
The number of bars used to calculate

Default: 4

PeriodFast
The number of bars used to calculate

Default: 10

PeriodSlow
The number of bars used to calculate

Default: 18

CALCULATION

The calculation of a simple moving average with the period n is as follows:
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For this indicator are three moving averages calculated. The very fast and fast
version are calculated with short periods and bring fast results. On the other hand
is the slow version calculated with longer period and needs some time to show
results.

USAGE

The fast versions react quick to trend reversal in the market. The slow version
indicates a longer trend in the market.

If the very fast signal line crosses over the fast signal line and the fast signal line is
over the slow signal line, is a buying pressure indicated. Selling pressure is
indicated if the very fast signal line crosses back under the fast signal line.

If the market is currently in a consolidation and is only moving sideways, is the
indicator not helpful, because it will create a lot of signals without a solid trend or
trend reversal.

MOVING AVERAGE WEIGHTED
Shortcode: WMA

DESCRIPTION

The Moving AverageWeighted indicator is a
variation of the "Moving AverageWeighted"
above and add a linear weighting factor to the
calculation. Older values are weighted lesser
then current values.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

Period
The number of bars used to calculate

Default: 10
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CALCULATION

The calculation of indicator is a simple moving average with the weighting factor
w. The weighting factor is linear and use the period n for the linear weighting.

USAGE

Ó COMPARISON BETWEENMOVING
AVERAGEWEIGHTED (WMA) AND
MOVING AVERAGE SIMPLE (SMA)

For the usage of any moving average as an
indicator are three factors important to classify
the significance: trend, noise, and delay. The
Moving Average Weighted improves the factor
delay compared the "Moving Average Simple"
on page 705 because the weighting factor
places a greater emphasis on the newer
values.

MOVING AVERAGE GAP
Shortcode: MAG

DESCRIPTION

This indicator calculates the difference
between two moving averages with different
period settings. The resulting the indicator
line oscillates around a zero line. The
indicator is similar to the "MACD" on
page 675 with the exception that two simple
moving averages are used in the calculation instead of two exponential moving
averages.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

711



Default: Close

Period_Short
The number of bars used to calculate the fast moving average.

Default: 3

Period_Long
The number of bars used to calculate the slow moving average.

Default: 10

CALCULATION

Two Simple Moving Averages (SMAs) with different period settings, 3 (fast) and
10 (slow), are calculated. The slow SMA is then subtracted from the fast SMA.

USAGE

This indicator can be used for identifying the strength or weakness, or direction, of
momentum behind a security's move. The indicator line oscillates around the zero
line:

à Crossovers indicate trend reversals.

à Increasing indicator values, especially when above the zero
line, indicate a positive (bullish) momentum.

à Decreasing indicator values, especially when below the zero
line, indicate a negative (bearish) momentum.

Ó MAG (CENTER) OSCILLATOR
(BOTTOM) COMPARED.
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ON BALANCE VOLUME
Shortcode: OBV

DESCRIPTION

This indicator calculates the trading volume of
a security and relates it to the respective
closing price. It calculates a cumulative sum
for each day and displays it as a line on the
chart. By analyzing divergences and
convergences between security and indicator
the strength of a trend can be evaluated and trend changes anticipated.

CALCULATION

If the current close is higher than the previous period's close the volume is added
to the previous period's indicator value, if it is lower it is subtracted from the
indicator value. The result is a cumulative sum which is displayed as a line on the
chart.

USAGE

The indicator is used to analyze divergences and convergences between security
and indicator. The numerical value of the indicator is irrelevant, only the direction
of the line created bears significance. A strong trend is indicated by an indicator
line which confirms the direction of the underlying security, i.e. by an indicator line
that moves in the same direction as the price of the security (convergence).
Divergences indicate a weakening of the trend or a possible trend reversal.

Trend lines applied to the indicator often generate trading signals even earlier
than the security. Those signals can be used to confirm signals from the security
itself. Trading signals can also be created by applying a Simple Moving Average
(SMA) to the indicator. For example, a buy signal is created when the indicator
crosses the SMA bottom-up.
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Ó THE SECOND DIVERGENCE
STRETCHES OVER A LONGER TIME
PERIOD AND THUS BEARSMORE
SIGNIFICANCE.

Ó THE INDICATOR TREND LINE IS
CROSSED BEFORE THE TREND LINE
IN THE CHART.

OPEN PRICE GAP STRATEGY

DESCRIPTION

The complete strategy trades along open
price gaps and goes long or short depending
on the direction of the open price gap. When
you want to use this strategy in a "Portfolio"
on page 251, use the portfolio optimized
version "Open Price Gap Portfolio Strategy"
on the next page.

PARAMETERS

StopLoss
Defines the threshold for stop loss trades.

Default: 0.5

MinGap
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Defines the minimal threshold for the gaps.

Default: 0.5

CALCULATION

Ó PORTFOLIO VERSION OF THIS
STRATEGY

The strategy is based on the indicator Opening
Gaps. For the calculation of the indicator itself,
see Opening Gap.

When an upwards gap is formed, the strategy
goes short. In the other direction, the strategy
goes long with matching stops and limits as
protection, when a downwards gap is formed.

The position is not held longer then a bar due to
a timed exit.

USAGE

With this strategy, there is limited potential for a high profit with each symbol. A
recurrent optimization of the inputs is useful. When the profit is good, the profit is
evenly gained with long and short trades.

The strategy works especially well with a "Portfolio" on page 251 but the variety of
open positions always includes more risk. A careful selection of the symbols can
increase the profit.

OPEN PRICE GAP PORTFOLIO STRATEGY

DESCRIPTION

The complete strategy trades along open
price gaps and goes long or short depending
on the direction of the open price gap. This
strategy is optimized for a "Portfolio" on
page 251.

PARAMETERS

StopLoss
Defines the threshold for stop loss trades.

Default: 0.5

MinGap
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Defines the minimal threshold for the gaps.

Default: 0.5

CALCULATION

Ó PORTFOLIO VERSION OF THIS
STRATEGY

The strategy is based on the indicator Opening
Gaps. For the calculation of the indicator itself,
see Opening Gap.

When an upwards gap is formed, the strategy
goes short. In the other direction, the strategy
goes long with matching stops and limits as
protection, when a downwards gap is formed.

The position is not held longer then a bar due to
a timed exit.

USAGE

With this strategy, there is limited potential for a high profit with each symbol. A
recurrent optimization of the inputs is useful. When the profit is good, the profit is
evenly gained with long and short trades.

The strategy works especially well with a "Portfolio" on page 251 but the variety of
open positions always includes more risk. A careful selection of the symbols can
increase the profit.

OSCILLATOR
Shortcode: OSC

DESCRIPTION

This indicator calculates the difference
between two moving averages with different
period settings. The resulting the indicator
line oscillates around a zero line. The
indicator is similar to the "MACD" on
page 675 with the exception that two simple
moving averages are used in the calculation instead of two exponential moving
averages. It is identical to the "Moving Average Gap" on page 711.
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PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

Period_Short
The number of bars used to calculate the fast moving average.

Default: 3

Period_Long
The number of bars used to calculate the slow moving average.

Default: 10

CALCULATION

Two Simple Moving Averages (SMAs) with different period settings, 3 (fast) and
10 (slow), are calculated. The slow SMA is then subtracted from the fast SMA.

USAGE

This indicator can be used for identifying the strength or weakness, or direction, of
momentum behind a security's move. The indicator line oscillates around the zero
line:

à Crossovers indicate trend reversals.

à Increasing indicator values, especially when above the zero
line, indicate a positive (bullish) momentum.

à Decreasing indicator values, especially when below the zero
line, indicate a negative (bearish) momentum.

Ó OSCILLATOR (CENTER) ANDMACD
(BOTTOM) COMPARED.
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Ó OSCILLATOR (CENTER) ANDMAG
(BOTTOM) COMPARED.

ORDER BOOK DEPTH
This indicator represents the order book on the Bid and Ask side, so it shows
bid/ask volume up to a certain depth. Your Joule account needs access to
BID/ASKDEPTH FIDs.

PARAMETERS

Depth
Defines the used depth.

Default: 10

VScale
A scale for vertical height of the box. Increase the value to close the gap between
the values.

Default: 1

Labels
Whether the labels with the volume should be drawn.

Default: False

FontSize
Font Size of the labels.

Default: 5

CALCULATION

The indicator draws the given order on the bid and ask side for the given candle.
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USAGE

The indicator should be used on intraday data in low periods like 1-minute
because it needs tick data for the calculation. The Order Book Depth can be
useful for a backtesting.

PARABOLIC SAR
Shortcode: PSAR

DESCRIPTION

The Parabolic SAR (Stop And Reversal) is an
indicator developed by J. Wells Wilder which
is following the current trend and sets stops
accordingly to the previous trend (see red
trendlines in the image). These stops are following a parabolic pattern defined by
the Acceleration Factor (AF). As soon as a stop is reached a reversal of the
current trend will follow. The AF is variable until the maximum or a trend reversal
is reached (see pink trendlines in the image).

PARAMETERS

AccStart
Defines the start value of the AF (Acceleration Factor)

Default: 0.02

AccInc
Defines the increment which is added to AF with each new bar

Default: 0.02

AccMax
Defines the maximum of AF

Default: 1

ShowAlerts
Alerts are shown, if true

Default: false

719



CALCULATION

The calculation is based on the extreme values of the previous trend SAR and
SIP and the acceleration factor AF.

The values for the inputs depend if a short follows a long or otherwise. For the first
evaluation the indicator assumes a long trade.

If a short follows a long trade, is SIP the highest value of the first candle
of the new trend cycle and will be adjusted with every new highest high. SAR is
the lowest value from the previous trend cycle and will be adjusted with AF. AF
will be increased with AccInc with every new candle. Additional, if the
evolution of the short trade is positive, the AF will be adjusted quicker
in the direction of the SAR. Therefore the stop will be reached quicker.

If a long follows a short trade, is SIP the lowest value of the first candle in the new
trend cycle and will be adjusted with every new lowest low. SAR ist the
highest value from the previous trend cycle and will be adjusted with AF. AF will
be increased with AccInc with every new candle. Additional, if the evolution of the
short trade is positive, the AF will be adjusted quicker in the direction of the SAR.
Therefore the stop will be reached quicker.

USAGE

The indicator is helpful to detect stops and reversals for current trends.
Problematic are lateral movements, because they will create too many signals. If
AF is small, the Parabolic SAR will follow the trend precisely.

PARABOLIC REVERSAL STRATEGY

DESCRIPTION

The Parabolic Reversal Strategy is based on
the Parabolic SAR indicator. The Parabolic
SAR is following the current trend and sets
stops accordingly to the previous trend. If the
trend reversal is reached and the stop is
crossed, the strategy will generate a trade.
For more information concerning the indicator
itself, please see "Parabolic SAR" on the previous page. When you want to use
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this strategy in a "Portfolio" on page 251, use the portfolio optimized version
"Parabolic Reversal Portfolio Strategy" on the next page.

PARAMETERS

Start
Defines the start value of the Acceleration Factor (AF)

Default: 0.02

Increment
Defines the increment which is added to AF with each new bar

Default: 0.02

Max
Defines the maximum of AF

Default: 1

Bullish
Defines what kind of orders are placed.

Default: LongEntry

Bearish
Defines what kind of orders are placed.

Default: LongExit

CALCULATION

For the calculation of the indicator itself, see "Parabolic SAR" on page 719.

USAGE

The strategy is very helpful to detect stops and reversals for current trends.

Problematic are lateral movements, because they will create too many signals.
An additional filter like a Moving Average Exponential (EMA) could be helpful. If
the graph of the EMA is relatively flat, a sidewards movement is currently active in
the market (see image).
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PARABOLIC REVERSAL PORTFOLIO STRATEGY

DESCRIPTION

The Parabolic Reversal Portfolio Strategy is
based on the Parabolic SAR indicator. The
Parabolic SAR is following the current trend
and sets stops accordingly to the previous
trend. If the trend reversal is reached and the
stop is crossed, the strategy will generate a
trade. This strategy is optimized for a
"Portfolio" on page 251.

PARAMETERS

Start
Defines the start value of the Acceleration Factor (AF)

Default: 0.02

Increment
Defines the increment which is added to AF with each new bar

Default: 0.02

Max
Defines the maximum of AF

Default: 1

LongEntry
Defines what kind of orders are placed.

Default: True

LongExit
Defines what kind of orders are placed.

Default: True

ShortEntry
Defines what kind of orders are placed.

Default: True

ShortExit
Defines what kind of orders are placed.
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Default: True

CALCULATION

For the calculation of the indicator itself, see "Parabolic SAR" on page 719.

USAGE

The strategy is very helpful to detect stops and reversals for current trends.

Problematic are lateral movements, because
they will create too many signals. An
additional filter like a Moving Average
Exponential (EMA) could be helpful. If the
graph of the EMA is relatively flat, a
sidewards movement is currently active in the market (see image).

PARABOLIC SAR - ENTRY STRATEGY

DESCRIPTION

The Parabolic SAR - Entry Strategy is based
on the Parabolic SAR indicator. The
Parabolic SAR is following the current trend
and sets stops accordingly to the previous
trend which are variable with a acceleration
factor (AF). If the trend reversal is reached and the stop is crossed, the strategy
will generate a trade. For Exit signals with the same trigger, please use the
"Parabolic SAR - Exit Strategy" on the next page.

PARAMETERS

AccStart
Defines the start value of the Acceleration Factor (AF)

Default: 0.02

AccInc
Defines the increment which is added to AF with each new bar

Default: 0.02

AccMax
Defines the maximum of AF

Default: 1
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EntryMethod
Defines what kind of orders are placed.

Default: Both

CALCULATION

For the calculation of the indicator itself, see "Parabolic SAR" on page 719.

USAGE

Ó PARABOLIC SAR ENTRYWITH EMA

The strategy is very helpful to detect stops and
reversals for current trends.

Problematic are lateral movements, because
they will create too many signals. An additional
filter like a Moving Average Exponential (EMA)
could be helpful. If the graph of the EMA is
relatively flat, a sidewards movement is currently active in the market (see
image).

PARABOLIC SAR - EXIT STRATEGY

DESCRIPTION

The Parabolic SAR - Exit Strategy is based
on the Parabolic SAR indicator. The
Parabolic SAR is following the current trend
and sets stops accordingly to the previous
trend which are variable with a acceleration
factor (AF). If the trend reversal is reached
and the stop is crossed, the strategy will
generate a trade. For Entry signals with the
same trigger, please use the "Parabolic SAR - Entry Strategy" on the previous
page.

PARAMETERS

AccStart
Defines the start value of the Acceleration Factor (AF)

Default: 0.02

AccInc
Defines the increment which is added to AF with each new bar
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Default: 0.02

AccMax
Defines the maximum of AF

Default: 1

ExitMethod
Defines what kind of orders are placed.

Default: Both

Visuals
If active, the symbols for the stop markers are drawn

Default: Inactive

CALCULATION

For the calculation of the indicator itself, see "Parabolic SAR" on page 719.

USAGE

The strategy is very helpful to detect stops and reversals for current trends.

Problematic are lateral movements, because they will create too many signals.
An additional filter like a Moving Average Exponential (EMA) could be helpful. If
the graph of the EMA is relatively flat, a sidewards movement is currently active in
the market (see image).

PERCENT PERFORMANCE PERIODIC
Shortcode: PPFP

DESCRIPTION

Plots the percent change over the current
calendar period.

PARAMETERS

Price
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The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Period
The period over which the percent performance is calculated. One of Yearly,
Quarterly, Monthly, Weekly or Daily.

Default: Yearly

CALCULATION

perf = Price / startPriceOfPeriod * 100 - 100

PERCENTILE
Shortcode: PCNT

DESCRIPTION

This indicator plots the value at the boundary
of the specified percentile.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Percent
Enter the percent below which [percent] of the value should be found.

Default: 80

Period
The number of bars used to calculate the percentile.

Default: 100

Method
Enter the calculation method, either Interpolate or NearestRank.

Default: Interpolate

CALCULATION

Nearest Rank:
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Rank = (Percentile / 100 ) * N

with N = ordered number of items from least to greatest

A percentile calculated using the nearest-rank method will always be a member of
the original ordered list.

Interpolation uses the linear interpolation method. A percentile calculated by
interpolation does not have to be a member of the original list.

USAGE

One way to use the percentile value is as an alert for extreme events. For
example, if the current price is in the 99th percentile of range of bars over the last
months, chances are high that the market will reverse.

Another way is using it similar to a ranking function to find e.g. stocks performing
above the 75th percentile.

PERIODIC CHANGE
Shortcode: PRDC

DESCRIPTION

This indicator shows either the percent or the
absolute price change of a parent item over a
defined calendar period (day, week, month,
quarter or year).

PARAMETERS

Price
The price that should be used: Open, High, Low, Close, Volume.

Default: Close

Period
The time period to use for the calculation: Yearly, Quarterly, Monthly, Weekly,
Daily.

Default: Monthly

Value
Controls whether the absolute price or the percentage should be used.
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Default: Percent

PartialInitialPeriod
Should the first partial period be considered or not for the calculation?

Default: False

CALCULATION

The absolute value is directly calculated as

diff = Price - startPrice

The percent value as

diff = (Price / startPrice * 100) - 100

USAGE

This is a basic indicator that shows price movements over a calender period,
allowing for the analysis of seasonal changes.

P&F HORIZONTAL TARGETS
Shortcode: PFHT

DESCRIPTION

This indicator draws price targets based on
congestion patterns and associated
breakouts in Point & Figure charts. The width
of the resulting U-shape determines either a
low or high price target.

PARAMETERS

MinWidth
The minimum width of a U-shape required for target generation.

Default: 6

MaxWidth
The maximum width of a U-shape allowed for target generation.

Default: 30

MinWallLength

728



The minimum number of boxes forming the wall of a U-shape.

Default: 10

MaxWallTopDiff
The maximum difference in the number of boxes between the entry and exit
column forming a U-shape.

Default: 3

ShorterInnerCols
Controls if columns in patterns may exceed length of the pattern's walls.

Default: True

ShowInvalidated
Controls whether invalidated price targets are shown or removed.

Default: False

ExtendTargets
Controls whether price targets are extended until invalidated or met.

Default: False

ShowPriceMarkers
Show active price targets next to the scale

Default: False

ShowPercentage
Show distance to active targets as percentage of current close

Default: False

Alerts
Generate alerts when price targets are hit

Default: Off

CALCULATION

The calculation of horizontal price targets is based on the width of congestion
patterns. The number of columns yielding the congestion pattern determines the
width which is then used as the starting point for the calculation:
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HORIZONTAL PRICE TARGET WITH CONGESTION BASE AND UPSIDE
REVERSAL BREAKOUT

Basis + Width * Box Size * Reversal

HORIZONTAL PRICE TARGET WITH CONGESTION TOP AND DOWNSIDE
REVERSAL BREAKOUT

Basis - Width * Box Size * Reversal

USAGE

Price targets may be used to confirm signals generated by other indicators or
strategies, or to predict the stability of a trend. They are estimates based on P&F
charting techniques with no guarantee of prices reaching the target.

P&F TREND LINES
Shortcode: PFTND

DESCRIPTION

The P&F Trend Lines indicator plots 45
degree trend lines onto a P&F chart based on
high and low swings of a specified strength.

This indicator can only be used on a "Point
and Figure Chart" on page 144.

PARAMETERS

MinTrendLength
Minimal number of columns for a trend. If ConfirmTrends is active, the minimum
length is effectively 4.

Default: 2

ConfirmTrends
Select whether lows and highs must support the trend (True). That means lows
must be rising to confirm support, highs must be falling to confirm resistance.

Default: True

MaxConfirmLookback
Maximum number of bars to look back to confirm trends. Only used for 1-box
reversal charts.
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Default: 5

ShowNonPrevailingTrends
Select whether non-prevailing trends that do not meet the criteria above should
also be displayed, with a thinner line strength.

Default: True

MinNonPrevailingLength
Define the minimum length until a trend is even considered non-prevailing.

Default: 4

CALCULATION

The indicator draws trendlines which are defined by the inputs and the given O-
and X-columns.

USAGE

The P&F trend line is used as a predictive indicator. If the following boxes' price
falls below the P&F trend line, it may be used as a new resistance level.
Conversely, if the market price rises above the trend line, it may act as the new
support level.

P&F TRENDS
Shortcode: PFTR

DESCRIPTION

This indicator draws 45 degree trend lines on
Point & Figure charts.Trendlines on 3-box
Reversal P&F charts are drawn at 45 degrees
up and 135 degrees down. An ascending
trendline is called a Bullish Support Line and
a descending trendline is called a Bearish
Resistance Line.

PARAMETERS

MinInnerDistance
The minimal vertical distance required between inner or outer trendlines.

Default: 3
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MinInnerLength
The minimal inner horizontal length required for an inner trendline.

Default: 7

ConfirmBreachWithSignal
Controls whether an additional simple buy or sell signal is required when a
trendline is breached.

Default: True

MinLengthForConfirm
The minimum length of trendlines required for confirmation.

Default: 3

USAGE

Because these lines are drawn at specific angles, they represent a specific rate of
ascent or descent. Chartists can use P&F trendlines to define the overall trend
and look for signals in the direction of that trend.

P&F VERTICAL TARGETS
Shortcode: PFVT

DESCRIPTION

This indicator draws price targets based on
multi-top patterns in Point & Figure charts.

PARAMETERS

MultiTopMinCount
The minimum number of columns with the same price to be considered a multi-
top/bottom.

Default: 2

MultiTopMaxDiffCols
The maximum number of columns with lower/higher price before a top/bottom
pattern candidate is terminated.

Default: 0

MultiTopMaxBoxDiff
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The maximum of number of boxes prices are allowed to differ per column before a
top/bottom pattern candidate is terminated.

Default: 0

MinSignifBreakout
The minimum breakout length in boxes for a significant column, only used for
vertical counts, significant columns allow an additional count to be taken as soon
as they are drawn.

Default: 6

MaxShortColLen
The maximum column length in boxes for a short column, only used for vertical
counts, short columns allow an additional count to be taken once they have been
reversed.

Default: 3

BullishMultiplier
The multiplier for the (bullish) reversal value (to be set for the underlying symbol)
used to define the distance between market price and target price.

Default: 1

BearishMultiplier
The multiplier for the (bearish) reversal value (to be set for the underlying symbol)
used to define the distance between market price and target price.

Default: 1

Width
The width of the trendlines used by price targets.

Default: 1

FontSize
The label font size.

Default: 8

ShowInvalidated
Controls whether to show invalidated price targets or to remove them.

Default: False

ExtendTargets
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Displays horizontal lines for price targets, extending them over subsequent
columns.

Default: False

ShowPriceMarkers
Toggles visibility of active price targets next to the scale.

Default: False

ShowPercentage
Toggles visibility of distance to active targets as percentage of current close.

Default: False

Alerts
Controls whether alerts are generated when price targets are hit.

Default: Off

CALCULATION

The calculation of vertical price targets begins with the Count Column which
forms the basis for an upside or downside target. One this column has been
identified, the vertical target is calculated as follows:

VERTICAL TARGET FOR UPSIDE TARGETS

Basis + Number of Boxes * Box Size * Reversal

VERTICAL TARGET FOR DOWNSIDE TARGETS

Basis - Number of Boxes * Box Size * Reversal

For both cases, the basis is defined as the low of an X column or the high of an O
column.

USAGE

Price targets may be used to confirm signals generated by other indicators or
strategies, or to predict the stability of a trend. They are estimates based on P&F
charting techniques with no guarantee of prices reaching the target.
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P&F VOLUME PROFILE
Shortcode: PFPVP

DESCRIPTION

This indicator displays a histogram of market
volume levels distributed according to the
respective price levels.

PARAMETERS

Period
The number of columns taken into account for the calculation of the volume bars.

Default: 38

HighLow
Controls whether high-low values are used instead of close values.

Default: True

Extent
The horizontal size of the volume bars.

Default: 25

CALCULATION

The indicator analyzes the columns for the set period and assigns the trading
volume to up and down days respectively. It displays a histogram of market
volume levels distributed according to the respective price levels.

USAGE

This indicator is used to analyze Point & Figure charts on the basis of the
respective trading volume. The analysis facilitated by this indicator allows for
predictions regarding the sustainability of chart marks.
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Ó IF PERIOD IS SET TO 1 THE VOLUME
BARSWILL REFLECT ONLY THE LAST
COLUMN.

P&F VOLUME PROFILE VIEWPORT
Shortcode: PFPVPV

DESCRIPTION

This indicator calculates the profile based on
the columns currently visible in the chart's
viewport. If a chart is scrolled, zoomed, or
new data causes the visible data range to
change, the profile will be recalculated.

This indicator can only be used on a "Point
and Figure Chart" on page 144.

PARAMETERS

HighLow
Controls whether high-low values are used instead of close values.

Default: True

Extent
Controls the horizontal stretch of the indicator bars.

CALCULATION

The indicator analyzes the columns for the set period and the currently visible
data and assigns the trading volume to up and down days respectively. It displays
a histogram of market volume levels distributed according to the respective price
levels.
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USAGE

Compared to the indicator "P&F Volume Profile" on page 735 this indicator can be
used in P&F charts that are currently being updated. E.g. for every new price
movement, the viewport gets adjusted and therefore the calculation runs.
However, this can be a challenge for the performance.

PIVOT POINTS ANALYSIS
Shortcode: PIV

DESCRIPTION

This indicator calculates the numerical
average of a stock's high, low and closing
prices.

PARAMETERS

ShowAllLevels
Select whether 3 support and resistance
levels should be considered (True) or only 2
(False). With 3, the number of displayed
points is higher.

Default: True

CALCULATION

The calculation starts with the prices of the previous period:

Pivot Point for Current = High (previous) + Low (previous) + Close (previous) / 3

Further support and resistance levels can be calculated, most commonly 3. All
high and low values used here are from the previous period:

Resistance 3 = 2 * (Pivot Point – Low) + High

Resistance 2 = Pivot Point + (High - Low)

Resistance 1 = (2 x Pivot Point) – Low

Support 1 = (2 x Pivot Point) – High

Support 2 = Pivot Point – (High - Low)

Support 3 = Low – (2* High - Pivot Point)
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USAGE

The pivot point is used as a predictive indicator. If the following day's market price
falls below the pivot point, it may be used as a new resistance level. Conversely, if
the market price rises above the pivot point, it may act as the new support level.

PORTFOLIO ALLOCATION
Shortcode: PALLOC

DESCRIPTION

This indicator can be added to a portfolio or chart to show how the portfolio is
invested in a specific group or instruments. It creates a stacked bar chart.

The indicator allows grouping by industry sector (for stocks), by instrument type
(stock, bond, etc.) or by using the group labels defined in a portfolio (groups can
be created by right-clicking in the list of securities and selecting "Set Group" for
each grouping).

For the indicator to show industry sectors, the necessary information for the
instruments must be available from the data provider.

PARAMETERS

Metric
Select the metric, either Group, Sector or Type.

Default: Sector

Scaling
Select the scaling, either available or invested capital.

Default: AvailableCapital

ShowLabels
Select whether the labels should be displayed (True) or not (False).

Default: True

FontSize
Select a font size.

Default: 8
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CALCULATION

The indicator doesn't calculate anything but shows additional grouping
information.

USAGE

Use the Portfolio Allocation indicator to check whether the portfolio is sufficiently
diversified.

PORTFOLIO LEAVE EXIT STRATEGY
This strategy will exit a position in a security when the security is removed
(deactivated) in the current Portfolio.

By default, it gets added automatically when adding the first strategy to a Portfolio
(unless changed in the advanced options, see "Indicators & Strategies" on
page 327).

PARAMETERS

Mode
Select which mode should be used for exiting the position: ThisBarMarket (the
trade is executed immediately), ThisBarClose (the trade is executed when the
current bar closes), NextBarMarket (the trade is executed at the next bar's
opening price).

Default: ThisBarMarket

USAGE

In principle, it is possible to remove (deactivate) a security in a Portfolio despite
still having open positions. This strategy is used to avoid this pitfall and to
automate closing all open positions when deactivating the security in the
Portfolio.

PRICE TO BOOK MOMENTUM PORTFOLIO
STRATEGY
This strategy invests equally in the securities with the lowest price to book ratio,
adjusted for strong relative momentum.
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It can only be applied to portfolios in which all stocks have the same currency and
provide a price-to-book ratio.

PARAMETERS

MomPeriod
Period used for calculating the momentum (in bars).

Default: 100

RebalancePeriod
Define how often the investments should be rebalanced (each day, week, month,
quarterly or yearly).

Default: Yearly

PtbWeight
The weight to apply to the price-to-book score versus the momentum score. If the
weight is set to 100, the momentum is not being considered in the calculation.

Default: 80

InvestmentThreshold
Set the percentage of the portfolio to invest in.

Default: 20

CALCULATION

The price-to-book ratio is calculated by dividing a company's stock price by its
book value per share (net assets).

In this indicator, the price-to-book value and the momentum value are combined.

For all symbols (i) in the Portfolio, calculate:

ptb[i] = Close of priceToBookFields( i - 1 ); // close price to book value (book value
must be available for the symbol)

mom[i] = ( Close / Close[MomPeriod] ) of symbols( i - 1 ); // close price vs. close
price during the momentum period

Based on these values, the highest and lowest ranks are calculated adjusted by
the weight.

ptbRank = ( highestPtb - ptb[i] ) / ( highestPtb - lowestPtb );

momRank = ( mom[i] - lowestMom ) / ( hightestMom - lowestMom );
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rank[i] = scaledPtbWeight * ptbRank + scaledMomWeight * momRank;

USAGE

A low price-to-book ratio signals a potentially undervalued stock. Whether a price-
to-book ratio is considered good also depends on the industry.

Investing based on the combination of a low price-to-book ratio combined with a
high upwards momentum has been shown to yield good returns.

PRICE VOLUME PROFILE
Shortcode: PVP

DESCRIPTION

This indicator calculates the relationship
between price levels and the market volume
traded at these levels. It displays a histogram
of market volume levels distributed according
to the respective price levels.

In addition shows the indicator the Point of Control and the corresponding Value
Area.

PARAMETERS

Period
The number of bars used to calculate the indicator.

Default: 38

Columns
The number of indicator bars to be displayed.

Default: 23

HighLow
Controls whether the period high and period low is used for the calculation.

Default: Yes

Extent
Controls the horizontal stretch of the indicator bars.

Default: 25
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PointOfControl
Controls the thickness of the line for Point of Control

Default: Small

POCExtent
Controls the horizontal stretch of the line for Point of Control

Default: 25

ValueArea
Controls the percentage of volume which is used for the Value Area

Default: 70

CALCULATION

The indicator analyzes the individual bars for the set period and assigns the
trading volume to up and down days respectively. It displays a histogram of
market volume levels distributed according to the respective price levels.

The indicator highlights the column with the highest volume with the Point of
Control. The Value Area marks the columns where most of the volume is
distributed. How much of the total volume is to be used for this can be controlled
with the ValueArea input.

USAGE

The indicator is commonly used to analyze chart marks on the basis of the
respective trading volume. The general opinion is that on the put side of
resistance lines the volume should be higher than on the call side, and that on the
call side of support lines the volume should be higher than on the put side. The
analysis facilitated by this indicator allows for predictions regarding the
sustainability of chart marks.

Ó THE INDICATOR IN AN HOURLY
CHART.

742



PRICE VOLUME PROFILE INTRABAR
Shortcode: PVPI

DESCRIPTION

This indicator plots the intrabar volume profile
for each bar in the chart when the chart is
extremely zoomed in. The intrabar volume
levels are generated using a lower period
specified in the properties. The profiles will
only be plotted if twenty or less bars are
visible in the chart.

PARAMETERS

Period
The period length, from 1 tick to 60 minutes.

Default: Mins60

Columns
The number of indicator bars to be displayed.

Default: 23

HighLow
Controls whether the period high and period low are used for the calculation
(True) or the close values (False).

Default: True

ShowLabels
Controls whether labels should be displayed.

Default: False

Color
Controls the label color and opacity.

CALCULATION

The indicator analyzes the individual bars for the set, very short period and
assigns the trading volume to up and down intrabar moments respectively. It
displays a histogram of market volume levels within each bar distributed
according to the respective price levels.
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USAGE

The indicator is commonly used to analyze chart marks on the basis of the
respective trading volume. The general opinion is that on the put side of
resistance lines the volume should be higher than on the call side, and that on the
call side of support lines the volume should be higher than on the put side. The
analysis facilitated by this indicator allows for predictions regarding the
sustainability of chart marks.

PRICE VOLUME PROFILE PERIODIC
Shortcode: PVPP

DESCRIPTION

This indicator is based on the "Price Volume
Profile" on page 741 and calculates the
relationship between price levels and the
market volume traded at these levels. It
displays a histogram of market volume levels
distributed according to the respective price levels. The calculation period is
based on single days, weeks, months or years. The period can be different to the
period in the chart itself.

In addition shows the indicator the Point of Control and the corresponding Value
Area.

PARAMETERS

RolloverPeriod
Controls the period for the indicator.

Default: Weekly

InnerPeriod
Controls the inner period for calculation of the indicator.

Default: Automatic

Columns
The number of indicator bars to be displayed.

Default: 30

HighLow
Controls whether the period high and period low is used for the calculation.
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Default: Yes

Width
Controls the horizontal stretch of the indicator bars.

Default: 40

PointOfControl
Controls the thickness of the line for Point of Control

Default: Small

ShowValueArea
Controls if the Value Area is shown

Default: True

ValueArea
Controls the percentage of volume which is used for the Value Area

Default: 70

CALCULATION

The indicator analyzes the individual bars for the inner period within the rollover
period and assigns the trading volume. It displays a histogram of market volume
levels distributed according to the respective price levels. The inner period can be
chosen automatic according to the period in the chart and the rollover period or
can be set to specific period.

The indicator highlights the column with the highest volume with the Point of
Control. The Value Area marks the columns where most of the volume is
distributed. How much of the total volume is to be used for this can be controlled
with the ValueArea input.

USAGE

The indicator is commonly used to analyze chart marks on the basis of the
respective trading volume. The general opinion is that on the put side of
resistance lines the volume should be higher than on the call side, and that on the
call side of support lines the volume should be higher than on the put side. The
analysis facilitated by this indicator allows for predictions regarding the
sustainability of chart marks.
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Ó THE INDICATOR IN AN HOURLY CHART
WITH ROLLOVERPERIOD DAILY AND
INNERPERIOD AUTOMATIC.

PRICE VOLUME PROFILE VIEWPORT
Shortcode: PVPV

DESCRIPTION

This indicator is based on the "Price Volume
Profile" on page 741 and calculates the
profile based on the data currently visible in
the chart's viewport. If a chart is scrolled,
zoomed, or new data causes the visible data
range to change, the profile will be
recalculated.

PARAMETERS

Columns
The number of indicator bars to be displayed.

Default: 30

HighLow
Controls whether the period high and period low is used for the calculation.

Default: True

Extent
Controls the horizontal stretch of the indicator bars.

Default: 25

PointOfControl
Controls the thickness of the line for Point of Control

Default: Small
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ShowValueArea
Controls if the Value Area is shown

Default: True

POCExtent
Controls the horizontal stretch of the line for Point of Control

Default: 100

ValueArea
Controls the percentage of volume which is used for the Value Area

Default: 70

CALCULATION

The indicator analyzes the individual bars for the currently visible data in the
viewport and assigns the trading volume to up and down days respectively. It
displays a histogram of market volume levels distributed according to the
respective price levels.

USAGE

Compared to the indicator "Price Volume Profile" on page 741 this indicator can
be used in charts that are currently being updated. E.g. for every new tick, the
viewport gets adjusted and therefore the calculation runs. However, this can be a
challenge for the performance.

RATIOCATOR
Shortcode: RAT

DESCRIPTION

This indicator analyzes the performance of
two securities relative to a base date. It is
similar to the Relative Performance indicator
with the exception that the Ratiocator's initial
value at the base date will be assigned to 100
instead of 0.

PARAMETERS

This indicator requires two parent instruments.
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PriceA
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

PriceB
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

BaseDate
Base date used for the comparison of the two instruments.

CALCULATION

This indicator calculates the relative performance of two securities.

USAGE

This indicator can be used to analyze the relative performance of securities and to
identify strong and weak performances of individual securities.

REF
Shortcode: REF

DESCRIPTION

This indicator allows access to the data from
another workspace series from within the
current chart (or other document).

This indicator can be used, for example, to
access the Strategy Equity values from a portfolio and compare them to a
benchmark of some type within another chart.

Note: While several Ref indicators can be added to a chart, the Ref subcharts cannot be
referenced themselves. It is also not possible to trade based on the combined data of a chart
and its referencing subchart.

Add the Ref indicator to an existing symbol chart, then add a referenced symbol
via the parameters.

PARAMETERS

Symbol
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The only input for the Ref indicator is a symbol. It is possible to choose items
within the same workspace, such as Strategy Equity Portfolio values (see Usage
below).

CALCULATION

The indicator doesn't calculate anything, it displays data from another input, with
the same x-axis as the chart the Ref indicator was applied to.

USAGE

The Ref indicator is a powerful tool to compare data from various inputs in one
workspace. When choosing a symbol, the optionWorkspace Symbol
List: <workspacename> displays all inputs available in the workspace.

In the example below, this is a portfolio with various stocks, a performance index
and a Strategy Equity indicator which offers open and closed equity. Each of
these entries can be chosen to be displayed in the Ref indicator.

Ó SELECTING AWORKSPACE ELEMENT

In combination with a Bollinger Band Breakout strategy, the resulting Portfolio
equity compared to the performance of the DAX performance index can be
displayed.

Ó EQUITY OF THE PORTFOLIO OVER
TIME COMPARED TO THE DAX
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RELATIVE MOMENTUM
Shortcode: RMOM

DESCRIPTION

This indicator plots a scatter graph of the
relative performance of a security to its
benchmark index against the momentum of
that performance.

PARAMETERS

Symbol
The data field from the benchmark instrument.

MomPeriod
The number of bars used to calculate the momentum value.

SmoothPeriod
The number of bars used to calculate the simple moving average which is applied
to the calculation of the relative performance as well as to the momentum value.

Method
Toggles between RateOfChange and Momentum calculation.

CALCULATION

This indicator calculates both the relative strength of a security versus a
benchmark as well as the related momentum. The relative strength is plotted on
the x-axis, the momentum on the y-axis. All results are normalized to only take
values between -100 and +100. The resulting diagram is divided into four
quadrants:

Quadrant 1: Leading - Outperformer with
positive momentum

Quadrant 2: Weakening - Outperformer with
negative momentum

Quadrant 3: Lagging - Underperformer with
negative momentum

Quadrant 4: Improving - Underperformer
with positive momentum
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USAGE

The Relative Momentum indicator detects underperforming or outperforming
securities and identifies changes from weak to strong market phases. It shows
the performance of a security relative to a selected benchmark by calculating both
the relative strength of securities versus a benchmark as well as the related
momentum. Securities whose performance differs significantly from the
benchmark can be easily identified.

Ó THIS INDICATOR SHOWS THE
PERFORMANCE OF A SECURITY
RELATIVE TO A SELECTED
BENCHMARK ON THE X-AXIS, WHILE
THEMOMENTUM IS DISPLAYED ON
THE Y-AXIS.

RELATIVE PERFORMANCE
Shortcode: REP

DESCRIPTION

This indicator compares the relative
performance of two securities relative to a
base date. It is similar to the Ratiocator
indicator with the exception that the Relative
Performance's initial value at the base date
will be assigned to 0 instead of 100.

PARAMETERS

This indicator requires two parent instruments.

PriceA
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The data field from the parent instrument (or indicator) on which to calculate this
indicator.

PriceB
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

BaseDate
Base date used for the comparison of the two instruments.

CALCULATION

This indicator calculates the relative performance of two securities.

USAGE

This indicator can be used to analyze the relative performance of securities and to
identify strong and weak performances of individual securities.

RELATIVE PERFORMANCE BENCHMARK

DESCRIPTION

This indicator compares the relative
performance of a security relative to a base
date to a benchmark. It is similar to the
Ratiocator Benchmark indicator with the
exception that the Relative Performance
Benchmark's initial value at the base date will
be assigned to 0 instead of 100.

PARAMETERS

This indicator requires two parent instruments.

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Benchmark
The data field from the benchmark instrument to which to compare the
instrument.

StartingDate
The base date used for the comparison.
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CALCULATION

This indicator compares the relative performance of a security relative to a base
date to a benchmark.

USAGE

This indicator can be used to analyze the relative performance of a security
against a benchmark and to identify strong and weak performances of a security.

RELATIVE STRENGTH INDEX
Shortcode: RSI

DESCRIPTION

The well known Relative Strength Index was
first used by Welles Wilder and is an oscillator
based indicator. The indicator indicates the
internal strength or weakness of a symbol. If
the top or bottom control levels are crossed,
the indicator predicts a trend reversal.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

Period
The number of bars used to calculate

Default: 14

OverSold
Defines value for bottom control level
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Default: 30

OverBought
Defines value for top control level

Default: 70

CALCULATION

The calculation of the indicator line is based on a modified exponential moving
average with a set period. The modified exponential moving average is a variation
of the "Moving Average Simple" on page 705with a smoothing factor which
eliminates the noise of the market.

The indicator uses in addition two constant levels, the top and bottom control
levels.

USAGE

If the top control level is reached, the market is saturated with buy trades and sale
trades will follow. In the other direction is the market saturated with sell trades and
buy trades will follow, if the bottom control level is reached. The center line is
constant and indicates a undecided market.

Welles Wilder and many others advise for the values for the top and bottom
control levels 70 and 30. Other values can be used, if only extremer values should
be taken into account (see image).
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RELATIVE STRENGTH INDEX SLOPE - ENTRY
STRATEGY

DESCRIPTION

The Relative Strength Slope - Entry Strategy
is based on the "Relative Strength Index" on
page 753 indicator. This indicator is based on
an oscillator and indicates the internal
strength or weakness of a symbol. The
strategy is triggered by the slope of the RSI.
For Exit signals with the same trigger, please
use the "Relative Strength Index Slope - Exit
Strategy" on the next page.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

Period
The number of bars used to calculate

Default: 14

Lookback
Defines the lookback period for the slope

Default: 2

EntryMethod
Defines what kind of orders are placed.

Default: Both

CALCULATION

For the calculation of the indicator itself, see "Relative Strength Index" on
page 753. If the slope is positiv during the set lookback period, the strategy will
place buy trades. In the other direction the strategy will place sell trades if the
slope is negatively during the lookback period.
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USAGE

The strategy is good to identify upcoming trends. In order to get only trigger for
stable trends, the lookback period can be adjusted.

RELATIVE STRENGTH INDEX SLOPE - EXIT
STRATEGY

DESCRIPTION

The Relative Strength Slope - Exit Strategy is
based on the "Relative Strength Index" on
page 753 indicator. This indicator is based on
an oscillator and indicates the internal
strength or weakness of a symbol. The
strategy is triggered by the slope of the RSI.
For Entry signals with the same trigger,
please use the "Relative Strength Index
Slope - Entry Strategy" on the previous page.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

Period
The number of bars used to calculate

Default: 14

Lookback
Defines the lookback period for the slope

Default: 2

ExitMethod
Defines what kind of orders are placed.

Default: Both
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CALCULATION

For the calculation of the indicator itself, see "Relative Strength Index" on
page 753. If the slope is positive during the set lookback period, the strategy will
place buy trades. In the other direction the strategy will place sell trades if the
slope is negatively during the lookback period.

USAGE

The strategy is good to identify upcoming trends. In order to get only trigger for
stable trends, the lookback period can be adjusted.

RELATIVE STRENGTH INDEX ZONE PORTFOLIO
STRATEGY

DESCRIPTION

The Relative Strength Index Zone Portfolio
strategy is based on the "Relative Strength
Index" on page 753 and follows the logic of
the indicator. The strategy is triggered, if the
RSI is crossing the top or bottom control
levels. This strategy is optimized for a
"Portfolio" on page 251.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

Period
The number of bars used to calculate

Default: 14

OverBought
Defines value for top control level

Default: 70

OverSold
Defines value for bottom control level
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Default: 30

Bullish
Defines what kind of orders are placed.

Default: LongEntry

Bearish
Defines what kind of orders are placed.

Default: LongExit

CALCULATION

For the calculation of the indicator itself, see "Relative Strength Index" on
page 753. The top or bottom control levels are constant.

USAGE

If the bottom control level is reached, is the market saturated with sell trades and
buy trades will follow. The strategy is now placing buy trades.

In the other direction the market is saturated with buy trades and sale trades will
follow if the top control level is reached. So the strategy will place sell trades.

RELATIVE STRENGTH INDEX ZONE SYSTEM
STRATEGY

DESCRIPTION

The Relative Strength Index Zone System
strategy is based on the "Relative Strength
Index" on page 753 and follows the logic of
the indicator. The strategy is triggered, if the
RSI is crossing the top or bottom control
levels. When you want to use this strategy in
a "Portfolio" on page 251, use the portfolio
optimized version "Relative Strength Index Zone Portfolio Strategy" on the
previous page.

PARAMETERS

Price
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The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

Period
The number of bars used to calculate

Default: 14

OverBought
Defines value for top control level

Default: 70

OverSold
Defines value for bottom control level

Default: 30

Bullish
Defines what kind of orders are placed.

Default: LongEntry

Bearish
Defines what kind of orders are placed.

Default: LongExit

CALCULATION

For the calculation of the indicator itself, see "Relative Strength Index" on
page 753. The top or bottom control levels are constant.

USAGE

If the bottom control level is reached, is the market saturated with sell trades and
buy trades will follow. The strategy is now placing buy trades.

In the other direction the market is saturated with buy trades and sale trades will
follow if the top control level is reached. So the strategy will place sell trades.
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RELATIVE STRENGTH INDEX - ENTRY
STRATEGY

DESCRIPTION

The Relative Strength Index - Entry Strategy
is based on the "Relative Strength Index" on
page 753 indicator. This indicator is based on
an oscillator and indicates the internal
strength or weakness of a symbol. If either
the top or bottom control levels or the center
line are crossed, the strategy predicts a trend
reversal. For Exit signals with the same trigger, please use the "Relative Strength
Index - Exit Strategy" on the next page.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

Period
The number of bars used to calculate

Default: 14

HigherZone
Defines value for top control level

Default: 70

LowerZone
Defines value for bottom control level

Default: 30

SigMethod
Defines the method for the signals

Default: CenterLine

EntryMethod
Defines what kind of orders are placed.

Default: Both
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CALCULATION

Ó STRATEGYWITH CENTERLINE AS
SIGMETHOD

For the calculation of the indicator itself, see
"Relative Strength Index" on page 753. The
strategy has two different signal
methods: CenterLine or InsideOut. If InsideOut
is chosen, the strategy will be triggered, when
the control levels are crossed (see first image).
After a crossover with the top control level a
buy order will be placed and after a crossover
with the bottom control level a sell order will be
placed. Any crossover with the same level will
have no effect for the current trade.

If CenterLine is chosen, the strategy will be
triggered when the RSI is crossing the center
line (see second image).

USAGE

If the top control level is reached, the market is saturated with buy trades and sale
trades will follow. In the other direction is the market saturated with sell trades and
buy trades will follow, if the bottom control level is reached. The center line is used
as well as trigger, because the crossover with the center line marks a growing
trend in the market.

RELATIVE STRENGTH INDEX - EXIT STRATEGY

DESCRIPTION

The Relative Strength Index - Exit Strategy is
based on the "Relative Strength Index" on
page 753 indicator. This indicator is based on
an oscillator and indicates the internal
strength or weakness of a symbol. If either
the top or bottom control levels or the center
line are crossed, the strategy predicts a trend
reversal. For Entry signals with the same trigger, please use the "Relative
Strength Index - Entry Strategy" on the previous page.

PARAMETERS

Price
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The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Close

Period
The number of bars used to calculate

Default: 14

HigherZone
Defines value for top control level

Default: 70

LowerZone
Defines value for bottom control level

Default: 30

SigMethod
Defines the method for the signals

Default: CenterLine

ExitMethod
Defines what kind of orders are placed.

Default: Both

CALCULATION

For the calculation of the indicator itself, see
"Relative Strength Index" on page 753. The
strategy has two different signal
methods: CenterLine or InsideOut. If
InsideOut is chosen, the strategy will be
triggered, when the control levels are crossed
(see first image). After a crossover with the
top control level a buy order will be placed
and after a crossover with the bottom control
level a sell order will be placed. Any
crossover with the same level will have no
effect for the current trade.

If CenterLine is chosen, the strategy will be triggered when the RSI is crossing the
center line (see second image).

762



USAGE

If the top control level is reached, the market is saturated with buy trades and sale
trades will follow. In the other direction is the market saturated with sell trades and
buy trades will follow, if the bottom control level is reached. The center line is used
as well as trigger, because the crossover with the center line marks a growing
trend in the market.

RENKO SHADOWS
Shortcode: RSHADOW

DESCRIPTION

This indicator draws shadows on a Renko
chart, showing the price movement away
from the current trend.

It can only be used on a Renko Chart.

PARAMETERS

UpShadow
The shadow color for the up price.

DownShadow
The shadow color for the down price.

HighLow
Controls whether the period high and period low are used for the calculation
(True) or the close values (False).

Default: True

CALCULATION

Renko Shadows looks for the lowest point in the candles (depending on setting
either low price or candle with the lowest close) that underlie an upward moving
column (and vice versa).

USAGE

Usually, Renko charts are used to condense information into a simple up-down
information based on price movements.
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The Renko Shadows indicator adds an information on the actual range of price
movement that hides behind the boxes, similar to bars. Large shadows indicate
large price movements (though not large enough to actually create a new box)
and therefore a possible direction of the future movement.

RSQUARE

DESCRIPTION

This indicator quantifies the strength of a
trend by measuring the quality of linear
regression. It shows how much of a security's
movement can be explained by another
security's movement.

PARAMETERS

This indicator requires two parent instruments.

Price1
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Price2
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Period
The number of bars used to calculate this indicator.

Default: 30

CALCULATION

The correlation coefficient r² is a measure of the linear correlation between two
variables X and Y. The RSquare indicator provides information on the quality of
the linear regression.
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USAGE

RSquare values range from 0 to 1 which represent percentages from 0% to
100%. An RSquare value of 1 means all movements of a security are completely
explained by movements in the other security. Values between 0.85 and 1 are
considered high, meaning the security's performance has been in line with the
performance of the other security (good model fit). Value of 0.70 or less are
considered low (poor model fit). RSquare is typically used in combination with
momentum-based indicators such as the "Linear Reg Curve" on page 673.

Ó A LOWRSQUARE VALUE (HERE: 0.03
FOR THEMOST RECENT BAR)
INDICATES AWEAK TREND.

RSS
Shortcode: RSS

DESCRIPTION

This indicator allows the user to add a
personalized information stream to the
charting window.

PARAMETERS

URL
RSS 2.0 or ATOM 1.0 feed URL.

Default: http://feeds.bbci.co.uk/news/rss.xml

RefreshSecs
Specifies the frequency of feed updates in seconds.

Default: 5

Display
Specifies the display method.
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ShowHeadlines displays the RSS headlines on top of the chart line.

ShowCount displays the value of feeds as a number on top of the chart line.

Default: ShowCount

MaxHeadLines
Specifies the value of shown headlines.

Default: 5

MaxHeadLinesLen
Specifies the character length of displayed headlines.

Default: 30

USAGE

Parameter can be changed in the properties field.

Ó PROPERTIES FIELD

The Equilla COM API must be enabled in the options menu, in order to enable
general RSS support.

Ó EQUILLA COM API
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SCATTER
Shortcode: SCAT

DESCRIPTION

This indicator analyzes two instruments and
provides information on the correlation
between the two. A regression line can be
overlayed to highlight positive or negative
correlation.

PARAMETERS

This indicator requires two parent instruments.

PriceX
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

PriceY
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

CALCULATION

The prices of the two instruments are plotted on the same two-axis diagram and
displayed as a scatter plot. The first instrument is plotted on the x-axis, the
second instrument is plotted on the y-axis. A regression line with the indicating
positive or negative correlation is displayed if necessary. The coefficient of
determination R² is also shown with the regression line.

USAGE

An ascending plot with points clustered tightly around the regression line
indicates positive correlation, a descending plot with points clustered tightly
around the regression line indicates negative correlation. A correlation provides
information on the direction of the price but not on the extent of the price change.
For example, a positive correlation between a security and an index does not
provide any information on the price increase. This indicator is often used in
combination with the RSquare indicator in order to determine the significance of
the trend and to calculate its confidence level.
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Ó POSITIVE CORRELATION.

Ó NEGATIVE CORRELATION.

SEASONAL PROJECTION
Shortcode: SEPR

DESCRIPTION

This indicator calculates the average
seasonal performance of the underlying
security. It displays the seasonal pattern on
the chart in order to facilitate comparisons
between current and historical performance.

PARAMETERS

PeriodInYears
The number of years to be included in the calculation of the seasonal
performance.

Default: 3

YearsShift
The base period of the indicator. Increasing the value shifts the period back in
time. An increase by 1 shifts the period one year into the past.

Default: 0
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Values
The method used to display seasonal projections: Absolute (normalized price
values), Percent (percentage of normalized price values) or Original (un-
normalized price values).

Default: Absolute

Mode
The year found in the historic data that will be used to project unencountered days
in the current year: ShortestYear or LongestYear.

Default: LongestYear

MinMax
Display the min/max range in addition to the line graph of the average values.

Default: True

CALCULATION

This indicator calculates the bar-by-bar average of the percent performance of
past trading years of a security.

USAGE

The calculated results are projected onto the current year. The projection makes
seasonal patterns visible and allows for a comparison between current and
historical performance. Users are provided with a “seasonal route” which can be
used for analysis and as an additional criterion for generating trading signals. This
indicator can also be used to compare the current trading year with a specific past
year. Multiple insertion of the indicator can reveal changes in the seasonality
pattern.

The following example shows a chart where the indicator has been inserted three
times with different settings for PeriodInYears:

Ó CHANGES IN SEASONALITY ARE
INSTANTLY VISIBLE.
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Ó DIFFERENT BASE PERIODS FOR THE
CALCULATION COMPARED, AND THE
RESULTING SEASONAL PATTERNS.

SECTOR ALLOC PORTFOLIO STRATEGY
This strategy invests capital according to weight given to each market sector.

It can only be applied to portfolios in which all stocks have the same currency and
provide an industry sector information.

PARAMETERS

RebalancePeriod
Define how often the investments should be rebalanced (each day, week, month,
quarterly or yearly).

Default: Yearly

Energy
Enter a weight for the Energy sector.

Materials
Enter a weight for the Materials sector.

Industrials
Enter a weight for the Industrials sector.

ConsumerDiscretionary
Enter a weight for the ConsumerDiscretionary sector.

ConsumerStaples
Enter a weight for the ConsumerStaples sector.

HealthCare
Enter a weight for the HealthCare sector.

Financials
Enter a weight for the Financials sector.
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InformationTechnology
Enter a weight for the InformationTechnology sector.

CommunicationsServices
Enter a weight for the CommunicationsServices sector.

Utilities
Enter a weight for the Utilities sector.

RealEstate
Enter a weight for the RealEstate sector.

USAGE

This strategy can be used to automate trading per industry sector. The sectors
are processed depending on their weight (from highest to lowest) until the
available capital is distributed. This may already happen after e.g. 3 of 5 sectors,
depending on your settings.

This strategy works similarly to the "Group Alloc Portfolio Strategy" on page 666,
but instead of self-defined groups in your portfolio, you trade in pre-defined
sectors.

SPREAD DIFF
Shortcode: SPD

DESCRIPTION

This indicator calculates the difference of two
given security price series.

PARAMETERS

This indicator requires two parent
instruments.

Price1
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Price2
The data field from the parent instrument (or indicator) on which to calculate this
indicator.
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CALCULATION

The indicator calculates the arithmetic difference between two given security
price series by subtracting two elements from each other.

USAGE

This indicator is often used on future spreads, more specifically to follow
relationships between related futures' prices. It graphically represents the price
difference between securities by displaying a curve. It allows for the comparison
of two securities' performances. For example, it may be used to compare a future
contract to its underlying.

SPREAD DIFF V
Shortcode: SPDV

DESCRIPTION

This indicator calculates the difference of two
given security price series and also outputs a
volume value based on the selected
combination method.

PARAMETERS

This indicator requires two parent instruments.

Price1
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Price2
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Volume
The combination method used to calculate the volume value.

Default: Max

CALCULATION

The indicator calculates the arithmetic difference between two given security
price series by subtracting two elements from each other.
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USAGE

This indicator is often used on future spreads, more specifically to follow
relationships between related futures' prices. It graphically represents the price
difference between securities by displaying a curve. It allows for the comparison
of two securities' performances. In combination with the Price Volume Profile this
indicator provides information on the frequency of a spread price reaching certain
price regions.

SPREAD QUOT
Shortcode: SPQ

DESCRIPTION

This indicator calculates the division of two
given security price series or indicators.

PARAMETERS

This indicator requires two parent
instruments.

Price1
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Price2
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

CALCULATION

This indicator calculates the division of two given security price series or
indicators.

USAGE

This indicator can be used to emulate the Relative Strength concept by dividing
one price series by another. For example, it may be used to compare an index to
one of its constituents.
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SPREAD QUOT V
Shortcode: SPQV

DESCRIPTION

This indicator calculates the division of two
given security price series and also outputs a
volume value based on the selected
combination method.

PARAMETERS

This indicator requires two parent instruments.

Price1
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Price2
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Volume
The combination method used to calculate the volume value.

Default: Max

CALCULATION

This indicator calculates the division of two given security price series or
indicators.

USAGE

This indicator can be used to emulate the Relative Strength concept by dividing
one price series by another. In combination with the Price Volume Profile this
indicator provides information on the frequency of a spread price reaching certain
price regions.
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STOCHASTIC FAST
Shortcode: FSTOC

DESCRIPTION

This indicator shows the location of the
closing price relative to the high-low range
over a set number of periods. It displays two
lines, the indicator line as well as a smoothed
version of the indicator line calculated by
applying a simple moving average.

PARAMETERS

This indicator requires a single parent instrument that has data fields for Open,
High, Low, Close available.

PeriodStoch
The number of bars used to calculate the %K Line of the indicator.

Default: 5

PeriodSmoothing
The number of bars used to calculate the %D Line, i.e. the smoothed %K Line.

Default: 3

OverBought
The overbought threshold.

Default: 80

OverSold
The oversold threshold.

Default: 20

ShowAlerts
Controls whether alerts are displayed if thresholds are exceeded.

Default: No

CALCULATION

The trading range is determined by calculating the difference between the highest
high and the lowest low of the chosen period. Then, the difference between the
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current close and the lowest low of the chosen period is calculated and divided by
the trading range determined. To determine the %K Line, this result is multiplied
by 100:

%K = (C - L) / (H - L) *100

To determine the %D Line, a simple moving average is applied to the %K Line:

%D = Sum(n) (%K) / n

USAGE

Indicator values range from 0 to 100. A value of 20 or lower typically means that
the security is oversold, a value of 80 or higher typically means that the security is
overbought. A trend reversal is expected in both cases though it may be delayed
depending on the strength of trend.

The %D Line may also be used to generate trading signals. For example, if the
indicator line (%K Line) crosses the %D Line bottom-up this is regarded as a buy
signal, if the indicator line crosses the %D Line top-down, this is regarded as a
sell signal.

Divergences between indicator and underlying security may can also be used to
create trading signals, especially if followed by a crossing of the %D Line.

Tip: Please note that prices often continue to move in their current direction in situations
where the indicator enters a threshold zone.

Ó A BULLISH DIVERGENCE.

Ó STOCHASTIC FAST IN AN UPTREND.

776



STOCHASTIC FAST - ENTRY STRATEGY

DESCRIPTION

The strategy is based on the indicator
"Stochastic Fast" on page 775. The indicator
contains two lines: %K and %D. %K is a
momentum which is calculated based on a
spread between the price in the past and the
current price. %D is smoothed version of %K.
The strategy is triggered if the two signal lines
are crossing. For Exit signals with the same
trigger, please use the "Stochastic Fast - Exit
Strategy" on the next page.

PARAMETERS

Period
The number of bars used to calculate

Default: 5

TriggerPeriod
The number of bars used to calculate the internal smoothing of %D

Default: 3

EntryMethod
Defines what kind of orders are placed.

Default: Both

CALCULATION

For the calculation of the indicator itself, see "Stochastic Fast" on page 775.

The strategy is triggered if the signal lines %K and %D are crossing. If %K
crossed under %D, generates the strategy a short signal. Otherwise, if %K
crosses over %D, is a long signal generated.

USAGE

The strategy alone indicates the current trend on the market and should be used
as other stochastic strategies along with the trend. In addition it is possible to
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trade only the crosses in the upper and lower section to trade only trades which a
clear trend.

STOCHASTIC FAST - EXIT STRATEGY

DESCRIPTION

The strategy is based on the indicator
"Stochastic Fast" on page 775. The indicator
contains two lines: %K and %D. %K is a
momentum which is calculated based on a
spread between the price in the past and the
current price. %D is smoothed version of %K.
The strategy is triggered if the two signal lines
are crossing. For Entry signals with the same trigger, please use the "Stochastic
Fast - Entry Strategy" on the previous page.

PARAMETERS

Period
The number of bars used to calculate

Default: 5

TriggerPeriod
The number of bars used to calculate the internal smoothing of %D

Default: 3

ExitMethod
Defines what kind of orders are placed.

Default: Both

CALCULATION

For the calculation of the indicator itself, see "Stochastic Fast" on page 775.

The strategy is triggered if the signal lines %K and %D are crossing. If %K
crossed under %D, generates the strategy a short signal. Otherwise, if %K
crosses over %D, is a long signal generated.
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USAGE

The strategy alone indicates the current trend on the market and should be used
as other stochastic strategies along with the trend. In addition it is possible to
trade only the crosses in the upper and lower section to trade only trades which a
clear trend.

STOCHASTIC SLOW
Shortcode: SSTOC

DESCRIPTION

This indicator is a variant of the "Stochastic
Fast" on page 775 Indicator compared to
which this indicator produces a quieter, more
balanced indicator line. It shows the location
of the closing price relative to the high-low
range over a set number of periods. Both fast
and slow variants consist of two lines; the %K line which compares the latest
closing price to the recent trading range while the %D line is a signal line
calculated by smoothing the %K line. The Slow Stochastic signal line is a moving
average of the %D line.

PARAMETERS

This indicator requires a single parent instrument that has data fields for Open,
High, Low, Close available.

PeriodStoch
The number of bars used to calculate the %K Line of the indicator.

Default: 5

PeriodSmoothing1
The number of bars used to calculate the internal smoothing of the indicator.

Default: 3

PeriodSmoothing2
The number of bars used to calculate the %D Line, i.e. the smoothed %K Line.

Default: 3

OverBought
The overbought threshold.
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Default: 80

OverSold
The oversold threshold.

Default: 20

ShowAlerts
Controls whether alerts are displayed if thresholds are exceeded.

Default: No

CALCULATION

The trading range is determined by calculating the difference between the highest
high and the lowest low of the chosen period. Then, the difference between the
current close and the lowest low of the chosen period is calculated and divided by
the trading range determined. To determine the %K Line, this result is multiplied
by 100:

%K = (C - L) / (H - L) *100

To determine the %D Line, a simple moving average is applied to the %K Line:

%D = Sum(n) (%K) / n

To determine the Stochastic Slow, a simple moving average is applied to the %D
Line:

StochasticSlow = Sum(n) (%D) / n

USAGE

Indicator values range from 0 to 100. A value of 20 or lower typically means that
the security is oversold, a value of 80 or higher typically means that the security is
overbought. A trend reversal is expected in both cases though it may be delayed
depending on the strength of trend.

The %D Line may also be used to generate trading signals. For example, if the
indicator line (%K Line) crosses the %D Line bottom-up this is regarded as a buy
signal, if the indicator line crosses the %D Line top-down, this is regarded as a
sell signal.

Divergences between indicator and underlying security may can also be used to
create trading signals, especially if followed by a crossing of the %D Line.
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Tip: Please note that prices often continue to move in their current direction in situations
where the indicator enters a threshold zone.

Ó A BEARISH DIVERGENCE.

Ó STOCHASTIC SLOW (CENTER) AND
FAST (BOTTOM) COMPARED.

STRATEGY DRAWDOWN
Shortcode: STRADD

DESCRIPTION

This indicator plots the current and maximal
strategy drawdown of a parent instrument in a
chart.

For a Portfolio, we recommend using
"Strategy Drawdown Portfolio" on the next
page instead.

PARAMETERS

Source
Select the source, either Parent, ParentIntraday, Global, or GlobalIntraday.

Default: Absolute
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Calculation
The method used for displaying the drawdown, either Absolute or Percent.

Default: Absolute

ShowDrawDownAsPositive
Select whether the drawdown should be shown as positive numbers (True) or not
(False).

Default: False

CALCULATION

Based on the applied strategies, the drawdown is calculated for the instrument.

USAGE

Use this indicator to get a drawdown result for a parent instrument. It can be
applied selectively to one instrument in a Portfolio.

STRATEGY DRAWDOWN PORTFOLIO
Shortcode: PDRDWN

DESCRIPTION

This indicator plots the current and max
strategy drawdown in a chart in much the
same way as "Strategy Drawdown" on the
previous page does. It requires no parent, so
it will not accidentally be removed if the first
item from the chart gets deleted. Its other
main advantage is that it will appear in a Portfolio regardless of what is selected.

By default, it gets added automatically when adding the first strategy to a Portfolio
(unless changed in the advanced options, see "Indicators & Strategies" on
page 327).

PARAMETERS

Source
Select the source, either Parent, ParentIntraday, Global, or GlobalIntraday.

Default: Absolute

Calculation
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The method used for displaying the Portfolio drawdown, either Absolute or
Percent.

Default: Absolute

ShowDrawdownAsPositiveValues
Select whether the drawdown should be shown as positive numbers (True) or not
(False).

Default: False

CALCULATION

Based on the applied strategies, the drawdown is calculated for the Portfolio.

USAGE

Use this indicator to get a combined drawdown for a Portfolio.

STRATEGY EQUITY
Shortcode: Equity

DESCRIPTION

This indicator plots the open and closed
equity curves for an underlying security.

PARAMETERS

ShowMarketPosition
Select if and how the current market position
should be displayed, either Direction and
Size, Direction, or None.

Default: DirectionAndSize

Mode
The method of displaying the equity, either Absolute or Percent or Percent of
Money Management.

Default: Absolute

Capital
Capital employed. This is necessary to calculate the equity based on the applied
strategies.
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Default: 1000

HighlightBacktestingRange
This setting will shade the chart horizontally to show where backtesting began, if
Intrabar Backtesting in the options of the Money Management is active.

Default: Yes

CALCULATION

The indicator calculates the open and closed equity for the underlying security.

USAGE

Use this indicator to get a single equity result for an instrument.

STRATEGY EQUITY COMBINED
Shortcode: CEquity

DESCRIPTION

This indicator shows the combined strategy
equity curve for all traded items in the chart.

This indicator needs a parent object. For a
Portfolio, we recommend using "Strategy
Equity Portfolio" on the next page instead.

PARAMETERS

Mode
The method of displaying the equity, either Absolute or Percent or Percent of
Money Management.

Default: Absolute

Capital
Capital employed. This is necessary to calculate the equity based on the applied
strategies.

Default: 1000

HighlightBacktestingRange
This setting will shade the chart horizontally to show where backtesting began, if
Intrabar Backtesting in the options of the Money Management is active.
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Default: True

CALCULATION

The indicator calculates and adds the open and closed equity for all items in a
chart and plots the resulting lines.

USAGE

Use this indicator to get a combined equity result for the instruments in a chart.

Applying the Strategy Equity Combined to a Portfolio will show the combined
equity of the Portfolio. However, as it needs a parent, it gets applied to a specific
instrument in the Portfolio, and might get deleted if the underlying instrument gets
deleted from the Portfolio. We therefore recommend using "Strategy Equity
Portfolio" below instead.

STRATEGY EQUITY PORTFOLIO
Shortcode: PEquity

DESCRIPTION

This indicator plots the open and closed
equity curves for all items in a chart in much
the same way as "Strategy Equity Combined"
on the previous page does. It requires no
parent, so it will not accidentally be removed if
the parent item gets deleted from the chart.
Its other advantage is that it will appear in a
Portfolio regardless of what is selected.

By default, it gets added automatically when adding the first strategy to a Portfolio
(unless changed in the advanced options, see "Indicators & Strategies" on
page 327).

PARAMETERS

Mode
The method of displaying the equity, either Absolute or Percent or Percent of
Money Management.

Default: Absolute

Capital
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Capital employed. This is necessary to calculate the equity based on the applied
strategies.

Default: 1000

HighlightBacktestingRange
This setting will shade the chart horizontally to show where backtesting began, if
"Intrabar Backtesting" in the options of the Money Management is active.

Default: True

CALCULATION

The indicator calculates and adds the open and closed equity for each item in the
Portfolio and plots the resulting lines.

USAGE

Use this indicator to get a combined equity result for the instruments in a Portfolio.

STRATEGY EQUITY WORKSPACE
Shortcode: WEquity

DESCRIPTION

This indicator plots the combined open and
closed equity for all charts and portfolios in
the current workspace.

PARAMETERS

Mode
The method of displaying the equity, either
Absolute or Percent or Percent of Money Management.

Default: Absolute

Capital
Capital employed. This is necessary to calculate the equity based on the applied
strategies.

Default: 1000
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CALCULATION

The indicator calculates and adds the open and closed equity of each chart and
portfolio in the current workspace and then plots the resulting lines.

USAGE

Use this indicator to get a combined equity result for instruments that are not
otherwise handled together, for example several charts in one workspace.

Ó THREE CHARTS IN AWORKSPACE
WITH STRATEGY EQUITY
WORKSPACE APPLIED

STRATEGY MARKET POSITION
Shortcode: POS

DESCRIPTION

This indicator shows the strategy's market
position as a colored band in the chart.

PARAMETERS

LongColor
Defines the color for the band.

Default: Green

ShortColor
Defines the color for the band.

Default: Red

FlatColor
Defines the color for the band.

Default: White
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CALCULATION

The indicator checks the value of the Equilla function MarketPosition and adjusts
the color of the band accordingly.

USAGE

The indicator is useful to identify the MarketPosition in the chart.

STRATEGY MONTHLY RETURNS GRID
Shortcode: none

DESCRIPTION

This indicator plots a heatmap of the monthly
strategy returns. Years are displayed as
rows, and months are displayed as columns.

PARAMETERS

StartYear
Bottom year in the grid. If fewer years are available from your data provider, only
the available years will be displayed, e.g. the last four.

Default: 2000

TextSize
Set the text size within the grid.

Default: 9

Labels
Select which labels should be displayed: Both, Months, Years, None.

Default: Both

TextColor
The color for the text.

BorderColor
The color for the border around the grid.

BackColor
The background color for the row and column heading and for empty fields.

UpColor
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The color for months on which returns went up.

DownColor
The color for months on which returns went down.

MidColor
The color for months where returns moved very little.

Graduation
The number that defines the level of color change on return differences. The
smaller the number, the sharper the color differences.

Default: 5

CALCULATION

The percentage of change for monthly returns is calculated for each month over
the years.

Change per month = ( capital - startCapital ) / startCapital * 100

USAGE

The indicator shows the monthly returns over the years, creating a heatmap that
can be used for analyzing seasonal patterns.

STRATEGY PERIODIC RETURNS
Shortcode: PSRET

DESCRIPTION

This indicator plots the percent or absolute
gain over a given calendar period.

PARAMETERS

Period
The time period to use for the
calculation: Yearly, Quarterly, Monthly, Weekly, Daily.

Default: Monthly

Value
Controls whether the absolute return or the percentage should be used.

Default: Percent
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ColorUp
The color for months on which returns went up.

ColorDown
The color for months on which returns went down.

CALCULATION

The absolute return is calculated as

diff = capital - startCapital

The percent value as

diff = ( capital - startCapital ) / startCapital * 100

USAGE

This is an indicator that shows returns over a calender period, allowing e.g. for the
analysis of seasonal changes. Multiple periodic returns of the same color signal
stable trends.

STRATEGY PORTFOLIO REPORT
Shortcode: PREPORT

DESCRIPTION

This indicator behaves much like the
"Strategy Report" on the next page but allows
the data statistic set of a Portfolio to be
viewed in the grid without the need to attach
the indicator to a specific instrument.

PARAMETERS

ShowLong
Select if long positions should be shown (True) or not (False).

Default: True

ShowShort
Select if short positions should be shown (True) or not (False).

Default: True

ShowTitles
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Select if the table titles should be shown (True) or not (False).

Default: True

MaxDecimalPlaces
Select the maximal number of decimal places to be displayed.

Default: 5

TextSize
Select the text size.

Default: 12

CALCULATION

The Strategy Portfolio Report indicator doesn't calculate anything but displays
data selected by the user.

USAGE

Use the Strategy Portfolio Report indicator for an overview of the performance
statistics of a Portfolio.

STRATEGY REPORT
Shortcode: REPORT

DESCRIPTION

This indicator shows a strategy performance
statistics in a small grid within the chart.
Statistics may be added or removed as
required.

PARAMETERS

UseAllData
Select if all data should be used (True) or not (False).

Default: True

ShowLong
Select if long positions should be shown (True) or not (False).

Default: True
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ShowShort
Select if short positions should be shown (True) or not (False).

Default: True

ShowTitles
Select if the table titles should be shown (True) or not (False).

Default: True

MaxDecimalPlaces
Select the maximal number of decimal places to be displayed.

Default: 5

TextSize
Select the text size.

Default: 12

CALCULATION

The Strategy Report indicator doesn't calculate anything but displays data
selected by the user.

USAGE

Use the Strategy Report indicator for an overview of the performance statistics.

STRATEGY SYMBOL RANKING
Shortcode: RANKSS

DESCRIPTION

This indicator lists the top symbols in the
portfolio ranked according to a strategy
statistic.

PARAMETERS

Count
Set the number of symbols displayed in the ranking.

Default: 5

MaxDecimalPlaces
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Set the maximal number of decimal places to be displayed.

Default: 5

TextSize
Enter a text size.

TextColor
Enter a color for the text.

Default: Black

GridColor
Enter a color for the grid lines.

Default: Dark Gray

BackColor
Enter a color for the background.

Default: Light gray

CALCULATION

The calculation depends on the displayed values. Select the output from the drop-
down list in the window.

It offers all values that are available in the "Performance Report" on page 287.

USAGE

This indicator returns a dynamic list of the top or bottom performing stocks in your
portfolio, based on criteria defined by you.

TARGET RETURN PORTFOLIO STRATEGY
This strategy is a relative return based portfolio trading strategy. The strategy will
calculate the lowest risk portfolio for the specified annual target return rate (based
on the 'Efficient Frontier' concept).

It can only be applied to portfolios in which all stocks have the same currency.

PARAMETERS

TargetAnnualReturn
The target annual return in percent.
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Default: 5

ReturnMode
Should the target be seen as exact value or as minimum? 

Default: Exact

ReturnPeriod
Howmany bars should be used to calculate the ex post returns?

Default: 24

RebalancePeriod
How often the investments should be rebalanced (each day, week, month,
quarterly or yearly)?

Default: Monthly

CALCULATION

The efficient frontier offers the highest expected return for a defined level of risk.
The risk is defined as the standard deviation of a security. Ideally, a portfolio
should have securities with a lower standard deviation than the standard
deviation of the industry sector, while still having higher returns.

The efficient frontier is curved - the less synchronized the securities / the higher
the diversification, the lower the standard deviation, and the better the risk/return
profile. Portfolios below the efficient frontier have less return for the same
risk; portfolios to the right of the efficient frontier have higher risk for the same
return.

USAGE

The automatic allocation of the Target Return strategy aims for a sensible annual
return (e.g. 5% above inflation) with the least possible risk necessary to achieve
this number. The target return is independent of market returns, focusing on
preserving the purchasing power of the portfolio. It is a long-term strategy: it is
possible that quarters may not yield the desired target value, but the average of
returns over time will allow approaching the annual target.

TIMED EXIT STRATEGY
This strategy will exit a position at a certain time of the day.
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PARAMETERS

CloseTime
Set the time when the position should be closed.

Default: 1900

Mode
Select which mode should be used for exiting the position: ThisBar (the trade is
executed immediately), NextBar (the trade is executed at the next bar's opening
price).

Default: NextBar

USAGE

Close open positions at a certain time, e.g. at the end of the work day at 1800
hours.

TIMED EXIT (BARS) STRATEGY
This strategy will exit a position at a certain time, based on bars.

PARAMETERS

Bars
Define the number of bars to be considered.

Default: 5

Mode
Select which mode should be used for exiting the position: ThisBar (the trade is
executed immediately), NextBar (the trade is executed at the next bar's opening
price).

Default: NextBar

USAGE

Close open positions at a certain point of the trading day, e.g. at the end of the
day (bar).
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TOP DOGS PORTFOLIO STRATEGY
This strategy is a generic implementation of the Dogs of the Dow trading system
(see "Dogs of the Dow Strategy" on page 663). Once per year, find the best
performers and invest equally in each. It uses the lowest rate of change as the
performance measure.

It can only be applied to portfolios in which all stocks have the same currency.

PARAMETERS

Period
The number of bars to be used for calculating the rate of change (volatility).

Default: 10

DogCount
In how many top performers should be invested?

Default: 10

TradeMonth
Select at the end of which month in each year the highest dividend yield should be
calculated.

Default: Jan

USAGE

The Top Dogs strategy is a long-term strategy that combines the Dogs of the Dow
highest dividend yield approach with the rate of change as volatility measure.
Once per year the top stocks with the highest dividend yield at the lowest risk are
found and the capital is rebalanced towards these top performers. Then for
another year, no trades take place (saving on tradings costs). The DogCount
ensures a lower portfolio volatility compared to investing in only 1-2 top
performers.
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TOOL ALERTS
Shortcode: none

DESCRIPTION

This indicator adds a window to the chart that
shows a ticker of the most recent tool alerts
that have occurred since the indicator was
added (or modified). It works like a live ticker -
if the chart is redrawn, the ticker is reset.

For this indicator to work, you need to add
e.g. drawing elements and enable their alert function.

This indicator is mainly included as a demonstration of intercepting tool alerts
from Equilla.

PARAMETERS

Items
Number of alerts to be displayed.

TextSize
Enter a text size.

CALCULATION

The listener waits for an alert. On alert, it will write a new line in the Tool Alerts
output window.

USAGE

Use this indicator to see the latest tool alerts.

TRADE DEPTH
This indicator plots histograms of bid/ask trades by volume for each candle.

PARAMETERS

Columns
The number of indicator bars to be displayed.

Default: 30
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ColorUp
Controls the color of the indicator bars for increasing volume.

ColorDn
Controls the color of the indicator bars for decreasing volume.

CALCULATION

The indicator assigns the trading volume to up and down intrabar moments
respectively. It displays a histogram of market volume levels within each bar
distributed according to the respective price levels. The volume is split up
between Bid and Ask volume.

USAGE

The indicator is like a "Price Volume Profile" on page 741 and splits the volume
into bid and ask volume for each bar. The general opinion is that on the put side of
resistance lines the volume should be higher than on the call side, and that on the
call side of support lines the volume should be higher than on the put side. The
analysis facilitated by this indicator allows for predictions regarding the
sustainability of chart marks.

TRADE SPAN
Shortcode: TSPAN

DESCRIPTION

This indicator draws a line between the entry
and exit of a trade.

CALCULATION

The indicator draws a line between the entry
and the exit of a trade. The color of the line
depends on the result of the trade (win, loss,
breakeven).

USAGE

Use this indicator to visualize trades and theirs results as a line in the chart
directly.
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TRADE VOLUME MAGNITUDE

DESCRIPTION

This indicator plots the trade volume via circles on a given bar and indicates via
the color of the circles if the trades were made on Bid or Ask side.

PARAMETERS

AvgPeriod
Defines the average period for the Moving Average Exponential

Default: 20

AvgWidth
Defines the average width of the circles

Default: 8

CALCULATION

The indicator plots the two circles in different colors. The radius of the circles is
based on a "Moving Average Exponential" on page 699. The Moving Average
Exponential uses the input AvgPeriod for the calculation.

The indicator needs access to the field SIDE via Joule.

USAGE

The indicator can be helpful to identify buying or selling pressure. The color and
the radius of the circles indicate on which side the most trades occurred. The
greener the radius is, the more trades were on the ask side. On the opposite, the
more red the radius, the more trades were on the bid side.

The meaningfulness of this indicator is higher on intraday chart.
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TREND CHANNELS
Shortcode: CHAN

DESCRIPTION

This indicator plots trend channels based on
high and low swings of a specified strength. It
works similarly to the indicator "Trend Lines"
on the next page but draws parallel lines like
a corridor.

The Trend Channels indicator only works on
charts with a fixed bar width.

PARAMETERS

HighSwingStrength
Ameasure for how "far" the algorithm should look for highs.

Default: 14

LowSwingStrength
Ameasure for how "far" the algorithm should look for lows.

Default: 14

MinExtend
Howmany bars at least to look ahead of the pivot point for the next pivot point.

Default: 5

MaxPivots
Howmany pivot points at most to be used for calculating the trend.

Default: 3

Alerts
Should leaving the trend channel cause an alert: Off, OncePerBar, Always

Default: Off

CALCULATION

Based on the pivot points and the given variables, the trend channels are
calculated.

The highest high and lowest low define the channel.
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The granularity of the trend channels is defined by swing strength and the
minimum extend value.

USAGE

The trend channel is used as a predictive indicator. If the following day's market
price falls below the trend channel, it may be used as a new resistance level.
Conversely, if the market price rises above the trend channel, it may act as the
new support level.

TREND LINES
Shortcode: LINE

DESCRIPTION

This indicator plots trend lines onto a chart
based on high and low swings of a specified
strength, i.e. the pivot points (see also the
indicator "Pivot Points Analysis" on
page 737).

The Trend Line indicator only works on charts
with a fixed bar width.

PARAMETERS

HighSwingStrength
Ameasure for how "far" the algorithm should look for highs.

Default: 14

LowSwingStrength
Ameasure for how "far" the algorithm should look for lows.

Default: 14

MinExtend
Howmany bars at least to look ahead of the pivot point for the next pivot point.

Default: 5

MaxPivots
Howmany pivot points at most to be used for calculating the trend.

Default: 3
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Alerts
Should crossing the trend line cause an alert: Off, OncePerBar, Always.

Default: Off

CALCULATION

Based on the pivot points and the given variables, the trend lines are calculated.

The granularity of the trend lines is defined by swing strength and the minimum
extend value.

USAGE

The trend line is used as a predictive indicator. If the following day's market price
falls below the trend line, it may be used as a new resistance level. Conversely, if
the market price rises above the trend line, it may act as the new support level.

VALUE AT RISK
Shortcode: VAR

DESCRIPTION

This indicator calculates the theoretical
maximum loss generated by a strategy over
the holding period based on a defined
confidence level. Conditional Value at Risk is
also plotted to show the mean average of all
strategy equity changes exceeding the Value
at Risk.

PARAMETERS

Period
The holding period (in bars) for which to calculate the value at risk.

Default: 1

ObservationPeriod
The number of bars over which to calculate the value at risk.

Default: 30

Confidence
The probability with which the value at risk calculated will not be exceeded.
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Default: 95

CALCULATION

Value at Risk calculates the potential loss based on strategy equity changes over
a prior observation period. For the calculation the Variance-Covariance Method is
used, which assumes that stock returns are normally distributed. Hence, two
factors are taken into account: an expected (or average) return and a standard
deviation. The Conditional Value at Risk calculates the average of the losses that
occur beyond the Value at Risk cutoff point in the distribution.
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USAGE

The information generated by this indicator can be used to assess potential
losses generated by a strategy. Exceedance of the Value at Risk may indicate
that a modification of the strategy currently applied is required. For example, the
indicator can be used to determine position sizes in order to minimize losses
when trading shares or contracts. The Conditional Value at Risk provides insight
into particularly adverse market situations in which the Value at Risk will be
exceeded. It calculates the average of the losses to be expected in those
situations.

Ó THE INDICATOR, APPLIED TO THE
BOLLINGER BANDS BREAKOUT
STRATEGY.

VOLUME ACCUMULATED
Shortcode: VAC

DESCRIPTION

This indicator confirms or disproves trends by
putting the daily momentum into relation to
the trading volume. It determines whether a
price move has been confirmed by the
correspondent volume.

CALCULATION

The indicator multiplies the daily momentum with the trading volume. To calculate
the daily momentum the indicator determines the difference between closing
price and daily low as well as the difference between closing price and daily high.
It then divides the difference between these two partial results by the trading
range. It then multiplies the this result by the daily trading volume.
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USAGE

The indicator shows whether a price movement has been confirmed by the
trading volume. The daily momentum, i.e. the ratio between trading range and
actual price movement, allows for analysis of market movements. High indicator
values indicate trading days with strong positive price movement accompanied by
high volume. Low indicator values indicate strong negative price movement
accompanied by high volume.

Ó PRICE MOVEMENTS CONFIRMED BY
THE TRADING VOLUME.

VOLUME MARKET
Shortcode: MAV

DESCRIPTION

This indicator analyzes the relationship
between Volume and Open Interest. It can
only be applied to futures for which Open
Interest data is available.

CALCULATION

The indicator is calculated by dividing Volume by Open Interest.

USAGE

The relationship between Volume and Open Interest indicates whether money is
moving into the market or subtracted.
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VOLUME PRICE TREND
Shortcode: VPT

DESCRIPTION

This indicator combines the price momentum
of a security with its trading volume. It
analyzes the strength of a trend and points to
possible weaknesses of a price movement. In
contrast to other price-volume indicators it is
based not on absolute price changes but on
percentage change.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

CALCULATION

On an up day, the volume is multiplied by the percentage price increase between
the current close and the previous bar's close. This value is then added to the
previous bar's indicator value.

On a down day, the volume is multiplied by the percentage price decrease
between the current close and the previous bar's close. This value is then added
to the previous bar's indicator value.

By adding together the individual results over the set period a smoothed indicator
value is created which is drawn as a line on the chart.

USAGE
à Increasing price accompanied by an indicator line moving

upwards confirms the upwards price trend; decreasing price
accompanied by an indicator line moving downwards
confirms the downwards price trend.

à Increasing price accompanied by an indicator line moving
downwards or sideways is a divergence and may suggest that
the upwards price movement is weak and lacking strength;
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decreasing price accompanied by an indicator line moving
upwards is a divergence and may suggest that the
downwards price movement is weak and lacking strength.

à Crossings of the indicator line with the zero line can be
interpreted as trading signals; divergences between indicator
and underlying instrument are regarded as warnings against a
possible trend change.

Ó INTERSECTIONS OF A SIMPLE
MOVING AVERAGE AND THE
INDICATOR LINE CAN ALSO BE
INTERPRETED AS TRADING SIGNALS

VOLUME PRICE BREAKOUT - ENTRY STRATEGY

DESCRIPTION

The strategy uses the relation as well within
the current candle as well as between the
volume and the "Moving Average Simple" on
page 705 to generate trading signals. For Exit
signals with the same trigger, please use the
"Volume Price Breakout - Exit Strategy" on
the next page.

PARAMETERS

Period
The number of bars used to calculate

Default: 10

ExitMethod
Defines what kind of orders are placed.

Default: Both
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CALCULATION

Ó STRATEGY BEFORE AND AFTER
OPTIMIZER

For the strategy is a simple moving average
with the input Period calculated. This simple
moving average, the volume and the current
candle are used for trading signals. For the
calculation of the indicator itself, see "Moving
Average Simple" on page 705.

The strategy generates a long entry signal
when the volume crosses over a simple moving average and the close is greater
than the open. The other way round, a short entry signal is generated when the
volume crosses over a simple moving average and the close is less than the
open.

USAGE

For Entry signals with the same trigger, please use the "Volume Price Breakout -
Entry Strategy" on the previous page.

Strategies which are using an average of historical data like price for trading
signals are always depending on delay, noise and trend. Due to the Moving
Average Simple used, the strategy cannot predict trends and trend reversal, but is
reacting to the ongoing trend with a delay. The influence of all three factors can be
reduced by choosing the right values for the input. The optimizer in Tradesignal is
very useful to find the right settings.

VOLUME PRICE BREAKOUT - EXIT STRATEGY

DESCRIPTION

The strategy uses the relation as well within
the current candle as well as between the
volume and the "Moving Average Simple" on
page 705 to generate trading signals. For
Entry signals with the same trigger, please
use the "Volume Price Breakout - Entry
Strategy" on the previous page.

PARAMETERS

Period
The number of bars used to calculate

Default: 10
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ExitMethod
Defines what kind of orders are placed.

Default: Both

CALCULATION

Ó STRATEGY BEFORE AND AFTER
OPTIMIZER

For the strategy is a simple moving average
with the input Period calculated. This simple
moving average, the volume and the current
candle are used for trading signals. For the
calculation of the indicator itself, see "Moving
Average Simple" on page 705

The strategy generates a long exit signal when
the volume crosses under a simple moving average or the close is less than the
open. The other way round, a short exit signal is generated when the volume
crosses under the simple moving average and the close is greater than the open.

USAGE

Strategies which are using an average of historical data like price for trading
signals are always depending on delay, noise and trend. Due to the Moving
Average Simple used, the strategy cannot predict trends and trend reversal, but is
reacting to the ongoing trend with a delay. The influence of all three factors can be
reduced by choosing the right values for the input. The optimizer in Tradesignal is
very useful to find the right settings.

VOLUME RATIO
Shortcode: VRAT

DESCRIPTION

This indicator compares buying pressure to
selling pressure using volume as a measure
of strength. It compares the volume on days
with increasing price to the volume on days
with decreasing price over a defined number
of bars. It identifies divergences between
price trend and volume.

PARAMETERS

Price
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The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Default: Volume

VolSeries
The data field from the parent instrument (or indicator) on which to calculate the
volume sums.

Default: Volume

Period
The number of bars used to calculate the volume summation.

Default: Period

CALCULATION

Over the base period, the trading volume is distributed over three values; the
volume on days with increasing closing price, decreasing closing price and
unchanged closing price respectively. The indicator is calculated by setting the
individual sums into proportion to each other.

USAGE

In a strong trend the volume should be high and increase when prices increase.
Divergences between price development and volume development may point to
an imbalance of market forces. The relationship between days with increasing
price and days with decreasing price should be in accord with the prevailing price
trend. Divergences may point to a weakness of the trend.

VOLUME WEIGHTED AVERAGE PRICE
Shortcode: VWAP

DESCRIPTION

Volume-weighted average price (VWAP) is a
ratio used by investors to make trades without
disturbing the market with large orders. This
indicator plots the VWAP value of the parent
security for its current period.

PARAMETERS

Mins
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The underlying granularity of data (in minutes) from which to calculate the VWAP
on each bar (0 for tick data).

Default: 1

CALCULATION

Volume-weighted average price is the average price of a security weighted
against its trading volume over a given time frame. When using non-tick data to
calculate the VWAP (i.e. when setting Mins to a non-zero value), the volume will
distributed over the four price values of each underlying bar.

USAGE

VWAP is a price source that reduces market noise. It generally does not provide
entry signals, stop loss levels or target prices.

When the price is below the VWAP, the trend is likely down or there is a
downward bias to the period.

When the price is above the VWAP, the trend is likely up or there is an upward
bias to the period.

WATERMARK LOGO

DESCRIPTION

This indicator displays the Tradesignal logo
as a watermark behind the chart. Custom
images can be inserted from the Equilla
editor.

USAGE

TheWatermark Logo allows you to display a custom image as a watermark
behind the chart, e.g. the logo of your organization. This is a useful feature when
using charts in publications or presentations.
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WATERMARK TICKER

DESCRIPTION

This indicator displays the symbol and/or
name of the underlying instrument as a
watermark behind the chart.

USAGE

Displaying the symbol and/or name of the
underlying instrument behind the chart is useful when using charts in publications
or presentations, especially in cases where the chart legend is hidden.

ZIGZAG
Shortcode: ZIG

DESCRIPTION

This indicator indicates trends by drawing
lines between turning points in a chart. It
filters out changes in an underlying security
that are less than a set trigger value. The
ZigZag has no predictive power due to its
lagging nature. It helps to identify significant
changes in price by eliminating the noise of everyday market conditions.

PARAMETERS

Price
The data field from the parent instrument (or indicator) on which to calculate this
indicator.

Mode
The method to be used for filtering out price movements, either absolute or
percent.

Default: Percent

Trigger
The sensitivity of the indicator. A higher value will result in a greater amount of the
price action being filtered.

Default: 5
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ShowReversalLevel
Sets the visibility of a marker which indicates the price that has to be exceeded to
reverse the current trend.

Default: Yes

CALCULATION

The current segment of the zig zag line is drawn between the current price and
the most recent turning point. This turning point is subtracted from today’s closing
price. Then, the difference is divided by the most recent turning point and
multiplied by 100. Please note the following:

à A turning point is generated only if the trigger value has been
reached and a change of direction occurs.

à A turning point is permanent only if a subsequent turning point
has been generated and the subsequent price movement
reaches the trigger value.

à A turning point is removed if the price changes direction and
continues its original movement before reaching the trigger
value. In this case, the most recent Zig Zag line is removed
and will continue from the previous turning point.

USAGE

The Zig Zag may be used to confirm the direction of a trend or trend reversals, or
to highlight important patterns. Please note that the ZigZag cannot be used as a
trading strategy due to its „lagging“ nature.

Ó THE ZIGZAG SET TO 5 PERCENT.
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Ó THE ZIGZAG SET TO 10 PERCENT. A
GREATER AMOUNT OF THE PRICE
ACTION HAS BEEN FILTERED.
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